
Release 12.0

Revision A

October 2021

Trimble RealWorks
USER GUIDE



LEGAL NOTICES

Corporate Office
Trimble Inc.
935 Stewart Drive
Sunnyvale, CA 94085
USA
www.trimble.com

GeoSpatial business area
Trimble Inc.
10368Westmoor Drive,
Westminster, CO 80021
USA
www.trimble.com/support/

Trimble Europe B.V.
Industrieweg 187A
5683 CC Best
The Netherlands

Legal Notices

© 2019–2021, Trimble Inc. All rights reserved.
Trimble, and the Globe & Triangle logo are trademarks of
Trimble Inc., registered in the United States and in other
countries.
All other trademarks are the property of their respective
owners.

Release Notice

This is the October 2021 (version 1) release of the Trimble
RealWorks User Guide.

Trimble RealWorks User Guide | 2

http://www.trimble.com/
http://www.trimble.com/support/


Contents

LEGAL NOTICES 2

WELCOME 1

WHAT'S NEW 3

INSTALL TRIMBLE REALWORKS 4

3.1 System Requirements 4

3.2 Check the Graphics Card in Use 5

3.2.1 Enforce the Use of the High Performance Graphics Card 5

3.2.2 Check the Version Number of the OpenGL Library 7

3.3 Check the Open Source Libraries and Licenses in Use 7

3.4 Download Trimble RealWorks 7

3.5 Download Trimble Update Network License Utility 8

3.6 Licensed Features 8

3.7 Install Trimble RealWorks 8

3.7.1 Trimble RealWorks Plant Tables 9

3.7.2 Storage Tank Application 9

3.8 Update Trimble RealWorks 10

3.9 Modify, Repair and Remove Trimble RealWorks 10

3.10 View & Manage Licensed Features 10

3.11 Export an Event Log File 13

3.12 Connect to an External Trimble Service Using Your TID 13

GET STARTED 14

4.1 Start Trimble RealWorks 14

4.2 Open your First Project 14

4.3 Working Environment 14

4.3.1 User Interface 15

4.3.2 Start Page 17

4.3.3 Menu Bar 18

Trimble RealWorks User Guide | 3



Contents

4.3.4 Toolbars 18

4.3.5 Ribbon 18

4.3.6 Vertical Toolbar 19

4.3.7 Windows 19

4.3.7.1 Start Page 19

4.3.7.2 WorkSpace 19

4.3.7.3 List 20

4.3.7.4 Property 21

4.3.7.5 Selection List 22

4.3.7.6 Station Maker List 22

4.3.7.7 Classification Layers 23

4.3.7.8 Limit Box List 23

4.3.7.9 3D View 23

4.3.7.9.1 View Manager 24

4.3.7.9.1.1 Change the Display Configuration of Sub-Views 24

4.3.7.9.1.2 Display & Hide a Sub-View in Full 25

4.3.7.9.2 2D Grid 25

4.3.7.9.3 Navigation Constraint Tools 26

4.3.8 Tools and Commands 26

4.3.8.1 Menu Bar 26

4.3.8.2 Toolbars 27

4.3.8.2.1 Main 27

4.3.8.2.2 Display 27

4.3.8.2.3 3D View 27

4.3.8.2.4 View Alignment 28

4.3.8.2.5 Tools in the Registration Module 29

4.3.8.2.6 Tools in the OfficeSurvey Module 30

4.3.8.2.7 Tools in the Modeling Module 31

Trimble RealWorks User Guide | 4



Contents

4.3.8.2.8 Windows 31

4.3.8.2.9 Working Frame 31

4.3.8.3 Shortcut Keys in RealWorks 32

4.3.8.3.1 Cloud Renderings 32

4.3.8.3.2 Geometry Renderings 32

4.3.8.3.3 Standard Views 32

4.3.8.3.4 Station Markers and Station Marker Labels 33

4.3.8.3.5 Gray-Scale Intensity With Color Rendering 33

4.3.8.3.6 View Manager 33

4.3.8.3.7 Picking Parameters 33

4.3.8.3.8 Head Always Up 33

4.3.8.3.9 Limit Box Extraction 34

4.3.8.3.10 Limit Box Mode 34

4.3.8.3.11 Segmentation 34

4.3.8.3.12 Fitting 35

4.3.8.3.13 Cloud-Based Registration 35

4.3.8.3.14 Geometry Modifier 35

4.3.8.3.15 SteelWorks Creator 35

4.3.8.3.16 Tank Creation 35

4.3.8.3.17 Toolbar/Ribbon 36

4.3.8.3.18 Image Rectification 36

4.3.8.3.19 Magnifier for Point Clouds 36

4.3.8.3.20 Magnifier for Geometries 36

4.3.8.3.21 Ortho-Projection 36

4.3.8.3.22 FF/FL Analysis (ASTM E1155) 36

4.3.8.3.23 Polyline Drawing 36

Merge Coplanar Polylines 36

4.3.8.3.24 Move Mesh 37

Trimble RealWorks User Guide | 5



Contents

4.3.8.3.25 Create Pipe 37

4.3.9 Customize the User Interface 37

4.3.9.1 Windows 37

4.3.9.1.1 Display a Window 37

4.3.9.1.2 Hide a Window 38

4.3.9.1.3 Undock a Window 38

4.3.9.1.4 Dock aWindow 39

4.3.9.1.5 Lock Windows from Undocking 39

4.3.9.2 Toolbars 40

4.3.10 Customize the Quick Access Toolbar 40

4.3.10.1 Move the Quick Access Toolbar 40

4.3.10.2 Add a Command to the Quick Access Toolbar 41

4.3.10.3 Export the Quick Access Toolbar 41

4.3.10.4 Import the Quick Access Toolbar 42

4.3.10.5 Show the Quick Access Toolbar Below/Above the Ribbon 42

4.3.10.6 Restore the Commands to the Default Values 42

4.4 Set the Unit of Measurement for Length 42

4.5 Set a Preference 42

4.5.1 Viewer 43

4.5.2 HD Display 43

4.5.3 Tools 44

4.5.3.1 Define the Width of All Polylines 44

4.5.3.2 Keep / Not Keep Displayed Objects Visible When Starting Segmentation 44

4.5.3.3 3D Manipulators Enhancements 44

4.5.4 Navigation 46

4.5.5 General 47

4.5.6 Units Preferences 47

4.5.7 Print Preference 48

Trimble RealWorks User Guide | 6



Contents

4.5.8 Improvement Program Preferences 48

4.6 Close Trimble RealWorks 48

PERFORM BASIC OPERATIONS 49

5.1 Supported Data Formats 49

5.1.1 Trimble 3D Scanning Files 49

5.1.2 RealWorks Files 49

5.1.3 TZF Files 51

5.1.4 TZS Files 55

5.1.5 JobXML, JOB and RAW Files 56

5.1.5.1 Scale Factor 59

5.1.5.2 Scale Factor - Ellipsoid Model 59

5.1.5.3 Scale Factor - Geoid -DatumModel 59

5.1.5.4 Switch from Ground to Grid 60

5.1.6 ASCII Files 60

5.1.6.1 With Wizard 61

5.1.6.2 Without Wizard 62

5.1.7 Trimble TX5 and Other FLS Files 62

5.1.7.1 Open a FLS Format File 62

5.1.7.2 Open an IQscan Format File 63

5.1.7.3 FLS and IQscan Import Results 63

5.1.8 Surveying Network ASCII Files 64

5.1.8.1 Import as a Topographic Station 65

5.1.8.2 Import in an Existing Station 66

5.1.9 SIMA ASCII Files 66

5.1.10 AutoCAD Files 67

5.1.11 IXF Files 69

5.1.12 RIEGL Scan Project Files 69

5.1.13 Z+F Scan Files 70

Trimble RealWorks User Guide | 7



Contents

5.1.13.1 Z+F Import Filters 71

5.1.14 LAS and LAZ Files 72

5.1.15 E57 Files 73

5.1.15.1 Gridded Data 73

5.1.15.2 Non-Gridded Data 74

5.1.16 PTX Files 75

5.1.17 PTS Files 75

5.1.18 DotProduct Files 75

5.1.19 Autodesk FilmBox Files 75

5.1.20 TDX Files 76

5.1.21 X7 Data Files 76

5.1.22 X7 TDX Files 76

5.1.23 IFC Files 79

5.2 Open a Project File 80

5.3 Import a Project File 80

5.4 Connect to Mobile Device 81

5.5 Import FLS Files 81

5.6 Import Image 83

5.7 Open Scan Explorer 83

5.8 Open SketchUp 84

5.9 Send to SketchUp 85

5.10 Open AutoCAD 86

5.11 Send to AutoCAD 87

5.12 Save Projects 87

5.13 Undo an Operation 87

5.14 Redo an Operation 88

5.15 Close Projects 88

DATA ORGANIZATION 89

Trimble RealWorks User Guide | 8



Contents

6.1 Project Tree 89

6.2 Scans Tree 89

6.3 Models Tree 90

6.4 Targets Tree 90

6.5 Images Tree 91

6.6 Annotations Tree 91

6.7 Project Cloud 92

6.7.1 Project Cloud Layer 93

6.7.2 Get all Points 93

6.7.3 Get the Remaining Points 94

6.8 Active Group 94

6.9 Groups and Objects 94

6.9.1 In the WorkSpace Window 94

6.9.2 In the List Window 94

6.10 Model Groups 96

6.10.1 Set a Group as a Model Group 96

6.10.2 Set as a Non Model Group 96

6.10.3 Duplicate a Model Group 96

6.10.4 Displace a Model Group 97

EDIT 98

7.1 Drag & Drop an Item 98

7.2 Cut & Paste an Item 99

7.3 Copy and Paste an Item 99

7.4 Delete an Item 100

7.5 Create a New Group Node 101

7.6 Rename in Item 101

7.7 Project 101

7.7.1 Shift Project 102

Trimble RealWorks User Guide | 9



Contents

7.7.2 Flip Project Vertical Axis 102

7.7.3 Merge Projects 102

7.7.4 UCS Creation 111

7.7.4.1 Open the Tool 111

7.7.4.2 Select a Reference Frame 112

7.7.4.3 Build a Frame without Constraints 112

7.7.4.3.1 Specify Coordinates 112

7.7.4.3.2 Pick Points 113

7.7.4.3.3 Fit an Axis 114

7.7.4.3.4 Pick the Local Frame of an Object 115

7.7.4.3.5 Take the Axis of an Axial Geometry as Axis 115

7.7.4.3.6 Pick Three Points 115

7.7.4.4 Build a Frame with Constraints 116

7.7.4.4.1 Lock the Origin 116

7.7.4.4.2 Lock an Axis 117

7.7.4.4.3 Lock the Origin and an Axis 118

7.7.4.4.4 Rotate Around an Axis 118

7.7.4.4.5 Build a Frame from a Geometry 119

7.7.4.5 Create the Built Frame 121

7.7.5 Set as Home UCS 122

7.8 TZF Scan 122

7.8.1 Open RealColor 122

7.8.2 Post-Process TZF Scans 123

7.8.3 Create Thumbnails 123

7.8.4 Create Station Images from TZF Scan Color 123

7.8.5 Get TZF Scan Files 124

7.8.6 Modify TZF Path 125

7.8.7 Color Points by Height 125

Trimble RealWorks User Guide | 10



Contents

7.8.8 Re-Project TZF Scans 126

7.8.9 Remove Points from TZF Scans 127

7.8.9.1 Create Sampled Scans 127

7.8.9.2 Select Points to Remove 128

7.8.9.3 Remove Points From TZF Scans 129

7.8.10 Create TZF Scan 130

7.8.10.1 Open the Tool 130

7.8.10.2 Choose the Automatic Mode 130

7.8.10.3 Choose the Advanced Mode 131

7.8.10.4 No Images, and no Scans 133

7.8.10.5 One or more Images, and no Scans 133

7.8.10.6 No Images, and Some Scans 133

7.8.10.7 Some Images, and Some Scans 133

7.8.10.8 Created TZF Scans 134

7.9 Scan 134

7.9.1 Limit Box Extraction 134

7.9.1.1 Open the Tool 134

7.9.1.2 Define the Center Point of a Limit Box 135

7.9.1.3 Edit the Properties of a Limit Box 135

7.9.1.3.1 Select the Center Point of a Limit Box 135

7.9.1.3.2 Change the Center Point of a Limit Box 136

7.9.1.3.3 Manipulate a Limit Box 136

7.9.1.3.3.1 Resize a Limit Box 136

7.9.1.3.3.2 Pan a Limit Box 137

7.9.1.3.3.3 Rotate a Limit Box 139

7.9.1.3.3.4 Switch from one Mode of Manipulation to Another 139

7.9.1.3.4 Display and Hide a Limit Box 139

7.9.1.3.5 Display & Hide Clouds and Geometries Outside the Limit Box 140

Trimble RealWorks User Guide | 11



Contents

7.9.1.3.6 View a Limit Box from one of its Sides 140

7.9.1.4 Record Limit Boxes 140

7.9.1.5 Manage Limit Boxes 140

7.9.1.6 Check the Current Loaded Points 141

7.9.1.7 Extract Points from a Specific Area 142

7.9.1.7.1 Apply a Sampling by Step Filter 142

7.9.1.7.2 Apply a Spatial Sampling Filter 142

7.9.1.7.3 Apply a Spatial Sampling (Keep Details) Filter 142

7.9.1.7.4 Create Scans from TZF Scans 143

7.9.1.7.5 Cancel the Extraction 143

7.9.1.8 Close the Tool 143

7.9.2 Create Sampled Scans 144

7.9.2.1 Sample the Scan Data 145

7.9.2.2 Filter the Scan Data 145

7.9.3 Equalize Luminance 146

7.9.4 Equalize Color 146

7.9.5 Color Points 146

7.10 Point Cloud 147

7.10.1 Segmentation 147

7.10.1.1 Open the Tool 147

7.10.1.2 Delimit a Region on a Set of Points 148

7.10.1.2.1 Draw a Fence (Polygon Only) 149

7.10.1.2.2 Draw a Fence (Lasso Only) 149

7.10.1.2.3 Draw a Fence (Polygon and Lasso) 149

7.10.1.2.4 Draw a Rectangular Fence 149

7.10.1.2.5 Draw a Circular Fence 149

7.10.1.3 Keep Points Inside or Outside a Fence 150

7.10.1.4 Assign a Classification Layer to the Fenced Cloud 151

Trimble RealWorks User Guide | 12



Contents

7.10.1.5 Set the Cloud Inside the Limit Box as a Working Cloud 152

7.10.1.6 Create the Results 153

7.10.2 Sampling 154

7.10.2.1 Open the Tool 154

7.10.2.2 Choose a Method 155

7.10.2.2.1 Spatial Sampling 155

7.10.2.2.2 Random Sampling 155

7.10.2.2.3 Intensity-Based Sampling 156

7.10.2.2.4 Scan-Based Sampling 157

7.10.2.2.5 Discontinuity-Based Sampling 160

7.10.2.2.5.1 Detect Edges 161

7.10.2.2.6 Topography-Based Sampling 162

7.10.2.2.7 Ground Extraction 163

7.10.2.2.7.1 Add Some Regions to the Ground 165

7.10.2.2.7.2 Remove the Ground 166

7.10.2.2.7.3 Keep the Ground 166

7.10.2.2.8 Floor Extraction (Indoor) 167

7.10.2.2.8.1 Add Some Regions to the Floor 168

7.10.2.2.8.2 Remove the Floor 169

7.10.2.2.8.3 Keep the Floor 169

7.10.3 Auto-Classify Outdoor 170

7.10.4 Auto-Classify Indoor 171

7.10.5 Auto-Classify Tunnel 172

7.10.6 Merge Several Point Clouds into One 173

7.10.7 Cloud Color 173

7.10.8 Delete Cloud 174

7.11 Geometry 174

7.11.1 Delete Geometry 175

Trimble RealWorks User Guide | 13



Contents

7.11.2 Geometry Color 175

7.12 Merge Coplanar Polylines 176

7.13 Equalize Image Color 177

EXPLORE 179

8.1 Expand and Shrink the Project Tree 179

8.2 Locate an Object in the Project 179

8.3 Find an Item in the Project 179

8.4 Explore in the 3D View 181

8.5 Explore in the Images Tree 181

8.6 Display 181

8.6.1 Show & Hide Cloud 181

8.6.2 Show & Hide Geometry 182

8.6.3 Hide all 183

8.6.4 View Only This 183

8.6.5 Display, Hide & Open Image 183

8.6.6 Station 185

8.6.6.1 Display & Hide all Station Markers 185

8.6.6.2 Display & Hide all Station Marker Labels 186

8.6.6.3 Display & Hide Specific Station Makers 186

8.6.6.4 Display & Hide the Network Visuals of a Station 187

8.6.6.5 Display & Hide the Network Visuals of all Stations 188

8.6.7 TZF Scan 190

8.6.8 Inspection Map 192

8.6.9 Annotation 193

8.6.10 ColorBar 196

8.6.10.1 Hide& Show a ColorBar 196

8.6.10.2 Edit a ColorBar 196

8.6.10.2.1 Create a ColorBar 197

Trimble RealWorks User Guide | 14



Contents

8.6.10.2.2 Edit a ColorBar 198

8.6.10.2.3 Import a ColorBar 199

8.6.10.2.4 Delete a ColorBar 199

8.6.10.2.5 Switch to a ColorBar 199

8.6.10.2.6 ColorBar Advanced Options 199

8.6.10.2.6.1 Define Intervals 200

8.6.10.2.6.2 Define Level Colors 200

8.6.10.2.7 Export a ColorBar 200

8.6.10.3 Switch to the Cut/Fill ColorBar 200

8.6.10.4 Switch to the Default ColorBar 201

8.6.11 Display & Hide the Alignment Stationing 201

8.7 Render the Data 201

8.7.1 Render a Point Cloud 202

8.7.1.1 Color a Point Cloud Based on the Classification Information 203

8.7.1.2 Color Point Clouds Based on by the Elevation Information 204

8.7.2 Define Settings for Cloud Rendering 206

8.7.2.1 Adjust the Intensity Contrast and Brightness 206

8.7.2.2 Blend the Intensity and Color Information 207

8.7.2.3 Define the Rendering by Elevation Interval 208

8.7.2.4 Define the Rendering by Elevation Origin 208

8.7.3 Render Point Clouds With Gray-Scale Intensity With Color 208

8.7.4 Choose a Point Cloud Shading 209

8.7.5 Choose a Point Cloud Visibility 210

8.7.6 Display the Discontinuity of Points 213

8.7.7 Change the Size of Displayed Points 213

8.7.8 Render a Geometry 213

8.7.8.1 Color Geometries Based on the Classification Information 213

8.7.8.2 Display Edges of Models 214

Trimble RealWorks User Guide | 15



Contents

8.7.9 Apply a Smooth Rendering to Meshes 215

8.7.10 Add a Lighting Direction 216

8.7.11 Adaptive Point Size 217

8.7.12 Cloud Transparency 217

8.7.13 Ortho-Image Transparency 219

8.8 Filter the Data 220

8.8.1 Launch the Limit Box Mode 220

8.8.2 Define the Center Point of a Limit Box 221

8.8.3 Edit the Properties of the Limit Box 221

8.8.3.1 Select the Center Point of a Limit Box 221

8.8.3.2 Change the Center Point of a Limit Box 222

8.8.3.3 Manipulate a Limit Box 222

8.8.3.3.1 Resize a Limit Box 222

8.8.3.3.2 Pan a Limit Box 223

8.8.3.3.2.1 Pan Along a Direction 224

8.8.3.3.2.2 Pan in a Plane 224

8.8.3.3.3 Rotate a Limit Box 225

8.8.3.3.4 Switch from one Mode of Manipulation to Another 226

8.8.3.4 Display and Hide a Limit Box 226

8.8.3.5 Display and Hide Clouds/Geometries Outside the Limit Box 226

8.8.3.6 View a Limit Box from one of its Sides 226

8.8.4 Record Limit Boxes 227

8.8.5 Manage Limit Boxes 227

8.8.5.1 Rename a Limit Box 227

8.8.5.2 Add a Description to a Limit Box 227

8.8.5.3 Apply a Limit Box 227

8.8.5.4 Remove a Limit Box 227

8.8.5.5 Export Limit Boxes 227

Trimble RealWorks User Guide | 16



Contents

8.8.5.6 Import Limit Boxes 228

8.9 Navigate 228

8.9.1 Customize the Settings for a Mouse 228

8.9.2 Set the Head Always Up Option 229

8.9.3 Set a Navigation Mode 229

8.9.3.1 Examiner 229

8.9.3.1.1 Navigate Without Constraints 230

8.9.3.1.1.1 Rotate Around the Center of the Screen 230

8.9.3.1.1.2 Rotate Around a Picked Point Position 232

8.9.3.1.1.3 Pan in a Direction 233

8.9.3.1.1.4 Zoom In / Zoom Out 234

8.9.3.1.2 Navigate Under Temporary Constraints 235

8.9.3.1.3 Navigate Under Permanent Constraints 237

8.9.3.2 Walkthrough 239

8.9.3.2.1 Tilt (or Rotate) "Look at" a Direction 240

8.9.3.2.2 Move the Camera in a Direction 240

8.9.3.2.3 Walk Through a Scene (or Objects) 240

8.9.3.3 Station-Based 241

8.9.3.3.1 Browse the Stations 241

8.9.3.3.2 Rotate Within a Station 242

8.9.3.3.3 ZoomWithin a Station 242

8.9.3.3.4 Display & Hide the Images 243

8.9.3.3.5 Filter the Images 243

8.9.3.3.6 Edit Manually a Distance 243

8.9.3.4 Move to a position on the ground 244

8.9.3.5 Look at a position on a wall (or an object) 247

8.9.4 Set a Projection Mode 248

8.10 Align the Data to a View 249

Trimble RealWorks User Guide | 17



Contents

8.10.1 Align to a Global View 249

8.10.2 Align to a Local View 250

8.11 Zoom 250

8.11.1 Zoom In & Zoom Out 250

8.11.2 Zoom Extents 251

8.11.3 Zoom on Selection 251

8.11.4 Center on Point 251

8.11.5 Magnifier Mode for Point Clouds 252

PICK & SELECT 253

9.1 Select the Data 253

9.1.1 WorkSpace Window 253

9.1.2 List Window 253

9.1.3 3D ViewWindow 253

9.1.3.1 Rectangular Selection 254

9.1.3.2 Polygonal Selection 254

9.1.3.3 Lasso Selection 254

9.1.4 Clear a Selection 254

9.2 Pick Data 255

9.2.1 Pick in the Standard Mode 255

9.2.1.1 Pick in the 3D Constraint Mode 255

9.2.1.2 Pick in the 2D Constraint Mode 256

9.2.2 Pick the Highest Cloud Point 257

9.2.3 Pick the Lowest Cloud Point 258

9.2.4 Face of Curb Point and Gutter Point Pickings 259

9.2.4.1 Pick Face of Curb Points 261

9.2.4.2 Pick Gutter Points 262

9.2.5 Roadmark Edge Pickings 263

LOAD, PROCESS & HD DISPLAY DATA 265

Trimble RealWorks User Guide | 18



Contents

10.1 Load Data 265

10.2 Process Data 265

10.3 Display Points in HD 266

CLASSIFICATION LAYERS 268

11.1 Work With Classification Layers 268

11.1.1 Create 268

11.1.2 Delete 269

11.1.3 Edit 269

11.1.4 Advanced View Mode 269

11.1.5 Select the Contents of a Specific Layer 270

11.2 Display & Hide Objects in a Classification Layer 270

11.3 Change the Classification Layer 271

BASIC TOOLS 273

12.1 Measure 273

12.1.1 Open the Tool 273

12.1.2 Measure a Distance 274

12.1.2.1 Measure a Distance 274

12.1.2.2 Measure a Distance on Screen 274

12.1.2.3 Measure a Distance in a Horizontal Plane 275

12.1.2.4 Measure a Distance Along a Vertical Axis 276

12.1.2.5 Measure a Vertical Clearance Distance (Upward) 276

12.1.2.6 Measure a Vertical Clearance Distance (Downward) 277

12.1.2.7 Measure a Distance to a Fitted Plane 277

12.1.2.8 Measure a Fitted Cylinder Diameter 278

12.1.2.9 Measure a Point-to-Geometry Distance 279

12.1.2.10 Measure a Multi-Point Distance 280

12.1.3 Measure an Angle 281

12.1.3.1 Measure an Angle 281

Trimble RealWorks User Guide | 19



Contents

12.1.3.2 Measure a Horizontal Angle 282

12.1.3.3 Measure a Slope Angle 283

12.1.3.4 Measure a Geometry Slope Angle 283

12.1.3.5 Measure a Between-Geometry Angle 284

12.1.4 Measure a Point Position 285

12.1.4.1 Measure a 3D Point 285

12.1.5 Measure an Orientation / Slope 285

12.1.5.1 Measure an Orientation / Slope 285

12.1.5.2 Measure an Orientation / Slope Using Three Points 287

12.1.6 Refine a Measurement 288

12.1.7 Save a Measurement 288

12.2 Key Plan 289

12.2.1 Generate key Plan from TZF Scans 291

12.2.2 Generate Key Plan from Current View 291

REGISTRATION MODE 292

13.1 SCAN-BASED REGISTRATION TOOLS 292

13.1.1 Auto-Register Using Planes 292

13.1.1.1 Open the Tool 292

13.1.1.2 Reference Station 294

13.1.1.3 Register Stations 294

13.1.1.4 Registration Report 296

13.1.1.5 Save in RTF Format 298

13.1.1.6 Options 298

13.1.1.6.1 Generate Preview Scans 298

13.1.2 Cloud-Based Registration 298

13.1.2.1 Open the Tool 298

13.1.2.2 Select Two Clouds 299

13.1.2.3 Register Clouds Automatically (Guess) 301

Trimble RealWorks User Guide | 20



Contents

13.1.2.4 Register Clouds by Picking Points 302

13.1.2.4.1 Pick the First Pair of Points 302

13.1.2.4.2 Pick the Second Pair of Points 302

13.1.2.4.3 Pick the Third Pair of Points 303

13.1.2.4.4 Delete the Last Picked Point/Pair of Points 304

13.1.2.4.5 Delete all Picked Points 304

13.1.2.5 Refine Automatically the Registration 304

13.1.2.6 Refine Interactively the Registration 305

13.1.2.6.1 Pan the Moving Cloud 305

13.1.2.6.2 Rotate the Moving Cloud 306

13.1.2.6.3 Change the Manipulator Center Location 307

13.1.2.7 Check the Quality of the Registration 307

13.1.2.8 Save the Registration Result 308

13.1.3 Refine Registration Using Scans 309

13.1.3.1 Open the Tool 310

13.1.3.2 Choose a Reference Station 310

13.1.3.3 Select a Subset of Stations for the Refinement 311

13.1.3.4 Refine the Registration 312

13.1.3.5 View the Registration Report 312

13.1.4 Orientation 314

13.1.4.1 Open the Tool 314

13.1.4.2 Set the Vertical Orientation of a Scene 314

13.1.4.2.1 Define Automatically the Vertical Axis 315

13.1.4.2.2 Define the Vertical Axis by Picking Two Points 315

13.1.4.2.3 Apply the Transformation 316

13.1.4.3 Set the Horizontal Orientation of a Scene 316

13.1.4.3.1 Define the Horizontal Axis by Picking Two Points 317

13.1.4.3.2 Automatic Axis Definition 317

Trimble RealWorks User Guide | 21



Contents

13.1.4.4 Rotate Counterclockwise 90° 317

13.1.4.5 Pick the Origin 318

13.1.4.6 Apply the Transformation 318

13.1.4.7 Close the Tool 318

13.1.5 Registration Report (Scan-Based) 318

13.2 TARGET-BASED REGISTRATION TOOLS 319

13.2.1 Auto-Extract Targets 319

13.2.1.1 Open the Tool 319

13.2.1.2 Choose a Target Type 321

13.2.1.3 Create Sampled Scans 321

13.2.1.4 Select a Reference Station 321

13.2.1.5 Register the Stations 322

13.2.2 Target-Based Registration 322

13.2.2.1 Open the Tool 323

13.2.2.2 Select a Reference Station 323

13.2.2.3 Auto-Pair the Targets 324

13.2.2.4 Edit Targets 326

13.2.2.5 Adjust the Stations 326

13.2.2.6 Check the Adjustment 329

13.2.2.6.1 Registration Details 329

13.2.2.6.2 From Station View 331

13.2.2.6.2.1 Matched Station Tab 331

13.2.2.6.2.2 Unmatched Station Tab 332

13.2.2.6.3 From Target View 332

13.2.2.6.4 Auto-Match All 333

13.2.2.6.5 Auto-Match Station 334

13.2.2.6.6 Export the Registration Report to a RTF File 334

13.2.2.7 Save the Adjustment Result 334

Trimble RealWorks User Guide | 22



Contents

13.2.3 Target Analyzer 335

13.2.3.1 Open the Tool 335

13.2.3.2 Select a Station 336

13.2.3.3 Select a TZF Scan 337

13.2.3.4 Focus on Targets 337

13.2.3.5 Create/Edit Targets 338

13.2.3.5.1 Fit a Geometry to Point Cloud [From Scan Items] 339

13.2.3.5.2 Create a 3D Points 340

13.2.3.5.3 Delete a Target 340

13.2.3.5.4 Edit the Target Height 340

13.2.3.5.5 Fit a Geometry to Point Cloud [From Unfitted Items] 340

13.2.3.5.6 Re-Fit a Geometry to Point Cloud [From Fitted Items] 341

13.2.3.5.7 Modify the Target Position 342

13.2.3.5.8 Extract Targets 343

13.2.3.5.8.1 Extract Spherical Targets 343

13.2.3.5.8.2 Extract Black andWhite Flat Targets 345

13.2.3.5.8.3 Extract Point Targets 348

13.2.3.5.8.4 Extract Point Targets (Corners) 349

13.2.3.5.8.5 Modify the Properties of a Target 352

13.2.3.6 Update the Network 352

13.2.3.7 Apply the Result 352

13.2.4 Georeferencing 352

13.2.4.1 Open the Tool 353

13.2.4.2 Select a Station for Georeferencing 353

13.2.4.3 Assign Known Coordinates to a Target 354

13.2.4.4 Assign Known Coordinates to a Picked Point 356

13.2.4.5 Check the Average Error 358

13.2.4.6 Apply the Georeferencing 359

Trimble RealWorks User Guide | 23



Contents

13.2.5 Modify Target 359

13.2.5.1 Match With 359

13.2.5.2 Match Targets 360

13.2.5.3 Unmatch Targets 361

13.2.5.4 Rename a Target 362

13.2.6 Registration Report (Target-Based) 362

13.3 SURVEYWORKFLOW TOOLS 363

13.3.1 Station Setup 363

13.3.1.1 Open the Tool 363

13.3.1.2 Select a Station 363

13.3.1.3 Select a Setup Type 363

13.3.1.3.1 Station Setup 364

13.3.1.3.1.1 Define the Properties of an Instrument Station 364

13.3.1.3.2 Resection 365

13.3.1.3.2.1 Define the Properties of an Instrument Station 366

13.3.1.3.3 Measure Targets 366

13.3.1.3.3.1 Extract Spherical Targets 367

13.3.1.3.3.2 Extract Black andWhite Flat Targets 369

13.3.1.3.3.3 Extract Point Targets 371

13.3.1.3.3.4 Extract Point Targets (Corners) 373

13.3.1.3.3.5 Modify the Properties of a Target 375

13.3.1.3.4 Define Backsight Points 376

13.3.1.3.4.1 Re-Fit a Target 376

13.3.1.3.4.2 Modify the Position of a Target 376

13.3.1.3.4.3 Input the Height of a Target 377

13.3.1.3.4.4 Match With a Known Point 377

13.3.1.3.5 Check the Results 377

13.3.1.3.6 Apply the Network Adjustment 378

Trimble RealWorks User Guide | 24



Contents

13.3.2 Network Adjustment 378

13.3.3 Name-Based Network Adjustment 379

13.3.4 Instrument Leveling 379

13.3.4.1 Force Leveled 380

13.3.4.2 Modify the Instrument Height 381

13.3.4.3 Set Over Known Point 382

13.3.4.4 Remove Known Point 384

13.3.4.5 Force Unleveled 385

13.3.5 Create Points 385

13.3.5.1 Create Topo Point 385

13.3.5.2 Create Topo Points from Selected Station Positions 386

13.3.5.3 Create Point Cloud from Topo Points 387

13.3.5.4 Create 3D Points 388

13.4 TRANSFORMATION TOOLS 389

13.4.1 Import Station Registration Parameters from TZF Files 389

13.4.2 Export Station Registration Parameters to TZF Files 389

13.4.3 Export Station Registration Parameters to RMX Files 390

13.4.4 Register Stations With Imported RMX Files 391

13.5 QUALITY ASSURANCE TOOLS 391

13.5.1 Registration Visual Check 391

13.5.1.1 Open the Tool 391

13.5.1.2 Define a Limit Box 392

13.5.1.2.1 Define a Limit Box by Defining a Horizontal Slice 392

13.5.1.2.2 Define a Limit Box by Defining a Slice Perpendicular to the Screen 392

13.5.1.2.3 Edit the Properties of a Limit Box 393

13.5.1.3 Inspect Visually 397

13.5.1.3.1 Display and Hide Clouds/Geometries Outside the Limit Box 397

13.5.1.3.2 Display and Hide a Limit Box 398

Trimble RealWorks User Guide | 25



Contents

13.5.1.3.3 View a Limit Box From Different Sides 398

13.5.1.3.4 Define the Moving Step 399

13.5.1.3.5 Navigate Through the Sections 399

13.5.1.3.6 Change the Color of a Station 400

13.5.1.3.7 Identify a Station 401

13.5.1.3.8 Display and Hide a Station 401

13.5.1.4 Isolate an Area of Interest 401

13.5.1.5 Store the Area as a Limit Box 401

PRODUCTION TOOLS 402

14.1 DRAWING TOOLS 402

14.1.1 2D-EasyLine 402

14.1.1.1 Open the Tool 403

14.1.1.2 Model Automatically Polylines 404

14.1.1.3 Model Manually Polylines 405

14.1.1.4 Edit Polylines 406

14.1.1.4.1 Select Items 406

14.1.1.4.1.1 Standard Selection Mode 407

14.1.1.4.1.2 Multi-Select 407

14.1.1.4.1.3 Partial Deselect 407

14.1.1.4.1.4 Partial Reselection Mode 408

14.1.1.4.2 Delete Items 408

14.1.1.4.3 Apply Filters 409

14.1.1.5 Saving Results 410

14.1.2 Polyline Drawing 410

14.1.2.1 Open the Tool 410

14.1.2.2 Define a 3D Plane 411

14.1.2.3 Draw a Polyline 411

14.1.2.3.1 Draw a Chain of Segments and/or Arcs 412

Trimble RealWorks User Guide | 26



Contents

14.1.2.3.2 Draw a Rectangle 414

14.1.2.3.3 Draw a Circle 415

14.1.2.4 Select a Polyline (or a Feature Set) 415

14.1.2.5 Edit a Polyline 416

14.1.2.6 Delete a Polyline 418

14.1.2.7 Move a Polyline 418

14.1.2.8 Auto-Duplicate a Polyline 420

14.1.2.9 Duplicate Manually a Polyline 423

14.1.2.10 Create a Polyline 424

14.1.3 Catenary Drawing 424

14.1.3.1 Open the Tool 424

14.1.3.2 Pick Three Points 424

14.1.3.3 Create a Power Line 425

14.1.4 EasyProfile 425

14.1.4.1 Open the Tool 425

14.1.4.2 Select an Existing Profile 426

14.1.4.3 Set the Section Size 426

14.1.4.4 Modify Built Elements 427

14.1.4.5 Create Profiles 429

14.1.5 Profile Matcher 429

14.1.5.1 Open the Tool 429

14.1.5.2 Define a Cutting Plane 430

14.1.5.3 Define a Profile 432

14.1.5.3.1 Set a Thickness 432

14.1.5.3.2 Move the Profile 432

14.1.5.3.2.1 Rotate the Profile 433

14.1.5.3.2.2 Pan the Profile 433

14.1.5.3.2.3 Scale the Profile 434

Trimble RealWorks User Guide | 27



Contents

14.1.5.4 Reverse the Profile 435

14.1.5.5 Create the Profile 436

14.1.6 Feature Set 436

14.1.6.1 Open the Tool 436

14.1.6.2 Feature Code Libraries 437

14.1.6.3 Feature Codes 437

14.1.6.4 Feature Points 438

14.1.6.4.1 Pick a Feature Point 438

14.1.6.4.2 Edit a Feature Point 439

14.1.6.4.3 Modify Feature Points 439

14.1.6.5 Set a Display Mode 440

14.1.6.6 Create (or Apply Changes to) a Feature Set 441

14.1.7 Edit a Feature Code Library 441

14.1.7.1 Edit a Library 441

14.1.7.2 Edit a Feature Code 442

14.1.8 Cutting Plane 443

14.1.8.1 Open the Tool 443

14.1.8.2 Define an Orientation 443

14.1.8.2.1 Set Coordinates 444

14.1.8.2.2 Select a Frame Axis 444

14.1.8.2.3 Pick an Object Local Frame 444

14.1.8.2.4 Pick Three Points 444

14.1.8.2.5 Pick Two Points 445

14.1.8.2.6 Fit With a Geometry 445

14.1.8.2.6.1 Fit a Plane 445

14.1.8.2.6.2 Find the Best Cross Plane 446

14.1.8.2.7 Edit Parameters 446

14.1.8.3 Define a Position 446

Trimble RealWorks User Guide | 28



Contents

14.1.8.4 Define a Slice 448

14.1.8.5 Preview a Single Slice 448

14.1.8.6 Preview a Multiple Slice 449

14.1.8.7 Build Polylines 450

14.1.8.8 Save the Cutting Result(s) 451

14.1.9 Contouring 451

14.1.9.1 Open the Tool 451

14.1.9.2 Define an Elevation Range 451

14.1.9.3 Calculate the Contours 453

14.1.9.4 Define the Principal Contours 454

14.1.9.5 Display Contours 455

14.1.9.6 Create Contours 455

14.1.9.7 Manipulate a Label 456

14.1.10 Profile/Cross-Section 456

14.1.10.1 Open the Tool 456

14.1.10.2 Select a Method 457

14.1.10.3 From Path 457

14.1.10.3.1 Select a Path 457

14.1.10.3.2 Draw a Path 458

14.1.10.3.3 Define the Start and End Positions 458

14.1.10.3.4 Set the Interval Parameter 460

14.1.10.3.5 Define a Width 460

14.1.10.3.6 Apply the Cutting Positions 461

14.1.10.4 The "From Segments" Method 461

14.1.10.4.1 Select a Group of Segments 461

14.1.10.4.2 Define a Path 462

14.1.10.4.3 Use the Width of the Segment 462

14.1.10.4.4 Apply the Cutting Positions 463

Trimble RealWorks User Guide | 29



Contents

14.1.10.5 Compute Cross-Sections 463

14.1.10.5.1 Set a Thickness 463

14.1.10.5.2 Set a Tolerance 463

14.1.10.5.3 Preview the Profile and the Cross-Sections 463

14.1.10.5.4 Print a Profile (or Cross-Sections) 465

14.1.10.5.5 Scale a Profile and Cross-Sections 465

14.1.10.6 Display Cross-Sections 466

14.1.10.7 Edit the Cross-Sections 466

14.1.10.8 Create Profile and Cross-Sections 466

14.1.11 Move Label 467

14.2 SURFACES TOOLS 467

14.2.1 Fitting 468

14.2.1.1 Open the Tool 468

14.2.1.2 Fence a Set of Points 468

14.2.1.3 Fit With a Geometry 469

14.2.1.4 Create a Fitted Geometry 470

14.2.2 Mesh Creation 470

14.2.2.1 Open the Tool 470

14.2.2.2 Select a Projection Mode 471

14.2.2.2.1 Define a Plane-Based Projection 471

14.2.2.2.2 Define a Cylinder-Based Projection 472

14.2.2.2.2.1 Select a Frame Axis 472

14.2.2.2.2.2 Pick an Axis From an Object 472

14.2.2.2.2.3 Draw a Circle 472

14.2.2.2.2.4 Draw a Cylinder 473

14.2.2.2.2.5 Edit the Parameters 473

14.2.2.2.3 Define a Current View-Based Projection 473

14.2.2.2.4 Define a Scanning Direction-Based Projection 473

Trimble RealWorks User Guide | 30



Contents

14.2.2.2.5 Select No Projection 473

14.2.2.3 Preview the Mesh 473

14.2.2.4 Create a Mesh 474

14.2.3 Mesh Editing 474

14.2.3.1 Open the Tool 474

14.2.3.2 Simplify a Mesh 474

Add Triangles 476

14.2.3.3 Fill Holes 476

14.2.3.4 Select Elements 477

14.2.3.4.1 Pick an Element 477

14.2.3.4.2 Pick a Vertex 478

14.2.3.4.3 Pick an Edge 478

14.2.3.4.4 Pick a Triangle 478

14.2.3.5 Select an Area 478

14.2.3.6 Edit a Mesh 479

14.2.3.6.1 Smooth a Mesh 479

14.2.3.6.2 Refine a Mesh 480

14.2.3.6.3 Remove Peaks 480

14.2.3.6.4 Reverse Triangles 480

14.2.3.6.5 Delete an Element 480

14.2.3.6.6 Extract to a New Mesh 480

14.2.3.6.7 Enhance With Break Lines Using Polyline(s) 480

14.2.3.6.8 Flip an Edge 481

14.2.3.7 MapWith a Texture 481

14.2.3.7.1 Apply a New Texture 481

14.2.3.7.2 Remove an Existing Texture 483

14.2.3.7.3 Overwrite an Existing Texture 483

14.2.3.8 Apply the Operation 483

Trimble RealWorks User Guide | 31



Contents

14.2.4 Merge Meshes 483

14.2.5 Move Mesh 484

14.2.5.1 Pan a Mesh 484

14.2.5.2 Rotate a Mesh 485

14.2.5.3 Change the Manipulator Location 486

14.2.6 Convert to Mesh 486

14.2.7 Volume Calculation 486

14.2.7.1 Open the Tool 486

14.2.7.2 Define a Plane 487

14.2.7.2.1 Define the Normal Direction 487

14.2.7.2.1.1 Select a Frame Axis 487

14.2.7.2.1.2 Fit With a Geometry 488

14.2.7.2.1.3 Pick an Object Local Frame 488

14.2.7.2.1.4 Pick Two Points 489

14.2.7.2.1.5 Pick Three Points 489

14.2.7.2.1.6 Edit Parameters 489

14.2.7.2.1.7 Plane Parallel to the Screen View 490

14.2.7.2.2 Define a Position 490

14.2.7.2.3 Define an Offset Value 490

14.2.7.3 Defining a Grid Resolution 490

14.2.7.4 Preview a Volume 491

14.2.7.4.1 Check a Volume to Keep 492

14.2.7.4.2 Save a Volume in a Report 492

14.2.7.5 Edit a Volume 493

14.2.7.5.1 Filter From an Elevation Range 493

14.2.7.5.2 Fence an Area 493

14.2.7.5.3 Fill Holes 494

14.2.7.5.4 Smooth Cells 494

Trimble RealWorks User Guide | 32



Contents

14.2.7.6 Save a Volume in the Database 495

14.3 INSPECTION TOOLS 495

14.3.1 Alignment Stationing 496

14.3.1.1 Open the Tool 496

14.3.1.2 Define Settings 497

14.3.1.3 Define Positions 498

14.3.2 Inspect Twin Surfaces 499

14.3.2.1 Open the Tool 499

14.3.2.2 Define a Projection Surface 499

14.3.2.2.1 Plane-Based Projection 499

14.3.2.2.2 Cylinder-Based Projection 500

14.3.2.2.2.1 Set From Frame 501

14.3.2.2.2.2 Draw a Circle 501

14.3.2.2.2.3 Draw a Cylinder 501

14.3.2.2.2.4 Pick an Axis from an Object 501

14.3.2.2.2.5 Edit Parameters 502

14.3.2.2.3 Tunnel-Based Projection 502

14.3.2.3 Determine a Resolution 504

14.3.2.4 Preview an Inspection 505

14.3.2.5 Avoid the Filling of Holes on an Inspection Map 507

14.3.2.6 Print an Inspection Map 508

14.3.2.7 Edit an Inspection Map 508

14.3.2.8 Filter the Inspection Result 509

14.3.2.9 Check the Inspection 510

14.3.2.10 Save the Inspection 510

14.3.3 Surface to Model Inspection 510

14.3.3.1 Open the Tool 510

14.3.3.2 Define a Projection 511

Trimble RealWorks User Guide | 33



Contents

14.3.3.2.1 Plane-Based Projection 511

14.3.3.2.2 Cylinder-Based Projection 511

14.3.3.2.3 Tunnel-Based Projection 511

14.3.3.3 Determine a Resolution 513

14.3.3.4 Preview an Inspection 514

14.3.3.4.1 Plane Shape 515

14.3.3.4.2 Cylinder Shape 515

14.3.3.4.3 Tunnel Shape 516

14.3.3.5 Avoid the Filling of Holes on an Inspection Map 517

14.3.3.6 Create & View a Colored Map 518

14.3.3.7 Print an Inspection Map 519

14.3.3.8 Edit an Inspection Map 519

14.3.3.9 Check the Inspection 519

14.3.3.10 Save the Inspection 520

14.3.4 Inspection Map Analyzer 520

14.3.4.1 Open the Tool 520

14.3.4.2 Select "Points & Polylines" 521

14.3.4.2.1 Pick Points 522

14.3.4.2.2 Draw Polylines 523

14.3.4.2.3 Save the Results 524

14.3.4.3 Select "Sections & Shifts" 525

14.3.4.3.1 Define a Section Position 525

14.3.4.3.2 Choose a Type of Object to Extract 527

14.3.4.3.3 Navigate Through the Sections 528

14.3.4.3.4 View the Difference Plot 530

14.3.4.3.4.1 Print a Plot 531

14.3.4.3.4.2 Scale a Plot 531

14.3.4.3.4.3 Swap the Axes 532

Trimble RealWorks User Guide | 34



Contents

14.3.4.3.5 Export Sections 532

14.3.4.3.5.1 Horizontal Slices from a Plane Inspection 532

14.3.4.3.5.2 Vertical Slices from a Plane Inspection 533

14.3.4.3.5.3 Horizontal Slices from a Cylinder Inspection 534

14.3.4.3.5.4 Vertical Slices from a Cylinder Inspection 535

14.3.4.3.5.5 Horizontal Slices from a Tunnel Inspection 536

14.3.4.3.5.6 Vertical Slices from a Tunnel Inspection 536

14.3.4.3.6 Create a Set of Sections and 1D Inspection 537

14.3.4.3.7 Create a Multitude of Sets of Sections and 1D Inspection 537

14.3.4.4 Select "Volumes & Surfaces" 538

14.3.4.4.1 Fence an Area 539

14.3.4.4.2 Pick a Color 541

14.3.4.4.3 Define a Color Range 543

14.3.4.4.4 Use the Surface Values 544

14.3.4.4.5 Filter the Altitudes 545

14.3.4.4.6 Report the Volume and Surface Information 545

14.3.4.5 Select "Iso-Curves" 546

14.3.4.5.1 Extract Iso-Curves 546

14.3.4.5.2 Browse Iso-Curves 547

14.3.4.5.3 Define Principal Iso-Curves 547

14.3.4.5.4 Create Iso-Curves 548

14.3.4.6 Select "Colored Meshes" 548

14.3.4.6.1 Extract Colored Meshes 548

14.3.4.6.2 Create Colored Meshes 549

14.3.4.7 Print Inspection Maps 549

14.3.5 Floor Inspection 550

14.3.5.1 Open the Tool 550

14.3.5.2 Edit the Selected Point Cloud 550

Trimble RealWorks User Guide | 35



Contents

14.3.5.3 Define an Inspection Area 550

14.3.5.4 Define an Inspection Grid 551

14.3.5.5 Define a Reference Plane 553

14.3.5.6 Generate an Inspection 553

14.3.5.7 Generate a Report 555

14.3.5.8 Save the Inspection Result 556

14.3.6 FF/FL Analysis (ASTM E1155) 556

14.3.6.1 Open the Tool 556

14.3.6.2 Define a Test Section 557

14.3.6.3 Create and Edit Samples 558

14.3.6.3.1 Create Samples 558

14.3.6.3.2 Delete Samples 559

14.3.6.4 Create a Report 559

14.3.6.5 Close the Tool 560

14.3.7 Wall Verticality Inspection 560

14.3.8 3D Inspection 564

14.3.8.1 Open the Tool 564

14.3.8.2 Compute an 3D Inspection Cloud 565

14.3.8.3 Create an 3D Inspection Cloud 566

14.3.9 Analyze a 3D Inspection Cloud 566

14.3.9.1 Open the Tool 566

14.3.9.2 Extract Clouds From 3D Inspection Clouds 567

14.3.9.3 Create the Extracted Cloud(s) 568

14.3.10 2D-Polyline Inspection 568

14.3.10.1 Open the Tool 568

14.3.10.2 Select a Model for Inspection 569

14.3.10.3 Set a Thickness 569

14.3.10.4 View the 2D Inspection Result 569

Trimble RealWorks User Guide | 36



Contents

14.3.10.5 Filter the 2D Inspection Result 570

14.3.10.6 Save the 2D Inspection Result 571

14.3.11 Annotate 571

14.4 IMAGING TOOLS 571

14.4.1 Convert to Ortho-Image 572

14.4.2 Ortho-Projection 575

14.4.2.1 Open the Tool 576

14.4.2.2 Define a Projection Plane 576

14.4.2.2.1 Pick Three Points 576

14.4.2.2.2 Use the Current Camera View 577

14.4.2.2.3 Set the Corners 577

14.4.2.2.4 Set (or Edit) the Parameters 577

14.4.2.3 Modify a Projection Plane 578

14.4.2.3.1 Define the Horizontal 579

14.4.2.3.2 Set a Position 579

14.4.2.3.3 Change the Dimensions 580

14.4.2.4 Check a Projection Plane 581

14.4.2.4.1 View from a Projection Plane' Side 581

14.4.2.4.2 Rotate 90° Around Vertical Axis 582

14.4.2.4.3 Edit Parameters 582

14.4.2.5 Define a Zone of Interest 582

14.4.2.5.1 Draw a Zone of Interest 583

14.4.2.5.2 Resize a Zone of Interest 583

14.4.2.5.3 Rotate Counterclockwise 90° 583

14.4.2.6 Set a Resolution 584

14.4.2.7 Choose a Rendering Option 584

14.4.2.8 Preview an Ortho-Image 585

14.4.2.9 Print an Ortho-Image 585

Trimble RealWorks User Guide | 37



Contents

14.4.2.10 Split an Ortho-Image 586

14.4.2.11 Create an Ortho-Image 586

14.4.3 Multi Ortho-Projection 586

14.4.3.1 Open the Tool 586

14.4.3.2 Define a Polyline 587

14.4.3.2.1 Select a Polyline 587

14.4.3.2.2 Draw a Polyline 587

14.4.3.3 Define a Zone of Interest 588

14.4.3.3.1 Top Align all Planes 589

14.4.3.3.2 Bottom Align all Planes 589

14.4.3.3.3 Edit Planes 589

14.4.3.3.4 Hide/Display the Input 590

14.4.3.4 Define the Image Parameters 590

14.4.3.4.1 Set a Resolution 590

14.4.3.4.2 Set a Density 591

14.4.3.4.3 Choose a Rendering Option 591

14.4.3.4.4 Define the Depth Parameter 591

14.4.3.5 Preview a Single Ortho-Image 591

14.4.3.5.1 Select a Projection Plane 592

14.4.3.5.2 View from a Projection Plane' Side 593

14.4.3.5.3 Print an Ortho-Image 593

14.4.3.6 Create Ortho-Images 593

14.4.3.6.1 Create a Single Ortho-Image 594

14.4.3.6.2 Create all Ortho-Images 594

14.4.4 Create Rectified Images 594

14.4.4.1 Open the Tool 594

14.4.4.2 Choose a Station 594

14.4.4.3 Filter the Images 595

Trimble RealWorks User Guide | 38



Contents

14.4.4.4 Define a Projection Plane 596

14.4.4.4.1 Define a Plane in the Station-Based Mode 596

14.4.4.4.1.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction)
and One 3D Points 596

14.4.4.4.1.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction)
and One 3D Point 597

14.4.4.4.1.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope
Directions) and One 3D Points 598

14.4.4.4.2 Define a 3D plane in the Examiner WalkThrough 600

14.4.4.4.3 Load Existing Rectified Image Parameters 600

14.4.4.4.4 Modify a Projection Plane's Size 601

14.4.4.4.5 Modify the Position of the Projection Plane 602

14.4.4.5 Define a Zone of Interest 602

14.4.4.5.1 Draw a Zone of Interest 602

14.4.4.5.2 Modify a Zone of Interest 603

14.4.4.6 Set an Image Resolution 604

14.4.4.7 Preview a Rectified Image 604

14.4.4.7.1 Perform a 2D-Distance Measurement 605

14.4.4.7.2 Print a Rectified Image 605

14.4.4.8 Split a Rectified Image 605

14.4.4.9 Create a Rectified Image 606

14.4.5 Move Ortho-Image 606

14.4.5.1 Move Perpendicular to the Ortho-Image 606

14.4.5.2 Move Perpendicular to the Ortho-Image by Picking 607

14.4.5.3 Pan in the Plane of the Ortho-Image 607

14.4.5.4 Rotate in the Plane of the Ortho-Image 608

14.4.5.5 Move in the Ortho-Image Plane by Picking 609

14.4.6 Match with an Image 610

14.4.6.1 Open the Tool 610

Trimble RealWorks User Guide | 39



Contents

14.4.6.2 Select an Image 611

14.4.6.2.1 Hide (or Show) a Thumbnail 611

14.4.6.2.2 Maximize (or Minimize) a Thumbnail 611

14.4.6.2.3 Extend (or Stretch) a Thumbnail 611

14.4.6.2.4 Move a Thumbnail 611

14.4.6.3 Select Markers 612

14.4.6.3.1 Pick Markers 612

14.4.6.3.1.1 Pick a Pair of Points 612

14.4.6.3.1.2 Pick a Pair of Lines 613

14.4.6.3.2 Load Markers 614

14.4.6.4 Modify Markers 614

14.4.6.4.1 Move a Point (or Line) 615

14.4.6.4.2 Delete a Point (or Line) 615

14.4.6.4.3 Reset all Points (or Lines) 616

14.4.6.4.4 Reorder Points (or Lines) 616

14.4.6.5 Save Markers 617

14.4.6.6 Match an Image 617

14.4.6.6.1 Preview 617

14.4.6.6.2 Improve 618

14.4.6.6.3 Adjust 618

14.4.6.6.3.1 Constrain to one Pair of Markers 618

14.4.6.6.3.2 Constrain to Two Pairs of Markers 618

14.4.6.6.4 Project 619

14.4.6.7 Color Points 619

14.4.6.8 Apply the Matching 619

14.4.7 Go to a Shooting Position 619

14.5 MODEL TOOLS 620

14.5.1 Cloud-Based Modeler 620

Trimble RealWorks User Guide | 40



Contents

14.5.1.1 Open the Tool 620

14.5.1.2 Select a New Cloud Data 621

14.5.1.3 Define a Set of Points on the Cloud Data 622

14.5.1.4 Choose a Geometry Type 623

14.5.1.5 Use Constraints 623

14.5.1.5.1 Plane 623

14.5.1.5.1.1 Make Parallel 624

14.5.1.5.1.2 Make Perpendicular 625

14.5.1.5.1.3 Pass Through a Point 625

14.5.1.5.2 Sphere 625

14.5.1.5.2.1 Lock a Radius 626

14.5.1.5.2.2 Lock a Center 626

14.5.1.5.2.3 Lock a Center on a Line 626

14.5.1.5.3 Cylinder 627

14.5.1.5.3.1 Make Parallel 628

14.5.1.5.3.2 Make Perpendicular 628

14.5.1.5.3.3 Pass an Axis Through a Point 628

14.5.1.5.3.4 Lock a Radius 628

14.5.1.5.3.5 Fix to an Axis 629

14.5.1.5.3.6 Make Secant to a Cylinder 629

14.5.1.5.4 Regular Cone 630

14.5.1.5.4.1 Make Parallel 631

14.5.1.5.4.2 Make Perpendicular 631

14.5.1.5.4.3 Fix to an Axis 631

14.5.1.5.5 Circular Torus 631

14.5.1.5.5.1 Make Perpendicular to a Direction 632

14.5.1.5.5.2 Make Parallel to a Plane 633

14.5.1.5.5.3 Lock a Center Line Radius 633

Trimble RealWorks User Guide | 41



Contents

14.5.1.5.5.4 Lock a Pipe Radius 633

14.5.1.5.5.5 Align to Join to two Secant Cylinders of Same Radius 633

14.5.1.5.6 3D Point 634

14.5.1.5.6.1 Lock on a Plane 635

14.5.1.5.6.2 Lock to Line (or Axis) 635

14.5.1.5.7 Circular Arc 635

14.5.1.5.7.1 Lock on a Plane 636

14.5.1.5.7.2 Make Parallel to a Plane 636

14.5.1.5.7.3 Make Perpendicular to a Direction 636

14.5.1.5.8 Segment 636

14.5.1.5.8.1 Make Parallel 637

14.5.1.5.8.2 Make Perpendicular 638

14.5.1.5.8.3 Pass an Axis Through a Point 638

14.5.1.5.9 Extrusion 638

14.5.1.5.9.1 Define a Polyline 639

14.5.1.5.9.2 Make Parallel to a Direction 640

14.5.1.5.9.3 Make Perpendicular to a Plane 641

14.5.1.5.10 Rectangular Torus 641

14.5.1.5.10.1 Align to Join to Two Existing Secant Boxes of Same Section 642

14.5.1.5.11 Box 643

14.5.1.5.11.1 Define the Vector X Direction 645

14.5.1.5.11.2 Define the Normal Z Direction 645

14.5.1.5.11.3 Make Secant to a Box (With Same Section) 645

14.5.1.6 Calculate a Geometry 645

14.5.1.7 Create a Geometry 646

14.5.2 Geometry Creator 646

14.5.2.1 Open the Tool 646

14.5.2.2 Define a Plane 647

Trimble RealWorks User Guide | 42



Contents

14.5.2.2.1 Define a Plane in all Navigation Modes 647

14.5.2.2.2 Define a Plane in the Station-Based Mode 648

14.5.2.2.2.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction)
and One 3D Points 648

14.5.2.2.2.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction)
and One 3D Point 650

14.5.2.2.2.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope
Directions) and One 3D Points 651

14.5.2.2.3 Edit Parameters 652

14.5.2.3 Define a Sphere 652

14.5.2.3.1 Pick Two Points 653

14.5.2.3.2 Edit Parameters 653

14.5.2.4 Define a Cylinder 653

14.5.2.4.1 Pick Three Points 653

14.5.2.4.2 Edit Parameters 654

14.5.2.5 Define a Regular Cone 654

14.5.2.5.1 Pick Three Points 654

14.5.2.5.2 Edit Parameters 654

14.5.2.6 Define a Circular Torus 655

14.5.2.6.1 Pick Two Points 655

14.5.2.6.2 Align to Joint to an Existing Cylinder 655

14.5.2.6.3 Align to Join to two Secant Cylinders of Same Radius 655

14.5.2.6.4 Edit Parameters 656

14.5.2.7 Define a Box 656

14.5.2.7.1 Pick an Entity With a Direction 657

14.5.2.7.2 Project a Box in a Plane 658

14.5.2.7.3 Pick the Bottom Left Corner of a Box 659

14.5.2.7.4 Pick Four Screen Points 659

14.5.2.7.5 Define a Horizontal Face By Picking One 3D Point, Then Four Screen Points (Two
Horizontal Directions and Depth) 661

Trimble RealWorks User Guide | 43



Contents

14.5.2.7.6 Define a Vertical Face By Picking One 3D Point, Then Four Screen Points (Hori-
zontal Direction, Vertical Direction and Depth) 663

14.5.2.7.7 Edit Parameters 664

14.5.2.8 Define a Rectangular Torus 665

14.5.2.8.1 Align to Join to Two Existing Secant Boxes of Same Section 665

14.5.2.8.2 Edit Parameters 666

14.5.2.9 Define an Extruded Entity 666

14.5.2.9.1 Create an Extrusion With Holes 667

14.5.2.10 Define a 3D Point 668

14.5.2.10.1 Pick a Point 668

14.5.2.10.2 Pick Three Planes 668

14.5.2.10.3 Pick a Plane and a Segment 670

14.5.2.10.4 Pick an Entity with Center 671

14.5.2.10.5 Project a 3D Point on a Plane 671

14.5.2.10.6 Pick Two Axial Entities 672

14.5.2.10.7 Edit Parameters 673

14.5.2.11 Define a Segment 673

14.5.2.11.1 Pick Two Points 673

14.5.2.11.2 Pick Two Planes 673

14.5.2.11.3 Pick an Axial Geometry 674

14.5.2.11.4 Edit Parameters 675

14.5.3 Sub-Tools 675

14.5.3.1 3D Picking 675

14.5.3.1.1 Pick an Entity with Direction 676

14.5.3.2 3D Direction 676

14.5.3.2.1 Define a 3D Direction Using Precise Methods 677

14.5.3.2.2 Define a 3D Direction Using Visual Methods 678

14.5.3.2.3 Validate a 3D Direction 679

Trimble RealWorks User Guide | 44



Contents

14.5.3.3 3D Point 679

14.5.3.3.1 Pick a Point 680

14.5.3.3.2 Pick Three Planes 680

14.5.3.3.3 Pick a Plane and a Segment 681

14.5.3.3.4 Pick an Entity with Center 682

14.5.3.3.5 Project a 3D Point on a Plane 683

14.5.3.3.6 Edit Parameters 684

14.5.3.3.7 Validate a 3D Point 684

14.5.3.4 3D Axis 684

14.5.3.4.1 Pick an Axial Entity 684

14.5.3.4.2 Pick Two Points 685

14.5.3.4.3 Pick Two Planes 685

14.5.3.4.4 Edit Parameters 685

14.5.3.4.5 Validate an 3D Axis 686

14.5.3.5 3D Radius 686

14.5.3.5.1 Edit Parameters 686

14.5.3.5.2 Pick a Radial Entity 687

14.5.3.5.3 Pick Two Points of a Diameter 687

14.5.3.5.4 Pick Two Points of a Radius 687

14.5.3.5.5 Pick an Axis and a Point 687

14.5.3.6 3D Secant 688

14.5.3.6.1 Make Secant to a Cylinder 689

14.5.3.6.2 Make Secant to a Cylinder With a Radius Constraint 689

14.5.3.6.3 Make Secant to a Cylinder With an Angle Constraint 689

14.5.3.6.4 Make Secant to a Cylinder With the Angle and Radius Constraints 689

14.5.3.7 3D Plane 690

14.5.3.7.1 Define a 3D Plane in the Examiner (or WalkThrough) 690

14.5.3.7.2 Define a 3D Plane in the Station-Based Mode 691

Trimble RealWorks User Guide | 45



Contents

14.5.3.7.2.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction)
and One 3D Points 692

14.5.3.7.2.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction)
and One 3D Point 693

14.5.3.7.2.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope
Directions) and One 3D Points 694

14.5.3.7.3 Modify the Size of a Plane 696

14.5.3.7.4 Validate a Plane 696

14.5.4 Modify Geometry 696

14.5.4.1 Open the Tool 696

14.5.4.2 Modify a Shape 696

14.5.4.2.1 Sphere 697

14.5.4.2.2 Cylinder 698

14.5.4.2.3 Cone 699

14.5.4.2.4 Circular Torus 700

14.5.4.2.5 Segment 701

14.5.4.2.6 Extrusion 701

14.5.4.2.7 Box 702

14.5.4.2.8 Rectangular Torus 703

14.5.4.3 Extend a Geometry by Snapping 704

14.5.4.4 Modify a Position 704

14.5.4.4.1 Pan Along the Home Frame Axes 704

14.5.4.4.2 Pan Along its Own Axes 706

14.5.4.4.3 Rotate a Geometry 707

14.5.4.4.3.1 Use the Manipulator 708

14.5.4.4.3.2 Enter Manually an Angle 708

14.5.4.4.4 Change the Manipulator Location 710

14.5.4.5 Switch from one Manipulation Mode to Another 710

14.5.4.6 Move a Geometry by Picking a Geometry 710

Trimble RealWorks User Guide | 46



Contents

14.5.4.6.1 Pick an Axis from Other Geometry, then Pan 711

14.5.4.6.2 Pick an Axis from Other Geometry, then Rotate 712

14.5.4.6.3 Pick a Point from Other Geometry, then Rotate 713

14.5.4.6.4 Pick a Plane, and then Pan 714

14.5.4.6.4.1 Pick and Pan a Plane 714

14.5.4.6.4.2 Pick a Plane and Select Another Object 715

14.5.4.6.4.3 Pick and Select a Plane 717

14.5.4.6.4.4 Picking a plane and selecting another object. 718

14.5.4.7 Move an Entity Along a User Defined Vector 719

14.5.4.8 Apply Constraints 721

14.5.4.8.1 Plane 721

14.5.4.8.1.1 Make Vertical 722

14.5.4.8.1.2 Make Horizontal 722

14.5.4.8.1.3 Make Parallel 722

14.5.4.8.1.4 Make Perpendicular 722

14.5.4.8.1.5 Pass Through a Point 723

14.5.4.8.1.6 Pass Through an Axis 723

14.5.4.8.2 Sphere 723

14.5.4.8.3 Cylinder 724

14.5.4.8.3.1 Make Vertical 724

14.5.4.8.3.2 Make Parallel 724

14.5.4.8.3.3 Make Perpendicular 725

14.5.4.8.3.4 Pass an Axis Through a Point 725

14.5.4.8.3.5 Lock a Radius 725

14.5.4.8.3.6 Fix to an Axis 725

14.5.4.8.3.7 Make Secant to a Cylinder 726

14.5.4.8.4 Regular Cone 726

14.5.4.8.4.1 Make Vertical 727

Trimble RealWorks User Guide | 47



Contents

14.5.4.8.4.2 Make Parallel 727

14.5.4.8.4.3 Make Perpendicular 727

14.5.4.8.4.4 Fix to an Axis 728

14.5.4.8.5 Circular Torus 728

14.5.4.8.6 3D Point 731

14.5.4.8.7 Segment 732

14.5.4.8.7.1 Make Vertical 732

14.5.4.8.7.2 Lock on a Plane 732

14.5.4.8.7.3 Make Parallel 732

14.5.4.8.7.4 Make Perpendicular 733

14.5.4.8.7.5 Pass an Axis Through a Point 733

14.5.4.8.8 Extrusion 733

14.5.4.8.8.1 Make Vertical 733

14.5.4.8.8.2 Make Secant to an Extrusion 734

14.5.4.8.9 Rectangular Torus 734

14.5.4.8.9.1 Align to Join to Two Existing Secant Boxes of Same Section 734

14.5.4.8.10 Box 735

14.5.4.8.10.1 Making Parallel to a Direction 736

14.5.4.8.10.2 Project a Box in a Plane 736

14.5.4.8.10.3 Making Secant to a Box (With Same Section) 737

14.5.4.8.10.4 Change the Direction of the Main Axis 737

14.5.5 Plane Bounding 737

14.5.5.1 Open the Tool 738

14.5.5.2 Modify the Selected Plane Bounds 738

14.5.5.3 Select an Existing Polyline for Bounding 739

14.5.5.4 Draw a New Polyline for Bounding 739

14.5.5.4.1 Draw a Polygonal Polyline 739

14.5.5.4.2 Draw a Rectangular Polyline 740

Trimble RealWorks User Guide | 48



Contents

14.5.5.4.3 Draw a Circular Polyline 741

14.5.5.5 Edit a Bounding Polyline 742

14.5.5.5.1 Delete a Node 742

14.5.5.5.2 Move a Node 743

14.5.5.5.3 Insert a Middle Node 744

14.5.5.6 Delete a Bounding Polyline 745

14.5.5.7 Activate/Deactivate the Selection Mode 745

14.5.5.8 Move a Bounding Polyline 745

14.5.5.9 Apply the Bounds 746

14.5.5.10 Validate the Bounds 747

14.5.6 Intersect Entities 747

14.5.6.1 Open the Tool 748

14.5.6.2 Extend to One Other Geometry 748

14.5.6.2.1 Cylinder 749

14.5.6.2.2 Sphere 750

14.5.6.2.3 Plane 750

14.5.6.2.4 Cone 752

14.5.6.2.5 Circular Torus 752

14.5.6.2.6 Box 752

14.5.6.2.7 Rectangular Torus 753

14.5.6.2.8 Extrusion 753

14.5.6.2.9 3D Point 753

14.5.6.2.10 Line 753

14.5.6.3 Extend Between two Other Geometries 753

14.5.6.3.1 Cylinder 753

14.5.6.3.2 Sphere 753

14.5.6.3.3 Plane 753

14.5.6.3.4 Cone 753

Trimble RealWorks User Guide | 49



Contents

14.5.6.3.5 Circular Torus 753

14.5.6.3.6 Box 753

14.5.6.3.7 Rectangular Torus 754

14.5.6.3.8 Extrusion 754

14.5.6.3.9 3D Point 754

14.5.6.3.10 Line 754

14.5.6.4 Connect a Series of Entities 754

14.5.6.5 Connect a Series of Planes 754

14.5.6.6 Connect Cylinders 756

14.5.6.7 Switch to Other Side 757

14.5.7 Duplicate 758

14.5.7.1 Open the Tool 758

14.5.7.2 Choose a Method 758

14.5.7.2.1 Define a Line 758

14.5.7.2.1.1 Draw a Line by Defining Two Points 759

14.5.7.2.1.2 Define a 3D Direction 760

14.5.7.2.2 Define a Circle 761

14.5.7.2.2.1 Draw a Circle by Defining its Center 761

14.5.7.2.2.2 Define a 3D Axis 762

14.5.7.2.3 Define a Polyline 763

14.5.7.2.3.1 Select a Polyline 764

14.5.7.2.3.2 Creating a Polyline 764

14.5.7.3 Resize a Path 765

14.5.7.4 Define Parameters 765

14.5.7.4.1 "Step & Quantity" Parameters 766

14.5.7.4.2 "Step & Length" Parameters 766

14.5.7.4.3 Length & Quantity 766

14.5.7.5 Reverse the Path Direction 767

Trimble RealWorks User Guide | 50



Contents

14.5.7.6 Duplicate Items 767

14.5.8 Auto-Extract Cylinders 767

14.5.9 Geometry Visual Check 769

14.5.9.1 Open the Tool 769

14.5.9.2 Check Visually a Geometry 769

14.5.9.3 Edit a Geometry 770

14.6 PLANT TOOLS 770

14.6.1 Create Pipe 771

14.6.2 Convert Geometries to Pipe Group 777

14.6.3 EasyPipe 778

14.6.3.1 Open the Tool 778

14.6.3.2 Select a New Cloud Data 778

14.6.3.3 Define a Set of Points on the Cloud Data 779

14.6.3.4 Extract an Initial Cylinder by Picking 780

14.6.3.5 Select an Initial Cylinder for Tracking 781

14.6.3.6 Start Tracking Cylinders 782

14.6.3.7 Continue Tracking Cylinders 783

14.6.3.8 Delete the Extracted Cylinders 783

14.6.3.9 Smooth the Extracted Cylinders 784

14.6.3.10 Model the Extracted Cylinders 784

14.6.3.11 Create the Extracted Cylinders 785

14.6.4 Export Pipe Center Lines 785

14.6.4.1 Export as a DWG Format File 785

14.6.4.2 Export as a DXF Format File 786

14.6.4.3 Export as a DGN Format File 786

14.6.5 Change Pipe Diameter 787

14.6.6 Import & Remove SteelWorks Catalogs 787

14.6.7 SteelWorks Creator 788

Trimble RealWorks User Guide | 51



Contents

14.6.7.1 Open the Tool 788

14.6.7.2 Select a New Cloud Data 788

14.6.7.3 Define a Set of Points on the Cloud Data 788

14.6.7.4 Import a SteelWorks Catalog 789

14.6.7.5 Manual Extraction Method 789

14.6.7.6 Automatic Extraction Method 790

14.6.7.7 Optimize the Fitting 790

14.6.7.8 Create Beams 791

14.6.8 Ladder 791

14.6.8.1 Open the Tool 791

14.6.8.2 Select a New Cloud Data 791

14.6.8.3 Define a Set of Points on the Cloud Data 792

14.6.8.4 Select a Ladder Model 793

14.6.8.5 Edit Parameters 793

14.6.8.6 Create a New Ladder Model 795

14.6.8.7 Lock the Ladder Top View in 2D 795

14.6.8.8 Draw a 2D Section 797

14.6.8.9 Define the Ladder Length and Start Height 798

14.6.8.10 Create a Ladder 800

14.6.9 Ladder Cage 800

14.6.9.1 Open the Tool 800

14.6.9.2 Define Hoops 801

14.6.9.3 Add Additional Hoops 802

14.6.9.4 Edit the Active Hoop 803

14.6.9.4.1 Set a Hoop as Active 803

14.6.9.4.2 Delete the Active Hoop 803

14.6.9.4.3 Choose the Shape of the Active Hoop 803

14.6.9.4.4 Change the Radius and Dimension Parameters 803

Trimble RealWorks User Guide | 52



Contents

14.6.9.4.5 Define the Shape of the Active Hoop 804

14.6.9.5 Edit Several Hoops 804

14.6.9.6 Define the Vertical Straps 804

14.6.9.6.1 Configure the Number of Straps 805

14.6.9.7 Create Ladder Cages 805

14.6.10 Railing 806

14.6.10.1 Open the Tool 806

14.6.10.2 Select a New Cloud Data 806

14.6.10.3 Define a Set of Points on the Cloud Data 807

14.6.10.4 Select a Path 808

14.6.10.5 Draw a Path 808

14.6.10.6 Select a Model 809

14.6.10.7 Edit Parameters 809

14.6.10.7.1 Configuration 809

14.6.10.7.2 Profiles 810

14.6.10.7.3 Heights 811

14.6.10.7.4 Loop End (Dimension) & End Type 812

14.6.10.8 Define Posts Along the Path 813

14.6.10.8.1 Define the Start and End Positions 814

14.6.10.8.2 Pick the Start and End Positions 814

14.6.10.8.3 Add Extra Posts 814

14.6.10.8.4 Remove Undesirable Posts 814

14.6.10.9 Create a NewModel 814

14.6.10.10 Create the Railings 814

14.6.11 Stairs 814

14.6.11.1 Open the Tool 815

14.6.11.2 Select a Stair Model 815

14.6.11.3 Edit Parameters 815

Trimble RealWorks User Guide | 53



Contents

14.6.11.4 Create a NewModel 816

14.6.11.5 Define the Landings 817

14.6.11.6 Draw a 2D Section 817

14.6.11.7 Create Stairs 817

14.6.12 Auto-Segment Steel Beams 818

14.6.13 Auto-Segment Moving Objects 818

14.7 STORAGE TANK TOOLS 818

14.7.1 Vertical Tank Calibration 819

14.7.1.1 Open the Tool 819

14.7.1.2 Define the Dipping Plate 819

14.7.1.3 Define the Parameters of the Body 822

14.7.1.4 Define the Parameters of the Sump 823

14.7.1.5 Define the Thickness for Outside Scans 823

14.7.1.6 Preview the Results 823

14.7.1.7 Create the Results 824

14.7.1.8 Export the Results 825

14.7.2 Horizontal Tank Calibration 825

14.7.2.1 Open the Tool 825

14.7.2.2 Define the Dipping Plate 826

14.7.2.3 Define the Body Parameters 827

14.7.2.4 Define the Parameters of the Sump 827

14.7.2.5 Define the Thickness for Outside Scans 827

14.7.2.6 Preview the Results 827

14.7.2.7 Create the Results 828

14.7.2.8 Export the Results 828

14.7.3 Tank Calibration Check 828

14.7.3.1 Open the Tool 829

14.7.3.2 Filter all Sections 829

Trimble RealWorks User Guide | 54



Contents

14.7.3.3 Select a Section to Edit 829

14.7.3.4 Edit a Section 830

14.7.3.5 Apply the Modifications 831

14.7.4 Tank Setup 831

14.7.4.1 Open the Tool 831

14.7.4.2 Define the Parameters 832

14.7.4.3 Classify Automatically a Tank 832

14.7.4.4 Classify Manually a Tank 833

14.7.4.5 Check and Refine the Classification 834

14.7.4.6 Create a Tank Object 834

14.7.5 Measure Tank 835

14.7.5.1 Open the Tool 835

14.7.5.2 Measure a Distance on the Shell 835

14.7.5.3 Reverse a Distance Measurement 836

14.7.5.4 Create the Measured Value 837

14.7.6 Vertical Tank Inspection 837

14.7.6.1 Open the Tool 838

14.7.6.2 Define a Reference for the Verticality 838

14.7.6.3 Define the Inspection Stations 839

14.7.6.3.1 Define the Initial Station 840

14.7.6.3.2 Define the Rest of the Stations 840

14.7.6.3.3 Shift a Station 841

14.7.6.3.4 Set the Orientation and Numbering Conventions 842

14.7.6.4 Evaluate the Shell of a Tank 843

14.7.6.4.1 Define Courses 843

14.7.6.4.1.1 Pick Welds 843

14.7.6.4.1.2 RemoveWelds 845

14.7.6.4.1.3 Shift a Weld 846

Trimble RealWorks User Guide | 55



Contents

14.7.6.4.2 Define the Shell Measurement Rules 847

14.7.6.4.2.1 Define Measurement Rules Spaced at Regular Distance Between TwoWelds 848

14.7.6.4.2.2 Define a Unique (or a Series of) Measurement Rule(s) Above the BottomWeld
of a Course 848

14.7.6.4.2.3 Define a Unique (or a Series of) Measurement Rule(s) Below the TopWeld of a
Course 849

14.7.6.4.3 Apply the Grid and Compute the Inspection 850

14.7.6.5 Evaluate the Bottom of a Tank 850

14.7.6.5.1 Generate a Preview of the Inspection Map 851

14.7.6.5.2 Change the Rendering of the Inspection Map 853

14.7.6.5.3 Edit Radial Measurements 853

14.7.6.5.4 Edit the Bottom Measurement Rules 854

14.7.6.5.5 Apply the Rules and Compute the Inspection 855

14.7.6.6 Check the Verticality of a Tank 855

14.7.6.6.1 Filter Sections 855

14.7.6.6.2 Analyze the Verticality from one Station Line 856

14.7.6.7 Check the Roundness of a Tank 857

14.7.6.7.1 Filter all Sections 858

14.7.6.7.2 Analyze the Roundness from One Measurement Rule Line 859

14.7.6.8 Create a Report 860

14.7.6.8.1 Report Content 861

14.7.6.8.2 Bottom Reference 861

14.7.6.8.3 Criteria for Verticality 864

14.7.6.8.4 Criteria for Roundness 864

14.7.6.8.5 Criteria for Shell Settlement 865

14.7.6.8.6 Conventions 865

14.7.6.9 Save the Inspection Results 865

14.7.7 Tank Secondary Containment 866

14.7.7.1 Open the Tool 866

Trimble RealWorks User Guide | 56



Contents

14.7.7.2 Define an Area 866

14.7.7.3 Compute the Containment Volume 866

14.7.7.4 Generate a Report 867

14.7.7.5 Create 868

14.7.8 Locate Table 868

MEDIA TOOLS 869

15.1 Video Creator 869

15.1.1 Open the Tool 869

15.1.2 Define a Navigation Path 869

15.1.2.1 Quick Mode 869

15.1.2.1.1 View Inwards/Outwards 870

15.1.2.1.2 Move the Circular Path Along a Direction 871

15.1.2.1.3 Move the Circular Path in a Plane 871

15.1.2.1.4 Resize the Circular Path 872

15.1.2.2 Step-by-Step Mode 873

15.1.2.2.1 Add a Keyframe 874

15.1.2.2.2 Load Keyframes from a File 876

15.1.2.2.3 Saving Keyframes to a File 876

15.1.2.2.4 Edit Keyframes 876

15.1.2.3 Path Mode 878

15.1.2.3.1 Select a Path 879

15.1.2.3.2 Draw and Create a Path 879

15.1.2.3.3 Set a Direction 880

15.1.2.3.4 Move the Path Along a Direction 881

15.1.2.3.5 Move the Path in a Plane 881

15.1.3 Browse the Keyframes 881

15.1.4 Define the Video Parameters 882

15.1.4.1 Set a Duration 882

Trimble RealWorks User Guide | 57



Contents

15.1.4.2 Define a speed 882

15.1.4.3 Choose a Processing Mode 882

15.1.4.3.1 High Quality Option (Recommended) 882

15.1.4.3.2 Quick Processing Mode 883

15.1.5 Preview the Video 883

15.1.6 Create the Video 884

15.2 Capture Screen (High Resolution) 885

15.3 Capture Screen 885

EXPORT 886

16.1 Export a Selection 886

16.1.1 Google Earth (KMZ) Format 886

16.1.1.1 User Defined 887

16.1.1.2 UTM to WGS84 Latitude and Longitude 888

16.1.2 PDMSMacro Format 888

16.1.3 Non-Gridded E57 Format 888

16.1.4 LAS Format 889

16.1.4.1 LAS 1.2 889

16.1.4.2 LAS 1.4 889

16.1.4.3 Export as a LAS Format File 889

16.1.5 LAZ format 890

16.1.6 Alias/WaveFront (OBJ) Format 890

16.1.7 MicroStation (DGN) Format 890

16.1.8 Pointools Format 891

16.1.9 PTS Format 891

16.1.10 ASCII Format 892

16.1.11 LandXML Format 892

16.1.12 Autodesk FilmBoX (BX) Format 892

16.1.13 TDX Format 893

Trimble RealWorks User Guide | 58



Contents

16.1.14 AutoDesk RCP format 894

16.1.14.1 Inputs 894

16.1.14.2 Outputs 894

16.1.15 Solids for AutoCAD 894

16.1.15.1 AutoCAD (DWG) Format 895

16.1.15.2 AutoCAD (DXF) Format 896

16.1.16 IFC Format 897

16.2 Advanced Exports 898

16.2.1 Export Object Properties 898

16.2.2 Export Images 898

16.2.3 Export Ortho-Images 898

16.2.4 Export Measurements 898

16.2.5 Export Feature Sets 899

16.2.6 Export TZF Images 899

16.2.7 Convert TZF Scans to Gridded E57/PTX/PTS/RCP 900

16.2.8 Export Inspection Maps and Slices 902

16.2.8.1 Export an Inspection Map 902

16.2.8.2 Export Horizontal Slices 902

16.2.8.3 Export Vertical Slices 907

16.3 Import and Register 911

16.3.1 Start to Import and Register 911

16.3.2 Select Scan Data Files 911

16.3.3 Set Point Cloud Extraction Options 914

16.3.4 Set Scan Data Registration Options 915

16.3.5 Process Files in Batch Mode 915

COLLABORATE & SHARE 917

17.1 Publish 917

17.1.1 Define a Layout 917

Trimble RealWorks User Guide | 59



Contents

17.1.2 Include a Media 918

17.1.3 Add a Link 919

17.1.4 Reduce the Size of the Data 919

17.1.5 Enable the Extraction of the Data 920

17.1.6 View the Publication 920

LICENSE AGREEMENT 922

Trimble RealWorks User Guide | 60



WELCOME

The RealWorks family of products is composed of RealWorks Viewer, RealWorks Starter, RealWorks Core, RealWorks Per-
formance and RealWorks Storage Tank.

REALWORKS VIEWER

This is a software tool for visualizing and exploring as-built data acquired by laser scanning technologies. In general, such a
data set contains a 3D point cloud and optionally a collection of 2D images. This software tool allows you to load as many
point clouds as needed. Each point of a point cloud can contain not only its 3D coordinates, but also other attributes such as
intensity and surface normal. You can visualize a point cloud in 3D, rotate, pan or zoom in/out in order to explore it in detail.
Visualization can be enhanced in different ways: points shaded by intensity, by color or by its normal, according to a view,
etc. You can also compare a 3D point cloud with 2D images (if available). When images are registered with the 3D point
cloud, you can visualize both data sets from the point of view from which the images were captured.

Features also available in RealWorks Viewer are:
n Registration report and station visualization,
n Sampling tool,
n Segmentation tool,
n UCSCreation tool and set as Home Frame,
n Measure tool,
n Cutting Plane tool,

Tip: RealWorksViewer is free. You can download it from the Trimble website. You only need to fill the form that will come
after clicking the link to download.

Note: You cannot save with RealWorks Viewer.

Note: RealWorks Viewer requires an RWP project file and its associated RWP folder. For more options relating to col-
laborating and sharing, see the Publisher function in certain modules.

REALWORKS

This software tool provides you with a set of tools for processing 3D point clouds and 2D images in order to obtain the
necessary information for your applications (or projects). Generally, this processing can be divided into three modes: Regis-
tration, OfficeSurvey™ and Modeling.

n In Registration, you can register scans with respect to other scans and/or with respect to a set of survey points. The
registration method is either target-based or cloud-based. When some targets have been used, you can first check
and modify them. Then the Target-Based Registration Tool automatically registers them simultaneously. The res-
ults are validated through registration errors, which can be saved in a report. You can also use the Geo-Referencing
Tool to put the scanned data into a known coordinate system.

n In OfficeSurvey™, you can extract different types of 2D drawings (polylines, contours, cross-sections, profiles, etc.)
from the point clouds. These extracted results can then be exported into CAD systems including, but not limited to,
AutoCAD® and MicroStation®. You can select and match 2D images to the point clouds; generate one (or multi)
ortho-image(s) or collect survey points as Total Stations can do. You can generate triangular meshes from the point
clouds and if required, carry out further editing of the result(s). You can determine the volume of a point cloud (or a
mesh), the volume between two point clouds (or two meshes) or the volume between a point cloud and a mesh. If
the volume information is not enough, you can compare two surfaces between each other (two point clouds or
meshes together, a point cloud with a mesh or a point cloud/mesh with a model) and generate an inspection map.
Since the metric information is still in the inspection map, you can extract measurements like surfaces, volumes,
points, drawings like polylines, sections, shifts, colored meshes, iso-curves, etc. You can match a profile (2D curve,
cross-section, polyline, etc.) at a specific point and in a given direction in a 3D scene; easily extract profiles along
curbs, pavements, rail lines, cuttings, natural features, etc. or fit a set of points with a geometry which can be of
planar, spherical or cylinder shape.

1
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n In Modeling, you can create a geometry of the following types: Sphere, Plane, Cylinder, etc. The creation can be
based on a point cloud selection (or not). The created geometry can be then duplicated, modified, moved, etc. A
sub-module including tools for modeling pipes and structural steelworks (with the notion of catalogs) has been
added.

All RealWorks products can support a huge amount of points. The user is able to precisely control which points are loaded
into memory and thus which are available for editing with all the regular tools. All RealWorks products include tools for man-
aging Trimble FX data; importing TZS scans, automatically creating station(s) on import with link to TZS; creating scans,
extracting targets, registering the created stations, creating sampled scans with spatial resolution, converting to Trimble
LASERGen format.

The user interface has been completely redesigned to incorporate a ribbon with larger icons and a Quick Access Toolbar.
In this layout configuration, The Office Survey and Modeling modes have been combined into a new Production mode.
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WHAT'S NEW

Following are the major new features and enhancements in Trimble RealWorks 12.0:
n IMPROVEMENTS OFWALKTHROUGHMODE: Move to a position on the ground (or roof) or look at a position on

a wall (or an object).
n MESH EDITING: Users can manually add triangles to a 3D mesh.
n CONVERT TO ORTHO-IMAGE: Use the feature to create an ortho-image registered (position, rotation, scale) on

the point cloud from an imported image file.
n 3D ANNOTATION: CREATE and VISUALIZE annotations on a computed 3D inspection cloud.
n ADD TRANSPARENCY TO POINT CLOUD: Use the feature to visualize geometries without needing to hide the

point cloud that is in front of.
n AUTO-SEGMENTMOVING OBJECTS: Use the feature to automate the process of isolating noisy points gen-

erated by moving objects (like e.g. pedestrians or moving cars) during a scan acquisition.
n START PAGE: The Start Page has been redesigned.
n UI THEMES: Optionally, change the user interface layout theme. Two themes are available: Light and Dark.
n AUTO-EXTRACT CYLINDERS: Enhancement of existing tool to let the users to only extract cylinders or cylinders

and elbows (pipelines).
n SCAN-BASED SAMPLING: Users can create sampled scans split by stations.
n CONVERT GEOMETRIES TO PIPE: This feature enables you to convert old pipe format to new format.
n ORTHO-IMAGE TRANSPARENCY: This feature enables you to display Ortho-Image with transparency.
n IMAGEMATCHING: The slider to change the blending parameter to check the coincidence of the image with the

3D data has been moved into the dialog box.
n TID: You can easily access an external Trimble service with a single login using your free Trimble Identification

(TID).
n CREATE & EDIT PIPE: The Create Pipe feature enables you to manually create and edit a complete pipeline object

from a point cloud.
n SUBSCRIPTION: Subscription license using a timed single- or multi-user subscription (requires logging in with your

Trimble Identification (TID)).

2
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INSTALL TRIMBLE REALWORKS

In this chapter, the user will find the information about the system requirements, program installation, activation and how to
contact Trimble.

3.1 System Requirements

Hereafter are detailed the requirements that are required for running Trimble RealWorks, Trimble Scan Explorer and
Trimble Scan Explorer Viewer.

TRIMBLE REALWORKS:

To run Trimble RealWorks, the system requirements are as shown.
n Operating System: Microsoft® Windows® 8.1 (64-bit OS) and 10.
n Multi-Core Processor: 2GHz or higher
n RAM: minimum 16 - 32 GB recommended
n Graphics card: 1GB, or higher, OpenGL 4.4
n Mouse: Three buttons with wheel
n SSD drive recommended
n Microsoft .Net Framework 4.8
n Microsoft Visual C++, Redistributable - X64: 2010, 2012, 2015 and 2017
n SketchUp, from 2014 to 2021

Note: Always update graphics card drivers before using Trimble 3D Spatial Imaging office software.

Note: Trimble Geospatial office software is designed to provide superior data processing and editing performance. To
ensure the best possible software use experience, and an optimum productivity/cost-of-equipment ratio, Trimble highly
recommends that users acquire the most powerful hardware configuration available at the time of purchase of the computer
equipment on which the software is intended to be used.

TRIMBLE SCAN EXPLORER:

Here are the minimum and recommended hardware requirements for Trimble Scan Explorer.
n Operating System: Microsoft® Windows® 8.1 (64-bit OS) and 10.
n Multi-Core Processor: 2GHz or higher
n RAM: minimum 8 GB - Recommended 16 GB
n Graphics card: 1GB, or higher, OpenGL 4.4
n Mouse: Three buttons with wheel
n Web Browser: Internet Explorer 8.0 or later
n Microsoft .Net Framework 4.8
n Microsoft Visual C++, Redistributable - X64: 2010, 2012, 2015 and 2017
n SketchUp, from 2014 to 2021

TRIMBLE SCAN EXPLORER VIEWER:

Here are the minimum and recommended hardware requirements for Trimble Scan Explorer Viewer.
n Operating System: Microsoft® Windows® 8.1 (64-bit OS) and 10.
n Multi-Core Processor: 2GHz or higher
n RAM: minimum 8 GB - Recommended 16 GB
n Graphics card: 1GB, or higher, OpenGL4.4
n Mouse: Three buttons with wheel
n Microsoft .Net Framework 4.8
n Microsoft Visual C++, Redistributable - X64: 2010, 2012, 2015 and 2017

3
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3.2 Check the Graphics Card in Use

You are able to know how many graphics cards there are in your computer and which one is in use with the software by
selecting About in the Support tab.

3.2.1 Enforce the Use of the High Performance Graphics Card

If your computer has two graphics cards: an integrated graphics card with low performance and a dedicated graphics card
with a high performance processor. Please enforce the use of the high performance processor graphics card with your soft-
ware.

Note: The given procedure is based on a NVIDIA graphics card, please refer to the documentation that comes with your
graphics card because the procedure may vary from one manufacturer to another.

To enforce the use of the high performance graphics card:
1. Right-click on your Desktop.
2. Choose NVIDIA Control Panel from the pop-up menu.
3. With the NVIDIA Control Panel open, choose Manage 3D Settings from the Select a Task panel.

4. From the Manage 3D Settings panel, first click on the Global Settings tab.
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5. From the Preferred Graphics Processor drop-down list, choose High Performance NVIDIA processor.

6. Click on the Program Settings tab.
7. Click on the Select a program to customize pull-down arrow.
8. Choose Trimblerealworks.exe from the list.
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9. If required, click on the "Select the preferred graphics processor for this program" pull-down arrow.
10. Again, choose "High Perform NVIDIA Processor" from the list.
11. In the "Specify the settings for this program" panel, select "Prefer Maximum Performance" from the "Power Man-

agement Mode" line.

12. Click Apply.

Note: If "Trimblerealworks.exe" is not in the list, you can add it manually by clicking on the "Add" button.

3.2.2 Check the Version Number of the OpenGL Library

You are able to check if your graphics card is compliant (or not) with OpenGL 3.2 by selecting About from the Help menu. If
your graphics card is not compliant, please, update your graphics card's driver to get the latest version of OpenGL. Other-
wise an error message appears.

3.3 Check the Open Source Libraries and Licenses in Use

Your software program uses open source libraries and therefore must comply with their respective licenses. In order to com-
ply with the licenses, your software programmust display various copyrights and licenses. All can be found while installing
the program software in the License Agreement window or in the About dialog once the software is installed.

3.4 Download Trimble RealWorks

You need to download from the Trimble Geospatial website.
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To download Trimble RealWorks:
1. With the Technical Support window open, click Downloads.

2. With the Downloads panel expanded, click on the Download Trimble RealWorks 12.0 link.

3. Once the download completed, click .

3.5 Download Trimble Update Network License Utility

You need to install the Trimble Update Network License Utility to be able to configure a HASP® network key with a multi-
user license. The utility can be downloaded from the Trimble Geospatial website.

To download Trimble Update Network License Utility:
1. With the Technical Support window open, click Downloads.
2. With the Downloads panel expanded, click on the Update Network License Utility link.

3.6 Licensed Features

The main tools and functionalities included in the Trimble RealWorks software and their inclusion in the available Editions
are detailed in the Trimble RealWorks support notes, which can be downloaded from the Trimble Geospatial website.

To download Trimble RealWorks support notes:
1. With the Technical Support window open, click Downloads.
2. Click on the Trimble RealWorks Software Support Notes link.
3. Download the support notes related to the version of your software.

3.7 Install Trimble RealWorks

This section explains how to install RealWorks on a standalone computer. Before you install RealWorks; close all Windows
programs, and ensure that your computer has sufficient operating system requirements and memory capabilities (for more
information, see the System Requirements section). Make sure that you have local or domain administration rights.

To install Trimble RealWorks:
1. Turn on your computer and start Microsoft Windows.
2. Download the Trimble RealWorks 12.0 package from the Trimble website.
3. Double-click on the package icon to launch the install Wizard.
4. At the Welcome to Trimble RealWorks 12.0 Setup dialog, press Next. The System Information and Current Pro-

gram Version dialog appears. System information and the current program version are listed.
5. Click Next. The License Agreement dialog appears.
6. Read carefully the terms of the license agreement.
7. If you do not accept the terms, check the "I do not accept the terms of the license agreement" option and the install

procedure will close.
8. If you accept all the terms, check the "I accept the terms of the license agreement" option and click Next. The

Choose Destination Location dialog opens.
9. In the Choose Destination Location dialog, choose Next to accept the default install directory C:\Program

Files\Trimble\Trimble RealWorks 12.0.
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10. If you wish to install in a different directory, choose the Change button. After you have chosen the install directory,
press Next. The Setup Type dialog appears.

11. In the Setup Type dialog, choose the type of Setup you prefer. Complete will install the program with all features.
Custom will require you to choose the options to install. By default, Complete is selected.

12. If you have a HASP license file, keep the Complete option and click Next. The Select Program Folder dialog
appears;

13. You should select a program folder inside which Setup will add program icons. You can keep the given program
folder, type a new one in the Program Folder field or select an existing one from the Existing Folders field.

14. Press Next. The Ready to Install the Program dialog appears.
15. Press Install. The Setup Status dialog opens and files are installed. The Setup Type dialog appears.
16. Select the type(s) of file you wish Trimble RealWorks to take in charge. Four types are available: NEU and ASC are

an ASCII format file extension, JXL is an extension of text files exported from Trimble Survey Controller™, Survey
Manager™ or Survey Pro™ software. TZS is an extension of files from Trimble's LASERGen. TSPX is a Trimble
Survey Project file.

17. Click Next. The InstallShield Wizard Complete dialog appears. You have successfully installed RealWorks on your
computer.

18. Click Finish to complete the installation*.

Note: (*) Sometimes, you may need to restart your computer.

Caution: Please exit TrimbleRealWorks if there is already a version of RealWorks installed on your computer and if a ses-
sion is open. This avoids the Setup of a new version of RealWorks to interfere with the current version.

3.7.1 Trimble RealWorks Plant Tables

Trimble RealWorks includes some catalog files. These files are automatically installed during the installation of the software
when you choose Complete as Setup Type. If you do not want them, you need to first choose Custom as Setup Type, and
then uncheck the RealWorks Plant Tables option in the Select Features page.

Note: These catalog files are necessary in the case you want to model point clouds with constraints in tools like the
SteelWorks Creator.

3.7.2 Storage Tank Application

The Storage TankApplication is an option which is automatically installed when choosing Complete as Setup Type. If you
do not want this option, you need to first choose Custom as Setup Type, and then un-check the Storage Tank Application
option in the Select Features page.

Note: The table files, installed during the installation of RealWorks, can be reached from a direct link in the user interface.
Refer to the Locate Tables section.
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3.8 Update Trimble RealWorks

This section explains how to update RealWorks on a standalone computer. The update only applies when you move from
one version (of RealWorks) to the higher.

To update Trimble RealWorks:
1. Turn on your computer and start Microsoft Windows.
2. Download the Trimble RealWorks 12.0 from the Trimble website.
3. Double-click on the package icon to launch the install Wizard.
4. If the Setup program does not start automatically, run it from the Start menu as described in the previous section.
5. At the Welcome to RealWorks 12.0 Setup dialog, press Next.
6. The System Information dialog appears and system information and the current program version are listed. Press

Next. The Ready to Install the Program dialog opens.
7. Click Install. The Setup Status dialog appears.
8. Once the update is done, you are prompted to either view the Help file or to launch RealWorks by checking the

option.
9. Click Finish.

3.9 Modify, Repair and Remove Trimble RealWorks

This section explains how to modify, repair and remove Trimble RealWorks from a standalone computer. Modification,
repair and removal (of Trimble RealWorks) apply only when you want to make a change of an option in an existing install-
ation, or simply to uninstall TrimbleRealWorks.

To modify, repair and remove Trimble RealWorks:
1. Turn on your computer and start Microsoft Windows.
2. Download the Trimble RealWorks 12.0 from the Trimble website.
3. Double-click on the package icon to launch the install Wizard.
4. If the Setup program does not start automatically, run it from the Start menu as described in the previous section.
5. At the Welcome to RealWorks 12.0 Setup dialog, press Next.
6. The System Information dialog appears and system information and the current program version are listed. Press

Next. The Modify, Repair or Remove the Program dialog opens.
7. Choose any of the following options:

n Select Modify and click Next. You can add new components in your program or select currently installed com-
ponents to remove.

n Select Repair and click Next. All program components installed in the previous setup will be re-installed.
n Select Remove and click Next. All installed program components will be removed.

8. If Modify has been selected, the Select Features dialog appears.
a. Un-check the components to clear and click Next.
b. Or check the components to install and click Next.
c. Click Finish to end the maintenance.

9. If Remove has been selected, the Confirm Uninstall dialog appears; click Finish to end the uninstall procedure.

Tip: You can also use the Add/Remove tool via your Windows® control panel.

Note: Updating, when carried out frequently, may generate residual files on your hard disk. To minimize such eventualities,
we recommend that you completely remove TrimbleRealWorks from your hard disk and perform a new installation pro-
cedure.

3.10 View & Manage Licensed Features

RealWorks supports the following licensing schemes:
n Perpetual single-user license using a HASP® hardware key connected to your computer.
n Perpetual single- or multi-user license using a HASP software key installed on your computer (single-user) or net-

work (multi-user).

Trimble RealWorks User Guide | 10



INSTALL TRIMBLE REALWORKS

n Subscription license using a timed single- or multi-user subscription (requires logging in with your Trimble Iden-
tification (TID)).

The License Manager allows you to view and manage all licensing information.

Note: RealWorks will display a dialog to notify you when your license expires in less than two weeks.

To view the License Manager:

1. Select License Manager in Support > License. The License Manager dialog displays.
2. Use this dialog to do any of the following:

n For perpetual license users:

- Select your perpetual license. If it is installed on a server, select the server.
- View the licensed features, the warranty expiration date, the version of RealWorks installed, and the current
key ID.
- Upgrade a single-user license installed on your computer.
- Check out a detachable instance of multi-user software license (if applicable).
- Launch the Sentinel Admin Control Center web page, which enables administrators to manage licenses and
users, and view usage data.

n For subscription license users:

- Select your subscription license.
- View licensed features, the expiration date, view the version of RealWorks currently installed, the currently
logged in Trimble Identification (TID) email address, and the name and email address for your subscription
license administrator.
- Check out your license for when you are not connected to the Internet.
- Launch the Trimble License Manager web page, which enables administrators to manage licenses and users,
and view usage data.

To view or select your license:

Each time you run RealWorks, it checks your license to determine the features available for use.

1. Select License Manager in Support > License. The License Manager dialog displays.
2. The License Type drop-down list shows the currently selected license type:

n Perpetual - Automatic: RealWorks searches for a perpetual license by first checking whether a HASP hardware
key is connected to a USB port on your computer. If it does not find a license on a HASP hardware key, it checks
whether a checked-out instance of a multi-user license is installed on your computer. If it does not find a
checked-out instance of a multi-user license, it checks whether a multi-user license is available on a HASP net-
work key. Optionally, specify a network server in the License Server drop-down list; otherwise, all network serv-
ers are searched.

n Perpetual - Hardware: RealWorks searches for a license installed on a HASP hardware key connected to a USB
port on your computer.

n Perpetual - Software: RealWorks searches for a checked-out instance of a multi-user license installed on your
computer.

n Perpetual - Network: RealWorks searches for a multi-user license on a HASP network key installed on the
server specified in the License server drop-down list. If the correct server is not already included in the list, select
the <search network> option to locate it.

n Subscription: RealWorks searches for any subscription licenses assigned to your TID and displays them in the
Subscription list.

- When a perpetual license is found, it is displayed at the top of the Features list, with all of the currently available
RealWorks editions and modules listed beneath it. The Status field indicates whether an edition or module is
included with the selected license. The Can check field? indicates whether a perpetual multi-user license can be
checked out.
- When a subscription license is found, it is displayed at the top of the Features list, with all of the associated fea-
tures listed beneath it.
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3. If you select a different license or make other changes you want to save, click Apply (leaves dialog open) or OK
(closes dialog).

To upgrade a perpetual single-user license:

If you have been provided a 19-digit upgrade code, do the following:
1. In the License Manager dialog, click Upgrade.
2. In the Upgrade License dialog, network key can be found, the server on which it is installed is already selected.
3. In the Duration box, select the key to upgrade and enter the 19-digit code provided for your upgrade.
4. Click Upgrade.

After the upgrade process is complete, verify the upgrade completed successfully by, depending on the type of upgrade,
checking that new features were added or checking that the warranty date was updated

To check out a perpetual multi-user license:

If your organization is using a perpetual multi-user license installed on a network, you might be able to check out a detach-
able instance of the license so that you can run the software without being connected to the network. The following con-
ditions must be met to enable checkout. Contact your administrator for additional assistance.

n A HASP perpetual network key (multi-user license) is installed on your network and is configured to support license
checkout.

n There are licenses available for checkout.
n Your computer is configured to allow license checkout.

Follow these steps:
1. In the License Manager dialog, click the Check Out button to display the Check Out License dialog.
2. Optionally, select the Server on which the HASP perpetual network key is installed. If only one HASP network key

can be found, the server on which it is installed is already selected.
3. In the Duration box, select the number of days you want to check out the license, or select a checkout expiration

date.
4. Click OK.

If your computer is not configured for license checkout, a message displays that provides appropriate instructions.
You can run the software with your detachable instance of a multi-user license for the duration of your checkout time
without being connected to the network.

To manage perpetual licenses and users (administrators):

In the License Manager dialog, click the Sentinel Admin Control Center link to display the License Manager in your web
browser. Use the online Help for additional instructions.

To check out a subscription license:

Check out a subscription license to use to run RealWorks when you are not connected to the Internet.
1. In the License Manager dialog, click the Check Out button to display the Check Out License dialog.
2. In the Duration box, select the number of days to check out the license (up to 30 days), or select a checkout expir-

ation date.
3. Click OK.

You can run the software with your detachable instance of a subscription license for the duration of your checkout time
without being connected to the Internet.

To view the subscription license administrator:

In the License Manager dialog, click the Subscription License Manager* link to display the License Manager in your web
browser. From the web page, click the License Administrator button to display a dialog showing the administrator's name
and email address, which you can use to contact the administrator if necessary.

Note: You also click on the License Administrator button.

To manage subscription licenses and users (administrators):
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In the License Manager dialog, click the Subscription License Manager* link to display the License Manager in your web
browser.

Notes:
n (*) If you are not logged to the License Manager, the License Manager web page displays and prompts you to enter

your Trimble Identification (TID) credentials.
n If you are already logged to the License Manager, you do not have to re-log again. Optionally, use the Log Out but-

ton to sign out.

3.11 Export an Event Log File

You can export an event log file from RealWorks for two reasons. First, in case RealWorks crashes, the log file can help the
support team to troubleshoot your problems. Second, when there is no crash, the log file can be helpful to understand some
behaviors of the software.

To export an event log file:

1. Select Export Logs in Support > Settings.
2. Or from the Support tab, click the Export Logs icon. The Export dialog opens, with a default name: LogExport_"Ver-

sion_Of_RealWorks"_"Date"_"Time".
3. Navigate to the drive/folder where you want to store the file.
4. Click Save. The Export dialog closes.

3.12 Connect to an External Trimble Service Using Your TID

You can easily access the following external Trimble service with a single login using your free Trimble Identification (TID):
n Trimble License Manager

To connect to an external Trimble services using your TID:

1. Select the Log In link located one the top right corner of the user interface. The Trimble Identity web page dis-
plays.

2. In the Sign In pane, do any of the following:
n Enter your Trimble Identification (TID) credentials and click Sign In.
n Select to sign in using Google or Apple.
n Click the Create an Account link to create a free new TID account.

You do not have to re-log in to access any of the services listed above.
You stay logged in after leaving RealWorks without signing out. You stay logged in for five days, afterward you
will have to sign in again.
You do not need to re-enter your credentials for nine days after the last session with a valid connection. If you
open RealWorks with a valid internet connection within the nine days you will never be asked to sign in again.
You do not need to sign in if you have already logged in with your TID in Trimble Business Center.
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This chapter guides you through the steps you will take after installing the software on your computer, from the startup of
the software, through the tour of the user interface in order to be familiar with it, to the opening of your first project.

4.1 Start Trimble RealWorks

From your desktop, double-click the Trimble RealWorks icon to start the software. At each time you start the soft-
ware; a message opens and prompts you to participate in the Trimble Solution Improvement Program (TSIP). When you
click on the Trimble icon to learn more, the Preferences / Improvement Program dialog opens. The message will disappear
from the next startup (of the software) once you have chosen an option from the Improvement dialog.

A Start Page also opens. From the Start Page, you can get started working with the software, access to different links like
checking for updates, open the recent projects, etc.

4.2 Open your First Project

With the user interface opened, you can start loading your first project in RealWorks. There are several manners. You can
select Open from the File menu, click on the Open an Existing Project link in the Start Page, drag and drop a project file into
RealWorks, choose the Open command from the File tab or from the Quick Access Toolbar on the top of the user interface.

Caution: A warning appears in the case you try to open a project from the link in the Start Page, with a tool (or feature) that
is in use.

Note: Refer to the Performing Basic Operations chapter for more information about the different file formats that
RealWorks can handle.

4.3 Working Environment

Trimble RealWorks includes either three modes (OfficeSurvey, Modeling and Registration) or two (Production and Regis-
tration), depending on the type of interface chosen by the user. Each mode corresponds to a processing mode. We are not
going to develop each of them here, but note that the working environment changes according to the one you chose.

In the Menus and Toolbars layout, to switch from e.g. OfficeSurvey to Registration and vice versa, click on the Con-
figuration pull-down arrow on the Tools toolbar.

4
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In the Ribbon layout, to switch from Production to Registration and vice versa, click on the Configuration pull-down arrow on
the Quick Access Toolbar.

In some rare situations, you may not be able to change the configuration. This is because the Configuration option has
been unchecked in the Quick Access Toolbar.

4.3.1 User Interface

When you start a RealWorks session, you can see the main window with its working sub-window components and the Start
Page (not illustrated). After you open a project, these components will activate so you can start working with them. You can
customize the settings of the different components inside the main window.

When you start RealWorks for the first time, the Ribbon layout is set default as well as the Head Always Up option. This last

one has the following representation displayed at the bottom right corner of the 3D View.

RIBBON LAYOUT:

A session of RealWorks looks like the following example, when the Ribbon layout has been chosen:
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MENUS & TOOLBARS LAYOUT:

A RealWorks session looks like the following example, when the Menus and Toolbars layout has been chosen:
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1 - Menu bar
2 - Toolbars
3 - WorkSpace
4 - 3D View
5 - List
6 - Status bar (not illustrated)

7 - Property
8 - Selection List (not illustrated)
9 - Start Page (not illustrated)
10 - Station Marker List (not illustrated)
11 - Classification Layers (not illustrated)
12 - Limit Box (not illustrated)

To switch from the classic Menus & Toolbars interface to the Ribbon interface, and vice versa.
n Select Ribbon/Toolbar in Support> Settings.
n Select Ribbon/Toolbar from the Window menu or click the Ribbon/Toolbar icon on the Windows toolbar.

Tip: Use the following combination of keys Ctrl + Alt + F9.

Tip:Optionally, select Switch Theme in Support > Settings to change the user interface layout theme. Two themes are
available: Light and Dark.

4.3.2 Start Page

The Start Page , included in the software, displays when you start the software for the first time. This page will appear
each time you start the software again until the option in the Preferences / General dialog remains checked. This page
includes many useful links.
Links in the Start Page
Open Files This link opens the Open dialog.
Check for
updates

This link brings you the Trimble Technical Support page, from which you
can check for new updates.
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License Man-
ager (*)

This link brings you to the License Manager system.

Click Here to
Join the
Trimble Forum

This link opens the Trimble RealWorks User Forum web page where
you can ask a question, share best practices, and get help from other
users or Trimble experts.

Trimble
RealWorks
Support

This link brings you to the Trimble Global Support & Service web page.

Video demos
on YouTube

This link brings you to the official channel of RealWorks on YouTube.

Help (F1) This link opens the online help file.
Release Notes This link brings you the Trimble Technical Support page, from which you

can release notes, documentation, etc.
Trimble
RealWorks
News

A panel inside which you can find all new news about Trimble
RealWorks, as well as a link to download the last version of Trimble
RealWorks

Video demos
on YouTube

This panel gathers recent videos

Use the following to:

Display projects by using lists

Display projects by using large thumbnails

For each project, the following information is displayed:

Number of stations in the project

Number of points in the project

Date of creation of the project

Optionally, select Switch Theme in Support > Settings to change the user interface layout theme. Two themes are avail-
able: Light and Dark.

Note: Links with an asterisk in parenthesis are not available in the Viewer version of RealWorks.

4.3.3 Menu Bar

In the Menus and Toolbars layout, RealWorks provides you with a set of tools and commands. The menu bar, always open
and displayed on the top of the user interface, contains all available tools and commands that you can use. This bar is com-
posed of main menus that you have to drop-down in order to reach the tool (or command) you wish to use. For some tools
(or commands), you may need to go to the sub-menu to reach them.

Some main menus will be automatically added (or deleted) according to the processing modes you are actively using.
Many tools and commands can also be reached from the toolbars, or the pop-up menus, by tapping on the screen (when
using a touchscreen), and waiting until a square appears then releasing.

4.3.4 Toolbars

In the Menus and Toolbars layout, the RealWorks user interface is composed of different toolbars. Each of them has spe-
cific uses. By default, all toolbars are not open when you start RealWorks. Those that are opened are displayed either hori-
zontally under the menu bar or vertically beside the WorkSpace window. You can move each toolbar to any location within
the user interface, open or close them.

4.3.5 Ribbon
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A ribbon is a command bar that organizes RealWorks's features into a series of tabs, at the top of the user interface. By
adopting the ribbon layout, the user finds a modern way to find, understand and use commands and tools efficiently in order
to perform a task or a series of tasks.

To minimize the ribbon:

1. Click the Customize Quick Access Toolbar .
2. Check the Minimize the Ribbon option from the drop-down list.

To restore the ribbon:

1. Click the Customize Quick Access Toolbar .
2. Uncheck the Minimize the Ribbon option from the drop-down list.

Tip: To minimize or restore the Ribbon, press CTRL + F1.

4.3.6 Vertical Toolbar

A toolbar located vertically on the right side of the 3D View, gathers the most used icons offering by this way a quick access
to each of them, and avoiding the user swapping from tab to tab. This toolbar cannot be either customized nor undocked
from its position.

4.3.7 Windows

RealWorks main window has several components, which are described hereafter.

4.3.7.1 Start Page

The Start Page disappears after you load a project in RealWorks, but you still have access to it by selecting Start Page
from the Window menu (or from the Support tab).

Tip: You can use the Ctrl + F4 key combination to close the Start Page.

4.3.7.2 WorkSpace

TheWorkSpace window (always opened when the user interface appears) is the one located under the tabs and comprises
a set of tabs. This window is used for organizing data hierarchically in a tree called Project Tree. This main tree is sub-
divided into sub-trees called Scans, Targets, Models and Images. Each of them is used for organizing certain types of data
from a loaded project. To display a sub-tree, click the corresponding tab.

Only one tab can be displayed at any given moment. The Images tab can be found in OfficeSurvey, Modeling and Regis-
tration (or in Production and Registration). You can move this window to any location within the user interface, or resize it.
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TheWorkSpace window in Production TheWorkSpace window in Registration

Note: The Cross button has been removed from the top right corner of the WorkSpace window. You are not able to close
the window with this button but you can still close it through the View tab, in the Windows group.

Caution:When the WorkSpace window is undocked, you can use the Alt and F4 combination to close it. First ensure that
the WorkSpace window is selected, otherwise, you close RealWorks and you lose all of your changes.

Note: You can change the orientation of the WorkSpace window to display the inner panels side-by-side horizontally (or ver-
tically), by clicking the Toggle Side-by-side / Top-Bottom View icon.

4.3.7.3 List

The List window, which was formerly a separate window, is now merged down with the WorkSpace window as a panel. It is
used to display the content of a selected group of the Project Tree. Each object node shown in this window is identified by
its icon, its name and its other properties. You can display it side-by-side with the WorkSpace panel horizontally (or ver-
tically), by clicking the Toggle Side-by-side / Top-Bottom View icon.
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Note: Because the number of points for a point cloud is often large and the symbol (Digit Grouping Symbol) used for group-
ing the digits makes that number unreadable; you now can customize this symbol by first opening the Regional and Lan-
guage Options in the Control Panel (of Windows®) and then selecting Customize and Digit Grouping Symbol. This change
will be memorized and used for the next session of RealWorks and will affect the display of the numbers of points in that win-
dow.

Caution: The notion of Number of Loaded Points in the List window has been removed in RealWorks 8.0.

Caution:When the WorkSpace window is undocked, you can use the Alt and F4 combination to close it. First ensure that
the WorkSpace window is selected, otherwise, you close RealWorks and you lose all of your changes.

The version 9.2 of RealWorks introduces the concept of layers, one per object node, whatever its type. A column, named
Layer, is added in the List window. You may see it only in OfficeSurvey and Modeling (or in Production).

Note: You cannot modify the layer of an object from the List window.

4.3.7.4 Property

This window is used to list the properties of a selected object and is divided into two columns. The left one lists the titles of
each property and the right one shows property values (either fixed or modifiable). The properties in gray are fixed and
those in black are modifiable. Properties are classified by category such as General, Content, Geometry, etc.

You can shrink each category of properties by hiding its content. To do this, click on the Shrink button. By default, the Prop-
erty window is not displayed in the user interface. You have to open it by using the command from the main Window menu
or from the pop-up menu after selecting an object. You can move this window to any location in the user interface, or close,
reduce and restore it.

1 - Title column 2 - Attribute column 3 - Modifiable attributes

Note: Because the number of points for a point cloud is often large and the symbol (Digit Grouping Symbol) used for group-
ing the digits makes in that number unreadable; you now can customize this symbol by first opening the Regional and Lan-
guage Options in the Control Panel (of Windows®) and then selecting Customize and Digit Grouping Symbol. This change
will be memorized and used for the next session of RealWorks and will affect the display of the numbers of points in the
Property window.
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Tip: You can select and copy any value from the Property window by using the Ctrl + C keys.

Caution: The notion of Number of Loaded Points in the Property window has been removed in RealWorks 8.0.

The version 9.2 of RealWorks introduces the concept of layers, one per object node, whatever its type. A line, named
Layer, is added in the Property window. You may see it only in OfficeSurvey and Modeling (or in Production). You are able
to change the layer of an object from this window.

4.3.7.5 Selection List

The Selection List window is used to list the selections done from the Project Tree* or from the 3D View. By default, the
Selection List window is not displayed within the user interface. You have to open it by selecting Selection List Window from
the Window menu (or fromWindows group on the View tab). You can move this window to any location in the user inter-
face, or close it.

1 - Number of items selected 2 - Clear button

Caution: The notion of Number of Loaded Points in the Selection List window has been removed since RealWorks 8.0.

Warning: Be aware that when you enter some tools like e.g. the Orientation in the Registration module, the objects you
selected as the input of the tool and listed in the Selection List window are removed from the window. When you leave the
tool, the selection is lost.

Note: (*) All the selected items do not appear in the List window. There are some exceptions. Please, refer to the Selection
Mechanism in the WorkSpace window.

The version 9.2 of RealWorks introduces the concept of layers, one per object node, whatever its type. A column, named
Layer, is added in the Selection List window. You may see it only in OfficeSurvey and Modeling (or in Production).

Note: You cannot modify the layer of an object from the SelectionList window.

4.3.7.6 Station Maker List

The Station Maker List window is used to show the display status of a station marker in the 3D View. By default, the Station
Marker List window is not displayed within the user interface. You have to open it by selecting the Station Marker List from
the 3D View / Rendering menu (or from the Windows group on the View tab). You can move this window to any location in
the user interface, or close it.
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Note: Please, refer to the section related to the Specific Station Marker(s) of a station (or set of stations).

4.3.7.7 Classification Layers

The Classification Layers window can be used to manage the layers within your project. You are able to create a new layer,
or delete, rename or change the color of an existing layer or edit its properties. By default, the Classification Layers window
is not displayed within the user interface. You have to open it by selecting ClassificationLayers from the Window menu (or
from the Windows group on the View tab). You can move this window to any location in the user interface, or close it.

Note: The ClassificationLayers Window is only available in OfficeSurvey and Modeling (or in Production).

4.3.7.8 Limit Box List

The Limit Box window can be used to manage the limit box objects that are created within an open session of RealWorks,
or those coming from other sessions of RealWorks.

By default, the Limit Box window is not displayed within the user interface. You have to open it by selecting Limit Box from
the Window menu (or from the Windows group on the View tab), or from any tool that handles the limit box visualization.
You can move this window to any location in the user interface, or close it.

Tip: The Limit Box window can also be opened with the Limit Box Extraction (or Limit Box Mode) toolbar.

4.3.7.9 3D View
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The 3D View is always open at the right side of the user interface under the tabs. You can move, reduce and restore it in the
same way as for the other windows but you cannot close it. This window is mainly used for displaying (or hiding) the 3D rep-
resentation of a selection from the Project Tree. An orthonormal Reference Frame and a Scale are displayed respectively
at the bottom right and bottom left corners of this window. By default, the window background is gray dark with a gradient
effect. You can customize it to suit your preference.

With a certain type of tools, the 3D View can be split into two or three sub-views. The top sub-view remains the 3D View,
and the other(s) can be a 3D View, or a 3D View locked in 2D, or a graph. The View Manager at the bottom right corner of
the user interface lets you organize them as you wish.

1 - 3D View
2 - Scale
3 - Reference frame
4 - 2D View

5 - Size of the 2D grid
6 - 2D grid
7 - View Manager

4.3.7.9.1 View Manager

The View Manager enables you to navigate through the different aspects that may have the 3D View when you use a cer-
tain type of tool. It appears as a toolbar at the bottom right corner of the 3D View and is composed of two sets of icons.

In the sub-view mode (two horizontal sub-views, two vertical sub-views or three sub-views), the sub-view with a yellow
edge is the active sub-view. In the one view mode, the view in full is always the active view.

4.3.7.9.1.1 Change the Display Configuration of Sub-Views

The first set of icons is detailed in the table below. It enables you to change the configuration to full view, or to two sub-
views, or to three sub-views.
This icon Enables
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Make Full To expand the selected sub-view to full view.

Split Horizontally To tile two sub-views horizontally

Split Vertically To tile two sub-views vertically

Split 3 Views To tile into three sub-views

TWO SUB-VIEW CONFIGURATION:

In that configuration, only Make Full, Split Horizontally and SplitVertically are available. When a sub-view has been selec-
ted and expanded in full, the Display Main View and Display Sub-View 1 icons become enabled.

THREE SUB-VIEW CONFIGURATION:

In that configuration, all are available: Make Full, Split Horizontally, SplitVertically and Split 3 Views are available. When a
sub-view has been selected and expanded in full, the Display Main View, Display Sub-View 1 and Display Sub-View 2
icons become enabled.

4.3.7.9.1.2 Display & Hide a Sub-View in Full

The second set is composed of the icons described in the table below. It enables you to hide or to expand in full a sub-view.
It also enables the restore of the default layer.
This icon Enables

Display Main View
To display the main 3D View in full

Display Sub-View 1
To display the first planar sub-view in full

Display Sub-View 2
To display the second planar sub-view in full.

Restore Default Layout
To restore the default layout.

Hide View
To hide the current view.

Notes:
n The Hide View icon can only be selected from the pop-up menu (or from the 3D View / Layout menu).
n A sub-view, once expanded in full, cannot be hidden. That's why the Hide View icon is dimmed.

4.3.7.9.2 2D Grid

In the 2D View mode, there is by default a 2D Grid superposed on the current sub-view. This grid helps the user to have a
metric scale of objects displayed within the sub-view.

Note: The 2D View mode only appears when using some tools, like e.g. the Cutting Plane tool, where data (resulting from
the use of this category of tools) needs to be represented in 2D.

To hide & show 2D grid:
1. You can right-click in the sub-view.
2. Select Hide 2D Grid (if the 2D Grid is displayed) or Show 3D Grid (if the 2D Grid is hidden) from the pop-up menu.

Notes:
n Hiding the 2D Grid from the current sub-view will display the scale.
n Whatever the view (3D View or current sub-view) you select, you should be in Parallel to be able to display the

scale.

There are seven pre-defined and square sizes: 0.1x0.1, 1x1, 5x5, 10x10, 50x50, 100x100 and 1000x1000. All are
expressed in the current unit of measurement. The current size is displayed at the bottom left corner of the sub-view.

To change a size:
1. You can right-click anywhere in a sub-view.
2. Select 2D Grid from the pop-up menu. A sub-menu drops down.
3. Select a predefined size.
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You can define a size which is either square (the same resolution in horizontal and in vertical) or not.

To customize a size:
1. Right-click anywhere in a sub-view.
2. Select Customize from the pop-up menu. A sub-menu drops down.
3. Select Customize from the sub-menu. The 2D Grid Size dialog opens.
4. Input a distance value in the Horizontal Size field.
5. Input a distance value in the Vertical Size field.
6. Click OK. The 2D Grid Size dialog closes.

4.3.7.9.3 Navigation Constraint Tools

When you manipulate a scene in the 3D View, you can apply a set of constraints like e.g. rotating it horizontally. All avail-
able constraints are split into two categories: temporary constraints or permanent constraints. All the permanent constraints
can be reached from the pop-up menu at the bottom right-corner of the user interface.

We will not discuss in detail these two constraint modes here. For more information, refer to the Displacement Modes sec-
tion.

4.3.8 Tools and Commands

Commands are actions which can apply to the selected object(s) or to a whole set of displayed objects, while tools are a set
of actions logically organized together to fulfill a function of the software.

In the classic Menus and Toolbars layout, all tools and commands can be found in the menu bar, and most of them can also
be found in various toolbars. In the Ribbon layout, all of them can be on the tabs. In the next topics, we will discuss in more
detail the organization of the tools and commands.

4.3.8.1 Menu Bar

The menu bar is a series of aligned menu titles. This series changes depending on the processing mode you are in. You
drop down a menu by clicking on its title, and then you can select a command.

n File: This menu is a standard menu that contains Open, Close, and other file related commands.
n Edit: This menu gives access to object editing operations such as cut, copy and paste, undo, redo, find, etc. and

access to advanced functions and preferences.
n Tools: This menu contains common tools that you can use no matter which processing mode you are in.
n Plant*: This menu contains tools for modeling pipes and structural steelworks.
n OfficeSurvey: This menu contains all available tools related to the OfficeSurvey™mode.
n Registration: This menu contains all available tools related to the Registration mode.
n Modeling*: This menu contains all available tools related to the Modeling module.
n Media Tools: This menu contains tools for computing video and capturing snapshots.
n Display: This menu gives access to object display and hide functions in the 3D View window.
n 3D View: This menu gives access to different visualization parameters (rendering, view, etc.) in the 3D View win-

dow.
n Window: This menu allows the user to organize the user interface.
n Help: This menu gives access to online help.
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Note: (*) The Plant and Modeling menus are not present in RealWorks Starter.

4.3.8.2 Toolbars

Icons are the graphic representation of tools and commands in the toolbars. They are organized into different toolbars
according to their similarity in terms of function.

4.3.8.2.1 Main

Under the Main toolbar, you can find the following list of icons:

Open

Connect to Mobile Device

Open Scan Explorer

Open SketchUp

Save

Print

Undo

Redo

4.3.8.2.2 Display

Under the Display toolbar, you can find the following list of icons:

Display Cloud

Display Geometry

Hide Cloud

Hide Geometry

Hide All

Limit Box Mode

Lighting Direction

4.3.8.2.3 3D View

Under the 3D View toolbar, you can find the following list of icons:

Cloud Rendering / White

Cloud Rendering / Cloud Color

Cloud Rendering / Station Color

Cloud Rendering / Scan Color

Cloud Rendering / Grey Scaled Intensity

Cloud Rendering / True Color

Cloud Rendering / Color Coded Intensity

Cloud Rendering / Color Coded Elevation

Cloud Rendering / Color Coded Classification

Cloud Rendering Settings
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Geometry Rendering / Wireframe

Geometry Rendering / Hidden Lines

Geometry Rendering / Solid

Geometry Rendering / Solid - Classification

Geometry Rendering / Textured

No Filters

Hide Background

See Inside

Outline

Cloud Transparency

Cloud Transparency Settings
Ortho-Image Transparency
Ortho-Image Transparency Settings

No Shading

Normal Shading

Ambient Shading

Enhanced Ambient Shading

Point Size / 1 Pixel

Point Size / 2 Pixels

Point Size / 3 Pixels

Point Size / 4 Pixels

Point Size / 5 Pixels

Adaptive Point Size

Projection Mode / Perspective

Projection Mode / Parallel

Navigation Mode / Examiner
Navigation Mode / WalkThrough

Navigation Mode / Station-Based

Selection Mode / Rectangular Selection

Selection Mode / Polygonal Selection

Show Stations

Show Station Maker Labels

Station Maker List

Change Cloud Color

Change Geometry Color

4.3.8.2.4 View Alignment
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Under the View Alignment toolbar, you can find the following list of icons:

Zoom On Selection

Center On Point

Zoom Extents

Center of Rotation Defined by Cursor Position

Zoom In

Zoom Out

Front

Back

Left

Right

Top

Bottom

Object Front

Object Back

Object Left

Object Right

Object Top

Object Bottom

Go to Shooting Position

4.3.8.2.5 Tools in the Registration Module

Here is a list of icons that you can find in the Tools toolbar when you are in the Registration module:

Auto-Extract Targets

Auto-register using Planes

Target-Based Registration

Refine Registration Using Scans

Cloud-Based Registration

Georeferencing

Target Analyzer

Orientation

Generate Key Plan From Current View

Registration Report (Target-Based)

Limit Box Extraction

Annotate

Measure
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4.3.8.2.6 Tools in the OfficeSurvey Module

Here is a list of icons that you can find in the Tools toolbar when you are in the OfficeSurvey™module:

Move Label

Segmentation

Sampling

Auto-Classify Outdoor

Auto-Classify Indoor

Limit Box Extraction

Annotate

Measure

Cutting Plane

Contouring
Profile/Cross-Section

EasyProfile

2D-EasyLine

Polyline Drawing

Catenary Drawing

Alignment Stationing

2D-Polyline Inspection

Volume Calculation

Twin Surface Inspection

Surface to Model Inspection

Inspection Map Analyzer

Floor Inspection

Wall Verticality Inspection
3D Inspection

3D Inspection Analyzer

Fitting

Mesh Creation

Mesh Editing

Ortho-Projection

Convert to Ortho-Image

Multi-Ortho-Projection

Image Rectification

Feature Set

Edit Library
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4.3.8.2.7 Tools in the Modeling Module

Here is a list of icons that you can find in the Tools toolbar when you are in the Modeling module:

Segmentation

Sampling

Auto-Classify Outdoor

Auto-Classify Indoor

Limit Box Extraction

Annotate

Measure

Cloud-Based Modeler

Geometry Creator

Modify Geometry

Intersect

Duplicate

Plane Bounding

Auto-Extract Cylinders

4.3.8.2.8 Windows

Here is a list of icons that you can find in the Windows toolbar:

WorkSpace window

Property window

Selection List Window

Classification Layers

Limit Boxes

Station Maker List

Lock Panes

Ribbon/Toolbar

Switch Theme

Export Log

Cascade

Tile Vertically

Tile Horizontally

Close All Windows

4.3.8.2.9 Working Frame

Here is a list of icons that you can find in the Working Frame toolbar which only appears when you select the related com-
mand:
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UCS Creation

4.3.8.3 Shortcut Keys in RealWorks

You can use shortcuts to carry out the following common tasks in RealWorks.
Press: To:
CTRL + 0 Open a file
CTRL + S Save a project
CTRL + Z Undo the last action
CTRL + Y Redo the last action
CTRL + X Cut the selected object
CTRL + C Copy the selected object
CTRL + V Paste the selected object
Del. Delete the selected object
CTRL + F Access to the Find function
CTRL + M Merge two selected clouds
CTRL + D Delete a geometry
Home Zoom Extents
X Center on Point

4.3.8.3.1 Cloud Renderings

You can use the following shortcut keys when applying Cloud Rendering options to clouds.
Press: To:
1 Render cloud(s) in white color
2 Render cloud(s) in Cloud color
3 Render cloud(s) in Station color
4 Render cloud(s) in Scan color
5 Render cloud(s) in Grey Scaled Intensity
6 Render cloud(s) in Color Coded Intensity
7 Render cloud(s) in True color
8 Render cloud(s) in Color Coded Elevation

Note: You need to first pick anywhere in the 3D View or perform a selection in the 3D View.

4.3.8.3.2 Geometry Renderings

You can use the following shortcut key for displaying the edges of displayed geometries.
Press: To:
O Display the edges of displayed models

4.3.8.3.3 Standard Views

You can use the following shortcut keys when changing the Standard View.
Press: To:
Ctrl + 5 Bring the standard view to Front
Ctrl + 0 Bring the standard view to Back
Ctrl + 8 Bring the standard view to Top
Ctrl + 2 Bring the standard view to Bottom
Ctrl + 6 Bring the standard view to Right
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Ctrl + 4 Bring the standard view to Left

Note: You need to first pick anywhere in the 3D View or perform a selection in the 3D View.

4.3.8.3.4 Station Markers and Station Marker Labels

You can use the following shortcut keys for displaying (or hiding) all station markers and station marker Labels.
Press: To:
J Show (or hide) station markers
K Show (or hide) station marker labels

Note: You need to first pick anywhere in the 3D View or perform a selection in the 3D View.

4.3.8.3.5 Gray-Scale Intensity With Color Rendering

You can use the following shortcut key for applying a Gray-Scale Intensity with Color overlay to clouds in the 3D View.
Press: To:
B Apply a gray-scale intensity with color overlay

Note: You need to first pick anywhere in the 3D View or perform a selection in the 3D View.

4.3.8.3.6 View Manager

You can use the following shortcut keys when the View Manager toolbar opens at the bottom of the 3D View.
Press: To:
F11 Set the active sub-view in full mode
CTRL +
F11

Replace the current view by the next one (only available in full mode)

SHIFT +
F11

Hide all open windows except the 3D View window or display them if
hidden

4.3.8.3.7 Picking Parameters

You can use the following shortcut keys when the Picking Parameters toolbar appears to pick with constraints in the 3D
View (in the XYZ Coordinate System).
Press: To:
Shift + X Lock the X coordinate
Shift + Y Lock the Y coordinate
shift + Z Lock the Z coordinate

You can use the following shortcut keys when the Picking Parameters toolbar appears to pick with constraints in a 2D View
(in the Cartesian System).
Press: To:
Shift + H Lock the H coordinate
Shift + V Lock the V coordinate

You can use the following shortcut keys when the Picking Parameters toolbar appears to pick with constraints in a 2D View
(in the Polar System).
Press: To:
Shift + A Lock the Angle coordinate
Shift + D Lock the Distance coordinate

4.3.8.3.8 Head Always Up

You can use the following shortcut key for selecting (or deselecting) the Head Always Up option.
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Press: To:
U Select the Head Always Up option

4.3.8.3.9 Limit Box Extraction

You can use the following shortcut keys with the Limit Box Extraction.
Press: To:
R Rotate
T Pan
E Modify Shape
á Move the Limit Box Up (1) (2)
â Move the Limit Box Down (1) (2)
à Move the Limit Box Right (1)
ß Move the Limit Box Left (1)
Page Up Move the Limit Box Back (1)
Page Down Move the Limit Box Forward (1)
Esc. Leave the Box Extraction Tool

Notes:
n (1) These keys are only available in the Pan mode. Be sure that NUM LOCK is unpressed (or is Off).
n (2) Along the axis which is the closest to the vertical.

4.3.8.3.10 Limit Box Mode

You can use the following shortcut keys with the Limit Box Mode.
Press: To:
F4 Launch the Limit Box Mode
R Rotate
T Pan
E Modify Shape
á Move the Limit Box Up (1) (2)
â Move the Limit Box Down (1) (2)
à Move the Limit Box Right (1)
ß Move the Limit Box Left (1)
Page Up Move the Limit Box Back (1)
Page Down Move the Limit Box Forward (1)
Esc. Leave the Box Extraction Tool

Notes:
n (1) These keys are only available in the Pan mode. Be sure that NUM LOCK is unpressed (or is Off).
n (2) Along the axis which is the closest to the vertical.

4.3.8.3.11 Segmentation

You can use the following shortcut keys with the Segmentation.
Press: To:
Shift and drag the mouse Draw a freehand selection
I Keep points inside the defined fence
O Keep points outside the defined fence
P Create the fenced points as a cloud
Esc. Cancel the defined fence

Or
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Leave the Segmentation Tool
Space Bar End fence
Double Click End fence

4.3.8.3.12 Fitting

You can use the following shortcut keys with the Fitting.
Press: To:
I Keep points inside the defined fence
O Keep points outside the defined fence
P Create a fitted entity
Esc. Cancel the defined fence

Or
Leave the Fitting tool

Space Bar End fence
Double Click End fence
F Fit geometry to cloud

4.3.8.3.13 Cloud-Based Registration

You can use the following shortcut keys with the Cloud-Based Registration.
Press: To:
Esc. Leave the Cloud-Based Registration Tool
F Refine the registration
F5 Apply the registration
C Change the manipulator center location

4.3.8.3.14 Geometry Modifier

You can use the following shortcut keys with the Modify Geometry tool.
Press: To:
Shift + E Change the shape of the selected entity
Shift + T Pan along the Home Frame axes
Ctrl + T Pan along its own axes
Shift + R Rotate around the center of the selected entity
C Change the location of the manipulator

4.3.8.3.15 SteelWorks Creator

You can use the following shortcut keys with the SteelWorks Creator.
Press: To:
Ctrl + H Select the H Section type
Ctrl + I Select the I Section type
Ctrl + U Select the U Section type
Ctrl + L Select the L Section type
Ctrl + T Select the T Section type

4.3.8.3.16 Tank Creation

You can use the following shortcut keys with the Tank Creation / Tank Classification.
Press: To:
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I keep points inside the defined fence
O Keep points outside the defined fence
P Assign the desired tank part

4.3.8.3.17 Toolbar/Ribbon

You can use the following shortcut keys to switch from Toolbar to Ribbon, and vice versa.
Press: To:
Ctrl + F1 Minimize or restore the Ribbon
Ctrl + Alt + F9 Switch from Toolbar to Ribbon

4.3.8.3.18 Image Rectification

You can use the following shortcut key with the Image Rectification.
Press: To:
Shift + R Set image resolution

4.3.8.3.19 Magnifier for Point Clouds

You can use the following shortcut key with the Magnifier.
Press: To:
N Set the Magnifier mode for point clouds

4.3.8.3.20 Magnifier for Geometries

You can use the following shortcut key with the Magnifier.
Press: To:
W Set the Magnifier mode for geometries

4.3.8.3.21 Ortho-Projection

You can use the following shortcut keys with the Ortho-Projection tool.
Press: To:
Shift + C Define a projection plane by existing ortho-image
Shift + R Define resolution of ortho-image

4.3.8.3.22 FF/FL Analysis (ASTM E1155)

You can use the following shortcut key with the FF/FL Analysis (ASTM E1155) tool.
Press: To:
A Add sample

4.3.8.3.23 Polyline Drawing

You can use the following shortcut key with the Polyline Drawing tool (when a polyline is selected in the tool).
Press: To:
L Change to the Line mode

C Change to the Arc mode

A Change to the 3-Point Arc mode

Enter Create the defined polyline

Esc. Close the Polyline Drawing tool

Ctrl + Shift + D Duplicate manually a polyline

Merge Coplanar Polylines
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You can use the following shortcut key with the Merge Coplanar Polylines features.
Press: To:
Ctrl + J Merge coplanar polylines

4.3.8.3.24Move Mesh
You can use the following shortcut key with the Move Mesh tool.
Press: To:

Shift + T Pan a mesh along the Home Frame axes

Shift +R Rotate a mesh around its center

C Change the manipulator location

4.3.8.3.25 Create Pipe
You can use the following shortcut key with the Create Pipe tool.
Press: To:

C Start a new run by picking two points on the cloud

G Start a new run by picking an already created cylinder

E Change the active extremity

4.3.9 Customize the User Interface

By default, all windows except the Property and Selection List windows are open within the user interface. Toolbars* are
also open and are displayed either horizontally under the menu bar or vertically along the left side of the 3D View.

Note: (*) In only the menus and toolbars layout.

4.3.9.1 Windows

You can display (or hide) any window as required. Note that you cannot close the 3D View. You can only reduce (or resize)
it.

4.3.9.1.1 Display a Window

To display a window:
1. Select Window from the menu bar.
2. Select a window (to display) from the drop-down menu.

Or
3. Right-click anywhere on any open toolbar.
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4. Select a window (to display) from the pop-up menu by checking it.

Tip: You can also select a window to open from the Windows toolbar.

To display a window:
n On the View tab, in the Windows group, click on e.g. the WorkSpaceWindow icon to display the window.

4.3.9.1.2 Hide a Window

To hide a window:
1. Select Window from the menu bar.
2. Select a window (to hide) from the drop-down menu.

Tips:
n You can also click on the Close button or right-click on the Title Bar (of a Floating window) and select Hide from

the pop-up menu.
n You can right-click anywhere on any open toolbar and select a window (to hide) from the pop-up menu by un-check-

ing it.

Note: An open window has its icon highlighted in the drop-down menu.

Tip: You can also select a window to hide from the Windows toolbar.

To hide a window:
n On the View tab, in the Windows group, click on e.g. the WorkSpaceWindow icon to hide the window.

4.3.9.1.3 Undock a Window

To undock a window:
1. Move the pointer somewhere over an area of the window (to un-dock). A good place to point is the title bar.
2. Press and hold the mouse button while you drag the window to a suitable location in your working environment.
3. Release the mouse button to drop the window to its new location. It will remain in this new place until you move it

again (or close it).
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Tip: A window, once moved from its Docking position, becomes Floating. You can check its status by right-clicking on the
Title Bar.

4.3.9.1.4 Dock a Window

To dock a Window:
1. Move the pointer somewhere over an area of the window (to dock). A good place to point is the Title Bar.
2. Press and hold the mouse button while you drag the window. A diamond guide appears.

1 - Guide Diamond
2 - Four arrows pointing toward the four sides of the edit-
ing panel

3 - Four additional arrows pointing toward the
four edges of the user interface

3. When the window reaches the location to dock, move the pointer over the corresponding portion of the guide dia-
mond. The desired area is then shaded.

4. Release the mouse button to drop the window to its new location. It will remain in this new place until you move it
again (or close) it.

Tip: You can also right-click on the Title Bar of an undocked window and select Docking from the pop-up menu. The win-
dow is then re-docked to its initial position.

4.3.9.1.5 Lock Windows from Undocking

You can lock all window panels (once docked within the RealWorks user interface) to avoid unintentional un-docked when
double-clicking on a title bar or when dragging and dropping a window.
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To lock all windows from undocking:
n On the View tab, from the Windows group, click the Lock Windows icon.

4.3.9.2 Toolbars

In the Menus and Toolbars layout, you can display (or hide) any toolbar as required.

To display a toolbar:
1. In the Window menu, select Toolbars.
2. Select a toolbar (to display) from the drop-down submenu.

Tip: You can right-click anywhere on any open toolbar and select a toolbar (to display) from the pop-up menu.

To hide a toolbar:
1. In the Window menu, select Toolbars.
2. Select a toolbar (to hide) from the drop-down submenu.

Tip: You can right-click anywhere on any open toolbar and select a toolbar (to hide) from the pop-up menu.

To move a toolbar:
1. Move the pointer somewhere over an area of the toolbar that does not display a button (or drop-down list). A good

place to point is the title bar.
2. Press and hold the mouse button while you drag the toolbar to a suitable location in your window.
3. Release the mouse button to drop the toolbar to its new location. It will remain in this new place until you move it

again or close it.

4.3.10 Customize the Quick Access Toolbar

The Quick Access Toolbar can be customized either in its contents to contain the set of commands you need or in its pos-
ition. The settings resulting from this customization, can be exchanged between different versions of RealWorks, by export-
ing and importing a file with the QAT extension. This exchange ability is applicable only from the version 10.2 of RealWorks.

4.3.10.1 Move the Quick Access Toolbar

The Quick Access Toolbar can be moved to the two possible locations:
To move the Quick Access toolbar:

1. Click the Customize Quick Access Toolbar .
2. Choose More Commands from the drop-down list. The Trimble RealWorks dialog opens.
3. Do one of the following:

n Keep the Show Quick Access Toolbar Below the Ribbon option unchecked to display the toolbar at its default loc-
ation, at the upper-left corner of the user interface, next to the Trimble RealWorks button image.

n Check the Show Quick Access Toolbar Below the Ribbon option to display the toolbar below the ribbon.
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4. Click OK. The Trimble RealWorks dialog closes.

Tip: You can also choose Show Above the Ribbon or Show Below the Ribbon from the Customize Quick Access Toolbar
list.

Tip: You can also choose More Commands from the Support tab.

4.3.10.2 Add a Command to the Quick Access Toolbar

You can add buttons that represent commands to the Quick Access Toolbar.
To add a command to the Quick Access toolbar:

1. Click the Customize Quick Access Toolbar .
2. Check one of the default commands from the drop-down list:

Or
3. Choose More Commands from the drop-down list. The Trimble RealWorks dialog closes.
4. Click on the pull-down arrow and choose a tab from the drop-down list.

Note: Some tabs appear two times, like for example Home. This is because it is in the Registration module and in
the Production module.

5. Choose a command from the list.
6. Click the Add button.
7. Click OK. The Trimble RealWorks dialog closes.

Note: In the Quick Access Toolbar, the commands are arranged in the order where they were added.

4.3.10.3 Export the Quick Access Toolbar

To export the Quick Access toolbar:
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1. From the Support tab, click on the Quick Access Toolbar pull-down arrow.
2. Choose Export Quick Access Toolbar from the dropped-down list. The Export Quick Access Toolbar dialog opens.
3. Keep the default name which is "Commands".
4. Or enter a new name in the File Name field.
5. Locate a drive/folder to store the file in the Look In field.
6. Click OK. The Export Quick Access Toolbar dialog closes.

4.3.10.4 Import the Quick Access Toolbar

To import the Quick Access toolbar:
1. From the Support tab, click on the Quick Access Toolbar pull-down arrow.
2. Choose Import Quick Access Toolbar from the dropped-down list. The Import Quick Access Toolbar dialog opens.
3. Navigate to the drive/folder where the *.qat file is located.
4. Click on the file to select it. Its name appears in the File Name field.
5. Click Open. The Import Quick Access Toolbar dialog closes.

4.3.10.5 Show the Quick Access Toolbar Below/Above the Ribbon
To show the Quick Access toolbar below the ribbon:

1. Click the Customize Quick Access Toolbar .
2. Choose the Show Below the Ribbon option from the drop-down list.

To show the Quick Access toolbar above the ribbon:

1. Click the Customize Quick Access Toolbar .
2. Choose the Show Above the Ribbon option from the drop-down list.

4.3.10.6 Restore the Commands to the Default Values

To restore the commands to the default values:
1. From the Support tab, click on the Quick Access Toolbar pull-down arrow.
2. Choose Restore Defaults Commands from the dropped-down list. A dialog opens.
3. Click Yes to restore the Quick Access Toolbar commands to the default values.
4. Click No to keep the Quick Access Toolbar commands with the customized values

4.4 Set the Unit of Measurement for Length

Before you start working on your project, you can set the unit of measurement to be used for all distance and/or length val-
ues; in order to properly represent your data set. You can do this either from the Preferences / Units dialog or from the
short-cut field at the bottom right corner of the user interface.

To define the unit of measurement:
1. Click inside the unit of measurement field at the bottom right of the user interface. The Preferences / Units dialog

opens.
2. Click on the Length pull-down arrow.
3. Choose a unit of measurement from the drop-down list.
4. Click OK. The Preferences / Units dialog closes.

4.5 Set a Preference
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Preferences allow you to customize the behavior and aspects of RealWorks. These preferences are grouped under seven
tabs. Preferences are persistent in RealWorks, i.e. the setting changes will be memorized and used for the following
RealWorks sessions.

To set a preference:

1. From the Quick Access Toolbar, select Preferences . The Preferences dialog opens.
Or

2. First right-click in the 3D View (except on a displayed object and not within an open tool).
3. And then, select Preferences from the pop-up menu.

4.5.1 Viewer

The preferences in the Viewer tab are described in the table below and allow you to control the behavior and the aspect of
the 3D View.
This Option Enables
Display Coordin-
ate Frame

To specify the choice between displaying and hiding the coordinate frame
in the 3D View.

Display Scale In
Orthographic
Mode

To specify the choice between displaying and hiding the scale in the 3D
View.

Polyline Width
(Pixel)

To specify the width of all polylines in the software.

Background
Color

To change the background color of the 3D View window. The default color
is dark gray when you first start RealWorks. You can change it to the color
you prefer. In addition to this, you can apply a gradient effect to this back-
ground color.

Highlight Color To change the color of the bounding box of selected objects. The default
color is yellow.

Information Box
Opacity

To apply transparency on any 3D widgets (like Information Box) and on any
Labels (Measure, Station Markers, Annotation Labels, Feature points, etc.).

3DWidgets Style To choose a style between Dark and Light for all 3D widgets (Information
Box, Labels, Annotations, etc.).

Empty Pixels
Color

To choose between black and white color to display empty pixels in an
inspection map.

4.5.2 HD Display

The preferences in the HD Display tab are described in the table below. They enable you to allocate a size to the VRAM
and RAM. HD stands for High Definition, RAM for Random Access Memory (volatile memory for the CPU) and VRAM for
Video Random Access Memory (volatile memory of the graphical card). VRAM, when increased, will improve the display
quality (number of points displayed) in HDmode at some point but also the point display processing mode. RAM is a disk
cache memory. When increased, it will improve the point loading performance in HDmode.
This Option Enables
Auto To automatically set the VRAM and RAM sizes according to the user's current

graphics card memory.
Advanced The user define manually allocated VRAM or RAM.

The Advanced option has to be chosen if you are an advanced user of RealWorks because you need to adapt the VRAM
and RAM values to the specifications of your computer. Both allocated VRAM and RAM sizes should be smaller than the
physical RAM size. For a smooth experience, the allocated RAM size should preferably be equal to or larger than twice the
allocated VRAM size. The VRAM size should be increased depending on the CPU speed. The dialog will ceil values if they
are too high for the amount of the computer RAM or VRAM.
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4.5.3 Tools

The preferences in the Tools tab are described in the table below and are dedicated to the tools options.
This Option Enables
Keep displayed objects vis-
ible when starting seg-
mentation

To keep or to not keep the display state (clouds and geo-
metries) once entering in a partition tool, like e.g. the Seg-
mentation tool.

Fence color To change the color of a fence when using a tool like the
Segmentation tool.

Drawing color To change the color of a drawing when using a tool like the
Polyline Drawing tool.

3D size To change the size of the manipulators when manipulating
a geometry.

Auto Save After Extraction
from Scan Explorer win-
dow

To automatically save the project in Trimble RealWorks for
each extraction done in Trimble Scan Explorer.

Note: If you try to change the color of a drawing in progress while you are using a tool like the Polyline Drawing tool, a warn-
ing message pops up and prompts you to first close the tool.

Note: You can change the color of a fence in progress when using a tool like the Segmentation tool.

4.5.3.1 Define the Width of All Polylines

This option lets the user define the width of all polylines in the software. The default value is 2 pixels. The minimum value
and the maximum value are respectively 1 pixel and 10 pixels. The option, once chosen, is not applied to the polylines that
are being constructed but to those that are already created in the database.

4.5.3.2 Keep / Not Keep Displayed Objects Visible When Starting Segmentation

This preference enables to keep (or to not keep) the display state (of points (and/or of geometries)) when entering in a tool.
Instead of having only the selected cloud (or geometry) displayed after entering a tool, you now have the choice between
displaying and not displaying the unselected clouds and/or geometries. The tools, that are concerned, are those using the
cloud segmentation tool directly or not, such as:

n Segmentation as a main tool or a sub-tool,
n Fitting as a main tool or a sub-tool,
n SteelWorks tool.
n Railing tool,
n Etc.

Note: This preference is not activated by default. Once activated, it becomes persistent.

4.5.3.3 3D Manipulators Enhancements

When manipulating a geometry, you can change the 3D manipulators' size from Small to Large. In this way, you can tune
their size so that they are always easy to click.
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When you hover the cursor over a manipulator, it gets highlighted to let you know that it is active.

When using the Modify Shape manipulator, the corresponding value is shown in the information box.

The radius manipulator for a cylinder is now located at the center to avoid mis-selection with the length manipulator.
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When picking a geometry in the Modify Geometry and Intersect tools, only the geometries of the required types are con-
sidered, even if other geometries or point clouds are displayed.

4.5.4 Navigation

The preferences in the Navigation tab are described in the table below and are dedicated to the navigation options in the 3D
View.
This Option Enables
Head
Always Up
(Z Axis)

When you move a 3D scene (rotate, zoom or pan) in the 3D View, you may
lose its orientation in relation to the coordinate frame. This option allows you to
keep the 3D scene with its Z direction always up (relative to the active coordin-
ate frame).

Reverse
Mouse-
Zoom

To invert the motion when zooming in (or out) in all viewers (3D or 2D).

Reverse
Mouse-

To invert the direction of the rotation (in the WalkThrough mode only).
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Rotation
Reverse
Mouse-Pan

To invert the direction of the translation (in the WalkThrough mode only).

Auto-Spin A scene to turn around itself with a speed defined by the last mouse move-
ment.

Rotate To assign a mouse button for the rotation.
Pan To assign a mouse button for the translation.
Default Box
Size

To change the size of the clipping box in the Magnifier tool in a range between
1 km and 1 mm. The default size is 1 cubic meter.

Auto-
Centered

To center the cropped area at the center of the screen in the Magnifier tool
when the option is activated.

Tip: You can use the U shortcut key instead of checking the Head Always Up (Z Axis) option.

4.5.5 General

The preferences in the General tab are described in the table below.
This Option Enables
Stack Size
For
Undo/Redo

To specify the number of levels for undo/redo operations. You can choose
between 1 and 50.

Location RealWorks creates a temporary backup file for each opened project. This
option allows you to specify a location to which this backup file will be stored.
By default, the backup folder is Windows/Temp.

Capacity This field indicates the capacity of the selected folder.
Coordinate
System

To choose between the Cartesian Coordinate System and the Geographic
Coordinate System.

Orientation
Measure Sys-
tem

To choose between two systems (Grade and Ratio) for the orientation meas-
urement annotation. Grade (Percentage) is a ratio of Rise to Run. Ratio
(Meters) is the correspondence between horizontal and vertical displacement
stated in a reduced format.

Language
Settings*

To select a language. The setting will only take effect next time the application
is launched.

Start Page To display the Start Page when you start the software, only if the option has
been checked. The setting will only take effect next time the software is
launched.

Note: (*) A warning dialog opens and warns that you need to restart RealWorks when changing the language setting. Other-
wise the new language setting will not be taken effect.

4.5.6 Units Preferences

The preferences in the Units tab are described in the table below. They allow you to set the unit system to use in your pro-
ject.
This Option Enables
Decimal
Places

To specify the number of digits after the decimal point.

Display
Value With
Unit Tag(s)

To display digital values with unit tag(s).

Unit Sys-
tem

To select the unit system between the Metric System and the US/British Sys-
tem for Length, Diameter, Angle, Area, Volume, and Residual. Use the drop-
down to choose one from the list.

Alignment To specify the format used to display a position with the stationing.
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Stationing

Tip: You are able to change the unit of measurement for Length directly within the user interface of RealWorks without hav-
ing to open the Preferences dialog. Please, refer to the Set the Unit of Measurement for Length topic.

Note: The US Gallons and Imperial Gallons have been added as units to quantify a Volume.

Note: The Fractional Inch format has been added for Length, Diameter and Residual Error in the following format: Inch for a
full unit (multiple of full unit) and Fraction of Inch for a portion of a unit divided equally into parts (e.g. 3 1/16).

4.5.7 Print Preference

The preferences in the Print tab are described in the table below.
This Option Enables
User Defined Logo To use an image file in BMP format as logo when running a report.
Trimble Logo To use the Trimble logo as logo when running a report.

4.5.8 Improvement Program Preferences

The Trimble Solution Improvement Program (TSIP) is implemented by Trimble to help us improve the quality, reliability, and
performance of our software products. If you select to participate in the program, the software will collect anonymous inform-
ation about your hardware configuration and how you use the software. Periodically, a file containing the collected inform-
ation will be sent to Trimble to help us identify trends and usage patterns.

No information will be collected that can be used to identify or contact you. You can select not to participate in TSIP at any
time.

Warning: You will be prompted to restart the software if you change the improvement state.

To participate in TSIP:
1. Click on the Improvement Program tab. The Trimble Solution Improvement Program dialog appears.
2. Click on theThe Read More About Trimble Solution Improvement Program Online link.
3. Carefully read the information that is displayed.
4. Check the Yes, I Want to Participate in the Program option.
5. Click OK.

To not participate in TSIP:
1. Click on the Improvement Program tab. The Trimble Solution Improvement Program dialog appears.
2. Click on the The Read More About Trimble Solution Improvement Program Online link.
3. Carefully read the information that is displayed.
4. Check the No, I Do Not Want to Participate in the Program option.
5. Click OK.

4.6 Close Trimble RealWorks

The way to close Trimble RealWorks is similar to other softwares, by selecting Exit from the File menu or by clicking

on the top right corner of the user interface.
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This chapter is dedicated to all basic operations, like e.g. the opening and the importation of project files into RealWorks.

5.1 Supported Data Formats

RealWorks supports numerous file formats. There are those that are Trimble's (software) proprietary formats, those coming
from Trimble's instruments (or from competitors), those generated from third-party software, etc.

5.1.1 Trimble 3D Scanning Files

A Trimble 3D Scanning File is a file with one of the following extensions: *.rwp, *.raw, *.jxl, *.asc, *.neu *.tzs and *.tzf.
Among all these file formats, some can be imported into an existing project and others cannot. A file of the following exten-
sion rwp cannot be imported. Only those of asc,neu, tzs and tzf extensions or those coming from the Trimble Survey Con-
troller™, Survey Manager™ or Survey Pro™ software (JobXML and related) can be imported.

Below are listed all the extensions and the application from which each extension is from.
n RWP Trimble proprietary RealWorks project file format.
n ASC a well-known ASCII coordinate file.
n NEU a Neutral file format identical to ASC.
n TZS Historical Trimble Scan File format file (will be converted into TZF)
n TZF Trimble Scan File format file,
n Etc.

5.1.2 RealWorks Files

RWP is a proprietary format of Trimble. It is a project file format. The RWI folder is a folder linked to the RWP format file. It
contains all data files of a project (RWC and RWV for versions of RealWorks before 8.0 and RWCX and RWV for
RealWorks 8.0). RWC and RWCX are cloud format files. RWV is an image format file.

A project file saved in a version of RealWorks older than 5.0 is not supported anymore in 8.0. When you try to open such a
file, an error message appears.

When you open a project saved in a version of RealWorks older than 8.0, all the project files are converted to the 8.0
format. The conversion takes a certain amount of time and is temporary.

If you decide to save the project under the same name (after converting), the conversion becomes definitive and cannot be
canceled. The project will not be accessible with older versions of RealWorks. The conversion (of all project files to 8.0
format) is only required one time. The next time you want to open the project, no conversion is required and the loading of
the project is accelerated.

If you decide to not save the project, the conversion is not applied and is lost (if you close RealWorks). The next time you
open the project in 8.0, the conversion is required again.

Note: A project will be open even if the cloud format files (RWCX) are missing. Only an error message will appear in that
case.

5
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Caution: There is a limit to the size of a TRW format file when you try to open it with RealWorks 8.0. This limit is 4 GB. If
your file size is bigger, you are able to open it, not with RealWorks version 8.0, but only from 8.1. If you try to do so, an error
message below appears.

RealWorks can import the Trimble TX8 3D scanner data using the High Precision mode. To get the High Precision data, the
Trimble TX8 3D Scanner scans four times the same scene from the same station. The data should have a smaller RMS
error (measured on planes for example) and objects from the first pass are kept. Moving objects from pass 2, 3 and 4 are
totally removed if not seen in the first pass. Four files are created, one standard TZF file and 3 other files containing inform-
ation from pass 2, 3 and 4. Those files cannot be opened directly in RealWorks.

1 - High Precision scans 2 - Standard Precision scan

RealWorks only sees the first TZF format file, not the TZFx ones. The thumbnail and the preview are available for display
only for the first TZF format file. There is no change in RealWorks, neither in the workflow nor in the project properties.

When you extract some data from the TZF files or open Trimble Scan Explorer, the post-processing is triggered. The TZF
files from the High Precision mode are first detected and then merged into one. At the end, all the original files are removed
and only the processed TZF remains.

Caution: If your project file comes from the import of JXL format files from the Trimble SX10 instrument, you are able to
open it with RealWorks, only from the 10.1 version. If you try to do it with an earlier version, the error message below
appears. This restriction is due to the numerous images that the SX10 instrument can capture.
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5.1.3 TZF Files

TZF is a proprietary format of Trimble. A file with such a format is essentially a Trimble Scan File.
n A project and a station* will be created and rooted under the Project Tree. The project is named ProjectX where X is

its order. The station takes the name of the TZF format file.
n A TZF Scan is also created and put under the station.
n The project is not saved. The user has to save it manually.
n Once saved, a project file and a folder are created. Both are named according to the name given by the user, with a

RWP extension for the first and a RWI extension for the second. The RWI folder is empty of content.

Note: The processing mode will automatically switch to Registration. The Scans Tree is selected by default.

Tip: A TZF format file can be either opened as a single project or imported into an existing project.

Note: (*) A Leveled Station is created and rooted in the Scans Tree for each TZF format file tagged as Leveled, once open
(or imported) into RealWorks.

You can preview a TZF format file as a Thumbnail in Windows Explorer. You need to first enable the Thumbnail Preview in
Windows Explorer and then to set the icon view size to Medium Icons, Large Icons or Extra Large Icons.

Some new information has been added to TZF format files, in RealWorks 8.0. This information, related to the instrument
itself and to the scanning settings, like Starting/Final Temperature (Internal) (in Celsius and Fahrenheit), Atmospheric Cor-
rection PPM (Parts Per Million), Grid Steps, Instrument Leveling and etc. appear when you display the properties of a TZF
Scan (only if the Property window is open).
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Caution: The Extended range density is a level which only appears with an optional upgrade (of the TX8 instrument). For
more information about the Extended feature, please refer to the Trimble TX6 / TX8 user manual.

MULTIPLE SCANS:

When a set of TZF files belonging to the same station is open through the File / Open command, a project and a station are
created. A TZF Scan is created per TZF file. All TZF Scans are put under the (same) station and only one is by default a
Main Scan.
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Note: If you drag and drop a set of TZF files into RealWorks, you will get the same result: a project with a station and a set
of TZF Scans (one per TZF file). All TZF Scans are placed under the station.

There is a tip to differentiate a native TZF Scan (coming from a Trimble TX instrument) and those converted from other (or
competitor) format files. In the first case, the name of the instrument is displayed in the Instrument Name line. [See A].

[A]

In the last case, the text "Converted from *.* file" appears in the Instrument Name line. See [B].

[B]
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COLORED SCANS:

The new TX series has the capability to capture images thanks to its embarked camera. These images can be taken in the
Standard (or HDR) mode, with (or without) the exposure correction. After loading the RWP project file into RealWorks, you
can check with which color acquisition mode and with which type of exposure a scan has been acquired by displaying the
properties of its related TZF Scan in the Property window.

A TZF Scan before the post-processing is triggered:

A TZF Scan, post-processed and colored:
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Some color discontinuities between individual images may be visible after coloring the TZF Scans (from the Trimble TX6
and TX8 instruments). Now in RealWorks 10.3, these images are blended so that the quality of the colorization is greatly
enhanced:

Note: All the TCF format files will be merged with the TZF files after the data processing. So if the user hasn't made a copy
of its original data sets, it is not possible to go back.

5.1.4 TZS Files

A TZS format file is a Trimble Scan File. For each TZS format file, a warning dialog appears and prompts you to proceed to
the conversion to the TZF format (or not).

Notes:
n The processing mode will automatically switch to Registration. The Scans Tree is selected by default.
n A TZS format file can be either opened as a single project or imported into an existing project.

Caution: You cannot open TZF format files in RealWorks 7.0 or lower.

To not convert to the TZF format:
n In the warning dialog, click No. If there is an open project, the project will close. If there is no open project, nothing

happens (no project is created).

To convert to the TZF format:
1. In the warning dialog, click Yes. An Information dialog appears.
2. Click OK. The Save dialog opens. The default folder is the folder where the TZS format file is.
3. Keep the default folder.
4. Or navigate to a drive/folder where you want to store the project.
5. Keep the default name which is ProjectX.
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6. Or input a name in the File Name field. The RWP extension is automatically added.
7. Click Save. The conversion is then performed.

Once completed, a project and a station are created and rooted under the Project Tree. The project has the name
given by the user. The station has the name of the TZS format file.

A TZF Scan is created under the station.

A project file and a folder are created. Both are named according to the name given by the user, with a RWP exten-
sion for the first and a RWI extension for the second. Under the RWI folder, a scan file with the TZF extension is also
created.

5.1.5 JobXML, JOB and RAW Files

A JobXML file (with *.jxl extension) is a text file exported from Trimble Survey Controller™, Survey Manager™ or Survey
Pro™ software in an XML based format. Some dependency files may be related to the JobXML file (such as scan files with
TSF extension (*.tsf stands for Trimble Scanning File) and JPEG images (*.jpg extension)).

A JOB file (with *.job extension) is a binary file format. It can be a Trimble Survey Controller job file or a Trimble Access job
file. In the first case, if Trimble Data Transfer© is installed on your computer, you can open a Survey Controller™ JOB. If
Trimble Data Transfer© is not detected on your computer, you cannot open it as the "Job Files (*.job)" file of type line in the
Open dialog is not available. In the second case, you need to have Trimble General Survey (Office Survey) installed on
your computer. Trimble Data Transfer and Trimble General Survey, both contain a converter. RAW file (with *.raw exten-
sion) is a SurveyPro™ native ASCII (or TXT) file format.

Objects in the JobXML (or Job or RAW) format file are opened (or imported) within the Scans Tree as follows:
n Points surveyed from one station setup are imported as standard survey points within each station,
n GPS points and keyed-in points are imported as topo-points within the TopoStation System folder,
n Each station of the Instrument is opened (or imported) as leveled station,
n Registered scans using the scanning capabilities of the Instrument are put under their respective station,
n Images taken from the Instrument are registered under the respective station if the stationing is carried out when

shooting the images. Images are put with no link to the station under the Images Tree if stationing has not been car-
ried out when shooting the images.
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1 - Leveled stations
2 - Images and scans

3 - Surveyed points opened or imported as
topopoints

A warning message appears when:
n Points are surveyed with no altitude. These points are then opened (or imported) with altitude 0 in RealWorks,

Z is equal to zero for points with no altitude
n Linked images / scans are missing from the reading folder. When opening (or importing) a JobXML (or Job or RAW)

format file, it refers to external files that contain scanning data and images respectively with the TSF (Trimble Scan-
ning File) extension and the JPG extension. These files are supposed to be in the same folder as the JobXML (or
Job or RW) file. Missing TSF files are shown as null size scans and Missing images as broken link images.

1 - Missing TSF file opened (or imported)
as null size scan

2 - Missing image file opened (or imported) as
broken link image

n Some object fields are missing,
n Images have been taken around zenith. These images are opened (or imported) in the Images Tree as

“Unmatched” images (they are still linked to their shooting station).
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Images taken around zenith are registered as "Matched"

Tip: You can display (or hide) the Topo Point (or Survey Point)'s 3D Labels by clicking the Display 3D Labels icon in the Sta-
tion Makers group on the View tab.

Note:When you open a JOB file format, internally, the file is converted (to the JXL format). An error message opens in
case you do not have the last converter installed on your computer. To have the latest version of the converter, please
download and install Trimble Installation Manager from the Trimble web page (http://www.trimble.-
com/installationmanager/), and then install Trimble Field Link Job File Converter.

Note: The Trimble SX10 instrument is able to capture hundreds of images from three different cameras, called Overview,
Primary and Telescope. When you open a JXL format file coming from the instrument, those images are organized in
folders, one per camera type, in each a station in the Scans Tree,

And in folders, by station and then by camera type in the Images Tree.
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When you open a JXL format file in RealWorks, two cases may occur: If there are images in the file, the point cloud is auto-
matically colorized using the color information therein in these images, in this order: Overview first, followed by Primary,
and ended by Telescope. The colorization process cannot be interrupted. If there is no picture, nothing happens. Only the
point cloud is imported.

Note: The user can stop the loading of points as well as its colorization by pressing Esc. In the first case, no point will be
loaded in RealWorks while in the second case, the colorization in progress will be stopped. Points that are already colorized
remain colorized. Those that are not yet colorized remain un-colorized.

5.1.5.1 Scale Factor

When importing a JOB (or JXL) project file for which the contents is in a Grid coordinate system, Trimble RealWorks uses
the centroid of the project to compute a Combined Scale Factor. If the Combined Scale Factor is different from 1, and as
Trimble RealWorks does only support coordinate systems with a scale factor equal to 1 (Ground coordinate system),
Trimble RealWorks will convert all the coordinates of the project with the scale factor equal to 1.

5.1.5.2 Scale Factor - Ellipsoid Model

For JOB (or JXL) format files that use an ellipsoid in the coordinate system, Trimble RealWorks will apply the conversion as
described previously.

5.1.5.3 Scale Factor - Geoid -Datum Model

For JOB (or JXL) format files that use either a geoid, or a datum, etc. in the coordinates system, Trimble RealWorks will
require an external data (Geoid files or others). These files do not come with the Trimble installer. If these files need to be
installed on your computer, Trimble RealWorks will pop up the error message below:

To avoid that such situation occurred, do one of the following:
n Install the GeoDatabase on your computer. It is already installed if Trimble Business Center has been installed for

example.
n Download Trimble Installation Manager from the Trimble web page (www.trimble.com/installationmanager) and install

it, and run the Office update.
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n Copy the Geoid Grid File(s) (or Datum Grid File(s)) based on the geoid (or datum) used in the project's coordinate sys-
tem, and put them under the Program Data\Trimble\Geo Data folder. Such files have the GGF (or DGF) extension:

5.1.5.4 Switch from Ground to Grid

You are able to switch the project coordinate system back to Grid. You need to be in Registration, select a project and
choose Apply Scale Factor from the pop-up menu.

Note: All measurements from a station, e.g. Survey Points or Scans will not have the Combined Scale Factor applied. Only
the coordinates of the Stations and TopoPoints do have the Combined Scale Factor applied.

Note: The default scale factor value, which is displayed in the open dialog, is the value of the last scaled project when
importing a JOB (or JXL) format in the current session. If no scaled import had been done, the default value is 1.0.

After applying the scale factor, the project is scaled and the values of the entities should be the same as in Trimble Busi-
ness Center.

Note:Only topo points, and station positions are moved.

5.1.6 ASCII Files

An ASCII format file may have ASC, NEU and XYZ as extensions. There are in general two sections in such a file. The first
section is called Header in which specific information about the nature of the file is stored. The second section is a list of 3D
Points. Each line contains a point represented by its X, Y, and Z coordinates plus, optionally, other attributes such as intens-
ity or color.

Tip: An ASCII format file can be either opened as a single project or imported into an existing one.

Trimble RealWorks User Guide | 60



PERFORM BASIC OPERATIONS

Notes:
n A file to open (or to import) containing some corrupted lines will be ignored.
n The processing mode will automatically switch to Production. The Models Tree is selected by default.

5.1.6.1 With Wizard

This opens aWizard which allows the user to choose the parameters to fit the ASCII format file to open.

To open with the wizard:
1. In the Open dialog, keep the OpenWizard for ASCII Files option checked.
2. Click Open. The Neutral Point Import dialog opens.

This dialog is composed of six parts: five for adjusting the parameters to import the data and one for visualization.
Header You can ignore the first lines of an ASCII file by selecting the number of lines

to skip. These lines can be headers, comments or X,Y,Z coordinates that you
do not want to keep.

Separator Separator between attributes of a point can be a Comma, Tabulation or other.

Units You have the choice between the Metric system and US/British system for the
values of X, Y, Z coordinates.

Select
Content

This part enables to display (or to not display) the information about the Intens-
ity, the Color and the Normal of loaded points.

If the Intensity option has been chosen, the user can customize the intensity
range. This means that intensity values larger than the value in the Max
Intensity field were replaced by 255 and those that are between 0 and the
Max Intensity value are mapped to the values from 0 to 255.

Data Type According to the option (or combination of options) chosen in the Select Con-
tent panel, this part identifies fourteen different combinations of the attributes
of a point. When the user chooses:

§ No option, only the "Single Coordinates X,Y,Z" option is available.
§ Intensity, the Max Intensity field and the "Coordinates and Intensity" option
become enabled.
§ Color, the "Coordinates and Color" option is enabled.
§ Normal, the "Coordinates and Normal" option is enabled.
§ Intensity and Color, the "Coordinates, Intensity and Color" and "Coordin-
ates, Color and Intensity" options are available.
§ Intensity and Normal, the "Coordinates, Normal and Intensity" and "Coordin-
ates, Intensity and Normal" options are available.
§ Color and Normal, the "Coordinates, Color and Normal" and "Coordinates,
Normal" and "Color" options are available.
§ Intensity, Color and Normal, the "Coordinates, Intensity, Color and Normal",
"Coordinates, Intensity, Normal and Color", "Coordinates, Color, Normal and
Intensity", "Coordinates, Color, Intensity and Normal", "Coordinates, Normal,
Intensity, and Color" and "Coordinates, Normal, Color and Intensity" are all
available.

If you select one of the options when you load an ASCII file without Intensity,
Color or Normal RealWorks indicates that the Intensity, Color or Normal can-
not be found and displays this error with three question marks between two
brackets.

Preview Only the first thirty points are listed in the Preview panel.

3. Choose the parameters to fit the file to open.
4. Click OK. The Neutral Point Import dialog closes.
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Tip: You can use the shortcut key Ctrl + O or click Open in the Main toolbar to pop-up the Open dialog.

Note: (*) We assume that there is no project opened. If there is one opened, the Add to Project option is enabled and
default checked. You can then import such a file into the already opened project.

5.1.6.2 Without Wizard

When you load an ASCII format without the Wizard, RealWorks attempts to determine which separator is used and the dif-
ferent attributes of a point.

To open without the wizard:
1. In the Open dialog, uncheck the OpenWizard for ASCII Files option.
2. Click Open. The Open dialog closes.

Note: An ASCII format file, when dragged and dropped into an open session of RealWorks, is loaded without the Wizard.

5.1.7 Trimble TX5 and Other FLS Files

RealWorks supports the Trimble TX5 file format originating from the Trimble TX5 3D scanning system. Such a format, with
the *.fls extension, is stored on a SD card (used with the Trimble TX5 3D scanner for storing data).

Files and folders on a Trimble TX5Scanner's SD card are structured as shown below. The FARO-LS format file is a sig-
nature file used to identify a SD card as a Trimble TX5 Scanner's SD card. The Scans folder is a folder where all acquired
scans are stored in.

An acquired scan is composed of a set of files and folders. All are put in a FLS folder under the Scans folder as illustrated
below. The file to open is mainly the FLS file in the FLS folder.

From a Trimble TX5Scanner's SD card, the opening through the File / Open menu is restricted to one FLS format file at a
time. The Import FLS Files feature avoids such restriction. Multiple selection of FLS files (or of FLS folder) is now permitted.

In addition to the FLS format, RealWorks also supports the iQscan format.

5.1.7.1 Open a FLS Format File

To open a FLS format file:
1. On the Home tab, click the Import icon. A list drops down.
2. Select the Open icon. The Open dialog opens.
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3. Select Trimble TX5 and Other FLS Files (*.iQscan; *.fls) from the File of Type field.
4. Do one of the following:

a. Navigate to the Trimble TX5' SD card.
b. Select the FLS file from the SD card / Scans / FLS folder. Its name appears in the File Name field.

Or
c. Navigate to a drive/folder where all the FLS files are located.
d. Select a FLS file (or a set of FLS files). Its name (or all names) appears (or appear) in the File Name field.

5. Click Open. The Open dialog closes.

Tip: You can also drag and drop a FLS file into RealWorks. This method is limited to one FLS file at a time.

Caution: Do not rename the extension (FLS) of the folder which contains the FLS format file to open. Otherwise, an error
dialog opens and warns you that the FLS format file has been removed (or deleted) from its previous location.

Note: A scan, acquired with colors, generates a colored file in the FLS format. The TZF Scan, that results, is colored. You
may see a colored preview in the Property window (only if it is open) when displaying the TZF Scan's properties.

Note: A scan, acquired with the dual-axis compensator On (compensated), is flagged as a leveled Fls format file. The TZF
Scan, that results, appears blue (leveled) in RealWorks. Those for which the dual-axis compensator is Off (none com-
pensated) remain yellow.

5.1.7.2 Open an IQscan Format File

To open an IQscan format file:
1. On the Home tab, click the Import icon. A list drops down.
2. Select the Open icon. The Open dialog opens.
3. Select Trimble TX5 and Other FLS Files (*.iQscan; *.fls) from the File of Type field.
4. Navigate to the drive/folder where the IQscan file is located.
5. Click on the file to select it. Its name appears in the File Name field.
6. Click Open. The Open dialog closes.

Tip: You can also drag and drop several IQScan files into RealWorks.

5.1.7.3 FLS and IQscan Import Results
n If there is one (or more) project(s) open in RealWorks, the Add to Project option is enabled. You can then choose a

project to import (the FLS or IQscan files) from the drop-down list.
n If there is no project, a dialog appears and informs you that you need to first create and save a project into the

Trimble RWP format.
Instead of importing systematically the information related to the Color, GNSS, and Tilt and Compass when they are
found in the FLS file, the FLS Import Options dialog which shows up lets the user choose the option to be imported.
This dialog opens once, even if several FLS files have been chosen as input.
- Force Full Scan: This option enables you to create an uncropped TZF Scan, by keeping pixels with no depth.
Empty pixels are on outdoor scans with large pieces of sky (Zenith) and no tall objects foreground (like the shadow
of the scanner (both indoor and outdoor) (Nadir).
- Equalize Luminance: Equalize point cloud luminance. This enhances the visual perception of the luminance but
might slightly affect the auto-extraction performances.
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For each file, a dialog appears and informs you that you need to first create and save a project into the Trimble RWP
format.
A project and a station are created and rooted under the Project Tree. You have to give a name to the project while
the station takes the file name.
A TZF Scan is also created and put under the station.

A project file and a folder are created. Both are named according to the name given by the user, with a RWP exten-
sion for the first and a RWI extension for the second. Under the RWI folder, a scan file with the TZF extension is also
created.

Note: The processing mode will automatically switch to Registration. The Scans Tree is selected by default.

5.1.8 Surveying Network ASCII Files

One of the key features of RealWorks is its ability to import surveyed data produced by other data collectors such as Total
Stations, Field Stations, etc. Each such file will be imported alone as a Topographic Station with points converted to
Topopoints or in a station with points converted to 3D points.

A file with the CRD extension is a coordinate file with five data fields (Point number, Northing, Easting, Elevation and
Description) in binary form. A file with the CR5 extension is also a coordinate file but owned by TDS. A file with the TXT
extension is an ASCII text file. Each line of the text file can contain any combination of Point number, Northing, Easting,
Elevation and Description. All point information should be on one line with the values separated by a comma, space or
other delineators. All these parameters can be customized during the loading phase in RealWorks.
The Surveying Network Import dialog which appears after opening a file is composed of six parts: five for adjusting the para-
meters to import the data and one for visualization. When you load a surveying network file, RealWorks attempts to determ-
ine which separator is used and the different attributes of a point. But you can customize these parameters:
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Import: You can import as topopoints or as 3D points.
Header: You can ignore the first lines of a Surveying Network ASCII format file by

selecting the number of lines to skip. These lines can be headers, comments,
or X, Y, Z coordinates that you don't want to keep. The number of lines that
you can skip is limited to 12. You can do the same for Column char and Com-
ment line char.

Separator: Separator between attributes of a point can be a semicolon, comma, tab-
ulation or other.

Units: You have the choice between several units: Millimeter, Meter, U.S. Survey
Foot and International Foot. The U.S. Survey Foot, defined by the National
Bureau of Standards NBS, corresponds to a value of 1200/3937m (or
0.3048006096m). The International Foot corresponds to a value of 0.3048m.

File
Format:

You can choose between two types of contents:

§ Point Number, X, Y, Z, Description,
§ Point Number, Northing, Easting, Elevation, Description.

Note: The OpenWizard for ASCII Files option in the Open dialog becomes active and is default-checked if the file to import
has a TXT extension; and remains inactive (grayed out) for files with CRD and CR5 extensions.

Tip: You can display (or hide) the Topo Point (or 3D Point)'s 3D Labels by clicking the Display 3D Labels icon in the Station
Makers group on the View tab.

5.1.8.1 Import as a Topographic Station

To import a Surveying Network ASCII format file as a Topographic Station, you need to have an open project or nothing
opens.

To Import as Topographic Station:
1. In the Surveying Network Import dialog, customize the opening parameters to fit the survey network file to open.
2. Click OK. The Surveying Network Import dialog closes.

1 - A topographic station 2 - A set of TopoPoints

Note: The processing mode will automatically swap to Registration. The Scans Tree is by default selected.
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Note:When you open a file to import topopoints, RealWorks does not create a new Topographic Station if there is already
one in the project. Topopoints from different files will be under the same Topographic Station. Also, if there are some points
in your project, you cannot import new ones with the same names and the same positions than those that already exist.

5.1.8.2 Import in an Existing Station

To import a Surveying Network ASCII format file in a station as unmatched 3D Points, you need to have an open project.

To import in an existing station:
n In the Surveying Network Import dialog, do one of the following:

n Import the surveying network file as a Topographic Station filled with Topopoints (see Import as a Topographic
Station).

n Import the surveying network file as 3D points in a station.
a. Check the In a Station (Fill with GeomPoints) option.
b. Click on the In a Station (Fill with GeomPoints) pull down arrow.
c. Choose a station from the drop down list.
d. Customize the parameters for the Surveying Network ASCII format file to open.
e. Click OK. The Surveying Network Import dialog closes.

Notes:
n The processing mode will automatically swap to Registration. The Scans Tree is by default selected.
n When importing a Surveying Network ASCII format file, you need to have at least a station within your project. Other-

wise the In a Station (Fill with GeomPoints) option is dimmed.

Caution: You are able to import points having the same names and the same positions as much as you like.

5.1.9 SIMA ASCII Files

RealWorks supports SIMA ASCII format files (Japanese survey file format). A file in such format (with sim extension) can
be opened (or imported) in RealWorks. If no project is open, the Add to Project option in the Open dialog is grayed out and
you are restricted to opening. If there is an opened project, the Add to Project option is enabled and default checked. Each
file will be opened (or imported) as a topographic station and each point converted to an unmatched Topopoint.

Note: RealWorks will swap for the Registration processing mode after opening such a file.
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Tip: You can display (or hide) the Topo Point's 3D Labels by clicking the Display 3D Labels icon in the Station Makers
group on the View tab.

5.1.10 AutoCAD Files

RealWorks can open drawings in DXF (Drawing eXchange Format) or DWG (DraWinG) file format. The DXF file format is
an ASCII file format which describes CAD data defined by AutoDesk. This file format facilitates the exchange of CAD data
between two different programs. The DWG file format is the binary file format from AutoCAD and AutoCAD LT.

To open a DXF (or DWG) format file:
1. On the Home tab, click the Import icon. A list drops down.
2. Select the Open icon. The Open dialog appears.
3. Select AutoCAD Files (*.dxf; *.dwg) from the File of Type field.
4. Navigate to the drive/folder where the DXF (or DWG) format file is located.
5. Click on the DXF (or DWG) format file's name to select it.
6. Click OK. The DXFFile Import (or DXFFile Import) dialog opens.

7. Click on the DXF Unit of Length (or DXF Unit of Length) pull down arrow.
8. Specify a unit of measurement to apply from the drop down list.
9. Choose between Merge Each 3D Face of the Same Layer into a Mesh and Merge Each 3D Point of the Same Layer

into a Cloud.
10. Or check both options.
11. Click OK. The DXFFile Import (or DXFFile Import) dialog closes.

Caution: A warning message appears if the DWG (or DXF) format file to open (or import) contains entities with no equi-
valent in RealWorks. These entities will not be opened (or imported) in RealWorks.

Note: If there is no project open, you can only open a DWG (DXF) format file. The Add to Project option in the Open dialog
is dimmed.

A set of model groups is created and put under a project rooted under the Models Tree. Each model group contains all 3D
faces (or 3D points) of the same layer - each opened as a mesh of two triangles (see A1) (or as a 3D point object (see B1
and B2)).
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A1 - A mesh has been created for each 3D face A2 - A mesh has been created for all 3D faces of the same layer

B1 - The Project Cloud is empty of points B2 - Each 3D point is opened as an object of 3D
point

There are two options in the DXFFile Import (or DWG File Import) dialog. The first when checked allows merging of all 3D
Faces of the same layer into a mesh (see A2) and the second all 3D Points into a Cloud (see B3 and B4)).
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B3 - The Project Cloud contains points B4 - All 3D points of the same layer are opened and
merged as a unique point cloud

Note: For all 3D Points of the same layer, a station is created and rooted under the Scans Tree.

5.1.11 IXF Files

A file of IXF format (Optech’s laser scanning systems - ILRIS - data format) with ixf extension can be opened (or imported)
in RealWorks. If no project is open, the Add to Project option in the Open dialog is grayed out and you are restricted to open-
ing. If there is an opened project, the Add to Project option is enabled and default checked. Each file will be opened (or
imported) as station(s) put in the Scans Tree and as points put in the current Project Cloud in the Models Tree.

5.1.12 RIEGL Scan Project Files

A file with the .rsp extension is a project file coming from the RiIEGL's RiSCANPROTM software. This file is a text file using
an XML structure. It does not contain scan data, but just links to the scan files. All of the scan files are stored in a folder with
the .rdb extension. It is named after the name of the project file. RiSCAN PROTM is the companion software for all Ter-
restrial 3D Laser Scanner Systems from RIEGL. RealWorks does support the coloring, georeferencing, registration, etc.
information that is in the .rsp format file. A RiIEGL's RiSCANPROTM project file has the structure illustrated below.
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1 - A Riegl's RiSCAN PRO format file
2 - Scan file folder

3 - Scan file
4 - Points file

In RealWorks, if no project is open, the Add to Project option in the Open dialog is grayed out and you are restricted to open-
ing a project file. If there is an open project, the Add to Project option is enabled and checked by default. Each scan file will
be converted to a TZF Scan and put under a station. All are rooted in the Scans Tree as illustrated below.

Note: RealWorks is being able to support the new RIEGL's point pout database format (RDB 2.0).

5.1.13 Z+F Scan Files

Data acquired by a Z+F 3D laser scanner can contain colors (or not) depending on how it has been acquired. For a given
data set, there are three types of files that come out of the scanner: ZFPRJ for project file, ZFS for scan files and ZFI for
image container.
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If the data has been acquired with no information of colors, only the ZFS format files are required. They can be opened (or
imported) directly into RealWorks. If the data has been acquired with colors taken by a Z+F camera (integrated or external),
the three types of files have to be processed in the Z+F LaserControl software which provides in return panoramic images,
in PNG or JPEG format. The color information is then stored in the panoramic images. If the data has been acquired with
colors taken by an external digital camera on a nodal point adapter, the images that come out the camera have to be pro-
cessed in a 3rd party software (PtGui, Autopano Giga).

In the last case, the panoramic images need to be:
n Be located in the same directory of each scan file (ZFS).
n Have the same name as the scan file (ZFS) followed by "Underscore and color".
n Have the same dimensions (in pixels) as the scan file (ZFS).

In RealWorks, if no project is open, the Add to Project option in the Open dialog is grayed out and you are restricted to open-
ing a scan file. If there is an opened project, the Add to Project option is enabled and checked by default. Each scan file
(ZFS) will be opened (or imported) as a TZF Scan put in a station in the Scans Tree.

5.1.13.1 Z+F Import Filters

The Z+F Import Filters dialog opens when you load a ZFS format file into RealWorks. From this dialog, you can choose a
set of filters to apply to points in order to keep those required, and filter out those that are noisy or badly acquired, etc.

Filter by Intensity
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This filter, when it is chosen, discards pixels that are below the Min. value and above the Max. value in terms of Intensity.
These two values are defined in percentage by the user. The default values depend on the type of the scanner.

Filter by Range

This filter, when it is chosen, discards pixels which are not in the defined range. The filter is not active when the Min. and the
Max. values are equal to zero.

Filter Edge Points

This filter, when it is chosen, removes pixels, which are on edges of objects and therefore not valid. On edges you have
mixed range values, these range values are often between the foreground and the background (but also possible in front or
behind objects).

Filter Bottom

This filter, when it is chosen, removes pixels from the bottom of the instrument (Nadir) up to a user given angle.

Remove Isolated Points

This filter, when it is chosen, removes pixels which have no valid neighbor.

Remove Bad Lines

This filter, when it is chosen, deletes the first scan lines of recording, marked by the scanner as “bad” due to laser warm-up
procedure at the early beginning of the scan (first few scan-lines).

Remove Scan Outer Boundary

This filter masks pixels at the outer borders of the scan. The first and last line and the first and the last pixel of each line are
filtered.

Remove Points at Range Discontinuities

This filter detects jumps in range and filters out pixels.

Remove Lines at Tilt Discontinuities

This filter, when it is chosen, removes lines which show too big tilt changes.

5.1.14 LAS and LAZ Files

The LAS file format is a public file format for the interchange of 3-dimensional point cloud data between data users. It is bin-
ary-based. The LAS format has several versions: 1.0, 1.1, 1.2, 1.3 and 1.4. RealWorks is able to import files from all of
those versions.

The LAZ format is a compressed version of the LAS format. Everything that is in a LAS file is also a LAZ file. The difference
is that the LAZ format offers a compression rate which is 5 to 20 times greater than the LAS format, thus providing smaller
files.

Note: LAZ files share the same version numbers as LAS files. RealWorks is also able to import LAZ files from all of those
versions.

Points in LAS/LAZ files can have intensity and/or color information. They can also have none of them. RealWorks behaves
as described below:

n If color is present without intensity, color is used to create intensity value.
n If intensity is present without color, a gray scale is applied to color.
n If color and intensity are present, both attributes are applied to color and intensity.
n If no color and no intensity are present, all points are rendered in white, in color and in intensity mode.

Note: LAS/LAZ format from 1.0 to 1.3 support at most 4 billion of points. LAS/LAZ 1.4 does support virtually infinite point
cloud size (over 4 billion of points), however the current version of RealWorks does not support importing LAS/LAZ files
with more than 4 billion points.

The 1.2 and 1.4 LAS format versions support natively the classification of point clouds. Both standards contain a slight dif-
ference in terms of number of layers.
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The import of a LAS format file, in version 1.4, should not create any issues as RealWorks sticks to the LAS 1.4 spe-
cification for point cloud classification. All valid classes (or layers), once imported, will match the same valid classes in
RealWorks, with the same meaning.

The import of a LAS format file, in version 1.2, is slightly different. All valid layers from 1.2 which will match the same valid
layers in RealWorks, except for the layers ID 8 and ID 12 (from 1.2), which are "Reserved" layers in 1.4. They will be then
imported as an "Unclassified", layer (ID 1).

The LAZ file format is a compressed LAS 1.2 file. The same class limitation is also applied to it. Importing from LAZ is the
same as importing from LAS 1.2.

Note: For LAS 1.4, in addition to meter distance units, you can now work with international foot and US survey foot distance
units.

5.1.15 E57 Files

The E57 format is a file format specified by the ASTM (American Society for Testing and Materials), an international stand-
ards organization. It is compact and vendor-neutral. It was developed for storing data (Point Clouds, images and metadata)
produced by 3D imaging systems such as laser scanners. Such format enables data interoperability among 3D imaging
hardware and software systems and is not dependent on proprietary formats for storing and exchanging data.

The E57 format supports two types of data: Gridded Data and Non-Gridded Data. Gridded data is data which is aligned in
regular arrays. An E57 format file can have an individual scan or several scans within.

5.1.15.1 Gridded Data

An E57 format file with gridded data can be open as a project or be imported into an existing one. In the first case, an inform-
ation dialog is displayed. This dialog prompts you to create and save the project into the Trimble RWP format.

n A project and a station are created and rooted under the Project Tree. The project is named according to the given
name. The station takes the name of the E57 format file.

n In the case of a multi-scans file, there are as many stations as there are scans within the E57 file.

n A TZF Scan is created and put under the station.
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n A project file and a project folder are created, both named according to the given name, with the respective RWP
extension and the RWI extension.

n Under the RWI folder, a scan file with the TZF extension is also created.

n In the case of a multi-scans file, there are as many TZF Scan files as there are scans within the E57 file.

Caution: The default mode is Production. You have to switch to Registration to see the result(s).
Note: The conversion (of an E57 format file with gridded data) to a TZF Scan file can fail. If this case occurs, the file is then
considered as a non-gridded file.
Note: The project will be automatically saved at the end of the conversion(s).

The color information in an E57 format file is preserved when converting (the E57 format file) to a TZF Scan.

5.1.15.2 Non-Gridded Data

An E57 format file with non-gridded data can either be opened as a new project or imported into an existing project.
n A project is created and rooted under the Project Tree. The project follows the naming convention of ProjectX where

X is its order.
n Non-gridded data is imported as a Cloud. All of its points are put in the Project Cloud.
n A station and a scan are created in the Scans Tree.
n A project file and a project folder are created, both named according to the given name, with the respective RWP

extension and the RWI extension.
n Under the RWI folder, a RealWorks scan file with the RWCX extension is also created.
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Note: The project will not be saved. You have to save it manually.

5.1.16 PTX Files

PTX is a file extension for laser scanning files. It is ASCII based. If there is no project, an information dialog appears for
each PTX format file. This dialog informs the user that he needs to first create and save a project into the Trimble RWP
format.

n A project and a station will be created and rooted under the Project Tree. The user has to give a name to the project
while the station takes the PTX format file name.

n A TZF Scan is also created and put under the station.
n A project file and a folder are created. Both are named according to the name given by the user, with a RWP exten-

sion for the first and a RWI extension for the second. Under the RWI folder, a scan file with the TZF extension is also
created.

Notes:
n The processing mode will automatically switch to Registration. The Scans Tree is selected by default.
n A PTX format file can be either opened as a single project or imported into an existing project.
n The project created within RealWorks is saved in the database.

PTX format files may contain several scans in the same station. RealWorks converts all the scans and creates TZF Scans,
one per scan, in the same station in the RealWorks project. The color information in a PTX format file is preserved when
converting (the PTX format file) to a TZF Scan.

5.1.17 PTS Files

PTS is a file extension for laser scanning files. It is a non-gridded ASCII based format. A project and a station per PTS
format file will be created and rooted under the Project Tree. The project is named ProjectX where X is its order. The station
has the PTS format file name. Under the station, a scan named ScanX where X is its order is created. In the case of a PTS
file with multi-scans, each scan is imported as a station.

Note: The processing mode will automatically switch to Production and the Models Tree selected by default.

Caution: The created project is not saved in the database; the user has to save it manually, otherwise it will be lost.

Once the project is saved, a RealWorks project file and a folder are created. Both are named according to the name given
by the user, with a RWP extension for the first and a RWI extension for the second. Under the RWI folder, a scan file with
the RWCX extension is also created.

5.1.18 DotProduct Files

DP is an extension for highly compressed files provided by a DPI-7 System from the DOT Product company. One file con-
tains several registered frames and RealWorks imports them all at once in one single scan.

5.1.19 Autodesk FilmBox Files

The FBX file format is a proprietary format, owned by Autodesk. It is used to provide an interoperability between applic-
ations when creating digital contents. The FBX entities you can import into a Trimble RealWorks project are given here-
after: Mesh, NURB, Surface NURB and Patch.

A Patch is a surface made from spline curves. NURB, stood for Non-Uniform Rational Basis Spline, is a mathematical
model commonly used in computer graphics for generating and representing curves and surfaces.

Each FBX entity is not imported as it is but is first converted into a FBX mesh and then into a RealWorks mesh entity, with
the information of name, color, position and orientation.

In the FBX format, the position and the orientation of an object are expressed in a right-hand coordinate system with the Y-
Axis directed to the Up. RealWorks has also a right-hand coordinate system, but with the Z-Axis directed to the Up instead.
When exporting, a conversion will be performed so that the views (Front, Up, Left) are identical in RealWorks and in the
FBX format.
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The FBX File Import dialog opens when you import a FBX format file into RealWorks. You have to determine in which unit of
measurement the coordinates in the FBX format file are expressed. Once imported, a mesh entity is created and put under
a folder in the Models tree.

Note:Once the RealWorks project is saved, a SQL database (a file with the DMT extension) is created under the RWI
folder. This database records all the operations you perform on geometries.

Note: All FBX meshes are imported in RealWorks, but the hierarchy in the FBX scene graph is ignored.

5.1.20 TDX Files

The TDX format is a format which enables the exchange of data between Trimble Business Center and Trimble RealWorks.
Scan data (scans, stations, and leveling information, and images) is imported into RealWorks.

5.1.21 X7 Data Files

Trimble RealWorks supports data files coming from a Trimble X7 3D laser scanner. These files are in TZF and TCF
formats, respectively for scan data and for image data. You can import a TZF format file into Trimble RealWorks by select-
ing Import / Open from the Home tab or by dragging and dropping the file into the program. For each imported TZF format
file, a unique station is created, with a TZF Scan inside.

An imported TZF format file contains the following information:
n Auto-Leveling: When the Auto-Leveling option has been enabled when acquiring scan data, a Tilt measurement is

performed to measure the horizontality of the instrument. If the result is within a range of +5° and -5°, Trimble
RealWorks creates a "Leveled" station (blue color). If the result is out of the +5° and -5° range, Trimble RealWorks
creates an "Unleveled" color (yellow color). In both cases, Trimble RealWorks applies a compensation to the scan
data*. When the Auto-Leveling option has been disabled when acquiring the scan data, Trimble RealWorks creates
an "Unleveled" station (yellow color), and does not apply any compensation.

n White Balance Correction: There are several correction modes for the white balance that can be set when acquiring
image data. For the Auto mode, no correction will be applied to the images during the acquisition but done in
Trimble RealWorks when processing the colorization of the scan data. All the TCF format files will be merged with
the TZF files after the data processing. So if the user hasn't made a copy of its original data sets, it is not possible to
go back. For the other modes, the chosen correction will be applied to the images during the acquisition.

n Scan and image IDs.
n IMU.

(*) Such Tilt compensated data (leveled) must be re-projected only before point eradication and upon the user's request. A
re-projection consists of correcting the significant shift between a pixel on the 2.5 Preview image (TZF Scan) and the 3D
Point that is behind by re-projecting each 3D Point onto its related pixel.

5.1.22 X7 TDX Files

A project, when exported to the TDX format from Trimble Perspective, contains the following:
n A TDX format file (Trimble Data eXchange format).
n A set of TZF format files (one per station). A scan can be colorized (or not) and may have different resolutions.
n A set of TCF format files (one per station) if the images have been acquired.
n A set of TPF format files (one per created panorama in Preview Quality (or High Quality) resolution and per station).

To import a TDX format file into the application, select Import / Open from the Home tab or by drag and drop the file into the
application. The application creates a new project and prompts to save it first. Once done, the TDX Processing dialog
opens. choose one of the following

n Sampling by Step: A method in which one point is taken into account at each defined Step vertically and horizontally
in the 2D image data (TZF Scan).

n Spatial Sampling: A method to obtain a point cloud with a homogeneous spatial density. First define the parameter
(distance value in the current unit of measurement).

n Generate Preview Scan: An option to create a scan by getting points, not from the TZF Scan but from its Preview,
and by computing the normals on the points. The created scan is always named Preview, containing about two mil-
lion points.
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n Filter by Range: A filter that discards pixels which are not in the defined range. The filter is not active when the Min.
and Max. values are equal to zero.

n Generate Panorama Image: An option to create a JPG format image from the High Quality panorama for each sta-
tion.

Click Start to process:
n For a leveled station created in Trimble Perspective, the application creates a leveled station (blue color). For an

unleveled station, an unleveled station (yellow color) is created. Each station is named according to the name set in
Trimble Perspective.

n For a registration set created in Trimble Perspective, the application creates a group and puts all the created sta-
tions belonging to the same registration set in the group. This group is named according to the registration set
name.

n For a created station, the application associates a TZF Scan, a sampled scan (or preview scan), and / or a set of six
station images, and / or an annotation entity and its linked image.

- If the imported station has a High Quality panorama and its scan is not colored, the High Quality panorama is used
to colorize the scan, create the set of station images and the JPG panorama image.
- If the imported station has no High Quality panorama and its scan is not colored, a temporary High Quality pan-
orama is created and used to colorize the scan, create the set of station images and the JPG panorama images.
- If the imported station has no High Quality panorama and its scan is already colored, the set of cubical images and
JPG panorama image are created from the color information found on the colored scan.
- If the imported station has no High Quality panorama and its scan is not colored (no TFC format associated), no
set of station images and JPG panorama image are created.
- In all cases, the TFC format file is merged with the TZF format file.
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n Annotations and precision points created in Trimble Perspective are imported as annotations in RealWorks, each
with a 3D position, a name, a comment and a linked image.

- Those that have been set for a georeferencing use are put under the Target Annotations folder in the Targets
Tree. Those that have not been set for a georeferencing use are rooted in the Target Tree. Select an annotation
from the tree and display its properties to edit its name, color and description.

- Only for those that have been set for a georeferencing use, a survey point is created per imported annotation (or
precision point). All survey points are put under the Unmatched folder in the Targets Tree and under the station they
belong to in the Scans Tree.

- If the imported TDX project has been georeferenced in Trimble Perspective by pairing annotations (or precision
points) with control points, RealWorks creates a TopoPoint per control point and put them all under a Topographic
station in the Scans Tree,

- A matched pair of annotation (or precision point) and control point is put in a folder named by the control point
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name.,

If required, you can create some groups under the tree to organize the imported annotations. In the Annotations
Tree, you can select and delete an annotation, copy an annotation and paste it to the same location or to a new loc-
ation, or cut an annotation and paste it to a new location. If an image is linked to an annotation, you can either open
the image in an independent window or display it as a thumbnail in the 3D View.

n Labels assigned to a station in Trimble Perspective are concatenated in one line once imported into Trimble
RealWorks. You can visualize and edit (rename or delete) the imported labels, on the Operator Labels line after dis-
playing the properties of the station.

n You can use the Find feature to sort the created stations by assigned labels, by name and leveling status. You need
to be in the Registration module, and press Ctrl + F. With the Find dialog opened, ensure to choose "Station" as
Type. For leveled stations, type 'True" in the Find What field, and "False" for unleveled stations.

5.1.23 IFC Files
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IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the con-
struction industry. IFC is developed as an open standard by buildingSMART.

n If no project is opened, a new one is created. Otherwise, the IFC models are imported under the currently opened
project below a group named "New Group".

n Each IFC model is imported as a unique mesh.
n Color information is imported.
n Hierarchy information is not imported.
n Classification type is imported and appears in the entity name (Beam, Column, Stair, etc.).
n Unit of measurement is always in meters.

5.2 Open a Project File

A project file can be opened by using the Open dialog, or by selecting the Recent Files from the File tab. The ten last
opened files are listed at the right panel of the File tab. As a shortcut, you can open any of them just by selecting it in this
menu.

To open a project file:

1. Select Open in Home > Import/Export > Import. The Open dialog opens with the Add to Project option dimmed.
2. Select a file type from the File of Type field.
3. Navigate to the drive/folder where the file is located.
4. Click on the file to select it. Its name appears in the File Name field.
5. Click Open. The Open dialog closes.

Tip: You can use the shortcut key Ctrl + O (or click Open in the Quick Access Toolbar) to pop-up the Open dialog.

You can also drag and drop to open a project file into RealWorks. If RealWorks is not already open, this operation will open
it. Only one project file can be dragged and dropped at a time. If it is already open, you can drag and drop a set (of project
files).

If no project is open in RealWorks, there is no difference in the result between opening a set of project files (through the File
/ Open menu) and dragging and dropping a set of files into RealWorks. In both cases, a project and a set of stations* are
created. For each project file, a scan is created and put under its related station*.

If there is a project already open in RealWorks, the result is the same. But in the first case, you can decide to open the pro-
ject files into the open project (or not). In the second case, you can only open the project files into a new project.

Notes:
n For files of certain types, you cannot drag and drop a set of projects into RealWorks when there is no open session.
n Projects are ranked by alphabetic order in the Project Tree in the WorkSpace. They are ranked from their opening

order in the List window.
n You can abort the opening of a project by pressing Esc.
n When you open a project previously saved in RealWorks format or in PointScape format or in JobXML format for

which images are missing, a warning message appears and all missing images are listed.

Note: (*) Except for TZF format files.

Note: You can also open a project by selecting from Open an Existing Project from the Start Page. When you try to do so
within a tool that is already open, a warning appears and prompts you to close the tool prior to loading a new project.

5.3 Import a Project File

A project file can be imported into an existing project by using the Open dialog.

To import a project file:

1. Select Open in Home > Import/Export > Import. The Open dialog opens with the Add to Project option dimmed*.
2. Select a type of file from the File of Type field.
3. Navigate to the drive/folder where the file is located.
4. Click on the file to select it. Its name appears in the File Name field.
5. Keep the Add to Project option checked.
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6. If there are several projects, click on the pull-down arrow.
7. Choose a project from the drop-down list.
8. Click Open. The Open dialog closes.

Tip: You can use the shortcut key Ctrl + O (or click Open in the Quick Access Toolbar) to pop-up the Open dialog.

5.4 Connect to Mobile Device

A fast way to open (or import) a file from a Trimble data collector such as a Recon™, TCU™ or TSC2™ in RealWorks is to
connect and synchronize the Trimble data collector with a desktop computer (or laptop). Only a file of RAW (from the
Trimble Survey Pro™), JOB (from the Survey Controller™ software) and JobXML (from the Trimble Survey Controller™,
Survey Manager™ or Survey Pro™ software) extensions can be opened (or imported) in that way.

Microsoft® ActiveSync® is a software program that comes with your data collector when you purchase it. This program
allows you to synchronize the information on your data collector with the information on your desktop computer (or laptop).
Synchronization is done by comparing data between these two computers and updates both of them with the most recent
information. ActiveSync® is already integrated into the operating system on your data collector. However, you must install
ActiveSync® on your desktop computer (or laptop). You can install the software from the CD that was shipped with your
data collector or you can download the current version of ActiveSync® from the Microsoft® website.

To connect to a mobile device:
1. Connect a Trimble data collector to your desktop computer (or laptop). For more details, please refer to the doc-

umentation that comes with your data collector.
2. Power the Trimble data collector On.

n If there is no project open, the Connection to Mobile Device dialog opens and the Add to Project option is grayed
out. You are restricted to opening a file.
a. Navigate to the drive/folder where the file is located.
b. Click on the file to select it. The Open button becomes active.
c. Click on the Open button.

n If there are one or more projects open in RealWorks:
a. Select the Connect to Mobile Device in > Home > Import/Export > Import. The Connection to Mobile Device

dialog opens and the Add to Project option is available and default checked.
b. Navigate the Drive / folder where the file is located.
c. Click on the file to select it. The Open button becomes active.
d. Keep the Add to Project option checked.
e. Click on the pull down arrow and choose a project from the drop down list.
f. Click on the Open button.

Note: The path to the file to open (or import) as well as the dialog box size are persistent. This means that they remain
unchanged till the user changes them.

5.5 Import FLS Files

To import FLS files:
1. Select Import FLS Files in Home > Import/Export > Import. The Import FLS Files dialog opens. All drives (of your

computer) are by default listed (when the dialog opens for the first time).
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2. Navigate to the Scans folder where all the FLS files are located.
3. Select the Scans folder. The Import button becomes enabled.
4. Do one of the following:

n Click Import. The Import FLS Files dialog closes. All FLS files from the Scans folder will be imported.
Or

n Select the FLS folders to import one by one.
n And click Import. The Import FLS Files dialog closes.

Note: The Open button becomes enabled if the selection (from the Import FLS Files dialog) is a drive (or a
folder). It swaps from Open to Import when you select a FLS folder (or a FLS file).
Note: The path to the FLS folders (or FLS files) to import in the dialog is persistent. This means that it remains
unchanged till you change it.

n If there is one (or more) project(s) open in RealWorks, the Add to Project option is enabled. You can then choose a
project to import (the FLS files) from the drop-down list.

n If there is no project, a dialog appears and informs you that you need to first create and save a project into the
Trimble RWP format.
Instead of importing systematically the information related to the Color, GNSS, and Tilt and Compass when they are
found in the FLS file, the FLS Import Options dialog lets the user choose the option to import. This dialog opens
once, even if there are several FLS files selected.
- Force Full Scan: This option enables you to create an uncropped TZF Scan, by keeping empty pixels. Empty
pixels are on outdoor scans with large pieces of sky (Zenith) and no tall objects foreground (Nadir).
- Equalize Luminance: Equalize point cloud luminance. This enhances the visual perception of the luminance but
might slightly affect the auto-extraction performances.

Trimble RealWorks User Guide | 82



PERFORM BASIC OPERATIONS

A project and a set of stations (one per file) are created and rooted under the Project Tree. You have to give a name
for the project while each station is named according to the file name.
A TZF Scan (one per file) is also created and put under its related station.

A project file and a folder are created. Both are named according to the name given by the user, with a RWP exten-
sion for the first and a RWI extension for the second. Under the RWI folder, a set of scan files with the TZF exten-
sion is also created.

Note: The processing mode will automatically switch to Registration. The Scans Tree is selected by default.

Caution: Do not rename the extension (FLS) of the folder which contains the FLS format file to open. Otherwise, an error
dialog opens and warns you that the FLS format file has been removed (or deleted) from its previous location.

Note: When a scan has been acquired with color, the FLS file that results is colored. The TZF Scan, created by opening (or
importing) such an FLS file, is colored too. You may see the color information by displaying the TZF Scan's properties (only
if the Property window is open).

Tip:When importing FLS format files into an existing project, the project is automatically saved once the import is com-
pleted.

Caution: The Import FLS Files feature is not available in RealWorks Viewer.

5.6 Import Image

Image files in JPEG, BMP (only of 24-bit depth) and TIF formats can be imported into an existing project. An imported
image is rooted under the Images Tree. If you attempt to import an image of a format other than those mentioned above, an
error message appears

To import an image into a project:
1. Select a project from the Project Tree.
2. Select Import Image in Home > Import/Export > Import. The Import Image dialog opens.
3. Select the right image type from the File of Type field.
4. Navigate to the drive/folder where the image file is located.
5. Click on the file to select it.
6. Click Import.

Note:Only RGB TIF files can be imported into RealWorks. If you attempt to import a TIF format image of a color space
other than RGB, an error message appears

Note: You need to have a project loaded in RealWorks. Otherwise, the Import Image feature remains dimmed.

5.7 Open Scan Explorer
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Trimble Scan Explorer is a plug-in hosted in RealWorks. It is a navigator dedicated to handling and navigating large data-
bases from which the user can extract and send data to RealWorks or to a specific file format. The Scan Explorer feature is
available with the following types of license: Viewer, Starter, Core, Performance and Storage Tank.

To open Scan Explorer:
1. Select either a project or a station (or set of stations).

2. Select Open Scan Explorer in Home > Scan Explorer.
Warning: Amessage appears if one (or more) TZF format file(s) is (or are) missing in the project (loaded through
RealWorks or if the project is not compatible with Scan Explorer.
Notes:
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and

prompts you to proceed to do so.
n All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

Tip: You can also open Scan Explorer first, and load a project into RealWorks.
Note: You will be prompted to close Scan Explorer first in case you intend to merge two projects into RealWorks.

Note:Within Scan Explorer, the Create Entities in RealWorks and Create Entities in SketchUp features are
available with the Performance and Storage Tank licenses. For more information, refer please to the Trimble Scan Explorer
documentation.

Note: It is now possible to open Trimble Scan Explorer from the main Trimble RealWorks window without the need to first
save the project.

5.8 Open SketchUp

The Open SketchUp feature is available with the Core, Performance and Storage Tank versions of RealWorks. This fea-
ture is enabled only if SketchUp Pro 2014 or above (until SketchUp Pro 2021) is installed on your computer. Otherwise, it
remains dimmed. The feature, when selected, starts SketchUp and allows you exporting an existing geometry, either from
RealWorks to SketchUp (by selecting the Export to SketchUp feature) or with Trimble Scan Explorer opened nearby (by
selecting Create Entities in SketchUp).

To open SketchUp:
1. Select either a project or a station (or set of stations).
2. Select Open SketchUp in Home > SketchUp.

n If the selected project is unsaved, a dialog opens and prompts you to save it.
n If there are some TZF Scans in the selected project, you can Open Trimble Scan Explorer and use the Create

Entities in SketchUp feature for extracting and sending entities to SketchUp.

Note: For more information related to the Create Entities in SketchUp feature, please refer to the Trimble Scan Explorer for
RealWorks documentation.

To close SketchUp:

SketchUp closes by itself when you close RealWorks. If a change has been done in the project, you will be asked to save
the project, in RealWorks. If some entities have been exported towards SketchUp, you will be asked to save the project, in
SketchUp.

If the connection between RealWorks and SketchUp is lost for any reason, a warning dialog opens. First close the dialog
and then select Reconnect to RealWorks from Plugins menu, in SketchUp as illustrated below.
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If the connection with RealWorks is broken, a dialog opens and prompts you to first leave SketchUp and then restart it from
RealWorks.

Caution: If there is no open project in RealWorks, the Open SketchUp feature remains grayed-out.

5.9 Send to SketchUp

You can export either a Geometry or an Ortho-Image to Trimble SketchUp. A geometry created in RealWorks can be of the
following types: 3D point, segment, polyline, composite curve, ellipse, circular arc, plane, plane with holes, extrusion, cyl-
inder, circular torus, rectangular torus, box, pyramid, full sphere, regular cone and eccentric cone. An ortho-image can res-
ult from using the Ortho-Projection tool or as a piece of a Key Plan (Generate Key Plans). When you select a group (or a
project), all entities in the group (or in the project) are exported toward SketchUp.

To send an entity to SketchUp:

1. First, select Open SketchUp by clicking .
2. Select an entity from the Models Tree.

3. Select Send to SketchUp in Home > SketchUp.
Or

4. Select Send to SketchUp from the pop-up menu.
n If the selection is a group (or a project), and if there is a mesh (or an unsupported geometry) in the selection, an

error message displays. The mesh (or unsupported geometry) cannot be exported.
n If there is an image in your selection which is not an Ortho-Image, an error message displays. The image cannot

be exported.
n If a Key Plan has been selected, all related ortho-images except the Preview are exported.
n A Preview, alone, can be exported.
n A geometry is exported in the common layer:
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n An ortho-image is exported in a specific layer.

Caution: The Send to SketchUp feature remains grayed-out if SketchUp has not been opened from RealWorks first and
when you select an entity for which the feature is not enabled.

Note: An error message appears when you try to export while the Welcome to SketchUp dialog is still opened.

Note: This feature requires the installation of SketchUp Pro on your computer. If you have SketchUp Make instead, a mes-
sage appears and warns that this feature is not compatible with SketchUp Make.

Tip: You can cancel the export in progress by pressing Esc.

One good practice is to generate a Top view, a Front view and a side view, export them to SketchUp, and then use them as
background. In SketchUp, set the 'View>Face Type' to X-Ray to be able to view the ortho-images behind the model.

Note: For the Send to SketchUp feature to work successfully, ensure the TCP/UDP port numbers are 2002 and 2003.

5.10 Open AutoCAD

The Open AutoCAD feature is enabled only if the AutoCAD 2019 (or 2020, 2021 and 2022) program from AutoDesk is
already installed on your computer. Otherwise, it remains dimmed. The feature, when selected, starts AutoCAD and opens
a dialog with prompts. After choosing to load the Trimble ARX (AutoCAD Runtime Extension) plugin into AutoCAD, a new
Drawing file, based on the current drawing template file, opens.

Note: If several versions of AutoCAD are installed on your computer, as only one instance of AutoCAD can communicate
with RealWorks at a time, AutoCAD 2021 is then considered.

Note: The Send to AutoCAD feature is dimmed if you choose to not load the Trimble ARX (AutoCAD Runtime Extension)
plugin into AutoCAD.
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5.11 Send to AutoCAD

The Send to AutoCAD feature is enabled when a point cloud has been selected, and if the requirements below are
met:

n AutoCAD has been started from RealWorks (see Open AutoCAD), and,
n The connection between the Trimble ARX plugin and RealWorks is established, and
n A Drawing file, based on the current drawing template file, opens in AutoCAD.

And if:
n AutoCAD 2019 (or 2020, 2021 and 2020) from AutoDesk is already installed.

Note:When an object having both point cloud and geometry properties has been selected, only the point cloud properties
will be exported to AutoCAD.

The result of the export is a point cloud that displays in AutoCAD. After saving the Drawing file, a DWG format file with a
name given by the user and a folder with RCP format file(s) are created.

5.12 Save Projects

A project, which has not been saved, has an asterisk beside its name in the Project Tree. You can save the project into the
existing project file by using the Save command or into a new project file by using the Save As command.

Caution:When a project has already been updated from an older version of RealWorks to the current version, saving it
under the same name will make it inaccessible under older versions of RealWorks.

Caution: You cannot save (or save as) a project in RealWorks Viewer.

To save a project:
1. Select an unsaved project from the Project Tree.

2. From the Quick Access Toolbar, click the Save icon.

Tip: You can also use the shortcut key Ctrl + S.

To save a project as:
1. Select either a saved project or an unsaved project from the Project Tree.

2. From the File tab, select Save As . The Save dialog opens.
3. Navigate to the drive/folder where you want to store the project.
4. Enter a name in the File Name field. The extension is added automatically.
5. Click Save. The Save dialog closes.

Note: The TZF Scan Files Management dialog opens if the selected project contains some TZF Scan files (within its RWI
folder). You can then choose between "Copy TZF Scan Files into the New Project" and "Do Not Copy TZF Scan Files, Keep
the Link to the Originals".

5.13 Undo an Operation

You can undo the last operation when the Undo Operation command is available. You can execute multiple-level undo, but
its behavior varies depending on whether you use a command or a tool. When you use a command, the undo will delete its
effects. When you are inside a tool, multiple undo will be applied to all intermediate steps of the tool, including their para-
meter settings and database operations. Once you exit the tool, multiple undo will take effect only on the database oper-
ations carried out by all operations of the tool.

To undo an operation:

1. From the Quick Access Toolbar, select Undo Operation .
2. Continue clicking Undo Operation to remove as many previous operations as necessary.

Notes:

Trimble RealWorks User Guide | 87



PERFORM BASIC OPERATIONS

n You can also use the Ctrl + Z shortcut keys or click the corresponding icon in the Main toolbar.
n The Undo stack is limited to the value defined in Preferences.

5.14 Redo an Operation

If you decide to restore the last operation (or action) you carried out in RealWorks, you can easily do so by using the Redo
Operation command. When the Redo Operation command is unavailable (dimmed), it means that you cannot redo the last
operation (or action).

To redo an operation:

1. From the Quick Access Toolbar, select Redo Operation .
2. Continue clicking Redo Operation to redo as many previous actions as necessary.

Note: You can also use the Ctrl + Y shortcut keys or click the corresponding icon in the Main toolbar.

5.15 Close Projects

You can either close a selected project (or all projects). When the project(s) is (or are) not saved, a warning will be issued.
You will be prompted to save (or not to save it (or them)). Note that there is one warning per open project and Close All does
not require selection.

To close the selected project:
1. Select a project from the Project Tree.

2. From the File tab, select Close .
Or

3. Select Close from the pop-up menu.

To close all projects:
n From the File tab, select Close All .
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A project contains original scanned data and images, and all objects created from the scanned data. In order to make such
data visible to users, we organize them into a Project Tree under the WorkSpace window.

6.1 Project Tree

Each Project Tree is composed of five sub-trees called Scans, Models, Targets, Images and Annotations. At any given
time, only one of them is displayed.

When a project is loaded into RealWorks, it is immediately inserted under the WorkSpace as a named project. Under the
project, you can find two types of nodes Group and Object. An object node is always a leaf node, while a group node could
be either an internal or a leaf node. The organization and manipulation of the group and the object nodes in the WorkSpace
window and the List window are similar to those of the respective File and List windows of Microsoft Windows Explorer.

Note: A project has a layer table. When loading a project in RealWorks, a default layer table with predefined layers is auto-
matically generated. The layer table is based on the LAS 1.4 specification. This means that there is a maximum of 256 lay-
ers per project, and the first layers will be the LAS 1.4 predefined or reserved ones.

Tip: You are able to manage the layers that are in your project. Please, refer to the Managing Layers chapter for more
information.

6.2 Scans Tree

The Scans Tree is only available in the Registration mode. To display it, you have to click on its tab in the WorkSpace win-
dow. This tree is used for organizing the scanning results called Stations, Scans, and/or Images.

It may have as many levels as a project requires. A Scan and an Image are always the leaves of the tree, while a Station is
an internal node. It is important to note that the content of a Station (Scans or Images) cannot be moved to other Stations,
nor can their position be changed inside a Station. This is to preserve the scanning order.

Caution: Images from the Scans Tree cannot be deleted and Scans from which all points have been deleted are erased.

Note: The objects from the Scans Tree have no layer.

RealWorks does support the new functionality of the Trimble TX instrument, i.e., the opportunity that is offered to the user to
work with the same method a surveyor does with a Total Station. If the instrument station has been Leveled and the Instru-
ment Height entered in the field, RealWorks will read and display them properly in the Property window.

The Projected Instrument Position of a leveled station, initially displayed as 3D coordinates in the Property window, is now
symbolized by the icon shown in the hereafter snapshot.

6
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6.3 Models Tree

The Models Tree is only available in the Production mode. You can display it by selecting its related tab from the
WorkSpace window. This sub-tree is used for organizing models of a scene. The organization can be logical, spatial or dis-
cipline-based (or simply a combination thereof), depending on the purposes of a project.

The Models Tree may have as many levels as a project requires. You can create, re-organize, delete, browse, search, loc-
ate or visualize objects in this sub-tree. Each object node of this sub-tree may contain a point cloud, a geometry or both. We
call them the two representations of this object. By default, only one representation is displayed:

n A cloud object is displayed by its cloud representation,
n A shape object is displayed by its geometric representation,
n By default, an object with both representations is displayed by its geometric shape representation. The user must

explicitly ask to display its cloud representation.

For a project saved in a version of RealWorks older than 8.0, there is at least one Sub-Project attached at the root of the
Models Tree and only one is active at a time (the one in bold). After saving an old project in 8.0, all Sub-projects are
replaced by groups named "From "Sub-Project" name".

1 - The Models Tree in projects older than
8.0.

2 - The Models Tree in projects saved in
8.0.

Note: A project created and saved directly in 8.0 has no notion of groups (coming from Sub-Projects conversion).

Note: An object of any kind in the Models Tree has a layer, except for a folder.

6.4 Targets Tree

The Targets Tree is only available in the Registration processing mode. You can display it by selecting its related tab from
the WorkSpace window. It is used for organizing the registration entities (Targets, Survey Points, Topo Points, etc.)
matched or not.
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Note: Refer to the Registration chapter for more details on the exact definition of the registration entities and how they are
organized and used.

Note: There is no layer associated with a target.

Note: The Targets tab does not display if the open project does not contain any target. If there are several projects open,
and one of the projects contains some targets, the related tab displays then.

6.5 Images Tree

The Images Tree is available in all modes (Production and Registration). You can display it by selecting its related tab from
the WorkSpace window whatever the mode you are in. This tree is used to organize (or browse) images taken by a laser
scanner’s on-board video camera (or other digital cameras). For example, you can group together a set of images and use
them for texturing a part of the scene.

Note: You can view an image (or group of images) as thumbnail(s) in the List window either by selecting first Database
Browsing, then Thumbnails from the Database toolbar.

Note: There is no layer associated with an image.

Note: The Images tab does not display if the open project does not contain any image. If there are several projects open,
and one of the projects contains some images, the related tab displays then.

6.6 Annotations Tree

The Annotations Tree is available in all modes (Production and Registration). To display the Annotations Tree, click the cor-
responding tab in the WorkSpace window. This tree is used for organizing the annotations coming from the import of a
Trimble X7 dataset or created with the Annotate tool in Trimble RealWorks.
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Note: The Annotations tab does not display if the opened project does not contain any annotation.

6.7 Project Cloud

A Project Cloud is a cloud node attached to the Models Tree in the OfficeSurvey and Modeling modes (or in the Production
mode). The aim of the Project Cloud is to allow you to quickly find all points (or all unused points) of the project.

Note: The contents of the Project Cloud are automatically displayed in the 3D View after getting all points or getting remain-
ing points.

Before 8.0, each Sub-project of a project had its own Project Cloud. Only points belonging to the Project Cloud of the active
Sub-Project are loaded.

After saving (a project) in 8.0, the Project Cloud of each Sub-project is converted to a Cloud with the same number of
points. This Cloud has the name "From Sub-Project" name Cloud".
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The newly saved project has a unique Project Cloud with the same number of points as the Project Cloud of the active Sub-
Project of the old project.

6.7.1 Project Cloud Layer

The Project Cloud in RealWorks is a special cloud where usually points are not yet processed. That's why it has a specific
layer, named "Created, Never Classified" with the ID 0. You are not allowed to change the Layer 0 of the Project Cloud by
another layer, or assign the Layer 0 to a cloud other than the Project Cloud.

6.7.2 Get all Points

When you load a project for the first time, the Project Cloud of the project is empty. You have to load it with points. You have
the choice of getting all points or only unused ones. Once the Project Cloud is loaded with all points, you can see the num-
ber of points in the corresponding attribute column.

To get all points:
1. Load first a project in RealWorks.
2. Select a project under the WorkSpace.
3. Select Project Cloud in the List window.
4. Right-click to display the pop-up menu.
5. Select Get All Points from the drop-down list.

Note:When you create a new project by importing TZF format file(s) (acquired by a Trimble TX 3D scanner or from e.g. a
TZS format file(s) conversion), you may notice the number of points in the Project Cloud is equal to zero. This number
remains in this state until you perform your first extraction (of points) from the TZF Scan(s).
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6.7.3 Get the Remaining Points

After you have segmented points of a project and organized them into different groups, there may remain some non-seg-
mented and/or unorganized points. At various moments, you may need to find/display these points. Once the Project Cloud
is loaded with all unused points, you can see the number of points in the corresponding attribute column.

To get remaining points:
1. Load first a project in RealWorks.
2. Select a project under the WorkSpace.
3. Select Project Cloud in the List window.
4. Right-click to display the pop-up menu and then select Get Remaining Points.

6.8 Active Group

An Active Group is a group that you have selected. Note that an active group can only be a project, a station, a group of
models or a group of images. Selecting an active group can be done in the Project Tree or in the List window. By default, all
new created objects will be put under this active group.

6.9 Groups and Objects

The user will find information related to the identification of Group and Object nodes in the WorkSpace and List windows.

6.9.1 In the WorkSpace Window

Each item of data displayed in the WorkSpace window is identified by its icon, name and order in the Project Tree. Below is
a list of icons appearing in the four sub-trees.

WorkSpace

Project

Project, Opened

Unmatched target folder

Matched target folder

Station

Group of objects

6.9.2 In the List Window

Each item of data displayed in the List window is identified by its icon, name, attributes and order in the Project Tree. Lists
given hereafter are not exhaustive and are given only as a guide.

SCANS TAB - Here is a list of icons that you can find in this window when you select the Scans tab.

Station, Unleveled

Station, Leveled

Station, Leveled and Setup

Scan

Scan, TZF

Image
Etc.

MODELS TAB - Here is a list of icons that you can find in this window when you select the Models tab:
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Project cloud

Group

. Models Group

Model as cloud

Model of box shape

Model of cylinder shape

Model of fitted cylinder shape

Model of plane shape

Model of fitted plane shape

Model of circular torus shape

Model of fitted circular torus shape

Model of sphere shape

Model of regular cone shape

Model of fitted Polyline

Model of fitted composite curve

Model of fitted mesh

Model of point-to-point distance measure

Model of angular measure

Model of 3D point measure
Etc.

IMAGES TAB - Here is a list of icons that you can find in this window when you select the Images tab:

Image, Imported

Image, Matched

Image, OrthoPhoto

TARGETS TAB - Here is a list of icons that you can find in this window when you select the Targets tab:

Target, Unmatched Group

Target, Matched Group

Target, Spherical

Target, Trimble Flat

Target, Fitted Sphere

TopoPoint
Etc.

ANNOTATIONS TAB - Here is a list of icons that you can find in this window when you select the Annotations tab:

Annotation
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6.10 Model Groups

AModel Group is a group inside which each entity is related to its neighbor. It can contain everything except a group. If
there is a group within, the Set as Model Group feature is dimmed. If there are some fitted entities within (entities with cloud
and geometry properties), only those with geometry property will be considered. A Model Group, by its nature, offers the
advantage of moving or duplicating the whole set as a unique block by just selecting one of its child entities.

6.10.1 Set a Group as a Model Group

To set a group as a model group:
1. Right-click on a group in the Project Tree.

2. Select Set as Model Group from the pop-up menu.

The selected group becomes a Model Group .

6.10.2 Set as a Non Model Group

To set a model group as a non model group:
1. Right-click on a Model Group in the Project Tree.

2. Select Set as Non Model Group from the pop-up menu.

The selected Model Group .becomes a normal group .

6.10.3 Duplicate a Model Group

You can duplicate a Model Group by using the Copy & Paste feature or the Duplicator tool (in Modeling or Production mod-
ule). The copied group inherits the property of its parent group and is named Copy of Models Group Name.

Duplication Rules:
n When selecting a Model Group, the Model Group is duplicated.
n When selecting an object from a Model Group, the entire Model Group is duplicated.
n If the Model Group contains a frame, the frame is duplicated.
n With the Copy & Paste feature, the Model Group is duplicated at the same position in the 3D View, and at the same

level in the Project Tree.

n With the Duplicate tool, if the Model Group contains some objects that cannot be duplicated, the warning below is
displayed:

And the Models Group is duplicated several times, not the same position in the 3D View but along the defined path.
All are put under the Duplication folder:
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Note: In case there are some fitted entities within the Model Group, only the geometry property of the entities is duplicated.

6.10.4 Displace a Model Group

AModel Group, when moved, is moved as a single object in rotation (or translation) in the Geometry Modifier tool.
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We have introduced a point cloud loading tool for supporting huge amounts of points. The user is able to precisely control
which points are loaded into memory and thus available for all the regular tools.

7.1 Drag & Drop an Item

The Drag & Drop functionality provides shortcut methods for performing common tasks. You can use the drag and drop
functionality to modify the organization of the Project Tree according to conditions).

In the Scans tree:
From: To:

Project Group
Project No No
Group No Yes (1)
Station No Yes (1)
Scan No No
Targets No No

In the Models tree:
From: To:

Project Group
Project No No
Project Cloud No No
Group No Yes (1)
Object No Yes (1)

In the Images tree:
From: To:

Project Group
Project No No
Group No Yes (1)
Images No Yes (1)

(1) In a group with the same level or in a sub-level group

To drag and drop an Item:
1. Select a group (or object node(s)) that you want to drag and drop.
2. Press and hold the left mouse button while you drag the object to its destination.

7

Trimble RealWorks User Guide | 98



EDIT

3. Release the mouse button to drop the object.

Note: The cursor changes to when you try to drag and drop an item for which the operation cannot be performed.

7.2 Cut & Paste an Item

You can use the Cut/Paste functionality to delete or re-organize the Project Tree according to conditions. It is important to
note that you cannot apply these operations to a scan or to an image; and these operations should be used inside a project.
Copying a group node will duplicate its contents.

In the Scans tree:
From: To:

Project Group
Project No No
Group No Yes (1)
Station No Yes (1)
Scan No No
Targets No No

In the Models tree:
From: To:

Project Group
Project No No
Project Cloud No No
Group No Yes (1)
Object No Yes (1)

In the Images tree:
From: To:

Project Group
Project No No
Group No Yes (1)
Images No Yes (1)

(1) In a group with the same level or in a sub-level group

To cut an item:
1. Select an object (or a group of objects) from the Models Tree.

2. Select Cut in Edit > General.
3. Navigate through the Models Tree to select a new location.

4. Select Paste in Edit > General.
The selected object (or group of objects) is moved.

Notes:
n You undo or redo the Cut operations you have previously performed.
n You can also pick an object directly in the 3D View and select a command from the pop-up menu.

Tip: You can use the following shortcut-keys: Ctrl + X for Cut and Ctrl + V for Paste.

Note: The Cut command in the General group remains grayed out when you select an item for which the cut cannot be per-
formed.

7.3 Copy and Paste an Item
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You can use the Copy/Paste functionality to delete or re-organize the Project Tree according to conditions. It is important to
note that you cannot apply this operation to a scan or to an image; and this operation should be used inside a project. Copy-
ing a group node will duplicate its contents.

In the Scans tree:
From: To:

Project Group
Project No No
Group No No
Station No No
Scan No No
Targets No No

In the Models tree:
From: To:

Project Group
Project No No
Project Cloud No No
Group No Yes (1)
Object No Yes (1)

In the Images tree:
From: To:

Project Group
Project No No
Group No No
Images No No

(1) In a group with the same level or in a sub-level group

To copy an item:
1. Select an object (or a group of objects) from the Models Tree.

2. Select Copy in Edit > General.
3. Navigate through the Models Tree to select a new location.

4. Select Paste in Edit > General.
The selected object (or group of objects) is duplicated. A copied object has the name Copy of "Name_Of_The_
Object_To_Copy".

Notes:
n You undo or redo the Copy operations you have previously performed.
n You can also pick an object directly in the 3D View and select a command from the pop-up menu.

Tip: You can use the following shortcut-keys: Ctrl + C for Copy and Ctrl + V for Paste.

Note: The Copy command from the General group remains grayed out when you select an item for which the copy cannot
be performed.

7.4 Delete an Item

This command can be used to delete an object from the RealWorks database. It is important to note that you cannot delete
a matched (or unmatched) target group in the Targets Tree and the Project Cloud in the Models Tree.

To delete an item:
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1. Select an object (or a group of objects) from the ModelsTree.

2. Select Delete in Edit > General.
3. Click Yes to delete.
4. Or click No to abort.

Note: You can also use the Del key instead of selecting the Delete command from the menu bar.

7.5 Create a New Group Node

This command allows you to create a new group. You can do this in the four sub-trees.

To create a new group node:
1. Select a project/group object from the ProjectTree.

2. Select New Group in Edit > General.
n An empty folder, whose name is immediately editable in the List window, is created in the hierarchy tree.

Tip: You can also choose the New Group command from the pop-up menu in the WorkSpace window.

7.6 Rename in Item

You can change the name of an object in two places: either in the WorkSpace/List window, or in the Property window. You
can rename all objects except the project node itself, the Project Cloud and unmatched targets.

To rename in the Property window:
1. Select an object from the ProjectTree and right-click to display the pop-up menu.
2. Select Properties from the pop-up menu. The Property window opens.
3. Click in the Name field. The selected object name becomes editable.
4. Enter a new name.
5. Press Enter.

To rename in the WorkSpace window:
1. Select an object from the Project Tree.
2. Left-click twice on the name of the found object.
3. Enter a new name.
4. Press Enter.

Note: You can also select an object and use the F2 key to rename it.

7.7 Project

The Project group, on the Edit tab, in the Production and Registration modules, gathers the features that apply a trans-
formation to a project by changing its UCS frame, by merging some of them, etc.

Note: The UCS Creation tool and the Set as Home UCS feature are not available in the Registration module.
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7.7.1 Shift Project

You can manually apply a shift to a project. It is not necessary to select it for that. Any item in the Project Tree can be used.
This tool can be used in any processing mode (OfficeSurvey/Modeling (or Production), or Registration).

To shift a project:
1. Select an item from the Project Tree.

2. Select Shift Project in Edit > Project. The Shift Project dialog opens.
3. Enter the coordinates of a vector in the Define Vector Shift field.
4. Click Apply. The Shift Project dialog closes. A dialog opens.
5. Click Yes. The dialog closes.

For a station, the scanner origin changes,
For an image, its camera position changes,
For a geometry, its center changes,
Etc.

Note: You can undo the operation.

7.7.2 Flip Project Vertical Axis

The user is able to apply a rotation to the Home Frame to change its verticality, by reversing its X and Z Axes. This trans-
formation, once selected, will be applied to the X and Y coordinates of all objects of the current projects, except to images
or anything related, like TZF Scan thumbnails.

To flip the vertical axis of a project:
1. If there is a unique open project open, no selection is required.
2. If there are multiple open projects, select one from the Project Tree.
3. Select an item from the Project Tree.

4. Select Flip Project Vertical Axis in Edit > Project. A dialog opens.
5. Click Yes. The dialog closes.

Note: You can undo the operation.

7.7.3 Merge Projects

You can merge several projects into a single project. After merging, a new project with the name Merge Project is created.

To merge several projects into one:
1. Select at least two projects from the Project Tree.

2. Select Merge Projects in Edit > Project.
n For each project that has been modified and not yet saved, a dialog appears and prompts you to save it.
n If you choose No, projects (to merge) will be then closed and unsaved.
n On the other hand, the merged project will take all changes (from the projects (to merge) into account.

SCANS TREE: Stations from different projects are merged under the same project and are renamed accord-
ing to the project they belong to.
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1 - Stations from two different projects under the
WorkSpace window

2 - Stations under the merged project

MODELS TREE:Objects (Group, Cloud, etc.) from different projects are merged under the same project
and are renamed according to the project they belong to.

1 - Objects from two different projects under the
WorkSpace node
2 - Merged project

3 - Objects under the merged project

Note: The Project Cloud of the merged project is the sum of all Project Clouds.
TARGETS TREE: Unmatched entities are merged under the same group (called Unmatched) and matched
entities (gathered in pairs) are put by order under the merged project. Pairs sharing the same name and the
same order than those in the first loaded project (first from the Project Tree) have their number changed in
order to continue the numbering*.
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1 - Matched and unmatched entities
from two different projects under the
WorkSpace node

2 - Pairs of matched entities numbered
from 001 to 010 becomes pairs of
matched entities numbered from 007 to
016 in the merged project

3 - Matched and
unmatched entities in the
merged project

Caution: (*) Only pairs are renumbered, not the entities inside.

IMAGES TREE: In the Images Tree, images of each tree are placed under a folder named after the old pro-
ject. If all images are named IMAGEX where X is an order, all are renamed. The first image, from the first
selected project and at the root of the Image Tree, is renamed to IMAGE1, the second IMAGE2, and so on.
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Images Tree BEFOREmerging

In the example below, IMAGE3 from AtelierBatB is renamed IMAGE1. The project to which each image
belongs is indicated between brackets. If all images are different; like e.g. A, B, C, etc. All keep their name.

Images Tree AFTERmerging

Note: Feature code libraries having the same name are also merged (Feature codes of same name belong-
ing to a library having the same name are duplicated).

ANNOTATIONS TREE: Annotations from different projects are merged together under the same project.
Attached images of each project are placed under a folder named after the old project name.
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PROJECT LAYERS:When you select several projects you want to merge into one, the layer tables will be
also merged into one according two options:

n Merge Classification Layers That Have the Same Class IDs:
The layers with the same ID will be merged into a unique layer. The name of the merged layer will be
the name of the layer belonging to the first project (in selection).
Or

n Keep Classification Layers and Reassign Class IDs:
The layers won't be merged. The layers of the second (in order of selection), third, etc. project will be
added to the layers of the first project, in the layer table by concatenation.
Project [A]:

Project [B]:

Project [B] + Project [A]:
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SAVE MERGED PROJECT: Amerged project is always unsaved. You have to manually save it by select-
ing Save (or Save As). Once done, a RealWorks project file and a folder, respectively with the RWP and
RWI extensions, are created. A set of RWC and RWV files for versions of RealWorks before 8.0 (or RWCX
and RWV files for RealWorks 8.0) is created. RWC and RWCX are cloud format files. RWV is an image
format file.

In the RWI folder of the merged project, RWV files from the first project (in order of selection) have their
name kept while those coming from the other projects are renamed in order to continue the numbering. For
RWC (or RWCX) files, their name also changes according to the name given by the user and follows the
same numbering rule as for the RWV files.
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PROJECTS WITH TZF SCAN FILES OUTSIDE THE RWI FOLDER: If the selected projects contain TZF
Scan files but these files are out of the project folder (RWI), RWC and RWV files for versions of RealWorks
before 8.0 (or RWCX and RWV files for RealWorks 8.0) are copied into the RWI folder of the merged pro-
ject. TZF Scan files are not copied anymore into the RWI folder. Links to the original TZF Scan files are kept.
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PROJECTS WITH TZF SCAN FILES INSIDE THE RWI FOLDER: If one of the projects contains TZF Scan
files in its project folder (RWI), the TZF Scan Files Management dialog appears.

With the Copy TZF Scan Files into the New Project option selected, TZF Scan files which are located inside
the RWI folder of the project(s) to merge are copied into the RWI folder of the merged project.
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Caution: Be aware that this operation may take a long time.

With the Do Not Copy TZF Scan Files option, all TZF Scan files are not copied into the RWI folder of the
merged project. Link to the original TZF Scan files is kept. Note that you can manually copy these TZF Scan
files later by choosing Copy Original TZF Scan Files into Project in the TZF Scan group.
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Caution: There is no undo once projects are merged together other than to not save the merged project.

7.7.4 UCS Creation

RealWorks enables the creation of any number of frames. Each of themmay be selected and set as Active Frame. When a
frame is designated as the Active Frame, all coordinates will be represented relative to this frame. This allows the user to
perform its modeling or to take measurements in any arbitrary default frame and to represent them in a frame that better
describes the data. The UCS (User Coordinates System) Creation tool provides you with several methods to create such
frames and almost all of them are mainly based on pickings; which can be constrained or free.

7.7.4.1 Open the Tool

To open the tool:
1. If needed, select an object (point cloud or geometry) from the Project Tree.
2. In the Project group, click the UCS pull-down arrow.
3. Choose UCS Creation from the list. The UCS Creation dialog opens as well as the Picking Parameters toolbar.

Inside the UCS Creation tool, we distinguish two groups of methods to build a frame: "Without Constraints" and
"With Constraints". Below is a detailed description of the UCS Creation tool.
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A temporary frame in yellow appears in the middle of the scene. If the default origin is too far from the displayed
scene; RealWorks will prompt you to set it so that it matches the scene’s center.

Tip: You can open the UCS Creation tool by clicking its related icon in the Active Frame toolbar.

Note: (*) In the X, Y, Z Coordinate System.

7.7.4.2 Select a Reference Frame

If the loaded project contains more than one frame; you can choose one as the Reference Frame. A Reference Frame is a
frame in which the coordinates of a frame to be created will be expressed. Otherwise, the SelectReference Frame field is
dimmed and the reference frame will be the default frame (Home).

To select a reference frame:
1. Click the pull down arrow in Step 1.
2. Select a frame from the drop-down list.

7.7.4.3 Build a Frame without Constraints

To build a frame, you can define each of its items by specifying the coordinates, by picking points (seven are required if you
wish to construct the whole frame using this method, two per axis and one for the origin), by fitting an axis with a plane, by
picking points (origin and two directions) or by picking an object's local frame. For a given frame, you can mix these sub-
methods (except for picking three points). Note that the coordinates for the three axes will be automatically normalized.

7.7.4.3.1 Specify Coordinates

With this method, neither selection nor display is required.

To specify coordinates:
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1. Enter the 3D coordinates of a point in the Origin field.
2. Enter a direction in the X-Axis field.
3. Enter a direction in the Y-Axis field.
4. Enter a direction in the Z-Axis field.
5. Click Reset (if required).

7.7.4.3.2 Pick Points

This method is not based on the selection but the display. A display can be done before (or after) entering the UCS Creation
tool and it should be of point cloud (or of mesh) type.

To pick points:

1. Click the Pick Origin icon.
2. Pick a point (free or constrained) on the displayed object(s).
3. Click the Pick Axis ( , or ) icon.

The yellow frame is hidden.

4. Pick two points (free or constrained).
The two points give a direction to the chosen axis.

The orientation of the yellow frame changes according to the new direction of the chosen axis.
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5. Repeat the steps from 3 to 4 for the two other axes.
6. Click Reset to cancel the parameters (if required).

7.7.4.3.3 Fit an Axis

This method is not based on the selection but on the display. A display can be done before (or after) entering the UCS
Creation tool and it should be of point cloud type; otherwise the three Fit Axis icons are dimmed.

To fit an axis:

1. Click the Fit Axis icon. The Fitting toolbar appears.
2. Fence an area on the displayed point cloud.
3. Choose In to keep points inside the fence.
4. Or choose Out to keep points outside the fence.
5. Click Plane. A plane is extracted from kept points and its normal gives the direction of the axis.

1 - The Fitting toolbar
2 - The drawn fence

3 - A plane extracted from points inside the drawn fence

6. Click Reset to cancel the parameters (if required).

Note: The Create Fitted Geometry icon in the Fitting toolbar which is dimmed means that you are not able to save the result
in the database.
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Tip:
n Instead of selecting Close Fence from the pop-up menu, you can also double-click or press on the Space Bar of

your keyboard to close the fence.
n Instead of clicking on an icon in the Fitting toolbar, you can also select its related command from the pop-up menu

or use its related short-cut key: I for In, O for Out.

Tip: You are able to perform a lasso selection by using the Shift.

7.7.4.3.4 Pick the Local Frame of an Object

You can construct a new frame such that it becomes the local frame of the selected object.

To pick the local frame of an object:

1. Click the Pick Object Local Frame icon. The cursor takes the following shape:
2. In the WorkSpace window, click on the Models tab.
3. Right-click on the selected object.
4. Select Display Geometry from the pop-up menu.
5. Pick a point (free or constrained).

1 - The top picture shows a picked object 2 - Its associated local frame now becomes the con-
structed frame and is shown in yellow

6. Click Reset to cancel the parameters (if required).

Note: Picking another object will cancel the frame you have just constructed.

7.7.4.3.5 Take the Axis of an Axial Geometry as Axis

To take the axis of an axial geometry as axis:

1. Click e.g. the Take the Axis of an Axial Geometry as X-Axis icon. The cursor takes the following shape:
2. In the 3D View, pick an entity with an axial direction.

n The values in the X-Axis field are updated with the values of the picked entity's axis direction.

7.7.4.3.6 Pick Three Points
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To build a frame by picking three points, you have the following options: Pick 3 Points (Origin, X direction, Y direction) ,

Pick 3 Points (Origin, Y direction, Z direction) and Pick 3 Points (Origin, Z direction, X direction) . Once three points
are picked, a right-angled frame will be created.

To pick three points:
1. Click the Change 3 Points Pick Mode pull down arrow.
2. Choose a picking mode from the drop-down list.
3. Pick three points on the displayed object(s).

1 - The first picked point 2 - The third picked point

The first picked point will be the origin of the frame you wish to create.
The second picked point will form with the first one the first vector.
The third picked point will form with the first one the second vector.

4. Click Reset to cancel the parameters of the new frame (if required).

Note: You can select Cancel Picking from the pop-up menu or press Esc to cancel the frame in progress.

7.7.4.4 Build a Frame with Constraints

You can build a frame under constraint either by locking one of its components, e.g. its origin or axis, or by rotating around
an axis. No more than two components can be locked at once; it’s always a pair formed by the origin and an axis. You can-
not lock two axes together.

7.7.4.4.1 Lock the Origin

To lock the origin:
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1. Define an Origin and lock it by clicking the Lock Origin icon.

2. Define the X-Axis, Y-Axis, and Z-Axis. For each, do one of the following:
n Enter its 3D coordinates,
n Take the axis of an axial geometry as axis,
n Pick two points to define an axis,
n Fit an axis.

3. Or use the three-point pick mode .
4. Click Reset to cancel the parameters (if required).

7.7.4.4.2 Lock an Axis

To lock an axis:

1. Define e.g. the X-Axis and click the Lock X-Axis icon.
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2. Define the Origin.
3. Define the Y-Axis and Z-Axis. For each, do one of the following:

n Enter its 3D coordinates,
n Take the axis of an axial geometry as axis,
n Pick two points to define an axis,
n Fit an axis.

4. Click Reset if required.

Note: If you open the Turn Around dialog, you may see the unlocked axes dimmed (Y and Z in this example) and the locked
axis (X) checked by default.

7.7.4.4.3 Lock the Origin and an Axis

To lock the origin and an axis:

1. Define an origin and click the Lock Origin icon.

2. Define e.g. the X-Axis and click the Lock X-Axis icon.

3. Define the Y-Axis and Z-Axis. For each, do one of the following:
n Enter its 3D coordinates,
n Take the axis of an axial geometry as axis,
n Pick two points to define an axis,
n Fit an axis.

4. Click Reset (if required).

Note: If you open the Turn Around dialog, you may see the unlocked axes dimmed (Y and Z in the example) and the locked
axis (X) checked by default.

7.7.4.4.4 Rotate Around an Axis

To rotate around an axis:
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1. Click the Turn Around Axis icon. The Turn Around dialog opens.

2. Check an option among X Axis, Y Axis, and Z Axis.
3. Enter a value in the Specify Angle field.

n If the default unit of measurement has been set in degrees; you do not need to enter “°”.
n You can change the default unit of measurement in the Preferences dialog.

4. Click Apply. In the 3D View, you may see the yellow frame turns around the selected axis and of the specified angle.
5. Click again Apply. The yellow frame turns again around the selected axis and of the specified angle.
6. Click Close. The Turn Around dialog closes.

Note: If you can combine e.g. the Lock Z Axis feature with the Turn Around Axis feature. In the Turn Around dialog; only the
Z Axis is available as it is used as a constraint and the others are dimmed.

7.7.4.4.5 Build a Frame from a Geometry

This feature uses the intrinsic shape of a geometry and the position of the point that you picked to build a frame. Not all
kinds (of geometry) can be used with the feature but only those enumerated hereafter: Box, Cylinder, Cone and Extrusion.

To build a frame from a geometry:

1. Click the Build Frame From Geometry icon. The cursor takes the following shape: .
2. In the 3D View, pick a geometry.

From a box:

A Box has six Faces, eight Vertices and twelve Edges. The position of the point you picked on the box determines the Ori-
gin of the frame to create. Normally this Origin should be on:

n The Face (F) whose position is the lowest along the Z-Axis (of the current frame).
n The Vertex (V4) whose position is the closest to the picked point.
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The three axes of the frame to be created are oriented so that:
n The Edge (E4) that is the most parallel to the Z-Axis (of the current frame) gives the direction of the Z-Axis (of the

frame to create).

From a cylinder:

A Cylinder has two Bases connected by a curved surface, and an Axis joining the center of each base. No matter the pos-
ition of the Point (P) that you picked on the Cylinder, the Origin of the frame to be created should be on:

n The Base (B) whose position is the lowest along Z-Axis (of the current frame).
n The Center (C2) of the Base (B2).

The Z-Axis of the frame to be created is the Axis of the cylinder while the X-Axis and Y-Axis are randomly oriented.

From a cone (or eccentric cone):

A Cone has two Bases connected by a curved surface, and an Axis joining the center of each base. No matter the position
of the Point (P) that you picked on the Cylinder, the Origin of the frame to be created should be on:

n The Base (B) whose position is the lowest along Z-Axis (of the current frame).
n The Center (C2) on the Base (B2).

The Z-Axis of the frame to be created is the Axis of the cylinder while the X-Axis and Y-Axis are randomly oriented.
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From an extrusion:

An Extrusion is an entity coming from the conversion of a 2D Sketch into a 3D Object. The position of the point you picked
on an extrusion determines the Origin of the frame to be created. Normally this Origin should be on:

n The Face (F) whose position is the lowest along the Z-Axis (of the current frame).
n The Vertex (V4) whose position is the closest to the Point (P) you picked.

The three axes of the frame to be created are oriented so that:
n The extrusion axis gives the direction of the Z-Axis.
n The X-Axis and Y-Axis are as close as possible to the two Edges (V3-V4 and V4-V5) of the Face (F).

7.7.4.5 Create the Built Frame

Once you have built a frame, you can create it in the database. You can use the Set As Active Frame option to set it as an
active frame. If you leave the UCS Creation tool without creating the newly built frame, a dialog opens and prompts you to
create (or not) the frame.

To create the built frame:
1. Check the Set As Active Frame option (if required).
2. Click Create. A new frame, with the "Unclassified" layer and whose name is OBJECTX where X is its order, is cre-

ated in the Models Tree.
3. Click Close. The UCS Creation dialog closes.

Note: Press Esc (or select Close Tool from the pop-up menu) to leave the UCS Creation tool.
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Tip: Instead of clicking Create, you can also select Create Frame from the pop-up menu.

7.7.5 Set as Home UCS

Each project has a Home UCS under which all data reside. If needed, you can select one of the frames of the project and
set it as the new Home UCS. It is important to note that this operation will transform the coordinates of the whole database
to this new frame. You can use this operation to orient, for example, a building scene so that its Z-axis is perpendicular to its
ground plane, and its origin is on a specific corner of a building. The difference between this operation and that of setting as
Active frame is that in the latter case, there is no coordinate transformation.

To set as Home UCS:
1. Select a coordinate frame from the List window.
2. Select Set as Home UCS in Edit > Project > UCS.

Note: There is no Undo for this operation. So you should use it with care.

7.8 TZF Scan

For better usage in RealWorks, TZF Scans depending on their origin (issued directly from a Trimble TX 3D scanner or con-
verted from another format) may be required to improve their quality with post-processing or re-projection operations. Other
operations described in this chapter allow extracting 3D or image information.

Data coming from a Trimble FX instrument is stored in a C3D format file. Such data (in C3D format) once processed (in the
Trimble FX Controller software) is saved as a Trimble Scan File (with TZS file extension). Files with such extension should
now be converted to the TZF format, otherwise you cannot open them.

In the Registration module, the operations related to the TZF Scans are gathered on the Edit tab, in the TZF Scan group:

And also in the Production module, in the TZF Scan group:

7.8.1 Open RealColor

Trimble RealColor is a solution for easily and efficiently coloring TZF Scans. The RealColor feature is available with the fol-
lowing types of license: Stater, Core, Performance and Storage Tank.

To open RealColor:
1. Select either a project or a station (or set of stations).
2. Select Open RealColor in Edit > TZF Scan.

Warning: Amessage is displayed if one (or more) TZF format file(s) is (or are) missing in the project (loaded through
RealWorks or if the project is not compatible with Trimble RealColor.

Notes:
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and prompts

you to proceed to do so.
n All leveled TZF Scans will be automatically re-projected during the Post-Processing step.
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Note: For more information related to Trimble RealColor, refer please to its FAQ.

7.8.2 Post-Process TZF Scans

A TZF Scan, before being able to be used as the input of a tool, must be post-processed. A post-processing procedure is an
operation applied on the data in order to improve the contrast and the luminance and to correct the noise effect. This oper-
ation must only be done once (per TZF Scan) and there is no undo. In addition to the post-processing operation, the user
can compress the TZF Scan file(s) by reducing its size by half. If you decline to post-process a TZF Scan, you cannot then
work with that TZF Scan.

Caution: An error message appears if the TZF Scan(s) to process is (or are) read-only.

Note: Your graphic card must be Open CL 1.1 compatible (or higher) and the driver up to date. Otherwise a warning (in the
Processing TZF Scans dialog) appears and post-processing TZF Scan(s) may take a long time.

7.8.3 Create Thumbnails

The Create Thumbnails feature allows you to create Thumbnails in batch processing mode or not. In the batch processing
mode, the user interaction is not required and a set of Thumbnails is created (one per TZF file). Out of the batch processing
mode, the user interaction is required and one Thumbnail is created for a given TZF file. A Thumbnail is a preview of a TZF
file within RealWorks.

To create thumbnails:
1. Select a project or a station (or set of stations).

2. Select Create Thumbnails in Edit > TZF Scan.
n For each TZF format file, a Thumbnail is created.
n The created Thumbnail is put under its related station in the ScansTree and as a list in the Images Tree.
n Each thumbnail has the following name: Thumbnail_ its related TZF file Name.

Note: If the selected project has not been yet saved in the database, you are then prompted to do so. We advise you to
save the project under the same folder as the TZF format files.

By default, a Thumbnail is not shown in the 3D View. You need to toggle the On/Off icon to On to display it as a thumbnail in
the 3D View. You can then drag and drop the thumbnail to any location within the 3D View. To hide the thumbnail; you have
the choice between toggling Off the On/Off icon and clicking on the Close button at the top right corner.

Notes:
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and prompts

you to proceed to do so.
n All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

7.8.4 Create Station Images from TZF Scan Color
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This feature enables you to view panoramic images issued from colorized TZF Scans in the Station-Based mode and use
them for texturing a mesh. See Trimble RealColor to know how to colorize TZF Scans.

To create station images from TZF Scan color:
1. Select a project, a set of stations containing colored TZF Scans, or a set of colorized TZF Scans.

2. Select Create Station Images from TZF Scan Color in Edit > TZF Scan.
For each TZF Scan, a set of six matched images is created, one for each face of a cube map centered on the station
location.
Each matched image is named after the name of the TZF scan followed by information related to its orientation
(Front, Back, etc.).
All created images are put under a folder named according to the station name.

Each matched image has a size which is determined by the level of the used TZF Scan as specified below:
Level 1: 3105 x 3105
Level 2: 6211 x 6211
Level 3: 1243 x 1243
Extended: 9317 x 9317

3. If required, switch to the Station-Based mode.
Note:When you select a station with several TZF Scans, only the Main Scan will be considered in the creation process.

7.8.5 Get TZF Scan Files

There are two cases in which TZF format files are not present in the project folder (RWI). The first case is when a project
has been created directly from TZF format files. The second case is when some projects (with TZF format files in the RWI
folder) have been merged together and these TZF format files have not been copied into the RWI folder of the merged pro-
ject. In both cases, the link to the original TZF format files is preserved. This feature enables you to copy the original TZF
format files into the RWI folder.

To copy original TZF Scan files into the project:
1. Select a project from the Project Tree.
2. Select Get TZF Scan Files in Edit > TZF Scan.

Trimble RealWorks User Guide | 124



EDIT

Caution: A TZF Scan, for which the link to the TZF format file is broken, has the following representation . You cannot
copy such TZF format files into the RWI folder.

7.8.6 Modify TZF Path

Displacing a lone (or a set of) TZF format file(s) from its folder will break the correspondence with the station(s) created
within RealWorks. You can no longer add new scans to the project*. The Modify Path For TZF Input File(s) command
allows you to restore that correspondence by changing the path to the TZF format files.

To modify the path of the input TZF Scan files:
1. First create new stations (in batch processing mode or in interactive mode)**.
2. Then select either the Project, or the "New Group" or a station.
3. Select Modify TZF Path in Edit > TZF Scan. The Select New File Folder dialog opens. The default folder is the

one storing the opened project.
4. Navigate to the new location of TZF files stored in the In field.
5. Select the folder and click OK. The Select New File Folder dialog closes and the Information dialog below appears.

6. Click OK to close the information.

Notes:
n You may see the path to a TZF format file by displaying its related station's properties (see Input Data Path Name

line).
n (*) Trying to add new scans without changing the path to the TZF format files will open a dialog which prompts

whether to continue with the remaining stations or not.

Note:When opening a project with TZF station(s) created out of RealWorks, the correspondence(s) (from the TZF station
(s) to the TZF format file(s)) will be automatically updated only if the TZF format file(s) is (or are) in the RWI folder (of the
Project).

7.8.7 Color Points by Height

This feature will apply a rendering to the point clouds according to the height of each point along the Z (or EI) axis. This ren-
dering will be applied to both loaded and unloaded points.

To generate point color-coding by height:
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1. Select a project (or a set of projects).

2. Select Color Points by Height in Edit > TZF Scan. A dialog opens warning you that the operation is definitive and
may take a long time.

3. Click Yes to continue.
4. Click No to abort.

A warning appears showing the stations for which the required information is missing.

Note: The Rendering option will automatically swap to True Color.

7.8.8 Re-Project TZF Scans

A TZF Scan issued from a Trimble TX 3D scanner may have an issue due to a shift between the real angle and the the-
oretical grid. In other words, there is a significant shift between a pixel on the 2.5 Preview image and the 3D Point that is
behind. The Re-Project TZF Scans feature enables to correct this mismatch by re-projecting each 3D Point onto its related
pixel.

To re-project TZF Scans:
1. Select a TZF Scan (or a station or a project with TZF Scan files within).

2. Select Re-Project TZF Scans in Edit > TZF Scan.
n A progress bar appears at the bottom left corner of the user interface.
n TZF Scans are processed one after the other (in the case a station (with several TZF Scans or a project has

been selected).

Note:When you perform an operation on a station, its leveling status is first checked. If the station is Leveled, all its TZF
Scans are automatically re-projected. If the station is Unleveled, the user has to re-project all the TZF Scans manually as
described above.

You can manually set a leveled station (with TZF Scans within) to unleveled. This change (in the station leveling status) has
no impact on the TZF Scans themselves. The leveling information is still present in the TZF Scans. The TZF Scans are auto-
matically re-projected.
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Note: The Re-Project TZF Scans feature is only available in the Registration mode.

Note: If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and prompts
you to proceed to do so.

7.8.9 Remove Points from TZF Scans

This feature lets you remove points from TZF Scans. There are some prerequisites to observe. All are listed here after:
n A project with TZF Scans,
n All points have been extracted from TZF Scan(s),
n One TZF Scan per station,
n In the case there are several TZF Scans per station, all the scans will be considered.
n Points to remove need to be first isolated and then put a part in a specific folder.
n For best results, make sure the scans have been re-projected. Otherwise the eradication may not be*.

Note: (*) Only with TZF Scans coming from a Trimble TX instrument.

7.8.9.1 Create Sampled Scans

To create sampled scans:
1. In the Scans Tree, select the station(s) containing the TZF Scan(s) for which the extraction is required.

2. Select Create Sampled Scans in Edit > Scan. The Sampled Scan Creation dialog opens.
3. In the Sampling panel, choose "Sampling by Step" from the drop-down menu (if not done).
4. In the Step (in Pixels) field, enter One.
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5. Click OK. The Sampled Scan Creation dialog closes.
n The sampling scan data process is launched for each TZF Scan selected.
n Once finished, a scan is created per TZF Scan.

Note: You can abort each sampling process by pressing Esc.

7.8.9.2 Select Points to Remove

To select points to remove:
1. Switch to Production (as processing mode).

2. Select New Group in Edit > General. A new group is created under the Models tree.
3. If required, rename the newly created group* to e.g. "Points to Delete".

4. In the Models tree, select Project Cloud.
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5. Select Get All Points from the pop-up menu.

6. If required, display points of the Project Cloud by turning the bulb to On.
7. In the Cloud group, click the Segmentation icon. The Segmentation toolbar appears.
8. Double-click on the "Points to Delete" folder to select it.
9. Select a portion of points to remove by fencing an area.
10. Create the set of points (by clicking Create).
11. Repeat the steps if required.

All created Clouds are put under the "Points to Delete" folder.

12. Leave the Segmentation tool by clicking Close Tool.

Tip: (*) With the Property window open, select the newly created folder. In the Name line (of the Property window), enter a
new name.

7.8.9.3 Remove Points From TZF Scans

To remove points from TZF Scans:
1. Under the "Points to Delete" folder, select the Cloud(s) to remove.
2. Select Remove Points from TZF in Edit > TZF Scan.

n As the eradication of points leads to the modification of the TZF files, a warning appears and prompts you to
make the backup of all the original TZF files before applying the operation.

n When points are eradicated, only their 3D coordinates are removed from the TZF Scans. Neither the color nor
the luminance are removed.

Caution: Points that are isolated (from the extraction) and eradicated (from the TZF Scan(s)) are not deleted from the
RealWorks project.

Tip: As the eradication of points is time consuming, we advise you to not apply the operation for each point cloud (to
remove) but once all point clouds (to remove) have been created.
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Tip: In the RWI folder, an image (PNG format) is created showing in red the points that have been removed as a result of
the eradication process. The image file name is based on the TZF file name.

7.8.10 Create TZF Scan

You can use the Create TZF Scan feature in the Registration module, or in the Production module, for creating TZF Scans.
In the Registration module, the creation is based on stations while in Production it is based on clouds.

In the Registration module, the input selection can be either: one station, a set of stations, a group containing stations (a
folder or the project). When a selection contains at least one station that contains scans, the tool will be available. It will be
grayed out otherwise. Survey Points are not considered as scans (they don’t count in the selection and they are not expor-
ted to TZF).

7.8.10.1 Open the Tool

To open the tool:
1. In Registration, select either a project, or one or more stations from the Scans Tree.

2. Select Create TZF Scan in Edit > TZF Scan.
n The Create TZF Scan dialog comes up with two modes: Automatic and Advanced. The last mode in use is by

default selected.
n If the project is not saved yet, you will be prompted to save it (in the RealWorks format).

Note: The images that will be taken into account are those that are inside the stations. If your selection is a project and
some of your images do not belong to a station, you may see the number of images in the Create TZF Scan dialog different
from the number of images in the project.

7.8.10.2 Choose the Automatic Mode

The Automatic mode requires no input. All the parameters are grayed out.

To choose the automatic Mode:
1. In the Create TZF Scan dialog, check the Automatic option.

If there is no image in your selection, the dialog looks as illustrated below and the Number of Images is equal to 0/0.

If there are images in your selection, but their type cannot be determined, the dialog looks as illustrated below:
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If there are images in your selection, and all have been acquired using a Trimble SX10 instrument, all the types will
be automatically selected. All points will be colored with the images issued from the camera having the highest pri-
ority. The Telescope camera is the highest in priority while the Overview camera is the lowest.

n If no TZF Scan is available in the project, the default Resolution, which is of 128 MPixels, will be used. This res-
olution corresponds more or less to the Level 2 of the Trimble TX instrument or to the Overview camera of the
Trimble SX10 instrument.

n If one or more TZF Scan exists, the resolution of the Main Scan will be used.
Note: The images that will be taken into account are those that are inside the stations. If your selection is a pro-
ject and some of your images do not belong to a station, you may see the number of images in the dialog dif-
ferent from the number of images in the project.

2. Click the OK button. The Create TZF Scan dialog closes.

7.8.10.3 Choose the Advanced Mode
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In the Advanced mode, the user has to input all the parameters needed to perform a custom conversion (to TZF). The
Advanced mode needs to be used to overcome the limitations of the Automatic mode.

To choose the advanced mode:
1. In the Create TZF Scan dialog, check the Advanced option.

If there is no image in your selection, the dialog looks as illustrated below and the Number of Images is equal to 0/0.

If there are images in your selection, but their type cannot be determined, the dialog looks as illustrated below:

If there are images in your selection, and all have been acquired using a Trimble SX10 instrument, then you can
choose the image type(s) to colorize the points by using the corresponding option(s).

Trimble RealWorks User Guide | 132



EDIT

Note: The images that will be taken into account are those that are inside the stations. If your selection is a project
and some of your images do not belong to a station, you may see the number of images in the dialog different from
the number of images in the project.

2. Select the Image Type(s) by checking the corresponding option(s).
3. Enter a value in the Grid Resolution field, and type Enter.
4. If required, click the Default button.
5. Click OK. The Create TZF Scan dialog closes.

7.8.10.4 No Images, and no Scans

When the selection contains neither images nor scans, nothing will occur and no TZF Scan(s) will be created as the Create
TZF Scan feature is dimmed.

7.8.10.5 One or more Images, and no Scans

When the selection contains one or more image(s) but no scan data, nothing will occur and no TZF Scan(s) will be created
as the Create TZF Scan feature is dimmed.

7.8.10.6 No Images, and Some Scans

When the selection contains no image(s) but only scan data:
n In the Automatic mode, TZF will be created with 5 layers (3 for the positions, 1 for the intensity, one for color). The

Default resolution* will be used. TZF coverage will be based on the area that has been scanned: full dome will be
projected in the { [0, 2p[; [0, p[ } domain while smaller scanned area will be projected accordingly to a smaller
domain (TZF are cropped). The Intensity layer will be cosmetically filled up with interpolated values where there are
small holes. Bigger holes will remain untouched.

n In the Advanced mode; the resolution that will be used is the resolution defined by the user. No negative value nor a
value equal to zero can be input.

7.8.10.7 Some Images, and Some Scans

If both the images and the scan data are found under the selection to be converted:
n In the Automatic mode, the Default resolution will be used. All points will be projected at the measured distance to

pick up color. A small cosmetical filtering will be applied to fill up small isolated holes. Bigger unmeasured area will
remain uncolored (black). This is to avoid any confusion when proper coloring is not possible and when the TZF
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might be used for measure in Trimble Scan Explorer. TZF will be cropped to fit the input domain.
n In the Advanced mode; the resolution that will be used is the resolution defined by the user. No negative value nor a

value equal to zero can be input.

7.8.10.8 Created TZF Scans

In Registration:

If a single station has been selected, a unique TZF Scan will be created in the station and will be named Scan X where X is
its order. X is equal to one if no TZF Scan is available in the project. It will be incremented from one from the last TZF Scan
of the project, if there are some TZF Scans in the project.

If the whole project (or a set of stations) has (have) been selected, a unique TZF Scan per station will be created. You may
see the conversion in progress by observing the status bar.

For each TZF Scan created, a TZF format file will be created under the RWI folder. The TZF format file name is based on
the name of the station. If a TZF format file already exists with a certain name, the new one will be created with an incre-
mental suffix, i.e.: Station.tzf, Station (2).tzf, Station (3).tzf, etc.

In OfficeSurvey & Modeling or Production:

From a selection of clouds, points will be sorted by station. For each station, a TZF Scan will be created. Created TZF name
is based on the name of the station and adds a "_cloud" suffix to it. If a TZF format file already exists with a certain name,
the new one will be created with an incremental suffix, i.e.: Station_cloud.tzf, Station_cloud (2).tzf, Station_cloud (3).tzf,
etc. You may see the conversion in progress by observing the status bar.

7.9 Scan

In the Edit tab, the Scans group looks as illustrated below, in Registration:

And as shown below in Production where the Limit Box Extraction tool and the Change Cloud Color feature are not present.

7.9.1 Limit Box Extraction

The Limit Box Extraction tool combines two features. With the first feature, you can create small sections for evaluating the
registration results, drawing polylines or just getting a clearer view of a specific area. With the second feature, you can
extract the full density of points from the selection area. You can be in any processing mode (OfficeSurvey/Modeling (or Pro-
duction), or Registration) to use the Limit Box Extraction tool.

7.9.1.1 Open the Tool

To open the tool:
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n Select Limit Box Extraction in Edit > Scan. The cursor becomes as follows .
The Limit Box Extraction toolbar opens as well as the Picking Parameters toolbar.
If an object has been selected (as input of the tool) and displayed in the 3D View; the object remains selected with
its limit box.

1 - Show/Hide Clouds and Geometries Outside the
Limit Box
2 - Show Limit Box

3 - Select Limit Box Center Point
4 - Change Limit Box Center Point
5 - Limit Boxes

To be able to leave the Limit Box Extraction tool, you need to first define a position by picking a point on the dis-
played objects, or select Close Center On Point from the pop-up menu, or press Esc. and then choose either Close
Tool or Esc.

Note: No selection is required to activate the tool. It is based on what is displayed in the 3D View.

7.9.1.2 Define the Center Point of a Limit Box

To define the center point of a limit box:
1. Pick a point on the displayed clouds and/or geometries*.

n The Modify Shape, Pan, Rotate and Canonical Views icons become enabled as well as the Sampling field, and
the Store Current Limit Box, Extract Points from TZF Scans and Close Tool icons.

n The Show Limit Box and Modify Shape icons become enabled and selected.

1 - Modify Shape
2 - Pan
3 - Rotate

4 - Canonical views
5 - Store the current Limit Box
6 - Extract points from TZF scans
7 - Close Tool

n A limit box is displayed centered on the picked point which is set to the center of the screen.
n The manipulator which appears with the limit box depends on the feature that has been last used, i.e., among

Modify Shape, Pan and Rotate.
n If an object has been selected (as input of the tool) and displayed in the 3D View; the object remains selected

with its bounding box.
2. If required, edit the properties of the Limit Box.
3. Do one of the following:

n Clip a specific area and check displayed points on that area.
n Clip a specific area, extract points from TZF Scans and check extracted points on that area.

Note: (*) To leave the picking mode, you can select Close Center on Point from the pop-up menu.

7.9.1.3 Edit the Properties of a Limit Box

A limit box is a three-dimensional figure with six square faces. It is used to isolate a region on clouds and/or geometries.

7.9.1.3.1 Select the Center Point of a Limit Box

Trimble RealWorks User Guide | 135



EDIT

To select the center point of a limit box:

1. Click the Select Limit Box Center Point icon. The cursor changes to show the following .
2. Pick a point on displayed clouds and/or geometries.

n The limit box is then centered on the picked point which is set to the center of the screen.

Note: To leave the picking mode, you can select Close Center on Point from the pop-up menu.

7.9.1.3.2 Change the Center Point of a Limit Box

To change the center point of a limit box:

1. Click the Change Limit Box Center Point icon. The cursor changes to show the following .
2. Pick a point on the displayed clouds and/or geometries.

n The limit box is then centered on the picked point.

Note: To leave the picking mode, you can press Esc.

7.9.1.3.3 Manipulate a Limit Box

There are three modes of manipulations, Modify Shape, Pan and Rotate.

7.9.1.3.3.1 Resize a Limit Box

To resize a limit box:
1. Click the Modify Shape icon. A manipulator with six FaceHandles appears, one on each face of the limit box, and

eight Corner Handles.

2. To increase or decrease the size of the limit box in one direction:
n Pick a FaceHandle to select it. It turns yellow.
n Drag and drop the Face Handle away from (or toward) the center of the limit box.
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3. To increase or decrease the size of the limit box, uniformly in all directions.
n Pick a Corner Handle to select it. It turns yellow.
n Drag and drop the Corner Handle away from (or toward) the center of the limit box.

Tip: You can also select Modify Shape from the pop-up menu.

Tip: You can also use the E shortcut key instead.

7.9.1.3.3.2 Pan a Limit Box

To pan a limit box:
1. Click the Pan icon. A manipulator, which is composed of three Axis Handles and three Plane Handles, appears. It

has as its origin the center of the limit box.
2. Do one of the following:

n Pan in a plane.
n Pan along a direction.

Tip: You can also select Pan from the pop-up menu or use its associated shortcut key T.

Note: It is advantageous to display the clouds and/or geometries that are outside the limit box and/or all of the Station Pos-
itions of the project. By doing this, you can know exactly where you are within the rest of the cloud and/or within all of the sta-
tions.

Tip:
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n You can use the following keys (á,â,ß,à, Page Up, Page Down) on your numeric keypad to move the limit box.
n You can combine the use of the above keys with the Ctrl key to speed up the movement of the limit box.

To pan the limit box along a direction:
1. Pick an Axis Handle to select it. It turns yellow. A direction in yellow aligned with the Axis Handle appears.
2. Drag the Axis Handle along the direction to move the limit box in that direction.
3. Drop the Axis Handle.

The cloud inside the limit box is automatically updated.

To pan the limit box in a plane:
1. Pick a Plane Handle to select it. A larger yellow Plane Handle is displayed.
2. Drag the Plane Handle in any direction on the plane to move the limit box in that direction.
3. Drop the Plane Handle.

The cloud inside the limit box is automatically updated.
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7.9.1.3.3.3 Rotate a Limit Box

To rotate a limit box:
1. Click the Rotate icon. A manipulator, which is composed of three Ring Handles (red, light blue and green), is dis-

played. This manipulator has the center of the limit box as the origin.
2. Pick a Ring Handle to select it. It turns yellow. An axis, passing through the center of the ring and perpendicular to it,

appears. This axis has the color of the selected ring.
3. Drag the Ring Handle to rotate the limit box around the axis.
4. Drop the Ring Handle.

The cloud inside the limit box is automatically updated.

Tip: You can also select Rotate from the pop-up menu or use its related shortcut key R.

7.9.1.3.3.4 Switch from one Mode of Manipulation to Another

You can easily switch between the different manipulation modes, i.e. from Modify Shape to Pan, and from Pan to Rotate,
and so on, by just picking one of the Handles.

Note: The cursor changes to when you hover it over a Handle.

7.9.1.3.4 Display and Hide a Limit Box

A limit box can be displayed and hidden at any time.

To display a limit Box:
n Click the Show Limit Box icon.

n The limit box, with its manipulator (Size, Pan or Rotate), is displayed in the 3D View.
n The Show Limit Box icon is highlighted in yellow.

To hide a limit Box:
n Click the Show Limit Box icon.

n The limit box, with the current manipulator, is removed from the 3D View.
n The Show Limit Box icon becomes unselected.
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7.9.1.3.5 Display & Hide Clouds and Geometries Outside the Limit Box

All objects that are outside the limit box, whatever they could be, can be at any time displayed, or hidden.

To display clouds and geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are displayed in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon is highlighted in yellow.

To hide clouds and geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are hidden in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon becomes unselected.

7.9.1.3.6 View a Limit Box from one of its Sides

To view a limit box from one of its sides:
1. Click on the Canonical Views pull down arrow.
2. Choose a view from the drop-down list.

Or
3. Right click in the 3D View.
4. Choose a view from the pop-up menu.

7.9.1.4 Record Limit Boxes

To record a limit box:
n Click the Record the Current Limit Box icon.

In the Limit Box window (if open), a limit box object with a default name (New Limit Box) is then created.

7.9.1.5 Manage Limit Boxes

A limit box, once recorded, is stacked in a list in the Limit Box window (if open).
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To rename a limit box:
1. In the Limit Box window, select a limit box.
2. Press the F2 key. The name of the selected limit box becomes editable.
3. Input a new name, and press Enter.

To add a description to a limit box:
1. In the Limit Box window, select a limit box.
2. Click inside the Description panel.
3. Input a comment in the Description panel.

To load a limit box:
1. In the Limit Box window, select a limit box.
2. Click the Apply Limit Box icon.

Tip: You can also right-click on a limit box and select Apply Limit Box from the pop-up menu or double-click a limit box.

To remove a limit box:
1. In the Limit Box window, select a limit box.
2. Click the Remove Limit Box icon. The selected limit box will be removed from the Limit Box window,

Tip: You can also right-click on a limit box and select Remove Limit Box from the pop-up menu.

To export limit boxes:
1. In the Limit Box window, click the Export icon. The Export a Limit Box File dialog opens.
2. Navigate to the drive/folder where to store the file.
3. Input a name in the File Name field.
4. Click Save. The Export a Limit Box File dialog closes.

A file with the extension (.BOX) will be then created. This file will contain as many limit boxes as the project contains.

To import limit boxes:
1. In the Limit Box window, click the Import icon. The Import a Limit Box File dialog opens.
2. Navigate to the drive/folder where the file is located.
3. Click on the file to select it. Its name appears in the File Name field.
4. Click Open. The Import a Limit Box File dialog closes.

To restore the last used limit box:

Use to restore the last unsaved limit box.

7.9.1.6 Check the Current Loaded Points

The primary aim of this tool is to let the user isolate a specific area of the points that are displayed in the 3D View.

To check the current loaded points:
1. Set the limit box to a position where you want to check loaded points*:
2. Do of the following:
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n If required, resize the limit box.
n If required, pan the limit box.
n If required, rotate the limit box.
n If required, hide the limit box.

3. Check the quality of the registration based displayed points.
4. Close the tool.

Note: (*) It is advantageous to display the clouds and/or geometries that are outside the limit box and/or all of the Station
Positions of the project. This allows you to easily know exactly where you are within the rest of the cloud and/or within all of
the stations.

7.9.1.7 Extract Points from a Specific Area

The Limit Box Extraction feature also allows the user to extract and analyze points on a specific area at a user selectable
density. The extraction is done by sampling TZF Scans.

To extract points from a specific area:
1. If required, set the limit box to a position where you want to extract more points*:
2. Do one of the following:

n If required, resize the limit box.
n If required, pan the limit box.
n If required, rotate the limit box.

3. Choose among Sampling by Step, Spatial Sampling and Spatial Sampling (Keep Details).
4. Create scans from TZF Scans.
5. Close the tool.

Note: (*) It is advantageous to display the clouds and/or geometries that are outside the limit box and/or all of the Station
Positions of the project. This allows you to easily know exactly where you are within the rest of the cloud and/or within all of
the stations.

Note:When you clip a large region on a pure TZF Scan (with points that are extracted), and apply either the Sampling By
Step, or the Spatial Sampling, or the Spatial Sampling (Keep Details), a dialog opens and prompts to first save the project.

7.9.1.7.1 Apply a Sampling by Step Filter

With the Sampling by Step filter, one point will be taken into account at each defined Step vertically and horizontally in the
2D image data. The Sampling by Step filter is required for getting a fast overview of all of the scans.

To apply a sampling by step filter:
1. Click on the first pull-down arrow.
2. Choose Sampling by Step from the drop-down list.
3. Enter a value in the Step field.

Note: A Step value is a value in pixels and it is always positive.

7.9.1.7.2 Apply a Spatial Sampling Filter

The Spatial Sampling method allows you to obtain a point cloud with a homogeneous spatial density that you have to
define.

To apply a spatial sampling filter:
1. Click on the first pull-down arrow.
2. Choose Spatial Sampling from the drop-down list.
3. Enter a value in the Distance field.

Note: A Distance value must always be positive.

7.9.1.7.3 Apply a Spatial Sampling (Keep Details) Filter
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This method enables to adaptively sample a TZF Scan using the local context, in order to extract a scan with high point
density in high contrast areas (e.g. edges) and low point density in flat, low varying areas (e.g. walls, floors). You have to
define a resolution which allows you to control the density of points in flat regions, and all the points in high information
areas are kept.

To apply a spatial sampling (keep details) filter:
1. Click on the first pull-down arrow.
2. Choose Spatial Sampling (Keep Details) from the drop-down list.
3. Enter a value in the Distance field.

Note: A Distance value must always be positive.

7.9.1.7.4 Create Scans from TZF Scans

To create scans from TZF Scans

1. Click the Extract Points from TZF Scans icon in the toolbar.
2. Or select Extract Points from TZF Scans from the pop-up menu.

n The extraction is then launched. RealWorks goes through all of the TZF Scans in the project, from the first to the
last. You can see the extraction status of each in the status bar.

n For TZF Scans inside the Limit Box, points are extracted and the process for each can take some time.
n At the end of the extraction:

n In the Models Tree, a cloud is created.
n In the Scans Tree, a scan is created for each TZF Scan (that is inside the Limit Box).
n In the 3D View, points inside the Limit Box are denser.

Note: Be aware that the extraction can take time in case there are a lot of TZF Scans inside the Limit Box and/or if the
(sampling) parameter is too small.

Caution: If there is no TZF Scan inside the Limit Box, the extraction (of points) is also launched. No point will be extracted.

Note: The project is automatically saved at the end of the extraction.

7.9.1.7.5 Cancel the Extraction

You can cancel an extraction in progress by pressing Esc. By doing this, no cloud and no scans will be created.

7.9.1.8 Close the Tool
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To close the tool:
n Do one of the following:

n Click Close Tool in the toolbar.
n Or Select Close Tool from the pop-up menu.
n Or press Esc.

7.9.2 Create Sampled Scans

The Create Sampled Scans feature allows the user to create a series of Sampled Scans in batch processing mode without
having to interact. But if required, the user can also create a series of Sampled Scans, but one by one.

To create sampled scans:
1. Select either a project or a station (or set of stations) or a TZF Scan (or a set of TZF Scans).
2. In the Scan group, click the Create Sampled Scans icon. The Sampled Scan Creation dialog appears.
3. Sample to the scan data.
4. And if required, filter the scan data.
5. Click Ok. The Sampled Scan Creation dialog closes.

n Each new Sampled Scan is named as follows:
n Sample - A where A is the Step value set in Sampling By Step,
n Or Sample - A where A the Distance value set in Spatial Sampling,
n Or Sample (Keep Details) - A where A the Resolution On Flat Areas value set in Spatial Sampling (Keep

Details),
n You can add as many Sampled Scans as needed under a given station. If a project has been selected, Sampled

Scans (one per station) are created in batch processing mode. If a station has been selected, only a Sampled
Scan is created and under the selected station.

Warning: All Sampled Scans cannot overall four billions points.

Tip:When you create from several TZF Scans within a station, all Sampled Scans (in that station) do not have the same
color. Each has its own color.

Notes:
n If the selected project has not been yet saved in the database, you are then prompted to do so. We advise you to

save the project under the same folder as the TZF format files.
n Inside the RWI folder, a scan file (with RWCX extension) is created per sampled scan named as follows Pro-

jectName_StationX_ScanY.

Notes:
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and prompts

you to proceed to do so.
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n All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

Tip: You can also right-click on a TZF Scan and select Create Sampled Scans from the pop-up menu.

Note:RealWorks internally computes the final number of points a full resolution extraction takes, and then checks the local
disk place. If there is a risk for the operation to fail due to a lack of disk space, an information box pops up, displays an estim-
ated amount of needed space and the actual space left on the selected disk. If there is no risk, nothing happens.

7.9.2.1 Sample the Scan Data

There are three sampling methods (Sampling by Step,Spatial Sampling and Spatial Sampling (Keep Details)) that you can
use in order to reduce the number of points in the scan data.

The sampling will be applied to the entirety of the scan data. The number of estimated points will be updated according to
the defined parameter except when using the Spatial Sampling or the Spatial Sampling (Keep Details). It is in that case
"Undefined". Note that the use of the

In the Sampling by Step method, one point will be taken into account at each defined Step vertically and horizontally in the
2D image data.

To apply a sampling by step:
1. Click on the Sampling pull-down arrow.
2. Choose Sampling by Step from the drop-down list.
3. Enter a value in the Step (In Pixels) field.
4. Or use the Up (or Down ) button to choose a value.

The Spatial Sampling method allows you to obtain a point cloud with a homogeneous spatial density that you have to
define.

To apply a spatial sampling:
1. Click on the Sampling pull-down arrow.
2. Choose Spatial Sampling from the drop-down list.
3. Enter a value in the Resolution field.
4. Or use the Up (or Down ) button to choose a value.

The Spatial Sampling (Keep Details) method enables you to adaptively sample a TZF Scan using the local context, in order
to extract a scan with high point density in high contrast areas (e.g. edges) and low point density in flat, low varying areas
(e.g. walls, floors). You have to define a resolution which allows you to control the density of points in flat regions, and all
the points in high information areas are kept.

To apply a spatial sampling (keep details):
1. Click on the Sampling pull-down arrow.
2. Choose Spatial Sampling (Keep Details) from the drop-down list.
3. Enter a value in the Resolution On Flat Areas field.
4. Or use the Up (or Down ) button to choose a value.

7.9.2.2 Filter the Scan Data
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There are two filters (Filter by Range and Filter by Zone) that you can use in order to reduce the number of points in the
scan data. Note that the use of the Filter by Range has no effect on the number of estimated points.

The By Range allows you to define a distance (from the center of the FX instrument) beyond which no point will be taken
into account. This filter is only applied to the scan data.

To filter by range:
1. Check the Filter by Range option. The Max Distance field becomes editable.
2. Enter a value in the Max Distance field.
3. Or use the Up (or Down ) button to choose a value.

The By Zone option allows filtering by defining a bounding box. The Min Point and Max Point are the two extremities of a
bounding box diagonal.

To filter by zone:
1. Check the By Zone option. The Min Point and Max Point fields become editable.
2. Enter a 3D coordinate in the Min Point field.
3. Enter a 3D coordinate in the Max Point field.

7.9.3 Equalize Luminance

You can equalize the intensity of all points of a project. The equalization augments the intensity dynamics to the whole
range (0,255). You can see the results immediately if you are in the intensity displaying mode (Gray Scale Intensity or Color
Coded Intensity).

To equalize point cloud luminance:
1. Select a project from the Project Tree.

2. Select Equalize Luminance in Edit > Scan. A message will prompt you to confirm (or cancel) the operation.
3. Click Yes to continue.

Notes:
n There is no Undo for this operation. So you should use it with care.
n This operation can take a significant amount of time in the case of large datasets.

7.9.4 Equalize Color

Generally speaking, data acquired by a 3D laser scanning system (scanner and embedded camera) contain a 3D point
cloud and a collection of 2D images. Each point of the point cloud can contain not only its 3D coordinates, but also other
attributes such as intensity or color. The intensity information is given by the scanner and the color information by the cam-
era. Point color equalization merges both the intensity information and the color information inside a single project. You can
see the result immediately if you are in the intensity displaying mode (Gray Scale Intensity or True Color).

To equalize point cloud color:
1. Select a project from the Project Tree.

2. Select Equalize Color in Edit > Scan. A message prompts you to confirm or cancel the operation.
3. Click Yes to continue.

Notes:
n There is no Undo for this operation. So you should use it with care.
n This operation can take a significant amount of time in the case of large datasets.

7.9.5 Color Points

This feature lets you color all the points of a station using the associated images. The only prerequisite is that the images
should be matched images. In any processing mode, you can select a project and the point coloring will be applied to all sta-
tions of the project. In the Registration, the user can select a station (or a set of stations), the point coloring will be applied to
the selected station(s). Note that there is no undo. Point coloring is permanent.

To color points using station images:
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1. Select a project from the Project Tree (in any processing mode).
2. Or select a station (or a set of stations) from the Project Tree.

3. Select Colorize Points in Edit > Scan. A dialog appears and prompts you to continue or to abort the action.
4. Click Yes. The dialog closes.

If the current project comes from the import of a JXL format file, from the Trimble SX10 instrument, the Image Type
Selection dialog appears:

Note: The images that will be taken into account are those that are inside the stations. If your selection is a project
and some of your images do not belong to a station, you may see the number of images in the dialog different from
the number of images in the project.

5. Select a type by checking the corresponding check box. The number of images of the chosen type is displayed.
6. Click OK. The Image Type Selection dialog closes.

Note: You can select the three types at the same time.

Note: If no check box has been selected, a warning will open and no points will be colored.

7.10 Point Cloud

In the Edit tab, the Cloud group looks as illustrated below, in the Production mode:

Where it is missing in the Registration module.

7.10.1 Segmentation

This tool allows you to segment a point cloud object into several point sub-clouds. By using this tool, you can structure a
complex scene into its logical component parts, and work subsequently on each part. It is important to note that an object
containing both the point cloud and geometry representations cannot be segmented. In order to do this, you have to use the
Sampling tool to create a new point cloud without geometry and then perform the segmentation on the newly created point
cloud. In order to enable this tool, you should select one or several point cloud objects.

Note: The Segmentation tool, as a main tool, is only available in OfficeSurvey and Modeling (or Production). When using it
as a sub-tool, it is available anywhere.

7.10.1.1 Open the Tool

To open the tool:
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1. Select a point cloud (or more*) from the ProjectTree.

2. Select Segmentation in Edit > Cloud. The Segmentation toolbar appears.

1 - Selection features
2 - Box Selection**
3 - Manual method for assigning classification lay-
ers to point clouds

4 - Create (P)
5 - Close Tool

n An information box appears at the top right corner of the 3D View and displays the sum total of points included in
the selected object. The mouse cursor shape changes; the arrow becomes a pointer. You can still navigate
(Zoom, Pan and Rotation) through the 3D scene, select or hide objects (or groups) or change the active group
before you start drawing a fence. Once you start drawing, these commands become unavailable except Pan.

n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not
checked, all objects displayed in the 3D View are hidden except the one selected. All of the displayed objects
have their bulb icon turned to Off.

n If the option is checked, all objects displayed in the 3D View remain displayed. All displayed objects have their
bulb icon remained On, except the one selected.

Tip: After opening the tool, the default selection method is the last used one.

Caution: (*) You can select several point clouds for entering the tool but one of them should not be the Project Cloud. In
case of a single selection, the Project Cloud can be selected as input of the tool.

Note: (**) The Box Selection feature becomes enabled only if the Segmentation tool is used with the Limit Box Mode.

Note:When using the Segmentation tool as a main tool, you can create a new folder, move or delete an object from the Pro-
ject Tree while doing a segmentation. When using the Segmentation tool as a sub-tool, you are only allowed to create a
new folder. Moving or deleting an object from the Project Tree, while doing a segmentation, is not permitted.

Tip: You can change the color of a fence in the Preferences / Tools dialog. This should be done before entering into the
tool, otherwise a message pops up.

7.10.1.2 Delimit a Region on a Set of Points

A fence may have several shapes (Polygon, Rectangle, Circle, Lasso or a combination of a Polygon and Lasso). A fence is
used as segmentation boundaries and drawing one is done by picking (or dragging) in the 3D View. Once the first vertex of
a fence is picked, you can no longer move the scene.

Tip: You can use the Esc key to cancel the fence that you are drawing.

Note: If you select Close Tool (or New Fence from the pop-up menu) while you have not finished drawing, your fence will
be cancelled.

Tip: To start a new fence, you need to cancel the current one by selecting New Fence from the pop-up menu.

Note: Even if the pop-up menu is displayed, the fence still snaps to the mouse cursor. You have to terminate the fence to
free it. When selecting In (or Out), RealWorks will automatically close your fence and points inside (or outside) this fence
will be kept.

Caution: Be careful with the Keep Displayed Objects Visible When Starting Segmentation option in the Preferences dialog.
If you decide to keep the option unchecked, all displayed clouds remain displayed with the selected cloud after entering the
tool. You are able to fence, not only the selected cloud but also those that are not selected (but only displayed). This may be
confusing but keep in mind that the displayed clouds are not taken into account in the fencing result.
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7.10.1.2.1 Draw a Fence (Polygon Only)

To draw a fence (polygon only):

1. Click the Polygonal Selection icon.
2. Click anywhere to draw the first vertex of a polygonal fence.
3. Click anywhere to draw the second vertex. The two vertices are linked by a segment.
4. Continue to define other vertices. The polygonal fence is always closed in such a way that the start vertex is always

linked to the last one.
5. Right-click in the 3D View to display the pop-up menu.
6. Select End Fence to terminate the polygonal fence.

Note: To end a fence, you can double-click (or press on the Space Bar).

Tip: You can select Polygonal Selection from the pop-up menu.

7.10.1.2.2 Draw a Fence (Lasso Only)

To draw a fence (lasso only):

1. Click the Polygonal Selection icon.
2. Press the Shift key, and drag the cursor around the objects (or the area) you want to fence.
3. Release the Shift key, once the lasso is drawn.
4. Right-click in the 3D View to display the pop-up menu.
5. Select End Fence to terminate the lasso.

Note: To end a fence, you can double-click (or press on the Space Bar).

Tip: You can select Polygonal Selection from the pop-up menu.

7.10.1.2.3 Draw a Fence (Polygon and Lasso)

To draw a fence (polygon and lasso):

1. Click the Polygonal Selection icon.
2. Pick anywhere to start the first vertex of a fence.
3. Pick anywhere to set the second vertex. The two vertices are linked by a straight line.
4. Press the Shift key and then drag the cursor around the objects (or the area) you want to fence.
5. When you finish, release the Shift key and the mouse button.
6. Continue to define other vertices. The fence is always closed in such a way that the start vertex is always linked to

the last one.
7. Right-click in the 3D View to display the pop-up menu.
8. Select End Fence to terminate the fence.

Note: To end a fence, you can double-click (or press on the Space Bar).

Tip: You can select Polygonal Selection from the pop-up menu.

7.10.1.2.4 Draw a Rectangular Fence

To draw a rectangular fence:

1. Click the Rectangular Selection icon.
2. Click anywhere to draw the first corner of a rectangular fence.
3. Click anywhere to draw the second and opposite corner. The rectangular fence is drawn.

Tip: You can select Rectangular Selection from the pop-up menu.

7.10.1.2.5 Draw a Circular Fence

To draw a circular fence:
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1. Click the Circular Selection icon.
2. Pick a point to start the first point of a Circular Fence's diameter.
3. Pick another point to set the second point of the diameter.

Tip: You can select Circular Selection from the pop-up menu.

7.10.1.3 Keep Points Inside or Outside a Fence

Once you have finished defining a fence, you can now segment the selected point cloud(s) by keeping either the points
inside (or outside) of the fence. Note that any segmented cloud is not permanently created in the database. You should use
the Create command to perform this operation. This also means that you can turn around the so-segmented cloud, and con-
tinue to perform fencing and segmentation.

To keep points inside or outside a fence:

1. Click the In icon. Points inside the fence are kept. Points outside the fence are unkept. This doesn't mean that
they are not deleted from the initial cloud but just hidden in the 3D View. The number of points inside the fence is
shown in the information box. You can also use the short-cut key I to do this. If the fence does not contain any
points, selecting In will not take any points into account.

2. Or click the Out icon. Points outside the fence are kept while those that are inside are unkept. The number of
remaining points is shown in the information box. You can also use the short-cut key O to do this. If the fence does
not contain any points, selecting Out will not take any points into account.

3. Click Display Un-partitioned Points if you want to work with the same cloud.

A - Polygonal fence B - Points inside the polygonal
fence are kept

C - Points outside the polygonal
fence are kept

Tip: You can also select In (or Out) from the pop-up menu.

Note: After keeping points in (or out) the fence, you can rotate the scene to do the selection from another point of view.
Such a combination allows you to do a 3D point selection (like to segment the cloud with a 3D polyhedron which is the inter-
section of the extrusion of these 2D fenced polygons).
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7.10.1.4 Assign a Classification Layer to the Fenced Cloud

You can assign a classification layer to the fenced cloud only when using the Segmentation tool as a main tool.

To assign a classification layer to the fenced cloud:
1. Click on the pull-down arrow.
2. Choose between "Maintain Classification" and a specific classification layer.

n If "Maintain Classification" has been chosen. clouds will be segmented and their attributes preserved. The num-
ber of output clouds will be equal to the number of input classification layers.

Clouds sharing the same classification layer will be merged into the segmentation result.

n If a specific classification layer has been chosen, clouds will be segmented and merged into a single cloud. The
chosen classification layer will be assigned to the segmentation result.
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7.10.1.5 Set the Cloud Inside the Limit Box as a Working Cloud

The Box Selection feature lets the user set the cloud inside the Limit Box as a working cloud.

To set the cloud inside the limit box as a working cloud:
1. In the Limit Box group, click the Limit Box Mode icon. The Limit Box Mode toolbar and the Picking Parameters tool-

bar open.
2. Define a Limit Box. For more information, refer to the Limit Box Mode section.

3. If the clouds and/or geometries outside the Limit Box are displayed, hide them by clicking . Otherwise, the Box

Selection feature (in the Segmentation toolbar) remains grayed-out.

n With a fence drawn, choose e.g. In (I) . The working cloud is the selected cloud. The number of points inside
the fence is displayed in the information box.
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n With a fence drawn, first click Box Selection to set the cloud inside the Limit Box as the working cloud. And
then choose e.g. In (I) . The number of points inside the fence is equal to zero.

7.10.1.6 Create the Results

To create the results:
1. Right-click anywhere in the 3D View to display the pop-up menu.
2. Select Create from the pop-up menu.
3. Select Close Tool.

n A cloud named OBJECTX is created in the Models Tree.
n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not

checked, all objects displayed in the 3D View remain hidden except the one selected.
n If the option is checked, all objects displayed in the 3D View remain displayed.

Tip: Instead of selecting Create from the pop-up menu, you can also press the P key on your keyboard.

Note:
n Selecting Create without closing the fence will close it automatically and a new cloud object will be created from all

points inside (or outside) this fence.
n The Create feature is always enabled after entering the tool even if there is no drawn fence. This way, you can cre-

ate a new cloud. It is based on all points of the selected cloud.
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Note:When using the Segmentation tool as a main tool, you can save your project after creating the segmented clouds in
the database.

Caution: You cannot save your result(s) when using the Segmentation tool as a sub-tool. The Create button is dimmed.

Note: A dialog appears and asks if you really want to close the tool without saving the result in the database (after a fencing
only).

7.10.2 Sampling

The Sampling tool enables to create a sub-point cloud from a selected point cloud. There are at all six methods: Spatial
Sampling, Random Sampling, Scan-Based Sampling, Intensity-Based Sampling, Discontinuity-Based Sampling and
Ground Extraction. The initial point cloud remains unchanged after sampling. You can combine these six different methods
to sample the selected point cloud, that is; you can use the result from one method as the input to another method and con-
tinue until you are satisfied with the result. Or you can create several sub-point clouds within an opened session.

Note: In case of a single point cloud (as input), the point cloud, that will be created from each method, will have the same
layer than the selected one, except when using the Ground Extraction method with the Keep Ground option. In case of sev-
eral point clouds, the created point cloud will have "Unclassified" as a layer.

7.10.2.1 Open the Tool

To open the tool:
1. Select a point cloud from the Project Tree.

2. Select Sampling in Edit > Cloud. The Sampling dialog opens.
The sampling method which appears first is the last used one.
The Scan-Based Sampling,Random Sampling and Ground Extraction methods work on disk', i.e., on the full data,
independently of what is loaded in the RAM. See [A].
The Spatial Sampling, Intensity-Based Sampling and Discontinuity-Based Sampling methods work on what is
loaded only in the RAM. See [B].
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Tip: To leave the Sampling tool, you can select Close from the pop-up menu or press Esc.

Caution: You are prevented from changing the number of loaded points inside the Sampling tool. The Point Loading Man-
ager is grayed out.

7.10.2.2 Choose a Method

Inside each method, you can use the Segmentation tool to select a data subset for performing a sampling. When used in
such condition, you cannot save the result. The Create command is deactivated.

Caution: In case you enter the Segmentation tool after sampling a point cloud, the number of points in the "Remaining"
field is considered as the input of the Segmentation tool. If you close the tool without performing any segmentation oper-
ation on the point cloud, first you get back to the Sampling tool, and the number of points upstream the Segmentation tool is
then considered as the "Initial" points.

7.10.2.2.1 Spatial Sampling

Point clouds obtained by scanning from different positions and at different distances are often not uniform in terms of point
density. This method enables you to obtain a point cloud with a homogeneous density (that the user has to define).

To sample spatially:
1. In the Sampling dialog, click the pull down arrow.
2. Choose Spatial Sampling from the drop-down list. The Spatial Sampling dialog appears.

1 - Density of points expressed in terms of a distance
between points

2 - Non editable fields

This dialog displays two numbers: Initial and Remaining. The Initial number is the total number of points before
sampling. The Remaining number corresponds to the number of points after sampling. The unit of measurement is
set by default in millimeters; but you can change it when necessary in Preferences.

3. Enter a value in the Distance Between Points field.
4. Click Preview to view the result before saving it.
5. Click Create and Close.

A sub-point cloud whose name is "Sample - "Distance Between Points" Value" is created under the current project
in the Models Tree.

Note: A negative value input in the Distance Between Points field is automatically converted to positive.

7.10.2.2.2 Random Sampling

This method consists in sampling a point cloud by using a percentage ratio defined by the user, which will determine the
amount of points that will be kept in the initial point cloud. These points will be randomly selected from the original point
cloud.

To sample randomly:
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1. In the Sampling dialog box, click the pull down arrow.
2. Select Random Sampling. The Random Sampling dialog appears.

1 - Slider
2 - Pre-defined (or user-defined) values

3 - Non editable field
4 - Editable field

In this method, there is no Preview. There are four ways to define the percentage ratio. The first is to use a slider.
The second is to select a predetermined value among those pre-defined (25, 50, 75 and 100%). The third is to enter
a rate value manually and the fourth is to enter the number of points in the Remaining field. Each time you define a
new ratio, the sampling will be performed dynamically, and the results (the number of points and the final cloud -
respectively in the dialog and in the 3D View) are displayed in real time.

3. Define a percentage ratio.
4. Click Create to save the result.
5. Click Close.

A sub-point cloud whose name is "Sample - "Rate in Percent" Value" is created under the current project in the
Models Tree.

Note:When entering a value in the Rate or Remaining field, do not forget to press Enter.

7.10.2.2.3 Intensity-Based Sampling

This method can be used for sampling the selected point cloud according to the intensity associated with each point. In
RealWorks, the intensity value ranges from 0 to 255. After selecting the Intensity Based Sampling method, the selected
point cloud will be rendered in Gray Scale Intensity.

To sample based on intensity(ies):
1. In the Sampling dialog, click the pull down arrow.
2. Select Intensity-Based Sampling. The Intensity-Based Sampling dialog appears.
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1 - Select Point Intensity
2 - Filtering range
3 - Vertical bars

4 - Unkept points (in red)
5 - Kept points (in grey)
6 - Show/Hide points that are out of the defined range

A histogram window appears in the dialog. You can then use the two vertical bars, which are shown as arrows at the
bottom of the histogram in the figure above, to define an intensity range so that all points with intensity within this
range will be kept. All points outside of this intensity range (called Unwanted Points) will be un-kept and shown in
red in the histogram and in the 3D View (only if the Display Unwanted Points option is checked). To manipulate the
two vertical bars, you can either directly use the cursor to move them, or use the picking mechanism (button on top
of the histogram) to select an intensity level from the displayed points.

3. Do one of the following:
n Sample according to point intensity.

a. Click Select Point Intensity.
b. Pick one point in the 3D View.

n Sample according to a range of intensity.
a. Place the mouse cursor over a vertical bar.
b. Drag and drop the vertical bar when the intensity value you need is reached.
c. Do the same operations for the other vertical bar.

4. Click Create and Close.
A sub-point cloud whose name is "By Intensity (X)" is created under the current project in the Models Tree. X is its
order.

Notes:
n If the selected cloud contains points with no intensity information, these points will not be taken into account.
n If you switch from Gray Scaled Intensity to Color Code Intensity; the selected Point Cloud is then rendered with a

range of colors - from red to blue with intermediate colors like orange, yellow and green. Points with intensity of 0
are rendered in red; those with intensity of 128 are in yellow and those with 255 are in blue.

7.10.2.2.4 Scan-Based Sampling

On certain occasions, you need to create a sub-point cloud including all points belonging to certain stations or scans. You
can use this method to achieve this. After selecting the method, the selected point cloud will be automatically rendered
according to the Scan Color.
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To sample based on scan(s):
1. In the Sampling dialog, click the pull down arrow.
2. Select Scan-Based Sampling. The Scan-Based Sampling dialog appears.

A sub-window including the Scans Tree appears in the dialog. By default, all elements (stations and scans) in this
tree are On. You can turn Off a station, a scan or a set of scans from this tree. The total number of points will be
changed accordingly and the point cloud displayed in the 3D View will be updated.

If required, use the Expand All (or Collapse All ) icon to expand (or shrink) the Scans Tree in the dialog.

If required, use to select all items from the dialog, to clear the selection and to reverse the selection.

"On" items are shown in the 3D View and will be considered in the final result

"Off" items (blue points) are hidden in the 3D View and won't be taken into account in the final result
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3. Turn Off some of the stations (or scans).
4. Optionally, check the Split Per Scans option.
5. Click Create to save the result.
6. Click Close. In the Models Tree, under the current project:

If the Split Per Scans option has not been checked, all selected scans are merged to create a new cloud named "By
Scan".

If the Split Per Scans option has been checked, a folder named "By Scan" is created. For each selected scan, a
cloud is created and named following the name of its station.

If a station has two scans and one is selected, only the selected scan is used to create the cloud.
If a station has two scans and both are selected, the two scans are merged as one cloud.
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Tips:
n You can select several stations (or scans or a mix of them) (from the Scan-Based Sampling dialog) by using the

CTRL(or SHIFT) key combined with the left clicking.
n To select all items (scans and/or stations) at once (from the Scan-Based Sampling dialog), select first an item and

then use the CTRL+ A key combination.

In this sub-tool, only stations and scans from the selected cloud are displayed in the dialog, instead of all of the stations and
scans of the project.

Tip: You can resize all the sampling dialogs horizontally, in particular the Scan-Based Sampling dialog in order to be able to
see all item names fully in case they are too long.

7.10.2.2.5 Discontinuity-Based Sampling

You may encounter discontinuities in a point cloud in three cases. First is when some points of the cloud have opposite or
different normal direction than the rest. We call this discontinuity Edge. Second is when all the cloud points have the same
normal direction but some of them are separated by irregular distance. We call this discontinuity Gap. The third case can be
everything except Edges and Gaps.

When loading a file of ASCII format, Edges and Gaps are un-generated. You can use the Edge Detection tool to generate
them. After selecting the Discontinuity-Based Sampling method, the selected point cloud will be automatically rendered in
Discontinuity Display.

To sample based on discontinuities:
1. In the Sampling dialog box, click the pull down arrow.
2. Select Discontinuity-Based Sampling. The Discontinuity-Based Sampling dialog appears.
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1 - Display/Hide discontinuity options 2 - Launch the Edge Detection tool

When selecting this method, the three discontinuity options are all checked. The Keep Edge option (when
unchecked) enables the removal of Edge discontinuities from the point cloud. The Keep Gap option (when
unchecked) enables the removal of Gap discontinuities from the point cloud. The Keep Others option (when
unchecked) enables removal of all discontinuities except Edges and Gaps.

3. If required, detect edges.
4. Click Create and Close. A sub-point cloud will be created in the database.

A sub-point cloud whose name is "By Discontinuity (X)" is created under the current project in the Models Tree. X is its
order.

7.10.2.2.5.1 Detect Edges

The Edge Detection is based on a grid method. You should first define a projection surface (mainly a plane) and then set its
grid resolution. The grid resolution is square - the same in both of the projection plane directions (length and width).
To detect edges:
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1. Click Edge Detection. The Edge Detection dialog opens.

1 - Set From Frame
2 - Fit
3 - Pick Axis From Object
4 - Plane Perpendicular to Screen
5 - Pick 3 Points on Plane

6 - Edit Parameters
7 - Plane Parallel to Screen View
8 - Projection Plane Resolution
9 - Discontinuity display options

2. Do one of the following to define a projection plane:
n Select a frame’s axis (1).
n Fit an extracted set of points with a plane (1).
n Find a perpendicular view plane from an extracted set of points (1).
n Pick an object’s axis (1)(2).
n Pick a plane perpendicular to the screen (1)(2).
n Pick three points (1)(2).
n Edit the project plane’s parameters.

a. Click Edit Parameters. The 3D Plane Editing dialog opens.
b. Click on the pull down arrow.
c. Choose between Normal + Point and Point + Point.
d. If Normal + Point has been chosen, enter a direction in the Normal field and give a position in the Point field.
e. If Point + Point has been chosen, enter a position in each of the Point fields.
f. Click OK. The 3D Plane Editing dialog closes.

n Set the plane parallel to the screen view.
3. Enter a value in the Resolution field.
4. Click Preview.
5. Click Apply.

Applying the results after previewing them creates them in the database and closes the Edge Detection dialog. Note
that clicking Apply without previewing the results cancels the generated discontinuities and clicking Cancel opens
an information box which prompts you to cancel or confirm the action you attempt to do.

Note:
n For more information related to (1), see Step 2 of the Cutting Plane tool.
n When selecting (2), the Picking Parameters toolbar appears, it's up to you to do a free picking or a constrained pick-

ing.

7.10.2.2.6 Topography-Based Sampling
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The idea behind this method is to separate valid points from invalid points inside a given point cloud. Because invalid points
are more or less important according to where they are on the point cloud, you need to be able to work separately on them.
This kind of situation occurs when the point cloud is a scene presentation with threes, bushes and the like. In such a case,
invalid points are trees, bushes, etc. and valid points are the ground.

To sample based on topography(ies):
1. In the Sampling dialog, click the pull down arrow.
2. Select Topography-Based Sampling. The Topography-Based Sampling dialog appears.

1 - Show/hide invalid points
2 - Set valid points as reference cloud
3 - Resolution of the square-grid
method

4 - Point distance selection
5 - Delete invalid points from the reference
cloud

First, you should define a point cloud as reference. This means that this point cloud remains unchanged whatever
the operations you apply to it except when deleting points or when replacing it by a new one. You can reload it as
often as required. If the point cloud you select comes from another sampling method or results from a seg-
mentation, the Only Wanted button is active. This means that you can set this point cloud as a reference.
The Topography-Based Sampling method is based on a grid method and the resolution is square by default - the
same in both of the projection surface (XY plane of the active coordinate frame) directions. Points of the selected
cloud outside the square-grid tolerance will be not taken into account. And those nearby or far away from the
square-grid boundary can be gradually ignored using a slider.

3. Fence an area on the reference cloud using the Segmentation tool.
4. Enter a value in the Resolution field and press Enter.
5. Slide the cursor to a position between + and -.

The result from the square-grid projection and the distance selection is a set of invalid points (called Unwanted
Points). These points will be un-kept and shown in red in the 3D View - only if the Display Unwanted Points (Red)
option is checked.

6. Click Erase Unwanted. Invalid points will be deleted from the reference cloud.
7. Click Reload Reference Points . The reference cloud is reloaded with invalid points less.
8. Repeat the steps from 3 to 7 on another area of the reference cloud.
9. Click Create to save the result and click Close.

A sub-point cloud whose name is "By Topography" is created under the current project in the Models Tree. X is its order.

7.10.2.2.7 Ground Extraction

The Ground Extraction feature lets the user extract the ground information from an indoor (or outdoor) scan, whatever the
shape of the ground (flat or no flat surfaces).

It extracts a new point cloud region that includes only ground-level scan points, as determined based on the geometry of
the scene (not laser intensity). The extraction algorithm assumes that the ground is locally horizontal (normals are used if
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available) and locally flat (local planarity is computed). Since the algorithm adapts its parameters automatically according to
the density of the point cloud, no input parameters are required.

Note the following when using the feature:
n The ground-extraction algorithm is intended to extract the lowest ground surface in the scene. For example, in a

multi-story building, only the lowest floor would be extracted.
n The ground-extraction algorithm may produce unexpected results when applied to noisy data that includes parasite

points below the ground. Therefore, it is recommended that you manually eliminate these parasite points (by using
the Segmentation tool) before using the Ground Extraction feature.

To extract the ground information:
1. In the Sampling dialog, click the pull down arrow.
2. Select the Ground Extraction method from the drop-down list. The Ground Extraction dialog appears.
3. Click the Extract button.

After the extraction, all points that are on the ground, have their color unchanged and are called Ground points.
Those, that are not on the ground, are colored in red and are called Outlier points.
Note: The Show Outliers (Red) option is automatically chosen (checked) when applying the extraction.
Note: You are able to stop the extraction in progress by pressing Esc.

The number of points in the Remaining field is diminished from the amount of Outlier points.
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4. Do one of the following:
n Add some regions to the ground.
n Keep the ground.
n Remove the ground.

5. Click Create and Close.
A sub-point cloud whose name is "Ground Extraction" is created under the current project in the Models Tree. If the Keep
Ground option has been chosen, the sub-point cloud has "Ground" as layer (ID 2). If the Remove Ground option has been
chosen, the sub-point cloud has "Unclassified" as layer (ID 1) in case of several inputs (or the layer of the input if there is
one).

7.10.2.2.7.1 Add Some Regions to the Ground

This option enables you to add potentially missing parts to the extracted ground by simply picking points. This is useful
when the automatic extraction fails due to non-connected ground at different levels.

To add some regions to the ground:

1. Click the Pick Points button. The cursor has its shape changed to become . The Pick Points button changes Com-
pute.

2. Pick several points on the Outlier points.

3. Click the Compute button.

In the 3D View, each picked point is used as seed to define a ground region, which is added to the previously extrac-
ted ground.
In the Ground Extraction dialog, the Remaining number is diminished from the amount of points that correspond to
the added regions. The Initial number remains unchanged.

4. If required, repeat the steps for other regions.

Note: To leave the picking mode, you can press Esc., select Cancel Picking from the pop-up menu, or press on the Com-
pute button.
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Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be aware
that this also cancels the ground extraction previously performed.

7.10.2.2.7.2 Remove the Ground

To remove the ground:
n Click the Remove Ground button. In the 3D View, the Ground points are hidden. In the Ground Extraction dialog,

the number of Outlier points becomes the Initial points. The Keep Ground and Remove Ground buttons are
dimmed.

Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be
aware that this also cancels the ground extraction previously performed.

7.10.2.2.7.3 Keep the Ground

To keep the ground:
n Click the Keep Ground button. In the 3D View, the Outlier points are hidden. In the Ground Extraction dialog, the

Remaining points, which are also the Outlier points, become the Initial points. The Keep Ground and Remove
Ground buttons are dimmed.

Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be
aware that this also cancels the ground extraction previously performed.
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7.10.2.2.8 Floor Extraction (Indoor)

This feature lets the user extract the floor information from an indoor scan. The floors need to be flat or quasi-flat, which cor-
respond to man-made structures such as indoor floors, parking, street segments, etc. The feature can be used for extract-
ing multi-level floors. When used, it extracts first the lowest floor information, automatically and parameterless. If the user
desires to extract the other level information, he has to manually pick points.

Note: Concerning the Floor Extraction, from a technical point of view, the algorithm is based on the geometry of the scene.
In that sense, the result does not depend on the laser intensity. The algorithm uses the hypothesis that the floor is locally
horizontal (normals are used if available) and locally flat (local planarity is computed).

To extract the floor information:
1. In the Sampling dialog, click the pull down arrow.
2. Select the Floor Extraction (Indoor) method from the drop-down list. The Floor Extraction (Indoor) dialog appears.
3. Click the Extract button.

After the extraction, points on the floor have their color unchanged and are called Floor points.
Those, that are not on the floor, are colored in red and are called Outlier points.
Note: The Show Outliers (Red) option is automatically chosen (checked) when applying the extraction.
Note: You are able to stop the extraction in progress by pressing Esc.

The number of points in the Remaining field is diminished from the amount of Outlier points.
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4. Do one of the following:
n Add some regions to the floor.
n Keep the floor.
n Remove the floor.

5. Click Create and Close.
A sub-point cloud whose name is "Floor Extraction" is created under the current project in the Models Tree. If the Keep
Floor option has been chosen, the sub-point cloud has "Ground" as layer (ID 2). If the Remove Floor option has been
chosen, the sub-point cloud has "Unclassified" as layer (ID 1) in case of several inputs (or the layer of the input if there is
one).

7.10.2.2.8.1 Add Some Regions to the Floor

In case the floor has only one level, this option enables you to add potentially missing parts to the extracted floor. The miss-
ing parts can be due to the non-continuity of the floor or due to the fact that the floor is not really flat. In both cases, the auto-
matic method fails to extract the floor information. In case of multi-level floors, like in a building, the option enables the
extraction of the other levels.

To add some regions to the floor:

1. Click the Pick Points button. The cursor has its shape changed to become . The Pick Points button changes Com-
pute.

2. Pick several points on the Outlier points.

3. Click the Compute button.
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In the 3D View, each picked point is used as seed to define a floor region, which is added to the previously extracted
floor.
In the Floor Extraction dialog, the Remaining number is diminished from the amount of points that correspond to the
added regions. The Initial number remains unchanged.

4. If required, repeat the steps for other regions.

Note: To leave the picking mode, you can press Esc., select Cancel Picking from the pop-up menu, or press on the Com-
pute button.

Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be aware
that this also cancels the floor extraction previously performed.

7.10.2.2.8.2 Remove the Floor

To remove the floor:
n Click the Remove Floor button. In the 3D View, the Floor points are hidden. In the Floor Extraction dialog, the num-

ber of Outlier points becomes the Initial points. The Keep Floor and Remove Floor buttons are dimmed.

Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be
aware that this also cancels the floor extraction previously performed.

7.10.2.2.8.3 Keep the Floor
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To keep the floor:
n Click the Keep Floor button. In the 3D View, the Outlier points are hidden. In the Floor Extraction dialog, the Remain-

ing points, which are also the Outlier points, become the Initial points. The Keep Floor and Remove Floor buttons
are dimmed.

Caution: You can decide to cancel the operation by selecting Undo or clicking the Reload Reference Points . Be
aware that this also cancels the floor extraction previously performed.

7.10.3 Auto-Classify Outdoor

The Auto-Classify Outdoor tool allows you to significantly increase productivity when classifying point clouds. It uses
algorithms that automatically classify point clouds in five classes: Ground, Building, Poles and Signs, Electric Lines and
High Vegetation.

Caution: The classification process is carried out on disk over all 3D points. It may take time with huge datasets.
n OPEN THE TOOL: The input of the Auto-Classify Outdoor tool is mainly a cloud (or a set of clouds). Select Auto-

Classify Indoor in Edit > Cloud.
n CHOOSE A CLASS:

n Ground is a surface, flat or not, accessible by walking. It includes terrain, road, sidewalk, curbs and stairs. In the
case of multiple-floors, only the lowest one will be retrieved

n Buildings are generally facades and roofs. All the indoor points are considered as building as well.
n Poles and Signs are poles, lampposts, traffic lights, etc. higher than 2 meters and touching the ground.
n Electric Lines are line conductors (commonly multiples of three), suspended by towers or poles.

Note: The algorithm works mainly on power lines from distribution corridors or urban environments. It may not
work properly on other use cases such as Railway Electrification Systems.

n High Vegetation includes trees, bushes and other vegetation higher than 1 meter.
n Remaining is everything matching none of the aforementioned classes.

Note: You need to have at least a class checked in the dialog, except the Remaining one. Otherwise, the
Extraction button remains grayed-out.

n EXTRACT & CLASSIFY POINT CLOUD REGIONS:
The status of the extraction process is displayed at the bottom of the user interface. When the process is complete,
the Rendering option automatically switches to Color Coded Classification. The points cloud regions, for which the
extraction succeeded, are created and classified as follows:
n A unique cloud is created. It belongs to the Ground layer (ID 2).
n A cloud for each individual building is created. All reside on the Building layer (ID 6). A folder containing all the

Building clouds will be created.
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n A cloud for each individual pole is created. All reside on the Transmission Power layer (ID 15). A folder con-
taining all the Poles and Signs clouds will be created.

n A unique cloud is created. It belongs to the High vegetation layer (ID 5).
n A single cloud is created. It belongs to the Wire - Conductor layer (ID 14).
n A cloud containing everything that does not match aforementioned classes. This cloud is assigned to layer 1

(Unclassified).

n All the regions except the Remaining region display in the 3D View in the color defined for the region according
to the Classification Layers window, i.e. the Ground region is brown by default.

Note: You can undo the extraction process by pressing the Esc key. In the Classification Layers window,
the assigned layers remain active after an undo.

Tip: After the extraction, and if required, you can use the Segmentation tool to refine the result manually.
Please, refer to the Assign a Classification Layer to the Fenced Cloud topic for more information.

7.10.4 Auto-Classify Indoor

The Auto-Classify Indoor tool allows you to significantly increase productivity when classifying indoor point clouds from
buildings or complex industrial environments. It uses algorithms that automatically classify point clouds in five classes:
Floor, Grating Floor, Ceiling, and Walls.

This tool is intended to work on point clouds containing a single floor. In case of multiple floors, you must first manually sep-
arate each floor, e.g., using the Scan-Based Sampling.

Caution: The classification process is carried out on disk over all 3D points. It may take time with huge datasets.
n OPEN THE TOOL: The input of the Auto-Classify Indoor tool is mainly a cloud (or a set of clouds). Select Auto-Clas-

sify Indoor in Edit > Cloud.
n CHOOSE A CLASS:

n Floor is a manmade flat surface accessible by a walking person. In industrial environments, it is usually built in
concrete. In the case of multiple-floors, only the lowest one will be retrieved.

n Grated Floor is a manmade floor composed of a regularly spaced collection of essentially identical, parallel,
elongated elements. In an industrial environment, grated floors are typically metallic and prevent access through
an opening while permitting communication or ventilation.

n Ceiling is the upper interior surface of a room or other similar compartment. The algorithm only manages flat ceil-
ing. Both grating and concrete ceilings will be extracted by the algorithm.

n Walls are vertical structures that enclose a space as part of the building envelope. The algorithm is intended to
work only on vertical walls (flat or curved). Inclined walls are not managed by the algorithm.

n Remaining is everything matching none of the aforementioned classes.

Note: You need to have at least a class checked in the dialog, except the Remaining one. Otherwise, the
Extraction button remains grayed-out.

Trimble RealWorks User Guide | 171



EDIT

n EXTRACT AND CLASSIFY POINT CLOUD REGIONS:
The status of the extraction process is displayed at the bottom of the user interface. When the process is complete,
the Rendering option automatically switches to Color Coded Classification. The points cloud regions, for which the
extraction succeeded, are created and classified as follows:
n A unique cloud is created for Floor. It belongs to the Ground layer (ID 2).
n A unique cloud is created for Grated Floor. It belongs to the Ground layer (ID 2).
n A unique cloud is created for Walls. It belongs to the Building layer (ID 6).
n A single cloud is created for Ceiling. It belongs to the Ceiling layer (ID 66).
n A cloud containing everything that does not match aforementioned classes. This cloud is assigned to layer 1

(Unclassified).

n All the regions except the Remaining region display in the 3D View in the color defined for the region according
to the LAS standard, i.e. the Ground region is brown by default.

Note: You can undo the extraction process by pressing Esc. In the Classification Layers window, the
assigned layers remain active after an undo.

Tip: After the extraction, and if required, you can use the Segmentation tool to refine the result manually.
Please, refer to the Assign a Classification Layer to the Fenced Cloud topic for more information.

7.10.5 Auto-Classify Tunnel

The Auto-Classify Tunnel feature classifies automatically the input point cloud into separate clouds in distinct clas-
sification layers: Tunnel Envelop, Ground and Remaining.

n PREREQUISITES: A tunnel should:
- Be pre-segmented to remove everything outside.
- Be a pseudo-cylindrical horizontal object, and longer than wide.
- Be a closed envelope with a ground.
- Be big enough to contain people and / or vehicles.

It should not:
- Have unscanned areas. If there are some, consider to cut the tunnel into several pieces and process each piece
separately.
- Have several branches, with overlapping parts.

Note: The Auto-Classify Tunnel feature does not work with bridges, vertical silos or vertical tanks.
n TOOL ACTIVATION: Select a point cloud and choose Auto-Classify Tunnel in Edit > Cloud.
n OPTIONS: Choose an option:

- Tunnel Envelop.
- Remaining.
- Ground.

n EXTRACT & CLASSIFY: Click Extract. The Rendering option switches automatically to Color Coded
Classification. Point cloud regions, for which the extraction succeeded, are created and classified as follows:
- A cloud for the Tunnel Envelop. It is assigned to the Tunnel Envelop layer (ID 30).
- A cloud for the Ground. It is assigned to the Ground layer (ID 2).
- A cloud containing everything that does not match aforementioned classes. This cloud is assigned to layer ID 1.
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7.10.6 Merge Several Point Clouds into One

Merging a set of clouds consists of creating a new cloud from the selected clouds and deleting them at the same time. It is
important to note that you can only merge objects containing only the cloud representation. If one of the selected objects
contains a geometry representation, a warning will be issued to the user. If the user decides to continue, the geometric
shape of the selected object will be lost. You cannot merge the scans. The selected clouds for merging must belong to the
same project. When you select clouds from two different groups, the merged cloud will be put under the group which con-
tains the last selected cloud.

To merge several point clouds into one:
1. Select several clouds from the Project Tree.
2. Select Merge Clouds in Edit > Cloud.

n If the selected clouds share the same layer, a new cloud is then created with the name of Merge. It is put in the
same layer as the selected clouds.

n If the selected clouds do not share the same layer, a new cloud is also created but it is put in the "Unclassified"
layer.

Tip: You can also use the following short-cut key CTRL + M.

Tip: You can also select Merge Clouds from the pop-up menu.

7.10.7 Cloud Color

To change the color of a point cloud:
1. Select and display a point cloud from the Project Tree.
2. Do one of the following:

1. Select Cloud Color in Edit > Cloud.
2. Choose a color from the color palette.
3. Or define your own color by clicking Other.

Or
4. With the Property window open, click in the Cloud Color line.
5. Choose a color from the color palette.
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6. Or define your own color by clicking Other.

7.10.8 Delete Cloud

To delete a point cloud:
1. Select an object from the Project Tree.

2. Select Delete Cloud in Edit > Cloud.
n If the selected object is only a point cloud, a dialog opens and prompts you to continue or not.
n If the selected object has both properties (point cloud and geometry), its point cloud properties are deleted with

no warning.

Tips:
n You can also right-click on an object with both properties (cloud and geometry) in the Models Tree (or in the 3D

View) and select Delete Cloud from the pop-up menu.
n You can also use the combination of keys CTRL + D.

7.11 Geometry

In the Edit tab, the Geometry group looks as illustrated below, in the Production mode:
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In the Registration module, the Geometry group is also present but the Delete Geometry and Convert to Mesh features are
not present.

7.11.1 Delete Geometry

To delete a geometry:
1. Select an object from the ProjectTree.
2. Select Delete Geometry in Edit > Geometry.

n If the selected object has only geometric properties, a dialog opens and prompts you to continue or not.
n If the selected object has both properties (point cloud and geometry), its geometric properties are deleted with

no warning.

Tips:
n You can also right-click on an object with both properties (cloud and geometry) in the Models Tree (or in the 3D

View) and select Delete Geometry from the pop-up menu.
n You can also use the combination of keys CTRL + D.

7.11.2 Geometry Color

To change the color of a geometry:
1. Select and display a geometry from the Project Tree.
2. Set e.g. the Surface rendering option.
3. Do one of the following:

1. Select Geometry Color in Edit > Geometry.
2. Choose a color from the color palette.
3. Or define your own color by clicking Other.

Or
4. With the Property window open, click in the Geometry Colorline.
5. Choose a color from the color palette.

Trimble RealWorks User Guide | 175



EDIT

6. Or define your own color by clicking Other.

Caution: You cannot change the color of all types of geometry. There are some restrictions. An inspection map is also a
geometry. You cannot change its color.

7.12 Merge Coplanar Polylines

To merge coplanar polylines:
1. Select several polylines from the Project Tree.

2. Select Merge Coplanar Polylines from the pop-up menu.
n If the selected polylines are not coplanar, an error message appears and the operation is aborted.
n If the selected polylines are coplanar, the resulting, created with a default name, is:

n A polyline with a unique point chain where redundant points are removed, if the selected polylines have com-
mon ends.

n A polyline with as many point chains as there are polylines in the selection, if the selected polylines do not
have a common end.
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Tip: You can use the CTRL + J shortcut or choose Merge Coplanar Polylines in Drawing> Line Work.

Note: Fitted polylines cannot be merged.

7.13 Equalize Image Color

In the Station-Based mode, a scene is viewed from a station's point of view with overlapped images in the background (if
not hidden). Each image has brightness characteristics different from its neighbor. This tool allows the adjustment of the
brightness of the images and the blending of overlapping regions, if required.

To equalize image color:
1. Select a set of images (or a project with images inside).
2. Set the Station-Based mode (if required).

3. Select Equalize Image Color in Edit > Image.
n If the current project has some images which come from an instrument other than the Trimble SX10, a dialog

appears and asks to blend the overlap regions of the images after adjusting the brightness. Jump to Step C.
n If the current project comes from the import of a JXL format file, from the Trimble SX10 instrument, the Image

Type Selection dialog appears:

Note: All of the images of the project will be taken, i.e., those that are inside the stations as well as those that are
outside.
a. Select a type by checking the corresponding check box. The number of images of the chosen type is dis-

played.
b. Click OK. The Image Type Selection dialog closes, and a dialog appears and asks to blend the overlap

regions of the images after adjusting the brightness.
c. Click Yes. This will adjust the brightness of the images and will blend the overlapped regions.
d. Or click No. This will only adjust the brightness of the images.
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Note: You can select the three types at the same time.
Note: You are able to undo the operation, if required.

Note: You do not need to display (or open) the selected images to perform this operation. The selected images need to
belong to a station.
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Exploration in RealWorks involves the comprehension of a complex scene from a loaded project by using all available
information, whether it is a point cloud, a model, a set of images or a combination thereof. Exploration can be done via the
Project Tree in order to understand how a scene is structured. It can also be done by examining (Examiner mode) or by
walking through (Walkthrough mode) a scene displayed in the 3D View or by viewing a scene from the instrument positions
(Station-Based mode).

8.1 Expand and Shrink the Project Tree

You can explore the Project Tree in the WorkSpace window in order to determine how the data is structured. You can click
on the Expand (or Shrink ) icon located at the left side of each group of nodes to expand (or reduce) the Project Tree
until you reach the level that contains the information you want. You can also use the scroll bar to go up (or down) the Pro-
ject Tree. Exploration in this tree is similar to Microsoft Windows Explorer.

8.2 Locate an Object in the Project

You can locate an item in the Project Tree. Like the Find command, the name of the found item will be highlighted in the List
window and its properties will appear in the Property window if it is opened. The father of the found item becomes the Active
Group in the Project Tree.

To locate an object in the project:
1. Select an item from the 3D View.

2. Select Locate in Home > Search.
Or

3. Double-click on an item in the 3D View.

8.3 Find an Item in the Project

You can find an item (or a set of items) in the current project with the Find command. You can find by Name, with a com-
plete or partial name, or you can find by Type.

To find an item in the project:

1. Select Find in Home > Search. The Find dialog box opens.
2. In the Find Text field, enter a name/or a partial name.

Or / and
3. From the Type list, choose a type. The number and the type of objects in the Type list differ depending on the mod-

ule you are using.
4. In the Registration module, the Type list looks as illustrated below:

8
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5. In the OfficeSurvey - Modeling (or Production) module, the Type list looks as illustrated below:

6. Select one of the options below:
n Match Case: This option allows you to find an object with its name case-matched to what was entered in the

Find What field.
n Current Directory: This option gives the choice to the user to search in the current directory or in all directories.

7. Click Find. The found objects are displayed in the Find dialog.
n In the Find dialog, you can perform a multi-selection, by using the Ctrl (or Shift or Ctrl + A) key(s).
n All the objects, selected from the Find dialog, are listed in the Selection List window (if opened).

8. Click Close. The Find dialog closes.
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Tip: You can also right-click anywhere in the 3D View and select Find from the pop-up menu or use the short-cut key Ctrl +
F.

8.4 Explore in the 3D View

Data exploration in the 3D View consists mainly of using the navigation commands such as Rotate, Pan, Zoom, etc. to
examine the contents of displayed scenes/objects.

8.5 Explore in the Images Tree

As explained in the data organization chapter, the Images Tree contains only images which can be taken by an on-board
camera in a 3D scanner or come from any 2D cameras. You can browse a set of images; compare each of them with a 3D
scene in order to have a better perception and understanding, etc.

8.6 Display

The display of objects in the 3D View is like taking a photograph of a virtual scene with a camera. The steps may typically
be the ones given below and each will be discussed separately.

n You specify the rendering parameters for displaying objects.
n You choose camera characteristics; for example, the projection modes.
n You then select objects to display.
n Finally, you choose the point of view from which you want to shoot your photo. This is equivalent to choosing the

viewing camera's position and its aiming orientation.

All the options can be selected in View > Display.

8.6.1 Show & Hide Cloud

A point cloud is a set of 3D points. Each 3D point can contain not only its 3D coordinates, but also other attributes such as
Intensity and Surface Normal.

To display objects, you should first select them either from the WorkSpace window or the List window. Once objects are
selected, you have the following options to display them. If the selected objects are group nodes, you can either use the
command Show Cloud from the Display group. You can also use the drag-and-drop function to drop the selected objects in
the 3D View. If the selected objects are object nodes (or scan nodes), you can either use the same methods as above or dir-
ectly toggle the On or Off icon beside the name of these selected objects in the List window. It is important to note that if the
selected objects have both the cloud and the geometry representations, only the later one will be displayed when you use
this box.

To show a point cloud:
1. Select an object with cloud property from the Project Tree.

2. Select Show Cloud in View > Display.
You have two ways to check if a cloud is displayed (or not) in the 3D View. The first way is to use the Show Cloud
icon in the Display group. It becomes active when you select a cloud which is not displayed in the 3D View. It
becomes inactive when the selected cloud is already displayed. The second way is to use the List window. A dis-
played cloud is turned-on .

Notes:
n You can also right-click in the WorkSpace (or List) window to get the pop-up menu from which you can choose the

Show Cloud command.
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n If you select a group node and display it, all leaf nodes under this group node will be displayed. This avoids having
to display them one by one.

Tip: You can use the D shortcut key for displaying a cloud, previously hidden. The cloud should be initially selected in the
3D View.

Hiding an object with cloud property consists of removing its representation from the 3D View. For hiding an object, you
have to select it either from the WorkSpace window or the List window or directly from the 3D View. If the selected object is
a group node, you can either use the command Hide Cloud from the Display menu or its corresponding icon in the Display
toolbar. If the selected object is a scan node, you can either use the same methods as above or directly toggle the On or Off
icon beside the name of these selected objects in the List window.

To hide a point cloud:
1. Select an object with cloud property from the ProjectTree.

2. Select Hide Cloud in View > Display.

Note: You can also right-click on a cloud in the Project Tree (or in the 3D View) so as to display the pop-up menu and select
Hide Cloud.

Tip: You can use the H shortcut key for hiding a cloud, initially selected in the 3D View.

8.6.2 Show & Hide Geometry

To display objects, you should first select them either from the WorkSpace window or the List window. Once objects are
selected, you have the following options to display them. If the selected objects are group nodes, you can either use the
command Display Geometry from the Display group. You can also use the drag-and-drop function to drop the selected
objects in the 3D View. If the selected objects are object nodes (or scan nodes), you can either use the same methods as
above or directly toggle the On or Off icon beside the name of these selected objects in the List window. It is important to
note that if the selected objects have both the cloud and the geometry representations, only the later one will be displayed
when you use this box.

To show a geometry:
1. Select an object with geometric property from the Project Tree.

2. Select Show Geometry in View > Display.
You have two ways to check if a geometry is displayed or not in the 3D View. The first way is to use the Display Geo-
metry icon in the Display group. It becomes active when you select a geometry which is not displayed in the 3D
View and inactive when the geometry is displayed in the 3D view. The second way is to use the List window. A dis-
played geometry is turned-on .

Notes:
n You can also right-click in the WorkSpace (or List) window to get the pop-up menu from which you can choose the

Display Geometry command.
n If you select a group node and display it, all leaf nodes under this group node will be displayed. This avoids having

to display them one by one.

Hiding an object with geometric property consists of removing its representation from the 3D View. For hiding an object, you
have to select it either from the WorkSpace window or the List window or directly from the 3D View. If the selected object is
a group node, you can either use the command Hide Geometry from the Display menu or its corresponding icon in the Dis-
play toolbar. If the selected object is an object node, you can either use the same methods as above or directly toggle the
On or Off icon beside the name of these selected objects in the List window.

To hide a geometry:
1. Select an object with geometric property from the Project Tree.

2. Select Hide Geometry in View > Display .

Note: You can also right-click on an object with geometric property in the Project Tree (or in the 3D View) to display the
pop-up menu and select Hide Geometry.
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8.6.3 Hide all

This command enables to hide all displayed objects at once in the 3D View, no matter the objects.

To hide all:
n Select Hide All in View > Display.

Note: You can also right-click anywhere in the 3D View in order to display the pop-up menu and select Hide All.

8.6.4 View Only This

The View Only This feature enables to display and hide objects as follows: The selection is displayed, the other objects are
hidden, If the selection contains objects that are not displayed, the feature shows the hidden objects and hides the objects
that are not selected. If the selection contains objects that are partially displayed (geometry without cloud or vice versa), the
feature displays all objects in the selection, and hides the rest. To do this, you can use the command View Only This from
the Display menu or the corresponding icon in the Display toolbar. You can also evoke this command from the right-click
pop-up menu.

To view only this:
n Select View Only This in View > Display.

Note: This command is not available when selecting a project.

8.6.5 Display, Hide & Open Image

You can display an image in two ways either as a thumbnail in the 3D View or in a separated 2D window beside the 3D
View. In the first case, you can only display an image once at a time. You can use a tip to check if an image is displayed or
not; it consists of using the List window. An image when displayed has an On-bulb icon at its left side. In the second case,
you can open as many images as required and no tip is available.

Note: An image (selected from the Images Tree) has its thumbnail displayed in the Property window (if open).

Note: In the Ribbon layout, these features can be selected only from the pop-up menu.

To display an image:

Displaying an image consists of opening it as a thumbnail within the 3D View. You can only display one image at once
1. Select an image from the Images Tree.
2. Do one of the following:

n In the List window, toggle the On/Off icon beside the image name to On.
n Right-click on an image in the Images Tree and select Display Image from the pop-up menu.
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n Resize: Place the mouse cursor anywhere on the thumbnail image frame. Stretch or shrink the frame by drag-
ging.

n Change location: Place the mouse cursor over the Drag & Drop icon on the thumbnail image. Drag and drop
the thumbnail image to a suitable location in the 3D view.

n Zoom: Click in the thumbnail image and zoom it In or Out using the mouse wheel (if it exists).

To hide an image:

The command closes an image that is open as a thumbnail in the 3D View. You can only hide one image at once.
1. Select an image opened as a thumbnail.
2. Right-click on an image in the List window and select Hide Image from the pop-up menu.

Tips:
n Select an image from the List window and toggle the On/Off icon to Off.
n Move your cursor over the thumbnail image and click the Close icon.

To open an image:

Once an image is open in a separate window, you can zoom an area of this image In or Out using the Zoom In and Zoom
Out commands, zoom the whole image In or Out using the mouse wheel or by defining a zoom factor. If the image is
zoomed In more than the 2D window can display, you can pan it in any direction in order to view the hidden areas.

1. Select an image from the Images Tree.
2. Do one of the following:

n In the List window, double-click on its name.
n In the List window, right-click on its name and select Open Image from the pop-up menu.
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3. To close the image window, click on the Close icon on the border of its frame.

Note:You cannot perform a distance measurement on an image that is open in a separate window; the Measure icon is
dimmed.

8.6.6 Station

You can display the position, name and properties of a station (or of all stations) within a project. All the options related to
the station visualization are gathered in the Stations Makers group, on the View tab.

And in the Target-Based Registration group, on the Registration tab.

Tip: You can use a shortcut key to hide (or display) all station Positions and all station Labels. Both are detailed in the Short-
cut Keys section.

8.6.6.1 Display & Hide all Station Markers

You can display (or hide) all station markers, in one time, in the 3D View regardless of the navigation mode (Examiner,
Walkthrough or Station-Based) you are using.

To display all station markers:
n Select Show Stations in View > Station Markers. The Show Station Marker Labels and Station Maker List icons

become enabled. All station markers (shown as follows ) are displayed in the 3D View.
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Tip: You can also select Show Stations from the 3D View toolbar.

Tip: You can jump from one station to another by double-clicking on the station marker icon in the 3D View. The navigation
mode will be automatically switched to the Station Based navigation mode.

Note: If the Station Maker List window was open before choosing Show Station Markers, it will be open after.

To hide all station markers:
n Select Show Stations in View > Station Markers. The Show Station Marker Labels and Station Maker List icons

become dimmed. All station markers (shown as follows ) are removed from the 3D View.

Note: If the Station Maker List window was closed before choosing Show Station Markers, it will stay closed after.

8.6.6.2 Display & Hide all Station Marker Labels

For a given station, a label is its name in text displayed in the 3D View, next to its station marker.

To display all station marker labels:
n Select Show Station Marker Labels in View > Station Markers.

Note: You need to display all the station markers first.

To hide all station marker labels:
n Select Show Station Marker Labels in View > Station Markers.

8.6.6.3 Display & Hide Specific Station Makers

You can display (or hide) the position and the label of a specific station (or a set of stations) in the 3D View, regardless of
the navigation mode (Examiner, Walkthrough or Station-Based) you are using.
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To display specific station marker(s):
1. Select Show Stations in View > Station Markers. The Show Station Marker Labels icon and the Station Maker List

icon become enabled.
2. Select Station Maker List Window . The Station Maker List window opens.

n If required, use Select All to display all station positions.
n If required, use Expand All (or Expand ) to expand all groups (or a unique group) from the tree.
n If required, use Collapse All (or Collapse ) to collapse all groups (or a unique group) from the tree.
n Select a unique station from the tree.
n Or select several stations (from the tree) by using the Ctrl (or Shift) key combined with the left clicking.
n Check the station(s) for which you want to display the station marker(s).

Note: Displaying the station marker of a specific station also displays its label (if the label has been previously displayed).

To hide specific station marker(s):
1. Select Show Stations in View > Station Markers. The Show Station Marker Labels icon and the Station Maker List

icon become enabled.
2. Select Station Maker List . The Station Maker List window opens.

n By default, all stations (or groups) from the project are checked.
n If required, use Clear Selection to hide all station markers at once.
n If required, use Expand All (or Expand ) to expand all groups (or a unique group) from the tree.
n If required, use Collapse All (or Collapse ) to collapse all groups (or a unique group) from the tree.
n Select a unique station from the tree.
n Or select several stations (from the tree) by using the Ctrl (or Shift) key combined with the left clicking.
n Uncheck the station(s) for which you want to hide the station marker(s).

Note: Hiding the station maker of a specific station also hides its label (if the label has been previously displayed).

Note: The J and K shortcut keys, respectively for Show Station Makers and Show Station Maker Labels, cannot be used
with the Station Maker List window open.

8.6.6.4 Display & Hide the Network Visuals of a Station

The Network Visuals in the 3D View is similar to a set of vectors, each vector connecting the station marker of a station (or a
point on the ground (if that station has a height)) to a registration target (or to its point on the ground (if the target has a
height)).

Note: The user should be in the Registration processing mode.

To display the network visuals of a station:
1. First display the station markers of the stations.
2. In the 3D View, right-click on a 3D position.

3. Select Display/Hide Network Visuals (Selected Station) from the pop-menu.
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Or
4. In the Registration mode, select a single (or a set of) station(s) from the List window.
5. Right-click to display the pop-up menu.

6. Select Display/Hide Network Visuals (Selected Station) .
Or

7. In the Registration mode, select a single (or a set of) station(s) from the List window.

8. Select Display/Hide Network Visuals (Selected Station) in Registration > Target-Based Registration.

Note: For the steps from 4 to 6 and 7 to 8, you cannot view the network visuals if the station marker(s) of the station(s) is (or
are) not displayed.

To hide the network visuals of a station:
1. In the 3D View, right-click on the same station marker.

2. Select Display/Hide Network Visuals (Selected Station) from the pop-menu.
Or

3. In the Registration mode, select the same lonely (or set of) station(s) from the List window.
4. Right-click to display the pop-up menu.

5. Select Display/Hide Network Visuals (Selected Station) .
Or

6. In the Registration mode, select the same lonely (or a set of) station(s) from the List window.

7. Select Display/Hide Network Visuals (Selected Station) in Registration > Target-Based Registration.

Note: (*) You cannot get the pop-up menu when selecting a set of stations.

8.6.6.5 Display & Hide the Network Visuals of all Stations

This feature is similar to the Display/Hide Network Visuals (Selected Station) feature but it is applied to all stations of the pro-
ject. The user can be in any processing mode: Registration, or Production.

In the Production mode, both the station markers and the Network Visuals are shown.
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In the Registration mode, each station is shown by its station marker, its height (if existed), the registration targets that are
inside as well as their height (if existed).

Note: No station selection is required.

To display the network visuals of all stations:
1. In the Registration processing mode, first display all the station markers.
2. In the 3D View, right-click on a station marker.

3. Select Display/Hide Network Visuals (All Stations) from the pop-menu.
Or

4. In the Registration processing mode, select a single (or a set of) station(s) from the List window.
5. Right-click to display the pop-menu.
6. Select Display/Hide Network Visuals (All Stations) .

Or

7. Select Display/Hide Network Visuals (All Stations) in Registration > Target-Based Registration.

Note: For the steps from 4 to 6 and 7, you cannot view the network visuals if the station markers of the stations are not dis-
played.
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To hide the network visuals of all stations:
1. In the 3D View, right-click on any 3D position.
2. Select Display/Hide Network Visuals (All Stations) from the pop-menu.

Or
3. In the Registration mode, select any single (or set of) station(s) from the List window.
4. Right-click to display the pop-menu.
5. Select Display/Hide Network Visuals (All Stations) .

Or

6. Select Display/Hide Network Visuals (All Stations) in Registration > Target-Based Registration .

8.6.7 TZF Scan

A TZF Scan is 2D Map Data, linked to a TZF format file which can come from a TZS, Faro, and etc. format file conversion or
from a Trimble TX 3D Scanner. In the first case, there is only one TZF Scan per station. It is by default a Main Scan. In the
second case, a station can contain more than one TZF Scan and each can be either a Full Scan* or an Area Scan, with a
Mode (or Density) (Preview, Level 1, Level 2,Level 3 or Extended).

In a set of scans, if there is a unique Full Scan, this Full Scan is by default the Main Scan. If there are two Full Scans, the
highest in Density is by default the Main Scan. If these Full Scans are equal in Density, the last (acquired) is by default the
Main Scan.

Notes:
n (*) A Full Scan is a 360°x158° scan.
n (**) The Spacing parameter is the distance between two consecutive laser spots.
n The Extended range density is a feature that comes with an option upgrade of the Trimble TX8 3D Scanner.

When you open several TZF Scans directly in RealWorks, in a multi-scan situation, the priority to set a TZF Scan as a Main
Scan depends first on its Type (a Full Scan has a higher priority than an Area Scan) and then on its Density (Level 3 has the
higher priority and Extended the lower).

With a Trimble TX8 instrument, when scanning with the Extended ability, two scans, identical but different in terms of range,
will be acquired. The first scan will be a short range scan (from 0 to 120m) while the second scan is a long range one (from
120 to 340m). The time to acquire a short range scan is shorter than the time to acquire the long range one. The two TZF
format files will be created under the RWI folder. Now, with RealWorks 10, the two TZF format files will now be merged into
a single TZF format.

Note: Colored data acquired by a TX instrument, when loaded in RealWorks, are not displayed with the color information.
You need to first post-process the TZF files to be able to view the color information. The TCF format files, which store the
color and exposure information, are merged with the TZF files once the post-processing is complete. We advise the user to
make a copy of his original data sets before performing the post-processing, because it is not possible to go back.

To display a TZF Scan:

You can display a TZF Scan as a thumbnail within the 3D View. You can only display one TZF Scan at a time.
1. Right-click on a TZF Scan in the Scans Tree.
2. Select Display Image from the pop-up menu. Below are the operations you can perform on a displayed TZF Scan.

n Resize: Place the mouse cursor anywhere on the thumbnail frame. Stretch (or shrink) the frame by dragging.
n Change location: Place the mouse cursor over the Drag & Drop icon. Drag and drop the thumbnail image to a

suitable location in the 3D view.
n Zoom: Click in the thumbnail image and zoom in or out using the mouse wheel (if it exists). The thumbnail, once

zoomed in, can be moved in any direction.

Tip: You can toggle the bulb from to .

To hide a TZF Scan:

Hiding a TZF Scan consists of closing its thumbnail displayed within the 3D View.
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1. Right-click on a TZF Scan in the Scans Tree.
2. Select Hide Image from the pop-up menu.

Tip: You can toggle the bulb from to or click on the Close button.

To set a TZF Scan as a main scan:

You can set a TZF Scan as a Main Scan manually.
1. Right-click on a TZF Scan from the Scans Tree.
2. Select Set as Main Scan from the pop-up menu.

Notes:
n The Set as Main Scan feature remains dimmed when selecting a Main Scan.
n The icon of the selected TZF Scan changes from to .

To visualize the preview of a TZF Scan:

A TZF Scan, once selected as an input of a tool like the Target Analyzer, is displayed as a 2D Preview Image in a specific
window. You can zoom In or Out an area of the 2D Preview Image using the Zoom In and Zoom Out commands, zoom the
whole image In or Out using the mouse wheel or select a zoom factor from the drop-down list. If the image is zoomed In
more than the 2D Viewer can display, you can pan it in any direction in order to view the hidden areas.

To visualize extracted targets from a TZF Scan preview:

All Spherical Targets, Black andWhite FlatTargets or Point Targets extracted from a TZF Scan by using e.g. the Auto-
Extract Targets feature, once created, are displayed within the TZF Scan as illustrated below.

A Target selected from the List window is highlighted in the TZF Scan (once open) as shown below.
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8.6.8 Inspection Map

An inspection map results from the comparison between two surfaces (cloud/cloud, cloud/mesh, mesh/mesh and cloud (or
mesh)/primitive, etc.). An inspection map may have three shapes: Plane, Cylinder and Tunnel; this depends on the sur-
faces selected for comparison and the projection type applied to that comparison. Each inspection map has two directions
(Vertical and Horizontal) shown by its own red-and-green-axis frame and a color bar associated with it.

To view which shape has an inspection map, display its properties in the Property window and check for the Projection
Type (Planar for a plane, Tunnel for a tunnel and Cylinder for a cylinder).

If the loaded project contains an inspection map, you can display it in the 3D View or open it in an independent window.

Caution: An inspection map is of geometry type. You can delete it by selecting from the pop-up menu either Delete or
Delete Geometry.
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To open an inspection map:
1. Right-click on an inspection map in the Models Tree.
2. Select Open Inspection Map from the drop-down menu.

n The selected inspection map is open in a specific window, beside the 3D View. This window is called by the
name of the inspection map. The same window is called Map Preview when you are inside a comparison (or
inspection) tool.

n You can zoom the map In or Out. If it is bigger than the window can show, you can pan it in any direction.
n You can manage the ColorBar that is associated with the map, create a new one, etc. Refer to the ColorBars sec-

tion for more information.
To close an inspection map:

n Click on the Cross button at the top right corner of the window.

To display an inspection map in the 3D View:
n In the List window, toggle the bulb icon beside an inspection map to On to display it in the 3D View.

To hide an inspection map in the 3D View:
n In the List window, toggle the bulb icon beside an inspection map to Off to hide it in the 3D View.

8.6.9 Annotation

An annotation is a note and / or an image attached to a picked location. The options below enable to display an annotation's
position, label and content in the 3D View. Select an annotation from the Annotations Tree, and choose from the pop-up
menu:

n Show Pin to display the pin (location) of an annotation:
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Tip: Turn on (or turn off ) to display (or hide) the pin (location) of an annotation.

n Show Label to display the label (name) of an annotation.

- Displaying the label of an annotation displays both the pin and the label.

- Click in an annotation's label to hide the label.

n Show Full Content to expand the content (attached image) of an annotation.
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- Displaying the content of an annotation displays all (pin, label and content).
- Click in an annotation's label to expand the content.
- Change the content's color from Dark to Light from the Preferences / Viewer.

n Hide to hide all views (pin, label and content) of an annotation.

In the 3D View:
n Drag & drop the content of an annotation to a new location. A link appears between the pin and the content.

- Click in an annotation's label to restore the content position.
- Click in an annotation's label to hide the content only.
- Change the width of the link by increasing the Polyline Width value in the Preferences / Viewer.

n Double-click a pin (or a label) of an annotation to toggle to all views (pin, label and content).

Tip: The content of an annotation displays when you hover over the pin, expanding automatically its label or displaying the
tooltip.

For each annotation, you can:
n Change its name, color and attached comment in the Properties dialog.
n Copy and paste it at the same position as the initial annotation.
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n Cut and paste (or drag and drop) it in order to organize the annotations under groups.
n Delete it

If an annotation has an attached image, you can:
n Open the attached image in a specific viewer by selecting Open Image from the pop-up menu.
n Export the attached image in JPG format by selecting Export Image from the pop-up menu.

Notes:
- An annotation (pin, label and content) display in a created ortho-projection image, in low-resolution and high-resolution
snapshots of the 3D View, and in a created video.
- In the Cloud-Based Registration tool where the 3D View is split into three sub-views, the annotations do not display in the
side-by-side views but only in the third sub-view.
- An annotation created from a 3D inspection cloud has the 3D Inspection Distance value displayed in the Property window.

8.6.10 ColorBar

A ColorBar is a scale of values and each color corresponds to a range of elevation values. It is always linked to an inspec-
tion map (or 3D inspection cloud). You can create, edit, delete, rearrange, import or export a ColorBar inside a comparison
(or inspection) tool like the Twin Surface Inspection or outside a tool after opening an inspection map.

Note:Outside a comparison (or an inspection), only an inspection map can be opened in an independent window, while an
3D inspection cloud cannot.

8.6.10.1 Hide& Show a ColorBar

To hide & show a ColorBar:
1. If not opened, open an inspection map.

2. Click the Hide/Show ColorBar icon to hide the current color bar.
3. Click again Hide/Show ColorBar to display the current color bar.

8.6.10.2 Edit a ColorBar

The Edit ColorBar feature enables to create (edit, import, delete, customize and export) a ColorBar.

To edit a ColorBar:

1. Click the Edit ColorBar icon. The ColorBar dialog opens.
2. Do one of the following:

n Create a new ColorBar.
n Edit a ColorBar.
n Import a ColorBar.
n Switch to a ColorBar.
n Delete a ColorBar.
n Export a ColorBar.
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3. Click OK. The ColorBar closes.

Note: First open an inspection map in an independent window, if not already done.

8.6.10.2.1 Create a ColorBar

You can create as many ColorBars as required. Only one can be associated with an inspection map (or a 3D inspection
cloud) at once. By default, a ColorBar is automatically created after an inspection. When you save your project, all the cre-
ated Color Bar(s) are saved automatically. A ColorBar has no representation in the Project Tree. To view it, open the
related inspection map (or 3D inspection cloud).

To create a ColorBar:
1. Enter a new name in the Name field, or use the default one.
2. Choose a type.

n
Signed ColorBar: A ColorBar showing negative and positive distance values. Positive distance values stand

for points above the Reference, and negative distance values for points below the Reference.
n

Unsigned ColorBar: A ColorBar showing all distance values as absolute values (all positive).

n
Luminance ColorBar: A ColorBar showing positive / negative values in two colors; the color intensity show-

ing the distance amplitude.
3. Do one of the following:

n Color Level Step enables you to define a color level length (1). The number of levels is adjusted based on the
maximum and minimum values of the current inspection map.

n Number of Color Levels enables you to define the number of color levels (2). The color length value is adjusted
based on the maximum and minimum values of the current inspection map.

4. Or choose an existing ColorBar.
5. Or import an existing ColorBar (see Import a ColorBar).
6. To customize the ColorBar, do one of the following:

n Before selecting an edition mode, the central cursor (1) is exactly at the center of the ColorBar and the Edit
Value field is empty.
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n Position Mid Cursor to Define Range to Modify: Move the central cursor to snap it to a color level (1). Optionally,
define a position for the end cursor(s) (2) or (3).

n Edit Range by Moving Mid Cursor: Set the central cursor to a position to scale the color levels' length (1) while
keeping the number color levels' number unchanged (2). Optionally, define a position for the end cursor(s) (3) or
(4).

n Instead of setting a slider to a position, select it and input a value in the Edit Value field.
7. Optionally, access the ColorBar Advanced Edition mode (see ColorBar Advanced Options).
8. Do one of the following.

n Click OK to create the ColorBar and close the dialog.
n Click Cancel to abort and close the dialog.
n Export the ColorBar (see Export a ColorBar).

Note: If two ColorBars have the same name; the second (according to the order of creation) is renamed with an increment
number between brackets.

Tip: To create a ColorBar based on an existing one; click the Existing ColorBar pull-down arrow in the ColorBar Editing dia-
log and select one from the drop-down list.

8.6.10.2.2 Edit a ColorBar

To edit a ColorBar:
1. Choose an existing ColorBar from the drop-down list.
2. Or import an existing ColorBar (see Import a ColorBar).
3. To customize the ColorBar to create, do one of the following:

n Before selecting an edition mode, the central cursor (1) is exactly at the center of the ColorBar and the Edit
Value field is empty.

n Level Mode: Move the central cursor to snap it to a color level (1). Optionally, define a position for the end cursor
(s) (2) or (3).
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n Scale Mode: Set the central cursor to a position to scale the color levels' length (1) while keeping the number
color levels' number unchanged (2). Optionally, define a position for the end cursor(s) (3) or (4).

n Instead of setting a slider to a position, select it and input a value in the Edit Value field.
4. Optionally, access the ColorBar Advanced Edition mode (see ColorBar Advanced Options).
5. Do one of the following.

n Click OK to update the ColorBar and close the dialog.
n Click Cancel to abort and close the dialog.
n Export the ColorBar (see Export a ColorBar).

8.6.10.2.3 Import a ColorBar

Use any TXT editor (WordPad for example) to create a ColorBar file and import it into your project. This file should contain a
series of RGB (Red Green Blue) and interval value pairs. The ColorBar once imported is automatically applied to the
opened (selected) inspection map (or 3D inspection cloud).

To import a colorBar:
1. Click Import. The Import ColorBar dialog opens.
2. Find a location in your disk where the ColorBar file is stored in the Look In field.
3. Click the ColorBar file name to select it.
4. Click Open. The Import ColorBar closes.
5. Click OK. The ColorBar dialog closes.

8.6.10.2.4 Delete a ColorBar

The Delete feature is available only if there is another ColorBar other than the default one.

To delete a ColorBar:
1. Check the Existing ColorBar option.
2. Select a ColorBar from the drop-down list.
3. Click Delete. If there are several ColorBars, the one that comes after becomes the active ColorBar.
4. Click OK. The ColorBar dialog closes.

Tip: No need to check the Existing ColorBar option. Clicking Delete selects the option and deletes the current ColorBar.

Note: You cannot delete a ColorBar from an inspection map or from an 3D cloud inspection.

8.6.10.2.5 Switch to a ColorBar

To switch to an existing ColorBar:
1. Check the Existing ColorBar option.
2. Choose a ColorBar from the drop-down list.
3. Click OK. The ColorBar dialog closes.

n The inspection map is now displayed according to the chosen ColorBar.
n You can come back to the default ColorBar rendering by clicking Switch to Default ColorBar.

8.6.10.2.6 ColorBar Advanced Options

The Advanced Options feature enables you to edit a ColorBar other than the default one by defining its intervals or by
choosing a color for each level.

To edit with advanced options:
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1. Click the Edit ColorBar icon. The ColorBar dialog opens.
2. Click Advanced Edition. The ColorBar Advanced Edition dialog opens.

n The Interval values in the Step - 1 field belong to the default ColorBar (or to one that has been chosen from the
Existing ColorBar list).

n The color of each Level is the level color of the default ColorBar (or of one that has been chosen from the Exist-
ing ColorBar list).

3. Do one of the following:
n Define intervals.
n Define level colors.

4. Click Save.

8.6.10.2.6.1 Define Intervals

Define either Regular Intervals or Irregular Steps.

To define the intervals:
1. In Step 1, delete all values in the field.
2. Enter several values in the field.
3. Press Enter to validate.

n The input values must be ranked from negative to positive, from lower to higher.
n Each value must be separated by a semicolon, a comma, etc.
n The number of levels is then updated according to the input values.
n All of the levels are also updated in Step 2.

8.6.10.2.6.2 Define Level Colors

To define a level color:
1. In Step 2, click on a pull-down arrow next to a level. A Color palette appears.
2. Choose an existing color from the palette.
3. Or click Other to define your own color.
4. Click Ok. The ColorBar palette closes.

8.6.10.2.7 Export a ColorBar

The Export feature is available only if there is another ColorBar other than the default one. A ColorBar, when exported, is a
TXT format file. This file, when opened, contains a series of RGB (Red Green Blue) and interval value pairs.

To export an existing ColorBar:
1. Click Export. The Export ColorBar dialog box opens.
2. Enter a name in the File Name field.
3. Find a location in your disk in the Look In field.
4. Click Save. The Export ColorBar dialog box closes.

8.6.10.3 Switch to the Cut/Fill ColorBar

The Switch to Cut/Fill ColorBar feature enables to display an inspection map with only two levels of information. All neg-
ative parts (of an inspection map) are rendered in blue and all positive parts are in red.
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An inspection map displayed with the default ColorBar

An inspection map displayed with the Sign-Based ColorBar

You can come back to the default ColorBar rendering by clicking Switch to Default ColorBar.

Note: First open an inspection map in an independent window, if not already done.

8.6.10.4 Switch to the Default ColorBar

The Switch to Default ColorBar feature lets you display an inspection map, with the default ColorBar which is the one that
comes with the inspection map after it has been created.

8.6.11 Display & Hide the Alignment Stationing

A polyline, for which an alignment stationing has been applied, has two distinguished properties: Geometry and Alignment
Stationing.

To display the alignment stationing:
1. From the Project Tree, select a polyline with an alignment stationing.
2. If its geometry is not yet displayed, display it by selecting Display Geometry from the pop-up menu.
3. And then select again Display Alignment Stationing from the pop-up menu.

To hide the alignment stationing:
1. From the Project Tree, select a polyline for which the stations are displayed.
2. Right-click on the polyline and select Display Alignment Stationing from the pop-up menu.

8.7 Render the Data
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A Rendering defines how an object is going to be displayed. For example, a geometry can be displayed in Wireframe or
shaded surface. We introduce the different options available for different object representations. A rendering will be applied
to all objects of the same type displayed in the 3D View. This means that you cannot specify different renderings for dif-
ferent displayed objects of the same type. For example, you cannot display a Geometry Object A in Wire-Frame, and the
Geometry Object B in Surface.

All the options related to the rendering are gathered in two places, in the Rendering group on the View tab and on the ver-
tical toolbar.

8.7.1 Render a Point Cloud

There are several rendering options that you can apply to a displayed point cloud. TheWhite Color option enables to render
all the displayed points with white color. The Cloud Color option enables you to render all the displayed points with the color
of the clouds they belong to. The Station Color option enables you to render all the displayed points with the color of the sta-
tions they belong to. The Grey Scaled Intensity option enables you to render all the displayed points using the gray scale
defined by their intensity. The True Color option enables you to render the displayed points using their color. The Color
Coded Elevation option enables you to render a point cloud with the height information encoded in the point color. The
Color-Coded Classification option applies a rendering to the displayed point clouds based on the colors of the classification
layers the displayed point clouds belong to.

To render a point cloud:
1. Select an object with cloud property from the Project Tree and display it.
2. In the Rendering group, click the Cloud Rendering pull-down arrow.
3. Select a rendering from the drop-down sub-menu.

For point clouds, you can combine the Normal Shading rendering with any of the renderings named above (except
for Point Size and Discontinuity Display) in order to have a relief (or depth) display. In (A), the White Color rendering
is applied to the point cloud in selection. The Normal Shading information is added to the White Color rendering in
(B) and to the True Color rendering in (C). When such a combination is applied, you can use the Lighting Direction
tool to modify the light source position. Note that such a combination reduces by half the time required to display
points.
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Tip: You can right-click anywhere in the 3D View (except on a displayed object) and select Rendering from the pop-up
menu. A sub-menu drops down. Select then a rendering option.

Tip: You can use a set of shortcut keys to swap from a Rendering option to another. All are detailed in the Shortcut Keys
section.

Note: You are able to customize the brightness and the contrast of points by using the Cloud Rendering Settings feature.

8.7.1.1 Color a Point Cloud Based on the Classification Information

The Color Coded Classification rendering can be used to apply a rendering to the objects of point cloud type, which are dis-
played in the 3D View. This rendering is based on the colors of the layers to which the displayed objects belong to.
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Note: The Color Coded Classification rendering is only available in the Production) mode. When you switch from e.g. Pro-
duction to Registration, the Color Coded Classification feature becomes dimmed.

Caution: The Color Coded Classification rendering is not available when exporting point clouds to the DXF format.

8.7.1.2 Color Point Clouds Based on by the Elevation Information

This feature enables you to render a point cloud with the height information encoded in the point color. This helps to visu-
alize instantaneously the height of points in the scene. This feature is useful to highlight e.g. in a building each floor sep-
arately, repeating the color bar at each level.

To color point clouds based on the elevation information:
1. Display a point cloud in the 3D View.
2. If required, bring the view to Front (Z-Axis up).
3. If required, open the Measurement tool and choose Point Measurement.
4. If required, measure the position of a point by picking it. This point will be the Rendering by Elevation Origin.
5. If required, measure the position of another point by picking it.
6. Measure the difference along the Z-Axis between the two picked points. This gap will be the Rendering by Elevation

Interval.
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Tip: For the steps from 3 to 6, you can also use the Distance Measurement Along Vertical Axis feature.
7. In the Rendering group, click the Cloud Rendering pull-down arrow.
8. Choose the Color Coded Elevation option from the drop-down list.
9. Click the Cloud Rendering Settings icon. The Cloud Rendering Settings dialog opens.
10. Input the Z coordinate of the first picked point in the Origin field.
11. Input the gap value along the Z-Axis between the two picked points in the Interval field.

Note: You can input a negative value as a Rendering Elevation Origin.
Note: The default value for the Interval is 10m.
Tip: You can get the Origin value by picking it with .

12. Click the OK button. The Cloud Rendering Settings dialog closes.

A color bar for a level

Caution: This feature does not require any selection. It is applied to all objects, mainly point clouds, displayed in the 3D
View.

Note: The current active frame determines the elevation direction. If required, use the USC tool to change the elevation dir-
ection.
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Tip: You can apply the Gray-Scale Intensity With Color rendering to a point cloud that is displayed with the Color Coded by
Elevation rendering.

Tip: You can use the shortcut key 8.

8.7.2 Define Settings for Cloud Rendering

This feature enables you to adjust the brightness and the contrast of points in a point cloud. It is useful in case a point cloud
has been acquired with e.g. an insufficient dynamic (low contrast or not enough bright). The adjustment is applied to the
point cloud displayed in the 3D View. It does not affect the raw information in the data file. In addition to the above feature,
you can blend the Luminance information with the RGB information (Blending (True Color) option).

The feature adjusts the brightness and the contrast of point color when the point cloud is displayed with the True Color ren-
dering and when the RGB information is available.

To define settings for cloud rendering:
1. First, display a point cloud in the 3D View.

2. Select Cloud Rendering Settings in View > Rendering. The Cloud Rendering Settings dialog opens.

n By default, the Contrast and Brightness sliders are at halfway.
n The Blending (True Color) slider is at the right end (True Color).
n All the parameters, once adjusted, become persistent. They remain unchanged until you reset them by clicking

the Default button.
n The True Color panel is enabled only if the True Color rendering has been chosen.
n The Rendering by Elevation panel is enabled only if the Color Coded Elevation rendering has been chosen.

Refer to the Color a Point Cloud Based on by Elevation the Information topic for more information.

8.7.2.1 Adjust the Intensity Contrast and Brightness

You can manually adjust the contrast and brightness on the intensity of points. This adjustment is done by modifying the
intensity values during the display of the data. The raw information in the data file is not modified.

To adjust the intensity contrast and brightness:
1. In the Rendering group, click the CloudRendering pull-down arrow. A submenu drops down.
2. Select a rendering mode from the drop-down list.

n If Cloud Color, Station Color, Scan Color and Color Coded Elevation has been chosen, you need to apply the
Gray-Scale Intensity With Color rendering too.
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n If Gray-Scaled Intensity or Color Coded Intensity has been chosen, the Gray-Scale Intensity With Color ren-
dering is not required.

n If True Color has been chosen, the adjustment will have any effect. You have to first blend the intensity and color
information.

3. In the Cloud Rendering Settings dialog, move the Contrast (or Brightness) slider.
4. Click OK. The Cloud Rendering Settings dialog closes.

8.7.2.2 Blend the Intensity and Color Information
With a point cloud rendered with the True Color mode, you can blend the Intensity information with the Color information,
thanks to a slider. By default, the cursor is at the right end (True Color). You need to first choose the True Color rendering.
Otherwise, the Blending (True Color) option remains grayed-out.

The cursor at the True Color end:

The point cloud is displayed with only the Color information.

The cursor at halfway between Intensity and True Color:

The point cloud is displayed with both the Intensity and Color information. You can adjust the Contrast and Brightness para-
meters as described in the previous topic.

The cursor at the Intensity end:

The point cloud is displayed with only the Intensity information.
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8.7.2.3 Define the Rendering by Elevation Interval

The Interval parameter defines the height of a color chart when applying the Color Coded by Elevation rendering to a dis-
played point cloud. The default value is 10 meters.

8.7.2.4 Define the Rendering by Elevation Origin

The Origin parameter defines the starting point of a color chart relative to the world coordinate system when applying the
Color Coded Elevation rendering to a displayed point cloud.

8.7.3 Render Point Clouds With Gray-Scale Intensity With Color

This feature lets the user add the intensity information on point clouds* which are displayed in the 3D View, only when one
of the following renderings, Cloud Color, Station Color or Scan Color, has been applied.

To render point clouds with gray-scale intensity with color:
1. Select an object with cloud property from the ProjectTree and display it.
2. In the Rendering group, click the Intensity-Based Blending icon.

Or
3. Right anywhere in the 3D View to display the pop-up menu.
4. Select Rendering / Intensity-Based Blending from the pop-up menu.

Point clouds with the Intensity-Based Blending feature applied.
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Point clouds with the Intensity-Based Blending feature not applied.

Tip: You can use the B shortcut key.

Note: The Intensity-Based Blending feature, once applied, becomes persistent. It remains in this state until you ask it to
change.

Notes:
n (*) Except for 2D slices created within the Cutting Plane, Contouring, Profile/Cross-Section.
n (*) Except also for inspection clouds displayed with its inspected color (Cloud Color rendering) and working cloud

created with the Tank Calibration.

8.7.4 Choose a Point Cloud Shading
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The Point Shading group contains modes intended to highlight details, depending on the data content. Applied to all point
clouds displayed in the 3D View, these modes enable you to understand the scanned environment whatever the data type,
i.e., whether the scan has laser intensity or not, color or not, surface normals or not, viewing an indoor dataset from the out-
side or from the inside, viewing an outdoor dataset, etc.

NO SHADING:

This rendering mode is the default mode. Points are displayed without lighting effect.

AMBIENT SHADING:

This rendering mode shows how exposed each point in a scene is to the ambient lighting. This mode’s best use case is
when neither color nor normal information is available.

This mode shades each point relative to the amount of ambient lighting it receives. This shading reveals the details. Since it
applies on all datasets - it doesn't require normal information or intensity or color - this is the recommended mode for most
situations, combined with your favorite color and visibility options. Please note that some point clouds may look too dark
when the Intensity-Based Blending is on (press B to remove it or put it back, see the Render Point Clouds With Gray-Scale
Intensity With Color section).

ENHANCED AMBIENT SHADING:

This mode is an improved mode of the existing Ambient Shading mode. It shades each point relative to the amount of ambi-
ent lighting it receives and applies a pixel anti-aliasing. When used combined with your favorite color and visibility options,
this mode will give you the best visual results. Depending on the graphics card, it may slightly impact the frame rate, and so
the existing Ambient Shading mode may still be preferred in some situations.

NORMAL SHADING:

This rendering mode shades each displayed point by using its normal information.

8.7.5 Choose a Point Cloud Visibility

The Point Visibility group contains some filters to let you display only what you would like to see.

NO FILTERS:

The filter is the default setting. All points are shown without visibility filtering.
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HIDE BACKGROUND:

The navigation inside an indoor scene, composed of 3D points, may make the interpretation of the scene more or less dif-
ficult depending on the density of the point cloud. You may see the objects behind some others. This filter hides the 3D
points that are occluded by the foreground objects. It is especially useful in indoor scenarios when navigating in the Station-
Based (or WalkThrough) mode.

To hide the background:
1. If required, display objects in the 3D View.
2. In the Rendering group, click the Hide Background icon.

Caution: The Hide Background rendering cannot be used within the Tank Grid Definition sub-tool, of the Vertical Tank
Inspection tool.
Caution: The Hide Background rendering cannot be used with the Hidden lines rendering for geometry. Selecting the Hide
Background rendering disables automatically the Hidden Lines option.

SEE INSIDE:
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This filter is ideal for looking at the interior of a building that has been scanned from the inside, from a viewpoint located out-
side. In this situation, if you use the Normal Shading, the scan points on the walls look black. The See Inside mode simply
hides these points, so that you can see what is behind, inside the building.

OUTLINE:

This filter is ideal for Keyplan-like visualization, e.g., for checking the registration on walls by hiding the points whose nor-
mal faces the screen (towards or backwards).

This is a scanned scene, viewed from Top, with no filtering.
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The same scene, viewed from Top, with the Outline and Normal Shading renderings applied.

8.7.6 Display the Discontinuity of Points

The Discontinuity Display option displays points with edge highlighted (where available).

8.7.7 Change the Size of Displayed Points

The Point Size option changes the size of points when displaying a point cloud in the 3D View from 1 Pixel to 5 Pixels.

8.7.8 Render a Geometry

There are five renderings applicable to a geometry displayed in the 3D View. TheWireframe option renders a selected geo-
metry in wire-frame. The Hidden Lines option renders a selected geometry in wire-frame with hidden lines removed. The
Solid option renders a selected geometry as a smooth shaded surface. The Solid - Classification option displays the
objects, of geometry type, displayed in the 3D View with the colors of the layers they belong to. The Textured option
renders a selected geometry as a texture mapped surface if such a mapping exists.

To render a geometry:
1. Select a geometry from the Project Tree and display it.
2. In the Rendering group, click the Geometry Rendering pull-down arrow.
3. Select a rendering from the drop-down sub-menu.

Tip: You can right-click anywhere in the 3D View (except on a displayed object) and select Rendering from the pop-up
menu. A sub-menu drops down. Select then a rendering option.
Note: In RealWorks 10.2, the Normal Shading rendering, when applied to a mesh displayed in the Surface mode, adds a
smooth rendering (one color per triangle with gradient effect). In RealWorks 10.3, the Normal Shading rendering produces
no effect. To have the same smooth rendering, please use the Mesh Smooth option.

8.7.8.1 Color Geometries Based on the Classification Information

The Solid - Classification rendering can be used to apply a rendering to the objects, of geometry type, which are displayed
in the 3D View. This rendering is based on the colors of the layers to which the displayed objects belong to.
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Note: The Solid - Classification rendering is only available in the Production mode. When you switch e.g. from Production
to Registration, the Solid - Classification feature becomes dimmed.

Caution: There are some objects for which the Solid - Classification rendering has no effect when it is chosen like e.g. an
Inspection Map, a Measurement, a Frame, a Volume, a Polyline, etc.

8.7.8.2 Display Edges of Models
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The Geometry Outline rendering option enables to display the edges of all displayed models in the 3D View (except
meshes). It has to be used with the Solid rendering, and can be activated by the O key or by choosing the Geometry Outline
icon in the Rendering group on the View tab.

8.7.9 Apply a Smooth Rendering to Meshes

Amesh displayed in the Solid rendering mode, has a flat rendering (one color per triangle with no gradient effect).

The Smooth Meshes option displays the surface meshes with a smooth rendering (one color per triangle with gradient
effect).

Trimble RealWorks User Guide | 215



EXPLORE

8.7.10 Add a Lighting Direction

The Lighting Direction feature lets you produce an infinity of lighting effects on complex objects. You can change the spot-
light’s direction or use pre-defined light effects - five are available. Note that lighting effect modifications will be applied to
the current (active) 3D View.

To add a lighting direction:
1. If required, display objects in the 3D View.

2. Select Lighting Direction in View > Rendering. The Lighting Direction dialog opens.
3. Do one of the following:

n Change the spotlight’s direction at will.
a. Place the mouse cursor over the handle.
b. Drag the handle. The spotlight direction changes and the handle color switches from grey to yellow.
c. Drop the handle when you have the desired light effect. The handle returns again to its previous color.
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n Change the spotlight’s direction using predefined light effects.
n Click  to light from the top left position.
n Click  to light from the down right position.
n Click  to light from the top right position.
n Click  to light from the down left position.
n Click  to return to the default position.

Caution: This feature does only apply a lighting effect to a geometry.

8.7.11 Adaptive Point Size
The Adaptive Point Size feature applies a rendering that increases point size according to two factors: the distance to the
camera and the camera zoom. The result is that holes on nearest clouds appeared filled, making the display quality of a 3D
scene greatly enhanced and the 3D scene more understandable.

This feature can be used only when the 3D scene displayed is in the Perspective projection mode. It can be combined with
any point cloud rendering options and point size display.In this case, point size sets the minimum point size and
increases the size factor to apply on nearest points.

Point cloud displayed with "No Shading"

Point cloud displayed with the "Enhanced Ambient Shading" and "Adaptive Point Size"

8.7.12 Cloud Transparency

The Cloud Transparency feature enables you to visualize geometries without needing to hide the point cloud that is in front
of.
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n Select Cloud Transparency in View > Rendering.

- A plain geometry behind and close to a point cloud has its colors blended with the colors of the point cloud. The
blending can be adjusted manually (see Cloud and Geometry Blending Settings).
- A plain geometry behind and far from a point cloud is hidden by any points with better z values.
- A geometry in front of a point cloud remains displayed as usual.
- A geometry which is not plain, like e.g. a 2D-segment, a polyline, remains displayed as it is.

n Select Cloud and Geometry Blending Settings in View > Rendering.

- Slide the cursor to set a transparency to the point cloud, from Transparent (0) to Opaque (100), with intermediate
steps (12, 25, 37, 50, and 75).
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8.7.13 Ortho-Image Transparency

The Ortho-Image Transparency feature enables you to add a transparency to all Ortho-Image pixels.
1. Select Ortho-Image Transparency in View > Rendering.
2. Select Ortho-Image Transparency Settings in View > Rendering.

3. Slide the cursor to set a transparency to the Ortho-Image, from Transparent (0) to Opaque (100), with intermediate
steps (12, 25, 37, 50, and 75).
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8.8 Filter the Data

The Limit Box Mode lets you create small sections for evaluating the registration results, drawing polylines or just getting a
clearer view of a specific area. This mode can be used outside or inside a tool. In both cases, it is purely a visualization
mode. In the last case (inside a tool), you have to keep in mind that the working cloud is not the cloud inside the limit box but
the cloud from the selection (that is required to enter the mode). If you want the working cloud to be the cloud inside the limit
box, you can select the Box Selection from the Segmentation tool.

Tip: In RealWorks Viewer, there is no menu entry nor shortcut (F4) for the Limit Box Mode feature. If there is a limit box pre-
viously stored in the project, you can load it. If there is no limit box, you can import one even from a non-related project. A
limit box, once loaded, can be edited, deleted and exported. Once the project is closed, all limit boxes which have been
modified within that Viewer session will be lost (apart from the exported ones).

8.8.1 Launch the Limit Box Mode

To launch the limit box mode:

1. Select Limit Box Mode in View > Limit Box. The cursor becomes as follows .
2. Or use the F4 shortcut key instead.

The Limit Box Mode toolbar opens as well as the Picking Parameters toolbar.
If an object has been selected (as input in this mode) and displayed in the 3D View; the object remains selected with
its bounding box.

Trimble RealWorks User Guide | 220



EXPLORE

1 - Show/Hide Clouds and Geometries Outside the
Limit Box
2 - Show Limit Box

3 - Select Limit Box Center Pos-
ition
4 - Change Limit Box Center Pos-
ition
5 - Limit Boxes

To leave the Limit Box Mode, first define a position by picking a point on the displayed objects (or select Close
Center On Point from the pop-up menu, or press Esc.) and then choose F4 or Limit Box Mode in View > Limit Box.

Note: No selection is required to activate the Limit Box Mode. It is based on what is displayed in the 3D View.

8.8.2 Define the Center Point of a Limit Box

To define the center point of a limit box:
n Pick a point on the displayed clouds and/or geometries*.

n The Modify Shape, Pan, Rotate and Canonical Views icons become enabled as well as the Store the Current
Limit Box icon.

n The Show Limit Box and Modify Shape icons become enabled and selected.

1 - Modify Shape
2 - Pan

3 - Rotate
4 - Canonical Views
5 - Store the current Limit Box

n A limit box is displayed centered on the picked point which is set to the center of the screen.
n The manipulator which appears with the limit box depends on the feature that has been last used, i.e., among

Modify Shape, Pan and Rotate.
n If an object has been selected (as input of the tool) and displayed in the 3D View; the object remains selected

with its Bounding Box.
Note: (*) To leave the picking mode, select Close Center on Point from the pop-up menu.

8.8.3 Edit the Properties of the Limit Box

A limit box is a three-dimensional figure with six square faces. It is used to isolate a region on clouds and/or geometries.

8.8.3.1 Select the Center Point of a Limit Box

To select the center point of a limit box:

1. Click the Select Limit Box Center Point icon. The cursor changes to show the following .
2. Pick a point on displayed clouds and/or geometries.

n The limit box is then centered on the picked point which is set to the center of the screen.
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Note: To leave the picking mode, you can select Close Center on Point from the pop-up menu.

8.8.3.2 Change the Center Point of a Limit Box

To change the center point of a limit box:

1. Click the Change Limit Box Center Point icon. The cursor changes to show the following .
2. Pick a point on displayed clouds and/or geometries.

n The limit box is then centered on the picked point.

Note: To leave the picking mode, you can press Esc.

8.8.3.3 Manipulate a Limit Box

There are three modes of manipulations, Modify Shape, Pan and Rotate.

8.8.3.3.1 Resize a Limit Box

To resize a limit box:
1. Click the Modify Shape icon. A manipulator with six FaceHandles appears, one on each face of the limit box, and

eight Corner Handles.

2. To increase or decrease the size of the limit box in one direction:
n Pick a FaceHandle to select it. It turns yellow.
n Drag and drop the Face Handle away from (or toward) the center of the limit box.

Trimble RealWorks User Guide | 222



EXPLORE

3. To increase or decrease the size of the limit box, uniformly in all directions.
n Pick a Corner Handle to select it. It turns yellow.
n Drag and drop the Corner Handle away from (or toward) the center of the limit box.

Tip: You can also select Modify Shape from the pop-up menu.

Tip: You can also use the E shortcut key instead.

8.8.3.3.2 Pan a Limit Box

To pan a limit box:
1. Click the Pan icon. A manipulator, which is composed of three Axis Handles and three Plane Handles, appears. It

has as its origin the center of the limit box.
2. Do one of the following:

n Pan in a plane.
n Pan along a direction.

Tip: You can also select Pan from the pop-up menu or use its associated shortcut key T.

Note: It is advantageous to display the clouds and/or geometries that are outside the limit box and/or all of the Station Pos-
itions of the project. By doing this, you can know exactly where you are within the rest of the cloud and/or within all of the sta-
tions.

Tips:
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n You can use the following keys (á,â,ß,à, Page Up, Page Down) on your numeric keypad to move the limit box.
n You can combine the use of the above keys with the Ctrl key to speed up the movement of the limit box.

8.8.3.3.2.1 Pan Along a Direction

To pan the limit box along a direction:
1. Pick an Axis Handle to select it. It turns yellow. A direction in yellow aligned with the Axis Handle appears.
2. Drag the Axis Handle along the direction to move the limit box in that direction.
3. Drop the Axis Handle.

The cloud inside the limit box is automatically updated.

8.8.3.3.2.2 Pan in a Plane

To pan the limit box in a plane:
1. Pick a Plane Handle to select it. A larger yellow Plane Handle is displayed.
2. Drag the Plane Handle in any direction on the plane to move the limit box in that direction.
3. Drop the Plane Handle.

The cloud inside the limit box is automatically updated.
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8.8.3.3.3 Rotate a Limit Box

To rotate a limit box:
1. Click the Rotate icon. A manipulator, which is composed of three Ring Handles (red, light blue and green), is dis-

played. This manipulator has the center of the limit box as the origin.
2. Pick a Ring Handle to select it. It turns yellow. An axis, passing through the center of the ring and perpendicular to it,

appears. This axis has the color of the selected ring.
3. Drag the Ring Handle to rotate the limit box around the axis.
4. Drop the Ring Handle.

The cloud inside the limit box is automatically updated.
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Tip: You can also select Rotate from the pop-up menu or use its related shortcut key R.

8.8.3.3.4 Switch from one Mode of Manipulation to Another

You can easily switch between the different manipulation modes, i.e. from Modify Shape to Pan, and from Pan to Rotate,
and so on, by just picking one of the Handles.

Note: The cursor changes to when you hover it over a Handle.

8.8.3.4 Display and Hide a Limit Box

A limit box can be displayed and hidden at any time.

To display a limit box:
n Click the Show Limit Box icon.

n The limit box, with its manipulator (Size, Pan or Rotate), is displayed in the 3D View.
n The Show Limit Box icon is highlighted in yellow.

To hide a limit box:
n Click the Show Limit Box icon.

n The limit box, with the current manipulator, is removed from the 3D View.
n The Show Limit Box icon becomes unselected.

8.8.3.5 Display and Hide Clouds/Geometries Outside the Limit Box

All objects that are outside the limit box, whatever they could be, can be at any time displayed, or hidden.

To display the clouds/geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are displayed in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon is highlighted in yellow.

To hide the clouds/geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are hidden in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon becomes unselected.

8.8.3.6 View a Limit Box from one of its Sides

To view a limit box from one of its sides:
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1. Click on the Canonical Views pull down arrow.
2. Choose a view from the drop-down list.

Or
3. Right click in the 3D View.
4. Choose a view of the Limit Box Views menu from the pop-up menu.

8.8.4 Record Limit Boxes

To record a limit box:
n Click the Record the Current Limit Box icon.

In the Limit Box window (if open), a limit box object with a default name (New Limit Box) is then created.

8.8.5 Manage Limit Boxes

A limit box, once recorded, is stacked in a list in the Limit Box window (if open).

8.8.5.1 Rename a Limit Box

To rename a limit box:
1. In the Limit Box window, select a limit box.
2. Press the F2 key. The name of the selected limit box becomes editable.
3. Input a new name, and press Enter.

8.8.5.2 Add a Description to a Limit Box

To add a description to a limit box:
1. In the Limit Box window, select a limit box.
2. Click inside the Description panel.
3. Input a comment in the Description panel.

8.8.5.3 Apply a Limit Box

To apply a limit box:
1. In the Limit Box window, select a limit box.
2. Click the Apply LimitBox icon.

Tip: You can also right-click on a limit box and select Apply Limit Box from the pop-up menu or double-click a limit box.

8.8.5.4 Remove a Limit Box

To remove a limit box:
1. In the Limit Box window, select a limit box.
2. Click the Remove LimitBox icon. The selected limit box will be removed from the Limit Box window,

Tip: You can also right-click on a limit box and select Remove Limit Box from the pop-up menu.

8.8.5.5 Export Limit Boxes
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To export limit boxes:
1. In the Limit Box window, click the Export icon. The Export a Limit Box File dialog opens.
2. Navigate to the drive/folder where to store the file.
3. Input a name in the File Name field.
4. Click Save. The Export a Limit Box File dialog closes.

A file with the extension (.BOX) will be then created. This file will contain as many limit boxes as the project contains.

8.8.5.6 Import Limit Boxes

To import limit boxes:
1. In the Limit Box window, click the Import icon. The Import a Limit Box File dialog opens.
2. Navigate to the drive/folder where the file is located.
3. Click on the file to select it. Its name appears in the File Name field.
4. Click Open. The Import a Limit Box File dialog closes.

8.9 Navigate

In the last session, we mentioned that the visualization of objects in the 3D View is like taking a photograph with a camera.
A photograph is a static view of the scene being visualized. If we can modify the camera position continuously, we can
obtain the so-called object animation effects. We call this the navigation of the scene. Here, the modification of the camera
position will be executed interactively by the user. In RealWorks, there are mainly three different ways for navigating
through a 3D scene: Examiner, Walkthrough and Station-Based.

All the navigation features can be found in View > Navigation.

8.9.1 Customize the Settings for a Mouse

The navigation inside a scene or the manipulation of objects in the 3D View is done by using a 2D mouse, a 3D mouse, or
with gestures on a touchscreen.

2D MOUSE:

When you launch RealWorks for the first time, the default assignment for the left button is Rotate, while the middle button is
dedicated for Pan. You are able to change these assignments in the Preferences / Navigation dialog.

3D MOUSE:

Before using a 3D mouse, you need to connect it to a USB port of your computer and place it properly, ideally on the oppos-
ite side of the 2D mouse, and with the printed logo of 3DConnexion facing you and the cable toward the screen. You also
need to download the latest software package from the 3DConnexion website (at www.3dconnexion.com/drivers) and
install it. All of these operations need to be done with the Trimble RealWorks program closed.

You can customize the settings of your 3D mouse in the Advanced Settings panel, which can be accessed via the 3DCon-
nexion Properties, or by clicking on the left button of the 3D mouse and selecting Properties from the Radial Menu. Please,
refer to the 3DConnexion documentation for more information.

Caution: The 3D mouse can be used anywhere, except in the Image Matching when the adjustment constraints are activ-
ated, in the Segmentation when a fence is started and the projection mode is Perspective and in the Annotate in Trimble
Scan Explorer, once an annotation has been drawn.

TOUCHSCREEN:
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You can use some gestures instead of a mouse to navigate through a scene when your screen has the touch-sensitive cap-
abilities.

8.9.2 Set the Head Always Up Option

The Head Always Up option enables, in the case you manipulate a 3D complex scene in the 3D View, to not lose its ori-
entation in relation to the coordinate frame. The Z direction of the 3D scene is then in a plane perpendicular to the screen,
as illustrated below.

When you start the software for the first time after you install it, the Head Always Up option is by default selected. You can
deselect the option in the Preferences / Navigation dialog, or uncheck the option from the 'Navigation' group on e.g. the
View tab, or press the U shortcut key.

In a pure navigation mode in the 3D View, the Head Always Up option can be chosen in order to preserve the vertical ori-
entation of the scene. In some situations, mainly inside a tool, this option, even if it has been chosen, cannot be used. In this

case, the Head Always Up icon changes from to .

8.9.3 Set a Navigation Mode

To set a navigation mode:
1. In the Navigation group, click the Navigation Mode pull-down arrow.
2. Choose among Examiner, Walkthrough and Station-Based from the list.

Tip: Right-click anywhere in the 3D View (except on a displayed object) and select Mode > Examiner (or Walkthrough or
Station-Based).

8.9.3.1 Examiner

The Examiner mode is the base mode of the software, that is, it is the default navigation mode when you start the software.
In this mode, you turn the camera around an object. These operations are actually obtained by moving the scene with a
mouse. In the 3D View, the navigation can be done:

n Freely. We call this mode the Standard Navigation .
n Under a temporary constraint.
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n Under a permanent constraint.

Note: If the Head Up option has been checked in the Preferences dialog, its representation is displayed at the bottom
right corner of the 3D View.

Note: In the Examiner mode, you can be in any projection mode (Perspective or Parallel).

8.9.3.1.1 Navigate Without Constraints

You can perform the operations listed hereafter when you navigate in the Examiner mode, with no constraint.

8.9.3.1.1.1 Rotate Around the Center of the Screen

Rotate is the action of turning a displayed object around the center of the screen.

ROTATE WITH A 2D MOUSE:

To rotate around the center of the screen:

1. Press the left button of the mouse. The cursor takes the following shape .
2. Drag the mouse in a direction while holding the left button pressed to rotate in that direction and around the center

of the screen*.

To rotate an object of 360° with a single displacement of the mouse:
1. Position the cursor on the left side of the 3D View.

2. Press the left button of the mouse. The cursor takes the following shape .
3. Drag the mouse to the opposite side of the 3D View.

n If the Head Up option and the Center of Rotation Defined by Cursor Position feature are not selected, the
3D scene rotates 180°.
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n If the Head Up option is unchecked and the Center of Rotation Defined by Cursor Position feature is selected,
the 3D scene rotates of more than one full turn. The number of turns is defined by the height of the 3D View, as
illustrated below.

n If the Head Up option and the Center of Rotation Defined by Cursor Position features are both selected, the 3D
scene rotates of more than one full turn. The number of turns is defined by the height of the 3D View, as illus-
trated below.

Note: (*) You can change the center of rotation using the Center on Point feature.

Note: (*) You can change the center of rotation using the Center of Rotation Defined by Cursor Position feature.

ROTATE WITH A 3D MOUSE:
To tilt around the horizontal axis of the screen:
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n Tilt the controller cap forwards / backwards to tumble the displayed objects around the horizontal axis.

Tip: Try to not pull or push down the controller cap as you tilt.

To spin around the vertical axis of the screen:

1. Rotate the controller cap clockwise to spin the object around the vertical axis of the screen (clockwise)

2. Rotate the controller cap counterclockwise to spin the object around the vertical axis of the screen (coun-
terclockwise)

To rotate around the view axis of the screen:

n Tilt the controller cap Left / Right to roll the displayed objects around the axis perpendicular to the screen.

Tip: Try tilting the controller cap on its X axis (forwards / backwards) without moving it on its Z axis (Left / Right).

ROTATE WITH GESTURES:

To rotate with a gesture:

n

Spin one finger on a position to rotate around that position.

8.9.3.1.1.2 Rotate Around a Picked Point Position

In the Examiner mode, the rotation is by default done around the center of the screen. With the Center of Rotation Defined
by Cursor Position feature, the rotation is done at the position you picked in the 3D View.

ROTATE WITH A 2D MOUSE:

To rotate around the position of a picked point:
1. In the Navigation group, click the Center of Rotation Defined by Cursor Position icon.
2. Pick a point anywhere in the 3D View. The position of the picked point will then be the center of the rotation.
3. Keep the mouse button pressed and drag the mouse. The displayed scene rotates around the picked point.

Tip: You can also use the Q shortcut key instead to activate / deactivate this feature.

ROTATE WITH A 3D MOUSE:

To rotate around the position of a picked point:
1. In the Navigation group, click the Center of Rotation Defined by Cursor Position icon.
2. Click the left button of the 3D mouse.
3. Choose Properties from the Radial Menu. The Trimble RealWorks dialog opens.
4. Click the Buttons button. The Buttons - Trimble RealWorks dialog opens.
5. Click e.g. on the LEFT pull down.
6. Choose Trimble RealWorks / Application Use from the drop-down menu, as illustrated below.
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7. Click Close. The Buttons - Trimble RealWorks dialog closes.
8. Click OK. The Trimble RealWorks dialog closes.
9. Pick a point anywhere in the 3D View, with the 2D mouse. The position of the picked point will then be the center of

the rotation.
10. Keep the Left button of the 3D mouse pressed and rotate the controller cap. The displayed scene rotates around the

picked point.

Tip: You can also use the Q shortcut key instead to activate / deactivate this feature.

ROTATE WITH GESTURES:

To rotate with a gesture:
1. In the Navigation group, click the Center of Rotation Defined by Cursor Position icon.
2. Tap a point anywhere in the 3D View. The position of the tapped point will then be the center of the rotation.

3. Spin one finger around the position to rotate around that position.

8.9.3.1.1.3 Pan in a Direction

Pan is the action of moving a displayed object in a plane parallel to the 3D View. You are able to pan in any direction or from
one side to another, or up and down.

PAN WITH A 2D MOUSE:
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With a standard mouse, you can pan an object displayed in the 3D View in any direction.

To pan in a direction:

1. Press the middle button of the mouse. The mouse takes the following shape .
2. Drag the mouse in a direction while holding the button pressed to pan in that direction.

PAN WITH A MOUSE:

With a 3D mouse, you can only pan an object displayed in the 3D View in four directions, Up, Down, Right and Left.

To pan from up to down:

1. Pull the controller cap to the Up to move the object upwards.

2. Push the controller cap to the Down to move the object downwards.

Tip: Keep the controller cap frommoving side-to-side or from tilting.

To pan from right to left:

1. Push the controller cap to the Right to move the object to the right.

2. Push the controller cap to the Left to move the object to the left

Tip: Keep the controller cap frommoving up / down and front / back.

PAN WITH GESTURES:

To pan with a gesture on a touchscreen:

n

Drag two fingers in a direction to pan in that direction.

8.9.3.1.1.4 Zoom In / Zoom Out

The Zoom In and Zoom Out features behave differently depending on the combination of keys you use. The first behavior,
called Zoom (Distance), is like moving a camera forward (or backward) through a scene to simulate the Zoom In or Zoom
Out effect. The second behavior, called Zoom (Angle), is like taking a picture from a fixed position (of the camera), the
Zoom In and Zoom Out effects are then obtained by magnifying or reducing the camera angle.

Note:When you zoom in (or out), the focus is done from the position of the cursor, instead of from the center of the screen.

ZOOM WITH A 2D MOUSE:

Zoom (Distance)

To zoom in (or out):

1. Press the left and middle buttons together. The mouse takes the following shape .
2. Drag the mouse forward while holding both pressed to Zoom In. The "camera" moves backward, and the scene is

reduced.
3. Drag the mouse backward while holding both pressed to Zoom Out. The "camera" moves forward, and the scene is

enlarged.
4. Or use the mouse wheel.

Zoom (Angle)

To zoom in (or out):

1. First press the Ctrl key and the left and middle buttons together. The mouse takes the following shape .
2. Drag the mouse forward while holding both pressed to Zoom In. The "camera" does not move. Its angle is enlarged,

the scene is zoomed out.
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3. Drag the mouse backward while holding both pressed to Zoom Out. The "camera" does not move. Its angle is
reduced, the scene is zoomed in.

4. Or press the Ctrl key and use the mouse wheel.

Tip: You can reverse the mouse for zooming in the Preferences dialog.

ZOOM WITH A 3D MOUSE:

Zoom (Distance)

To zoom in (or out):

1. Push the controller cap to Zoom Out.

2. Pull the controller cap to Zoom In.

Zoom (Angle)

To zoom in / zoom out:

1. First press the Ctrl key and then push the controller cap to Zoom Out. The mouse takes the following shape
.

2. Keep the Ctrl key pressed and pull the controller cap to Zoom In. The mouse takes the following shape .

Note: You can reverse the controller cap motion for Zoom In and Zoom Out in the Advanced Settings.

ZOOM WITH GESTURES:

To zoom with gestures:

1. Move two fingers apart or to zoom in.
Or

2. Move two fingers toward each other or to zoom out.

8.9.3.1.2 Navigate Under Temporary Constraints

You can navigate under a temporary constraint according to three directions: Horizontal, Vertical and Perpendicular-to-the-
Screen. By this way, you can switch easily from a free navigation (in the Standard Navigation) to a constrained navigation.

The illustration below shows where you need to place the cursor in the 3D View to activate a temporary constraint. There
are eight areas in the 3D View, illustrated by the letters A, B and C.
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To rotate horizontally:
1. Place the cursor anywhere along the right (or left) side of the 3D View, (A areas in the 3D View).
2. Click on the LEFT button of your mouse.
3. Move your mouse from up to down and in reverse to rotate a scene constrained under the horizontal direction.

Note:When using a touchscreen, drag one finger up and down to rotate a scene constrained under the horizontal dir-
ection.

To rotate vertically:
1. Place the cursor anywhere along the top of the 3D View, (B areas in the 3D View).
2. Click on the LEFT button of your mouse.
3. Move your mouse from right to left and in reverse to rotate a scene constrained under the vertical direction.

Note:When using a touchscreen, drag one finger left and right to rotate a scene constrained under the vertical dir-
ection.

To pan horizontally:
1. Place the cursor anywhere along the top of the 3D View.
2. Click on the middle button of your mouse.
3. Move your mouse from right to left and in reverse to pan a scene constrained under the horizontal direction.

Note:When using a touchscreen, drag two fingers left and right to pan a scene constrained under the horizontal dir-
ection.

To pan vertically:
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1. Place the cursor anywhere along the right (or left) side of the 3D View, (A areas in the 3D View).
2. Click on the middle button of your mouse.
3. Move your mouse from top to bottom and in reverse to pan a scene constrained under the vertical direction.

Note:When using a touchscreen, drag two fingers up and down to pan a scene constrained under the vertical dir-
ection.

To rotate locked in the screen:
1. Place the cursor anywhere at one of the four corners of the 3D View, (C areas in the 3D View).
2. Click on the left button of your mouse and move it clockwise and anticlockwise and in reverse to rotate a scene con-

strained under an axis perpendicular to the screen.

Note: You cannot rotate a scene constrained under an axis perpendicular to the screen if the Head Always Up option is
checked in the Preferences dialog.

Note:When using a touchscreen, spin one finger clockwise and anticlockwise and in reverse to rotate a scene con-
strained under an axis perpendicular to the screen.

8.9.3.1.3 Navigate Under Permanent Constraints

A constraint can also be permanent (for all navigation purposes). There are five types at all: Horizontal Pan, Vertical Pan,
Horizontal Rotation, Vertical Rotation and Screen Rotation. All of these constraints can be accessed from the Navigation
group, on the View tab.

But you can right-click on a constraint mode icon at the right side of the status bar. This displays a pop-up menu from which
you can select a type of constraint.
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You can also right-click anywhere in the 3D View (except on a displayed object) and select Mode from the pop-up menu. A
sub-menu drops down. Select then a constraint mode.

Tip: You can use the Alt key to slow down all navigations in the 3D View, free or permanent constraint.

Note: To get the Standard Navigation mode back, you can double-click on the constraint mode icon at the right side of
the status bar.

To pan horizontally:
1. In the Navigation group, click on the Navigation Constraints pull-down arrow. A sub-menu drops down.
2. Select Horizontal Pan from the sub-menu.
3. Press on the middle button of your mouse and move it from left to right and in reverse to pan the displayed scene

constrained under the horizontal axis.

Note:When using a touchscreen, drag two fingers right and left to pan along a horizontal axis constraint.

To pan vertically:
1. In the Navigation group, click on the Navigation Constraints pull-down arrow. A submenu drops down.
2. Select Vertical Pan from the submenu.
3. Press on the middle button of your mouse and move it from top to bottom and in reverse to translate the displayed

scene constrained under the vertical axis.

Note:When using a touchscreen, drag two fingers up and down to pan along a horizontal axis constraint.

To rotate horizontally:
1. In the Navigation group, click on the NavigationConstraints pull-down arrow. A submenu drops down.
2. Select Horizontal Rotation from the submenu.
3. Press on the left button of your mouse and move it from top to bottom and in reverse to rotate the displayed scene

constrained under the horizontal axis.
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Note:When using a touchscreen, spin one finger to rotate constrained around the horizontal axis.

To rotate vertically:
1. In the Navigation group, click on the NavigationConstraints pull-down arrow. A submenu drops down.
2. Select Vertical Rotation from the submenu.
3. Press on the left button of your mouse and move it from left to right and in reverse to rotate the displayed scene con-

strained under the vertical axis.

Note:When using a touchscreen, spin one finger to rotate constrained around the vertical axis.

To rotate locked in the screen plane.
1. In the Navigation group, click on the Navigation Constraints pull-down arrow. A submenu drops down.
2. Select Screen Rotation from the submenu.
3. Press on the left button of your mouse and move it clockwise and anticlockwise to rotate the displayed scene con-

strained under an axis perpendicular to the screen.

Caution: The Screen Rotation feature is grayed-out if the Head Up option has been checked in the Preferences / Nav-
igation dialog.

Note:When using a touchscreen, spin one finger to rotate constrained around an axis perpendicular to the screen.

8.9.3.2 Walkthrough

In the Walkthrough mode, you use the mouse movement to simulate a walking through of the displayed scene. You cannot
apply a constraint of any kind (either temporary or permanent) in this navigation mode.
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Note: If the Head Always Up option has been checked in the Preferences dialog,  is displayed in the bottom right corner
of the 3D View.

Tip: If the Parallel mode is the current projection mode, choosing Walkthrough will automatically swap the projection mode
to Perspective.

8.9.3.2.1 Tilt (or Rotate) "Look at" a Direction

The steps below describe the controls to use to simulate a "Look at a Direction" mode, by turning your head inside a dis-
played scene.

To use a 2D mouse:

1. Press the left button of the mouse. The cursor takes the following shape .
2. Drag the mouse in a direction while holding the button pressed to spin the camera in that direction.

Tip: The rotation can be inverted in Preferences > Navigation > Invert Mouse-Rotation.

To use a 3D mouse:

1. Rotate the controller cap towards you to pitch up the camera.
2. Rotate the controller cap toward your screen to pitch down the camera.

3. Rotate the controller cap clockwise to spin the camera (clockwise)

4. Rotate the controller cap counterclockwise to spin the camera (counterclockwise)

8.9.3.2.2 Move the Camera in a Direction

The steps below describe the controls to use to simulate a "Displacement" mode, left and right, and up and down.

To use a 2D mouse:

1. Press the middle button of the mouse. The cursor takes the following shape .
2. Drag the mouse in a direction while holding the button pressed to move the camera along that direction.

Or
3. Use theè (orç) arrow key to move the camera along that direction.
4. Use the Page Up (or Page Down) key to move the camera up (or down) along the Z axis.

Tip: The pan can be inverted in Preferences > Navigation > Invert Mouse-Rotation.

To move up to down:

1. Pull the controller cap to the Up to move the camera from you.

2. Push the controller cap to the Down to move the camera toward you.

Tip: Keep the controller cap frommoving side-to-side or from tilting.

To move left and right:

1. Push the controller cap to the Right to move the camera to the right.

2. Push the controller cap to the Left to move the camera to the left

Tip: Keep the controller cap frommoving up / down and front / back.

To use gestures:

n

Drag two fingers in a direction to move the camera along that direction.

8.9.3.2.3 Walk Through a Scene (or Objects)
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The steps below describe the controls to use to simulate a "Walking Through" mode, forwards and backwards through a
scene.

To use a 2D mouse:

1. Press the left and middle buttons together. The cursor takes the following shape .
2. Drag the mouse forward while holding both pressed to Walk Inside a scene (objects).
3. Drag the mouse backward while holding both pressed to Walk Out of a scene (or objects).

Or
4. Scroll the mouse wheel forward to Walk Inside a scene (objects).
5. Scroll the mouse wheel backward to Walk Out of a scene (or objects).

Or
6. Use theé arrow key to Walk Inside a scene (objects)
7. Use theê arrow key to Walk Out of a scene (or objects).

Tip: You can reverse the mouse for zoom in the Preferences dialog.

To use a 3D mouse:

1. Pull the controller cap to Walk Out of a scene.

2. Push the controller cap to Walk Inside a scene.

8.9.3.3 Station-Based

In the Station-Based mode, a scene is viewed from the viewpoint of one of the stations, i.e., the instrument location for this
station, and you can jump from one station to another (if there is more than one). The Head Up preference and the Per-
spective projection mode are both set.

The navigating through a scene is restricted to Rotate, Zoom In and Zoom Out. You cannot apply a constraint of any kind
(either temporary or permanent).

8.9.3.3.1 Browse the Stations

To browse the stations:
1. In the Navigation group, click on the Navigation Mode pull-down arrow.
2. Select Station-Based from the submenu.

The scene is viewed from the first station viewpoint (the first in the Project Tree) with overlapped images in the back-
ground (see the upper illustration). You can use the AutoSpin feature in the Preferences to endlessly turn a scene
around the station position. You can display (or hide) the position of the other stations as well as their label in the 3D
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View. For more information, refer to the Display (or Hide) all Stations and Display (or Hide) all Station Marker Labels
sections.

3. Do one of the following:
n To display the first (or last) station, click the Go toFirst Station (or Last Station) button.
n To display the next (previous) station, click the Go to Next (or PreviousStation) button.
n Click the current station button and choose another station from the drop-down list (1). The current station is

grayed out and has a check mark at its side.
n Double-click on a station marker .

Note: To leave the Station-Based mode, choose between Examiner andWalkthrough.

Tip: In the Scans Tree, if you select a station from the Project Tree, right-click and select Station-Based Mode from the
pop-up menu; the selected scene will be viewed from the selected station viewpoint. If no station has been selected, the
scene will be viewed from the first station viewpoint.

Caution: (1) Empty stations are not displayed in the 3D View, and do not appear in the drop-down list.

8.9.3.3.2 Rotate Within a Station

Rotate is the action of turning around the point of view of the current station.

ROTATE WITH A 2D MOUSE:

To rotate around the viewpoint of the current station:

1. Press the left button of the mouse. The cursor takes the following shape .
2. Drag the mouse in a Direction while holding the button pressed to rotate in that Direction and around the viewpoint

of the current station.

ROTATE WITH A 3D MOUSE:

To rotate around the viewpoint of the current station:

1. Rotate the controller cap clockwise to spin the camera clockwise.

2. Rotate the controller cap counterclockwise to spin the camera counterclockwise.

Note: You can reverse the controller cap motion for rotating in the Advanced Settings.

ROTATE WITH GESTURES:

Drag the mouse in a Direction while holding the button pressed to rotate in that Direction and around the viewpoint of the

current station .

8.9.3.3.3 Zoom Within a Station

Zoom In (or Zoom Out) is the action of moving the camera backwards (or forwards) from the point of view of the current sta-
tion.

ZOOM WITH A 2D MOUSE:

To zoom in (or out):

1. Press the left and middle buttons together. The mouse takes the following shape .
2. Drag the mouse Forward* while holding both pressed to Zoom In.
3. Drag the mouse Backward* while holding both pressed to Zoom Out.
4. Or use the mouse wheel.

Note: (*) You can reverse the mouse for Zoom In and Zoom Out in the Preferences.

ZOOM WITH A 3D MOUSE:

To zoom in (or out):
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1. Push the controller cap to Zoom In. The mouse takes the following shape .

2. Pull the controller cap to Zoom Out. The mouse takes the following shape .

Note: You can reverse the controller cap motion for Zoom In and Zoom Out in the Advanced Settings.

8.9.3.3.4 Display & Hide the Images

To display and hide the images:
1. First, filter the images to display.
2. And then, click the Display Images  button.

Or

3. Click the Hide Images  button.

8.9.3.3.5 Filter the Images

To filter the images:

1. Click the Filter Images by Camera Type button.
If the current project has no images; the Select Image Type dialog is empty and looks as illustrated below:

If the current project has some images which come from an instrument other than the Trimble SX10, the Select
Image Type dialog appears as illustrated below:

If the current project has some images which come from the Trimble S1X0 instrument, the Select Image Type dia-
log appears as illustrated below:

2. Select a type by checking the corresponding check box. The number of images of the chosen type is displayed. The
selected images are displayed in overlap in the background, only if the Display Images option has been chosen. 

Note:Only one of the images can be selected at once.

8.9.3.3.6 Edit Manually a Distance

Images taken by a Trimble SX10 instrument may be of three types (Overview, Primary and Telescope) and not be con-
centric, i.e., the camera is not in the same position as the center of the station. The current shift value used to check if the
images are not concentric is of 5 mm. You are able to apply a correction to this non-concentricity by editing manually the dis-
tances of the images in order to have a perfect overlay of the images on a specific area. Below are the different cases that
you may encounter depending on the number of image types in the project, and if the images are concentric or not.

The station contains several image types and the images have a shift:

Trimble RealWorks User Guide | 243



EXPLORE

The station contains several image types but no image has a shift:

The station has one image type and the images have a shift:

The station contains one image type and no image has a shift:

The default value is 15 m. The value you can input ranges between 0.5 m and 1000 m. This value will be applied not only to
the current station but to all stations of the project. The value will be kept inside the current session (of RealWorks), but not
from one session to another.

To edit manually a distance:
n Do one of the following:

n Press to decrement the distance value of 5%.
n Press to increment the distance value of 5%.
n Input a value followed by the unit of measurement in the Distance field.
n Press Shift and scroll up the mouse wheel to increment the distance value.
n Press Shift and scroll down the mouse wheel to decrement the distance value.

8.9.3.4 Move to a position on the ground

In the Perspective projection and Examiner (or Walkthrough) navigation, pick a point on the ground to move:
- Above the picked point, without rotation, when picking in the center of the screen.
- Above the picked point, with rotation to face the walking direction, when picking in a side of the screen.
Or pick a point on a wall to move close to the wall while looking at it.

To move to a position on the ground:
1. Press and hold the SHIFT key.
2. With the LEFT button of the mouse, click a position on the ground in the middle of the screen. The camera will:

- Move parallel to the scene's ground.

Trimble RealWorks User Guide | 244



EXPLORE

3. With the LEFT button of the mouse, click a position on the ground on the side of the screen. The camera will:

- Move parallel to the scene's ground.
- Rotate to face the walking direction.
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4. With the LEFT button of the mouse, move close to the wall and click a position on a wall. The camera will:

- Rotate to face up to the wall.
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Tip: To assign a mouse button for the rotation, see Preferences > Navigation.

8.9.3.5 Look at a position on a wall (or an object)

In the Parallel projection and Examiner navigation, pick a point on a surface to face the picked surface.

To look at a position on a wall (or an object):
1. Press and hold the SHIFT key.
2. With the LEFT button of the mouse, click a position on a wall or on an object. The camera will:

- Rotate to face the picked wall (or object).
- Move up or down to match the clicked height.
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Tip: To assign a mouse button for the rotation, see Preferences > Navigation.

8.9.4 Set a Projection Mode

There are two projection modes. In the Parallel mode, the distance from the viewing camera origin to displayed objects has
no impact on how large an object appears. In the Perspective mode, the most unmistakable characteristic is foreshortening
- the further an object from the viewing camera, the smaller it appears in the final screen image.

To set the Perspective mode:
1. In the Navigation group, click the Projection Mode pull-down arrow.
2. Select Perspective from the drop-down menu.

Tip: You can right-click anywhere in the 3D View (except on a displayed object) and select Mode / Perspective from the
pop-up menu.

Note: In the Perspective mode, you can use any of the displacement modes (Walkthrough, or Examiner or Station-Based).

To set the Parallel mode:
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1. In the Navigation group, click the Projection Mode pull-down arrow.
2. Select Parallel from the drop-down menu.

Note: The scale at the left down corner of the 3D View is only available in Parallel.

Tip: You can right-click anywhere in the 3D View (except on a displayed object) and select Mode / Parallel from the pop-up
menu.

Note: In the Parallel mode, you can only use the Examiner mode. If you choose Parallel, the displacement mode will auto-
matically swap to Examiner.

8.10 Align the Data to a View

There are twelve pre-programmed standard viewing positions. All of them can be found in View > View.

8.10.1 Align to a Global View

You can align to a global view with either a 2D mouse or a 3D mouse. The Top, Back, Right, Left, Front and Back are
defined as shown below where X, Y, Z represent the three axes of the Active Frame.
View View Direction
Top Looking parallel to - Z-axis, + Y-axis bottom to top, + X-axis left to right
Bottom Looking parallel to + Z-axis, + Y-axis top to bottom, + X-axis left to right
Front Looking parallel to + Y-axis, + Z-axis bottom to top, + X-axis left to right
Back Looking parallel to - Y-axis, + Z-axis bottom to top, + X-axis right to left
Left Looking parallel to + X-axis, + Z-axis bottom to top, + Y-axis right to left
Right Looking parallel to - X-axis, + Z-axis bottom to top, + Y-axis left to right

USE A 2D MOUSE TO ALIGN:

With a 2D mouse, you can align according to six views.

To align to a global view:
1. In the View group, click the Standard Views pull-down arrow.
2. Select one of the six options from the sub-menu.

Note: No selection is required to apply a standard view.

Tip: You can right-click anywhere in the 3D View (except on displayed objects) and select Standard Views from the pop-up
menu. A sub-menu drops down from which you can select a view.

Tip: You can use shortcut keys to swap from a Standard View to another. All are detailed in the Shortcut Keys section.

USE A 3D MOUSE TO ALIGN:

With a 3D mouse, you can align with only three views: Front, Top and Right.

To align to a global view:
1. Click the right button of your 3D mouse. The Radial Menu appears.
2. Choose among Front View, Top View and Right View from the Radial Menu, with the 2D mouse.
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n If Front View has been chosen, the view is brought to Front .
n If Top View has been chosen, the view is brought to Top .
n If Right View has been chosen, the view is brought to Right .

8.10.2 Align to a Local View

The ObjectTop, Object Bottom, ObjectRight, Object Left, Object Front and ObjectBack correspond to the top, bottom, right,
left, front and back face of an entity which should be selected and of geometry property.

To align to a local view:
1. Select and display an object with geometry property in the 3D View.
2. In the View group, click on the Object Views pull-down arrow.
3. Select an option from the sub-menu.

Tip: You can right-click anywhere in the 3D View (except on displayed objects) and select Standard Views from the pop-up
menu. A sub-menu drops down from which you can select a view.

8.11 Zoom

At any time while you navigate in the 3D View and in any navigation mode (Examiner, Walkthrough or Station-Based), you
can re-align your view frustum by using the following functions: Zoom In, Zoom Out, Zoom on Selection, Zoom Extents,
Center on Point and Go to Shooting Position.

All the options can be selected in View > Zoom.

8.11.1 Zoom In & Zoom Out

The Zoom In feature fits a fenced zone into the whole 3D View while the Zoom Out feature fits the whole 3D View into a
fenced zone.

To zoom in / zoom out:
1. In the Zoom group, choose:

n Zoom In.
n Or Zoom Out.

2. Draw a fence in the 3D View window.
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Note: Before drawing a fence, pressing Esc will leave the Zoom In or Zoom Out tool.

Tip: You can use the mouse buttons Left + Right to zoom in and out.

8.11.2 Zoom Extents

The Zoom Extents feature fits the whole displayed scene into the 3D View (except in the Station-Based mode, where the
field of view is limited).

To zoom with a 2D mouse:
n In the Zoom group, click the Zoom Extents icon.

Tip:
n You can right-click anywhere in the 3D View (except on a displayed object) and select View Alignment from the pop-

up menu. A sub-menu drops down. Select then Zoom Extents.
n You can use the short-cut key Home instead of selecting the Zoom Extents command.

To zoom with a 3D mouse:
1. Click the right button of your 3D mouse. The Radial Menu appears.
2. Choose Fit from the Radial Menu, with the 2D mouse.

To zoom with gestures:

When using a touchscreen, you double tap anywhere in the 3D View except on displayed objects to use the Zoom
Extents feature.

8.11.3 Zoom on Selection

The Zoom on Selection feature fits an object (or a set of objects) in selection into the 3D View.

To zoom on selection:
1. Select an object from the Project Tree.
2. Display the selected object in the 3D View.
3. In the Zoom group, click the Zoom on selection icon.

Tip: You can right-click on an object (cloud or geometry) in the 3D View and select Zoom On Selection from the pop-up
menu and

Tip:When using a touchscreen, you double tap on displayed objects to zoom on the selection.

8.11.4 Center on Point

The Center on Point feature locates a center of rotation onto a selected point (in the Examiner mode) or to merely view
towards this point (in the Station-Based or Walkthrough mode).
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To center on point:
1. In the Zoom group, click the Center on Point icon. The Picking Parameters toolbar appears and the cursor becomes

as follows .
2. Pick a point on the displayed objects.

Note: Before picking a point, press Esc will leave the Center on Point tool.

Tip: You can use the X key on your keyboard as a shortcut.

8.11.5 Magnifier Mode for Point Clouds

To clip and zoom to explore an area of interest on the displayed point clouds:
1. Hover the mouse cursor over an area of interest on the displayed cloud.
2. Press and hold the N key. With the N key held pressed:

n The 3D View shows you the area around the mouse cursor location. The default size of the clipping box is 1
cubic meter. It can be changed in the Preferences / Navigation.

n If the Auto-Center option is activated, the cropped area is set at the center of the screen, else it is not moved (i.e.
it stays under the mouse cursor). The Auto-Center option can be activated / deactivated in the Preferences / Nav-
igation.

n If the current navigation mode is Station-Based (or Walkthrough), it swaps automatically to Examiner.
n If the current projection mode is Perspective, it swaps automatically to Parallel.
n If the current point size is less than 3, it is automatically set to 3, and is not modified.

3. Press the + key to widen the size of the clipping box by 10%.
4. Press the - key to reduce the size of the clipping box by 10%.

Note: The + and - keys are not changing the value of the box size in the Preferences, these changes are applied
only while the N key is pressed down

5. Press the * key to restore the size of the box as defined in the Preferences.
6. Release the N key:

n The zoom and the camera orientation are restored.
n The initial navigation mode is restored to the current mode.
n The initial projection mode is restored.
n The initial point size is restored.

Note: This mode deactivates itself, if you can change the navigation mode. It does not deactivate If you change the pro-
jection mode, and the canonical views, and when you rotate, pan and zoom.

Note: This mode deactivates itself when you access the majority of tools, except with the Measure and Segmentation tools.

Tip: The magnifier mode enables you to quickly visualize a cross section view. In particular, it is a powerful way to visually
check the registration quality on specific details.
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The selection and the picking are two mechanisms you guys need to understand before you can effectively use RealWorks
because both are linked and the description of each is detailed hereafter.

9.1 Select the Data

Selection is a very important concept. All commands and tools in RealWorks will be applied only to the selected project /
objects. It is thus clear that before invoking a command and tool, you should first of all select the objects that you want to
operate on. It is also important to note that according to the nature of the selected objects; only the applicable commands
and tools will be available (whether from the menus, the toolbars or the pop-up menu). In other words, the applicability of
tools and commands is context-sensitive.

9.1.1 WorkSpace Window

A selection in the WorkSpace window is done by picking an object by left clicking it. It is important to note that you can only
make a single selection here. If you wish to perform a multi-selection, you need to do it in the List panel.

MODELS TREE:

Selecting a project node will display its contents (Project Cloud, objects, and/or group of objects) in the List panel. Selecting
a group node will display its contents (objects and/or groups of objects) in the List panel.

SCANS TREE:

Selecting a project node will display its contents (stations, group of stations, scans, or images) in the List panel. Selecting a
station node will display its contents (scans, targets or images) in the List panel.

IMAGES TREE:

Selecting a project node will display its contents (images or group of images) in the List panel. Selecting an image group
node will display its contents (images or group(s) of images) in the List panel.

TARGETS TREE:

Selecting an unmatched group node will display all unmatched targets in the List panel. Selecting a matched group node
will display all matched targets in the List panel.

9.1.2 List Window

A selection in the List panel consists of picking an object by left-clicking it. The selected object will be highlighted in this win-
dow and also in the 3D View and will be put in the Selection List window (if opened). To make a multiple-selection, you can
either combine the Shift key with left-clicking or Ctrl with left-clicking. To select all objects in this window, you should use the
following combination Ctrl + A.

9.1.3 3D View Window

In the 3D View, a selection consists of picking an object by left-clicking it (see the Picking Mechanism section). The selec-
ted object will be highlighted by its bounding box in this window and also in the List window and will be put in the Selection
List window (if opened).

If you wish to perform a multiple-selection, you can first press the Ctrl key and then pick one-by-one each object or use one
of the following methods: Rectangular Selection, Polygonal Selection or Lasso Selection. The method you chose is per-
sistent; it remains unchanged until you expressly ask to change. By using one of the three methods, the selection in pro-
gress is always added to the previous one.

9
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Tip: To select all displayed objects in this window, you should use the following combination Ctrl + A.

Note: There is no Undo / Redo on the selection operations.

Note: You can change the bounding box’s color in the Preferences dialog.

9.1.3.1 Rectangular Selection

To select with a rectangular fence:
1. Press on the Ctrl key and keep it pressed.

2. Select Rectangular Selection in Home > 3D Selection.
3. Pick anywhere to draw the first corner of a rectangular fence and drag the cursor to a new location in the 3D View.
4. Once you reach the position, release the Ctrl key and the mouse button. The rectangular fence is drawn.

n If the rectangular fence, in dash, has been drawn from Left to Right, only the objects whose bounding box is com-
pletely included in the rectangular fence is selected.

n If the rectangular fence, in dash, has been drawn from Right to Left, all the objects which intersect the rect-
angular fence are selected.

Note: You can cancel a selection in progress by pressing Esc.

9.1.3.2 Polygonal Selection

To select with a polygonal fence:
1. Press on the Ctrl key and hold it pressed.

2. Click the Polygonal Selection in Home > 3D Selection.
3. Pick anywhere to draw the first vertex of a polygonal fence and drag the cursor to a new location in the 3D View.
4. Once you reach the position, release the Ctrl key and the mouse button. The two vertices are linked by a segment.
5. Add other vertices by a simple click.
6. Double-click to terminate the polygonal fence.

n All the objects which intersect the polygonal fence, in dash, are selected.

Note: You can cancel a selection in progress by pressing Esc.

9.1.3.3 Lasso Selection

To select with a lasso fence:
1. Press on the Ctrl key and hold it pressed.

2. Click the Polygonal Selection in Home > 3D Selection.
3. In the 3D View, pick a point to start your selection.
4. Drag the cursor to a new location and release the Ctrl key.
5. Press the Shift key, and drag the cursor around the objects or the area you want to select.
6. Double-click to terminate the lasso selection.

n All the objects which intersect the lasso, in dash, are selected.

Note: You can cancel a selection in progress by pressing Esc.

9.1.4 Clear a Selection
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All selections done in the List window and in the 3D View will reside in the Selection List window until you decide to clear
them. To do so, use the Clear Selection button in the Selection List window.

9.2 Pick Data

As mentioned in the previous section, a picking is the action of selecting an object displayed in the 3D View. This action can
be more or less accurate. A picking enables also to get the 3D position of a point in the 3D View. In that case, the action
should be accurate. The Picking Parameters is here to help you to get this accuracy.

There is no command for opening the Picking Parameters toolbar. It comes up with some tools where pickings are required
like the Polyline Drawing,Measure, or Geometry Creator*, etc. There are three picking modes: Standard, Lowest Cloud
Picking and Highest Cloud Picking. The Standard mode is the mode which comes up by default when the toolbar opens.

Note: (*) This tool is not present in Trimble RealWorks Starter and Core.

9.2.1 Pick in the Standard Mode

In the Standard mode, the Picking Parameters toolbar is composed of three fields (X, Y and Z coordinates)* and a button
(Lock on Primitive Center) in the 3D constraint mode and of two fields (Angle and Distance called Polar coordinates or
Distance and Distance called Cartesian coordinates) in the 2D constraint mode.

Note: (*) In the X, YZ Coordinate System or North, East and Elevation in the North, East, Elevation Coordinate System.

9.2.1.1 Pick in the 3D Constraint Mode

In the 3D Constraint Mode, you can lock in the active coordinate frame a coordinate, a couple of coordinates, all coordin-
ates at once or the center of a primitive. When only one coordinate is locked, the picking is constrained on a plane. When
two coordinates are locked, the picking is constrained on a line. And three locked coordinates define the position of a point.
All fields are blank before you pick a point.

1 - Buttons 2 - Fields in which the user can enter values 3 - Lock on Primitive Center

Note: The unit of measurement is set by default to Meters; you do not have to enter “m” and you can change it when neces-
sary (see Preferences).

Tip: In the X, Y, Z Coordinate System, instead of clicking the X (or Y or Z) button, you can also use its related shortcut
SHIFT + X (or Y or Z).

Caution: No shortcut is available when you are in the North, East, Elevation Coordinate System.

CONSTRAIN THE PICKING ON A PLANE:
1. Enter a coordinate in any of the three fields. Its related button is automatically pressed-on.

X* is locked in this example
2. Pick one point on the displayed object. Picking is locked in the X* coordinate.

Note: (*) In the X, Y, Z Coordinate System.
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CONSTRAIN THE PICKING ON A LINE:
1. Enter a coordinate in any of the three fields. Its related button is automatically pressed-on.
2. Enter another coordinate in any of the two remaining fields. Its related button is automatically pressed-on.

X* and Y* are locked in this example
3. Pick one point on the displayed object. Picking is locked in the X and Y coordinates.

Note: (*) In the X, Y, Z Coordinate System.

CONSTRAIN THE PICKING ON A POINT:
1. Enter a coordinate in each of the three fields. Its related button is automatically pressed-on.

2. Go to the 3D View and pick one point. Picking is locked in that position.

LOCK ON A CENTER OF A PRIMITIVE:
1. Click the Lock on Primitive Center icon.
2. Go to the 3D View and pick on a primitive. Wherever you pick on the primitive, you are locked on its center and its

3D coordinates are displayed in the X*, Y* and Z* fields.

Note: (*) In the X, Y, Z Coordinate System.

9.2.1.2 Pick in the 2D Constraint Mode

In the 2D constraint mode, you can use Cartesian (H and V distances both in mm*) or Polar (Angle and Distance respect-
ively in degrees** and in mm**). The Cartesian and Polar constraint picking mode comes automatically when you have to
2D-pick. In each mode, you can constrain one or both items. To tilt from one constraint mode to the other, click on the
Switch to Polar or Cartesian button or on the pull-down arrow and choose the constraint mode you need. Note that you can
do this at any time before and while picking points.

Notes:
n (*) The unit of measurement for H (or V) in Cartesian is set by-default in Millimeter. You can change it in Prefer-

ences \ Units.
n (**) The unit of measurement for the Angle (or Distance) in Polar is set by-default in Degree (or Meter). You can

change it in Preferences \ Units.

USE THE CARTESIAN COORDINATES SYSTEM:

Before you pick a first point, both fields (H and V) are grayed out. After you pick your first point; this point is assumed as the
origin - with 0 and 0 as H and V coordinates - for the next point to come. This next point is itself assumed as the origin for the
third point to come and so on.

1 - Clickable buttons 2 - Editable fields
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Tip: Instead of clicking on the H and V buttons; you can also use its related shortcuts key H and V.

USE THE POLAR COORDINATE SYSTEM:

Before you pick a first point, both fields (Angle and Distance) are grayed out. After you pick your first point; the Angle and
Distance fields are empty of value. When you pick the next point; the Angle field remains empty of value and the Distance
field is filled with a value that corresponds to the distance from the first point to this second point. When you try to pick a
third point, the Angle field is filled with the second point/first point and second point/third point angle value.

1 - Clickable buttons 2 - Editable fields

Tip: Instead of clicking on the Angle (or Distance) button; you can also use its related shortcut keys Shift + A (or D).

9.2.2 Pick the Highest Cloud Point

You can pick the highest point on a region of the screen around the position of your cursor with regard to the Z axis of the
current frame. You are able to choose a size (in pixels) around the position of your cursor. The illustration below shows the
principle in the XYZ coordinate system.
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To pick the highest cloud point:
1. Bring the view to Top by selecting Top in the View group.
2. Open a tool where pickings are required, like e.g. the Measure. The Picking Parameters toolbar opens.
3. Drop-down the first pull-down arrow and choose Highest Cloud Point from the list.
4. Drop-down the second pull-down arrow and choose the numbers of pixels from the list. The number of pixels

ranges from 5 Pixels to 20 Pixels.
5. Hover the cursor over a point.

n A square marker appears at the end of the cursor.
n Its 3D coordinates are displayed in the X, Y and Z fields.

Tip: To avoid you from losing the Top view of the scene, we advise you to lock the scene in the Screen Rotation pos-
ition. By this way, when you manipulate the scene, the Top view is always kept.

Tip: You can define another Z axis direction by using the USC tool.

9.2.3 Pick the Lowest Cloud Point

You can know the lowest point on a region on the screen around the position of your cursor with regard to the Z axis (or
Elevation axis). You are able to choose a size (in pixels) around the position of your cursor. The illustration below shows the
principle in the XYZ coordinate system.
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To pick the lowest cloud point:
1. Bring the view to Top by selecting Top in the View group.
2. Open a tool where pickings are required, like e.g. the Measure. The Picking Parameters toolbar opens.
3. Drop-down the first pull-down arrow and choose Lowest Cloud Point from the list.
4. Drop-down the second pull-down arrow and choose the numbers of pixels from the list. The number of pixels

ranges from 5 Pixels to 20 Pixels.
5. Hover the cursor over a point.

n A square marker appears at the end of the cursor.
n Its 3D coordinates are displayed in the X, Y and Z fields.

Tip: To avoid you from losing the Top view of the scene, we advise you to lock the scene in the Screen Rotation pos-
ition. By this way, when you manipulate the scene, the Top view is always kept.

9.2.4 Face of Curb Point and Gutter Point Pickings
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The Face of Curb Point and Gutter Point pickings help you to be more productive when you want to draw a Curb (and/or
Gutter) contour in a 3D point cloud, by snapping the mouse position to the closest Face of Curb (and/or Gutter) Points in the
neighborhood. These smart picking capabilities are present in the Picking Parameters toolbar, next to the existing Highest
Cloud Point and Lowest Cloud Point pickings. The Picking Parameters toolbar opens when you use a tool like e.g. the
Polyline Drawing.

A Face of CurbPoint is the most external (i.e. closest to the road) and highest point on the sidewalk. It always corresponds
to a real (acquired) 3D point in the point cloud.

A Gutter Point, located on the road, is the closest point to the Face of Curb point. In the case of occlusions, the Gutter point
corresponds to a synthetic (computed) point just below the Face of Curb point.

There are three types of curb:

Vertical Curb:

Inclined Curb:

Occluded Curb:

Limitations:
n You are intended to work in a view in which both the sidewalk and the road are visible. Ideally a view near to the Top

View is the most natural for this use case.
n The algorithm is designed to extract real-world curbs and gutters with heights between 1~2 cm and 20 cm.
n If the curbs and gutters are occluded or contain too few points, the snapping may fail.
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n Since the algorithm works locally, objects looking like curbs, e.g. stairs, beams and low walls, might be detected by
the algorithm.

n Vegetation and noise near to curbs may produce false detection.

Caution: Please beware, every pick will launch a background computation; Trimble recommends that you sample your
point datasets first with any sampling method (Ground Extraction, Spatial Sampling, etc.) to avoid this drawback.

Note:RealWorks beeps when the algorithm fails.

9.2.4.1 Pick Face of Curb Points

To pick face of curb points:
1. If required, bring the view to Top. In the view, both the sidewalk and the road are visible.
2. In the Picking Parameters toolbar, drop-down the pull-down arrow and choose Face of Curb Point from the list.
3. Pick a series of points by following the contour of the sidewalk. Each point can be picked roughly around the Face of

Curb Point, and an internal algorithm will compute a point on the closest curb.
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9.2.4.2 Pick Gutter Points

To pick gutter points:
1. If required, bring the view to Top. In the view, both the sidewalk and the road are visible.
2. In the Picking Parameters toolbar, drop-down the pull-down arrow and choose Gutter Point from the list.
3. Pick a series of points by following the contour of the sidewalk. Each point can be picked roughly around the Gutter

Point, and an internal algorithm will compute a point on the closest gutter.
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9.2.5 Roadmark Edge Pickings

The Roadmark Edge picking helps the user to find the nearest points on a road mark, i.e., a corner or a point on an edge, by
picking a point on a point cloud.

To pick roadmark edges:
1. Display a point cloud in the 3D View.
2. Apply the Color Coded Intensity (or Gray-Scaled Intensity) rendering to the point cloud.
3. Pick a point on the floor (floor horizontal with the current frame) near an intensity discontinuity:

n If the picking is close enough to a corner, then the picking will fit on the corner,
n Otherwise the picking result will be a point on the edge (most often orthogonal projection on the edge).
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Note: The resulting point is not necessarily a point of the selected point cloud but a computed point.
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We have introduced a Point Loading Manager for supporting huge amounts of points. The user is able to precisely control
which points are loaded into memory and thus available for all the regular tools.

10.1 Load Data

We distinguish two types of data: data loaded on disk and data loaded in RAM. The way the user is able to load (or unload)
points in RAM can be done through a field in the status bar. At any time, the user can enter a value between 1 and 2000 (in
Millions of Points) in the field and press Enter.

10.2 Process Data

Some tools can work on disk, i.e., on the full data, independently of what is loaded in the RAM (see [A]). Others work dir-
ectly on the data loaded in the RAM (see [B]).

In [A], the number of points used by the Scan-Based Sampling is
equal to the whole data set.

In [B], the number of points used by the Intensity-Based Sampling is
equal to what is loaded in the RAM.

Here is a list of tools for which the need is to work on the full data, i.e., on disk.
n Segmentation tool: As a stand-alone tool, as a sub-tool in other tools and all tools working in a similar way (Cloud-

based Modeler, SteelWorks and EasyPipe).
n Scan-Based Sampling and Random Sampling methods from the Sampling tool (as a stand-alone tool and as a sub-

tool in other tools).

10

Trimble RealWorks User Guide | 265



LOAD, PROCESS & HD DISPLAY DATA

n Exports of point cloud data,
n Generate Point Color-Coding by Height,
n Color Points Using Station Images,
n Coloring in Image Matching tool.

In all the other tools, the deliverable will be produced with what is loaded in RAM.

You can define the amount of points to use with a tool. A dialog appears in case the loading of requested points is not yet
complete. You are then prompted between waiting until the loading is complete and computing now the amount of already
loaded points.

Note: If you decide to compute now, your setting will be changed to the current load.

10.3 Display Points in HD

The HD Display is a new rendering motor in which a camera-based dynamic display loading is implemented. It enables you
to dissociate the loading of points from its display. By this way, you are able to display more points than what you load.

HD Display mode inside a tool:

The Loading Value field and the HD Display mode will appear when you enter a tool. With the Loading Value field, you can
have feedback on the current loading value and you can change it if required. Note that the loading value defines the num-
ber of points the algorithms are working on. The Loading Value field and the HD Display mode will disappear when you
close the tool. The default value is 25 million points and any new value, once set, is persistent (same persistence for all
tools).

In the picture below, the HD Display has not been chosen. The display will be limited to the loading value as long as you are
in the tool.

If you activate the HD Display mode by clicking the HD button, you may have some HD feedback to see more details. This
is useful for picking a precise point, visually checking, identifying an area of interest, etc.
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Note: The new display technology used a VRAMmemory. You can define the maximum VRAM and the cache RAM you
want to allocate to this session in Preferences / HD Display.

The behavior of the HD Display mode depends on the type of tool you are using.

HD Display Mode Outside a Tool:

Outside a tool, the HD Display mode is not available. The Loading Value field is useless, as the display (of points) does not
depend on it anymore.
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Every point coming from a LIDAR instrument has a classification assigned to it which reflects the type (or category) the
point belongs to. The different classes, defined using numeric codes, are defined according to the LAS 1.4 standard.

11.1 Work With Classification Layers

You can manage the classification layers that are within your project, by creating some new ones, deleting those you do not
want anymore, changing its properties, etc. A classification layer is defined by an ID, a name, a color, and an activation
state.

To work with classification layers:

1. Select Classification Layers in View >Windows. The Classification Layers window opens.
2. Do one of the following:

n Create a classification layer.
n Delete a classification layer.
n Edit a classification layer.

3. Click the Cross button. The Classification Layers window closes.

Note: The ClassificationLayers window is only available in the Production mode. When you switch from e.g. Production to
Registration and the Classification Layers window closes of itself (if it is opened).

11.1.1 Create

A classification layer, newly created, is by default set to Active.

To create a classification layer:
1. Click the Add New Classification Layer icon. The CreateNew Classification Layer dialog opens.
2. Enter a name in the Name field.
3. Drop-down the Color pull-down arrow.
4. Choose a color from the color palette.

Or
5. Define a new color by clicking Other.
6. Drop-down the Active pull-down arrow.
7. Choose between Yes and No.
8. Input a number ranging from 64 to 255 in the ID field.
9. Click OK. The CreateNew Classification Layer dialog closes.

An error message appears in the case the input ID corresponds to an existing one (from 2 to 63).
What happens if you input 0, or 1, or anything else than a number? A new layer will be created with the last ID + 1.

Caution: There is no restriction about the number you can input in the ID field. You can of course exceed 255. However, be
aware in case this situation occurs, some information may be lost when exporting to the LAS format because you are out of

11
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the LAS classification range. It is under the user's responsibility to maintain the layer IDs inside the LAS domain if he
intends to export later on.

11.1.2 Delete

You can only remove a classification layer whose LAS ID ranges from 64 to 255, i.e., the one you created.

To delete a classification layer:
1. From the Classification Layers window, select a classification layer.
2. Click the Remove Classification Layer icon. A dialog appears and prompts to continue or not.
3. Click Yes.

n If there are some clouds associated with the selected layer, all the clouds will be moved to the "Unclassified"
layer and the selected layer removed from the project.

n If there is no cloud associated with the selected layer, only the selected layer will be removed from the project.
4. Or click No to abort.

Tip: You can also use the DEL. key on your keyboard instead.

11.1.3 Edit

You can edit a classification layer by changing its properties, except for Layer 0.

To edit a classification layer:
1. Select a layer from the Classification Layers window.
2. Click the Edit Classification Layer icon. The Edit Classification Layer dialog opens.
3. Do one of the following:

n Rename a classification layer: You can rename any layer except those with the LAS IDs 0 and 1, and those
ranging from 19 and 63.

n Change the color of a classification layer: You can change the color of any classification layer.
n Activate or deactivate a classification layer: You can toggle the classification layers from an Active state to

an Inactive state, and vice versa, only for those whose LAS ID varies from 64 to 255.
n Change the LAS ID number: You can change the LAS ID number of any classification layer, except those ran-

ging from 0 and 63.
4. Click OK. The Layer Properties Edition dialog closes.

Tip: You can also double-click on a classification layer.

11.1.4 Advanced View Mode

The Classification Layers window in the Basic View mode will only display all the activated layers, while in the Advanced
View mode, all layers related to the project will be displayed. The mode that comes first is the last chosen one.

To switch to the Advanced View mode:
n Click the Basic View/Advanced View icon.

Basic View mode:
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Advanced View mode: All classification layers are listed by alphabetical order, except the two first ones, "Created,
Never Classified" and "Unclassified" with respectively the LAS ID "0" and "1". You can sort the classification layers
by clicking on the title of each column:
Name: Order the classification layers, except the LAS IDs 0 and 1 ones, from A to Z or from Z to A.
Color: Gather all the colored (or uncolored) classification layers together.
LAS ID: Order the classification layers by increasing (or decreasing) order.
Active: Gather all the active (or inactive) classification layers together.

Note: In the Classification Layers window, you are able to browse from the first layer to the last layer by using theá andâ
keys on your keyboard or select them all by using the Ctrl + A shortcut keys.

11.1.5 Select the Contents of a Specific Layer

You can have quick access to the list of objects of a specific classification layer.

To select the contents of a specific layer:
1. Select a layer from the ClassificationLayers window.
2. Right-click to display the pop-up menu.
3. Select Select All Objects in Classification Layer from the drop-down menu.

n All the objects associated with the classification layer are selected.
n All are listed in the Selection List window (if open).
n All are highlighted in GRAY in the Models Tree.

Tip: You are able to select and display the contents of several classification layers.

11.2 Display & Hide Objects in a Classification Layer

You can display (or hide) the contents of a specific classification layer by type: Cloud or Geometry.

Caution: These operations cannot be performed within a tool.

Tip: You can select several layers by using the Shift (or Ctrl) key and display (or hide) all the contents at once.

Trimble RealWorks User Guide | 270



CLASSIFICATION LAYERS

Note: The objects, once displayed, are not necessarily centered in the center of the 3D View. We advise you to use the
Zoom Extents feature to center them.

To display all clouds in a classification layer:
1. Select a layer from the ClassificationLayers window.
2. Click the Display All Clouds in Classification Layer icon.

Or
3. Right-click to display the pop-up menu.
4. Select Display All Clouds in Classification Layer from the drop-down menu. All the clouds associated with the selec-

ted layer are displayed.

To hide all clouds in a classification layer:
1. Select a layer from the ClassificationLayers window.
2. Click the Hide All Clouds in Classification Layer icon.

Or
3. Right-click to display the pop-up menu.
4. Select Hide All Clouds in Classification Layer from the drop-down menu. All the clouds associated with the selected

layer are hidden.

To display all geometries in a classification layer:
1. Select a layer from the Layers window.
2. Click the Display All Geometries in Classification Layer icon.

Or
3. Right-click to display the pop-up menu.
4. Select Display All Geometries in Classification Layer from the drop-down menu. All the geometries of the selec-

ted layer are displayed.

To hide all geometries in a classification layer:
1. Select a layer from the Classification Layers window.
2. Click the Hide All Geometries in Classification Layer icon.

Or
3. Right-click to display the pop-up menu.
4. Select Hide All Geometries in Classification Layer from the drop-down menu. All the geometries of the selected

layer are hidden.

To hide other classification layers:

If there are several objects, belonging to different layers, that are displayed in the 3D View, you can select a layer and only
keep the objects of the layer displayed and hide the rest by selecting Hide Other Classification Layers .

11.3 Change the Classification Layer

There are two methods to modify the classification layer of an object. With the first method (Change Classification Layer),
you can assign the same layer to a set of objects. You have to perform a multi-selection before, either from the Models Tree
or from the Selection List window. With the second method (from the Property window), you can do it for a unique object.
You also need to have more than the "Created, Never Classified" and "Unclassified' classification layers in your project.
Otherwise, you are not able to modify the classification layer.

Note: There is no undo for such an operation.

To modify from the Models Tree:
1. Select an object (or several objects) having a layer from the Models Tree. This object can be of any type, except a

project.
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2. Right-click to display the pop-up menu.
3. Select Change Classification Layer from the drop-down menu. The Change Classification Layer dialog opens.
4. Click on the Select New Classification pull-down arrow.
5. Choose a layer from the drop-down list.

To modify from the Property window:
1. Select an object having a layer from the Models Tree. This object can be of any type, except a project and a group.
2. Display the properties of the selected object.
3. Click on the Classification Layer line in the Property window.
4. Click on the pull-down arrow.
5. Choose a layer from the drop-down list.

To modify from the Selection List window:
1. Select a layer from the ClassificationLayers window.
2. Right-click to display the pop-up menu.
3. Choose Select all Objects in Classification Layer from the drop-down list. All objects of the selected layer become

selected and are listed in the Selection List Window.
4. Right-click any object in the Selection List Window.
5. Choose Change Classification Layer from the drop-down list. The Change Classification Layer dialog opens.
6. Click on the Select New Classification pull-down arrow.
7. Choose a layer from the drop-down list. All the objects of the selected layer have their layer changed.
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Tools are classified into two categories: basic tools and high-level tools. Basic tools can be used alone or be opened inside
a high-level tool to perform basic operations in the two following processing modes, Registration* and OfficeSurvey/Model-
ing** (or Production), i.e., preparing data for high-level tools. In such cases, you cannot save the result.

Note: (*) In Registration, only the Measurement tool, Limit Box Extraction tool, Shift Project, Generate Key Plan from TZF
Scans and Generate Key Plan from Current View are available.

Note: (**) The Modeling processing mode is not present in RealWorks Viewer, Starter and Core.

12.1 Measure

This tool allows you to make point-to-point distance measurements, angular measurements, point-to-scanning position
measurements, orientation measurements, etc. You can try as many measurements as you wish and for those you need
later on, you can create them as persistent objects in the database. The created measurement objects will be put under the
current active group. Measurements are based on pickings which can be free (or constrained).

12.1.1 Open the Tool

Ameasurement determines the distance two between picked points, calculates the angle from three picked points, shows
the XYZ coordinates of a picked point and gives the orientation of a picked point on a sloping surface, etc. It is important to
note that picking for the measurement will always function on objects, that is, either on points or on geometric shapes. You
can still navigate in the 3D View while performing a measurement but you cannot select an object.

To open the tool:
1. Display an object (point cloud, mesh or geometry) in the 3D View.

2. Select Measure in e.g. Home > Measure. The Measurement and Picking Parameters toolbars open.
n If you use the tool in the 3D View, the toolbar looks as shown below:

n If you use it in a 2D View, the toolbar looks as shown below:

The toolbar is composed of a set of icons. They are grouped by category: 1 - Distance Measurements, 2 - Angu-
lar Measurements, 3 - Point Measurement, 4 - Orientation Measurements, 5 - Create and 6 - Close. The meas-
urement type which comes first is the one selected during the last use of that tool. While you are in this tool, an
information box will appear on the top right corner of the 3D View, and the mouse's cursor will change its shape
to that of a ruler. When you are on a 3D point, a circle surrounding this point appears at the end of the ruler.

12
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Note: Each type of measurement can be activated via its corresponding icon in the Measurement toolbar or by selecting its
related command from the pop-up menu.

12.1.2 Measure a Distance

To perform a distance measurement, choose the appropriate type of measurement by clicking on the associated icon. In
each case, you should pick two points except for the Vertical Clearance Measurement (Upward) (or Vertical Clearance
Measurement (Downward)) where just one point is required.

12.1.2.1 Measure a Distance

To measure a distance:

1. Click the Distance Measurement icon.
2. Pick one point on the displayed object. This point is the first measurement point (A).
3. Navigate in the 3D View and pick another point on the displayed object to assign the second measurement point

(B).
Once the second point is picked, the distance measurement and its projections along the X, Y and Z axes are dis-
played in the 3D View. At the same time, the information box will display the measurement result in text. Each time
you start a new measurement; this information box updates automatically the information inside.

Length: Distance from the two picked points
Delta X: Delta distance between the two points along the X axis
Delta Y: Delta distance between the two points along the Y axis
Delta Z: Delta distance between the two points along the Z axis

Note: Press Esc (or select another measurement type) to undo the distance measurement.

12.1.2.2 Measure a Distance on Screen

The tool lets the user measure a distance by choosing two points, not by picking on what is displayed in the 3D View as for
the Distance Measurement tool, but by picking anywhere, no matter what is behind a picked point. The prerequisite to
enable the tool is to be in the Parallel projection mode, and the result cannot be refined or saved in the database. This tool
can be used in the Production mode and the Registration mode.

To measure a distance on screen:
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1. Click the View-Based 2D Distance Measurement icon.
2. Pick a point anywhere, not necessary on the displayed objects. This point is the first measurement point.

The 3D scene is locked in 2D in the current viewing direction, with the 2D Grid in superimposition (if not previously
hidden).

3. Navigate in the 2D View and pick another point to assign the second measurement point.
Once the second point is picked, the distance measurement displays in the 2D View. The 2D Grid (if displayed
when picking the first point), remains displayed. At the same time, the information box displays the measurement
result in text. Each time you start a new measurement; the information box updates automatically the information
inside.

Note: Press Esc (or select another measurement type) to undo the distance measurement.

12.1.2.3 Measure a Distance in a Horizontal Plane

To measure a distance in a horizontal plane:

1. Click the Distance Measurement in Horizontal Plane icon.
2. Pick a point on the selected object. This point is the first measurement point (A).

3. Navigate in the 3D View and pick another point on the selected object to assign the second measurement point (B).

The measurement is performed between point (A) and the projection of point (B) in the XY plane. The result and its
projections along the X, Y and Z axes are displayed in the 3D View. At the same time, the information box will dis-
play the measurement result in text. Each time you start a new measurement; this information box updates the
information inside automatically.
Length: Distance from point (A) to the projection of point (B) in the XY plane
Delta X: Delta distance between the two points along the X axis
Delta Y: Delta distance between the two points along the Y axis
Delta Z: Delta distance between the two points along the Z axis
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Note: Press Esc (or select another measurement type) to undo the distance measurement.

12.1.2.4 Measure a Distance Along a Vertical Axis

To measure a distance along a vertical axis:

1. Click the Distance Measurement Along Vertical Axis icon.
2. Pick a point on the selected object. This point is the first measurement point (A).

3. Navigate in the 3D View and pick another point on the selected object to assign the second measurement point (B).

The measurement is performed between point (A) and the projection of point (B) along the Z axis. The result dis-
plays in the 3D View. At the same time, the information box will display the measurement result in text. Each time
you start a new measurement; this information box updates the information inside automatically.
Length: Distance from point (A) to the projection of point (B) along the Z axis
Delta X: Delta distance between the two points along the X axis
Delta Y: Delta distance between the two points along the Y axis
Delta Z: Delta distance between the two points along the Z axis

Note: Press Esc (or select another measurement type) to undo the distance measurement.

12.1.2.5 Measure a Vertical Clearance Distance (Upward)

A Vertical Clearance is the minimum unobstructed vertical space between two points along the Z-Axis. The Vertical Clear-
ance Measurement (Upward) is dedicated to indoor (or outdoor) measurements where the user needs to know the unob-
structed distance between two points (from e.g. the ground to the ceiling).

To measure a vertical clearance distance (Upward):

1. Click the Vertical Clearance Measurement (Upward) icon.
2. Pick a point on the selected object.
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The distance measurement is displayed in the 3D View. At the same time, the information box will display the meas-
urement result in text. Each time you start a new measurement; this information box updates the information inside
automatically.

Length: Vertical clearance distance
Delta X: Delta distance between the two points along the X axis
Delta Y: Delta distance between the two points along the Y axis
Delta Z: Delta distance between the two points along the Z axis

Note: Press Esc (or select another measurement type) to undo the distance measurement.

Caution: The Vertical Clearance Measurement (Upward) method is not available in a 2D View.

12.1.2.6 Measure a Vertical Clearance Distance (Downward)

A Vertical Clearance is the minimum unobstructed vertical space between two points along the Z-Axis. The Vertical Clear-
ance Measurement (Downward) is dedicated to indoor (or outdoor) measurements where the user needs to know the unob-
structed distance between two points (from e.g. the ceiling to the ground).

To measure a vertical clearance distance (Downward):

1. Click the Vertical Clearance Measurement (Downward) icon.
2. Pick a point on the selected object.

The distance measurement is displayed in the 3D View. At the same time, the information box will display the meas-
urement result in text. Each time you start a new measurement; this information box updates the information inside
automatically.
Length: Vertical clearance distance
Delta X: Delta distance between the two points along the X axis
Delta Y: Delta distance between the two points along the Y axis
Delta Z: Delta distance between the two points along the Z axis

Note: Press Esc (or select another measurement type) to undo the distance measurement.

Caution: The Vertical Clearance Measurement (Downward) method is not available in a 2D View.

12.1.2.7 Measure a Distance to a Fitted Plane

This method measures a distance from three picked points. The two first points are used to fit a set of points with a (circular)
plane. The first point which should be picked on a set of points defines its center. The second point (with the first one)
defines its diameter. The distance from the third picked point to its projection on the fitted plane is then measured.

To measure a distance to a fitted plane:

1. Click the 'Point to Fitted Plane' Distance Measurement icon.
2. Pick a point on the displayed object.
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3. Move your mouse. A sphere whose diameter is formed by the first picked point and the cursor position appears.
This sphere is used as bounds for fitting a circular plane.

4. Pick a new point not necessary on the displayed object. A fitted circular plane appears.

5. Pick another new point, now on the displayed object.

Notes:
n The fitted (circular) plane will not be created in the RealWorks database once the measurement has been validated.
n The 'Point-to-Fitted Plane' Distance Measurement feature is not present in the toolbar when using the Measure tool

as a sub-tool in the Cloud-Based Registration tool.

Caution: The 'Point to Fitted Plane' Distance Measurement method is not available in a 2D View.

12.1.2.8 Measure a Fitted Cylinder Diameter

This method enables from a point picked on a set of points to first fit this set of points with a cylinder and then to measure its
diameter. This method of measurement cannot be applied to sagging pipes.
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To measure a fitted cylinder diameter:

1. Click on the Fitted Cylinder Diameter Measurement icon.
2. Pick a point on the displayed object.
3. Move your mouse. A sphere whose diameter is formed by the first picked point and the cursor position appears.

This sphere is used as bounds for the cylinder fitting.

4. Pick a new point not necessary on the displayed object.

The set of points in the neighborhood of the first picked point is fitted with a cylinder and its diameter is measured
and displayed.

Note: The fitted cylinder will not be created in the RealWorks database once the measurement has been validated.

Caution: The Fitted Cylinder Diameter Measurement method is not available in a 2D View.

12.1.2.9 Measure a Point-to-Geometry Distance

This method measures the shortest distance between a 3D point and a geometry.

To measure a point-to-geometry distance:

1. Click the 'Point to Geometry' Distance Measurement icon.
2. Pick a geometry. The cursor takes the shape shown below.
3. Move your cursor. The shortest distance from the picked geometry to your cursor position is displayed in the inform-

ation box at the top right corner of the 3D View.
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4. Pick a 3D point on the displayed object.

Note: The 'Point to Geometry' Distance Measurement feature is not present in the toolbar when using the Measure tool as
a sub-tool in the Cloud-Based Registration tool.

12.1.2.10 Measure a Multi-Point Distance

This method measures along a path by picking points.

To measure a multi-point distance:

1. Click the Multi-Point Distance Measurement icon.
2. Pick at least two points on the displayed object.

You can pick as many points as required. Each time a new point is added, the measurement is updated in the 3D
View and in the information box.
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3. To end the measurement, double-click with the left mouse button.
Tip: You can also select End Measurement Definition from the pop-up menu instead of double-clicking.

4. If required, move a node. Perform as described below:
a. Hover the cursor over a node. A red square appears.
b. Drag the selected node and drop it to a required location.

5. If required, delete a node. Perform as described below:
a. Hover the cursor over a node. A red square appears.
b. Select Delete Active Node from the pop-up menu.

Note: You can delete any node, regardless of its position along the measurement, but two nodes must remain at the end.

Note: To cancel the current measurement, press Esc. or start picking new points.

12.1.3 Measure an Angle

To perform an angular measurement, choose the appropriate type of measurement by clicking on the associated icon.

12.1.3.1 Measure an Angle

To measure an angle:

1. Click on the Angular Measurement icon.
2. Pick a point. This point will be the vertex of the angle to measure (A).
3. Navigate through the scene and pick a new point. This point will form with the first point the first segment of the

angle to measure (B).
4. Navigate through the scene and pick a new point. This point will form with the first point the second segment of the

angle to measure (C).

Once the third point is picked, the angular measurement will be displayed in the 3D View. At the same time, the
information box will display the measurement result in text. Each time you start a new measurement this information
box will automatically update the information inside.

Note: The three picked points should be on the displayed object.
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12.1.3.2 Measure a Horizontal Angle

To measure a horizontal angle:

1. Click the Horizontal Angular Measurement icon.
2. Pick a point [A]. This point will be set as the vertex of an angle to measure.

3. Navigate through the scene and pick a new point [B]. This point will form with the first point the first segment of the
angle.

4. Navigate through the scene and pick a new point [C]. This point will form with the first point the second segment of
the angle.

The angular measurement will not be performed between the vertex [A] and points [B] and [C] but between the ver-
tex [A] and the projections of point [B] and point [C] in the XY plane. The result is displayed in the 3D View. At the
same time, the information box will display the measurement result in text. Each time you start a new measurement;
this information box updates the information inside automatically.
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Note: The three picked points should be on the displayed object.
Caution: The Horizontal Angular Measurement method is not available in a 2D View.

12.1.3.3 Measure a Slope Angle

To measure a slope angle:

1. Click the Slope Angular Measurement icon.
2. Pick a point [A]. This point will be set as the vertex of the angle to measure.

3. Navigate through the scene and pick a new point [B]. This point will form with the first point the first segment of the
angle to measure.

The angular measurement will be performed between the vertex [A], the point [B] and the projection of point [B] in
the XY plane. The result is displayed in the 3D View. At the same time, the information box will display the meas-
urement result in text. Each time you start a new measurement; this information box updates the information inside
automatically.

Caution: The Slope Angular Measurement method is not available in a 2D View.

12.1.3.4 Measure a Geometry Slope Angle

To measure a geometry slope angle:

1. Click the Geometry Slope Angle Measurement icon.
2. Pick an axial geometry. Its center will be set as the vertex of the angle to measure. Its axis will be the first segment

of the angle to measure.
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The angular measurement will be performed between the vertex, the geometry's axis and the projection of the geo-
metry's axis in the XY plane. The result is displayed in the 3D View. At the same time, the information box will dis-
play the measurement result in text. Each time you start a new measurement; this information box updates
automatically the information inside.

Caution: The Geometry Slope Angle Measurement method is not available in a 2D View.

12.1.3.5 Measure a Between-Geometry Angle

To measure a between-geometry angle:

1. Click the 'Angle Between Geometries' Measurement icon.
2. Pick an axial geometry.

3. Pick another axial geometry.
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The angular measurement will be performed between the two axes of the picked geometries. The result is dis-
played in the 3D View. At the same time, the information box will display the measurement result in text. Each time
you start a new measurement; this information box updates automatically the information inside.

Note: A warning message appears if the axes (of the geometries) are not secant.

Caution: The 'Angle Between Geometries' Measurement method is not available in a 2D View.

12.1.4 Measure a Point Position

To perform a point measurement, there is only one method.

12.1.4.1 Measure a 3D Point

For a point-to-scanning position measurement, you need just one point.

To measure a 3D point:
1. Click on the Point Measurement icon.
2. Pick one point on the displayed object to measure its 3D position.

A measured point is displayed with a label showing its coordinates. At the same time, the information box will dis-
play the measurement in text. Each time you start a new measurement, this information box will automatically
update the information inside.

Note: Press Esc (or select another type) to undo the measurement.

Tip: You can remove a measured point’s label by first selecting Rendering, then Display 3D Labels from the 3D View menu.

12.1.5 Measure an Orientation / Slope

To perform an orientation measurement, choose the appropriate type of measurement by clicking on the associated icon.

12.1.5.1 Measure an Orientation / Slope

The Slope / Orientation Measurement method lets you know the orientation of a sloping surface from a given point. An ori-
entation is expressed in the form of two angles. The measurement is done as follows. A plane (of circular shape) is extrac-
ted from a picked point. Two angles are then calculated. The first angle called Slope is formed by the extracted plane and
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the YX plane of the active coordinate frame. The second angle called Azimuth Angle is formed by the extracted plane and
the ZX plane of the active coordinate frame.

To measure an orientation / slope:

1. Click on the Slope / Orientation Measurement icon.
2. Pick a point on the displayed object.
3. Navigate through the 3D scene. A sphere whose diameter is formed by the first picked point and the cursor position

appears. This sphere is used as bounds for the plane extraction.
4. Pick a new point on the displayed object.

Once the second point is picked, the result will be shown in the 3D View as a Slope in Ratio or Grade
depending on the Slope / Orientation Measurement System display option in the Preferences. At the
same time, the information box will display the measurement in text (Azimuth Angle and Slope as Angle,
Grade and Ratio). Each time you start a new measurement the information box will update the inform-
ation inside.

Tip: Press Esc. (or select another type) to undo the measurement.

Notes:
n Because a measurement is based on point pickings, you cannot perform an orientation measurement on an object

of geometry type.
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n You can reverse the orientation of a measurement. To do this, right-click anywhere in the 3D View to display the
pop-up menu and select Reverse Orientation Measurement.

Tip: In the 3D View, you can switch the orientation measurement’s notation from Grade to Ratio and vice versa in the
Preferences dialog.

Caution: The Slope / Orientation Measurement method is not available in a 2D View or in 3D locked in 2D.

12.1.5.2 Measure an Orientation / Slope Using Three Points

The Slope / Orientation Measurement Using Three Points method also lets you know the orientation of a sloping surface.
As with the Slope / Orientation Measurement method, the same angles will be calculated: Azimuth Angle and Slope. In this
method, there is no extraction of plane but you have to define one by picking three points which should not be collinear. The
measurement is set at the center of the so-defined plane.

To measure an orientation / slope using three points:

1. Click on the Slope / Orientation Measurement Using Three Points icon.
2. Pick three none-collinear points.

If the three picked points are collinear, an error dialog opens.

After picking the two first points, a temporary plane (of triangular shape) is displayed. As long as you move the
cursor over a point of the displayed object, the temporary plane shape changes.
Once the third point is picked, the result will be shown in the 3D View as a Slope as a Ratio or Grade depending on
the Orientation Measurement System display option in the Preferences. At the same time, the information box will
display the measurement result in text (Azimuth Angle and Slope as Angle, Grade and Ratio). Each time you start a
new measurement this information box will update automatically the information inside.
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Tip: Press Esc. (or select another method) to undo the measurement.

Notes:
n You can perform an orientation measurement on an object of geometry type.
n You can reverse the orientation of a measurement. To do this, right-click anywhere in the 3D View to display the

pop-up menu and select Reverse Orientation Measurement.

Tip: In the 3D View, you can switch the orientation measurement’s notation from Grade to Ratio and vice versa in the
Preferences dialog.

Caution: The Slope / Orientation Measurement Using Three Points method is not available in a 2D View or in 3D locked in
2D.

12.1.6 Refine a Measurement

You can refine the measurement you have just performed by modifying the picked points except for the point-to-scanning
position measurement. For the orientation measurement, you can enlarge/reduce the sphere diameter (or move its center).
For the point-to-point distance measurement, you can move each end in order to extend (or shorten) its length. For the
angular measurement, you can move each of the ends to change its angle, etc.

To refine a measurement:
1. Place the mouse cursor upon an already picked point.
2. Drag and drop it to a new location on the displayed object.

Tip: Before starting a measurement, press Esc (or click Close Tool in the toolbar) to close the Measure tool. When a meas-
urement is in progress, press Esc to cancel it and start a new one.

12.1.7 Save a Measurement

You can save the measurement you have just performed as a persistent object in the RealWorks database. For each saved
measurement, a geometric object, with the "Unclassified" layer, is created and put under the active group in the Models
Tree. You can save as many measurements as you need without leaving this tool. You can also export a measurement res-
ult as a report in Excel format (*.CSV files).

To save a measurement:

1. Click Create . The measurement is saved in the database.
n For all kinds of distance measurements, an object of "Point To Point Distance Measurement" type is created.
n For a multi-point-distance measurement, an object of "Polyline Measurement" type is created*.
n For an orientation measurement, an object of "Orientation Measurement" type is created.

Trimble RealWorks User Guide | 288



BASIC TOOLS

n For an angular measurement, an object of "Angle Measurement" type is created.
n For a point measurement, an object of "3D Point Measurement" type is created.

2. Start a new measurement (if required).
3. Click Close Tool.

Tips:
n Press Esc (or select Close Tool from the pop-up menu) to leave the tool.
n Press Enter (or select Create from the pop-up menu) to save the result.

Note: You should first close the Measure tool to be able to export a result in the Excel file format. Otherwise, the Export-
ation Measurements command is dimmed.

Caution: In the Registration mode, you are not able to save a measurement. The Create icon is always grayed-out.

Note: Amulti-point-distance measurement, when resulting from a measurement done in the 3D, has no normal in its prop-
erties. The same measurement, when done in 2D (like the tank measurement or a polyline measurement drawn on a 3D
locked view) has a normal in its properties.

12.2 Key Plan

What is a Key Plan? From Trimble Scan Explorer's point of view, it is purely a 2D view (of the whole project or of a station
(or set of stations)) with a set of triangles superimposed. Each triangle symbolizes a station's position. From RealWorks's
point of view, a Key Plan is a Preview and a set of split Ortho-images. All are put under a folder named Key Plan under the
Images Tree. A Key Plan is mainly computed within RealWorks* and loaded in Trimble Scan Explorer. The computation
can be done either from a unique (or a set of) TZF scan(s) or from a point cloud displayed in the 3D View. For both meth-
ods, the user interaction is restricted to selecting the input. No parameters are required as they are automatically set.

One of the parameters is the Projection Plane, which is a plane on which points are projected. It is characterized by a pro-
jection direction (Normal) and a Position. The way this Projection Plane is set by default depends on the chosen method
and on what is displayed in the 3D View or not. The Projection Plane is a Top View when generating a Key Plan from TZF
scans, and the focal plane when generating from the displayed point cloud.

Another parameter is an Area Of Interest which is used for computing a Key Plan. By default, the size of the 3D View is con-
sidered as the Area of Interest. It is up to you to size the 3D view to a dimension to compute a Key Plan to that size (only for
the Generate Key Plan From Current View feature).

For the Generate Key Plan from TZF Scans feature, the option to render the computed Key Plan is based on the Elevation
information. The Elevation value is calculated for each point based on its distance to the Projection Plane. Points that are
far away from the Projection Plane are rendered Red. Those that are closer are rendered Blue.

For the Generate Key Plan From Current View feature, the option to render the computed Key Plan is not based on the Elev-
ation information but on the Cloud Rendering options (White Color, Cloud Color, Station Color, Scan Color, Gray Scaled
Intensity, Color Coded Intensity, Color Coded Elevation and True Color). Points are rendered according to the chosen
option.
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The Preview is an Ortho-Image of low resolution which is about 0.1 megapixels. The Ortho-Image, which is split into a set of
small pieces of Ortho-Image, is of high resolution which cannot exceed 10 megapixels. Each split Ortho-Image is named as
follows ImageX_Line Index_Colum Index. It has a size (W x H) in pixels which is about 500 x 500 pixels.

From the 9.1 version of the software, a Key Plan has two new attributes which can be viewed when displaying its prop-
erties. These attributes are the Elevation Max and the Elevation Min of the data (point cloud) along the Z-Axis of the current
frame. When a Key Plan has been created with an earlier version of RealWorks, i.e. before 9.1, these attributes are not
available. But when you load the Key Plan in RealWorks 9.1, they are automatically computed.

The attributes mentioned above are editable manually in the Property window. This can be useful in case of a Key Plan with
several floors because you are able to filter the positions of the stations to keep only those belonging to one level. The attrib-
utes of a Key Plan belong to the Key Plan, so that each is editable individually, and the result is visible directly in Trimble
Scan Explorer (if the Filter Station Markers by Elevation Range option has been checked). These attributes, once changed
and saved, become persistent. This means that you are not able to restore them to the default values.

Notes:
n (*) You should save your RealWorks project to be able to load the newly computed Key Plan in Trimble Scan

Explorer.
n A file with the RWV extension is created per Ortho-Image. All RWV format files are put under the RWI folder.

Tip: All Key Plans are created in the root of the Images Tree and have the same name: Key Plan. Only its order indicated
between brackets allows differentiating one Key Plan from another Key Plan. To make this distinction clearer and more obvi-
ous, we advise you to manually rename all Key Plans (in the Name line of the Property window).
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Tip: You can export an Ortho-image from a Key Plan or the Key Plan itself toward Trimble SketchUp. For more information,
refer to the Export an Entity to SketchUp topic.

Note: A Key Plan has no layer.

12.2.1 Generate key Plan from TZF Scans

This method uses the Top view (of the project) as a Projection Plane regardless of what is displayed in the 3D View. Its
Normal is parallel to the Z-Axis of the current frame of the project. Its Position is the Origin or barycenter of the Projection
Plan.

To generate a Key Plan from TZF Scans:
1. Select either a project(1) or a station(2) or a TZF Scan(3).

2. Select Generate Key Plan From TZF Scans in Home > Scan Explorer > Key Plan.

Notes:
n When selecting a project with some TZF format files inside, it is not necessary to be within a specific processing

mode.
n The Generate Key Plan From TZF Scans feature is dimmed when there is no TZF scan in the project.
n You can be in Parallel or Perspective as projection mode.

Note: (1) All TZF Scans (of the project) are used for computing Key Plan. (2) All TZF Scans (of the station) are used for
computing Key Plan. (3) Only that TZF Scan is used for computing Key Plan.

Note: A filter is applied on the X, Y and Z directions when generating a Key Plan from TZF Scans in order to remove para-
site points.

12.2.2 Generate Key Plan from Current View

This method uses the current camera view as the Projection Plane. Its Normal direction is perpendicular to the plane of the
screen. Its Position is the Origin or barycenter of the Projection Plan.

To generate a Key Plan from the current view:
1. Display a point cloud in the 3D View.
2. Rotate the scene to specify the point of view from which you want to create a Key Plan.

3. Select Generate Key Plan From Current View > Home > Scan Explorer > Key Plan.

Note: This feature is dimmed if there is no point cloud displayed in the 3D View.

Caution: You need to display only clouds from a single project. Otherwise an error message appears.

If you are in the Perspective projection mode, a warning dialog opens and warns you that the project mode has to be
changed to Parallel to be able to process the Key Plan generation.

If you choose No, the process is then aborted. If you choose Yes, the projection mode changes then during the operation
and takes back its state once finished.
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When you load a file (of the following formats (SIMA and TXT with Topopoints)) that was never saved in the RealWorks
format; the Registration processing mode is set by default. When you load a file, saved in the RealWorks format and in the
Registration processing mode, that file will be opened with that processing mode.

When you are out of this processing mode and you need to use it, you have to choose Registration from the Quick Access
Toolbar,

You may meet the following message “The Survey Configuration load state will be kept in the Registration configuration. Do
you want to save the previous Registration configuration load state?”.

The Registration module includes a broad range of tools. Some are basic tools, like e.g. the Auto-Extract Targets and Tar-
get Analyzer features. By using them, you can quickly register a project and analyze the results. Some are advanced tools,
like e.g. the Auto-Register Using Planes, Refine Registration using Scans, etc. feature. By using them, you can register the
scan data quickly and automatically without having to place targets, and refine the registration.

Note: Tools are grouped according to their functionality, no matter the layout chosen by the user.

13.1 SCAN-BASED REGISTRATION TOOLS

The "Scan-Based Registration" group, as its name indicates, gathers a set of tools offering the ability to register a dataset
based on its point clouds. This group can be found in the group named above on the Registration tab.

13.1.1 Auto-Register Using Planes

The Auto-Register Using Planes feature automatically registers leveled scans of structured environments, i.e. that contain
a significant amount of predominantly flat walls. It automatically extracts all the main planes (walls, ground, ceiling, etc.),
matches them automatically between scans and uses them to register the scans.

Warning:Make sure the amount of memory (RAM) is enough when you launch the Auto-Register Using Planes feature on
a huge dataset. You need about 90 Mb per TZF Scan.

13.1.1.1 Open the Tool

To open the tool:
1. Select at least two stations, a group (or set of groups)(1), or a project(2) created from TZF format file(s) from the

Scans Tree.

2. Select Auto-Register Using Planes in Registration > Scan-Based Registration. The Auto-Register Using Planes
dialog is displayed.

13
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n The Reference Station (or Reference Group) is in bold.
n None of the stations (or groups) is selected. By default, all of the stations (or groups) are checked.
n If required, use to select (CHECKED) all of the stations (or groups) from the tree.
n If required, use to unselect (UNCHECKED) all of the stations (or groups) from the tree.
n In the case of groups only, all of them are collapsed by default.
n If required, use (or ) to expand all groups (or a unique group) from the tree.
n If required, use (or ) to collapse all groups (or a unique group) from the tree.
n Select a station from the tree. It is highlighted. If there is a unique TZF Scan within (the selected station), its pre-

view is displayed in the dialog as shown below. If there are several TZF Scans within, the preview of the Main
TZF Scan is displayed.

n You can select several stations (from the tree) by using the Ctrl (or Shift) key combined with the left clicking. No
preview is displayed.

n Check all of the stations you need for your registration and uncheck those that are not necessary.
Notes:

n (1) With at least two stations inside a group. Otherwise, if there is only a unique station in a group, the tool is grayed-
out.

n (2) With several stations, a unique group or a set of groups. Otherwise, if the project has only a unique station
within, the tool is grayed-out.

If the input does not contain at least two valid stations (with TZF Scan within), a warning dialog is displayed and the Auto-
Extract Targets tool is not launched anymore.
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Tip: If stations are gathered into a group, start by auto-registering first the stations within the group together. Then once the
stations within the group(s) have been registered, auto-register all groups together.

Note: If there is no TZF format file in one of the selected stations, the station is automatically removed from the auto-regis-
tration process.

13.1.1.2 Reference Station

The Reference Station is the one whose position and orientation remain unchanged through the Auto-Register Using
Planes process. If a project (or a set of stations) has been selected as input, the first station from the set of stations (or from
the project) is the default Reference Station. If a leveled station has been chosen as input, this station is by default Refer-
ence Station.

To choose a reference station:
1. Click on the Selection List pull-down arrow.
2. Choose a station from the drop-down list.

n If a project has been selected as input, all stations (of the project) are in the Selection List.
n If a set of stations has been selected as input, only the selected stations (of the set) are in the Selection List.

Note: If a set of stations has been selected as input, the first selected station is by default the Reference Station. The order
(or selection) is preserved.

Caution: After clicking OK in the Auto-Extract and Register dialog, if the station selected as Reference Station is not a
Leveled Station, an error message appears and prompts you to change the selection. Close the Error message. The
Leveled Station is automatically set as Reference Station in the dialog.

Tip: RealWorks can differentiate a station from a group (of stations). A group is flagged as "(Group)" in the Auto-Register
Using Planes dialog.

13.1.1.3 Register Stations

To register stations:
1. In the Auto-Register Using Planes (Target-Less) dialog, click Start. Stations are then registered together*.
2. If stations can be registered together, the Registration Report dialog opens.
3. In the Registration Report dialog, do one of the following:

n Click Save In RTF. The Registration Report dialog opens.
Or

n Click Close. The Registration Report dialog closes. An Auto-Registered Group is created and rooted under the
Scans Tree.
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An Auto-Registered Group is a group gathering the stations selected for the Auto-Register Using Planes pur-
pose. We distinguish two different groups, one called Reference and the other Secondary. Basically an Auto-
Registered Group (Reference) is a group that contains stations registered together and for which one of them is
registered with a station chosen as the Reference Station. An Auto-Registered Group (Secondary) is a group
with stations registered together and any of them cannot be registered with the Reference Station. An Auto-
Registered Group (Reference) can contain a sub-group which is also an Auto-Registered Group (Reference).
This occurs when both share the same Reference Station.
Stations that cannot be registered with the others are put under a folder named "Non-Registered Stations".

1 - Group with registered stations among
which one of them is a Reference Station

2 - Group with stations for the registration
with the Reference Station failed
3 - Group containing all stations that can-
not be registered with others

And/or
n If the Generate a Preview Scan option has been checked, the Registration Report dialog remains open.

Sampled scans are then created. Again in the Registration Report dialog, click OK. The Registration Report dia-
log closes.
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A - Common parts of the clouds are not yet superimposed B - Common parts of the clouds are superimposed

4. If stations cannot be registered together, an error dialog opens and suggests you to try the Cloud-Based Regis-
tration tool.

Note: (*) The user can abort the registration (of stations) in progress by clicking Esc. A dialog opens and prompts you to
abort or not.

Note: Stations with several TZF Scans within, for which the registration with the Reference Station fails, are put all together
under the "Non-Registered Stations" folder.

13.1.1.4 Registration Report

The Registration Report dialog lists for each station (of the selection) the following information:
n Howmany station(s) each of them is registered with and the name of each.
n The deviation in a pair registered stations in the current unit of measurement.

The purpose of the Auto-Register Using Planes (Target-Less) feature is to register stations based on planes (paired
together). The accuracy of two stations registered together is given by the Cloud-to-Cloud Error. This error is an
average distance between paired planes (of one station) and the point cloud (of the other station). The Cloud-to-
Cloud Error in a pair (of registered stations) is the same from one direction to the other (e.g. from Station_A to Sta-
tion_B or from Station_B to Station_A).
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1 - Cloud-to-Cloud Error from Station_A to
Station_B

2 - Cloud-to-Cloud Error from Station_B to
Station_A

n The amount of Coincident Points per pair (of registered stations) is in percentage. The percentage in a pair (of
registered stations) is the same from one direction to the other (e.g. from Station_A to Station_B or from Station_B
to Station_A).

1 - Common points from Station_A to Sta-
tion_B

2 - Common points from Station_B to Sta-
tion_A

Note: An Overall Cloud-to-Cloud Error (from all the station errors) is displayed at the bottom left corner of the Registration
Report dialog. This Overall Cloud-to-Cloud Error allows weighting of each station error with respect to their overlap per-
centage.

A new column, named Confidence, has been added in the Registration Report dialog. This Confidence, applied to a pair of
stations, is expressed in percentage. It is the ratio between Coincident Points and Occlusion, in terms of distance.
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All Confidence rates, below 90%, have a red warning beside them. This does not mean that the results are wrong. It is
an indication that the results should be analyzed more closely.

13.1.1.5 Save in RTF Format

You can save the Auto-Register Using Planes result in a report in RTF format.

To save in RTF format:
1. In the Registration Report dialog, enter a name for the report file in the File Name field.
2. Find a location where you want the report file to be stored.
3. Click Save. The Registration Report dialog closes.

Note: An Overall Cloud-to-Cloud Error (from all the station errors) is displayed at the beginning of the file, just before the list
of stations. This Overall Cloud-to-Cloud Error weights each station error with respect to their overlap percentage.

Note: The Confidence column has been also added to the RTF report. No red warning appears next to the Confidence
value.

13.1.1.6 Options

There is one option that comes after the registration (of stations). If it has been chosen, the related process is then per-
formed, otherwise nothing occurs.

13.1.1.6.1 Generate Preview Scans

The Preview Scan option creates a Scan by first getting points, not based on a TZF Scan but from its Preview, and by com-
puting Normals on them. A Scan is always named Preview. The number of points for each is about two million points.

To generate preview scans:
n Check the Generate a Preview Scan option.

Notes:
n If several stations have been selected as input, a set of Scans (one per station) are created in batch mode, one after

the other.
n When you interrupt the Generate a Preview Scan step by pressing Esc, a dialog opens and prompts you to abort or

not.

Notes:
n You may not see anything happen in the 3D View if the option is not checked.
n The Generate a Preview Scan step is an optional step. If the Generate a Preview Scan option has been checked,

you will prompt to save the current project in the RealWorks database, if it is not yet saved. If the option has been
kept unchecked, no prompt appears.

Tip:When you create from several TZF Scans within a station, all Scans (in that station) do not have the same color. Each
has its own color.

13.1.2 Cloud-Based Registration

The purpose of this tool is to register two selected scanning stations (or two station groups). The user has the choice
between using an automatic method or picking a pair of points from both the point clouds to initialize the registration. Then
the software can refine this registration by using the common parts of the two point clouds. The registration error will be
shown as an average distance between the two point clouds. The user can also check the registration results visually by
using the Registration Visual Check tool. The Cloud-Based Registration tool is available only in the Registration module. In
order to use this tool, you should select at least a set of two stations from the ScansTree.

13.1.2.1 Open the Tool

You have to select two different items from a single project from the Scans Tree. The following combinations are allowed:
two groups of stations, two stations or one group of stations and one station. The input (of the tool) can be also a single
group (with stations inside).
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To open the tool:
1. Select two different items from the Scans Tree.

2. Select Cloud-Based Registration in Registration > Scan-Based Registration. The Cloud-Based Registration dia-
log opens.

13.1.2.2 Select Two Clouds

The first selected station becomes a Reference Cloud. Its name is highlighted in the Reference Cloud field. The second
selected station is a Moving Cloud. Its name is displayed in the Moving Cloud field. The number of points of each are dis-
played in the dialog. The Reference Cloud (or Moving Cloud) has a specific representation which can be seen when you
drop down the Reference Cloud list (or the Moving Cloud list).

1 - Reference Cloud 2 - Moving Cloud

Caution: The leveling status of the input stations in the reference group may affect the registration result when using either
the automatic method, or the manual method, or when performing a refinement after an initial registration. Ideally and for a
good result, the reference group should contain at least a leveled station. If the aforementioned condition is not met, i.e., the
reference group has no leveled station and the moving group has some unleveled stations, RealWorks cannot apply any
rotation to the Z axis of the unleveled stations and displays an error message to warn the user that he performs the regis-
tration if he desires but the result cannot be as good as it should be.

The 3D View is split into three sub-views, two sub-views side-by-side and one sub-view below. The left sub-view is sur-
rounded by a frame in red. It displays the Reference Cloud. The right sub-view is surrounded by a frame in green. It dis-
plays the Moving Cloud. The two clouds keep the rendering that they had before entering the tool. If you change the current
rendering option for a new one, it will be changed for the two clouds. The bottom sub-view displays the registration result
between the Reference Cloud and the Moving Cloud, respectively in red and in green. Only one sub-view can be active at
once. As the default layout is three sub-viewers; you can use the View Manager to display in one full view window or to
switch from one sub-view to another.
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You are directly in the picking mode after entering the tool. When you hover the cursor over a sub-view, e.g. the bottom
one, its size switches, from small to large. When you hover the cursor over one of the side-by-side sub-views, the size of
both switches, from small to large, and so on.

You can manually resize each of the sub-views. Be aware that the new sizes, become at first persistent, and then can dis-
able the automatic tilting mechanism of the sub-views. The condition for the mechanism to be enabled is to have the height
of the side-by-side sub-views two times smaller (or higher) than the height of the bottom sub-view. If not, the mechanism is
disabled.

Because the refinement of the registration is based on the common parts of the two selected stations (or groups), you can
use the Segmentation to pre-select these common parts or the Sampling to simplify the clouds for registration refinement.
The Create command for these two tools is disabled. This means that you cannot save the result.

n For either the Reference Cloud or the Moving Cloud, click the Segmentation (or Sampling) icon.
n Inside a top sub-view, select Sampling Reference Points for the Reference Cloud (or Sampling Moving Points for

the Moving Cloud) from the pop-up menu.
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n Inside the bottom sub-view, select Sampling Reference Points and/or Sampling Moving Points) from the pop-up
menu.

Notes:
n The fact of sampling (or segmenting) the Reference Cloud (or Moving Cloud) updates the number of points (of the

Reference Cloud (or Moving Cloud)).
n When a group of stations has been selected as input, all scans of the group are displayed. The number of Points is

the sum of all points of all scans.

Caution: The number of points for the Reference Cloud (or for the Moving Cloud), in the case of a group (or a station) with
a large amount of points, depends on the loading state defined in the status bar. Refer to the Point Loading Manager
chapter for more information.

Note:When the Moving Cloud is too far from the Reference Cloud, i.e. more than 10 km, a warning, as illustrated below,
appears.

At the same time, the bottom sub-view which displays normally the registration result between the Reference Cloud and the
Moving Cloud, respectively in red and in green is empty of contents.

If you choose Yes, the Moving Cloud is moved close to the Reference Cloud. Both the clouds appear in the bottom sub-
view. If you choose No, nothing will be done.

13.1.2.3 Register Clouds Automatically (Guess)

You are able to register two stations or groups of stations automatically without picking points thanks to the Guess fea-
ture. An automatic algorithm determines a coarse transformation for aligning both stations/groups. It assumes that the Z
axis is not so far from the vertical in both stations/groups, thus only a 2D transformation is required.

The requirements for the feature to register with success are:
n The stations need to be levelled (or near to).
n There is enough information on the "Reference".
n There is enough overlap between the sets of data.

The registration may fail:
n When the sets of data have not enough overlap and/or not enough density at the good place one dataset compared

to the other similar place on the other dataset.
n If the datasets have a lot of similar potential areas to match without discriminant places, e.g. in an indoor situation

with a lot of rooms but without furniture insides. More the "Reference" grows, the more mistakes there are.
n If the Z axis is far from the vertical.

After the automatic registration, you can decide:
n If the result is good, to keep and save the result in the database (see Save the Registration Result).
n If the result is good enough, to make a refinement (see Refine Automatically the Registration).
n If the result is not good, to make manual corrections by picking points (see Register by Picking Points) or using the

manipulators (see Refine Interactively the Registration).

Tip: You can use the G shortcut key instead.

Note: An error message appears in case there are not enough points to compute a reliable registration.
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13.1.2.4 Register Clouds by Picking Points

The registration by picking points feature uses a smart algorithm which lets you obtain the best registration result with the
minimum of points. You have to start picking a complete pair of points, one point per top sub-view. The registration is then
run. If the result is not good enough, you can proceed to complete the first pair of points with a new pair. If the result is not
good enough again, you can then complete the previous pairs with a new pair, but you cannot overrun three pairs.

The picking is done under constraint. If you have picked a point in one of the top sub-view, it is not possible to pick another
point inside the same sub-view. You have to pick the point in the other sub-view.

13.1.2.4.1 Pick the First Pair of Points

To pick the first pair of points:
1. In a sub-view, pick a point on the displayed cloud.
2. Go to the other sub-view.
3. Pick another point on the displayed cloud.

Once the first pair of points has been picked, the registration algorithm is then run. The result is displayed on the bot-
tom sub-view. At the same time, a tool-tip is displayed to show that a registration has been computed. You can
check the quality of the registration based either on the clouds that are superimposed or the computed error (see
Check the Quality of the Registration). If the result is not good enough, you can return to the top sub-views in order
to continue picking a new pair of points and improve the current registration.

Note: You can cancel the registration by selecting Undo. This brings you back to the state you are in before picking points.

Caution: To help you to easily pick points, you can lock each sub-view from rotating by selecting Screen Rotation from
the 3D View / Mode menu. Be aware that the view merged from the two sub-views is not locked anymore.

13.1.2.4.2 Pick the Second Pair of Points

To pick the second pair of points:
1. In a sub-view, pick a point on the displayed cloud.
2. Go to the other sub-view.
3. Pick another point on the displayed cloud.
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Once the second pair of points has been picked, the registration algorithm is again run and the result is again shown
on the bottom sub-view. If the result is not again good enough, you can switch again to the top sub-views in order to
pick the third pair of points and improve the current registration.

Note: You can cancel the registration by selecting Undo. This brings you back to the one point picking state.

Caution: To help you to easily pick points, you can lock each sub-view from rotating by selecting Screen Rotation from
the 3D View / Mode menu. Be aware that the view merged from the two sub-views is not locked anymore.

13.1.2.4.3 Pick the Third Pair of Points

To pick the third pair of points:
1. In a sub-view, pick a point on the displayed cloud.
2. Go to the other sub-view.
3. Pick another point on the displayed cloud.
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Once the third pair of points has been picked, the registration algorithm is run and the result is shown on the bottom
sub-view. A tool-tip is displayed to show you that a new registration has been computed. If the result is not good
enough, you can proceed from the beginning until you get a result.

Note: You can cancel the registration by selecting Undo. This brings you back to the two point picking state.

Caution: To help you to easily pick points, you can lock each sub-view from rotating by selecting Screen Rotation from
the 3D View / Mode menu. Be aware that the view merged from the two sub-views is not locked anymore.

13.1.2.4.4 Delete the Last Picked Point/Pair of Points

If a pair is complete, i.e., one point per top sub-view. You can remove them from the sub-views by using . If a pair is incom-
plete, two points in e.g. the left sub-view and one in the right-view. The last picked point (in the left-view) is removed.

13.1.2.4.5 Delete all Picked Points

You can easily remove all the picked points from the two top sub-views by using . There is no requirement that the points
have been paired.

13.1.2.5 Refine Automatically the Registration

You can now refine the initial registration, if necessary. The refinement uses an iterative method. So you can perform sev-
eral iterations to improve the results.

To refine automatically the registration:
1. Click the Refine button to refine the result.
2. If required, click again Refine until you obtain the best registration result.
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Note: You can use the F shortcut key instead.

13.1.2.6 Refine Interactively the Registration

You can use the Interactive Pan, Interactive Rotation and Change Manipulator Center features to refine the registration of
the Moving Cloud with the Reference Cloud, by manually adjusting its position and/or its orientation. By default, none of the
features is selected after entering the tool. Once you have chosen one, it becomes persistent and remains selected until
you disable it or you select another one.

When the first pair of points has been picked and one of the features, like e.g. Interactive Pan, has been chosen before pick-
ing, the manipulator will then be positioned on the first picked point of the pair.

Tip: You can choose Interactive Pan or Interactive Rotation or Change Manipulator Center from the pop-up menu.

13.1.2.6.1 Pan the Moving Cloud

To pan the moving cloud:
1. Click the Interactive Pan icon.

n AManipulator appears, not in the global coordinate system but in the local coordinate system of the Moving
Cloud. It has the center of the Moving Cloud as the center .

n This manipulator has three secant Axis Handles, each with its own color (red, green and blue). In addition to the
handles, you can find three Plane Handles.

n At the same time, the Change Manipulator Center icon becomes enabled.
2. Pick an Axis Handle. It turns yellow. The direction along which you can displace the Moving Cloud is highlighted in

yellow. Those for which you cannot are in mauve.
3. Move the Moving Cloud along that direction.
4. Pick a Plane Handle. It turns yellow. The plane in which you can displace the Moving Cloud is highlighted in yellow.

Trimble RealWorks User Guide | 305



REGISTRATIONMODE

5. Move the Moving Cloud in that plane.

Tip: You can deselect the Interactive Pan by pressing Esc.

Tip: You can easily switch from Interactive Rotation to Interactive Pan, and vice versa, by just picking one of the Handles.

Note that the cursor changes to when you hover it over a Handle.

13.1.2.6.2 Rotate the Moving Cloud

To rotate the moving cloud:
1. Click the Interactive Rotation icon.

n AManipulator appears, not in the global coordinate system but in the local coordinate system of the Moving
Cloud. It has as center the center of the Moving Cloud.

n This manipulator has three Ring Handles, each with its own color (red, green and blue). You can rotate the Mov-
ing Cloud around an axis passing through the center of a ring and perpendicular to it.

n At the same time, the Change Manipulator Center icon becomes enabled.
2. Pick a Sphere Handle. It turns yellow. The axis around which the Moving Cloud can be rotated is dotted and is in

green.
3. Move the Moving Cloud around that axis.
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Tip: You can easily switch from Interactive Pan to Interactive Rotation, and vice versa, by just picking one of the Handles.

Note that the cursor changes to when you hover it over a Handle.

Note: For a station from a leveled instrument or from an instrument that is leveled and setup over a known point, respect-
ively of blue color and green color in the Scans Tree, you can only rotate it around the Z-Axis of the active coordinate frame.
This is to preserve the leveling information on the station.

Tip: You can deselect the Interactive Rotation by pressing Esc.

Note: You are not able to switch to Interactive Pan by just picking the Handle in this specific case.

13.1.2.6.3 Change the Manipulator Center Location

The default position of a Manipulator, when it appears, is the center of the Moving Cloud.

To change the manipulator center location:
1. Click the Change Manipulator Center Location icon. The cursor becomes a cross. This means that you are in the

picking mode*.
2. Pick a point on the displayed clouds.

Tip: You can use the C shortcut key instead.

Note: (*) To leave the picking mode, you can either press Esc. or click again the Change Manipulator Center Location icon.

Tip: You can set the center of a manipulator to a station position by picking on its related triangle.

13.1.2.7 Check the Quality of the Registration

You can either visually check the quality of the registration in the 3D View because each station (or group of stations) still
remains with each own color* or control the errors displayed in the dialog.

Note: (*) Clouds are always rendered in Red and Green, regardless of the Rendering option(s).

To check visually the result:

You can use this tool to quickly and visually check the quality of the registration, by creating cross sections and specific
areas for analysis. To do so, click the Registration Visual Check button, in Step 3.

To check the error:
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The registration error, in case of a registration, is simply called Error. It expresses the average distance error of the pair(s)
of points, as well as the overlap percentage.

The registration error, in the case of a refinement, is called Refine Error. It expresses the average distance error of the
points present in the common parts of the two clouds, as well as the overlap percentage.

The Error and Refine Error are expressed in the unit of measurement defined in the Preferences dialog.

13.1.2.8 Save the Registration Result

To save the registration result:
1. Drop-down the list above the Apply button.
2. From the list, choose an option among "Do Not Create Group", "Add to the Reference", and "Merge With the Refer-

ence".
3. Click Apply to validate the registration in the database.

n If the "Do Not Create Group" option has been chosen, the selected items are registered together. The "Moving"
item becomes the "Reference" item for the next registration, and the item which comes after the "Moving" item
becomes the new "Moving" item.

n If the "Add to the Reference" option has been chosen, the selected items are registered together. If the "Refer-
ence" item is not a group but a station, a folder named "Registered" is created. The registered items are then put
under the folder. See [A].

If the "Reference" item is a group, the registered items are gathered under that folder. See [B].
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In both cases, the folder remains the "Reference" item and the item which comes after the "Moving" item
becomes the new "Moving" item.

n If the "Merge With the Reference" option has been chosen, the selected items are also registered together (as
for the "Add to the Reference" option), but the "Moving" item is merged with the "Reference" item.

4. Click Close. The Cloud-Based Registration dialog closes.

Note: You can continue to register other stations without quitting the tool. If you use the options above to put the stations
just registered together, you can use it to register with another station. In this way, you can structure the ScansTree in such
a way that it reflects the history of your registration procedure.

Tip: You can use the F5 shortcut key instead.

Note: The "Add to the Reference" option is by default set after entering the tool. If you choose an option from the list, this
option becomes persistent until you change it for another one.

Note: If there is already a "Registered" folder, and you register two new items with the option "Add to the Reference" or
"Merge with the Reference", a new "Registered" folder is then created two the number 2 in parenthesis.

13.1.3 Refine Registration Using Scans

This feature refines the position and orientation of the stations using the scan data. The stations need to be already
registered, at least coarsely, for this function to work successfully. The feature can be run after any registration method
(Auto-Extract Targets, Target-Based Registration, Auto-Register Using Planes, Register Stations With Import RMX Files,
Cloud-Based Registration). It enhances the accuracy of the registration. A report is generated, showing residual errors and
percentage of common points between matched stations. The report can be saved as an RTF file.

When the stations are leveled, the feature keeps this constraint: the stations will remain leveled in the process.

Tip: In some cases, where the scans have a high density and the overlap areas are scanned from a long distance, it may
be possible to obtain an even better accuracy by setting the stations to 'unleveled'.

The stations can contain either a TZF Scan (TZF files) or only regular scans (RWCX files), e.g., as obtained by extracting
points from a TZF Scan or by importing ungridded scan files. The feature uses two different algorithms to refine the regis-
tration parameters, and automatically chooses which algorithm to use depending on the stations:
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n If your project contains only TZFScan(s) for each station, the feature launches an algorithm that uses the TZF files.
n If your project contains only RWCX files, the feature launches another algorithm that uses RWCX files.
n If your project contains both TZFScan(s) for each station and RWCX files, the TZF algorithm is launched (TZF has

the priority).
n If your project contains RWCX and only some TZF, the RWCX algorithm is used.

13.1.3.1 Open the Tool

To open the tool:
1. Select at least two stations or a group (or a set of groups)(1), or a project(2)) from the Scans Tree.

2. Select Refine Registration Using Scans in Registration > Scan-Based Registration.
n If a set of stations has been selected, the Refine Registration Using Scans dialog opens.
n If a project has been selected, a dialog opens and prompts you to process with all stations (or not). Click Yes.

The dialog closes and the Refine Registration Using Scans dialog appears.

Notes:
n (1) With at least two stations inside a group. Otherwise, the feature is grayed-out.
n (2) With several stations, a unique group with at least three stations or a set of groups. If the project has a unique sta-

tion within, the feature is grayed-out.

Warning: By principle, the Refine Registration Using Scans feature does not refine within groups. If there are some groups
in your input, a warning appears and prompts you to continue or to abort the process. If you choose Yes, the refinement will
be performed between the groups, by using the proper stations in them. This is visible in the report, where only the stations
from different groups will be matched.

Warning: If the input does not contain at least two valid stations, i.e. with valid TZF Scans or regular scans, a dialog opens
and the feature cannot be run.

13.1.3.2 Choose a Reference Station

The Reference Station or Reference Group is the only station or group whose position and orientation remain unchanged
along the Refine Registration Using Scans process. If a project (or a group of stations) has been selected as input, all sta-
tions (of the project) (or of the group) are in the selection list and the first station (from the list) is chosen to be the reference.
If there are some leveled stations, the first of them will be chosen to be the reference by default.

To choose a reference station:
1. Click on the Selection List pull-down arrow.
2. Choose a station (or a group) from the drop-down list.

n The selected station (or group) has its name displayed in the Reference Station field.
n It is in bold in the selection list.
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Caution: If the selection contains some leveled stations and the station selected as Reference Station is not leveled, an
error message appears and prompts you to change the selection. If you wish to use an unleveled station as reference, you
can set all the selected stations to unleveled (by using Registration / Modify Station / Force Unleveled).

13.1.3.3 Select a Subset of Stations for the Refinement

When working with groups containing many stations, the refinement on all stations can be computationally expensive, and
hence time consuming. In the dialog, you can choose a subset of stations to run the computation on. Typically, you may
want to choose the stations that have some overlap with the other groups. The refinement is then applied to the whole
group, but the computation can be much faster.

To select a subset of stations for the refinement:

1. Click the Clear Selection icon to un-select (UNCHECKED) all the stations (or groups) in the selection list.
2. In the case of groups only, all are by default not collapsed.
3. Click the Expand All icon (or ) to expand all groups (or a unique group) in the selection list.
4. Select a station (or a group of stations) from the selection list. It is highlighted.

n If the selected station has a TZF Scan within, its preview and its name are displayed in the dialog as shown
below.

n If there are several TZF Scans within, the preview of the Main TZF Scan is displayed.
n No preview is displayed in case the selected station has a TZF Scan for which the link to the TZF file is broken.
n In case of a group, the first station (from the group) or the first leveled station (if existed) has its preview and

name displayed.

n If the selected station has no TZF Scan within but only regular scans, no preview and no name are displayed in
the dialog.

5. Check only the stations you wish to include in the computation and leave the others unchecked.

Tip: You can select several stations (from the selection list) by using the Ctrl (or Shift) key with the left clicking. There is no
preview in that case.
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13.1.3.4 Refine the Registration

To refine the registration:

1. Click on the Start button.
n If the selected stations contain only TZF Scans, the links to the TZF files are valid and the TZF files are not miss-

ing, the Refine Registration Using TZF Scans method will be applied to the selection.
n If the selected stations contain only regular scans, the Refine Registration Using Extracted Scans method will be

applied to the selection.
n If the selected stations contain both (TZF Scans and regular scans), and the links to the TZF files are valid and

the TZF files are not missing, the Refine Registration Using TZF Scans method will be applied.
n If the selected stations contain both (TZF Scans and regular scans), and some of the TZF links are broken or

some of the TZF files are missing, the dialog below opens:

a. Click Yes. The Refine Registration Using Extracted Scans method will be applied.
b. Or click No. No refinement will be applied.

n If the selected stations contain both (TZF Scans and regular scans), and some TZF links are broken or/and TZF
files are missing or/and some regular scans are missing, an error message appears:

n Click OK. No refinement will be applied.
2. If required, press Esc. to abort the refinement in progress. A dialog opens and prompts you to abort or not.

13.1.3.5 View the Registration Report

Once the refinement has been applied, a report opens. It is named Report Registration (Using TZF Scans) if the method on
TZF Scans has been applied and Report Registration (Using Extracted Scans) if the method on the regular scans has been
applied.

To view the registration report:
1. In the Registration Report dialog, verify the refinement results:

For each station (of the selection), the table shows:
n The name of the station(s) it has been matched with. In the case of the algorithm on the regular scans, this con-

sists of a single station (pairwise refinement).
n For each pair of stations, the Cloud-to-Cloud Error and Coincident Points percentage - in the current unit -, and

the Confidence level.
The Cloud-to-Cloud Error is the root mean square of the point-to-point distances on the overlapping areas. It is
computed from the distances between individual points in the first scan to their corresponding scan point in the
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second scan. The error is symmetrical: it has the same value from Station_A to Station_B as from Station_B to
Station_A).

1 - Cloud-to-Cloud Error from Station_A to
Station_B

2 - Cloud-to-Cloud Error from Station_B to
Station_A

The Coincident Points value is the amount of common points per pair (of registered stations) is in percentage.
The percentage in a pair (of registered stations) is the same from one direction to the other (e.g. from Station_A
to Station_B or from Station_B to Station_A).

1 - Common points from Station_A to Sta-
tion_B

2 - Common points from Station_B to Sta-
tion_A

The Overall Cloud-to-Cloud Error (from all the station errors) is displayed at the bottom left corner of the Regis-
tration Report dialog. This Overall Cloud-to-Cloud Error is the average of the errors on all the station pairs.
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This Confidence value gives an idea of how reliable a pair is. It is expressed in percentage. All Confidence rates,
below 90%, have a red warning beside them. This does not mean that the results are wrong. It is an indic-
ation that the results may require a closer analysis.
Note: The Confidence level resulting from a refinement, for which the input stations have unknown position, can-
not be trusted.

2. Click Save In RTF. The Registration Report dialog opens.
3. Click Close. The Registration Report dialog closes.

13.1.4 Orientation

The Orientation provides the user with tools to easily orientate a 3D scene after it has been locally registered. It is assumed
that, in most cases, the instrument (used to acquire the 3D scene data) is leveled, and the Z axis is correct. The Orientation
then allows orienting the scene in 2D in order to re-define the X and Y axis.

13.1.4.1 Open the Tool

To open the tool:
1. Perform a display in the 3D View.
2. Select Orientation in Registration > Scan-Based Registration. The Orientation toolbar appears.

1 - Define Vertical Axis
2 - Define Horizontal Axis by Picking Two Points
3 - Automatic Rotation Definition

4 - Rotate 90° counterclockwise
5 - Pick Origin
6 - Apply Transformation
7 - Close Orientation Tool

n The 3D scene is locked in a 2D plane in the Top view (in the XY plane) with a 2D grid superimposed (if not hid-
den previously).

n A temporary yellow frame appears:
n If only one station is displayed in the 3D View, the origin of the yellow frame is the origin of the station.
n If several stations are displayed in the 3D View, the origin of the yellow frame is the origin of the last station

(from the project).
n If several stations (with a TZF scan in each) are registered and displayed in the 3D View, the origin of the yel-

low frame matches the origin of the Reference Station.

Note: All the features present in the Orientation Tool toolbar can also be reached from the pop-up menu.

Caution: You can enter in the tool without displaying anything in the 3D View. But this has no sense because most of the
tools (in the Orientation Tool) are based on picking the object(s).

Note: There is no way to unlock the 3D scene from the 2D lock after entering the tool. Once you are in the 2D lock position,
you can only Pan in the YZ plane, Zoom In (or Out) along the Z axis or Rotate around the Z axis.

Caution: The frame transformations cannot be applied to a project linked to remote datasets (those extracted from Trimble
Scan Explorer) (or to remote projects). When you attempt to perform such operations, an error dialog appears.

Note: A warning appears in the case the current frame is not the Home frame.

13.1.4.2 Set the Vertical Orientation of a Scene
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The Define Vertical Axis feature, from the Orientation toolbar, lets the user define the vertical orientation (Z-Axis) of a
non-leveled scan dataset, especially for structured environments like buildings, e.g., indoor environments. Two tools, inde-
pendent but complementary, are available.

To set the vertical orientation of a scene:
n Click the Define Vertical Axis icon. The Define Vertical Axis toolbar opens and the 3D scene is free from the 2D

lock. The 2D Grid is hidden (if not hidden previously).

1 - Automatic Vertical Axis Definition
2 - Define Vertical Axis by Picking Two Points

3 - Apply Transformation
4 - Close Vertical Axis Definition Sub-Tool

Note: A warning appears in case a leveled station has been selected as input. If you wish to modify the vertical orientation
of a station, you need to set the station to unleveled (from the Registration / Modify station / Force Unleveled menu) before
entering in the tool.

13.1.4.2.1 Define Automatically the Vertical Axis

The Automatic Vertical Axis Definition is an automatic method for defining the vertical orientation of a scene. It is inten-
ded to be applied to a set of data of structured environments like buildings or indoor environments, etc. The algorithm
behind this method uses the hypothesis that the initial orientation of the dataset is not so far from the real vertical. This
means that the instrument, required to acquire the dataset, is not leveled anymore and its inclination compared to the ver-
tical should be not more than S0 degrees. The automatic method, when chosen, will be applied not only to the stations dis-
played in the 3D View, but to the entire project. This is useful in case of a project with both indoor and outdoor scans, as the
computation will be carried out only on the indoor scans.

Note: The automatic method is based on normal vectors, i.e., it will not work if normals are not available and a warning mes-
sage will appear.

13.1.4.2.2 Define the Vertical Axis by Picking Two Points

To define the vertical axis by picking two Points:

1. Click Define Vertical Axis by Picking Two Points . The cursor changes as follows *. The Picking Parameters
toolbar appears in the 2D constraint mode. The yellow frame disappears from the 3D View.

2. In the 3D View, pick two 3D points on a vertical structure like e.g. a wall.
n The first point should be on the bottom of the vertical structure
n The second point should be on the top of the vertical structure.
n Both points define the Z-Axis of the temporary frame.
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n The temporary frame reappears in the 3D View. It remains unchanged in position but not in orientation. Its Z axis
is then parallel to the picked axis.

n The 3D scene is then locked again the XY plane of the temporary frame.
Notes:

n To leave the picking mode, press Esc.
n Picking should not be necessary on the displayed object.

Tip: To render the selection of points easier, we recommend that you switch to the Based-Station mode.

13.1.4.2.3 Apply the Transformation

To apply the transformation:

1. Click the Apply Transformation icon.
2. Or press Enter. A dialog opens and prompts you to apply the transformation to the Home Frame.
3. Click Yes. All coordinates of the current project are then modified. The Define Vertical Axis toolbar closes.
4. Or click No to not apply. The Define Vertical Axis toolbar remains open.

13.1.4.3 Set the Horizontal Orientation of a Scene

Once the vertical orientation has been defined, the X and Y axes are automatically computed to obtain an orthonormal
frame. If you are not satisfied with the result, you can easily refine or redefine the X and Y axes using the features described
in the below topics.
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13.1.4.3.1 Define the Horizontal Axis by Picking Two Points

To define the horizontal axis by picking two points:

1. Click Define Horizontal Axis by Picking Two Points . The cursor changes as follows *. The Picking Para-
meters toolbar appears in the 2D constraint mode. The yellow frame disappears from the 3D View.

2. Pick a 3D point in the 3D View.
3. Pick another 3D point in the 3D View.

n The two picked points define an axis.

n The 3D scene is then rotated (in the XY plane and around the Z axis of the current frame) so that this axis
becomes horizontal.

n The yellow frame reappears in the 3D View. It remains unchanged in position but not in orientation. Its X axis is
then parallel to the picked axis.

Notes:
n (*) To leave the picking mode, press Esc.
n Picking should not be necessary on the displayed object.

13.1.4.3.2 Automatic Axis Definition

The Automatic Axis Definition feature allows the user to find the correct orientation based on the Normal X, Normal Y and
Normal Z information that are in the displayed point cloud.

To automatically define the axis:
n Click the Automatic Axis Definition icon.

13.1.4.4 Rotate Counterclockwise 90°

To rotate counterclockwise 90°:
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n Click Rotate Counterclockwise 90° . The whole 3D scene is then rotated 90° counterclockwise. The yellow frame
remains unchanged in position and in orientation.

13.1.4.5 Pick the Origin

The Pick Origin feature allows the user to associate a picked point with a Known Point.

To pick the origin:

1. Click Pick Origin . The cursor changes as follows *. The Picking Parameters toolbar appears in the 3D con-
straint mode

2. Pick a 3D point in the 3D View. The Define Origin dialog opens. The 3D coordinates of the picked point are dis-
played in the Picked 3D Point field. The values in this field are not editable.

3. Input Known Point coordinates in the New Coordinates field.
4. Click OK. The Define Origin dialog closes. The origin of the yellow frame is then moved to the picked point.

Notes:
n (*) To leave the picking mode, press Esc.
n Picking should be on the displayed cloud. You may hear a warning sound when picking an empty point.

Tip: You can select the 3D coordinates that appear in the Picked 3D Point field (after picking a point).

13.1.4.6 Apply the Transformation

To apply the transformation:

1. Click Apply Transformation .
2. Or press Enter. A dialog opens and prompts you to apply the transformation to the Home Frame.
3. Click Yes. All coordinates of the current project are then modified. The Orientation toolbar closes.
4. Or click No to not apply. The Orientation toolbar remains open.

13.1.4.7 Close the Tool

To close the tool:

1. Click Close Orientation Tool .
2. Or press Esc. A dialog opens and prompts you to save the new orientation or not.
3. Click Yes to apply.
4. Or click No to not apply.

13.1.5 Registration Report (Scan-Based)

This feature lets you recompute the Registration Report once TZF Scans are registered together. Within the feature, no
extraction (of points) is permitted, only a recomputation of the Registration Report is done if a new selection of the Refer-
ence Station (or Group) is requested. This feature has the same input requirements as Auto-Register Using Planes.

To create a scan-based registration report:
1. Select at least two stations, a group (or set of groups), or a project (with TZF Scan within) from the Scans Tree.

2. Select Registration Report (Scan-Based) in Registration > Scan-Based Registration. The Registration Report
(Scan-Based) dialog opens.
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n The Reference Station (or Reference Group) is in bold.
n None of the stations (or groups) is selected. By default, all of the stations (or groups) are checked.
n If required, use to select (CHECKED) all of the stations (or groups) from the tree.
n If required, use to unselect (UNCHECKED) all of the stations (or groups) from the tree.
n In the case of groups only, all of them are collapsed by default.
n If required, use (or ) to expand all groups (or a unique group) from the tree.
n If required, use (or ) to collapse all groups (or a unique group) from the tree.
n Select a station from the tree. It is highlighted. If there is a unique TZF Scan within (the selected station), its pre-

view is displayed in the dialog as shown below. If there are several TZF Scans within, the preview of the Main
TZF Scan is displayed.

n You can select several stations (from the tree) by using the Ctrl (or Shift) key combined with the left clicking. No
preview is displayed.

n Check all of the stations you need for your registration and uncheck those that are not necessary.
3. If required, drop-down the Reference Station list.
4. Choose a station (or group) as the Reference Station.
5. Click Start.

13.2 TARGET-BASED REGISTRATION TOOLS

The Target-Based Registration group, as its name indicates, gathers a set of tools offering the ability to register a dataset
based on targets.

13.2.1 Auto-Extract Targets

The Auto-Extract Targets feature allows the extraction of targets from TZF Scans, to match those in common and to
register the stations the extracted targets belong to.

13.2.1.1 Open the Tool
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To open the Tool:
1. Select a station (or a set of stations or a project(1) created from TZF format file(s)(2)) from the Scans Tree.

2. Select Auto-Extract Targets in Registration > Target-Based Registration.
n If a station (or set of stations) has (or have) been selected, the Auto-Extract Targets dialog opens.
n If a project has been selected, a dialog opens and prompts you to process with all stations (or not). Click Yes.

The dialog closes and the Auto-Extract Targets dialog appears.
3. Choose a Target Type.
4. Create sampled scans.
5. Select a Reference Station.
6. Click OK. The Auto-Extract Targets dialog closes.

Notes:
n (1) With a unique station (or a set of stations (or a set of groups)). Otherwise, if the input is a project with only a

unique group, the tool is grayed-out.
n If the input is a group (with a station (or a set of stations)), the tool is grayed-out.

If there is no TZF format file in one of the selected stations, a dialog opens and asks you if you wish to continue with the
remaining station(s). Choosing "No" will leave the tool.

If there is no TZF format file inside the whole selection, a warning message appears with the text "No TZF Scan found in
selected stations".

Note: (2) If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog opens and prompts
you to proceed to do so.

A warning message appears in the Auto-Extract Targets dialog when one of the selected stations has a Level 3 Scan
within.
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Note: You need to have at least one Target Type checked to enable the OK button. Otherwise, it remains dimmed.

Note: All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

13.2.1.2 Choose a Target Type

You can extract two types of target: Spherical Target or Black andWhite Flat Target.

To choose a Target Type
1. Check both options: Spherical Target and Black andWhite Flat Target.
2. Or only check one type.
3. If Spherical Target has been checked, the Diameter field becomes enabled.
4. Input a value in the Diameter field according to the type of sphere you used during data acquisition.
5. Or click on the Diameter pull-down arrow.
6. And choose a value from the drop-down list.

n There are five predefined diameters: 76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm.

Tip: The current unit of measurement is in Millimeters. You do not need to enter "mm".

Note: Extracted targets are created in the database as Spherical Targets (or Black andWhite Flat Targets) with
Unmatched status. All of them are gathered in the Unmatched folder under the Project node in the Project Tree and each
one is put under its related station. An extracted target is named TargetX where X is an order, whatever its type.

Caution: The minimum distance between two targets should be 200 mm between two centers. The threshold is the same
for Spherical Targets as for Black andWhite Targets.

Note: For targets of spherical type, you need to know their exact diameter. If you enter a diameter (in the dialog) that is dif-
ferent from the diameter of the scanned targets, nothing (or a very small number of targets) will be extracted from the TZF
Scans.

13.2.1.3 Create Sampled Scans

You can create a Scan based on the Preview of a TZF Scan (by getting points from the Preview and computing Normals on
them). A Scan is always named Preview. The number of points for each is about two million points.

To create a sampled scan:
n Keep the Generate a Preview Scan option checked.

Notes:
n If several stations have been selected as input, a set of Scans (one per station) is created in batch mode, one after

the other. You can interrupt each of them by pressing Esc.
n If the Generate a Preview Scan option has been checked, you will be prompted to save the current project in the

RealWorks database, if it is not yet saved. If the option has been kept unchecked, no prompt appears.

Tip:When you create from several TZF Scans within a station, all Scans (in that station) dot not have the same color. Each
has its own color.

13.2.1.4 Select a Reference Station

You have to choose a station from the project (or from the set of stations) and set it as a Reference Station. This means that
the chosen station will be used as a reference (station remaining unchanged) and the other stations as stations to register
with.

To select a reference station:
1. Click on the Reference Station pull-down arrow.
2. Choose a station from the drop-down list.

Notes:
n If a single station has been selected as input, no registration will occur.
n If a project has been selected as input, the first station (of the project) is by default the Reference Station.
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Note: If a set of stations has been selected as input, the first selected station is by default the Reference Station. The order
(of selection) is preserved.

Caution: After clicking OK in the Auto-Extract Targets dialog, if the station selected as Reference Station is not a Leveled
Station, an error message appears and prompts you to change the selection. Close the Error message. The Leveled Sta-
tion is automatically set as Reference Station in the dialog.

Caution: After clicking OK in the Auto-Extract Targets dialog, an error message appears if the input (of the tool) contains a
Topographic Station and the station has not been chosen as Reference Station. Close the Error message. The Topo-
graphic Station is automatically set as Reference Station in the dialog.

13.2.1.5 Register the Stations

To register the stations:
n In the Auto-Extract Targets dialog, click OK.

If there are enough targets inside each station (and at least three in common between two stations), the auto-pair-
ing of targets will be performed and the Target-Based Registration dialog opens.
If the auto-pairing of targets succeeds, you may see the number of paired targets in the Station List of the Target-
Based Registration dialog. For a given station, the Number of Targets is shown as X/Y. Y is the sum of targets and
X is the sum of matched targets. The Adjust button in Step 3 of the Target-Based Registration dialog is dimmed
(because stations are registered). The Registration Details dialog opens automatically with the Station View set by
default.

1 - Reference Station (in bold)
2 - Matched targets in a station

3 - Total of targets (matched and unmatched) in a sta-
tion

If there are not enough targets inside each station and/or if there are no common targets between stations, the auto-
pairing of targets will fail and the Adjust button in Step 3 of the Target-Based Registration dialog is enabled. The
Registration Details dialog is not open.

Note: The Target-Based Registration dialog will not open if the input is a single station.

13.2.2 Target-Based Registration

The Target-Based Registration tool allows you to register a set of stations by using targets. The targets could be those
obtained while scanning, those created manually during a registration, or those obtained by using traditional surveying
instruments such as Total Stations. The registration is based on a least-squares adjustment method using the cor-
responding target observations of each station. A registration report will be created after the registration. You can check the
registration quality based on this report. If any of the targets are out of error tolerance, you can un-validate them and re-per-
form the registration.

Note:Match Leveled Stations With Only two Targets. The matching algorithm used, when starting the tool or when doing
an Auto-Match All in the Registration Details window, can match leveled stations using a minimum of two targets in com-
mon. Please note that the two targets have to be at different heights. If not, then there are two valid solutions. In such a
case, the algorithm will ignore the matching to avoid creating a wrong match.

Note:Match Traverse Network. A survey traverse network is a sequence of leveled stations where all the targets should be
matched to station points. The station points may correspond to known Topo Points or not. The Target-Based Registration
tool can auto-match a traverse network acquired from a Trimble TX series scanner or other vendor's scanners. If using a tar-
get adapter in the field, this can be an automated alternative to using the manual Station Setup tool: there is no need to
measure target and station heights except for the first station.
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Note: Target Matching Behavior in Degenerate Cases of Targets at Same Distance Target-based registration requires pla-
cing targets correctly in the field. In particular, one should avoid degenerate cases like having several targets at equal dis-
tances from each other, since they yield ambiguous configurations with several possible valid solutions. The target
matching algorithm identifies the case of three targets with two equal distances - isosceles triangles -, and chooses the solu-
tion that keeps the stations upward.

Notes: Some Degenerate Cases to Avoid in the Field
n Targets aligned on the same line.
n Repeated patterns, e.g. put targets at regularly placed assets like columns.
n Targets at equal heights
n Avoid isosceles triangles, i.e., targets that have equal distances
n For these reasons, it is always better to place the targets a bit randomly, at varying heights.

13.2.2.1 Open the Tool

To open the tool:
1. Select a station(1), a set of stations, a set of groups or a project(2) from the Scans Tree.

2. Select Target-Based Registration in Registration > Scan-Based Registration.
3. Or perform an Auto-Extract Target and Register.

The Target-Based Registration dialog opens. It is subdivided into three parts. Each corresponds to one step in the
Target-Based Registration process.

Notes:
n (1) Among other stations. Otherwise, if the station is alone in the project, the tool is grayed.
n (2) With a set of stations (or a set of groups). Otherwise, if the project has only a unique station (or group (of sta-

tions) within) the tool is grayed-out.

Notes:
n If the input is a group with a unique station (or a group with a set of stations) within, the tool is grayed-out.
n If the loaded project contains some scans of spherical target type which are not already fitted, RealWorks will

prompt you to automatically fit each of them with a geometry.

Caution: You cannot open the Target-Based Registration tool if the input is only of Topographic Station type.

Notes:
n (1) When a single station has been selected, the whole project is then taken as the entry of the tool and the selected

station becomes the Reference Station.
n (1) You can also select two stations without TZF Scan inside.

Tip: You can also select Target-Based Registration from the pop-up menu.

If you enter into the Target-Based Registration tool with some stations that have already been registered and some not, a
dialog appears and asks to register those that have not yet registered with those that are already.

13.2.2.2 Select a Reference Station

This step consists of fixing a station as a Reference Station. The other station(s) is/are used to be registered with it. If a pro-
ject (or a set of stations) has been selected as input, the first station (of the project) is the default Reference Station. If a
leveled station has been chosen as input, this station is by default Reference Station. If one of the stations is a Topographic
station, i.e. it contains points surveyed by using a traditional surveying instrument; this station is set by default as the Refer-
ence Station.

To select a reference station:

Trimble RealWorks User Guide | 323



REGISTRATIONMODE

1. Click on the pull down arrow of the Reference Station list.

1 - Reference Station (in bold)
2 - Stations displayed in the 3D View

3 - Stations not displayed in the 3D View

By default, all selected stations are put in the Station List window. They are listed not by the order of selection but by
their order (of creation). All of them are not displayed in the 3D View. The Reference Station is in bold.

2. Select a station from the drop-down list.
3. Select and toggle the Reference Station to On. Its representation is shown in the 3D View.
4. Select and toggle another station to On. Its representation is shown in the 3D View.

Note: If there are several Topographic Stations within the project, only one is assigned as the Reference Station.

Caution: If the station selected as Reference Station is not a Leveled Station, an error message appears and prompts you
to change the selection.

Caution: An error message appears if the selection (as input of the tool) contains a Topographic Station and this station
has not been chosen as a Reference Station.

13.2.2.3 Auto-Pair the Targets

A target has two states: Matched or Unmatched. If there are already extracted targets within the input (of the tool) and if
these targets have not yet been paired (Unmatched), all of them are gathered in the Unmatched folder in the Targets Tree
and per station in the Scans Tree.
If there are enough targets inside each station and at least TWO in common between two LEVELED stations (or THREE in
common between two UNLEVELED stations), the auto-pairing of targets will be performed automatically.
Note: If there are enough targets inside each station and at least TWO in common between two REGISTERED groups and
one of the groups is leveled, the matching will be performed automatically.
Note: The feature lets the user register all the stations of a project together even if there are not enough targets in common
between some stations. In the below picture, Station B and Station C share three targets in common, Station C and Station
A two targets only and Station B and Station A only one target in common. Station B and Station C, having three common
targets, will be registered and automatically be put in a group that will be used to register with Station A.
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If the auto-pairing of targets succeeds, you may see the number of paired targets in the Station List of the Target-Based
Registration dialog. For a given station, the Number of Targets is shown as X/Y. Y is the sum of the targets and X is the sum
of the matched targets. The adjustment (of stations) is then performed automatically without user interaction. The Adjust
button (in Step 3 of the Target-Based Registration dialog) becomes dimmed. The Registration Details dialog opens auto-
matically with the Station View set by default.

1 - Reference Station (in bold)
2 - Matched targets in a station

3 - Total of targets (matched and unmatched) in a sta-
tion

If there are not enough targets inside each station and/or if there are no common targets between stations, the auto-pairing
of targets will then fail and the Adjust button (in Step 3 of the Target-Based Registration dialog) is enabled. The Registration
Details dialog is not open. The auto-pairing of targets can also fail even if there are not enough targets inside only in a sta-
tion in common with other stations.

If the extracted targets have already paired (Matched), they are gathered per pairing group named XXX where XXX is its
order. All pairing groups are rooted in the Targets Tree. The target pairing information is still displayed in the Station List as
illustrated above. After entering into the tool, the stations are automatically adjusted. The Adjust button in Step 3 is still
enabled as the stations are automatically registered.

If there is no target within each station, the tool opens too. For each selected station, you may see the sum of targets Y and
the sum of matched targets X, both equal to zero. An information box with the "Reference station is not registrable" text may
appear.

Tip: In general, a station should have at least three targets inside. If one of the stations is a Topographic Station and the
other a Leveled Station, two targets (per station) are enough.
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Note: A pairing group (XXX where X is its order) is shown in the 3D View with a label. The label's name is the group
name and its color corresponds to the one that you can find in each of the targets matched together. Unmatched targets still
remain in the Unmatched folder.

Tip: Targets, extracted by using the Auto-Extract and Register method and paired together immediately in the Target-
Based Registration tool, are renamed as well as their pairing groups. They are renamed as XXX. XXX starts at 001 and is
incremented by one. See [A]. If the Auto-Extract and Register method is not combined with the Target-Based Registration
tool, paired targets are not renamed but only their pairing groups are. See [B].

13.2.2.4 Edit Targets

For each station, you can modify targets (either of spherical type or of planar type), delete those that are incorrectly fitted,
and/or create additional targets in the point cloud where such a target is identified visually as having been scanned.

To edit targets.
n In Step 2, click Analyze. The Target Analyzer dialog opens.

13.2.2.5 Adjust the Stations

Once the pairing (of targets) is done, the adjustment (of stations) is then launched automatically without the user's inter-
action. From this point on, stations are split into two categories: "Registered" and "Unregistered". "Unregistered" stations
are those for which the targets inside are not enough in quantity or are not in common with other stations. They are then
grayed out in the Station List and the Residual Error is equal to Zero. "Registered" stations are those for which the targets
inside are in common and paired with other station(s). The Residual Error is not equal to zero.

1 - Reference station (in bold)
2 - Registered station(s)

3 - Unregistered station(s)
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Caution: Changing the current Reference Station to a new one will NOT reset the adjustment information. The Adjust but-
ton, in Step 3, will stay grayed-out.

Note: After registering a Leveled Station with a Topographic Station, the Up (Z direction) of the Leveled Station is retained.

The Overall Residual Error is the average of all station residual errors. It is displayed in Step 1 of the Target-Based Regis-
tration dialog below the Station List. The smaller the Overall Residual Error, the more accurate the registration of the sta-
tions.

ALL STATIONS ARE REGISTERED - When all of the selected stations have been successfully registered (together), the
Overall Residual Error in Step 1 of the Target-Based Registration dialog, below the Station List, displays a value as illus-
trated below.

The Registration Details dialog automatically opens with the same Overall Residual Error value.

SOME SELECTED STATIONS ARE REGISTERED - When some of the selected stations have been successfully
registered together, there is no value in the Overall Residual Error line in Step 1 of the Target-Based Registration dialog.
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The Registration Details dialog still opens automatically. The Residual Error is not "Overall" but only for "Registered Sta-
tions". There is a value.

ALL STATIONS ARE NOT REGISTERED - If all of the selected stations have not been successfully registered (together),
there is no value for the Overall Residual Error in Step 1 of the Target-Based Registration dialog.
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The Registration Details dialog is not open. You have to open it manually by clicking the Check button. The Residual Error
is also not "Overall" but only for "Registered Stations", and there is no value.

13.2.2.6 Check the Adjustment

You can then check the quality of the adjustment. You can check the mean error for each target group (inside which you
can find all matched observations of this target from different stations). You can also check the error for each target obser-
vation. To do this, you should select the corresponding line in the table, and all pertinent information will be shown in the dia-
log area below the table. If the error of a target is e.g. out of tolerance, you can select it and use the Unmatch button to
remove it from the next registration. You can then re-perform the registration.

To check the adjustment:
n In Step 3, click on the Check button. The Registration Details dialog opens.

13.2.2.6.1 Registration Details
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What is a Fitting Error? An extracted target is in fact a set of points fitted with a geometry. The accuracy of the fitting is given
by this error (a distance value in the current unit of measurement). This distance is the deviation from the fitted geometry to
the set of points. The shorter the distance, the more accurate the fitting.

As a target does not belong to only one station but to several stations and the fitting error (of this target) in a station differs
from the fitting error in another station. The Residual Error of a target is the average of all Fitting Errors (of this target), each
from a station observation.

1 - Station's Residual Error
2 - Target's Residual Error

3 - Target's Fitting Error

A Residual Error of a station is the average of Fitting Errors of all targets (belonging to the station). The shorter the distance,
the more accurate the matching of targets.

1 - Target group's Residual Error
2 - Target's Residual Error

3 - Target's Fitting Error

A Target Group is a group inside which you can find all matched observations of this target from different stations. The
Residual Error in this case is the average of all Fitting Errors of this target.

Caution: The Projected Instrument Positions of leveled stations, which are also displayed in the Registration Details dia-
log, are not used for the registration.
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13.2.2.6.2 From Station View

To check the errors from the station view:
1. Click on the pull-down arrow.
2. Select Station View from the drop-down list.

13.2.2.6.2.1 Matched Station Tab

The Matched Station tab lists in a table all registered stations with targets whether matched or unmatched. By default, all
are Off (undisplayed in the 3D View).

1 - Registered station(s) 2 - Unmatched target(s) 3 - Matched target(s)

1.  Do one of the following:
n Toggle a registered station On. All targets of this station are On and have their representation displayed in the

3D View.
n Toggle a matched target On. Its representation is displayed in the 3D View.

2. Do one of the following:
n Unmatch a pair of matched targets.

a. Select a matched target. The Unmatch button becomes active.
b. Click Unmatch. This target and the one(s) in the same pair are unmatched.

n Unmatch all matched targets in a registered station.
a. Select a registered station. The Unmatch button becomes active.
b. Click Unmatch. All targets from this station and the ones from the other registered stations are unmatched.

n Match a matched target with.

Registered Stations
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The panel below the table displays for a registered station its name, the number of station(s) it is linked to, the name of each
linked station, the number of common targets and the Mean Distance (in the current unit of measurement).

Unmatched Targets
For an unmatched target, the panel displays its name and the station and group the matched target belonging to.

Matched Targets
For a matched target, the panel displays its name, the station and group it belonged to, the target(s) paired to it.

13.2.2.6.2.2 Unmatched Station Tab

The Unmatched Station tab lists all unregistered stations. They are only those that have been selected (as input) but for
which the registration failed. There are some extracted targets inside (if there is a TZF scan) the stations.

1 - Station selected as input of the regis-
tration

2 - Targets belonging to the unmatched sta-
tion

n Do one of the following:
n Toggle an unmatched target On. Its representation is shown in the 3D View.
n Toggle an unmatched station On. All targets inside this station have their representation displayed in the 3D

View.
n Match a target with.

Notes:
n The Unmatch button is not available (dimmed) when selecting the Unmatched Station tab.
n The Unmatched Station tab is not present in the Registration Details dialog if all the selected stations have been suc-

cessfully registered together.

Unregistered Stations
For an unregistered station, the panel below the table displays its name and the "0 linked station(s) text".

Unmatched Targets
For an unmatched target, the panel displays its name and the station it belongs to.

Match an unmatched target with.

13.2.2.6.3 From Target View

To check the errors from the target view:
1. Click on the pull-down arrow.
2. Select Target View from the drop-down list.

MATCHED TARGET TAB - This tab lists in a table all pairs of matched targets. By default, all are Off (undisplayed in the
3D View).
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1 - Pairs of matched targets 2 - Matched targets inside a pair

1. Do one of the following:
n Toggle a pair of matched targets On. Both targets (one from each station) are displayed in the 3D View.
n Toggle a matched target On. Its representation is displayed in the 3D View.

2. Do one of the following:
n Unmatch a pair of matched targets.

a. Select a pair of matched targets. The Unmatch button becomes active.
b. Click Unmatch. This pair of targets is unmatched.

n Unmatch a matched target.
a. Select a matched target. The Unmatch button becomes active.
b. Click Unmatch. This target and the one in the same pair are unmatched.

n Match a target with.

UNMATCHED TARGET TAB - This tab lists all unmatched targets. All are put in the Unmatched folder.

n Do one of the following.
n Toggle an unmatched target On. Its representation is displayed in the 3D View.
n Toggle the Unmatched folder On. All unmatched targets inside this folder have their representation displayed in

the 3D View.
n Match a target with.

Note: The Unmatch button is not available (dimmed) when selecting the Unmatched Target tab.

13.2.2.6.4 Auto-Match All

The Auto-Match All feature allows you to first un-adjust stations that had previously been adjusted and then adjust them
again. No selection is required. Stations are those selected as the input of the Target-Based Registration (or Auto-Extract
Targets).

Note: The user can be in either the Station View or the Target View.
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13.2.2.6.5 Auto-Match Station

The Auto-Match Station feature allows you to auto-adjust a selected station from the Registration Details dialog. If the selec-
ted station is already adjusted, it is then unadjusted and adjusted again. If it is not already adjusted, it is then automatically
adjusted. A selection is required. It must be done in the Station View from either the Matched Station tab or the Unmatched
Station tab.

13.2.2.6.6 Export the Registration Report to a RTF File

You are able to export the registration result in a report in a RTF format file without having to leave the Target-Based Regis-
tration tool, by clicking the Export Report button in the Registration Details dialog. For more information, refer to the Create
a Registration Report (Target-Based) topic.

13.2.2.7 Save the Adjustment Result

If you are satisfied with the adjustment result, you can use the Apply (or Group) button to save this result. You can continue
to perform other registrations or to quit the tool by using the Close button.

Tip: Close can also be selected from the pop-up menu.

To apply the adjustment:
1. Click Apply. The Target-Based Registration dialog remains open. Paired targets remain paired. Stations are adjus-

ted.
2. Click Close. The Target-Based Registration dialog closes.

Tip: You can perform two undo operations, one for the adjustment (of stations) and one for the auto-pairing (of targets).

To apply the adjustment and group the stations:
1. Click Group. A dialog opens and asks you to apply all changes before grouping stations.
2. Do one of the following:

n Click Yes. The Target-Based Registration dialog closes. A new folder named New Group is created in the Scans
Tree. All adjusted stations are put under that folder while all unadjusted stations are outside*. Targets and target
groups, instead of being named TargetX and mTargetX where X is an order, they are renamed as XXX. XXX
starts at 001.

1 - Group gathering registered stations
2 - Matched target(s)

3 - Unmatched target(s)

Trimble RealWorks User Guide | 334



REGISTRATIONMODE

Or
n Click No. A new dialog opens and asks you to apply all changes to the database.

a. Click Yes. The Target-Based Registration dialog closes. Targets remain paired. Stations are adjusted and
no new folder is created.

b. Or click No. The Target-Based Registration dialog closes. Targets are unpaired. Each target keeps its
default name: TargetX (where X is an order). Stations are not adjusted.

3. Click Close. The Target-Based Registration dialog closes.
Note: You can perform two undo operations, one for both the grouping and the adjustment (of stations) and one for the
auto-pairing (of targets).

Note: (*) Only stations registered to the Reference Station and the Reference Station itself are grouped.

13.2.3 Target Analyzer

This tool helps you to analyze a project before you register the stations that are inside. For each station, you can check if
there are enough targets (either of spherical type or of planar type), modify or delete those that are incorrectly fitted, and/or
create additional targets in the point cloud where such a target is identified visually as having been scanned.

13.2.3.1 Open the Tool

To open the tool:
1. Select a project (or a group of stations(1) or a single station(1)) from the Project Tree.

2. Select Target Analyzer in Registration > Target-Based Registration.
Or

3. In Step 2 of the Target-Based Registration dialog, click Analyze.
The Target Analyzer dialog opens as the fourth (or fifth) tab of the WorkSpace window. It is composed of five parts.
The first part allows you to select a station for analyzing. The second part is to check targets/surveying points and
scans that are in the selected station. The third part is to repair (or correct) a given target or to create a new one.
The fourth part is to update the network(2). The fifth part is to save the result, close the tool and give access to the
online help. The number of scans and targets in the selection appear in text below the selection box.

Notes:
n If the input contains some scans of spherical target type which are not already fitted, RealWorks will prompt you to

automatically fit each of them with a primitive.
n (1) If the TZF format files have not yet been processed, the Processing TZF Scans dialog opens and prompts you to

proceed to do so.
n (2) This part is only available when launching the Target Analyzer tool through the Target-Based Registration tool.

Tips:
n When a single station has been selected, the whole project is then taken as the entry of the tool.
n You can also right-select on a project (or a group of stations(1) or a single station(1) or a TZF Scan) from the Project

Tree and Target Analyzer tool from the pop-up menu.

Note: All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

Note: RealWorks internally computes the final number of points a full resolution extraction takes, and then checks the local
disk place. If there is a risk for the operation to fail due to a lack of disk space, an information box pops up, displaying an
estimated amount of needed space and the actual space left on the selected disk. If there is no risk, nothing happens.
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13.2.3.2 Select a Station

If a set of stations has been selected as the input (of the tool), no matter in which order each station has been selected, the
first from the list is the one that is displayed in Step 1. The same rule is applied when selecting a project.

To select a station:
1. Click on the pull down arrow.
2. Select a station from the drop-down list.
3. Or click Go to Next Station (or Go to Previous Station).

For each station, the number of scans and the number of targets are displayed as well as the Residual Error (in the
current unit of measurement). If the station has not yet been registered, its Residual Error is equal to Zero. By
default, the Main Scan within the selected station is displayed in a 2D Viewer as a 2D Preview Image.

You can zoom an area of this 2D Preview Image In or Out using the Zoom In and Zoom Out commands, zoom the
whole image In or Out using the mouse wheel or by defining a zoom factor. If the image is zoomed In more than the
2D Viewer can display, you can pan it in any direction in order to view the hidden areas.
Spherical Targets, Black andWhite FlatTargets or Point Targets extracted from a TZF Scan by using e.g. the Auto-
Extract Targets and Register feature, once created, are displayed within the TZF Scan. You can display (or hide) all
labels by clicking on the Show/Hide Labels icon.

Note: The 2D Viewer will not appear anymore when there is no TZF Scan within the input (of the tool).

Caution: If there is no TZF format file inside the selected station, a dialog opens and warns you that the TZF format file can-
not be opened. It may be absent, corrupted or blocked. The 2D Viewer disappears after closing the warning dialog.
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13.2.3.3 Select a TZF Scan

As a station can contain more than one TZF Scan, you can manually choose to display the one you want other than the
Main Scan.

To select a TZF Scan:
1. In the 2D Viewer, click on the TZF Scan pull-down arrow.
2. Choose a TZF Scan to display.

Tip: If a TZF Scan has been chosen (as input of the Target Analyzer tool), it is then displayed in the 2D Viewer instead of
the Main Scan.

13.2.3.4 Focus on Targets

Targets and scans of the station selected in Step 1 are listed according to the category they belong to. A target can be
either of spherical shape or of flat shape. It can also be a surveying point. Only fitted targets can be used for registration
(see the Target-Based Registration tool for full details). Fitted targets are put together in the Fitted list and this list is
accessed by selecting its corresponding tab.

Similarly, unfitted targets and scans are respectively in the Not fitted and Scan lists. The first item of the Fitted list is shown
in the 3D View but none is selected. The information box at the top right corner of the 3D View, which is here to display the
selected item, is blank. Both the Go to Next Target and the Go to Previous Target in the dialog are dimmed.

Properties depend on where the selected item is. If the selected item belongs to the Scan and Not Fitted lists, its name and
number of points are listed in the information box. If the selected item comes from the Fitted list, you will find two other items
of information (Standard Deviation (also called RMS error) and Scanner Distance) in addition to its name and number of
points. If the selected item is from a leveled station, you will also see the Target Height and Scanner Up Direction inform-
ation.

To focus on a target:
1. If the station (selected in Step 1) has no TZF scan inside, Step 2 looks as shown in [A].
2. If the station (selected in Step 1) has a TZF scan inside, Step 2 looks as shown in [B].
3. Select an item from the current list. Both the Go to Next Target and the Go to Previous Target buttons become

enabled.
4. Click Go to Next Target (or Go to Previous Target) to navigate through the list (of target).
5. Or press Down or Up on your keyboard.

[A] [B]

A Target selected from Step 2 is highlighted in the TZF Scan and centered on the 3D View and on the 2D Viewer as
shown below.
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Notes:
n You can only view the target height in the 3D View if its absolute value is greater than zero.
n You can first select any item from the current list and use Page Up and Page Down. The first and last item of this list

becomes consecutively selected and its representation is shown in the 3D View.

13.2.3.5 Create/Edit Targets

If the station selected in Step 1 contains already fitted items, you can focus on each item of the Fitted list from the first to the
last. Visually compare each of the selected item’s representations (points and geometry) in the 3D View and if required
check the RMS Error value in the information box. The smaller this value, the more precise the fitting. Those that are not cor-
rectly fitted can be modified or deleted. Step 3 (of the Target Analyzer dialog) appears as shown in [A], [B] and [C] when
selecting respectively a spherical item, a flat target and a survey point.
[A] [B]

[C]

If already fitted items are not sufficient, you can create additional items with the Fitting tool. You should first select an item
from one of the two lists (Not Fitted and Scans). If the selected item is from the Not Fitted list and is of spherical shape (or
flat shape (or survey point)), the dialog appears as shown in [D], (or [E] (or [F])).
[D] [E]

[F]

If the selected item is from the Scans list, the dialog looks as shown in [G]. From each item of the Scans list, you can extract
a 3D point as in the 3D Point Creation tool.
[G]
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Those, that are not correctly fitted and that belong to a leveled station (or from a survey instrument), can also be modified
and deleted. If the selected item is from the Fitted list, you can edit its height (see [H] when selecting a flat item). If it is either
from the Not Fitted list or from the Scan list, you cannot edit any height as the Target Height is grayed out (see [I] when
selecting a flat item).
[H] [I]

If the station selected in Step 1 contains fitted items extracted from a TZF scan, the dialog looks as shown in [J] (for an un-
leveled station) and [K] (for a leveled station).
[J] [K]

13.2.3.5.1 Fit a Geometry to Point Cloud [From Scan Items]

To fit a geometry to point cloud (from scan items):
1. Select a scan from the Scan list.
2. Click Fit. The Fitting tool toolbar appears.

3. Fence a set of points by drawing a polygon.
4. Click on the Fit Geometry to Cloud pull-down arrow.
5. Do one of the following:

n Fit with a Spherical Target.
a. If required, select Spherical Target from the drop-down list.
b. Click on the Diameter pull-down arrow.
c. Select AUTO to do a free fitting.
d. Or key a diameter value in the Diameter field.
e. Or select a diameter between 76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm to perform a constrained fit-

ting.
f. In the Fitting tool toolbar, click again Spherical Target. A Spherical Target is fitted to the fenced points.

n Fit with a Flat Target.
a. Select Flat Target from the drop-down list.
b. In the Fitting tool toolbar, click Flat Target again. A Flat Target is fitted to the fenced points.

6. Click Create Fitted Geometry.
7. Click Close Tool.

Tip: You can also right-click anywhere in the 3D View and select a command from the pop-up menu.

Note: The value entered in the Diameter field will no longer be kept. If you close the Fitting tool without creating the fitted
geometry.
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A set of points, once fitted, is put with its geometry in the Fitted list and under the Unmatched folder of the Targets Tree and
under the active group of the Scans Tree. Undoing the fitting removes the set of points with its primitive from the Fitted list,
the Unmatched folder and the active group.

Note: Please, be aware that the Flat Target icon looks like this .

13.2.3.5.2 Create a 3D Points

To create a 3D point:
1. Select a scan from the Scan list.
2. Click Pick Point to Create 3D Point icon. The Picking Parameters toolbar appears in 3D constraint mode and the

cursor becomes a cross.
3. Pick a point on the point cloud displayed in the 3D View. A 3D Point whose name is Scan_ObjectX where X is its

order is created. This 3D Point which is an unmatched target is put in the current station in the Scans Tree and in
the Unmatched folder in the Targets Tree.

13.2.3.5.3 Delete a Target

To delete a target:
1. Select a target from the Fitted list.
2. Click Delete the Selected Target . A warning dialog appears.
3. Do one of the following:

n To delete both the geometry and the points, click Delete Scan and Target.
n To delete only the geometry, click Delete Target Only.
n To cancel, click Cancel.

Caution: The deletion is definitive. You cannot undo.

13.2.3.5.4 Edit the Target Height

To edit the target height:
1. Select a target from the Fitted list.
2. Enter a value in the Target Height field.
3. Or keep the default value.
4. Type Enter.

Note: The selected target needs to belong to a leveled station.

Tip: Instead of editing the Target Height value from the Target Analyzer dialog, you can also do so in the Property window.

13.2.3.5.5 Fit a Geometry to Point Cloud [From Unfitted Items]

To fit a geometry to point cloud (from unfitted items):
1. Select an unfitted item from the Not fitted list.
2. Click Fit. The Fitting tool toolbar appears.
3. If the selected item is of spherical type, the Fitting tool toolbar appears as shown below.

4. If the selected item is of flat type, the Fitting tool toolbar appears as shown below.
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5. If required, fence the target by drawing a polygon.
6. Do one of the following:

n If the target is of Spherical Target type.
a. Click on the Diameter pull-down arrow.
b. Select AUTO to perform a free fitting.
c. Or key a diameter value in the Diameter field.
d. Or select a diameter between 76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm to perform a constrained fit-

ting.
e. In the Fitting toolbar, click again Spherical Target.

n If the target is of Flat Target type.
a. In the Fitting toolbar, click again Flat Target

7. Click Create Fitted Geometry.
8. Click Close Tool.

Tip: You can also right-click anywhere in the 3D View and select a command from the pop-up menu.

Note: The value entered in the Diameter field will no longer be kept if you close the Fitting tool without creating the fitted
geometry.

A target scan, once fitted, is removed from the Not Fitted list and put in the Fitted list and under the Unmatched folder in the
Targets Tree. Undoing the fitting replaces the target scan again in the Not Fitted list and removes it from the Unmatched
folder.

13.2.3.5.6 Re-Fit a Geometry to Point Cloud [From Fitted Items]

To re-fit a geometry to point cloud (from fitted items):
1. Select a fitted item from the Fitted list.
2. Click Re-Fit. The Fitting toolbar appears. The geometry representation of the selected item is then hidden.
3. If the selected item is of spherical type, the Fitting toolbar appears as shown below.

4. If the selected item is of flat type, the Fitting toolbar appears as shown below.

5. If required, fence the target by drawing a polygon*.
6. Do one of the following:

n If the target is of Spherical Target type.
a. Click on the Diameter pull-down arrow.
b. Select AUTO to perform a free fitting.
c. Or enter a diameter value in the Diameter field.
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d. Or select a diameter between 76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm to perform a constrained fit-
ting.

e. In the Fitting toolbar, click Spherical Target again.
n If the target is of Flat Target type.

a. In the Fitting toolbar, click Flat Target again.
7. Click Create Fitted Geometry.
8. Click Close Tool.

Tip: You can also right-click anywhere in the 3D View and select a command from the pop-up menu.

Notes:
n The value entered in the Diameter field will no longer be kept if you close the Fitting tool without creating the fitted

geometry.
n (*) If some points have been removed from the point cloud when fencing, the Residual Error of the fitted item

changes as well as the RMS, Standard Deviation and Number of Points.
n Please, be aware that the Flat Target icon looks like this .

13.2.3.5.7 Modify the Target Position

You can adjust the extracted target (of flat type) so that it fits exactly the points of the scanned target. A Manipulator (with
two axis handles and a plane) appears. You can adjust the fitted geometry by moving it with the manipulator. You can pan
the fitted geometry along a direction or in the plane.

To modify the target position:
1. Select a fitted item (of flat type) from the Fitted list.

2. Click Show Manipulators to Modify Target Position . A Manipulator (with two axis handles and a plane) appears.
3. Click on a handle; it turns yellow. The direction along which you can displace the geometry is highlighted in yellow

and the one along which you cannot displace it is in magenta.
4. Move the fitted geometry along that direction.

5. Click on the translucent plane. It turns yellow. The plane in which you can displace the fitted geometry turns to yel-
low.
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6. Move the created target in that plane.

13.2.3.5.8 Extract Targets

The Extract feature allows the user to extract Spherical Targets, Black andWhite Flat Targets, Point Targets and Point Tar-
gets (Corner) from TZF scans and use the extracted targets to register the stations they belong to.

To extract targets:
1. In Step 1, select a station from the station list.
2. In Step 3, click the Extract button. The Target Creator toolbar opens.

n The extract method, which appears in the Target Creator toolbar, is the last used one.
Note: The targets shown in red are the newly created targets, i.e. the ones that have been created in the current
session of the Target Creator tool. Once you close the Target Creator toolbar, they are shown in green.

13.2.3.5.8.1 Extract Spherical Targets

To extract a spherical target:
1. If required, click on the pull-down arrow.
2. Choose Spherical Target as object type. The Target Creator toolbar appears as shown below.
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3. Click on the Diameter pull-down arrow.
4. Choose one of the five predefined diameters (76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm).

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Click) icon.
2. Pick a point on the displayed TZF Scan.

A Sphere fits the points in the neighborhood of the picked one. Both of them are displayed in the 3D View and the
Fitting toolbar opens as shown below. At the same time, a scan of Spherical Target type (named TargetX) is cre-
ated and put under the current station.
The information box, at the top right corner of the 3D View, displays the number of points in the created scan, the
Standard Deviation value (except when the extraction failed), and the fitting Diameter.

Note: An error dialog opens when RealWorks cannot find a Spherical Target close to the picked point.

Fence an Area
To fence an area:

1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

A Sphere, whose diameter has been previously defined, fits the points inside the fence. Both of them are displayed
in the 3D View. The Fitting toolbar opens as shown below. At the same time, a scan of Spherical Target type
(named TargetX) is created and put under the current station.
The information box, at the top right corner of the 3D View, displays the number of points in the created scan, as
well as the Standard Deviation information (except when the extraction failed), and the fitting Diameter. If the area
contains no points; nothing occurs.
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Tip: Instead of double-clicking, press on the Space Bar of your keyboard.

Note: Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-
gress.

Create the Fitted Geometry
To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again a new set of points.
3. If required, choose another diameter.
4. Click the Spherical Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Spherical Target is assigned as "Unmatched" and
put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target Properties dialog opens.

The properties of a scan (of Spherical Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.2.3.5.8.2 Extract Black and White Flat Targets
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To extract a black and white flat target:
1. If required, click on the pull-down arrow.
2. Choose Black andWhite Flat Target as object type. The Target Creator toolbar looks as shown below.

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

A Black andWhite Target fits the points in the neighborhood of the picked one. Both of them are displayed in the 3D
View and the Fitting toolbar opens as shown below. At the same time, a scan of Flat Target type (named TargetX) is
created and put under the current station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).

If required, use the manipulator to modify the position of the target.
Note: An error dialog opens when RealWorks cannot find a Black andWhite Flat Target close to the picked point.

Fence an Area
To fence an area:

1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

A Black andWhite Target fits the points inside the fence. Both of them are displayed in the 3D View and the Fitting
toolbar opens as shown below. A scan, of Flat Target type (named TargetX), is created and put under the current
station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).
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If required, use the manipulator to modify the position of the target.
Tips:

n Instead of double-clicking, press on the Space Bar of your keyboard.
n Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-

gress.

Modify the Position of a Target
Amanipulator composed of two axis handles and one plane handle is set at the position of the target. To move the target
along a direction, click on an axis handle. It turns yellow. The direction along which you can displace the target is high-
lighted in yellow and the one along which you cannot displace the target are in mauve. Move the target along that direction.

To pan the target in a plane. Click on the plane handle. It turns yellow. A plane in yellow appears. Pan the target in that
plane.

Create the Fitted Geometry
To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again to refine the fitting.
3. If required, choose another diameter.
4. Click the Black andWhite Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Fitting toolbar closes on its own. The Flat Target is
assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target
Properties dialog opens.
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Properties of a scan (of Black andWhite Flat Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.2.3.5.8.3 Extract Point Targets

To extract a point target:
1. If required, click on the pull-down arrow.
2. Choose Point Target as object type. The Target Creator toolbar looks as shown below.

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

If the target extraction succeeds; points of the created scan with a fitted geometry are displayed in the 3D View and
the Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created and put under
the current station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information.

Note: An error dialog opens when RealWorks cannot find a Point Target close to the picked point.

Create the Fitted Geometry
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To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again to refine the fitting.
3. If required, choose another diameter.
4. Click the Point Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Fitting toolbar closes on its own. This Survey Point is
assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target
Properties dialog opens.

Properties of a scan (of Point Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.2.3.5.8.4 Extract Point Targets (Corners)

To extract a point target (corner):
1. If required, click on the pull-down arrow.
2. Choose Point Target (Corner) as object type. The Target Creator toolbar looks as shown below.

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

If the target extraction succeeds; points of the created scan with a fitted geometry and a manipulator are displayed
in the 3D View. The Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created
and put under the current station.
If required, use the manipulator to modify the position of the target.
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An information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).
An error dialog opens when a Point Target cannot be found closed to the picked point.

We advise you to pick a point on a corner. The extraction (of a target) can fail if you pick a point on a flat surface. If
that case occurs, only a point cloud is extracted and the Fitting toolbar which opens looks as shown below.

Fence an Area
You need to define an area from which a target will be created. This area is to be defined on the 2D image data in the 2D
viewer.

To fence an area:
1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

If the target extraction succeeds; points of the created scan with a fitted geometry and a manipulator are displayed
in the 3D View. The Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created
and put under the current station.
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If required, use the manipulator to modify the position of the target.

An information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).

Tips:
n Instead of double-clicking, press on the Space Bar of your keyboard.
n Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-

gress.

Modify the Position of a Target
Amanipulator is composed of three secant axis handles. This manipulator is set at the position of the target. In addition to
the three axis handles, the user can find three plane handles.

Use the manipulator to move the target along a direction. Click on an axis handle; it turns to yellow. The direction along
which you can displace the target is highlighted in yellow and those along which you cannot displace the target are in
mauve. Move the target along that direction.

Use the manipulator to pan the target in a plane. Click on a plane handle. It turns yellow. A plane in yellow appears. Pan the
target in that plane.
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Note: In the Input Data 2D Viewer, you may not see the position of the target changed. This only occurs after you create the
target in the database.

Create the Fitted Geometry
To create the fitted geometry:

n Click the Create icon in the Fitting toolbar.
The created scan is displayed in the Input Data 2D Viewer. The Fitting toolbar closes on its own. This Survey Point
is assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Tar-
get Properties dialog opens.

Properties of a scan (of Point Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.2.3.5.8.5 Modify the Properties of a Target

The properties of a target are mainly its Name and its Height which is the distance the user has to measure from a point on
the ground and the center of the target.

To modify the properties of target:
1. In the Name field, input a new name
2. In the Height field, input a distance value.
3. Click OK. The Modify Target Properties dialog closes.

13.2.3.6 Update the Network

This step, which only appears when using the Target Analyzer tool within the Target-Based Registration tool, allows the
user to redo the adjustment of the stations after modifying the extracted targets e.g. refitting, deleting, etc.

13.2.3.7 Apply the Result

Once you are satisfied with the result, you can select another station and perform the same operations. When all selected
stations are analyzed, you can save all results by using the Apply button. You can then evoke the Target-Based Regis-
tration tool for registering stations together.

Note: The Projection Mode in use by default (in the Target Analyzer) is Perspective. If you are in Parallel (before entering
the tool), the projection mode automatically switches to Perspective. Once the tool is closed, the projection mode is
restored.

13.2.4 Georeferencing

Georeferencing describes the process of locating an object in the "real world" coordinates. For example, you can geor-
eference your house by determining its latitude and longitude coordinates. In RealWorks, the objective of this tool is to
allow you to georeference a station (or a group of stations or a project) to a known coordinate system. To do this, you have
to assign for some targets (or points) of the station (or group of stations) the corresponding known coordinates. Once you
assign at least three pairs, a least squares fitting method will be used to calculate the best transformation. You can also
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import a control network surveyed by traditional surveying instruments, and use these control points to assign coordinates.
If you apply this procedure station by station, this amounts to performing registration sequentially (in contrast to Target-
Based Registration where the least squares adjustment is applied simultaneously to all selected stations).

Caution: The Georeferencing tool does only move point clouds. Geometries, created in OfficeSurvey (or Modeling), are
not moved anymore.

13.2.4.1 Open the Tool

To open the Georeferencing tool, you need to select a station (or a group of stations or a project); no matter if the selection
contains or not targets.

To open the tool:
1. Import a survey network file including measured points into your project, if required.
2. Select a station (or a project) from the Scans Tree and display it if required.

3. Select Georeferencing in Registration > Target-Based Registration. The Georeferencing dialog opens.
This dialog box opens as the fourth tab of the WorkSpace window and is composed of four parts. Each of them cor-
responds to one step in the georeferencing procedure.
n If the input is a lonely station, this station is by-default selected. All targets (if existed) of this station are listed in

the Target List window.
n If the input is a group of stations, the first station is selected by-default. All targets (if existed) of this station are lis-

ted in the Target List window.
n If the input is a project, this project is by-default selected. All targets (if existed) of this project are listed in the Tar-

get List window.

1 - The selected project 2 - The Target List window 3 - Targets in the selection
n For a leveled station, its Projected Instrument Position is also displayed in the Target List window.

Note: Ameasured point may have two states: Matched or Unmatched. All measured points when unmatched are gathered
into a folder named Unmatched and rooted under the Project node in the Targets Tree. This folder can be reached by
selecting the Targets tab.

Tip: The Georeferencing tool can also be selected from the pop-up menu.

13.2.4.2 Select a Station for Georeferencing
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You should first select a station for which you want to georeference. Once it is selected, all targets (if existed) of this station
are listed in the Target List window.

To select a station for Georeferencing:
1. Click on the Select Station pull-down arrow.
2. Select a station from the Select Station list. This station is displayed in the 3D View and all targets that are inside are

listed in the Target List window.

Note:Multi-selection is forbidden.

You cannot drop-down the list and select a station from if a project has been selected (as input of the tool). All targets from
the project are listed in the Target List window as illustrated below.

13.2.4.3 Assign Known Coordinates to a Target

If there are targets, you can select and assign one of them with known coordinates. You have two methods. If there is a con-
trol network imported, you can choose the corresponding one and use it to assign the coordinates. Otherwise, you can key-
in the coordinates in the text field. A target, once assigned with known coordinates, will be removed from the Target List win-
dow and put in a list under the By Target and By Picking buttons. Similarly, it will be displayed and numbered in the 3D
View.

To assign known coordinates to a target:
1. If required, check the Zoom On Selected Target option.
2. Select a target from the Target List window. The By Target button becomes active.

The Zoom On Selected Target option lets you easily find the target, that you selected in the Target List, in the 3D
scene. A selected target is highlighted in the Target List window, and highlighted and centered in the 3D View.
If the geometry of the selected target is not displayed, the selection in the Target List window displays it. When you
select a target in the 3D View, it gets highlighted in the Target List window and in the 3D View.
You are able to select the Projected Instrument Position of a leveled station and assign known coordinates to it.
Note that a Projected Instrument Position has no representation in the 3D View. What is displayed is the last selec-
ted target.

3. Click the By Target button. The Assign Known Coordinates to Target dialog opens.
For a target selected (from the Georeferencing dialog or from the 3D View), its name and its coordinates appear in
the Selected Target panel, and you cannot modify them. The second part lets you assign known coordinates to the
selected target, by editing manually the known coordinates or by selecting a measured point and assigning its
coordinates. The third part lets you validate the operation.

4. Do one of the following:
n Edit known coordinates by hand.

a. The Manual Edit in the Topo Point field is set by default. If not, select it.
b. Enter a known coordinate in the X field.
c. Enter a known coordinate in the Y field.
d. Enter a known coordinate in the Z field.
e. Keep the default name TopoPoint 1.
f. Or enter a new name in the Name field
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1 - Name of the selected tar-
get (not editable)

2 - Coordinates of the selected
target (not editable)

3 - Values the user has to enter
manually

n Select known coordinates from the survey network file.
a. Click on the Topo Point pull-down arrow.
b. Select a Topo point from the list.
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1 - A Topo point selected from the sur-
vey network file

2 - Coordinates and name of the selec-
ted Topo point assigned to the selected
target

5. Click OK. The Assign Know Coordinates to Target dialog closes.

Note: You can mix the two ways of assigning coordinates (By Picking and By Target) in a single georeferencing operation
without leaving the tool.

Tip: For assigning known coordinates to a target, you can select it from the Target List window or pick on it in the 3D View.
A selected target is highlighted in the 3D View.

13.2.4.4 Assign Known Coordinates to a Picked Point

If there are no targets, the By Target button in the Georeferencing dialog is dimmed. You can then assign known coordin-
ates to a point picked in the 3D View. You have two methods for assigning known coordinates. If there is a control network
imported, you can choose the corresponding one and use it to assign the coordinates. Otherwise, you can key-in the
coordinates in the text field.

To assign known coordinates to a picked Point:
1. In the Georeferencing dialog, click on the By Picking button.
2. Pick a point on the displayed object(s). The Assign Known Coordinates to Target dialog opens.

For a point picked in the 3D scene, a name by default PickPoint1 and the 3D position of the picked point appear in
the Selected Target panel. You can rename this picked point but you cannot modify its coordinates. The second
part enables to assign known coordinates to the picked point. You can either edit the coordinates by hand or select
a measured point and assign its coordinates. You can then validate the operation in the third part.

3. Keep the default name PickPoint 1.
4. Or enter a new name in the Name field.
5. Do one of the following:
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n Edit known coordinates by hand.

1 - Default name of the picked point 2 - 3D coordinates of the
picked point

3 - Values the user has to
enter manually

a. Manual Edit in the Topo Point field is set by default. If not, select it.
b. Enter a known coordinate in the X field.
c. Enter a known coordinate in the Y field.
d. Enter a known coordinate in the Z field.

n Select known coordinates from the survey network file.
a. Click on the Topo Point pull-down arrow.
b. Select a Topo point from the list.
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1 - A Topo point selected from the sur-
vey network file

2 - Coordinates and name of the selec-
ted Topo point assigned to the selected
target

6. Click OK. The Assign Known Coordinates to Target dialog closes.

Notes:
n If you have selected a station, you can only pick points of that station.
n You can leave the picking mode by selecting Exit Picking Mode from the pop-up menu.
n You can mix the two ways of assigning coordinates (By Picking and By Target) in a single georeferencing operation

without leaving the tool.

Tip: You can remove the Topo point labels from the 3D View by first selecting Rendering, then Display 3D Labels from the
3D View menu.

13.2.4.5 Check the Average Error

In the 3D View, a target (or a picked point) once assigned is displayed with the letter P and a number, in yellow. This num-
ber is an order.

Once at least three known coordinates have been assigned to the targets and/or to the picked points, a least-squares fitting
method is then automatically applied to calculate the best transformation.

You can select and delete an already assigned target (or picked point) by pressing the Del. key. An assigned target once
deleted is removed from the list below and put again in the Target List window for a new assignment.

The error for each target (or for each picked point) is expressed as a distance. You are able to uncheck the targets (and/or
the picked points) having the greatest error; the fitting method is then applied each time you check or uncheck the targets
(or picked points).

You can visualize the errors in the 3D View by clicking the Display Errors button. The known coordinates you assigned to a
target and/or to the picked point are displayed with the letter P and a number, in red.
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13.2.4.6 Apply the Georeferencing

To apply the georeferencing:
1. Click the Apply button.
2. Click Close. The Georeferencing dialog closes.

Note: Ameasured point (from the survey network file) once assigned is set as matched.

Note: Leaving the Georeferencing tool without applying the georeferencing will display an error message which prompts to
abort or continue the operation.

Tip: You can leave the Georeferencing tool by pressing Esc or by selecting Close from the pop-up menu.

13.2.5 Modify Target

The "Modify Target Matching" group, from the Registration menu, in the Menu and Toolbars and the "Modify Target" menu,
from the Target-Based Registration group, in the Ribbon, gathers the operations the user can apply to a target.

13.2.5.1 Match With

Matching a pair of targets consists of pairing one with the other. The Match With command can be reached from the Regis-
tration menu or within e.g. the Target-Based Registration tool in the Registration Details dialog after auto-pairing targets.
You can select an unmatched target (or matched target) as input of that tool.
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To match a target with:
1. Select a target (matched or not) from the Project Tree.

2. Select Match With in Registration > Target-Based Registration > Modify Target. The Match With dialog opens.
3. In the Match With dialog, expand the Project Tree if required.

In the Match With dialog, the Project Tree gathers all unmatched items except those belonging to the selected sta-
tion.
You are able to select an item of any kind (project position of an instrument, target and topopoint) to match with the
selected target.

4. Select an item from the Match With dialog. The OK button becomes active.
n If the selected item is not yet matched, both are matched together and put under a matched folder in the Targets

Tree.
n If the selected item is already matched, both are also matched together but no matched folder is created in the

Targets Tree. The item selected for matching (in the Match With dialog) is put under the existing matched folder
(the one inside which resides the selected item and its pair).

n If the selected item is the projection position of an instrument station, the status of that station switches from
to ., like it is setup over a known point.

Tip: You can also right-click on an unmatched item from the Project Tree and select Match With from the pop-up menu.

13.2.5.2 Match Targets

You can manually pair an unmatched target with another unmatched target. Both must not reside under the same station.
You can also pair two different stations. Both need to be leveled and setup over a Known Point.

Notes:
n You can undo the operation.
n Use the Ctrl (or Shift) key combined with the left-click for multi-select items.

To select targets for matching:
1. Select an unmatched target from a station from the Project Tree.
2. Select another unmatched target from a different station from the Project Tree.
3. Select Match Targets in Registration > Target-Based Registration > Modify Target.

Targets (once paired) are put under a matched folder in the Scans Tree.
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To select stations for matching:
1. Select at least two stations from the ScansTree.
2. Select Match Targets in Registration > Target-Based Registration > Modify Target.

n If the stations have been leveled and setup over a known point, a dialog opens and prompts you to accept the
removal of a target (or not). Click Yes to accept.

n If the stations have been only leveled, the projection positions of both are matched together.

13.2.5.3 Unmatch Targets

Unmatching a pair of matched targets consists of dissociating one from the other. Selecting a matched target will unmatch
the pair that it belongs to. Selecting a station will unmatch all pairs of matched targets that are inside.

To unmatch a Target:
1. In the Registration Details dialog, select a matched entity from a station in the Station View (or from a pair in the Tar-

get View). The Match With and Unmatch buttons become enabled.
2. Click on the Unmatch button.

Or
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3. Select a matched entity from a pair.
4. Select Unmatch Target in Registration > Target-based Registration > Modify Target.

Tip: You can also right-click on a matched item from the Project Tree and select Un-match Target from the pop-up menu.

13.2.5.4 Rename a Target

Auto-Pairing Targets: Targets and target groups are renamed. Instead of being named TargetX and mTargetX where X is
an order, they are renamed as XXX. XXX starts at 001 and is incremented by one. Manual-Pairing Targets: Targets keep
their default name and target groups are renamed as described above. The Rename Targets feature allows renaming of tar-
gets in case the manual method has been used.

To rename targets:
1. Select a target group from the Targets Tree.
2. From the Registration menu, select Modify Target Matching / Rename Targets. Targets are renamed according to

the target group name they belong to.

Tip: You can also right-click on a target group and select Rename Targets from the pop-up menu.

Note: In the Ribbon, the Rename feature can be reached from the Modify Target list, in the Target-Based Registration
group, on the Registration tab.

13.2.6 Registration Report (Target-Based)

The Registration Report (Target-Based) feature lets the user create a report after a registration (based on pairing targets) in
an RTF (Rich Text Format) file. The RTF specification is a method of encoding formatted text and graphics for easy transfer
between applications. Currently, users depend on special translation software to move word-processing documents
between different MS-DOS®, Windows, OS/2, Macintosh, and Power Macintosh applications. The RTF specification
provides a format for text and graphics interchange that can be used with different output devices, operating environments,
and operating systems. This feature is only available in Registration. You can only create one report per project. If several
projects exist under the Project Tree, the report concerns the project which contains the active group. For a given project, if
any registration has been performed, the report is empty of information.

To create a target-based registration report:
1. Select a project from the Project Tree.

2. Select Registration Report (Target-Based) in Registration > Target-Based Registration. The Registration Report
(Target-Based) dialog opens.

3. Navigate to the drive/folder where you want the report file to be stored in the Look In field.
4. Enter a name in the File Name field. The extension RTF is added automatically.
5. Click Save.
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Note: The results in the report are split into two categories: By Stations and By Targets.

13.3 SURVEY WORKFLOW TOOLS

The Survey Workflow group lets the user use a 3D scanner that does not have a built-in traverse routine for performing a tra-
verse type workflow in the field, and then complete the survey workflow in the office to register the data.

13.3.1 Station Setup

The Station Setup tool lets the user register a set of 3D scans, acquired with any instrument, following a smooth survey
workflow. It also lets the user move a registered set of data over a survey control network.

13.3.1.1 Open the Tool

The input of the Station Setup tool can be a station, a set of stations or a project.

To open the tool:

1. Select either a leveled station or a project from the Project Tree.

2. Select Station Setup in Registration > Survey Workflow. The Station Setup dialog opens.
n RealWorks displays the list of all the stations inside the project, even if a unique station has been selected.
n In case there are some unlevelled stations inside your project, a message appears and the whole is auto-

matically leveled.
n If there are some Topo Points inside your project, the TopoStation System the Topo Points belong to the Refer-

ence Station.
n If no Topo Point exists in your project, the first leveled station from the selection is the Reference Station.

Tip: The Station Setup tool can also be reached from the pop-up menu.

Note: If you are importing Topo Points and choose these ones for a backsight calculation, you must not put a target height.
It is already calculated during the import. If you need to adjust the target heights for Topo Points, please calculate only with
the delta.

13.3.1.2 Select a Station

To select a station:
1. Click on the pull-down arrow.
2. Choose a station from the drop-down list.

Or

3. Click Previous Station or Next Station .

Note: The Previous Station and Next Station buttons are enabled only if there are more than one station in your selection.

Note: In case an already defined station, i.e., registered station, has been selected, the dialog shows the current state of
the network for that station. This means that if the station had been set over a known point, the tool shows Station setup as
method, and the value of the Instrument Height as well as the coordinates and the name of the Known Point.

13.3.1.3 Select a Setup Type

In this step, you need to choose a method that will be used to determine the Position and Orientation of an instrument sta-
tion.
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To select a type of setup:
1. Click on the Setup Type pull-down arrow.
2. Choose between Station Setup or Resection.

13.3.1.3.1 Station Setup

A Station Setup is a method which enables to determine the Position and the Orientation of an instrument station by setting
the instrument over a Known Point on the ground, and by measuring a Backsight, as illustrated below.

IH - Instrument Height
KP - Known Point

TH - Target Height

To perform a station setup:
1. Define the properties of an instrument station.
2. If required, measure targets.
3. Define backsight points.
4. Check the result.

13.3.1.3.1.1 Define the Properties of an Instrument Station

In the Station Setup method, the user has to define the properties of an instrument station by inputting the Instrument
Height and setting the instrument station over a Known Point.

Define the Instrument Height
The Instrument Height (IH) is the distance which separates a point on the ground to the centre of the instrument. This dis-
tance, the user needs to measure in the field with a tape. A station coming from a project acquired with a Trimble TX instru-
ment has the Leveling and Instrument Height (IH) information within. In that case, both information will appear in the Station
Setup dialog when selecting such a station.

To define the instrument height:
n Input a distance value in the Instrument Height field. The input value is added to the Z coordinate of all items (point,

geometry, scanner origin, etc.) of the selected station, and RealWorks adjusts the whole network automatically.

Tip: For more information, refer to the Modify the Instrument Height topic.
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Set Over a Known Point
To set over a known point:

1. Select a Topo point from a list.
2. Or key-in a point.

The Select Point to Define Station Position and Key-in Point to Define Station Position become dimmed. The
Unmatch icon becomes enabled and the selected (or key-in) point name as well as it coordinates are displayed in
the dialog. To be able to change the selected point for another point, you must first un-match if.

At the same time, RealWorks adjusts the whole network automatically.

The selected station switches from to .

Note: For more information, refer to the Set Over a Known Point topic.
Select a Known Point from a List
You can select a target that does not belong to the station selected in Step 1 but to other stations, or a Topo point from a
TopoStation System, and assign it as a Known Point.

To select a known point from a list:

1. Click the Select Point to Define Station Position icon. The Set Station Over a Known Point dialog opens.
2. Choose a Known Point from the dialog.
3. Click OK. The Set Station Over a Known Point dialog closes

Create a Known Point
This is the case where there is no target and no Topo point within your project. You can then create one by key-in its
coordinates.

To create a known point:

1. Click the Key-in Point to Define Station Position icon. The Create New Topopoint dialog opens.
2. In the Topo Point Name field, input a name or keep the default one.
3. In the Coordinates field, input or paste 3D coordinates.
4. Click Create. The Create New Topo Point dialog closes.

13.3.1.3.2 Resection

A Resection is a method which allows determining the Position and Orientation of an instrument station by measuring at
least two Backsight Points, as illustrated below.
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IH - Instrument Height
KP - Known Point

TH - Target Height

To perform a resection:
1. Define the Properties of an Instrument Station.
2. If required, measure targets.
3. Define backsight points.
4. Check the result.

13.3.1.3.2.1 Define the Properties of an Instrument Station

In the Resection method, the user has to define the properties of an instrument station by only inputting the Instrument
Height.

Define the Instrument Height
The Instrument Height (IH) is the distance which separates a point on the ground to the centre of the instrument. This dis-
tance, the user needs to measure in the field with a tape. A station coming from a project acquired with a Trimble TX instru-
ment has the Leveling and Instrument Height (IH) information within. In that case, both information will appear in the Station
Setup dialog when selecting such a station.

To define the instrument height:
n Input a distance value in the Instrument Height field. The input value is added to the Z coordinate of all items (point,

geometry, scanner origin, etc.) of the selected station, and RealWorks adjusts the whole network automatically.

Tip: For more information, refer to the Modify the Instrument Height topic.

13.3.1.3.3 Measure Targets

The Extract feature allows you to first extract points from a displayed TZF Scan, and then fit them with a geometry of target
type. There are four types: Spherical Targets, Black andWhite Flat Targets, Point Targets and Point Targets (Corner). This
feature is grayed-out in case there is no TZF Scan in the project. The Extract feature is grayed-out in case there is no TZF
Scan within your project.
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To extract targets:
n In Step 3, click the Extract button. The Target Creator toolbar opens.

Note: The extract method, which appears in the Target Creator toolbar, is the last used one.

Note: In the 3D View, the extracted points are displayed with a size in pixels. The size will automatically switch to 3 Pixels if
it is lower than this value. The size will not change if it is equal or greater than 3 Pixels. The change, when happened, will be
kept after you close the Target Creator toolbar and leave the tool.

13.3.1.3.3.1 Extract Spherical Targets

To extract a spherical target:
1. If required, click on the pull-down arrow.
2. Choose Spherical Target as object type. The Target Creator toolbar appears as shown below.

3. Click on the Diameter pull-down arrow.
4. Choose one of the five predefined diameters (76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm).

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Click) icon.
2. Pick a point on the displayed TZF Scan.

A Sphere fits the points in the neighborhood of the picked one. Both of them are displayed in the 3D View and the
Fitting toolbar opens as shown below. At the same time, a scan of Spherical Target type (named TargetX) is cre-
ated and put under the current station.
The information box, at the top right corner of the 3D View, displays the number of points in the created scan, the
Standard Deviation value (except when the extraction failed), and the fitting Diameter.

Note: An error dialog opens when RealWorks cannot find a Spherical Target close to the picked point.

Fence an Area
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To fence an area:
1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

A Sphere, whose diameter has been previously defined, fits the points inside the fence. Both of them are displayed
in the 3D View. The Fitting toolbar opens as shown below. At the same time, a scan of Spherical Target type
(named TargetX) is created and put under the current station.
The information box, at the top right corner of the 3D View, displays the number of points in the created scan, as
well as the Standard Deviation information (except when the extraction failed), and the fitting Diameter. If the area
contains no points; nothing occurs.

Tip: Instead of double-clicking, press on the Space Bar of your keyboard.

Note: Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-
gress.

Create the Fitted Geometry
To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again a new set of points.
3. If required, choose another diameter.
4. Click the Spherical Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Spherical Target is assigned as "Unmatched" and
put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target Properties dialog opens.
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The properties of a scan (of Spherical Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.3.1.3.3.2 Extract Black and White Flat Targets

To extract a black and white flat target:
1. If required, click on the pull-down arrow.
2. Choose Black andWhite Flat Target as object type. The Target Creator toolbar looks as shown below.

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

A Black andWhite Target fits the points in the neighborhood of the picked one. Both of them are displayed in the 3D
View and the Fitting toolbar opens as shown below. At the same time, a scan of Flat Target type (named TargetX) is
created and put under the current station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).
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If required, use the manipulator to modify the position of the target.
Note: An error dialog opens when RealWorks cannot find a Black andWhite Flat Target close to the picked point.

Fence an Area
To fence an area:

1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

A Black andWhite Target fits the points inside the fence. Both of them are displayed in the 3D View and the Fitting
toolbar opens as shown below. A scan, of Flat Target type (named TargetX), is created and put under the current
station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).
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If required, use the manipulator to modify the position of the target.
Tips:

n Instead of double-clicking, press on the Space Bar of your keyboard.
n Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-

gress.

Modify the Position of a Target
Amanipulator composed of two axis handles and one plane handle is set at the position of the target. To move the target
along a direction, click on an axis handle. It turns yellow. The direction along which you can displace the target is high-
lighted in yellow and the one along which you cannot displace the target are in mauve. Move the target along that direction.

To pan the target in a plane. Click on the plane handle. It turns yellow. A plane in yellow appears. Pan the target in that
plane.

Create the Fitted Geometry
To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again to refine the fitting.
3. If required, choose another diameter.
4. Click the Black andWhite Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Fitting toolbar closes on its own. The Flat Target is
assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target
Properties dialog opens.

Properties of a scan (of Black andWhite Flat Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.3.1.3.3.3 Extract Point Targets

To extract a point target:
1. If required, click on the pull-down arrow.
2. Choose Point Target as object type. The Target Creator toolbar looks as shown below.

Pick One Point
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To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

If the target extraction succeeds; points of the created scan with a fitted geometry are displayed in the 3D View and
the Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created and put under
the current station.
The information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information.

Note: An error dialog opens when RealWorks cannot find a Point Target close to the picked point.

Create the Fitted Geometry
To create the fitted geometry:

1. If the extraction has succeeded, click the Create icon in the Fitting toolbar.
Or

2. If the extraction has failed, fence again to refine the fitting.
3. If required, choose another diameter.
4. Click the Point Target icon.

5. And then, click the Create icon.
The created scan is displayed on the displayed TZF Scan. The Fitting toolbar closes on its own. This Survey Point is
assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Target
Properties dialog opens.

Properties of a scan (of Point Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.
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13.3.1.3.3.4 Extract Point Targets (Corners)

To extract a point target (corner):
1. If required, click on the pull-down arrow.
2. Choose Point Target (Corner) as object type. The Target Creator toolbar looks as shown below.

Pick One Point
To pick one point:

1. Click the Auto-Extract Target (One Point) icon.
2. Pick a point on the displayed TZF Scan.

If the target extraction succeeds; points of the created scan with a fitted geometry and a manipulator are displayed
in the 3D View. The Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created
and put under the current station.
If required, use the manipulator to modify the position of the target.

An information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).
An error dialog opens when a Point Target cannot be found closed to the picked point.

We advise you to pick a point on a corner. The extraction (of a target) can fail if you pick a point on a flat surface. If
that case occurs, only a point cloud is extracted and the Fitting toolbar which opens looks as shown below.
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Fence an Area
You need to define an area from which a target will be created. This area is to be defined on the 2D image data in the 2D
viewer.

To fence a zone:
1. Click the Polygonal Selection icon.
2. Pan (or zoom In or Out) the displayed TZF Scan (if needed).
3. Draw a polygonal fence by picking and double-clicking to end.

If the target extraction succeeds; points of the created scan with a fitted geometry and a manipulator are displayed
in the 3D View. The Fitting toolbar opens as shown below. A scan of Survey Point type (named TargetX) is created
and put under the current station.
If required, use the manipulator to modify the position of the target.

An information box at the top right corner of the 3D View displays the number of points in the created scan as well
as the Standard Deviation information (except when the extraction fails).

Tips:
n Instead of double-clicking, press on the Space Bar of your keyboard.
n Press Esc (or select New Fence or Close Polygon tool from the pop-up menu) to undo the polygonal fence in pro-

gress.

Modify the Position of a Target
Amanipulator is composed of three secant axis handles. This manipulator is set at the position of the target. In addition to
the three axis handles, the user can find three plane handles.

Use the manipulator to move the target along a direction. Click on an axis handle; it turns yellow. The direction along which
you can displace the target is highlighted in yellow and those along which you cannot displace the target are in mauve.
Move the target along that direction.
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Use the manipulator to pan the target in a plane. Click on a plane handle. It turns to yellow. A plane in yellow appears. Pan
the target in that plane.

Note: In the Input Data 2D Viewer, you may not see the position of the target changed. This only occurs after you create the
target in the database.

Create the Fitted Geometry
To create the fitted geometry:

n Click the Create icon in the Fitting toolbar.
The created scan is displayed in the Input Data 2D Viewer. The Fitting toolbar closes on its own. This Survey Point
is assigned as "Unmatched" and put in the Unmatched folder in the Targets Tree. At the same time, the Modify Tar-
get Properties dialog opens.

Properties of a scan (of Point Target type) fitted with a geometry

Note: A dialog appears if the user decides to close the Fitting tool without creating the fitted geometry.

13.3.1.3.3.5 Modify the Properties of a Target

The properties of a target are mainly its Name and its Height which is the distance the user has to measure from a point on
the ground and the center of the target.

To modify the properties of a target:
1. In the Name field, input a new name
2. In the Height field, input a distance value.
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3. Click OK. The Modify Target Properties dialog closes.

13.3.1.3.4 Define Backsight Points

All the targets belonging to the station selected in the Step 1 or those extracted in the Step 3, appear as a list in Step 4. For
some, you are able to re-fit, and for others, to change the position. But for all, you are able to modify the height, previously
defined in the Modify Target Properties dialog.

For each extracted target from the list, the distance-to-instrument information has been computed, and displayed in the
information box.

To define a backsight point:
1. In Step 4, click on the pull-down arrow.
2. Choose a target from the drop-down list.
3. If required, do one of the following:

n Re-fit a target.
n Modify the position of a target.

4. Input the Height of a Target.
5. Do one of the following:

n With the Station Setup method, match with a known point.
n With the Resection method, perform the steps from 1 to 4 at least two times and for each target, match with a

known point.

13.3.1.3.4.1 Re-Fit a Target

To refit a target:
1. Click on the pull-down arrow and choose either a Spherical Target or a Black andWhite Target.

2. Click the Re-Fit icon. The Fitting toolbar appears.

Note: Refer to the Extract Spherical Targets and the Extract Black andWhite Flat Targets section for more information.

13.3.1.3.4.2 Modify the Position of a Target

To modify the position of a target:
1. Click on the pull-down arrow and choose a Flat Target.

2. Click the Show Manipulators to Modify Target Position icon.
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Note: Refer to the Modify the Position of a Target for more information.

13.3.1.3.4.3 Input the Height of a Target

To input the height of a target:
n In the Backsight Height field, input a distance value.

13.3.1.3.4.4 Match With a Known Point

To match to a known point:
1. Select a point from a list.
2. Or key-in a point.

The Select Point to Define Backsight Position and Key-in Point to Define Backsight Position become
dimmed. The Unmatch icon becomes enabled and the selected (or key-in) point coordinates are displayed in the
dialog. To be able to change the selected point for another point, you must first unmatch if.

Select a Known Point from a List
You can select a target that does not belong to the station selected in Step 1 but to other stations, or a Topo point from a
TopoStation System, or the Projected Instrument Position of a station (except the selected one), and assign it as a Known
Point.

To select a known point from a list

1. Click the Select Point to Define Backsight Position icon. The Match With dialog opens.
2. Choose a Known Point from the dialog.

3. Click OK. The Match With dialog closes

Create a Known Point
To create a known point:

1. Click the Key-in Point to Define Backsight Position icon. The Create New Topopoint dialog opens.
2. In the Topo Point Name field, input a name or keep the default one.
3. In the Coordinates field, input or paste 3D coordinates.
4. Click Create. The Create New Topo Point dialog closes.

13.3.1.3.5 Check the Results
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The Residual Error of a Backsight Point corresponds to the average distance between the selected target and the control
point with which the selected target is matched with.

To check the results:
n In case of a Station Setup, RealWorks displays the residual error of the chosen backsight point in Step 5.

n In case of a Resection, RealWorks displays the residual error of each chosen backsight point in Step 5 and the
coordinates of the station point (Projected Instrument Position). It is undefined after adding the first backsight point.

The coordinates become 0;0;0 after adding the second backsight point.

13.3.1.3.6 Apply the Network Adjustment

To apply the network adjustment:
n In case of a Resection, RealWorks computes the coordinates of the station point (Projected Instrument Position).

n Either in the Station Setup method or in the Resection method, RealWorks computes the station setup errors as
illustrated below.

Caution: The adjustment may fail in case some links between stations are not sufficiently defined.

13.3.2 Network Adjustment

With this feature, all targets of the entire project are matched without user intervention. The matching is based on target geo-
metries in opposition to the Named-Based Network Adjustment which is base target names. This feature shares the same
dialog as the Target-Based Registration tool.

To adjust the registration network:
1. Select a project from the Project Tree.

2. Select Adjust Network in Registration > Survey Workflow. The Target-Based Registration dialog opens as well
as the Registration Details dialog.
In the Target-Based Registration dialog, targets are automatically matched. The Adjust button in Step 3 of the Tar-
get-Based Registration is grayed-out. In the Registration Details dialog, the Station View is set by default. Each tar-
get is automatically paired with other targets.
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In the Targets Tree, targets matched together are put in a folder named mTARGET and rooted under the Project
node.

3. Click Apply. The Target-Based Registration dialog closes. All the changes are applied to the database.
4. Or click Close. An information box appears and prompts the user to apply the changes in the database or not.

13.3.3 Name-Based Network Adjustment

The Name-Based Network Adjustment feature first un-matches any already matched target* and then matches all targets
of the whole project by associating them by name. This feature shares the same dialog as the Target-Based Registration
tool.

To adjust the registration network based on target names:
1. Select a project from the ProjectTree.
2. Select Name-Based Network Adjustment in Registration > Survey Workflow. The Target-Based Registration dia-

log opens as well as the Registration Details dialog.
Targets are automatically matched by their name. The Adjust button in Step 3 of the Target-Based Registration is
grayed-out. In the Registration Details dialog, the Station View is set by default.

3. Switch to the Target View. Targets that are paired by their name are put in a folder named by the target name.

4. Click Apply. The Target-Based Registration dialog closes. All the changes are applied to the database.
5. Or click Close. An information box appears and prompts the user to apply the changes in the database or not.

Note:When you select a project for which any target can be matched by name, you will be automatically directed to the
basic Target-Based Registration tool.

Tip: (*) You can also select a project for which no target has been initially matched.

Note: Targets that are matched together are not renamed.

13.3.4 Instrument Leveling

The "Instrument Leveling" group, in the Ribbon, gathers all the operations available that the user can apply to a station.
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13.3.4.1 Force Leveled

A station for which the leveling parameter is missing because the instrument had not been initially leveled can be manually
set to leveled. You can change the leveling property of a set of stations.

To force leveled:
1. Select an unleveled station from the Scans Tree.

2. Select Instrument Leveling / Force Leveled in Registration > Survey Workflow.

In the Scans Tree, the selected item switches from to .
In the Property window, the "Instrument Leveling" state switches from "False" to "True". The "Instrument Height"
and "Projected Instrument Position" appear with respectively 0.00 m as distance value for the first and 0,0,0 as
coordinates for the second.
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Note: You can undo the operation.

Caution:When you change the status of a station, this does not modify the status of the TZF Scans that are inside, i.e.,
when you set an unleveled station to leveled, the set of TZF Scans that are within remains unleveled.

13.3.4.2 Modify the Instrument Height

To modify the instrument height:
1. Select a leveled station from the Scans Tree.

2. Select Instrument Leveling / Modify Instrument Height. The Modify Station Height dialog opens.
3. Enter a distance value in the Station Height field.
4. Click Apply. The Modify Station Height dialog closes.

In the Property window, the current value of the "Instrument Height" line changes. In the example below, the keyed-
in value 1.50 m is displayed instead of 0.
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The new set value is added to the Z coordinate of all items (point, geometry, scanner origin, etc.) of the selected sta-
tion.
If some targets of the selected station have been previously paired with targets of other stations, a warning mes-
sage appears and warns you that a Network Adjustment of the project is now necessary to adjust corresponding sta-
tions.

Tip: You can also select and right-click on a leveled station in the ProjectTree and select Modify Instrument Height from the
pop-up menu.

Note: You can undo the operation.

The Instrument Height is always related to a station. In case there are several TZF Scans within a selected station, you are
able to select a unique TZF Scan and set the Instrument Height parameter to it. This parameter is then applied to the station
the TZF Scan belongs to. When you switch from one station to another station, the value you set in the dialog for the first sta-
tion is not kept, it is reset to zero for the second station.

13.3.4.3 Set Over Known Point

Setting-up a station over a Known Point consists of associating both together. A Known Point can be a fitted target (sphere
or flat target), a Survey Point or a Topo Point. It must belong to a different station than the selected one.

To setup over a known point:
1. Select a leveled station from the Scans Tree.

2. Select Instrument Leveling / Set Over Known Point. The Set Over Known Point dialog opens.
3. Expand the Project Tree if required.
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1 - A leveled station* 2 - Registration items

4. In the Set Over Known Point dialog, the Project Tree gathers all registration items except those belonging to the
selected station.

5. Select an item. The OK button becomes enabled.
6. Click OK. The Set Over Known Point dialog closes.

In the Scans Tree, the station item switches from * to .
In the Property window, the "Over a Known Point" line appears. The selected item's name appears in that line. The
"Projected Instrument Position" and "Instrument Origin" lines are updated respectively with the selected item's 3D
coordinates and the selected item's 3D coordinates plus the Instrument Height value for the Z value.

7. In the Targets Tree, a matched folder is created with the selected station and the known point inside.
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Note: You can undo the operation.
Notes:

n If some targets of the selected station have been previously paired with targets of other stations, a warning mes-
sage appears and warns you that a Network Adjustment of the project is now necessary to adjust corresponding sta-
tions.

n (*) It is not necessary to have a leveled station as input.

Caution: The Set Over Known Point feature is dimmed if there is no target inside the other station.

13.3.4.4 Remove Known Point

Removing a Known Point from a station consists of dissociating one from the other; this doesn't require any parameter and
no dialog appears. To change the current Known Point of a station; first remove it and then associate a new Known Point.

To remove a known point:
1. Select a station setup over a known point from the Scans Tree.

2. Select Instrument Leveling / Remove Known Point in Registration > Survey Workflow.

In the Scans Tree, the selected station switches from to .
In the Property window, the "Over a Known Point" line disappears. Note that the coordinates in the "Projected Instru-
ment Position" and "Instrument Origin" lines remain unchanged.

Note: You can undo the operation.
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13.3.4.5 Force Unleveled

To force unleveled:
1. Select a leveled (or setup over a known point) station from the Scans Tree.

2. Select Instrument Leveling / Force Unleveled in Registration > Survey Workflow.

In the Scans Tree, the selected item switches from (or ) to .
In the Property window, the "Instrument Leveling" state switches from "True" to "False". For a leveled station, the
"Instrument Height" and "Projected Instrument Position" information are lost. For a setup over a known point sta-
tion, the "Instrument Height", "Over a Known Point" and "Projected Instrument Position" information are lost.

Note: You can undo the operation.

Caution:When you change the status of a station, this does not modify the status of the TZF Scans that are inside, i-e,
when you set a leveled station to un-leveled, the set of TZF Scans that are within remains leveled.

13.3.5 Create Points

The "Create Points" menu gathers the operations related to the creation of points. It can be reached from the Survey Work-
flow group, in the Ribbon.

13.3.5.1 Create Topo Point

To create a Topo Point:
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1. Select anything from the Project Tree.
2. Select Create Point / Create Topo Point in Registration > Survey Workflow. The Create New Topo Point dialog

opens.
3. Keep the default name TopoPoint.
4. Or enter a new name in the Topo Point Name field.

n If the given name does not exist, jump to the next step.
n If the given name already exists, a dialog appears and prompts to set a new name instead. Click Yes to use the

new name.
5. Enter new coordinates in the Coordinates field.
6. Click Create. The Create New Topo Point dialog closes.

An unmatched Topo Point is created and placed under a station (named TopoStation System) in the Scans Tree.
This Topo Point is shown in the 3D View.

Note: You can undo the operation.

Tip: You can display (or hide) the Topo Point's 3D Labels by selecting Rendering/Display 3D Labels from the 3D View
menu. The Display 3D Labels feature once selected has a check mark on its side.

13.3.5.2 Create Topo Points from Selected Station Positions

To create Topo Points from selected station positions:
1. Select a station (set of stations or a project) from the Project Tree.

2. Select Create Points / Create Topo Points from Selected Station Positions in Registration > Survey Workflow.
n For each station, an unmatched Topo Point is created and placed under a station named TopoStation System in

the Scans Tree.
n All created Topo Point are shown in the 3D View and are named according to the station names.
n If the selected station is leveled and has a height, only its position projected on the ground is used to create a

Topo point.
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Note: You can undo the operation.

Tip: You can display (or hide) the Topo Point's 3D Labels by selecting Rendering/Display 3D Labels from the 3D View
menu. The Display 3D Labels feature once selected has a check mark on its side.

Tip: You can export the created Topo Point 3D coordinates in a RTF report by selecting the Export Object Properties fea-
ture.

13.3.5.3 Create Point Cloud from Topo Points

To create a point cloud from Topo Points:
1. Select a Topo Point (or a set of TopoPoints) from the Scans Tree.
2. Select Create Points / Create Point Cloud from Topo Points in Registration > Survey Workflow.

Each Topo Point is converted to a 3D coordinate point. In the Scans Tree, all are gathered in a scan named
TopoStationCloud which is placed under a leveled station (blue color) named FromTopoStation. This scan is dis-
played in the 3D View. In the Models Tree, a new point cloud (named FromTopoStation) is created.

Notes:
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n You cannot undo the operation.
n By default, the Project Cloud does not contain the newly created point cloud.

13.3.5.4 Create 3D Points

You can convert any registration entity (matched or unmatched) to a 3D coordinate point. A registration entity can be a
Spherical Target, a Flat Target, and a Survey Point coming from a survey network file, an imported Topo Point or a Topo
Point created within a RealWorks tool such as the Georeferencing tool or a target obtained by geometry fitting. The idea of
this feature is to convert the barycentre of a registration entity to a 3D Point. This barycentre is the averaged center position
when selecting a set of matched targets.

To create a 3D point from a target:
1. From the Scans Tree, select a set of matched (or unmatched) entities from a station.
2. Select Create Points / Create 3D Points From Targets in Registration > Survey Workflow. An information box

opens.
3. Click OK. The information box closes.

A group named Target_Point (x) is created and rooted under the current project in the Models Tree; where X is its
creation order. This group gathers the entities that are converted to 3D Points. There is a Target_Point group per
conversion. Each 3D Point has the name of the entity it is issued from.

Note: A selection is always from the Scans Tree. When you select an unmatched entity from the Unmatched folder
(or a matched entity from a pair) in the Targets Tree, only the FromMatched Targets command is available. For
both a warning message appears and warns that the selection is not valid.

Tip: You can display (or hide) the 3D Point's 3D Labels by selecting Rendering/Display 3D Labels from the 3D View menu.
The Display 3D Labels feature once selected has a check mark on its side.
To create a 3D point from a matched target:

1. From the Targets Tree, select at least a pair of matched entities.
2. Select Create Points / Create 3D Points From Targets in Registration > Survey Workflow. An information box

opens.
3. Click OK. The information box closes.

A group of AverageCenter_mTarget is created and rooted under the current project in the Models Tree. This group
contains the average barycenter of the matched entities. Each 3D Point has the name of the pair (of matched entit-
ies) it is issued from.

Notes:
n There is no Undo.
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n The Create 3D Points FromMatched Targets command is available even if you select a single matched entity from
a pair. But a warning message appears and warns you that the selection is not valid. No 3D Point is then created in
the Models Tree.

Tip: You can display (or hide) the 3D Point's 3D Labels by selecting Rendering/Display 3D Labels from the 3D View menu.
The Display 3D Labels feature once selected has a check mark on its side.

13.4 TRANSFORMATION TOOLS

A TZF format file holds registration parameters which are Vector of Translation, Axis of Rotation and Angle of Rotation. On
the first import of TZF format files, in the case of a new project e.g., RealWorks creates new stations and automatically ini-
tializes them with the registration parameters of the TZF format files. These registration parameters will no longer be read
(or written) anymore after the initialization even if they are changed in the meantime. The only way these parameters can
be read (or written) is by performing an explicit import (or export).

All the features related to this import (or export) are gathered in the Transformations group, in the Registration tab.

13.4.1 Import Station Registration Parameters from TZF Files

Select Import Station Registration Parameters from TZF Files in Registration > Transformations > TZF. It will read the regis-
tration information from the TZF format files and to apply them to the station they belong to, as illustrated below

Notes:
n No selection is required but you need to have at least a project loaded in RealWorks.
n If the project contains a station that is not valid (with no TZF Scan(s) within), a dialog opens and asks you to pro-

ceed with the remaining station(s). Choosing No will interrupt the import process.

13.4.2 Export Station Registration Parameters to TZF Files

Select Export Station Registration Parameters to TZF Files in Registration > Transformations > TZF. It will write the regis-
tration information of a station into all its related TZF format files, as illustrated below.
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Note: You need to have at least a project loaded in RealWorks and you need to perform a selection from the project to
enable this feature, whatever the selection.

13.4.3 Export Station Registration Parameters to RMX Files

This feature lets you export the Station Registration Parameters that have been applied to stations (empty or not) in batch
(or interactive) processing mode. The registration parameters (Vector of Translation, Axis of Rotation and Angle of
Rotation) are stored in a file of RMX format which is an ASCII format file. One RMX format file will be created for each sta-
tion. The RMX format file has the same name as the registered station.

To export the station registration parameters to RMX Files:
1. First apply transformation to stations (if required)*.
2. Then select either a project (or a station (or a set of stations)).
3. Select Export Station Registration Parameters to RMX Files in Registration > Transformations > RMX. The Select

New File Folder dialog opens.
4. Navigate to the drive/folder where you want to store the RMX format files in the In field.
5. Click Open. The Select New File Folder dialog closes.

Below is an example of what a RMX format file looks like.

Note: (*) If any transformation has been applied to stations; the registration parameters (Vector of Translation, Axis of Rota-
tion and Angle of Rotation) are equal to zero.
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13.4.4 Register Stations With Imported RMX Files

This feature allows you to import and apply registration parameters to stations (empty or not) in batch (or interactive) pro-
cessing mode. The registration parameters (Vector of Translation, Axis of Rotation and Angle of Rotation)* are stored in a
file of RMX format which is an ASCII format file. You need to have one RMX format file per station. The RMX format file has
the same name as the station to register.

To register stations with imported RMX files:
1. Select a project or a station (or a set of stations).
2. Select Register Stations With Imported RMX Files in Registration > Transformations > RMX. The Select New File

Folder dialog opens.
3. Navigate to the drive/folder where the RMX format files are stored in the In field.
4. Select and open the folder by double-clicking on it**.

n The RMX format files will be processed one after the one.
n For a given RMX format file, if RealWorks finds a related station; the registration parameters will be applied to

the station. If the RMX format file has no corresponding station; the warning dialog below appears. Click OK.
The registration parameters won't be applied.

Notes:
n (*) 3D coordinates in millimeters.
n (**) Otherwise the above warning dialog appears.

13.5 QUALITY ASSURANCE TOOLS

The Quality Assurance group provides a quick way to visually check the quality of the registration, by creating cross sec-
tions and specific areas for analysis.

13.5.1 Registration Visual Check

The Registration Visual Check feature offers the ability for different teams working on the same project to exchange the
information in order to quickly and visually check the result of a registration by isolating roughly an area on the result, and in
details a station where the registration issue is present.

13.5.1.1 Open the Tool

To open the tool:
n Select Registration Visual Check in Registration > Quality Assurance.

The Registration Visual Check dialog opens and the rendering option swaps automatically to Station Color.

Note: No selection is required. The use of this tool is based on what is displayed in the 3D View.
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Tip: You can open the Limit Box window by clicking the Limit Box List icon in order to view, edit and load the saved limit
box. Please refer to the Managing Limit Boxes section for more information.

Note: You can undo and redo certain operations when using the tool, or after using the tool. These operations are those
that affect the canonical views, the station color and the limit box creation.

13.5.1.2 Define a Limit Box

In the first step, we have to define an area on the registration result, symbolized by a limit box that we want to focus on.
There are three different ways to define the orientation of a limit box:

n Define a Limit Box by Defining a Horizontal Slice.
n Define a Limit Box by Defining a Slice Perpendicular to the Screen.
n Import an already existing limit box thanks to the Import feature in the Limit Box List .

Note:When you load a saved limit box, the Thickness field will be updated with the Thickness value of the loaded limit box.

13.5.1.2.1 Define a Limit Box by Defining a Horizontal Slice

The Horizontal Slice feature lets the user define a limit box whose:
n Orientation is given by a plane (1) whose center lies at the position of a picked point (2), and whose normal is par-

allel to the Z axis.
n Height (3) is given by the value in the Thickness field.
n Width (4) is extended to the whole displayed scene.

Note: You need to pick one point on the displayed objects in the 3D View.

Note: You cannot enter a negative value in the Thickness field.

13.5.1.2.2 Define a Limit Box by Defining a Slice Perpendicular to the Screen
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The Slice Perpendicular to Screen feature lets the user define a limit box whose:
n Orientation is given by a plane (1) passing through two picked points (2) and perpendicular to the screen,
n Height (3) is given by the value in the Thickness field.
n Width (4) is extended to the whole displayed scene.

Note: You need to pick two points on the displayed objects in the 3D View.

Note: You cannot enter a negative value in the Thickness field.

13.5.1.2.3 Edit the Properties of a Limit Box

A limit box is a three-dimensional figure with six square faces. It is used to isolate a region on clouds and/or geometries.

Change the Center of a Limit Box

To change the center point of a limit box:

1. Click the Change Limit Box Center Point icon. The cursor changes to show the following .
2. Pick a point on the displayed clouds and/or geometries.

n The limit box is then centered on the picked point.

Note: To leave the picking mode, you can press Esc.

Manipulate a Limit Box

There are three modes of manipulations, Modify Shape, Pan and Rotate.

Resize a Limit Box
To resize a limit box:

1. Click the Modify Shape icon. A manipulator with six Face Handles appears, one on each face of the limit box, and
eight Corner Handles.
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2. To increase or decrease the size of the limit box in one direction:
n Pick a Face Handle to select it. It turns yellow.
n Drag and drop the Face Handle away from (or toward) the center of the limit box.

3. To increase or decrease the size of the limit box, uniformly in all directions.
n Pick a Corner Handle to select it. It turns yellow.
n Drag and drop the Corner Handle away from (or toward) the center of the limit box.
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Tip: You can also select Modify Shape from the pop-up menu.

Tip: You can also use the E shortcut key instead.

Note: Resizing a limit box will change consequently the value of its Thickness.
Pan a Limit Box
To pan a limit box:

1. Click the Pan icon. A manipulator, which is composed of three Axis Handles and three Plane Handles, appears. It
has as its origin the center of the limit box.

2. Do one of the following:
n Pan in a plane.
n Pan along a direction.

Tip: You can also select Pan from the pop-up menu or use its associated shortcut key T.

Note: It is advantageous to display the clouds and/or geometries that are outside the limit box and/or all of the Station Pos-
itions of the project. By doing this, you can know exactly where you are within the rest of the cloud and/or within all of the sta-
tions.

Tips:
n You can use the following keys (á,â,ß,à, Page Up, Page Down) on your numeric keypad to move the limit box.
n You can combine the use of the above keys with the Ctrl key to speed up the movement of the limit box.

Pan Along a Direction
To pan the limit box along a direction:

1. Pick an Axis Handle to select it. It turns yellow. A direction in yellow aligned with the Axis Handle appears.
2. Drag the Axis Handle along the direction to move the limit box in that direction.
3. Drop the Axis Handle.

The cloud inside the limit box is automatically updated.
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Pan in a Plane
To pan the limit box in a plane:

1. Pick a Plane Handle to select it. A larger yellow Plane Handle is displayed.
2. Drag the Plane Handle in any direction on the plane to move the limit box in that direction.
3. Drop the Plane Handle.

The cloud inside the limit box is automatically updated.

Rotate a Limit Box
To rotate a limit box:

1. Click the Rotate icon. A manipulator, which is composed of three Ring Handles (red, light blue and green), is dis-
played. This manipulator has the center of the limit box as the origin.

2. Pick a Ring Handle to select it. It turns yellow. An axis, passing through the center of the ring and perpendicular to it,
appears. This axis has the color of the selected ring.
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3. Drag the Ring Handle to rotate the limit box around the axis.
4. Drop the Ring Handle.

The cloud inside the limit box is automatically updated.

Tip: You can also select Rotate from the pop-up menu or use its related shortcut key R.

Switch from one Mode of Manipulation to Another
You can easily switch between the different manipulation modes, i.e. from Modify Shape to Pan, and from Pan to Rotate,
and so on, by just picking one of the Handles.

Note: The cursor changes to when you hover it over a Handle.

13.5.1.3 Inspect Visually

In the first step, we have to find out the stations that are involved in the registration issue, by doing one of the following:
n Inspect the limit box from different sides.
n Isolate the station(s) by coloring it (or them).
n Identify the station(s) by name.
n Hide (or display) the station(s) that is (or are) needed.

13.5.1.3.1 Display and Hide Clouds/Geometries Outside the Limit Box

All objects that are outside the limit box, whatever they could be, can be at any time displayed, or hidden.
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To display clouds and geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are displayed in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon is highlighted in yellow.

To hide clouds and geometries outside the limit box:
n Click the Show/Hide Clouds and Geometries Outside the Limit Box icon.

n Clouds and/or geometries outside the limit box are hidden in the 3D View.
n The Show/Hide Clouds and Geometries Outside the Limit Box icon becomes unselected.

13.5.1.3.2 Display and Hide a Limit Box

A limit box can be displayed and hidden at any time.

To display a limit Box:
n Click the Show Limit Box icon.

n The limit box, with its manipulator (Size, Pan or Rotate), is displayed in the 3D View.
n The Show Limit Box icon is highlighted in yellow.

To hide a limit box:
n Click the Show Limit Box icon.

n The limit box, with the current manipulator, is removed from the 3D View.
n The Show Limit Box icon becomes unselected.

13.5.1.3.3 View a Limit Box From Different Sides

To view a limit box from different sides:
1. Click on the View pull-down arrow.
2. Choose a side among Front View (1), Back View (2), Left View (3), Right View (4), Top View(5) and Bottom View

(6).
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13.5.1.3.4 Define the Moving Step

The user has to specify a Step (3) to move from a section to another, along the direction (2) given by the normal of the sec-
tioning plane (1).

13.5.1.3.5 Navigate Through the Sections

You can move the limit box previously defined with a constant Step (1) along the direction (2) given by the normal of the sec-
tioning plane.

n Use the Next button to move up the defined limit box from one Step.
n Use the Previous button to move down the defined limit box from one Step.
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Tip: You can use the arrow keys, Left and Right, used as shortcut keys, instead of Previous and Next.

13.5.1.3.6 Change the Color of a Station

When you create a station, a random color is automatically assigned to the station. Inside an area, several stations may
have colors that are very close. This makes the comparison very difficult as each station cannot be easily distinguished
from the others with their color. You can manually change the color of each station, in the Property window, but this can be
very tough as all of the stations are not obviously in the same place in the Project Tree. You may need to expand or shrink
the Project Tree to change the color of a station.

The Change Station Color feature lets you change the color of each station directly in the 3D View. You can use a pre-
defined color, a customized color or a color coming from an imported color palette.

To change the color of a station:
1. Click on the Change Color drop-down arrow. A color palette appears.
2. Choose a color from the color palette.
3. In the 3D View, fill points with the chosen color.

The station whose points have been colored is colored with the same color.
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Note: You can leave the coloring mode by selecting Close Pick Point from the pop-up menu.

13.5.1.3.7 Identify a Station

To identify a station in the 3D View, you can place the cursor over the displayed point cloud, the name of the station the
point cloud belongs to appears as a tooltip.

13.5.1.3.8 Display and Hide a Station

The keys H and D, are commonly used as shortcuts to rapidly hide and show a scan in the 3D View. In the Registration
Check tool, these two buttons in addition to hide or display the selected scan, also hide and display the station the selected
scan belongs to.

The keys H and D, when used outside the tool, behave differently. They only hide or show the scan selected from the 3D
View.

13.5.1.4 Isolate an Area of Interest

To isolate an area of interest:
1. Click the Draw Area button.

n If the limit box has been defined with the Horizontal Slice method, the 3D View is then locked in 2D, in the XY
plane of the current frame, with the 2D grid displayed (if not previously hidden).

n If the limit box has been defined with the Slice Perpendicular to Screen method, the 3D View is then locked in
2D, in the plane defined by the two picked points and perpendicular to the screen, with the 2D grid (if not pre-
viously hidden).

2. Pick two points to define a rectangular fence.
3. If required, resize the rectangular fence by doing the following:

n Drag and drop a corner.
n Drag and drop a middle node of a segment.

4. If required, cancel the current fence and start a new one by selecting Redraw Area from the pop-up menu.
5. Click the Done button.

The current limit box is resized to the size of the defined zone of interest.

Tip: You can also select Done from the pop-up menu.

13.5.1.5 Store the Area as a Limit Box

In this step, the user can record the current limit box. This record will be added to the Limit Box List window, and can be
exported to an XML file.

In addition to the name, the user can add a comment to the Limit Box Object just like an ‘annotation’. These records can
then be exported and sent, and then reviewed just by using the limit box tool.

To store the area as a limit box:
1. Input a name in the Name field.
2. Or keep the default one.
3. If required, add a comment in the Description field.
4. Click the Store button.

n If the Limit Box window is open, the limit box is added to the limit box list.

Note: You need to input a name in the Name field to be able to store the area as a limit box.

Note: As described previously, no selection is required to open the tool. It is based on what is displayed in the 3D View win-
dow. The defined limit boxes will be saved in the current open project, and anywhere else. To avoid confusion, in the case
there are several projects that are open in RealWorks, the Save button will be grayed out. You will not be able to save the
defined limit boxes.

Trimble RealWorks User Guide | 401



PRODUCTION TOOLS

When you load a file of any format, except SIMA and TXT with topopoints, that had never been previously saved in the
RealWorks format; the Production processing mode is set by default.

When you load a file saved in the RealWorks format and in the Production processing mode; that file will be opened with
that processing mode set. When you are out of this processing mode and you need to be in it; you have to choose the Pro-
duction mode on the Quick Access Toolbar on the top of the user interface:

14.1 DRAWING TOOLS

The Line Work group includes a set of tools that lets the user create, use and manipulate polylines.

The Features group mainly includes two tools. The first one allows the collection of a set of surveying points/chains from a
scanned point cloud in a way that simulates regular surveying methods. The second one enables you to create and edit a
feature set library usable directly with the first tool or with the new feature set capability in the Trimble Scan Explorer.

The Slice Tools group includes a series of tools with the slicing capability. From either a point cloud or a mesh, the user can
create a terrain contour map, a set profile and cross-sections along an alignment, or perform a slice.

Note: The user can also find the Slice Tools group from the Drawing tab on the Surfaces tab.

14.1.1 2D-EasyLine

14
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This tool allows you to create polylines from point cloud's slice(s) that result(s) from the use of the Cutting Plane tool or from
planar polylines. The resulting polylines can contain only segments or a combination of segments and circular arcs. The
2D-EasyLine tool can be used as a standalone tool or as a sub-tool inside the Cutting Plane tool.

14.1.1.1 Open the Tool

The behavior of the 2D-EasyLine tool depends upon the input data.

If the input data is a pure point cloud slice, Step 1 of the 2D-EasyLine dialog looks as shown in [A]. You can use either the
automatic procedure or the manual procedure (Step 2 in the 2D-EasyLine dialog) for modeling polylines.

[A] When a cloud slice has been selected:
1. In the Cutting Plane dialog, select a point cloud slice.
2. Click on the 2D-EasyLine button.

Or
3. Select a point cloud slice from the Models Tree.
4. Select 2D-EasyLine in Drawing > Line Work.

n Both the number of segments and the number of arcs are equal to zero.
n The sub-tools (Sampling and Segmentation) as well as the Display Cloud option and the Preview button are

enabled.

If the input data is a planar polyline (without points inside), Step 1 of the 2D-EasyLine dialog looks as shown in [B]. You can
only edit the planar polyline (Step 2 in the 2D-EasyLine dialog).

[B] When a planar polyline has been selected:
1. Select a planar polyline (with no points inside) from the Models Tree.
2. Select 2D-EasyLine in Drawing > Line Work. The 2D-EasyLine dialog opens as shown below.

n The number of segments and the number of arcs inside the planar polyline are shown in text in Step 2.
n The sub-tools (Sampling and Segmentation) as well as the polyline computation parameter (Threshold) and the

Preview button are all dimmed.

If the input data is a planar and fitted polyline (with points inside), Step 1 of the 2D-EasyLine dialog looks as shown in [C].
You can choose between the two procedures for modeling new polylines or use the editing tools to modify the planar and fit-
ted polyline.
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[C] When a planar and a fitted polyline have been selected:
1. Select a planar and fitted polyline (with points inside) from the Models Tree.
2. Select 2D-EasyLine in Drawing > Line Work. The 2D-EasyLine dialog opens as shown below.

n The number of segments and the number of arcs inside the planar polyline are shown in text in Step 2.
n The sub-tools (Sampling and Segmentation) as well as the polyline computation parameter (Threshold), the Pre-

view button and the two displayed options (Display Cloud and Displayed Polyline) are all enabled.

The selection required to open the tool - planar polyline (fitted or not) or point cloud slice - is displayed in a planar view (2D)
with the 2D grid in superimposition. This means that the planar polyline (fitted or not) or the point cloud slice is locked in 2D;
you can navigate through it (like performing a zoom, panning or rotation). You can use the View Manager toolbar to show
the 3D sub-view and the planar view at the same time, or to switch between them. In the planar view, you can use the pop-
up menu to modify the size of the 2D grid or to hide it.

14.1.1.2 Model Automatically Polylines

The automatic modeling procedure uses an algorithm which approximates points of the selected cloud slice (or fitted poly-
line) with segments. The Threshold parameter will be used so that points of the selected cloud (or fitted polyline) which are
inside the Threshold will be taken into account for the automatic modeling procedure. You can change the modeling para-
meter and use Preview where several attempts are required*.

To model automatically polylines:
1. Enter a value in the Threshold field and press Enter.
2. Or select a value using the Up (or Down ) button.
3. Click on the Preview button.

n If the input data is a pure slice cloud, new polylines are modeled according to the value set in Threshold and are dis-
played in the 3D View. You have a choice between the two display options (Display Cloud and Display Polyline) and the
Reload Initial Cloud - Polyline is grayed out.

The Reload Initial Cloud - Polyline is dimmed

Note: The other editing tools in Step 2 in the 2D-EasyLine dialog become enabled.
n If the input data is a fitted polyline, new polylines are modeled according to the value set in Threshold and are displayed

in the 3D View. You have a choice between the two display options (Display Cloud and Display Polyline) and the Reload
Initial Cloud - Polyline becomes enabled.
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The Reload Initial Cloud - Polyline is enabled

Note: Reload Initial Cloud - Polyline cancels the computed polyline(s) and reloads the initial polyline.
n For both, the number of segments and the number of arcs will be updated according to the Threshold value. (*) If the

Threshold value is too high, new polylines cannot be built. The number of segments and the number of arcs fall to zero.
The Step 1 becomes as shown below and only points are displayed in the 3D View.

Both the Reload Initial Cloud - Polyline and the Display Polyline are dimmed

14.1.1.3 Model Manually Polylines

You can use the Polyline Drawing tool to model by hand polylines. You can model polylines with only segments or a com-
bination of segments and circular arcs. If the input is a planar polyline (fitted or not), the Step 2 looks as shown in [A]. If the
input is a pure slice cloud, it is as shown in [B].
[A] [B]

Polyline Drawing

To model manually polylines:

1. Click Polyline Drawing . The Drawing and Picking Parameters (in 2D constraint mode) toolbars appear.
2. Pick a series of points (on displayed points or not) to draw a polyline.

n After modeling by hand a polyline, the number of segments and the number of arcs that are inside are shown in
text.

Trimble RealWorks User Guide | 405



PRODUCTION TOOLS

n If the input is a planar polyline (fitted or not), Reload Initial Cloud - Polyline becomes enabled. Click on it to
reload the initial polyline.

n If the input is a pure slice cloud, the other editing tools become enabled.

Note: The Create button in the Drawing toolbar is dimmed. To validate the polyline, choose Close Tool from the toolbar or
from the pop-up menu.

14.1.1.4 Edit Polylines

You can edit the modeled polyline. The edition can be done manually or thanks to filters. If you want to use the by-hand
method; choose the Polyline Drawing tool to move or add vertices, delete a segment, etc. (see the Polyline Drawing tool) or
use the Edit Polyline tools to define which parts of the modeled (or selected) polyline you want to keep. If you want to use
the by-filter method, any selection is required and you can apply filters like simplification, smoothing, filling holes, etc.

1 - Polyline Drawing
2 - Change Selection Mode
3 - Reverse Selection
4 - Smooth

5 - Filtering methods
6 - Filtering parameter
7 - Filtering option
8 - Simplify button

9 - Number of segments/arcs in the selec-
ted/modeled polyline(s) before edition

14.1.1.4.1 Select Items

We describe hereafter the different selection modes that you can use for editing polyline(s). There are four modes in all.
Before selecting items from the displayed polyline(s), only two modes can be used: Standard Selection and Multi Selection.
Once a first selection is made, the two other modes become enabled: Partial Deselection and Partial Reselection.

Items in the polyline(s) are mainly arcs and segments. The information box at the top right-corner of the 3D View displays in
text the number of arcs and the number of segments in the selection. The 2D-EasyLine dialog displays the total number of
arcs and segments in the polyline(s). The numbers in the information box will be updated automatically each time you add
or subtract items from the polyline(s).

To select items:
1. Select item(s).
2. Add the new selected item(s) to the previous one(s).

Once a first selection is made, the two other selection modes - Partial Deselection and Partial Reselection - in
Change Selection Mode become active as well as Change Deletion Mode.

3. Subtract the new selected item(s) from the previous one(s).
4. Intersect the new selected item(s) with the previous one(s).
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Clicking Reverse Selection will set unselected items as selected and those are selected as unselected. If any poly-
gonal fence has been drawn, clicking Reverse Selection will then select the whole polyline in the 3D View.

Notes:
n The polygonal fence should contain at least one item (segment or arc) in its entirety so that this item can be selec-

ted.
n You can undo a selection by using the Undo command.
n Selecting New Fence from the pop-menu (or pressing Esc) will undo the polygonal fence in progress.
n Selecting Clear Selection from the pop-menu will clear the polygonal fence from the polyline(s).

Tips:
n Instead of double-clicking to close the polygonal fence, you can also right click anywhere in the 3D View window

and select End Fence from the pop-up menu.
n You can select Clear Selection from the pop-up menu to cancel the selection.

14.1.1.4.1.1 Standard Selection Mode

To select:
1. Click on the Change Selection Mode pull down arrow.
2. Choose Standard Selection Mode .
3. Draw a polygonal fence.

1 - Polygon in the Standard Selection mode 2 - Selected items (in red)

14.1.1.4.1.2 Multi-Select

To multi-select:
1. Click on the Change Selection Mode pull down arrow.
2. Select Multi-Selection Mode .
3. Draw a series of polygonal fences.

1 - Initial selection 2 - Polygon in the Multi Selection
mode

3 - Newly selected items are added to
previous selected items

Tip: In the Standard Selection Mode, hold the Ctrl (or Shift) key pressed and pick a point to define the first vertex of a poly-
gonal fence.

14.1.1.4.1.3 Partial Deselect
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To partial deselect:
1. Click on the Change Selection Mode pull down arrow.
2. Select Partial Deselection Mode .
3. Draw a polygonal fence.

n If the polygonal fence contains some of the previously selected items. These items are deselected and the oth-
ers remain selected.

n If the polygonal fence contains any of the previously selected items. No subtraction will be performed.

1 - Initial selections (in red) 2 - Polygon in the Partial Deselection
mode

3 - Newly selected items are removed
from previous selected items

Tip: In the Standard Selection Mode, hold the Alt key pressed and pick a point to define the first vertex of a polygonal fence.

14.1.1.4.1.4 Partial Reselection Mode

To partial reselect:
1. Click on the Change Selection Mode pull down arrow.
2. Select Partial Reselection Mode .
3. Draw a polygonal fence.

n If the polygonal fence contains some of the previously selected items; then common items remain selected and
the others are unselected.

n If the polygonal fence contains any of the previously selected items. No intersection will be performed.

1 - Initial selections (in red) 2 - Polygon in the Partial Reselec-
tion mode

3 - Only common items between new
and old selected items are kept

Tip: In the Standard Selection Mode, hold the Ctrl + Alt keys pressed and pick a point to define the first vertex of a poly-
gonal fence.

14.1.1.4.2 Delete Items

You can now continue editing the selected/modeled polyline(s) using the available filters. Filters can be separated into two
categories. The first category contains filters for which you do not need to set parameters. These filters are: Delete Selec-
tion, Delete Selection Filling Holes and Smooth.

To delete items:
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1. Perform a selection as described previously.
2. Click on the Change Deletion Mode pull down arrow.
3. Select Delete Selection from the drop down list.

n Segments and arcs inside the selection are deleted.
n If the input is a slice cloud, Reload Initial Cloud - Polyline remains dimmed.
n If the input is a polyline (fitted or not), Reload Initial Cloud - Polyline becomes enabled. Click on it to reload the ini-

tial polyline.

Note: You can also right-click anywhere in the 3D View window to display the pop-up menu and select Delete Selection.

To delete items and prevent from hole creation:
1. Perform a selection as described previously.
2. Click on the Change Deletion Mode pull down arrow.
3. Select Delete Selection Filling Holes from the drop down list.

n Segments and arcs inside the selection are deleted and the extremities are connected together.
n If the input is a slice cloud, Reload Initial Cloud - Polyline remains dimmed.
n If the input is a polyline (fitted or not), Reload Initial Cloud - Polyline becomes enabled. Click on it to reload the ini-

tial polyline.

1 - Selected items (in red) 2 - Selected items are deleted 3 - Selected items are deleted and extremit-
ies are connected

Tip: You can also right-click anywhere in the 3D View to display the pop-up menu and select Delete Selection Filling Holes.

14.1.1.4.3 Apply Filters

The second category contains filters for which parameters and options should be set. These filters are Simplification and
Fill Line Breaks. The purpose of the Simplification filter is to simplify the selected/modeled polyline(s) by segments. The Tol-
erance parameter will be used in this filter so that the original points or the polyline vertices will be inside this tolerance with
respect to the final approximated polyline(s). You can choose the Use Arcs option; the filter will use both segments and arcs
to approximate the original polyline(s). The purpose of the Fill Lines Breaks filter is to fill gaps on the selected/modeled poly-
line(s) with segments. The Gap parameter will be used in this filter so that gaps whose size is smaller than this parameter
will be filled by segments. Note that the default unit of measurement is set to millimeters; you do not need to enter “mm”
after the value. You can change the default unit of measurement in Preferences.

Notes:
n No selection is required for both the Simplification filter and the Fill Line Breaks filter.
n If a selection has been done, both the Simplification filter and the Fill Line Breaks filter are applied to the selection.

To simplify the modeled polyline:
1. Drop down the selection list and select Simplification.
2. Enter a value in the Tolerance field and press Enter.
3. Or select a value using the Up (or Down ) button.
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4. Select the Use Arcs option if needed.
5. Click on the Simplify button.

n Segments and arcs displayed in the 3D View are simplified.
n If the input is a slice cloud, Reload Initial Cloud - Polyline remains dimmed.
n If the input is a polyline (fitted or not), Reload Initial Cloud - Polyline becomes enabled. Click on it to reload the ini-

tial polyline.

To fill the line breaks:
1. Drop down the selection list and select Fill Line Breaks.
2. Enter a value in the Gap field and press Enter.
3. Or select a value using the Up (or Down ) button.
4. Click on the Fill button.

n Line breaks are filled with segment lines.
n If the input is a slice cloud, Reload Initial Cloud - Polyline remains dimmed.
n If the input is a polyline (fitted or not), Reload Initial Cloud - Polyline becomes enabled. Click on it to reload the ini-

tial polyline.

1 - Gap size 2 - Filtering parameters 3 - Gaps filled with segment

14.1.1.5 Saving Results

After checking the modeled results, you can use the Apply button to create them in the RealWorks. Each modeled polyline
will be created as a polyline. Note that if the original is also a polyline, then it will be replaced by the new one.

To save the results:
1. Click Apply.
2. Click Close.

Note: Close can also be selected from the pop-up menu.

14.1.2 Polyline Drawing

This tool allows you to quickly create a polyline drawing by successively picking on the displayed object(s) or not. The final
result is a polyline which you can export as a 3D polyline in DXF (or DGN) format, or as a 2D polyline in DXF format for
coplanar polyline. You can use the Polyline Drawing tool in both the 3D View and the planar view (as used in the 2D-
EasyLine tool). In the latter case, the created polyline is a planar one. You can use this to carry out inspections.

14.1.2.1 Open the Tool

To open the tool:
1. Select and display a point cloud or a geometry in the 3D View.
2. Select Polyline Drawing in Drawing > Line Work. The Drawing toolbar opens.

Or

3. If you are in a main tool like e.g. the 2D-EasyLine, click the Polyline Drawing icon.
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Note: No selection is necessary to access the tool. Anything that is displayed in the 3D View, whether selected or not, can
be picked.

Tip: You can change the color of a drawing polyline in the Preferences / Tools dialog. This change should be done before
entering in the tool, otherwise a message pops up.

14.1.2.2 Define a 3D Plane

You can use the 3D Plane tool to define a 3D plane or lock the screen view in 2D, and draw a polyline on it. The Drawing
toolbar looks as shown below in the Examiner (or Walkthrough) mode:

To use the screen view as a 3D plane:

1. Click the Lock In 2D icon. The Show/Hide Plane icon becomes enabled. The scene is locked in the defined
3D plane with a 2D grid superimposed (if not hidden previously). The Picking Parameters toolbar appears in the 2D
constraint mode.

2. If required, click the Show/Hide Plane icon to display the defined plane.

To define a 3D plane:

1. Click the Start 3D Plane Tool icon. The 3D Plane toolbar and a 3D plane in yellow both appear.
2. Define a 3D plane, and validate it. The Show/Hide Plane icon becomes enabled. The Lock In 2D icon is by

default set. The scene is locked in the defined 3D plane with a 2D grid superimposed (if not hidden previously). The
Picking Parameters toolbar appears in the 2D constraint mode.

3. If required, click the Show/Hide Plane icon to display the defined plane.
The Drawing toolbar looks as shown below in the Based Based mode:

To define a 3D plane:

1. Click the Start 3D Plane Tool icon. The 3D Plane toolbar and a 3D plane in yellow both appear.
2. Define a 3D plane, and validate it. The Show/Hide Plane icon becomes enabled. The Lock In 2D icon is default

set. The defined 3D plane has the following representation:

3. If required, click the Show/Hide Plane icon to display the defined plane.

Tip: You can also select the Start 3D Plane icon from the pop-up menu.

Note: In the Polyline Drawing tool, you can swap from a navigation mode (Examiner/Walkthrough/Station-Based) to
another as often as required.

Note: In the Station-Based mode, the Lock in 2D icon remains unavailable before defining a 3D plane.

Note: If a 3D plane has been selected as input of the Polyline Drawing tool, the 3D scene will be locked on that plane with a
2D grid superimposed (if not hidden previously).

14.1.2.3 Draw a Polyline
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The basic tool to draw a polyline is the action of picking which can be free or constrained. The Polyline Drawing tool, split
into three modes (Polyline, Rectangle and Circle), behaves differently according to the input. In the Polyline mode, if the
input data is of 3D type, you can only draw segments as the Change Mode to Arc icon is dimmed. This is true unless you
lock in 2D in a 3D plane that you have to define. In that case, you can draw segments and/or a combination of segments
and circular arcs. In the Rectangle and Circle modes, the input data can only be of 2D type, or of 3D type but locked in 2D in
a 3D plane the user has to define.

Before RealWorks 9.0:

When you start drawing a polyline, if the cursor is over another polyline, the first node will start exactly at the middle of a seg-
ment (or arc), as illustrated below.

In RealWorks 9.0:

When you start drawing a polyline, if the cursor is over another polyline, the start node will be exactly on the existing poly-
line at the cursor position, as illustrated below. The behavior is the same with the end of the polyline.

14.1.2.3.1 Draw a Chain of Segments and/or Arcs

If you are in 3D, the Drawing tool toolbar opens as shown below and the Picking Parameters toolbar (in the 3D constraint
mode) appears. The Change Mode to Arc, Draw Circle and Draw Rectangle icons are unavailable.

In 3D:
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If you are in 2D, the Drawing toolbar looks as shown here below and the Picking Parameters toolbar in the 2D constraint
mode (H/V or Angle/Distance) appears. The Change Mode to Arc, Draw Circle and Draw Rectangle icons are available.

In 2D:

To draw a chain of segments and/or arcs:
1. Click the Change Mode pull-down arrow.
2. Choose Change Mode to Line (L) from the drop-down list.
3. Pick a point to start the first node of a polyline.
4. Move the cursor to a new position and pick a point. A line, in dash between the two picked points, is displayed.
5. Pick a point to complete the segment.

Note: For the Line mode, the pickings should be done on the displayed object(s) in 3D and can be constrained on a cloud
point using the Ctrl key with the left-click. This means that you cannot pick anywhere except on the point. In 2D (or 3D
locked in 2D), you can pick on displayed object(s) or not.

6. Click the Change Mode pull-down arrow.
7. Choose Change Mode to 3-Point Arc (A) from the drop-down list.
8. Pick a point to start the first node of a polyline.
9. Move the cursor to a new position and pick a point. A line, in dash between the two picked points, is displayed.
10. Move the cursor to a new position. An arc, in dash passing by the two picked points and the cursor, is displayed.
11. Pick a point to complete the arc.

Note: For the 3-Point Arc mode, the pickings should be done on the displayed object(s) in 3D and can be constrained on a
cloud point using the Ctrl key with the left-click. This means that you cannot pick anywhere except on the point. In 2D (or 3D
locked in 2D), you can pick on displayed object(s) or not.
12. Click the Change Mode pull-down arrow.
13. Choose Change Mode to Arc (C) from the drop-down list.
14. Pick a point to start the node of a polyline.
15. Move the cursor to a new position. An arc, in dash passing by the picked point and the cursor, is displayed.
16. Pick a point to complete the arc.

Note: You need to be in 2D (or 3D locked in 2D) and you can pick on displayed object(s) or not.
17. Continue in picking in order to define the other nodes of the polyline.
18. Right-click anywhere in the 3D View to display the pop-up menu.
19. Select End Line to terminate the polyline. The start node is not linked to the last selected node.
20. Select Close Line to end and close the polyline. The start node is linked to the last selected node.
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Tip: You can switch from Line to Arc (or 3-Point Arc) as often as you wish just by pressing respectively the L and C (or A)
keys on your keyboard, by clicking on the Change Mode button in the Drawing toolbar or by selecting its related command
from the pop-up menu.

Note: Pressing Esc while you are picking points will end and validate (but not create) the polyline in progress.

Note: Each time you validate a polyline by double-clicking or by using the End Line and Close Line commands; you can
continue to draw other polylines. These polylines will not be connected.

Tip: You can double-click to end the drawing. In this case, the drawn polyline is always an open one.

Note: For the 3-Point Arc mode, double-clicking with only one validated point will cancel the arc in progress. When two
points have been validated, double-clicking will add a third point at the position of the cursor and will complete the arc. The
Close Line command becomes enabled once there are three valid vertices.

14.1.2.3.2 Draw a Rectangle

To be able to draw a rectangle when the input is of 3D data type, first click the Lock in 2D icon to lock the 3D View in 2D or
define a 3D plane by using the 3D Plane tool. Otherwise, the Draw Rectangle icon remains grayed-out. When the scene is
locked in 2D, there is a 2D grid superimposed (if not hidden previously) and the picking mode switches from 3D constraint
to 2D constraint. When you click again the Lock in 2D icon, the scene is free from the 2D lock and from the 2D constraint
picking mode. If the input is of 2D data type; you do not need to lock the scene in 2D because it is (by definition) locked in a
2D plane.

In 3D:

In 2D:

To draw a rectangle:
1. Click on the Draw Rectangle pull-down arrow.
2. Choose Draw Rectangle by Defining 2 Points from the drop down list.
3. Pick a point. A node  appears. This sets up the first corner of a rectangle.
4. Move your cursor to set up the opposite corner. The node disappears and a dotted rectangle appears. Its shape

changes as long as you move the cursor.
5. Pick a point. A rectangle is then drawn.

Or
6. Click on the Draw Rectangle pull-down arrow.
7. Choose Draw Rectangle by Defining 3 Points from the drop down list.
8. Pick a point. A node  appears. This sets up the first end of a rectangle’ side.
9. Move your cursor to set up the opposite end. The node disappears and a dotted segment appears. Its shape

changes as long as you move the cursor.
10. Pick a point. The segment in dotted becomes continuous and another node  appears.
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11. Move your cursor to set up the opposite end. The node disappears. Three other sides in dotted and perpendicular to
the first side appear. Their length changes as long as you move the cursor.

12. Pick a point. A rectangle is then drawn.

Note: You can switch from the 2-point drawing mode to the 3-point drawing mode and conversely as often as you wish just
by clicking on the Draw Rectangle icon.

Tip: You can also select Lock in 2D, Draw Rectangle by Defining 2 Points and Draw Rectangle by Defining 3 Points from
the pop-up menu.

14.1.2.3.3 Draw a Circle

To be able to draw a circle when the input is of 3D data type, first click the Lock in 2D icon to lock the 3D View in 2D or
define a 3D plane by using the 3D Plane tool. Otherwise, the Draw Circle icon remains grayed out. When the scene is
locked in 2D, there is a 2D grid superimposed (if it has not been hidden previously) and the picking switches from the 3D
constraint mode to the 2D constraint mode. When you click again the Lock in 2D icon, the scene is free from the 2D lock
and from the 2D constraint picking mode. If the input is of 2D data type; you do not need to lock the scene in 2D because it
is by definition locked in a 2D plane.

In 3D:

In 2D:

To draw a circle:
1. Click on the Draw Circle pull-down arrow.
2. Choose Draw Circle by Defining the Center and the Radius from the drop-down list.
3. Pick a point. It will be the center of a circle to come.
4. Navigate through the 3D scene and pick another point. These two points will form the radius of a circle.

Or
5. Click on the Draw Circle pull-down arrow.
6. Choose Draw Circle by Defining the Diameter .
7. Pick a point to start the first point of a circle’s diameter.
8. Navigate through the 3D scene and pick another point to set the second point of the diameter.

Note: You can switch from the center-and-radius drawing mode to the diameter drawing mode and conversely as often as
you wish just by clicking on the Draw Circle button.

Tip: You can also select Lock in 2D, Draw Circle by Defining the Center and the Radius and Draw Circle by Defining the Dia-
meter from the pop-up menu.

14.1.2.4 Select a Polyline (or a Feature Set)
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If there is an already created polyline or a feature set displayed in the 3D View, you can select it by picking on it. Note that
this is only available in 3D (or 3D locked in 2D).

To select a polyline (or a feature set):

1. Click the Import Polyline . The cursor becomes as
2. Pick a polyline (or a feature set). A polyline (in green) appears over the picked polyline (or feature set).

n If a 2D polyline (or a planar feature set) has been picked, the scene is locked in a 2D plane that contains the
picked polyline (or feature set) (the Lock in 2D in the Drawing Polyline toolbar is default set and dimmed) with a
2D grid superimposed (if not hidden previously). The Picking Parameters toolbar appears in the 2D constraint
mode.

n If a 3D polyline (or a non-planar feature set) has been picked, the scene remains unlocked and the Picking Para-
meters toolbar remains in the 3D constraint mode.

Notes:
n Press Esc to leave the picking mode.
n If required, hide all objects displayed in the 3D View; this can help you in picking a polyline (or a feature set).
n If you are in 3D locked in 2D, after choosing Import Polyline and before picking a polyline (or a feature set), the 3D

scene is free from the 2D lock and after picking a polyline (or feature set), the 3D scene comes back to the 2D lock
state.

Tip: You can also check Import Polyline from the pop-up menu.

14.1.2.5 Edit a Polyline

Before creating a polyline, you can delete the whole of it or modify it by deleting, moving and inserting nodes or by con-
tinuing it. When you place the cursor over a segment of a polyline, you may see the following symbols: (Nodes),
(Middle Nodes) and (Middle Nodes to Insert). When you place the cursor over an arc of a polyline; only (Nodes) are
available.

To delete a node:
1. Place the cursor over a node. A solid square appears upon the node.
2. Right-click to display the pop-up menu and select Delete Node.

1 - The selected node on the polyline 2 - The selected node is removed
from the polyline

3 - The selected node is moved
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Notes:
n Deleting the Start (or End) node of a chain of segments will remove the First (or Last) segment from that chain.

Deleting a Conjunction node will delete the segment on both sides of that node.
n Deleting a node at the end of a lonely segment won't delete that segment.
n You cannot delete a node of a lonely arc.

To move a node:
1. Place the cursor over a node. A solid square appears upon the node.
2. Drag the node to a position. The green square turns to yellow. If the node belongs to a segment; that segment

becomes dotted. If it belongs to an arc, the arc shape does not change.
3. Drop the node to that position. Note that in the case of drawing in the 3D View, the new position should be on dis-

played objects.

Notes:
n Moving a node at the end of a segment (or arc) will only move that node.
n Moving a node in the middle of a segment will move the whole segment.
n Picking a point anywhere on a segment except on the end and middle nodes or on an arc except on the end nodes

will transform that point to a node.

To insert a node:
1. Place the cursor anywhere on a segment (except at the end/middle nodes) or on an arc (except at the end nodes).

A hollow square appears upon the segment at the cursor position.
2. Right-click to display the pop-up menu and select Insert Middle Node. A new Middle Node is inserted not at the pick-

ing position but at the middle of the segment (or arc).

1 - Two opposite ends 2 - A node is inserted between the two ends

To continue a polyline:
1. Place the cursor over the end (or start) node of a polyline or anywhere over the last segment of a polyline.
2. Right-click to display the pop-up menu and select Continue. A dotted line appears between the cursor and the selec-

ted node if the end (or start) node has been chosen or between the cursor and the last node if the last segment has
been chosen.

3. Left-click anywhere in the 3D View to continue the polyline.
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1 - Selected node on the polyline 2 - A segment is added after the selected vertex

Note: You cannot continue in drawing a closed polyline.

14.1.2.6 Delete a Polyline

In 3D (or 2D), after drawing a polyline, the Create, Delete Polyline and Delete All icons become enabled. Note that the
Delete Polyline icon is not present on the toolbar but can only be reached from the pop-up menu.

In 3D:

In 2D:

To delete a single polyline:

If there is a lonely polyline that has been drawn, this polyline will be deleted. If there are several polylines, the last polyline
will be deleted.

1. Right-click anywhere in the 3D View.
2. Select Delete Polyline from the pop-up menu.

Note: You can also delete a polyline while drawing it (or after validating it).

Tip: To delete a polyline that is already created, please use the Undo button. It is not necessary to close the Polyline Draw-
ing tool for that.

To Delete all Polylines:
n Click the Delete All icon.

Note: You can also delete a polyline that is set as selected (using the Select Polyline command).

14.1.2.7 Move a Polyline

After drawing a polyline (or setting an already created one as selected), you can use the displacement mode to Pan or
Rotate the polyline within the displayed scene. The displacement mode which comes first is the one chosen during the last
use of that tool.

In 3D:
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In 2D:

Tip: You can choose the Selection Mode from the pop-up menu.

Note:Moving an already created polyline (which is set as selected) will not displace it but only the selection (the green poly-
line which appears over the created polyline).

To pan a polyline:

After choosing Pan, a Manipulator in a plane parallel to the screen view appears. If there is a polyline selected, (or when
there are several polylines drawn), the Manipulator has as origin the selected (or last drawn) polyline’s center. You can
move the selected (or last drawn) polyline along a direction at once or anywhere in the Manipulator’s plane.

1. Click the Selection Mode icon. The Change Move Mode becomes enabled.
2. Click on the Change Move Mode pull-down arrow.
3. Choose Pan from the drop-down list. A Manipulator appears. It is composed of two Axis-Handles and one Plane-

Handle.
4. If you are in 3D, rotate slightly so that the plane - inside which the Manipulator is - is unparalleled to the screen view.
5. Pick an Axis-Handle to select it; it turns to yellow. The direction along which you can move the selected polyline is

highlighted in yellow. Those (two in all) for which you cannot move the selected polyline are in mauve. Move the
selected polyline along that direction.

6. Or pick on the Plane-Handle. The two Axis-Handles remain with their own color and the two directions along which
you can move the selected polyline are highlighted in yellow. The forbidden direction - normal to the plane - is in
mauve. Move the selected polyline in that plane.
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7. If you are in 2D, you can only move the selected polyline along a direction. You may only see one forbidden dir-
ection in mauve. If you move the selected polyline in a plane, you may not see any forbidden direction.

Tip: You can easily switch between Rotate and Pan, and inversely, by just picking one of the Handles. The cursor changes
to when you hover it over a Handle.

To rotate a polyline:

After choosing Rotate, a Manipulator of ring shape (in deep blue) with two extended diagonals (in light blue and mauve)
appears in a plane parallel to the screen view. If there is a polyline selected (or when there are several polylines drawn), the
Manipulator has as origin the selected (or last drawn) polyline’s center. You can rotate the selected (or last drawn) polyline
around an axis perpendicular to the ring’s plane.

1. Click the Selection Mode icon. The Change Move Mode becomes enabled.
2. Click on the Change Move Mode pull-down arrow.
3. Choose Rotate from the drop-down list. A Manipulator appears. It has a Ring Handle with two extended and per-

pendicular diagonals.
4. If you are in 3D, rotate slightly so that the plane - inside which the two extended diagonals are - is unparalleled to the

screen view. You may see the direction - around which you can rotate the selected polyline - in dashes.
5. Pick the Ring Handle; it turns to yellow. The direction around which you can rotate the selected polyline tilts to deep

blue. Rotate the selected polyline around that direction.

6. If you are in 2D, do the same procedures as in step 4. You may not see any forbidden direction.

Tip: You can also right-click to display the pop-up menu and select first Change Move Mode and then Rotation.

Tip: You can easily switch between Pan and Rotate, and inversely, by just picking one of the Handles. The cursor changes
to when you hover it over a Handle.

14.1.2.8 Auto-Duplicate a Polyline

In the Station-Based mode, you can duplicate a polyline in two directions (Horizontal or Vertical). The polyline needs to be a
2D polyline or a 3D coplanar polyline (all nodes in the same plane).

Tip: You need to have matched images within your station(s).

To duplicate a polyline horizontally:
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1. Draw a 3D coplanar polyline or select one.

2. If not done, switch to the Station-Based mode.

3. If required, filter the images:

a. Click the Filter Images by Camera Type button.
If the current project has some images which come from an instrument other than the Trimble SX10, the Select
Image Type dialog appears as illustrated below:

If the current project has some images which come from the Trimble SX10 instrument, the Select Image Type
dialog appears as illustrated below:

b. Select a type by checking the corresponding check box. The number of images of the chosen type is displayed.
The selected images are displayed in overlap in the background, only if the Display Images option has been
chosen. 
Note:Only one type of images can be selected at once.

4. Click the Auto-Duplicate Horizontally (Image-Based) icon to duplicate the selected (or drawn) polyline hori-
zontally.
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Tip: You can also select a part of an already duplicated polyline using the Selection Mode and duplicate it horizontally.

To duplicate a polyline vertically:
1. Draw a 3D coplanar polyline, or select one.

2. If not done, switch to the Station-Based mode.

3. If required, filter the images:

a. Click the Filter Images by Camera Type button.
If the current project has some images which come from an instrument other than the Trimble SX10, the Select
Image Type dialog appears as illustrated below:
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If the current project has some images which come from the Trimble SX10 instrument, the Select Image Type
dialog appears as illustrated below:

b. Select a type by checking the corresponding check box. The number of images of the chosen type is displayed.
The selected images are displayed in overlap in the background. only if the Display Images option has been
chosen. 
Note:Only one type of images can be selected at once.

4. Click the Auto-Duplicate Vertically (Image-Based) icon to duplicate the selected (or drawn) polyline vertically.

Tip: You can also select a part of an already duplicated polyline using the Selection Mode and duplicate it vertically.

14.1.2.9 Duplicate Manually a Polyline

You can manually duplicate a polyline in any navigation mode (Examiner, Walkthrough or Station-Based). The duplication
direction is the one given by the manipulator which appears when using the Selection Mode.

To manually duplicate a polyline:

1. Select a drawn polyline using the Selection Mode *. The Change Move Mode becomes enabled. The selected
polyline color swaps from green to yellow and a manipulator (with two handles (Green and Red)) appears over it.
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2. Select Copy Selection and Create from the pop-up menu. You cannot see the duplicated polyline because it is upon
the original polyline.

3. If required, click on the Change Move Mode pull-down arrow.
4. Choose between Pan and Rotate.
5. Move the duplicated polyline in consequence. The duplicated polyline becomes selected (yellow) and the original

polyline unselected (green).

Notes:
n You can also use the following short-cut key Ctrl + Shift + D.
n (*) If your polyline has been already created in the RealWorks database, first set it using the Select Polyline com-

mand.

14.1.2.10 Create a Polyline

Once you are satisfied with the drawn polyline(s), you can create it (or them) in the database. The newly created object will
be put in the current active folder under the Models Tree.

To create a polyline:
1. Click Create.
2. Click Close Tool.

Note: If you draw several unconnected polylines, they will be created into the same polyline.

Tips:
n You can also select Create from the pop-menu or press Enter.
n You can also select Close Tool from the pop-menu or press Esc.

If the polyline is made of one chain, closed, planar and with no auto-intersections, the property will contain the area.

If a feature set has selected, it will be converted to a polyline independently of its display mode (i.e. Points Only, Continuous
Segment and Dash-Line Segment).

14.1.3 Catenary Drawing

The Catenary Drawing tool enables you to create a model of a power line (or several in a row) from scan data.

14.1.3.1 Open the Tool

This tool, which requires no selection as input, is based on what is displayed in the 3D View.

To open the tool:
1. Display a point cloud in the 3D View.

2. Select Catenary Drawing in Drawing > Line Work.

14.1.3.2 Pick Three Points
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This step consists in picking three points, no matter the order of the points. Two of the points need to be the locations where
the power line ends, typically, where it reaches the poles.

To pick three points:

1. If required, click the Pick Three Points icon. The cursor becomes as follows . A yellow cross appears at the
picked position.

2. Pick a point on the displayed point cloud. The cursor becomes as follows . A yellow cross appears at the picked
position.

3. Pick another point on the displayed point cloud. The cursor becomes as follows .

4. Pick the last point on the displayed point cloud. A power line is extracted from the point cloud and the Create icon
becomes enabled.

Note: Pressing Esc. while you are picking points, cancels the points.

Note: An error message appears in the case no power line can be computed from the picked points, for instance if the
points are not on a hanging catenary shape. You are then prompted to pick new points.

14.1.3.3 Create a Power Line

To create a power line:
n Click Create . A planar Polyline, named Object, is created in the database.

Tip: You can change the width of the created polyline in Preferences / Viewer.

14.1.4 EasyProfile

The idea behind this new feature is to allow you to easily extract profiles along curbs, pavements, rail lines, cuttings, natural
features etc. Profiles are determined by tracking a predetermined section. A section can be of segment and circle arc based
shape. This tool requires a point cloud selection to be able to be activated.

14.1.4.1 Open the Tool

A section can be of segment and/or circle arc shape. A section shape is defined based on a 2D-curve (profile). If the project
you load contains at least one 2D-curve (profile), you can then select it for defining a section shape. In that case, both the
Profile Matcher and Cutting Plane buttons in Step 1 of the EasyProfile™ dialog are available. This means that you can pos-
ition the existing 2D-curve (profile) within a 3D scene or create a new one. If any 2D-curve (profile) is available, only the Cut-
ting Plane button is available. You should then define one. Note that a 2D-curve (profile) - mainly composed of several
segments and curve parts, connected or not - can be one imported from AutoCAD or can be previously generated within
RealWorks.

To open the tool:
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1. Select an object with cloud property from the Project Tree.

2. Select EasyProfile in Drawing > Line Work. The EasyProfile dialog opens.
This dialog opens as the third tab of the WorkSpace window and is composed of three parts. Each part corresponds
to one step in the EasyProfile procedure.

1 - Start Profile Matcher 2 - Start Cutting Plane 3 - The 2D-curve (profile) in
selection

Caution: You can select several point clouds as input of the tool but one of them should not be the Project Cloud.

14.1.4.2 Select an Existing Profile

To select an existing profile:
1. Click on the pull-down arrow.
2. Select an existing 2D-curve (profile) from the drop-down list.

1 - 2D-curve (profile) in white 2 - Section size (in red) 3 - Preview the tracking result

14.1.4.3 Set the Section Size

After defining a section shape, you need to define its size. Profile tracking will start from the defined section shape with the
specified step size value (that we call Element) and will consist of building and propagating in both directions a series of con-
secutive constrained Elements (all based on the first Element and all ball-jointed at a pivot point). The tracking will stop on
its own when the fitting error between the current (last) Element and its points is too large or the number of points in the
immediate neighborhood is too small.

To set the section size:
1. Enter a value* in the Step Size field.
2. Or use the Up and Down buttons to select a value.
3. Click Start.
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Points inside each Element (shown in yellow) can be hidden by un-checking the Display Used Points option. Those
outside the Elements can be also hidden by un-checking the Display Remaining Points option. Once the tracking
ends, profiles are then computed from the sequence of built Elements and the start button becomes dimmed.

1 - First Elements (in red) with profile (in white) 2 - Propagation of consecutive Elements

Note: The Delete Elements and Pick to Continue buttons are not available before clicking Start.

Caution: You cannot enter a value equal to zero or negative in the Step Size field.

14.1.4.4 Modify Built Elements

If the last Elements are not correctly fitted, you may decide to delete them. You do this by picking an Element in the 3D
View. Those that are after the picked Element are deleted. You can decide to jump to a position by picking a point on the
selected point cloud. Once a point has been picked, the tracking propagation will start on its own from that point onwards.
The side on which the new sequence is appended to the previous sequence is chosen automatically.

To delete sections:

1. Click Delete Elements . The mouse cursor becomes as shown below.
2. Pick an Element in the 3D View window.

Trimble RealWorks User Guide | 427



PRODUCTION TOOLS

1 - The picked Element 2 - The picked Element and those follow are deleted

Note:
n You can undo the deletion by selecting Undo Delete Elements from the pop-up menu or by using the following

short-cut Ctrl + Z.
n You cannot delete the first Element; the one which contains the selected 2D-curve and is used for tracking.

To continue tracking:

1. Click Pick to Continue . The mouse cursor becomes as shown below.
2. If required, change the Step Size value.
3. Pick one point on the working cloud.

1 - The picked point 2 - The old sequence is appended to the
new sequence

3 - Propagation of another
sequence of Elements from the
picked point
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Note: You can undo continuing tracking by selecting Undo Continue from the pop-up menu or by using the following short-
cut Ctrl + Z.

14.1.4.5 Create Profiles

Once you are satisfied with the tracking result, you can save it in the database. A new folder is created and rooted under the
current project. This folder contains all computed profiles and a cloud. A profile is always named Prof-xxx where xxx is its
order. The cloud - always named EasyProf-Cloud - contains points inside the fitted Elements used for tracking profiles.

To create profiles:
1. Click Create.
2. Click Close.

14.1.5 Profile Matcher

The idea behind this tool is to allow the user to match or position a profile (2D curve, cross-section, polyline, etc.) at a spe-
cific point and in a given direction in a 3D scene. We mean by “matching a profile” not just to move it from its current position
to a new one in a 3D scene but also to create this profile in the RealWorks database. This tool is useful when you import a
profile from a CAD application, and you wish to position it within a 3D scene in RealWorks, or when you use the EasyProfile
tool or when you wish to duplicate a profile's pattern in different locations in a 3D scene.

14.1.5.1 Open the Tool

You need to have at least one profile and a point cloud or mesh selected in your current project to be able to activate the
tool. You can activate it from the EasyProfile tool or by selecting its related command from the menu bar.

To open the tool:
1. Select both a point cloud/mesh and a profile from the Project Tree.

2. Select Profile Matcher in Drawing > Line Work. The Profile Matcher dialog opens.
This dialog opens as the third tab of the WorkSpace window and is composed of four parts. Each part corresponds
to one step in the matching process. The 3D View splits into two horizontal viewers. The top viewer (a 3D viewer)
displays in 3D the selected point cloud or mesh and the selected profile as well as a 3D-plane. The selected profile
is in the 3D-plane. This means that both have the same position and orientation in the 3D scene. The lower viewer
(a 3D-locked viewer) displays in 2D (locked in the XY* plane of the active coordinate frame) the selected profile and
a set of points with a 2D-grid in superimposition. This set results from slicing the selected point cloud.
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1 - The 3D View
2 - A 3D plane

3 - The 3D-locked view
4 - The selected point cloud

5 - The selected point cloud sli-
cing
6 - The profile

Notes:
n The Picking Parameters toolbar opens in the distance constraint mode below the 3D View.
n (*) In the X, Y, Z Coordinate System.

14.1.5.2 Define a Cutting Plane

In this step, we are going to define and use a 3D-plane to change the selected profile’s position and orientation. The
method for defining a 3D-plane (mostly the same as in the Cutting Plane tool) is based on picking which can be free or con-
strained.
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1 - Set From Frame
2 - Fit
3 - Pick Axis from Object
4 - Plane Perpendicular to Screen
5 - Pick Three Points on Plane

6 - Plane Parallel to Screen View
7 - Pick First Point
8 - Display and Hide options
9 - Restore the profile's initial position

To define a cutting plane:
1. Do one of the following:

n Select a frame’s axis (1).
n Fit an extracted set of points with a plane (1).
n Find a perpendicular view plane from an extracted set of points (1).
n Pick an object’s axis (1).
n Pick a plane perpendicular to the screen (1).
n Pick three points (1) (2).
n Set the plane parallel to the screen view.
n Define a position and set a direction:

a. Enter a direction in the Normal field.
b. Or click Pick Point. The Picking Parameters toolbar appears.
c. Pick on point (free or constrained) in the 3D View.
d. Enter a position in the Point field.

2. If required and if a point cloud has been selected, uncheck Display Cloud.
3. If required and if a mesh has been selected, uncheck Display Mesh.
4. If required, uncheck Display Plane.
5. If required, click Restore.

The Restore button remains unavailable as long as any 3D-plane has been validated. After validating a 3D-plane, a
profile of the same shape as the selected one (the one required to activate the tool) is created. This profile is in the
validated 3D-plane. Any transformation has been applied to the selected profile; it remains unchanged in position
and direction. Clicking Restore will undo the new 3D-plane as well as the new profile.
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1 - The initial 3D plane with the selected profile inside 2 - The new 3D plane with new profile

Note: For more information related to (1), see Step 2 of the Cutting Plane tool. For (2), see the Picking Parameters.

14.1.5.3 Define a Profile

You can arrange the newly defined profile in the 3D-plane by rotating, panning, scaling up and down or reversing it. The
Thickness field is not unavailable (grayed out) if a mesh has been selected in Step 1. The Thickness value (cannot be equal
to zero) is used for slicing the selected point cloud from each side of the 3D plane.

1 - Flip profile on the plane
2 - Interactive mode (in plane)

3 - Reset the displacement made in plane

14.1.5.3.1 Set a Thickness

To set a thickness:
1. Enter a value in the Thickness field.
2. Or use the Up and Down buttons to select a value.

14.1.5.3.2 Move the Profile

To move the profile:

Trimble RealWorks User Guide | 432



PRODUCTION TOOLS

1. Click Interactive Mode (in Plane) . The Profile Matcher information window appears at the top right corner of the
3D-locked viewer. This window displays the profile's current scale factor.

2. Do one of the following:
n Rotate the profile in the 3D plane.
n Pan the profile in the 3D plane.
n Scale the profile in the XY plane.
n Scale the profile up and down using the mouse wheel.

3. If required, click Reset.

Tip: You can also right-click in the 3D-locked viewer and select Start Interactive Mode or Quit Interactive Mode from the
pop-up menu.

14.1.5.3.2.1 Rotate the Profile

To rotate the profile:
1. In the 3D-locked viewer, hold the left button pressed.
2. Rotate the profile in the 3D plane.

1 - The mouse shape in Rotate mode 2 - Before rotating the profile 3 - After rotating the profile

Tip: You can also click in the 3D-locked viewer and use the m or M key to activate or deactivate the Interactive Mode.

14.1.5.3.2.2 Pan the Profile

To pan the profile:
1. In the 3D-locked viewer, hold the middle button pressed.
2. Move the mouse in any direction to pan the profile.
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1 - The mouse in Pan mode 2 - The Profile before panning 3 - The Profile after panning

Tip: You can also click in the 3D-locked viewer and use the <Arrow> keys to pan the profile Up, Down, Right and Left.

14.1.5.3.2.3 Scale the Profile

To scale the profile:
1. In the 3D-locked viewer, hold the left and middle buttons pressed.
2. Move the mouse forward to scale down the profile.
3. Move the mouse backward to scale up the profile.
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1 - The profile before scaling down
2 - The profile after scaling down
3 - The mouse shape in Scale mode

4 - The scale factor before scaling down
5 - The scale factor after scaling down

Tip: You can also click in the 3D-locked viewer and use the + and – keys to scale the profile Up and Down.

14.1.5.4 Reverse the Profile

To reverse the profile:
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n Click Flip Polyline on Plane .

1 - Before reversing the profile 2 - After reversing the profile

Tip: You can also right-click in the 3D-locked viewer and select Flip Polyline on Plane from the pop-up menu.

14.1.5.5 Create the Profile

When you are satisfied with the newly defined profile's position, orientation and scale in the 3D scene, you can create it as a
persistent object in the RealWorks database. The object is of polyline type and has the same shape as the selected one
(the one required to activate the tool). You can create as many profiles as you need without leaving the tool.

To create the profile:
1. Click Create.
2. Click Close.

14.1.6 Feature Set

This tool allows you to collect a set of surveying points/chains from a scanned point cloud in a way that simulates a regular
surveying method. If there is no Feature Set available in your project, this tool lets you define your own feature code library /
feature codes; collect surveying points/chains and attach them to a feature code. If there is a Feature Set available in your
project, you can select it and edit the already collected points.

14.1.6.1 Open the Tool

If the loaded project contains no Feature Code Library, a default library named LIB_1 will be created. You can rename (or
delete) it. If there is a Feature Code Library, you can edit it.

To open the tool:
1. In creation mode, select and display a point cloud in the 3D View.
2. In modification mode, select both a point cloud and a feature set and display them in the 3D View.

3. Select Feature Set in Drawing > Features. The Feature Set Creation dialog opens as well as the Picking Para-
meters toolbar.
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The Feature Set Creation dialog opens and is composed of three parts. The first part is for collecting points. The
second part is to define a library and feature codes. The last part allows you to save (or apply) the results, close the
tool and obtain access to the online help.

14.1.6.2 Feature Code Libraries

If there is no Feature Code Library within the project you loaded, you can add one by creating a new one (or by importing
one originated from surveying applications). If the new library is empty of Feature Codes, it will not be taken into account. A
new library is always named LIB plus X corresponding to its order of creation. If there is a Feature Code Library within the
project you loaded, you can rename it (or edit the feature code or define ones more).

To add a feature code library:

You can add a new Feature Code Library in your current project by creating one. If the new library is empty of feature
codes, a warning message appears and it will be deleted. A new library is always named LIB plus X corresponding to its
order of creation.

1. Click the Edit Feature Code Library . The Feature Code Library Editing dialog opens.
2. Click New. A new feature code library is added.
3. Click OK.

To import a feature code library:

You can import a Feature Code Library that originates from surveying applications.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing dialog opens.
2. Click Import. The Import Feature Code Library dialog box opens.
3. Navigate through your hard disk to locate the library to be imported and select it.
4. Click Open.

To rename a feature code library:

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Click Rename. The feature code library name becomes editable.
3. Enter a new name and press Enter.
4. Click OK.

To delete a feature code library:

If the loaded project contains a Feature Code Library that you don't want anymore; you can delete it. If the Feature Code
Library you delete is the last in your project, a warning message appears and a default Feature Code Library is created.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Drop down the Library list and select a feature code library.
3. Click Delete. The selected feature code library is deleted.
4. Click OK.

To export a feature code library:

A library once filled with Feature Codes can be exported to a TXT format file so that it can be used for other RealWorks pro-
jects.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Click Export. The Export Feature Code Library opens.
3. Enter a new name in the File Name field or keep the default one.
4. Specify a location on your hard disk in which to store the library in the Look In field.
5. Click Save.

14.1.6.3 Feature Codes
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A Feature Code is a system for codifying Feature Points. A Feature Code should reflect the Feature Points you intend to col-
lect.

To define a feature code:
1. Click Edit Feature Code Library. The Feature Code Library Editing dialog opens.

1 - Already defined feature codes 2 - Field for defining feature codes

2. Select a Feature Code Library from the list.
3. Or use the default one (no selection is required).
4. Click in the Feature Code panel below the PC Feature Code.
5. Define a new Feature Code.
6. Press Enter on your keyboard.
7. Click Apply.

Tip: Instead of defining Feature Codes, you can import into your project a library which already contains a set of Feature
Codes.

To delete a feature code:

Deleting a library will similarly delete the Feature Codes (if available) that are inside.

To rename a feature code:
1. In the Feature Code Library Editing dialog, first select a library to modify.
2. In the Feature Code pane, select a code to modify.
3. Press F2 and input a new name.
4. Press Enter.
5. Click Apply.

14.1.6.4 Feature Points

A Feature Point is composed of attributes like its name (Prefix + Index), its 3D coordinates, its Feature Code and optionally,
a Description. You can pick (or define a new Feature Point) or modify an existing Feature Point.

1 - Prefix of a Feature
Point

2 - Order a of a Feature
Point

3 - Coordinates of a Feature
Point

14.1.6.4.1 Pick a Feature Point

A Feature Point can be collected either by free (or constrained) picking a point. In that case, the mouse cursor’s shape
changes to a pencil.

To pick a feature point:

Trimble RealWorks User Guide | 438



PRODUCTION TOOLS

1. Pick a Feature Point on the displayed scene in the 3D View. Its 3D coordinates are displayed in the Point field.
2. If required, enter a name in the Prefix field.
3. Click on the Feature Code Library pull down arrow.
4. Select a library from the Feature Code Library list.
5. Click on the Feature Code pull down arrow.
6. Select a code from the Feature Code list.
7. Continue in collecting other Feature Points.

Note: An empty point will not be taken into account.

14.1.6.4.2 Edit a Feature Point

You can edit a Feature Point previously defined. Just pick on it in the 3D View. Its features are displayed in the Prefix, Index
and Point fields. You can then modify them as you please.

14.1.6.4.3 Modify Feature Points

You can delete the last collected Feature Point by undoing the operation or by removing it from your selection using the
Delete Point command. You can insert or add a Feature Point to your collection once the selection is completed.

To delete a feature point:
1. Pick on an already picked point in the 3D View.
2. Right-click in order to display the pop-up menu.
3. Select Delete Point from the pop-up menu.

Note: Instead of selecting Delete Point from the pop-up menu, you can also use the Del key on your keyboard.

To insert a feature point:

You can insert a Feature Point between two Feature Points only if they are linked by a Continuous (or Dash-Line) Segment.
1. Place the cursor over a position between two Feature Points.
2. Click to insert a Feature Point at this position.

1 - The cursor' shape when placing it between two
connected feature points

2 - The last collected feature point has a red label
3 - The inserted feature point

To add a feature point:
1. Place the cursor over a point on the displayed object. An empty point is not taken into account.
2. Click to add a Feature Point at this position.
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1 - The last collected Feature Point has a red label 2 - A Feature Point has been added at this position

To move a feature point:
1. Place the cursor over a Feature Point. A green square appears.
2. Drag the Feature Point from its current position. The green square becomes red and remains over the selected

Feature Point’s position.
3. And drop the Feature Point to a new position. A yellow square appears under the cursor while moving it.

1 - The selected Feature Point current position 2 - The cursor' shape while dragging and dropping the
selected Feature Point
3 - The selected Feature Point new position

14.1.6.5 Set a Display Mode

A Feature Point when collected may have two statuses: isolated points simply called points or connected points called
chains. If points are connected, you can close the chain by checking the Closed Feature Set option.

1 - Close a set of feature
points

2 - Field for selecting display
mode

3 - The number of feature
points

To set a display mode:
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1. Click on the Set Display Mode pull down arrow.
2. Do one of the following:

n Select Points Only to set collected points as isolated points.
n Select Continuous Segment to connect collected points with plain line segments.
n Select Dash-Line Segment to connect collected points with dotted line segments.

14.1.6.6 Create (or Apply Changes to) a Feature Set

A Feature Set is created in the database for each collection of Feature Points saved in the database. The user can create
as many Feature Sets as required without leaving the tool. A Feature Set has OBJECTX as name and is rooted in the
Models Tree. You can export a Feature Set to an ASCII format file.

To create (or apply Changes to) a feature set:
1. In creation mode, click Create.
2. In modification mode, click Apply.
3. Click Close.

Note: You can also select Close from the pop-menu.

14.1.7 Edit a Feature Code Library

To edit a feature code library:

1. Select Edit Library in Drawing > Features. The Feature Code Library Editing dialog opens.
2. Do one of the following:

n Edit a library.
n Edit a feature code.

3. Click Apply (or OK). The Feature Code Library Editing dialog closes.

14.1.7.1 Edit a Library

You can add a new Feature Code Library in your current project by creating one or by importing one that originates from sur-
veying applications. If the new library is empty of feature codes, a warning message appears and it will be deleted. A new
library is always named LIB plus X corresponding to its order of creation.

To add a feature code library:

You can add a new Feature Code Library in your current project by creating one. If the new library is empty of feature
codes, a warning message appears and it will be deleted. A new library is always named FEATURE_CODE_LIBRARY plus
X corresponding to its order of creation.

1. Click the Edit Feature Code Library . The Feature Code Library Editing dialog opens.
2. Click New. A new feature code library is added.
3. Click OK.

To import a feature code library:

You can import a Feature Code Library that originates from surveying applications.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing dialog opens.
2. Click Import. The Import Feature Code Library dialog box opens.
3. Navigate through your hard disk to locate the library to be imported and select it.
4. Click Open.

To rename a feature code library:

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Click Rename. The feature code library name becomes editable.
3. Enter a new name and press Enter.
4. Click OK.
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To delete a feature code library:

If the loaded project contains a Feature Code Library that you don't want anymore; you can delete it. If the Feature Code
Library you delete is the last in your project, a warning message appears and a default Feature Code Library is created.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Drop down the Library list and select a feature code library.
3. Click Delete. The selected feature code library is deleted.
4. Click OK.

To export a feature code library:

A library once filled with Feature Codes can be exported to a TXT format file so that it can be used for other RealWorks pro-
jects.

1. Click the Edit Feature Code Library icon. The Feature Code Library Editing box opens.
2. Click Export. The Export Feature Code Library opens.
3. Enter a new name in the File Name field or keep the default one.
4. Specify a location on your hard disk in which to store the library in the Look In field.
5. Click Save.

14.1.7.2 Edit a Feature Code

A Feature Code is a system for codifying Feature Points. A Feature Code should reflect the Feature Points you intend to col-
lect.

To define a feature code:
1. Click Edit Feature Code Library. The Feature Code Library Editing dialog opens.

1 - Already defined feature codes 2 - Field for defining feature codes

2. Select a Feature Code Library from the list.
3. Or use the default one (no selection is required).
4. Click in the Feature Code panel below the PC Feature Code.
5. Define a new Feature Code.
6. Press Enter on your keyboard.
7. Click Apply.

Tip: Instead of defining Feature Codes, you can import into your project a library which already contains a set of Feature
Codes.

To delete a feature code:

Deleting a library will similarly delete the Feature Codes (if available) that are inside.

To rename a feature Code:
1. In the Feature Code Library Editing dialog, first select a library to modify.
2. In the Feature Code pane, select a code to modify.
3. Press F2 and input a new name.
4. Press Enter.
5. Click Apply
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14.1.8 Cutting Plane

The Cutting Plane tool enables to cut a selected entity (point cloud or mesh) with a plane whose position and orientation
need to be defined by the user. The result of this cut is a sectioned point cloud or a polyline. This tool can be used alone as
a main tool or inside a main tool as a sub-tool. In the latter case, it is mainly used as a visual quality checking tool and no res-
ults can be created.

14.1.8.1 Open the Tool

To open the tool, you should first select either a point cloud or a mesh. If a point cloud is selected, you can clean it by remov-
ing for example parasite points or reduce it by sampling or by fencing an area. These can be done thanks to the two fol-
lowing sub-tools (Sampling and Segmentation). If a mesh is selected, these two sub-tools are unavailable.

To open the tool:
1. Select an object (point cloud or mesh) from the ProjectTree.

2. Select Cutting Plane in Drawing > Slice Tools. The Cutting Plane dialog opens.
This dialog opens as the third tab of the WorkSpace window and is composed of four parts. The first part (Define
Cutting Plane) contains tools for defining a plane. The second part (Define Slice) allows you to set a thickness for
the plane defined in the previous step and to choose between Single Slice and Multi Slice. The third part (Control) is
to preview the result(s). The last step is to save the result(s).

1 - A plane
2 - The slider

3 - The selection required to open the tool
4 - The bounding box

A planar view with a 2D grid that you can customize opens below the 3D View. A plane perpendicular to the screen
and a slider appear in the 3D View. This plane runs across a point that corresponds to the centre of the selection
(required to open the tool). This point sets the altitude (Offset) of that plane. In this case, it is 0 mm*. The bounding
box that highlights the selection delineates the size of that plane.

3. From now, you should define a plane. First, you should set its orientation. Then you can define its position.

Note: (*) The current unit of measurement is in Millimeter. You can change it in the Preferences dialog.

14.1.8.2 Define an Orientation

There are four methods for precisely defining the orientation of a plane. The first method is to select an axis (from the active
frame) so that the initial plane becomes perpendicular to it. The second method is by picking an object’s local frame. The
third method is to specify the coordinates of its normal vector. The fourth method is to edit parameters.

There are three methods for visually defining the orientation of a plane. The first method is to pick two points. The initial
plane will pass through the line defined by these two points and perpendicular to the screen plane. The second method is to
pick three points. The initial plane will pass through the plane drawn by these three points. The third method is to define a
plane. The initial plane will be parallel to the defined plane.

Trimble RealWorks User Guide | 443



PRODUCTION TOOLS

1 - Select From Frame
2 - Fit

3 - Pick Axis From Object
4 - Plane Perpendicular to
Screen

5 - Pick Three Points on
Plane
6 - Edit Parameters

14.1.8.2.1 Set Coordinates

To set coordinates:
n Enter the coordinates of a plane’s normal vector in the Normal field.

14.1.8.2.2 Select a Frame Axis

This method consists of selecting an axis from the active frame as Normal direction. The initial plane will be moved so that
its Normal will be parallel to the selected axis. Its position in the 3D scene will be kept and its Offset (altitude) will be reset.

To select a frame axis:
1. Click on the Set from Frame pull down arrow.

2. Choose among X Axis , Y Axis and Z Axis (in the X, Y and Z Coordinate System).
3. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).

14.1.8.2.3 Pick an Object Local Frame

This method consists of picking an object's local frame. The initial plane will be moved so that its Normal will be parallel to
the picked local frame. Its position in the 3D scene and its Offset (altitude) will be set by the picked point.

To pick an object local frame:

1. Click the Pick Axis from Object icon. The initial cutting plane disappears from the 3D View.
2. In the WorkSpace window, click on the Models tab.
3. Right-click on the selection to display the pop-up menu.
4. Select Display Geometry.
5. Click an object.

Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and make the last defined plane
appear.

14.1.8.2.4 Pick Three Points

This method consists of picking three points. The initial plane will be moved so that it will pass through the three picked
points. Its position in the 3D scene and its Offset (altitude) will be the barycentre of the three picked points.

To pick three points:

1. Click the Pick 3 Points on Plane icon. The Picking Parameters toolbar appears.
2. Pick three points (free or constrained). Picking is always on the displayed object.
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1 - Picked points 2 - The cutting plane passes through the picked points

Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and make the last defined plane
appear.

14.1.8.2.5 Pick Two Points

This method consists of picking two points. The initial plane will be moved so that it will pass through the two picked points
and perpendicular to the screen.

To pick two points:

1. Click the Plane Perpendicular to Screen icon.
2. Pick two points. No need to pick on the displayed object.

Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and make the last defined plane
appear.

14.1.8.2.6 Fit With a Geometry

To fit with a geometry:
1. Click on the Fit pull-down arrow.
2. Choose one of the following:

n Select Fit Plane . The Fitting toolbar appears as well as an information window at the top right corner of the
3D View.

n Select Find Best Cross Plane . The Fitting toolbar appears as well as an information window at the top right
corner of the 3D View.

14.1.8.2.6.1 Fit a Plane

1 - In (i)
2 - Out (o)
3 - Display Un-partitioned Points

4 - Plane
5 - Create Fitted Geometry
6 - Close Tool (Escape)

To fit a plane:
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1. Fence a set of points for which you want to fit with a plane.
2. Click the Plane icon. Kept points are fitted with a plane.

Note: It is not necessary to fence a set of points; fitting a plane can be applied to the entire point cloud.

14.1.8.2.6.2 Find the Best Cross Plane

1 - In (i)
2 - Out (o)
3 - Display Un-partitioned Points

4 - Plane Normal
5 - Create Fitted Geometry
6 - Close Tool (Escape)

To find the best cross plane:
1. Fence a set of points with which you want to fit a plane.
2. Click the Plane Normal icon. Kept points give the projection plane’s normal direction.

Note: It is not necessary to fence a set of points; finding the best cross plane can be applied to the entire point cloud.

14.1.8.2.7 Edit Parameters

To edit parameters:

1. Click the Edit Parameters icon. The 3D Plane Editing dialog opens.
2. Click on the pull down arrow and do one of the following:

n Choose Normal + Point to define a normal and a position.
a. Enter a direction in the Normal field.
b. Enter a point position in the Point field.

n Choose Point to Point to define two points. Points(To) - Point (From) defines a normal and Point (From) gives a
position.
a. Enter a point position in the Point (To) field.
b. Enter a point position in the Point (From) field.

3. Click OK. The 3D Plane Editing dialog closes.

14.1.8.3 Define a Position

There are three methods for defining a plane's position. The first method is to define this position by one point. You can
either pick this point in the displayed scene or key in its coordinates. We call this method By Offset. The second method is
to define this position by two points. This can be used, for example, to find the center plane of two parallel walls of a build-
ing. We call this method By Interpolation. You can either pick the points in the displayed cloud or give their exact coordin-
ates. Then you can use the Ratio field to define the position of the cutting plane precisely between these two points. Ratio 0
will put the position coincident with the first point, and Ratio 1 with the second point. The third method is to use the slider at
the left side of the 3D View to move the plane. This can be used to visually define the position of a plane and is often used
for visual checking of registration quality.

To define a position by Offset:
1. Check the By Offset option.
2. Enter a point position in the Point field.
3. Or click Pick Point . The Picking Parameters toolbar appears in 3D constraint mode.
4. Pick one point in the 3D scene.

n The cutting plane passes through that point.
n The Offset value is set to 0.00*.
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Notes:
n (*) In the current unit of measurement. You can change it in Preferences.
n Moving the slider Up (or Down) will increase (or decrease) the Offset value.

To define a position by Interpolation:
1. Check the By Interpolation option.
2. Enter a point position in the Point 1 field.
3. Or click the Pick First Point icon. The Picking Parameters toolbar appears in 3D constraint mode and the cursor

becomes as shown below.
4. Pick a point in the 3D scene.

n The initial plane will pass through Point 1.
n The Ratio value is equal to 0.

5. Enter another point position in the Point 2 field.
6. Or click the Pick Second Point icon. The Picking Parameters toolbar appears in 3D constraint mode and the

cursor becomes as shown below.
7. Pick another point in the 3D scene.

n The initial plane will pass through Point 2.
n The Ratio value is equal to 1.
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8. Define the exact position of the plane by entering a value between 0 and 1 in the Ratio field.

14.1.8.4 Define a Slice

After defining a plane, you now need to decide whether to perform a Single Slice or Multiple Slice cutting. In the case of a
Single Slice, the cutting will be along the defined plane. You will then choose the thickness of the slice in order to cut the
point clouds. In the case of a Multiple Slice, you also need to define the interval between two slices. The slices will be
propagated from the position of the defined plane in two directions with the given interval. The number of slices indicated at
the bottom of the dialog is calculated in such a way that slices will span the whole range of the point cloud along the normal
direction of the defined plane.

To define a single slice:
1. Check the Single Slice option.
2. Enter a value in the Thickness field.
3. Or use the Up and Down buttons to select a value.

To define a multiple slice:
1. Check the Multiple Slice option.
2. Enter a value in the Thickness field.
3. Enter a value in the Interval field.
4. Or use the Up and Down buttons to select a value.

Note: The Thickness value cannot exceed the Interval value. It can only be the same.

14.1.8.5 Preview a Single Slice

If the Single Slice option has been chosen, the Preview button remains inactive. The top window displays the selected
object (point cloud or mesh) with the defined plane. The planar view displays in real time the cutting result. There is by
default a 2D Grid superposed on the displayed sliced cloud; you can choose to change the grid size or to hide it by using the
corresponding items from the pop-up menu. Note that the View Manager toolbar appears at the bottom of the 3D View. You
can use the icons to change the configuration of the two sub-views.
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1 - The 3D View
2 - The Planar View

3 - The point cloud
4 - A point cloud slice

Note: If the selected object is a mesh, the cutting result will be a polyline. Otherwise the result will be a cloud slice.

14.1.8.6 Preview a Multiple Slice

If the Multiple Slice option has been chosen, the Preview button switches from inactive to active and the planar view
becomes empty of contents (see [A]). Clicking Preview will display the cutting results in the 3D View and will remove the
defined plane representation from it. The active slice, the one in pink in the 3D View, is shown in the planar view (see [B]).
The Control tools (see Step 3 of the Cutting Plane dialog) become active. In the planar view, there is by default a 2D Grid
superposed on the displayed sliced cloud; you can choose to change the grid size or to hide it by using the corresponding
items in the pop-up menu. Note that the View Manager toolbar appears at the bottom of the 3D View. You can use the icons
in this toolbar to change the configuration of the two sub-views.
[A]

1 - 3D view
2 - Planar view

3 - Point Cloud
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[B]

1 - The 3D View
2 - The Planar view

3 - A set of point cloud slices
4 - The Active point cloud slice

Note: If the selected object is a mesh, the cutting results will be polylines. Otherwise the results will be cloud slices.

14.1.8.7 Build Polylines

To build a polyline from a single slice:
1. Click 2D-EasyLine. The 2D-EasyLine dialog opens.
2. Build a polyline from the slice.
3. Click Apply. The 2D-EasyLine dialog closes.

To build polylines from a multiple slice:
1. To select a slice, do one of the following:

n Pick a slice in the 3D View.
n Use the Control tools as follows:

n Click Display Next Slice to view the one after the active slice.

1 - Display First Slice
2 - Display Last Slice

3 - Display Next Slice
4 - Display Previous Slice

n Click Display Previous Slice to view the one before the active slice.
n Click Display First Slice to view the first slice.
n Click Display Last Slice to view the last slice.
n Key in a number and press Enter.

2. Click on the 2D-EasyLine button. The 2D-EasyLine dialog opens.
3. Build a polyline from the slice.
4. Click Apply. The 2D-EasyLine dialog closes.

Notes:
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n Instead of clicking Display Next Slice or (Display Previous Slice), you can also use the Up (or Down) key on your
keyboard.

n You can multi-select cloud slices (or polylines) in the 3D View using the Ctrl + A shortcut keys, open the 2D-
EasyLine tool and build polylines based on the selected cloud slices or polylines.

n The 2D-EasyLine tool is not available in RealWorks Viewer.

14.1.8.8 Save the Cutting Result(s)

If you are satisfied with the cutting result(s), you can create it (or them) in the database. When selecting Single Slice, only
an object will be created. When selecting Multiple Slice, a folder* will be created in which each slice result (including sliced
cloud and the polyline if it exists) will be created as an object. You can create as many cutting planes as you need without
leaving the Cutting Plane tool.

To save the cutting result(s):
1. Click Create.
2. Click Close.

Tip: Close can also be selected from the pop-up menu.

Notes:
n Leaving the Cutting Plane tool without saving the result(s) will make a warning message appear.
n (*) The folder's default name is Cross-Cut-Interval -XX-Th YY. XX is the Interval value and YY the Thickness value.

Note: All objects resulting from the use of the tool have the "Unclassified" layer.

14.1.9 Contouring

The purpose of the Contouring tool is to create iso-contours from 2.5 point cloud(s) or mesh(es) along the Z Axis (or Elev-
ation Axis) of the active coordinate frame. The output of this tool will be a set of contours, each of which is represented by a
polyline lying on the plane situated at the corresponding elevation.

14.1.9.1 Open the Tool

To open the tool:
1. Select an object (point cloud or mesh) from the Project Tree.
2. Select Contouring in Drawing > Slice Tools. The Contouring dialog opens.

This dialog opens as the third tab of the WorkSpace window and is composed of several parts. The first part con-
tains two sub-tools (Segmentation and Sampling)*. If the input is a point cloud, you can clean it by removing para-
site points (or reduce its size by simplifying it). The way that point cloud is rendered changes. Its Rendering swaps
to White Color. If the input is a mesh, both sub-tools are grayed-out and Its Rendering remains unchanged. The
second part enables you to define an elevation range. The third part enables you to set a tolerance for contour
decimation. The fourth part is to define principal contours and the last part lets you display and save the contour cre-
ation results.

Notes:
n You can leave the Contouring tool by pressing Esc or by right-clicking anywhere in the 3D View to display the pop-

up menu and select Close.
n (*) The results issued from the use of both sub-tools cannot be saved. The Create command is deactivated.

14.1.9.2 Define an Elevation Range

A default elevation range is set up so that the High Elevation and Low Elevation correspond to the top and bottom of the
bounding box that highlights the selected object. This elevation range is represented by a graduated vertical bar. A Cutting
Plane perpendicular to the Z (or Elevation) Axis of the active coordinate frame runs across the Low Elevation of the default
Elevation Range and its size (only width) is given by the bounding box size (only width).
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1 - High Elevation
2- Low Elevation
3 - Bounding box
4 - Bounding box's width

5 - Cutting Plane
6 - Bottom of the bounding box
7 - Elevation Range
8 - Top of the bounding box

To set the low and high elevation values:
1. Enter a value in the From field and press Enter.

1 - Low Elevation
2 - High Elevation

3 - Icons for resetting the initial value

2. Enter a value in the Top field and press Enter.
3. If required, get back the initial Low (or High) Elevation value by clicking the Reload Initial Low Elevation (or Reload

Initial High Elevation) icon.

To pick the low and high elevations:

1. Click the Pick Low Elevation icon. The Picking Parameters toolbar appears. The Cutting Plane and the graduated
vertical bar are removed from the 3D View.

2. Pick a point on the displayed object in the 3D View. It’s up to the user to pick a point (freely or with constraint).
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1 - Pick Low Elevation
2 - Pick High Elevation

3 - Reload Initial Elevation

3. Repeat the two upper steps for the High Elevation.
4. If required, get back the initial Low (or High) Elevation value by clicking the Reload Initial Low Elevation (or Reload

Initial High Elevation) icon.

To define an interval value:
1. Enter a value in the Interval field and press Enter.
2. Or use the Up and Down buttons to select a value.

14.1.9.3 Calculate the Contours

This step enables you to set a value for the Tolerance parameter, preview the contouring result and if required hide the
input data.

1 - Contour decimation tolerance
2 - The Hide / Display option

3 - Preview the contouring results

The Tolerance value is used to decimate contours. The polyline of each contour will be decimated in such a way that the ver-
tices of the original polyline will be inside the defined tolerance range.

To define the Tolerance parameter:
1. Enter a value in the Tolerance field.
2. Or use the Up and Down buttons to select a value.

After defining an elevation range and the decimation tolerance, you can use the Preview button to visualize the contouring
result. At this moment, the 3D View will be split into two sub-windows: one for visualizing the data with the contours super-
posed in 3D and another for displaying each contour in a planar view.

To preview the contours:
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n Click Preview. The results are shown in two sub-windows.

1 - Top view
2 - Graduated scale
3 - Bottom view

4 - Contours
5 - Active Contour

In the top window, each contour is displayed with a color. A graduated scale at the left side gives the altitude inform-
ation for a given color. An information box at the right top corner displays the active (selected) contour's properties:
Order and Elevation. In the bottom view, there is by default a 2D Grid superposed (if not hidden previously) on the
displayed contour. You can choose to change the 2D Grid's size or to hide it by using the corresponding items from
the pop-up menu. An information box at the right top corner displays in addition to the properties listed above the Fit-
ted Polyline's size. A View Manager toolbar appears at the bottom of the 3D View. You can use the icons in this tool-
bar to change the configuration of the 2D sub-views.

If the input data (required to open the Contouring tool) is a point cloud, you can remove its representation from the 3D View
by clearing the Display Cloud option. If the input data is a mesh, this option will become Display Mesh. You can clear the
option to hide the mesh representation.

14.1.9.4 Define the Principal Contours

You can choose and assign some of the contours as principal contours. The remaining contours are then considered as
intermediate contours.

To define the principal contours:
1. Check the Define Principal Contours option. The First and Skip fields become enabled as well as the Pick Principal

Contour icon. A label appears next to each contour.

1 - The Define Principal Contours option
2 - Define the first principal contour by entering a

3 - Define the number of contours to
skip
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number 4 - Pick Principal Contour

2. Enter a value in the First field and press Enter.
3. Or click the Pick Principal Contour icon. The Picking Parameters toolbar appears.
4. Go to the top view and pick a contour - using the constraint or not.

1 - Intermediate contours have no label 2 - Each principal contour is shown with a label

5. Enter a value in the Skip field and press Enter.

14.1.9.5 Display Contours
The first contour is the active one. It is displayed in the bottom view and appears in pink in the top view.

1 - Display First Contour
2 - Display Previous Contour
3 - Contour in selection (Active)

4 - Display Next Contour
5 - Display Last Contour

If the active contour is other than the first contour, you can use the Up and Down keys of your keyboard (or the Display Pre-
vious Contour and Display Next Contour buttons in the Step 4 of the Contouring dialog) to display the next and the previous
contour in the bottom view. Be sure to first select the top view to be able to use the Up and Down keys. It should have a yel-
low frame. Clicking the Display First Contour and Display Last Contour buttons will set the first and last contour as active
(selected). You can key in a contour’s order in Step 4 to select it. Do not forget to validate by pressing the Enter key.

Tip: You can visualize several contours in the bottom view. Please, select the ones you need from the top view by com-
bining the use of Ctrl key with left-clicking; or multi-select all using the Ctrl + A shortcut keys.

14.1.9.6 Create Contours

Once you are satisfied with the contouring results, you can use the Create button to create them in the database. A folder
named "Cross-Map" is created and put under the current active folder, in which all contours are put. The Interval parameter
is appended to the folder name. Each contour is named by combining a default name string "Cross-Map" with the elevation
information and of Fitted Polyline type.

You can create as many contours as required without leaving the Contouring tool. If you decide to leave this tool without cre-
ating any contours, a message appears and prompts you to confirm, undo or cancel the action you are going to perform.

To create contours:
1. Click Create.
2. Click Close.
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Note: You can leave the Contouring tool by pressing Esc or by right-clicking anywhere in any window and select Close from
the pop-up menu.

Note: The created contours have the "Unclassified" layer.

14.1.9.7 Manipulate a Label

Each principal contour has a label which contains the length information in text. You can move that label to any location in
the 3D View. Note that you should first create the contours in the database and leave the Contouring tool to be able to
manipulate the labels.

To manipulate a Label:
1. Select a Principal Control from the 3D View by picking it.

2. Select Move Label in Drawing > Slice Tools. A white square appears beside the selected principal contour's
label.

3. Pick on the white square. It becomes yellow.
4. Drag and drop the square from its current position to a new one. The label will move consequently.

1 - A Principal Contour 2 - Directions for moving the label

5. From the OfficeSurvey menu, select again Show Manipulators to leave this tool.

14.1.10 Profile/Cross-Section

This tool is of particular use in civil engineering applications such as tunnel, bridge or road inspections. It is used for gen-
erating profiles and cross-sections from a point cloud (or from a set of point clouds) or from a mesh. A profile is a cut along a
given polyline (also called Path). Cross sections are cuts performed perpendicularly to a given path.

14.1.10.1 Open the Tool

If a point cloud has been selected, the step consists of working on it in order to delimit an area for the profile and cross sec-
tion calculation, or to render the point cloud cleaner without parasite points or to simplify it. For these operations you can
use two sub-tools: Sampling and Segmentation. Each of them, when used in such a condition, prevents you from saving
the result, the Create command is deactivated. If a mesh has been selected, the two upper sub-tools are unavailable.

To open the tool:
1. Select a point cloud (or mesh) from the Project Tree.
2. Select Profile/Cross Section in Drawing > Slice Tools. The Profile/Cross Section dialog opens.

This dialog opens as the third tab of the WorkSpace window and is composed of five parts. The first part contains
two sub-tools: Segmentation and Sampling. The second part allows you to define the 2D cutting position. The third
part is to set section parameters. The fourth part is assigned for calculating and displaying sections. The fifth and

Trimble RealWorks User Guide | 456



PRODUCTION TOOLS

last part is to save the created sections in the database, close the tool and give access to the online help. The selec-
ted point cloud is displayed in white in the 3D View, and the others are hidden.

Tip: You can also select a couple of point cloud (or meshe) and fitted polyline (or set of segments) as input of the Pro-
file/Cross Section tool.

14.1.10.2 Select a Method

There are two methods for computing a set of cross-sections: From Segments and From Path. If the loaded project does
not contain any set of segments, the button From Segments stays dimmed. If there are some*, the button becomes
enabled. The button From Path is always enabled even if there is no fitted polyline in the loaded project. Before selecting a
method, the No Path Selected and No Bounds texts are displayed and the number of cross-sections is equal to 0.

To select a method:
n In the Profile/Cross-Section dialog, do one of the following:

n Click the From Segments button. The Cut Positions from Segments dialog opens.
n Click the From Path button. The Cut Positions on Path dialog opens.

Tips:
n If the input is a couple of point cloud (or mesh) and fitted polyline, the No Bounds text remains displayed. The fitted

polyline name appears in the Path line. The number of cross-sections is calculated based on the default value of the
Interval parameter.

n If the input is a couple of point cloud (or mesh) and set of segments, the No Path Selected and No Bounds texts
remain displayed. The number of cross-sections is equal to the number of segments.

Note: (*) The user does not need to select them.

14.1.10.3 From Path

In this method, cross-sections are similar and regular along a given path. "Similar" means that all cross-sections are
identical in terms of thickness and length. "Regular" means that all are equidistant i.e. the interval between two consecutive
cross-sections is the same in all cases. A path can either be one that is in the project or one you draw. Paths are polylines.

14.1.10.3.1 Select a Path

If there is at least one path (polyline) in the loaded project. You can select it for calculating the cross-sections. In that case,
the selected point cloud (or mesh) and the current path (polyline) - the one listed in the selection box - with its projection (if
existing) in the XY* plane are displayed in the 3D View.

To select a path:
1. In the Cut Positions on Path dialog, click the pull down arrow.
2. Select a path (polyline) from the drop down list.

1 - Combo box for selecting an existing path
2 - Radio buttons for choosing between Horizontal
Path or Use 3D Path

3 - Draw and Create Path in Data-
base
4 - Field for setting the Starting
value on the path

If the Use Horizontal Path option has been checked, cross-sections will be computed from the path projection in the
XY plane. If the Use 3D Path option has been checked, cross-sections will be computed perpendicularly from the
path in 3D (not projected in the XY plane). The Starting on a path is like its origin; its default-value is equal to zero
but you can set it to a value that meets your needs.
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1 - A path 2 - Horizontal path (path projected
in the XY plane)

3 - 3D path (path not projected
in the XY plane)

3. Enter a value in the Starting field.
4. Select a path.
5. Or draw a path.

Notes:
n The selected path (polyline) has to be regular (one chain with at least three points).
n (*) In the X, Y, Z Coordinate System.

14.1.10.3.2 Draw a Path

If any path (polyline) exists in your project, the combo box is grayed out. You have to create at least one in the database. In
that case, only the selected scene (point cloud or mesh) is shown in the 3D View. The scene is constrained in the XY* plane
of the active coordinate frame and movements while picking points are restricted to navigation movements. You can rotate
the complete scene around the Z* axis, zoom (in or out) along this same axis and pan in the XY* plane.

To draw a path:

1. Click the Draw and Create Path in Database icon. The Drawing toolbar appears. The scene is locked in a 2D
plane in the Top view with a 2D grid superimposed (if not hidden previously). The Picking Parameters toolbar
appears in the 2D constraint mode. The mouse cursor changes to a pencil.

2. Pick at least two points (free or constrained).
3. Click End Line. The last picked point ends the line.
4. Or click Close Line. The start and end picked points are linked with a segment in order to form a closed line.
5. Click Create. The drawn line is saved and created in the database as a polyline.

Notes:
n If the 2D Grid had been hidden in a previous case, it will also be hidden when you activate the Polyline Drawing tool.
n (*) In the X, Y, Z Coordinate System.

14.1.10.3.3 Define the Start and End Positions
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You need to define a portion from the selected or created path (polyline) - more exactly a portion from its projection on the
XY* plane of the active coordinate frame (if Use Horizontal Path has been checked) or the path in 3D (if Use 3D Path has
been checked) - for which you want to calculate cross sections. You need to define the Start and End points along the path
(polyline). If the Starting value in Step 1 is equal to zero; the Start and End points are set to the beginning and the end of the
path (polyline). If this value is different from zero; the Start and End positions on the path are shifted of that value.

1 - Set the Start/End position by
inputting a value
2 - Reverse the path direction

3 - Reload the initial
Start/End position

4 - Pick the Start/End pos-
ition
5 - An estimation of the num-
ber of sections

To define the Start and End positions:
1. Enter a distance value in the Start field and press Enter.
2. Enter a distance value in the End field and press Enter.

Here below are two screen-captures showing the Start and End positions when the Use Horizontal Path option has
been chosen.

1 - The Start position on the horizontal (projected) path
2 - The Start position modified on the horizontal (projected)
path

3 - The End position on the horizontal (pro-
jected) path
4 - Pick to modify the Start position on the
horizontal (projected) path
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Here below are two screen-captures showing the Start and End positions when the Use 3D Path option has been
chosen.

1 - The Start position on the 3D path
2 - The Start position modified on the 3D path

3 - The End position on the 3D path
4 - Pick to modify the Start position on the 3D
path

3. Click the Reload Initial Start Position On Path icon (if required).
4. Click the Reload Initial End Position On Path icon (if required).

To pick the Start and End positions:
1. Click the Pick Start Position On Path icon. The mouse cursor shape changes to a pointer.
2. Pick a point along the path (polyline). The picked point becomes the Start point.
3. Repeat the two above steps for the End position.
4. Click the Reload Initial Start Position On Path icon (if required).
5. Click the Reload Initial End Position On Path icon (if required).

To reverse the Start and End positions:

The Start and End positions give a direction to the path. That’s why the Start value must be positive and smaller than the
End value. You can change the path’s direction by reversing the Start and End positions.

14.1.10.3.4 Set the Interval Parameter

Cross-sections will be calculated between the Start and End positions along the path (polyline). The distance between two
consecutive cross-sections is defined in the Interval field. The estimated number of cross-sections is given in the dialog
box. Each time you change the Start (or End) position or the Interval parameter, this number is updated.

To set the Interval parameter:
1. Enter a new value in the Interval field and press Enter.
2. Or use the Up and Down buttons to select a value.

Note: The given number of cross-sections is an estimation. If a cross-section contains no points, it will not be created in the
database even if the Create command is selected.

14.1.10.3.5 Define a Width
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The Interval between two consecutive cross-sections is not enough to define them along the path (polyline). You also need
to define their width by bounding them from each side. The left and right boundaries that delineate the width of each cross-
section can be equal or different one from each other. TheWidth of a cross-section on a given position on the path (poly-
line) is the width of the point cloud.

To define a width:
1. Check the Use Fixed Width option. The Left and Right fields become editable.
2. Enter a new value in the Left field.
3. Enter a new value in the Right field.

14.1.10.3.6 Apply the Cutting Positions

Once you have finished defining the cut positions (path, positions on path, step length and cross section width) on the selec-
ted point cloud (or mesh), you can use the Apply button. Note that after leaving the From Path method, the name of the
selected (or drawn) path (polyline) as well as the number of cross-sections are displayed in text in the Profile/Cross-Section
dialog. If the Use Fixed Width option has been selected, the With Bounds text appears.

14.1.10.4 The "From Segments" Method

Cross-sections that result from this method are all different and irregular along a given path. “Different” because they are
not all identical in terms of thickness and length. “Irregular” because all are not equidistant. Such cross-sections can be
obtained with a set of segments. Segments can come from a DXF (AutoCAD®) file that you import into your project. A path
can either be one that is in the project or one you draw. Paths are polylines.

14.1.10.4.1 Select a Group of Segments

To select a group of segments:
1. In the Cut Positions from Segments dialog, click on the pull-down button.
2. Select a group from the drop-down list.

1 - A combo box for selecting a group of segments
2 - The selected segments (in yellow)

3 - The number of segments in the selected
group
4 - The selected segments projected in the XY
plane (in red)

The number of segments in the selected group appears below the selection list. Each segment (in yellow) and its
projection (in red) in the XY* plane of the active coordinate frame are shown in the 3D View. Note that the segments
in yellow are in 3D while those in red are in 2D.

Note: (*) In the X, Y, Z Coordinate System.
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14.1.10.4.2 Define a Path

As in the From Path method, a path (if available in your project) allows you to generate a profile and to set the cross sec-
tioning direction (Start and End positions). Note that a path is not necessary for generating cross-sections; that's why this
step (in the From Segments method) is optional. A path becomes necessary if you wish to order all cross-sections and to
have the position of each of them along the profile (distance from the Start position to the current (active) cross-section). If
no path exists in your project, you can use the Draw and Create Path in Database tool to draw one.

Tip: You can use a path that comes from the From Path method in the From Segments method, and conversely.

To select a path:
1. Check the Define Path option. The Select Path field becomes active.
2. Click on the Select Path pull-down arrow.
3. Select a path (polyline). The path (polyline) representation appears in the 3D View.

1 - A box for selecting an existing path
2 - The Define Path option
3 - A path

4 - The path projected in the XY plane
5 - The Draw and Create Path in Database

The selected path (in yellow) and its projection in the XY* plane (in red) are displayed in the 3D View window.

Note: (*) In the X, Y, Z Coordinate System.

To define a path:

1. Click the Draw and Create Path in Database icon. The Drawing toolbar appears. The scene is locked in a 2D
plane in the Top view with a 2D grid superimposed (if not hidden previously). The Picking Parameters toolbar
appears in the 2D constraint mode.

2. Draw and create a path.
The drawn path (in yellow) and its projection in the XY* plane (in red) are displayed in the 3D View.

Note: (*) In the X, Y, Z Coordinate System.

14.1.10.4.3 Use the Width of the Segment

You can constrain the point cloud’s sectioning with the segment’s width by using the Use Segment Width option. In [A], this
option is unused - each selected segment and its projection have differing widths. In [B], this option is used - each segment
and its projection have identical widths.
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14.1.10.4.4 Apply the Cutting Positions

Once you have finished defining the cut positions on the selected point cloud (or mesh), you can use the Apply button. After
leaving the From Segments method, the number of cross-sections is displayed in text in the Profile/Cross-Section dialog
box. If a path has been selected, its name is displayed. And if the Use Segment’s Width option has been selected, With
Bounds text appears.

14.1.10.5 Compute Cross-Sections

The Compute Sections panel remains dimmed if any selection of a set of segments (or of a fitted polyline) has been per-
formed after

14.1.10.5.1 Set a Thickness

The distance between two consecutive cross-sections defined in the previous step is not a sufficient parameter for com-
puting the whole cross-sections. You must also define a value which will be used as a cutting thickness along the profile.

To set a thickness:
1. Enter a new value in the Thickness field.
2. Or use the Up (or Down ) button to select a value.

Note: The Thickness field is enabled only if there is a fitted polyline (or set of segments) selected.

14.1.10.5.2 Set a Tolerance

Tolerance is a parameter used for approximating the model (profile) to the reality (cloud). The smaller this parameter is, the
closer the approximation will be. Tolerance zero means that the corresponding profile or cross-sections pass through all
sectioned points.

To set a tolerance:
1. Enter a new value in the Tolerance field.
2. Or use the Up (or Down ) button to select a value.

Note: The Tolerance field is enabled only if there is a fitted polyline (or set of segments) selected.

14.1.10.5.3 Preview the Profile and the Cross-Sections

You have to preview the results before saving in the RealWorks database or change the parameters and perform a new pre-
view as many times as you please.

To preview the profile and cross-sections:
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1. Click Preview. The 3D View splits into three sub-windows.

1 - The active cross-section (in fuchsia)
2 - The Step length

3 - The profile (in red)

The top left sub-window displays the active (or selected) cross-section as a linear graph. The sub-window in the top
right corner displays the profile as a linear graph. The third sub-window displays all generated cross-sections with
the path and the profile. The active cross-section is in fuchsia. You can organize these three sub-windows as you
please using the commands of the toolbar at the bottom of the user interface.
When selecting the From Path method, for a given cross-section, an information box located at the top right corner
of the third sub-window lists information such as its order, the cloud size (number of points that it contains) if a point
cloud has been selected, the polyline size, its distance from the Start position and its 3D position not on the path but
on the path projected in the XY* plane if Use Horizontal Path has been checked and on the 3D path if Use 3D Path
has been checked. The slope angle is obtained by intercepting the path (horizontal or 3D) with the horizontal plane.
For this reason the Z coordinate and the Slope angle value are equal to 0 when computing cross-sections from a
projected path.

1 - The selected path
2 - 3D coordinates of the current cross-section pos-
ition on the horizontal (or 3D) path

3 - Horizontal path (path projected in the XY*
plane)
4 - 3D path (path modeled from the path in selec-
tion)
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When selecting the From Segments method - in (A) no path has been selected, the active (selected) cross-section’s
position is unknown while its order is known. In (B) a path has been selected, the same cross-section’s position is in
text in the information box and its order differs from the one in (A).

1 - The active cross-section
2 - The Start position

3 - The active cross-section order
4 - The active cross-section position

2. If a point cloud has been selected, un-check the Display Cloud option to remove the point cloud representation from
the 3D View, if required.

3. If a mesh has been selected, un-check the Display Mesh option to remove the mesh representation from the 3D
View, if required.

Note: (*) In the X, Y, Z Coordinate System.

14.1.10.5.4 Print a Profile (or Cross-Sections)

To print a profile (or cross-sections):
1. Click inside a graph to select it.
2. From the File menu, select Print from the menu bar. The Print Setup dialog opens.
3. Set the print parameters (if required).
4. Click OK. The Print Setup dialog closes.

Tip: You can also right-click inside a graph for which you want to perform a print-out. The pop-up menu drops down. Then
select Print.

14.1.10.5.5 Scale a Profile and Cross-Sections

For a given linear graph, you can zoom it in/out, pan it or change its scale. Note that Zooming In/Out will change the linear
graph scale. Changing a linear graph scale can be done by using the mouse wheel or by selecting the Scales command
from the pop-up menu.

To manipulate the profile and cross-Sections:
1. Click inside a graph to select it.
2. Do one of the following:

n Drag and drop the graph (with the left button) to a new location to pan it.
n Use the mouse scroll wheel to zoom in/out.
n Or use the left and middle buttons.

Note: The Zoom is centered on the current mouse location.

To scale the profile and cross-sections:
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1. Click inside a graph to select it.
2. Right-click and select Scales from the pop-up menu. The Plot Scale dialog opens with the Automatic Scaling option

checked by default.
3. Un-check the Automatic Scaling option to choose the manual scaling. Both the Horizontal Scale and the Vertical

Scale fields become active.
4. Click on the Horizontal Scale (or Vertical Scale) pull-down arrow.
5. Choose a scale for the Horizontal Scale (or Vertical Scale) list.
6. Click OK. The Plot Scale dialog closes.

14.1.10.6 Display Cross-Sections

To display cross-sections:
1. Use the buttons illustrated below to navigate through the cross-sections.
2. Or pick a cross-section in the 3D View.
3. Or enter a cross-section order in the field and press Enter.

1 - Display First Section
2 - Display Previous Section

3 - Field for entering a value
4 - Display Next Section
5 - Display Last Section

n If the selected cross-section is empty (see [A]), the 2D-EasyLine button remains grayed out.
n If the selected cross-section contains points and fitted polyline (see [B]), the 2D-EasyLine button becomes

enabled.
[A] [B]

Tip: Instead of clicking Display Next Section or (Display Previous Section), you can also use the Up (or Down) key on your
keyboard.

Note: The Display Sections panel becomes enabled only if a preview of cross-sections has been performed.

14.1.10.7 Edit the Cross-Sections

You can select and edit a cross-section using the 2D-EasyLine tool. The selected cross-section needs to have points inside
and fit with a polyline.

14.1.10.8 Create Profile and Cross-Sections

When saving the result in the database, a group named Cross-Sec-Thick "Thickness value"-Tol "Tolerance value" is cre-
ated and rooted under the Models Tree. This group contains the calculated cross sections and the selected (or drawn) path.
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These results are fitted polylines and can be exported via DXF/DGN formats to AutoCAD® and MicroStation®.

To save the profile and cross-sections:
1. Click Create.
2. Click Close.

Notes:
n Close can also be selected from the pop-up menu.
n Instead of selecting Close, click inside a sub-view and press Esc.
n Leaving the Profile/Cross-Section tool without leaving the results will make a warning message appear.

14.1.11 Move Label

Each Section has a label which contains the altitude information in text. You can move its label to any location in the 3D
View. Note that you should first create the Sections in the database. You should select a Section from the List window to be
able to see its Label.

To manipulate the label of a section:
1. Select a Section from the List window.
2. Display the selected Section in the 3D View by turning the bulb to On. A white square appears beside the selected

Section.

3. From the OfficeSurvey menu, select Move Manipulators .
4. Pick on the white square. It becomes yellow.
5. Drag and drop the square from its current position to a new one. The label will move consequently.

Note: Instead of selecting Show Manipulators from the OfficeSurvey menu, you can also click its corresponding icon in the
Tools toolbar.

Note: In the Ribbon, the Move Labels feature can be selected in the Slice Tools group, on the Surfaces (or Drawing) tab.

14.2 SURFACES TOOLS

The Surface group includes a set of tools that enables to create and edit a surface-type object, in opposition to a point-
cloud-type object by fitting.

The Slice Tools group includes a series of tools with the slicing capability. From either a point cloud or a mesh, the user can
create a terrain contour map, a set profile and cross-sections along an alignment, or perform a slice.

The Volume group includes only one tool. It enables you to compute a volume from a point cloud or a mesh.
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14.2.1 Fitting

This tool is used for fitting a geometry to a set of points. The geometry can be a plane, a sphere or a cylinder. Creating a
plane (or a cylinder) can be useful when you need to compare a surface to a geometric model in the Surface-to-Model
Inspection tool.

14.2.1.1 Open the Tool

To open the tool:
1. Select and display one point cloud (or more*) from the Project Tree.
2. Select Fitting icon in Surfaces > Surface. The Fitting toolbar appears as well as an information window at the top

right corner of the 3D View.

n The information window displays the total number of points in the selected point cloud (Right Number) and the
number of points after defining a region for fitting (Left Number). Before fencing, the Right Number and the Left
Number are both equal.

n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not
checked, all objects displayed in the 3D View are hidden except the one selected. All of the displayed objects
have their bulb icon turned to Off.

n If the option is checked, all objects displayed in the 3D View remain displayed. All displayed objects have their
bulb icon remained On, except the one selected.

Note: You can fit the whole selected point cloud without fencing as Fit Geometry to Cloud is active. If no fence has been
defined, a geometry also appears when clicking Sphere, Cylinder, Vertical Cylinder, Plane or Horizontal Plane. In this case,
the geometry fits all points of the selected point cloud and the two numbers of points in the information window remain
unchanged.

Caution: (*) You can select several point clouds as input of the tool but one of them should not be the Project Cloud.

14.2.1.2 Fence a Set of Points

To fence a set of points:
1. Navigate through the 3D scene to find a set of points for which you want to fit with a geometry.
2. Fence this set of points by drawing a polygonal fence.
3. Right-click anywhere in the 3D View.
4. Select End Fence from the pop-up menu. The In and Out icons become active.

5. Select In to keep points inside the fence.
6. Select Out to keep points outside the fence.

n The number of points in the selected point cloud will be diminished from the amount of points used for fitting (in
the information window and in the 3D View).

Tips:
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n You can also select In (or Out) from the pop-up menu or use the related short-cut key I (or O).
n Instead of selecting End Fence from the pop-up menu, press the SpaceBar.

Notes:
n Pressing Esc will undo a closed fence (validated) or a fence in progress (still to be validated).
n After fencing, the Display Un-partitioned Points becomes enabled. Clicking on it will reload all points of the selected

point cloud.

Caution: Be careful with the Keep Displayed Objects Visible When Starting Segmentation option in the Preferences dialog.
If you decide to keep the option unchecked, all displayed clouds remain displayed with the selected cloud after entering the
tool. You are able to fence, not only the selected cloud but also those that are not selected (but only displayed). This may be
confusing but keep in mind that the displayed clouds are not taken into account in the fencing result.

14.2.1.3 Fit With a Geometry

To fit with a geometry:
1. Click on the Fit Geometry to Cloud pull down arrow.
2. Choose a type from the drop-down list. If a cylinder (or plane) type has been chosen, the Fitting toolbar looks as

shown below.

3. Click Cylinder, Vertical Cylinder, Plane, Horizontal Plane or Vertical Plane.
n A Cylinder, Vertical Cylinder, Plane, Horizontal Plane or Vertical Plane appears so that it fits all points inside the

fence.
n If Vertical Cylinder has been chosen, the Cylinder has a direction of axis parallel to the Z-Axis.
n If Horizontal Plane has been chosen, the Plane has a normal direction parallel to the Z-Axis.
n If Vertical Plane has been chosen, the Plane has a normal direction parallel to the Y-Axis.

4. If Sphere has been chosen, the Fitting toolbar looks as shown below. The Diameter field becomes enabled.

5. Click on the Diameter pull down arrow.
6. Choose between Auto,76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm.
7. Or give a diameter value*.
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8. Click Sphere.
n If Auto has been chosen, a Sphere appears so that it fits all points inside the fence.
n If 76.20 mm, 100 mm, 139 mm, 200 mm and 230 mm (or a user-defined value) has been chosen, a Sphere

whose diameter is constrained by the chosen (or defined) value appears.

Tips:
n You can fit points directly inside a drawn fence without using In (or Out).
n You can use the F short-cut key instead of clicking the Fit Geometry to Cloud icon. The geometry type used for fit-

ting will be the current one.

Notes:
n After fitting, the Display Unpartitioned Points icon becomes unavailable.
n Pressing Esc will undo the geometry fitting as well as the drawn fence. The fitted geometry disappears from the 3D

View.
n The information window at the top right corner of the 3D View displays the RMS Deviation value after fitting with a

Cylinder, Vertical Cylinder, Plane, Horizontal Plane or Sphere.
n (*) The value will not be kept anymore if no fitting has been performed.

14.2.1.4 Create a Fitted Geometry

If you are satisfied with the fitting result; you can save it as a persistent object in the database. The Created Fitted Geo-
metry icon enables to create a fitted entity under the current group behind other objects. The Create In feature also creates
a fitted entity and puts it under the model group you have to choose from the drop-down pop-up sub-menu.

To create a fitted geometry:
1. Click Create Fitted Geometry.

n A Fitted Object is then created and rooted in the Models Tree under the current project and shown in the 3D
View.

n The selected Point Cloud recovers its total number of points (in the information window and in the 3D View).
2. Click Close Tool.

n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not
checked, all objects displayed in the 3D View remain hidden except the one selected.

n If the option is checked, all objects displayed in the 3D View remain displayed.

Notes:
n Before leaving the Fitting tool, be sure to create the newly fitted geometry in the database; otherwise it will be lost.
n Pressing Esc will close the Fitting tool but will not cancel the created geometry.
n The Create In feature can only be selected from the pop-up menu. It is available only if there is at least one group of

models under the selection (required to open the Fitting tool). Otherwise, it won't appear in the pop-up menu.

Tip: Instead of clicking on a button in the Fitting toolbar, you can also select its corresponding command from the pop-up
menu.

14.2.2 Mesh Creation

The purpose of the Mesh Creation tool is to create a triangulated mesh from a point cloud which must have no geometry.
Such a mesh can be used for further editing, texture mapping, and ortho-projection image creation or as input for the Cut-
ting Plane tool. You can also export it to other software in DXF (or DGN) format.

This tool uses a 2D triangulation method that applies a projection of the 3D points onto a 2D surface. There are several
ways to define this projection surface. Note that you can select several point clouds to use this tool. In this case, the tool will
create a mesh for each selected point cloud.

14.2.2.1 Open the Tool

To open the tool:
1. Select a point cloud from the Project Tree.
2. Select Mesh Creation in Surfaces > Surface. The Mesh Creation dialog opens.
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The dialog is composed of four parts. The first part enables editing the selected point cloud with the Sampling and
Segmentation tools. The selected point cloud is called Working Cloud and its total number of points is displayed in
this dialog. The second part allows you to select a projection mode. The third and last parts enable previewing and
building a mesh.

Note: The Sampling and Segmentation tools can be selected either from the pop-up menu or from the dialog.

14.2.2.2 Select a Projection Mode

A projection surface can be a 2D plane, a 3D plane, or a 3D cylinder. Three methods to define a projection plane are avail-
able. The Plane-based Projection method enables you to define a 3D plane as in the Cutting Plane tool. The Screen-View-
Based Projection method uses the current camera position. In that case, the projection plane (in 2D) will be the screen
plane. The Station-Based Projection method uses the scanning position linked to each station. In that case, the projection
plane (in 2D) is the scanning grid surface, which, depending on the scanner, will be a plane or a spherical or cylindrical sur-
face.

There is only one way to define a projection cylinder. There is another method for computing meshes from the selected
point cloud. This method (called No Projection) is based on any projection surface. Satisfactory results may be obtained
where the selected point cloud is relatively free of spikes and peaks on its surface.

To select a project mode:
1. Drop down the Select Projection Mode.
2. Select a projection mode from the list.
3. Do any of the following:

n Define a plane-based projection,
n Define a cylinder-based projection,
n Define a current view-based projection,
n Define a scanning direction-based projection,
n Select No projection.

14.2.2.2.1 Define a Plane-Based Projection

After choosing the Plane-Based Projection, a projection plane perpendicular to the Y Axis* of the active coordinate frame
appears in the 3D View. You can change its direction as you are used to do in the Cutting Plane tool or by manual-editing.
In all cases, the bounding box that highlights the selection (point cloud) delimits the height of the projection plane and you
cannot exceed it.

1 - Set From Frame
2 - Fit

3 - Pick Axis From Object
4 - Plane Perpendicular to Screen

5 - Pick Three Points on Plane
6 - Edit Parameters

To define a plane-based projection:
1. Select a frame’s axis (1).
2. Or fit an extracted set of points with a plane (1).
3. Or find a perpendicular view plane from an extracted set of points (1).
4. Or pick an object’s axis (1).
5. Or pick a plane perpendicular to the screen (1).
6. Or pick three points (1)(2).
7. Or edit the project plane’s parameters.
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a. Click Edit Parameters. The 3D Plane Editing dialog opens.
b. Click on the pull down arrow and choose between Normal + Point and Point + Point.
c. If Normal + Point has been chosen, enter a direction in the Normal field and give a position in the Point field.
d. If Point + Point has been chosen, enter a position in the Point (From) and Point (To) fields.
e. Click OK. The 3D Plane Editing dialog closes.

Notes:
n For more information related to (1), see Step 2 of the Cutting Plane tool. When selecting (2), the Picking Parameters

toolbar appears, it’s up to you to do a free picking or a constrained picking.
n (*) In the X, Y, Z Coordinate System.

14.2.2.2.2 Define a Cylinder-Based Projection

After choosing the Cylinder-Based Projection method, a projection cylinder with an axis parallel to the Y Axis* of the active
coordinate frame appears in the 3D View. You can change the projection cylinder’s direction according to the two other
axes (X* and Z*). If the selection (point cloud) that you performed in Step 1 contains an entity, you can pick on it so that its
axis becomes the new axis of the projection cylinder. You can also pick points on your selection to define a projection cyl-
inder or edit one manually. In all cases, the bounding box that highlights the selection (point cloud) delimits the height of the
projection cylinder and you cannot exceed it.

1 - Set From Frame
2 - Draw Circle

3 - Draw Cylinder
4 - Pick Axis From Object

5 - Edit Parameters

Note: (*) In the X, Y, Z Coordinate System.

14.2.2.2.2.1 Select a Frame Axis

This method consists of selecting an axis from the active frame as Normal direction. The initial plane will be moved so that
its Normal will be parallel to the selected axis. Its position in the 3D scene will be kept and its Offset (altitude) will be reset.

To select a frame axis:
1. Click on the Set from Frame pull down arrow.

2. Choose among X Axis , Y Axis and Z Axis (in the X, Y and Z Coordinate System).
3. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).

14.2.2.2.2.2 Pick an Axis From an Object

To pick an axis from an object:

1. Click Pick Axis from Object . The initial projection disappears from the 3D View.
2. Click on the Models tab.
3. Right-click on the selection to display the pop-up menu.
4. Select Display Geometry.
5. Click one point.

14.2.2.2.2.3 Draw a Circle

To draw a circle:
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1. Click Draw Circle . The Picking Parameters toolbar appears.
2. Pick two free points or two constrained points.

Note: Picking can be done anywhere - on the selection (point cloud or mesh) or not. These two points determine the pro-
jection cylinder’s diameter and its direction is perpendicular to the screen view.

14.2.2.2.2.4 Draw a Cylinder

To draw a cylinder:

1. Click Draw Cylinder . The Picking Parameters toolbar appears.
2. Pick three free points or three constrained points.

Note: Picking should be on the selection (point cloud or mesh) for the two first points and anywhere for the third point (on
selection or not). The first and second picked points give the projection cylinder’s direction and the second and third picked
points determine its diameter.

14.2.2.2.2.5 Edit the Parameters

To edit the parameters:

1. Click Edit Parameters . The Cylinder Editing dialog opens.
2. Choose between 2 Points + Radius and Point + Direction + Radius.
3. If 2 Points + Radius has been selected:

a. Enter a point’s position in the Point1 field.
b. Enter another point’s position in the Point2 field.
c. Enter a value in the Radius fields.

4. If Point + Direction + Radius has been selected:
a. Enter a point position in the Point field.
b. Define a direction in the Direction field.
c. Enter a value in the Radius field.

5. Click OK.

14.2.2.2.3 Define a Current View-Based Projection

The Screen View-Based Projection method uses the current viewing direction to define a 2D projection.

14.2.2.2.4 Define a Scanning Direction-Based Projection

The Station-Based Projection method uses the scanning direction to define a 2D projection.

14.2.2.2.5 Select No Projection

By choosing the No Projection method, the user can compute a mesh on more complex geometries. The point cloud, selec-
ted as input, will be spatially sampled with a 2 mm resolution for reducing the point cloud density where it is too high, i.e.
close to the scanner. The resulting mesh will be slightly smoothed: it will not exactly pass through the input points.

Note:When the input point cloud has less than 90% of non-zero normals, the normals are discarded from the mesh com-
putation. When it has more than 90% of non-zero normals, the normals are used in the mesh computation.

14.2.2.3 Preview the Mesh

Before previewing a mesh, the Number of Vertices and Number of Triangles in the dialog are both equal to zero.

To preview the mesh:
1. Choose a resolution:

n Lightweight is to obtain a mesh with fewer triangles with a great number of decimation iterations (20).
n High Detail is to obtain a mesh with a great number of triangles with no decimation.
n Use the slider to choose an intermediate resolution (15, 10, or 5 iterations).

2. Check the Display Edges option. This will display the edges of triangles for easier verification of the result.
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3. If needed, uncheck the Display Points option. The input representation is removed from the 3D View.
4. If needed, check the Remove Discontinuities option. This will remove the triangles around surface discontinuities

(spikes, peaks etc.).
5. Click on the Preview Meshes button. The triangulation procedure will be performed.

n On completion, the triangular mesh will be displayed in the 3D View.
n The Number of Vertices and Number of Triangles in the final mesh are shown in the dialog.
n You can cancel the mesh and compute a new one. The Number of Vertices and Number of Triangles will then be

updated automatically.

Notes:
n The Remove Discontinuities option is not available in the No Projection method.
n The Display Edges, Display Points and Remove Discontinuities options can be checked either before or after pre-

viewing the meshes.

Tip: Preview Meshes can also be selected from the pop-up menu.

14.2.2.4 Create a Mesh

By clicking on the Create button, the previewed mesh will be created in the RealWorks database. If you select several point
clouds, the corresponding meshes will be created in association with each other. You cannot create a mesh without per-
forming a preview. RealWorks will forbid you to do so by inhibiting the Create button.

To create the mesh:
n Click Create. The Mesh Creation dialog closes on its own.

n If the input is a Cloud, a Fitted Mesh named ObjectX is created based on the Cloud in the Models tree.
n If the input is the Project Cloud, the result, a separate object containing the created mesh and points of the Pro-

ject Cloud, is named ObjectX.

Tip: Create and Close can also be selected from the pop-up menu.

14.2.3 Mesh Editing

We have explained in the previous section how to compute a mesh from a point cloud with the Mesh Creation tool. Here,
are described a set of tools to improve the quality of a mesh. The Mesh Editing tool allows you to do that. You can delete
some of its vertices, edges or triangles, smooth or refine it, remove some noisy peaks, extract a part to create a new mesh
or apply a texture or invert the normals.

14.2.3.1 Open the Tool

To open the tool:
1. Select a mesh from the Models Tree.

2. Select Mesh Editing in Surfaces > Surface to display the Mesh Editing command dialog.

14.2.3.2 Simplify a Mesh

This step consists in decimating triangles in a displayed mesh by making it lightweight while preserving its shape and topo-
logy as much as possible. To decimate, do the following:

n Maintain Outer Edge - Select (or deselect) the option to keep (or to not keep) the boundaries of the displayed mesh
when decimating.

n Reduction Factor - Define the number of iterations required to decimate the triangles in the displayed mesh. Light-
weight is to obtain a mesh with fewer triangles with a great number of decimation iterations (100). High Detail is to
obtain a mesh with a great number of triangles with only one decimation iteration. Use the slider to choose a factor
in between.

n Desired Number of Triangles - Define the number of triangles to keep by entering a number or using the slider. Light-
weight is to obtain a mesh with fewer triangle (1% of triangles). High Detail is to obtain a mesh with a great number
of triangles (100% of triangles). Use the slider to choose a number in between.

Once done, press Reduce.
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If required, press .

Note: After decimation, the Displayed Mesh field updates to display the final number of triangles (see Step 2). This number
cannot be the exact number of triangles defined in the Desired Number of Triangles field. It depends on how the mesh is
made of and on the chosen option(s) (Maintain Outer Edge and/or Reduction Factor).
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Add Triangles

Click the Add Triangles button, and pick a vertex and an edge to add a triangle. Pickings should be in the following order:
first a vertex first and then an edge.

14.2.3.3 Fill Holes

Click the Fill Holes button, and hover the cursor over a hole, and pick.
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Note: Before filling a hole, consider removing any isolated triangles inside the hole, or to complete it if it is incomplete by
adding some triangles.

Note: The Fill Holes will detect any object with boundaries, thus, any set of triangles as a hole.

14.2.3.4 Select Elements

Before any selection, only the Change Selection Mode (1), Select Areas (2) and Reverse Selection (3) icons are available.

Use Select Elements to pick a component, whatever the component. Use Select Vertices, Select Edges or Select Triangles
to respectively pick a vertex, an edge and a triangle.

14.2.3.4.1 Pick an Element

To pick an element:
1. Check the Show Edges option (if required).
2. Drop-down the Change Selection Mode list.
3. Choose Select Elements.
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4. Pick an element from the selected mesh. The picked element becomes yellow (or red).
5. Click Reverse Selection. All non-selected elements are selected and appear in red.

Notes:
n The Keep Selected and Keep Unselected icons remain dimmed for either a vertex or an edge and become

enabled for a triangle.
n To add a new selection to the previous one, first press CTRL and then pick. Otherwise, the previous selection will

be canceled.

Tip: The Select Elements icon can also be selected from the pop-up menu.

14.2.3.4.2 Pick a Vertex

Pick a vertex:
1. Check the Show Edges option (if required).
2. Drop down the Change Selection Mode list.
3. Choose Select Vertices. A vertex symbol appears next to the cursor.
4. Pick a vertex from the selected mesh. The picked vertex becomes yellow.
5. Click Reverse Selection. All non-selected items are selected and appear in red.

Notes:
n The Keep Selected and Keep Unselected icons remain dimmed.
n To add a new vertex to the previous selection, first press CTRL and then pick. Otherwise, the previous selection will

be canceled.

14.2.3.4.3 Pick an Edge

To pick an edge:
1. Check the Show Edges option (if required).
2. Drop-down the Change Selection Mode list.
3. Choose Select Edges. An edge symbol appears next to the cursor.
4. Pick an edge from the selected mesh. The picked edge becomes yellow.
5. Click Reverse Selection. All non-selected items are selected and appear in red.

Notes:
n The Keep Selected and Keep Unselected icons remain dimmed.
n To add a new edge to the previous selection, first press CTRL and then pick. Otherwise, the previous selection will

be canceled.

14.2.3.4.4 Pick a Triangle

Pick a triangle:
1. Check the Show Edges option (if required).
2. Drop down the Change Selection Mode list.
3. Choose Select Triangles. A triangle symbol appears next to the cursor.
4. Pick a triangle from the selected mesh. The picked triangle becomes red.
5. Click Reverse Selection. All non-selected items are selected and appear in red.

Notes:
n The Keep Selected and Keep Unselected icons become enabled.
n To add a new triangle to the previous selection, first press Ctrl and then pick. Otherwise, the previous selection will

be canceled.

14.2.3.5 Select an Area

To fence an area:
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1. Click on the Select Areas icon.
2. Pick several points to draw a polygonal fence.

3. Double-click to close the polygonal fence. The Keep Selected and Keep Unselected icons become enabled.
4. Click Keep Selected. All triangles inside the fence are kept.
5. Or Click Keep Unselected. All triangles outside the fence are kept.
6. Click Reversion Selection to reverse the selection.

Tips:
n Press the Space Bar to close a fence instead of double-clicking.
n Click left + CTRL to multi-select or click left + SHIFT to remove from the selection.

Note: Picking can be done out of the displayed mesh. The Keep Selected (or Keep Unselected) command is similar to the
In (or Out) operation in the Segmentation tool.

The Reload All command becomes active after choosing Keep Selected or Keep Unselected. You can then reload all tri-
angles of the selected mesh.

14.2.3.6 Edit a Mesh

Several tools to edit a mesh are available. You can delete, refine, smooth, remove peaks, extract to a new mesh, invert the
normals of the triangles or flip the selected edges. The Refine (1), Smooth (2), Remove Peaks (3) and Invert Triangle
Normal (4) features do not require a selection, see [A1]. Each will be applied to the whole mesh. After selecting a triangle or
a set of triangles, vertices and edges, Delete (5) and Extract to New Mesh (6) become active, see [A2]. Each will be applied
to the selection.

The Show Models in List Window (1) lists all polylines in the project, see [A3]. After selecting one, the Enhance MeshWith
Break Lines Using Polyline(s) (2) icon becomes enabled, see [A4].

After selecting a vertex (or an edge), the Flip Selected Edges (1) becomes enabled, see [A5].

14.2.3.6.1 Smooth a Mesh

The Smooth feature applies a median filtering to the vertices of the selected triangles.
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To smooth a mesh:
1. In the Mesh Editing dialog, click Smooth.
2. Or select the command from the pop-up menu.

14.2.3.6.2 Refine a Mesh

The Refine feature consists in swapping or splitting edges.
1. In the Mesh Editing dialog, click Refine.
2. Or select the command from the pop-up menu.

14.2.3.6.3 Remove Peaks

The Remove Peaks feature removes certain noisy peaks in the displayed mesh.

To remove peaks:
1. In the Mesh Editing dialog, click Remove Peaks.
2. Or select the command from the pop-up menu.

14.2.3.6.4 Reverse Triangles

To reverse triangles:
1. In the Mesh Editing dialog, click Invert Triangle Normal.
2. Or select the command from the pop-up menu.

Note: The Invert Triangle Normal will be applied to the whole mesh in display whatever the selection you made.

14.2.3.6.5 Delete an Element

To delete an element:
1. In the Mesh Editing dialog, click Delete.
2. Or select the command from the pop-up menu.

n Deleting a vertex will delete all triangles of the displayed mesh having that vertex in common.
n Deleting an edge will delete all triangles of the displayed mesh having that edge in common.
n Deleting a triangle will only delete that triangle.

Tip: Instead of selecting Delete, use the related short-cut key Del.

14.2.3.6.6 Extract to a New Mesh

The Extract to New Mesh feature creates a new mesh from the selection done in Step 2. By performing this operation, you
can segment a mesh into different sub-meshes. This feature can be applied to a single triangle (or a set of triangles).

To extract to a new mesh:
1. In the Mesh Editing dialog, click Extract To NewMesh.
2. Or select the command from the pop-up menu.

Tip: Instead of selecting the Extract to New Mesh icon, use the related short-cut key P.

14.2.3.6.7 Enhance With Break Lines Using Polyline(s)

The Enhance MeshWith Break Lines Using Polyline(s) feature does not require a selection; it will be applied to the dis-
played mesh. This enables the integration of a polyline into a mesh.

To enhance with a break lines using polyline(s):
1. Click the Show Models in List View icon. Polylines are listed in the List window and none is displayed in the 3D

View.
2. Select the appropriate polyline from the List window. The Enhance MeshWith Break Lines Using Polyline(s) button

becomes enabled.
3. Toggle the selected Polyline's On/Off icon On (if required). It is displayed in the 3D View.
4. Click the Enhance MeshWith Break Lines Using Polyline(s) icon.
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The new mesh contains new edges that correspond to the Polyline. All the vertices of the previous mesh are pre-
served during this operation.

Note: Several polylines may be selected at the same time.

Tip: The Enhance MeshWith Break Lines Using Polyline(s) icon can also be selected from the pop-up menu.

14.2.3.6.8 Flip an Edge

When an edge is shared by two triangles, you can use the Flip Selected Edges tool for swapping it so that it is still shared by
these two triangles but from the two other vertices.

To flip an edge:
1. Select an edge (or a set of edges) from the displayed mesh.
2. Click on the Flip Selected Edges icon.
3. Or select the command from the pop-up menu.

14.2.3.7 Map With a Texture

This optional step consists in using a matched image to texture map the selection done on the displayed mesh. If any selec-
tion has been performed, the texture mapping will be applied to the entire mesh. If a selection (or the entire mesh) has
already been textured, you can choose to overwrite or remove the existing texture. Texture mapping can be done by recom-
puting (splitting) the edges to fit the image boundaries.

Note: An unmatched image cannot be used for texture mapping. This is why selecting one will not show it as a thumbnail in
Step 4 and the Apply Texture button is dimmed.

Note: Several matched images may be selected at the same time and applied as textures.

14.2.3.7.1 Apply a New Texture
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Within the Map Texture step, you have the ability to texture a mesh using the images that you previously used for coloring a
TZF Scan in Trimble RealColor. You do not need to create some matched images from the colored TZF scans in the Regis-
tration module to use the images for texturing.

To apply a new texture:
1. Select an area from the selected mesh or the whole mesh.

2. Click the Show Images In List View icon.
a. If there are some matched images in your project, all of them are listed in the List window and none is displayed.
b. Jump to step 5.

Or
c. If there is no matched image in your project, a dialog opens. It first warns you that no matched image has been

found and then prompts you to create some.
d. Click Yes. The dialog closes.

If there is a non-colored TZF Scan in your project, nothing occurs. Skip the Map Texture step.
If there is a colored TZF Scan in your project, the Create Station Images from TZF Scan Color process is then
launched.
Once the process has completed, a set of six matched images is created, one for each face of a cube centered
on the station location. All matched images are put under a folder named according to the station.

e. Jump to step 5.
Or

f. If there is no TZF Scan, a warning appears. Click OK. The dialog closes.
g. Skip the Map Texture step.

3. If required, switch to the Station-Based mode.
4. Filter the images:

If the current project has some images which come from an instrument other than the Trimble SX10, the Select
Image Type dialog appears as illustrated below:

If the current project has some images which come from the Trimble SX10 instrument, the Select Image Type dia-
log appears as illustrated below:

Select a type by checking the corresponding check box. The number of images of the chosen type is displayed. The
selected images are displayed in overlap in the background., only if the Display Images option has been
chosen. 

5. Select the matched image behind the selected mesh in the 3D View window. It is shown as a thumbnail in Step 3.
6. Click the Apply Texture button.

n If the Project Image Borders option is not checked, only the selected triangles that lie entirely inside the image
will be textured.

n If the Project Image Borders option is checked, the selected triangles that lie entirely inside the image will be tex-
tured in the same way, but the triangles that intersect the selected image boundaries will also be split. In this
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way, the whole image is used for texturing the selected triangles. Note that the shape of the mesh does not
change during this operation.

14.2.3.7.2 Remove an Existing Texture

To remove an existing texture:
1. Select an area (or the entirety) of the mesh where a texture removal is required.
2. Click on the Remove Existing Texture icon.

14.2.3.7.3 Overwrite an Existing Texture

To overwrite an existing texture:
1. Select an area (or the entirety) of the mesh where a texture overwriting is required.
2. Click the Show Images in List View icon. Matched images are listed in the List window and none is displayed.
3. Select the appropriate image from the List window. It is shown as a thumbnail in Step 3.
4. Toggle the selected image's On/Off icon On. It is displayed in an independent window in the 3D View. The displayed

mesh is aligned with the camera's point of view.
5. Check the Overwrite Existing Texture option.
6. Click Apply Texture.

14.2.3.8 Apply the Operation

Till now, all operations applied to the selected mesh(es) are just temporarily stored. To make them permanent, you have to
apply the operations.

To apply the operation:
1. Click Apply.
2. Click Close.

Tip: Close can also be selected from the pop-up menu.

Note: Leaving the Mesh Editing tool without applying all changes in the database will make a message appear.

14.2.4 Merge Meshes

You can merge several meshes into a new one. A mesh can be either a fitted mesh (with points inside) or a pure mesh (no
points inside).

To merge meshes:
1. Select at least two meshes from the Project Tree.

2. Select Merge Meshes in Surfaces > Surface.
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Amerged mesh, with the "Unclassified" layer and whose name is OBJECTX, is created under the current project in
the Models Tree. X is its order. This mesh has no point cloud representation inside.

14.2.5 Move Mesh

The Move Mesh feature lets you move a mesh (or a set of meshes) from one position to another position along the three dir-
ections of the active frame, and by rotating it centered on its center (one defined by the user) in order to match it with a point
cloud. A mesh can be only a pure mesh (obtained from converting a geometry or a fitted mesh).

To move a mesh:
1. Select a mesh (or a set of meshes) from the Project Tree.

2. Select Move Mesh in Surfaces > Surface. The Move Mesh toolbar displays.
3. Do one of the following:

n Pan a mesh.
n Rotate a mesh.
n Change the manipulator location.

4. Click Apply to validate the transformation.
5. Click Close to leave the tool.

14.2.5.1 Pan a Mesh

To pan a mesh:
1. Click the Pan Along Home Frame Axes icon.

A Manipulator, positioned at the center of the mesh, appears. It is made of three secant Axis Handles (red, green
and blue arrows respectively parallel to the X, Y and Z axes of the active frame), and three secant Plane Handles
(XY, YY and ZX planes).

Note: If multiple meshes have been selected, the manipulator is at a position that is equidistant from all of them.
2. If required, Change the manipulator location.
3. Pick an Axis Handle. It turns yellow as well as the moving direction. The two other directions for which you cannot

move are in mauve.
4. Drag to move the mesh along the yellow direction.
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5. Pick a Plane Handle. It turns yellow as well as the plane one which the handle is lying on.
6. Drag to displace the mesh on the yellow plane.

7. Click the Apply icon.
Tip: You can use the following combination of keys: Shift + T.

Tip: You can select Pan Along Home Frame Axes from the pop-up menu.

14.2.5.2 Rotate a Mesh

To rotate a mesh:
1. Click the Rotate icon.

A Manipulator, positioned at the center of the mesh, appears. It is made of three secant Ring Handles (red, green
and blue arrows respectively perpendicular to the X, Y and Z axes of the active frame).

Note: If multiple meshes have been selected, the manipulator is at a position that is equidistant from all of them.
2. If required, Change the manipulator location.
3. Pick e.g. the red Sphere Handle. It turns to yellow. The axis around which the mesh can be rotated is dotted and is

in red.
4. Move the mesh around that axis.

5. Click the Apply icon.
Tip: You can also use the following combination of keys: Shift + R.
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Tip: You can select Rotate from the pop-up menu.

14.2.5.3 Change the Manipulator Location

To change the manipulator location:
1. Click the Change Manipulator Location icon.
2. Pick a point anywhere

The manipulator moves to the picked position.
Tip: You can also use the following shortcut key: C.

Tip: You can select Change Manipulator Location from the pop-up menu.

14.2.6 Convert to Mesh

The Convert to Mesh feature allows the conversion of a geometric entity like a cube, sphere, cylinder, cone, extruded
model or plane (with holes or not) to a triangulated mesh. The created mesh is refined using parameters. This allows the
application of texture to models.

To convert a mesh:
1. Select a geometry* from the Models Tree.

2. Select Convert to Mesh in Surfaces > Surface. The Convert to Mesh dialog opens.
3. Enter a value in the Average Triangle Edge Length field.

The refinement consists of splitting the vertices for which the length is greater than the value set in the above field.
4. Click Create.

A group whose name is "Mesh - "Average Triangle Edge Length" value" is created under the current project in the Models
Tree. A converted mesh whose name is OBJECTX is created and put under that group. X is its order. The converted mesh
inherits the layer of the input (from which it originated).

Tip: (*) You can also select a mesh as an input. In this case, a new refined mesh is created and the selected mesh remains
unchanged. You can compare the properties of both. The number of vertices and the number of triangles are changed con-
sequently.

14.2.7 Volume Calculation

The Volume Calculation tool enables you to compute the volume between a point cloud and a plane, between two point
clouds, between a point cloud and a mesh or between two meshes. The volume computation is based on a grid method and
the result is represented in the 3D View by a graph of vertical color lines with scale. You can choose in the Preferences dia-
log the units to represent the computed volumes.

14.2.7.1 Open the Tool

You need to select one or two surfaces from a project. You cannot exceed three.

To open the tool:
1. Select one or two surfaces from the ProjectTree.
2. Select Volume Calculation in Surfaces > Surface. The Volume Calculation dialog opens.

This dialog opens as the third tab of the WorkSpace window and is composed of six parts. The first part contains
two sub-tools (Segmentation and Sampling). The second part enables you to define a plane. The third part lets you
set its resolution. The fourth part enables you to preview the volume computation result, display (or hide) the selec-
ted surface(s), check the computed volume(s) to keep and edit a report. The fifth part is to edit the computed
volume(s). The sixth part is to save the volume computation result, and close the tool.
If one surface has been selected, this surface will be automatically displayed in the 3D View with its own color. If two
surfaces have been selected, the first (by selection order) will be set as Reference Surface and displayed in Red
and the second as Comparative surface and in Green.

Notes:
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n If the selected surface is a mesh, these two sub-tools (Segmentation and Sampling) are unavailable.
n If the input contains a point cloud and a mesh; the mesh will be by default the Reference Surface and will not be

able to change to the Comparison Surface.

14.2.7.2 Define a Plane

A plane perpendicular to the Z-axis of the active coordinate frame appears.

To define a plane:
1. Define a direction for the Normal.
2. Set a Position for the plane.
3. Define the Offset.

14.2.7.2.1 Define the Normal Direction

It is up to the user to orientate the initial plane. There are several tools available for this purpose.

1 - Set From Frame
2 - Fit
3 - Pick Axis From Object

4 - Plane Perpendicular to Screen
5 - Pick 3 points on Plane
6 - Edit Parameters

7 - Plane Parallel to Screen View
8 - Field for defining a direction

To define the normal direction:

Do one of the following:
n Select one of the frame’s axes.
n Fit an extracted set of points with a plane.
n Find a perpendicular view plane from an extracted set of points.
n Pick one of the object’s axes.
n Pick a plane perpendicular to the screen.
n Pick three points (1).
n Set the plane parallel to the screen view.

Note: After selecting (1), the Picking Parameters toolbar appears. You can pick free or constrained points.

14.2.7.2.1.1 Select a Frame Axis

This method consists of selecting an axis from the active frame as Normal direction. The initial plane will be moved so that
its Normal will be parallel to the selected axis. Its position in the 3D scene will be kept and its Offset (altitude) will be reset.

To select a frame axis:
1. Click on the Set from Frame pull down arrow.

2. Choose among X Axis , Y Axis and Z Axis (in the X, Y and Z Coordinate System).
3. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).
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14.2.7.2.1.2 Fit With a Geometry

To fit with a geometry:
1. Click on the Fit pull-down arrow.
2. Choose one of the following:

n Select Fit Plane . The Fitting toolbar appears as well as an information window at the top right corner of the
3D View.

n Select Find Best Cross Plane . The Fitting toolbar appears as well as an information window at the top right
corner of the 3D View.

Fit a Plane

1 - In (i)
2 - Out (o)
3 - Display Un-partitioned Points

4 - Plane
5 - Create Fitted Geometry
6 - Close Tool (Escape)

To fit a plane:
1. Fence a set of points for which you want to fit with a plane.
2. Click the Plane icon. Kept points are fitted with a plane.

Note: It is not necessary to fence a set of points; fitting a plane can be applied to the entire point cloud.
Find the Best Cross Plane

1 - In (i)
2 - Out (o)
3 - Display Un-partitioned Points

4 - Plane Normal
5 - Create Fitted Geometry
6 - Close Tool (Escape)

To find the best cross plane:
1. Fence a set of points with which you want to fit a plane.
2. Click the Plane Normal icon. Kept points give the projection plane’s normal direction.

Note: It is not necessary to fence a set of points; finding the best cross plane can be applied to the entire point cloud.

14.2.7.2.1.3 Pick an Object Local Frame

This method consists of picking an object's local frame. The initial plane will be moved so that its Normal will be parallel to
the picked local frame. Its position in the 3D scene and its Offset (altitude) will be set by the picked point.

To pick an object local frame:

1. Click the Pick Axis from Object icon. The initial cutting plane disappears from the 3D View.
2. In the WorkSpace window, click on the Models tab.
3. Right-click on the selection to display the pop-up menu.
4. Select Display Geometry.
5. Click an object.
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Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and will make the last defined plane
appear.

14.2.7.2.1.4 Pick Two Points

This method consists of picking two points. The initial plane will be moved so that it will pass through the two picked points
and perpendicular to the screen.

To pick two points:

1. Click the Plane Perpendicular to Screen icon.
2. Pick two points. No need to pick on the displayed object.

Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and will make the last defined plane
appear.

14.2.7.2.1.5 Pick Three Points

This method consists of picking three points. The initial plane will be moved so that it will pass through the three picked
points. Its position in the 3D scene and its Offset (altitude) will be the barycentre of the three picked points.

To pick three points:

1. Click the Pick 3 Points on Plane icon. The Picking Parameters toolbar appears.
2. Pick three points (free or constrained). Picking is always on the displayed object.

1 - Picked points 2 - The cutting plane passes through the picked points

Note: Pressing Esc while the picking is in progress will cancel the selected point(s) and will make the last defined plane
appear.

14.2.7.2.1.6 Edit Parameters

To edit parameters:

1. Click the Edit Parameters icon. The 3D Plane Editing dialog opens.
2. Click on the pull down arrow and do one of the following:

n Choose Normal + Point to define a normal and a position.
a. Enter a direction in the Normal field.
b. Enter a point position in the Point field.

n Choose Point to Point to define two points. Points(To) - Point (From) defines a normal and Point (From) gives a
position.
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a. Enter a point position in the Point (To) field.
b. Enter a point position in the Point (From) field.

3. Click OK. The 3D Plane Editing dialog closes.

14.2.7.2.1.7 Plane Parallel to the Screen View

To set a plane parallel to the screen:
n Click Plane Parallel to Screen View .

14.2.7.2.2 Define a Position

Once the initial plane is well oriented, you have to define its position in the 3D space.

To define a position:
1. Enter a 3D position in the Point field.
2. Or first click on the Pick Point icon. The Picking Parameters toolbar appears in 3D constraint mode.
3. And then, pick a point in the 3D scene.

n The initial plane passes through that point.
n The Offset value is set to 0.00.

The initial plane in the 3D View is hidden and the Volume Calculation dialog appears in grey. This means that
the options and commands from this dialog are unavailable. The dialog comes back to its initial state when you
have picked a point.

Note: The picking must be done on the selected surface (point cloud or mesh).

14.2.7.2.3 Define an Offset Value

Once the initial plane's position has been defined, you have to set its position along its normal. By default, its current pos-
ition corresponds to Offset 0. Setting a positive value will move the plane Up along its normal while a negative value will
move it Down.

To define an offset value:
1. Enter a value in the Offset field.
2. Or use the Up and Down buttons to select a value.

1 - A plane's Normal direction 2 - Positive offsets 3 - Negative offsets

14.2.7.3 Defining a Grid Resolution

This step consists of defining a grid resolution which is square - the same in both of the defined plane directions (Length
andWidth).

To define a grid resolution:
1. Enter a value in the Resolution field.
2. Or use the Up and Down buttons to select a value.
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14.2.7.4 Preview a Volume

You can perform a preview to visualize the result before saving it in the database. You can change the parameters as many
times as you please and perform a preview without leaving this tool. There are two display options (one per surface). If one
surface has been selected as input, only one display option is available. See (A1). If two surfaces have been selected as
input, the two display options are all available. You can reverse this comparison order by clicking on the Swap
Reference/Comparison Surfaces icon. The Reference Surface becomes a surface to inspect and its color swaps to green.
The Comparison Surface becomes a Reference Surface and its color turns to red. See (B1).

1 - Display/Hide the selected surface(s) 2 - Swap Reference/Comparison Surfaces

To preview the computed volume(s):
1. Click Swap Reference/Comparison Surfaces if required.
2. Click on the Preview button.

If one surface (point cloud or mesh) has been selected, the volume computation is done between this surface and
the plane defined in Step 1. Two volumes are computed if the plane cuts the selected surface in two. The Positive
(Cut) volume is the part (of the selected surface) above the plane while the Negative (Fill) volume is the part below.
The sum of both is the volume computation result. A unique volume is computed if the plane does not cut the selec-
ted surface.

1 - The projection plane
2 - Part of the surface above the plane
3 - Part of the surface below the plane

4 - The Color scale
5 - Positive part of the volume
6 - Negative part of the volume

If two surfaces (point cloud(s) or mesh(es)) have been selected, the volume computation is done between both of
them.
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1 - The projection plane
2 - The Reference Surface in red
3 - The Comparison Surface in green

4 - The color scale
5 - Negative part of the volume
6 - Positive part of the volume

A volume is represented in the 3D View by a graph of vertical color lines. You can estimate the height of each point
(if a point cloud is selected) or of vertex (if a mesh is selected) compared to the defined plane using the graduated
color scale on the left of the 3D View.

Notes:
n The Swap Reference/Comparison Surfaces icon is not present when a single surface has been selected.
n After clicking Preview, if the projection resolution set in Step 1 is too small; the following message #Volume size is

very high; Computation may take a long time. Do you want to continue?# appears. Close the message and set a big-
ger projection resolution.

14.2.7.4.1 Check a Volume to Keep

Once a preview has been performed, the Preview button becomes disabled and the Check Volume to Keep options
become enabled. See (A2) and (B2).

1 - Edit and export the volume result(s) 2 - Check Volume to Keep options

To check a volume to keep:
1. Clear the Positive (Cut) option. The positive representation of the volume is hidden.
2. Or clear the Negative (Fill) option. The negative representation of the volume is hidden.

Note: You cannot have the Positive (Cut) and Negative (Fill) options both unchecked. You need to have at least one
checked.

14.2.7.4.2 Save a Volume in a Report

Trimble RealWorks User Guide | 492



PRODUCTION TOOLS

Once you are satisfied with the previewed volume(s), you can create a report and export to RTF format.

To save a volume in a report:
1. Click Report. The Volume Calculation Report dialog opens.
2. Click Export. The Export Volume Calculation Report dialog opens.
3. Enter a name in the File Name field.
4. Specify a drive/folder where to store the file.
5. Click Save. The report is opened as an rtf file in the Microsoft Word application.
6. Print the report as required.

14.2.7.5 Edit a Volume

The volume previously computed may have irregularities like holes or peaks, you can then edit it by keeping (or removing)
the part you want (or do not want), completing holes, smoothing or filtering according to two given elevations. The cursor is
in the segmentation mode and only the Range Based Filtering feature is available. This means that it is up to the user to fil-
ter the computed volume or to fence an area for editing.

Range Based Filtering

14.2.7.5.1 Filter From an Elevation Range

You can filter the computed volume according to a range of elevation values. Note that this filter cannot be applied to a part
of the volume.

To filter from an elevation range:
1. Click the Range Based Filtering icon. The Range Based Filtering dialog opens.
2. Enter a value in the Minimum Value field.
3. Enter a value in the Maximum Value field.
4. Click OK.

Parts of the volume out of the defined range are not taken into account

14.2.7.5.2 Fence an Area

If you start by fencing an area on the volume, the Fill Holes and Smooth Cells icons become enabled and the Range Based
Filtering icon swaps from enabled to disabled.
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1 - Keep Cells
2 - Empty Cells

3 - Fill Holes
4 - Smooth Cells

To fence an area:
1. Fence an area on the volume.
2. Right-click anywhere in the 3D View.
3. Select End Fence from the pop-up menu.
4. Click the Keep Cells icon.
5. Or click the Empty Cells icon.

Tips:
n You can also right-click in the 3D View to display the pop-up menu and select the command you want to use.
n Instead of selecting Keep Cells (or Empty Cells), you can also use the related short-cut key I (or O).
n Instead of selecting End Fence from the pop-up menu, you can also double-click.

Notes:
n Once a fence has been drawn, the user can no longer manipulate the volume.
n To start a new fence, please cancel the current one by selecting New Fence from the pop-up menu or by pressing

Esc.

14.2.7.5.3 Fill Holes

To fill holes:
1. Fence an area on the computed volume.
2. Click on the Fill Holes icon.

1 - A hole 2 - The hole is filled up

Tip: The Fill Holes icon can also be selected from the pop-up menu.

Note: The Positive (Cut) (or Negative (Fill)) value is then updated.

14.2.7.5.4 Smooth Cells

To smooth cells:
1. Fence an area on the computed volume.
2. Click on the Smooth Cells icon.
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1 - A set of peaks 2 - The set of peaks are smoothed down

Tip: The Smooth Cells icon can also be selected from the pop-up menu.

Note: The Positive (Cut) (or Negative (Fill)) value is then updated.

14.2.7.6 Save a Volume in the Database

You can save the computed volume as a permanent object in the database, perform a screen print or export to the DXF file
format. For each saved result, a volume object is created and is put under the Active Group in the Models Tree.

To save a volume in the database:
1. Click Create.
2. Click Close.

Notes:
n Close can also be selected from the pop-up menu.
n Leaving the Volume Calculation tool without saving the result will display a warning message.

14.3 INSPECTION TOOLS

Data loaded in RealWorks can be inspected using the dedicated tools. All are gathered on the Inspection tab, in the Pro-
duction module, and split into three groups.

The Inspection Map group includes a set of tools that lets the user compare two surfaces, close enough in the shape,
together. The result can be analyzed and exported.

The 3D Inspection group includes mainly two tools. The first one enables you to determine the from-point-point distances,
from two different point clouds. The result can be analyzed with the second too.
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The Polyline Inspection group enables the inspection of a point cloud along a planar polyline.

The Polyline Inspection group enables you to define station positions on an alignment.

The Floor group includes mainly two tools. It enables you to inspect the flatness of a floor, and to measure its flatness as
well as the levelness values.

TheWalls group enables you to inspect if a wall is flat and vertical.

14.3.1 Alignment Stationing

The Alignment Stationing feature lets the user define the stations along a given polyline. The stations have known positions
along that curve.

14.3.1.1 Open the Tool

To open the tool:
1. Select a polyline, with only one chain, from the Project Tree.

2. Select Alignment Stationing in Inspection > Stationing. The Alignment Stationing dialog displays.
n In the 3D View, the selected polyline displays with its own color. Its two ends, each with a cross and a label, dis-

play in green.
n The Start and End indications show the direction along which stations will be positioned.
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n Stations are automatically positioned along the polyline, following the values found in the Beginning Station,
Interval Start Station and Interval fields.

n Each station position, symbolized by a cross and a label, display in the color of the selected polyline.
n The value displayed on the labels is the sum of the values found in the Beginning Station, Interval Start Station

and Interval fields except for the first label which is the addition of Beginning Station and Interval Start Station val-
ues.

n The Interval Start Station specifies the distance between the Start position to the first station position (0 m is the
default value).

n The Beginning Station specifies the start value in terms of distance of the first station (0 m is the default value).

1 - Interval Start Station
2 - Beginning Station + Interval Start Station for the
first station

3 - Beginning Station + Interval Start Station +
Interval for the rest of the stations

Note: If you enter in the tool with a polyline for which an alignment stationing has been already performed, the dialog which
appears is filled up with the parameters of the alignment.

Tip: You can specify the style used to format a station value, among No Formatting, 2 Digits: 10+00, and 3 Digits: 1+000, in
the Preferences / Units dialog.

Note: You can leave the tool by pressing Esc.

14.3.1.2 Define Settings

To define the settings:
1. Start by setting a direction for the alignment to be performed. Click the Reverse Alignment button, the direction

along the selected polyline is reversed. The Start end becomes the End end, and vice versa.
2. Choose an option:

n Horizontal Step (2D): This is the step on the projected path (projection in a horizontal plane).
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n Distance Along Alignment (3D): This is the step on the 3D path.

3. Enter a distance value in the Beginning Station field. This value can be positive or negative.
4. Enter a value in the Start Prefix field. This value can be any combination of ASCII characters. It is used for naming

the stations with the number defined above.

14.3.1.3 Define Positions

To define positions:
1. Enter a distance value in the Interval Start Station field, and press Enter.
2. Or pick a position on the selected polyline.
3. Enter a distance value in the Interval field, and press Enter. The Interval value is the distance between two con-

secutive stations.
n If the Interval Start Station value is larger than the Interval value, the applied value for the Interval Start Station is

recomputed to be between the beginning of the polyline and the value of the first Interval.
n If the Interval value induces the creation of more than 1000 stations, a question pops up and asks you to con-

tinue or not.
n If the Interval Start Station value is higher than the length of the selected polyline, this value is not taken into

account.
4. Click the Apply button. The Alignment Stationing dialog closes.

A new object, named "Polyline - With Stations", is created. When displaying its properties, you can see the number
of stations defined in the polyline, the Station Prefix used for the stations name, as well as the interval between two
stations, and the slicing method (Horizontal Step (2D) or Distance Along Alignment (3D)).

If the selected polyline is composed of a set of segments and arcs. The created polyline doesn't contain arcs. All of
them are discretized in segments.

Note:When you save a project with the newly created polyline in RealWorks 10.2, this changes the database. As a result,
the project cannot be opened in 10.1.
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Note: The exact position of a station on the polyline is not exported when exporting the properties of a "Polyline - With Sta-
tions" object. Only the number of stations, and the prefix of the stations, are exported.

Note: A "Polyline - With Stations" object can be used like a polyline.

14.3.2 Inspect Twin Surfaces

The Twin Surface Inspection tool enables you to compare two surfaces together. These surfaces should be similar as much
as possible or not so different one from the other. You can compare together two point clouds, a point cloud and a mesh or
two meshes. The surface inspection is based on a grid method and the result is an Inspection Map. You can choose in the
Preferences dialog the units required to represent this map.

14.3.2.1 Open the Tool

You should select two surfaces from a project in order to be able to activate the Twin Surface Inspection tool. The first selec-
ted surface will be a reference surface (called Reference) and the second selected surface will be a surface to inspect
(called Comparison).

To open the tool:
1. Select two surfaces from the Project Tree.

2. In the Inspection Map group, click the Twin Surface Inspection in Inspection > Inspection Map. The Twin Sur-
face Inspection dialog opens
This dialog opens as the third tab of the WorkSpace window and is composed of six parts. The first part contains
two sub-tools: Segmentation and Sampling. If point clouds have been selected, you can use these two sub-tools to
delineate an area for the inspection, to render them cleaner (i.e. reduce parasite points) or to simplify them. The
second part allows you to define a projection surface. The third part allows you to set the projection surface’s res-
olution. The fourth part allows you to preview the inspection result, display (or hide) the selected point cloud
(s)/mesh(es). The fifth part is to edit the inspection result. The sixth part is to save the inspection result, close the
tool and give access to the online help.
Before opening the Twin Surface Inspection tool, each selected surface is shown with its own color in the 3D View.
After you open the tool, the reference surface (the first selected) will appear in red and the second surface (the
second selected) in green. If the selection contains a point cloud and a mesh as surfaces; the mesh will be by
default a reference surface (in red) and will not be able to be changed to a comparison surface (in green). The
information box (at the top right corner of the 3D View) lists the name of the reference surface and of the com-
parison surface*.

Note: If the Project Cloud has been selected as input, it is by default the Reference Surface. Its name does not appear in
the information box.

14.3.2.2 Define a Projection Surface

A projection surface can be a 3D Plane, a 3DCylinder or a 3D Tunnel.

To define a projection surface:
1. In the Twin Surface Inspection dialog, click the pull-down arrow.
2. Choose among Plane-Based Projection, Cylinder-Based Projection and Tunnel-Based Projection.

Note: The projection type which comes first is the one you have selected during the last use of that tool.

14.3.2.2.1 Plane-Based Projection

If the two selected surfaces are of plane shape, choose the Plane-Based Projection method. Step1 of the Twin Surface
Inspection dialog becomes as shown below:
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A projection plane with a normal direction parallel to the Z axis* of the active coordinate frame appears in the 3D View. A
slider at the left side of the 3D View allows you to move the projection plane from the top to the bottom and vice versa. The
way of defining a 3D plane is the same as in the Cutting Plane tool.

1 - Slider
2 - The Reference Surface

3 - A projection surface
4 - The comparison Surface

Note: (*) In the X, Y and Z Coordinate System.

14.3.2.2.2 Cylinder-Based Projection

If the two selected surfaces are of cylinder shape, choose the Cylinder-Based Projection method. Step1 of the Twin Sur-
face Inspection dialog becomes as shown below:

A projection cylinder with an axis parallel to the Z axis* of the active coordinate frame appears in the 3D View. You can
change the projection cylinder axis direction according to the two other axes (X* and Y*). If the selection (only point cloud)
that you performed in Step 1 contains an entity, you can pick on it so that its axis becomes the new axis of the projection cyl-
inder. You can also pick points on your selection (point cloud or mesh) to define a projection cylinder or edit one manually.
In all cases, the bounding box that highlights the selection (point cloud or mesh) delineates the height of the projection cyl-
inder. You cannot exceed it.
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1 - Projection surface
2 - Reference Surface (in red)

3 - Comparison Surface (in green)

Note: (*) In the X, Y and Z Coordinate System.

14.3.2.2.2.1 Set From Frame

To define a projection cylinder by selecting a frame axis:
1. Click on the Set from Frame pull down arrow.
2. Choose among X Axis, Y Axis and Z Axis (in the X, Y and Z Coordinate System),
3. Or choose among North Axis, East Axis and Elevation Axis (in the North, East and Elevation Coordinate System).

14.3.2.2.2.2 Draw a Circle

To pick two points to define a projection cylinder:
1. Click the Draw Circle icon. The Picking Parameters toolbar appears in 3D constraint mode below the 3D View win-

dow.
2. Pick one free (or constrained) point. After picking this point, the Picking Parameters toolbar switches to the

Cartesian System constraint.
3. It's up to you to use this constraint or to pick a free point.

Note: Picking can be done anywhere on the selection (point cloud or mesh) or not. These two points determine the pro-
jection cylinder's diameter and its direction is perpendicular to the screen view.

14.3.2.2.2.3 Draw a Cylinder

To pick three points to define a projection cylinder:
1. Click the Draw Cylinder icon. The Picking Parameters toolbar appears in the 3D constraint mode.
2. Pick three points (free or constrained).

Note: Picking should be on the selection (point cloud or mesh) for the two first points and anywhere for the third point (on
selection or not). The first and second picked points give the projection cylinder's direction and the second and third picked
points determine its diameter.

14.3.2.2.2.4 Pick an Axis from an Object

To pick an axis from an object:
1. Click the Pick Axis from Object icon. The initial projection disappears from the 3D View.
2. Click on the Models tab.
3. Right-click on the selection to display the pop-up menu.
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4. Select Display Geometry.
5. Click one point.

14.3.2.2.2.5 Edit Parameters

To edit manually a cylinder:
1. Click the Edit Parameters icon. The Cylinder Editing dialog opens.
2. Click the pull down arrow and do one of the following:

n Define a projection cylinder with two points and a radius.
a. Select 2 Points + Radius.
b. Enter a point’s position in the Point1 field.
c. Enter another point’s position in the Point2 field.
d. Enter a value in the Radius fields.

n Define a projection cylinder with one point, on direction and a radius.
a. Select Point + Direction + Radius.
b. Enter a point position in the Point field.
c. Define a direction in the Direction field.
d. Enter a value in the Radius field.

3. Click OK. The Cylinder Editing dialog closes.

14.3.2.2.3 Tunnel-Based Projection

If the two selected surfaces are of tunnel shape, choose the Tunnel-Based Projection method. If your project contains a 3D
Path and a 2D Shape (respectively a 3D polyline and a 2D polyline), the name of each is displayed. If there is more than
one path or shape, you can drop-down the selection list for each and select another 3D Path or 2D Shape. See [A]. If your
project contains no 3D Path and no 2D Shape; the dialog displays as shown in [B], and you are not able to perform an
inspection.

A projection tunnel of the 3D Path’s length and of the 2D Path’s shape appears with the reference and comparison surfaces
respectively in red and green.

You can inspect the Comparison Surface (in green) with the Reference Surface (in red) along or perpendicular to the 3D
Path by checking Perpendicular or along the 3D Path and in the Z axis* direction (of the active coordinate) by checking Ver-
tical.

Note: (*) In the X, Y and Z Coordinate System.

To define the Start and End positions when no alignment stations has been defined:

If no alignment stationing has been defined on the selected 3D Path, the dialog displays as illustrated:
n If required, drop-down the 3D Path (and/or 2D Shape) list and choose which 3D Path (and/or 2D Shape) to be used

for the inspection.
n By default, the inspection performs from the beginning of the 3D Path to its end.
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n If required, you can define the Start (or End) position of the inspection, by picking a point along the 3D Path.
n You can reset the Start position (and/or the End position) to the beginning (and/or to the end) of the 3D Path.

To define the Start and End positions when an alignment stations has been defined:

If an alignment stationing has been defined on the selected 3D Path, the dialog displays as illustrated below:
n If required, drop-down the 3D Path (and/or 2D Shape) list and choose which 3D Path (and/or 2D Shape) to be used

for the inspection.
n By default, the inspection performs from the beginning of the 3D Path to its end.
n The value in the Start field is the value of the Beginning Station (see the Alignment Stationing tool).
n The value in the End field corresponds to the location at the end of the 3D Path.
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n Define the Start and End positions of the inspection, by picking a point along the 3D Path.
n Or enter a distance value in the Start and End fields.

n If required, reset the Start position (and/or the End position) to the beginning (and/or to the end) of the 3D Path.
Note: If the alignment stationing is done with the Distance Along Alignment (3D) option, the distance will be along the 3D
Path. If the alignment stationing is done with the Horizontal Distance (2D) option, the distance will correspond to the dis-
tances along the curve projected onto the horizontal plane.
Note: You cannot set the Start position after the End position. To swap the path orientation, you need to go to the Align-
ment Stationing tool and do the Reverse Alignment.

Note: There is no minimum distance between the Start position and the End position for performing an inspection. When
you enter the exact value of the Start position into the End field, this value is not taken into account.

14.3.2.3 Determine a Resolution

The same resolution will apply to both directions and will differ according to the projection surface you have defined in Step
2. If the projection surface is a 3D plane, the resolution directions will be the width and length directions of that plane. If the
projection surface is a 3D cylinder, the resolution directions will be the axis direction of this cylinder and the direction of its
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circumference when you unfold it. If the projection surface is a 3D tunnel, the resolution directions will be the 3D Path and
2D Shape directions.

To determine a resolution in the Plane/Cylinder-Based Projection:
1. Enter a value in the Resolution field.
2. Or use the Up and Down buttons to select a value.

To determine a resolution in the Tunnel-Based Projection:
1. Enter a value in the Along 3D Path field.
2. Enter a value in the Along 2D Shape field.
3. Or use the Up and Down buttons to select a value.

14.3.2.4 Preview an Inspection

Once you have finished defining the projection surface and setting its resolution, you can preview the result before saving it
in the database. You can change the parameters (projection surface and resolution) as many times as you please and per-
form a preview without leaving this tool. By default, an object selected for activating the tool is automatically displayed in the
3D View. To hide it, you have to un-check the display option. And to display it again, you should re-check the option. There
are two display options (one for each selected object).

To preview an inspection:
1. Un-check the Display Reference (Red) option, if needed.
2. Un-check the Display Comparative (Green) option, if needed.
3. Keep the Fill Holes option unchecked, if required.
4. Click the Preview.

n If the two surfaces are of the same type (Point Cloud (or Mesh) for both), the Swap Surfaces icon is avail-
able. Click the Swap Surfaces icon. The Reference Surface becomes a surface to inspect (Comparison) and the
Comparison Surface swaps for Reference.

n If the two surfaces are from different type (Point cloud for one and Mesh for the other), the Swap Surfaces icon is
then unavailable

5. Click again the Preview.

The inspection result is a map. It is shown in a specific window, called Map Preview. It is opened beside the 3D View. This
map is a 2D image inside which each pixel is colored according to the difference (expressed in terms of elevation) between
the two surfaces. A ColorBar located at the right side of the inspection map is a scale of elevation values and each color cor-
responds to a range of elevation values.
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1 - The scale and the origin of the inspection map
2 - The reference surface (red)

3 - The comparison surface (green)
4 - The inspection map

1- Zoom tools
2 - Hide/Show ColorBar
3 - Edit ColorBar
4 - Switch to Default Color

5 - Switch to Sign-Based ColorBar
6 - The scale and the origin of the inspection map
7 - An inspection map
8 - A ColorBar

In the Map Preview window, you can zoom the inspection map In or Out. You can do this in three ways. The first one is to
magnify (or reduce) an area of the inspection map using Image Zoom In and Image Zoom Out . The second way is to
magnify (or reduce) the inspection map using the mouse wheel (if present). The last way is to select a rate from the drop-
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down list. If the inspection map is larger than the Map Preview window can show, you can pan it on left-click in four dir-
ections: Up, Down, Right and Left. In the 3D View, the inspection map is shown in superposition with the two selected sur-
faces and the projection surface. A frame (red and green) corresponding to the inspection map’s origin appears in both the
3D View and the Map Preview window.

Tip: Please, refer to the ColorBars section for more information about how to use the features.

Note:When a cylinder is vertical, i.e. when the angle between its axis and the Z-axis of the current coordinate system is
less than 45 degrees, the orientation of the inspection map changes between RealWorks 10.1 and RealWorks 10.2. When
the angle is greater than 45 degrees, the cylinder is considered horizontal. In this case, the orientation of the map does not
change between 10.1 and 10.2. Refer to the table below.

Horizontal Cylinder Vertical Cylinder
10.1 10.2 10.1 10.2

Note:When you save a project for which the orientation of the inspection map changed due to the verticality of the cylinder
in RealWorks 10.2, this changes the database. As a result, the project cannot be opened in 10.1.

14.3.2.5 Avoid the Filling of Holes on an Inspection Map

When you create an inspection map using clouds, and when there is a hole located inside the dataset, i.e., an area without
data that is completely surrounded by data, you have the choice of filling this hole (or not), whatever the size of the hole.

When the Fill Holes option has been kept unchecked, all the holes on the clouds are preserved on the inspection map.
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When the Fill Holes option has been checked, all the holes on the clouds are filled on the inspection map.

14.3.2.6 Print an Inspection Map

To print an inspection map, click inside the Map Preview window and do one of the following:

To print an inspection map:
1. Click Print in the Main toolbar,
2. Or select Print from the File menu
3. Or select Print from the pop-up menu.

14.3.2.7 Edit an Inspection Map

The inspection map computed previously may have irregularities like holes or spades, you can then edit it in order to keep
or to remove the part you want, to complete the holes or to smooth the map. In the edition mode, the mouse cursor will
change its shape and picking is always inside the inspection map. Before you draw a polygonal fence, only the Draw Poly-
gon To Edit tool can be used (see [A]). After you draw and validate a polygonal fence, the other tools become active (see
[B]).
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1 - Draw Polygon to Edit
2 - Keep Cells

3 - Empty Cells
4 - Fill Holes

5 - Smooth Cells

To fence an area:
1. Click the Draw Polygon to Edit.
2. Fence an area on the inspection map.
3. Right-click in the 3D View window.
4. Select End Fence from the pop-up menu.

Notes:
n To cancel the current polygonal fence, you can press Esc or select New Fence from the pop-up menu.
n To leave the Draw Polygon to Edit tool, click again the Draw Polygon to Edit, select Close Polygon Tool from the

pop-up menu or press Esc.

Tips:
n Instead of selecting End Fence from the pop-up menu, you can either double-click or press on the Space Bar.
n You can also select Keep Cells (or Empty Cells) from the pop-up menu or use their related short-cut key I (or O).

To filter an area:
1. Click the Fill Holes, if the fenced area contains holes.
2. Or click Smooth Cells, if the fenced area contains spikes for example.

Notes:
n You can also select Fill Holes (or Smooth Cells) from the pop-up menu or use their related short-cut key F (or S).
n An inspection map, once created, becomes uneditable.

14.3.2.8 Filter the Inspection Result

Do one of the following if you wish to filter the inspection map between a set of intervals: edit the current ColorBar and
change its interval values to those you need to use for filtering; or create a new ColorBar and set the interval values
required for filtering. The elevation differences which are out of this range of intervals will disappear from the inspection
map.

To filter the inspection result:
1. Click Edit ColorBar. The ColorBar dialog opens.
2. Click Edit. The ColorBar Editing dialog opens.
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1 - Option for setting only pos-
itive values of intervals

2 - Number of levels in the
current ColorBar

3 - Field for defining inter-
vals by setting values

3. Click in the interval value field and key in new values. The number of levels is displayed below.
4. Select the Positive Values option (if required).
5. Click in an interval line. A pull down arrow appears
6. Click on the pull down arrow. A color palette appears.
7. Choose an existing color or click Other to define yours.
8. Click Save.

14.3.2.9 Check the Inspection

The map gives you a global vision of the inspection between both selected surfaces. You can move your cursor over a point
on the inspection map in order to have the difference of elevations between these two surfaces at this point. The difference
of elevations appears in text beneath the Map Inspection window.

14.3.2.10 Save the Inspection

In this last step, you can save the inspection result as a permanent object in the database, perform a screen printout or go
further in analyzing the result thanks to the Inspection Map Analyzer tool. For each inspection map you save, a geometric
object is created and is put under the active group in the Models Tree. The ColorBar(s) that is (or are) related to it will be
saved too. As any geometric object in RealWorks, you can display its representation in the 3D View by double-clicking it in
the Project Tree or by selecting the Open Inspection Map command from the Display menu. A ColorBar has no rep-
resentation in the Project Tree.

Notes:
n To leave the Twin Surface Inspection tool, you can press Esc or select Close from the pop-up menu.
n Leaving the Twin Surface Inspection tool without saving the inspection result will open an information box which

prompts you to confirm, undo or cancel the operation you attempt to execute.

14.3.3 Surface to Model Inspection

This tool allows you to compare a surface with a model of plane, cylinder or tunnel shape. The surface and the model
should be fairly similar in the sense that the tool is designed to be used in "before and after" situations. You can select a
point cloud or a mesh for comparison. The surface inspection is based on a grid method and the result is an Inspection
Map. You can choose in the Preferences dialog box the units required to represent this map.

14.3.3.1 Open the Tool

You need to select a surface (point cloud or mesh) and a model from a project in order to be able to open the Surface to
Model Inspection tool. A model (when of plane and cylinder shape) can now be created using e.g. the Geometry Creator
tool in the Modeling processing mode. A model of tunnel shape is computed from a 2D Shape and a 3D Path within the Sur-
face to Model Inspection tool; both are polylines respectively in 2D and 3D. These polylines can be created using e.g. the
Polyline Drawing tool. You can also import a model either from 3Dipsos (a Trimble software application) or by loading a
DXF/DWG format file. The selected model will be a reference surface and the point cloud (or mesh) will be a surface to
inspect.

To open the tool:
1. Select one of these two sets (surface and model of plane/cylinder shape or surface and 2D polyline and 3D polyline)

from the Project Tree.

2. Select Surface to Model Inspection in Inspection > Inspection Map. The Surface to Model Inspection dialog
opens.
This dialog opens as the third tab of the WorkSpace window and is composed of five parts. The first part contains
two sub-tools: Segmentation and Sampling. The second part allows you to set a projection surface (3D plane, 3D
cylinder or 3D tunnel) resolution. The third part allows previewing the inspection result, displaying (or hiding) the
selected point cloud/mesh or model. The fourth part is to edit or to analyze the inspection result. The fifth part is to
save the inspection result, close the tool and give access to the online help.
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14.3.3.2 Define a Projection

A projection model will be automatically set after opening the Surface to Model Inspection tool. The surface to inspect (point
cloud or mesh) remains with its own color and the reference surface (model) is shown in yellow.

14.3.3.2.1 Plane-Based Projection

If the Model is a plane, the projection should be based on a 3D plane, with the same direction (Normal) and whose dimen-
sions (Width and Length) are delineated by the highlighting box.

1 - Model of Plane shape 2 - Cloud

14.3.3.2.2 Cylinder-Based Projection

If the Model is a cylinder, the projection should be based on a 3D cylinder, with the same size (Diameter and Length).

1 - Point cloud 2 - Model of Cylinder shape

14.3.3.2.3 Tunnel-Based Projection

If a 2D Shape and a 3D Path (respectively a 2D polyline and a 3D polyline) have been selected, the projection is based on a
3D Tunnel of the 3D polyline’s length and of the 2D polyline’s shape. The 2D Shape and 3D Path names are displayed in
Step 1. You can inspect the Comparison Surface (point cloud or mesh) with the Reference Surface (model) along or
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perpendicular to the 3D Path by checking Perpendicular or along the 3D path and in the Z axis direction (of the active
coordinate) by checking Vertical. You can also swap the 3D path and the 2D Shape.

Note: The step Define Projection is only available when selecting a 2D shape and a 3D path.

Define the Start/End Position When no Alignment Stationing has been Defined

If no alignment stationing has been defined on the selected 3D Path, the dialog displays as shown as illustrated:
n By default, the inspection performs from the beginning of the 3D Path to its end.

n You can define the Start (or End) position of the inspection, by picking a point along the 3D Path.
n If required, reset the Start position (and/or the End position) to the beginning (and/or to the end) of the 3D Path.

Define the Start/End Position When an Alignment Stationing has been Defined

If an alignment stationing has been defined on the selected 3D Path, the dialog displays as illustrated below:
n By default, the inspection performs from the beginning of the 3D Path to its end.
n The value in the Start field is the value of the Beginning Station (see the Alignment Stationing tool).
n The value in the End field corresponds to the position at the end of the 3D Path.
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n Define the Start and End positions of the inspection, by picking a point along the 3D Path.
n Or enter a distance value in the Start and End fields.

n If required, reset the Start position (and/or the End position) to the beginning (and/or to the end) of the 3D Path.
Note: If the alignment stationing is done with the Distance Along Alignment (3D) option, the distance will be along the 3D
Path. If the alignment stationing is done with the Horizontal Distance (2D) option, the distance will correspond to the dis-
tances along the curve projected onto the horizontal plane.

Note: Along a given 3D Path, you cannot set the Start position after the End position.

Note: There is no minimum distance between the Start position and the End position for an inspection. When you enter the
exact value of the Start position into the End field, this value is not taken into account.

14.3.3.3 Determine a Resolution

A same resolution will be applied to both directions of the projection surface except when a 2D Shape and a 3D Path have
been selected - see [A] and [B]. These directions will differ according to the projection model set in Step 1. If the projection
model is a 3D Cylinder, the projection directions are equal to the axis direction of the 3D Cylinder and to the direction along
the 3D Cylinder’s circumference. If the projection model is a 3D Plane, the projection directions correspond to the width and
length directions of the 3D Plane. If the projection surface is a 3D Tunnel, the resolution directions will be the 3D Path and
2D Shape directions.
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To determine a resolution in the Plane/Cylinder-Based Projection:
1. Enter a value in the Resolution field.
2. Or use the Up and Down buttons to select a value.

To determine a resolution in the Tunnel-Based Projection:
1. Enter a value in the Along 3D Path field.
2. Enter a value in the Along 2D Shape field.
3. Or use the Up and Down buttons to select a value.

14.3.3.4 Preview an Inspection

Once you have finished defining the projection surface resolution, you can perform a preview to visualize the result before
saving it in the RealWorks database. You can change the parameter as many times as you please and perform a preview
without leaving this tool. By default, an object selected for activating the tool is automatically displayed in the 3D View. To
hide it, you have to un-check the display option. And to display it again, you should re-check the option. There are two dis-
play options (one for each object selected). If the selected object is a point cloud, the display option will take the name of
Display Cloud. If the selected object is a mesh, the display option will take the name of Display Mesh. The second display
option’s name is always Display Model.

To preview an inspection:
1. Un-check the Display Cloud (or Display Mesh) option, if needed.
2. Un-check the Display Model option, if needed.
3. Keep the Fill Holes option unchecked, if required.
4. To add a colored layer, check Create Color Layer With Current Layer rendering.
5. Click Preview.

Note: You do not necessarily need to validate the value you key in the Resolution field. Clicking the Preview button will val-
idate the value on its own.

The inspection is done by comparing the Model with the selected Surface. The inspection result is a map shown in a spe-
cific window (called Map Preview) which opens above the 3D View. This map is a 2D image inside which pixels are colored
according to the difference (expressed in terms of elevation) between the Surface and the Model. A ColorBar located at the
right side of the inspection map is a scale of elevation values and each color corresponds to an elevation value.

In the Map Preview, you can zoom the inspection map In (or Out) in three ways. The first one is to magnify (or reduce) an
area of the inspection map by using Image Zoom In and Image Zoom Out . The second way is to magnify (or reduce)
the inspection map using the mouse wheel (if present). The last way is to select a rate from the drop-down list. If the inspec-
tion map is larger than the Map Preview window can display, you can pan it on left-click in four directions: Up, Down, Right
and Left. You can also hide/show the current ColorBar or edit a new one.

In the 3D View, the inspection map is shown in superposition with the two selected items (Surface and Model). A frame (of
red and green colors) corresponding to the origin of the inspection map (also called Orientation) appears in both the 3D
View and the Map Preview.
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1 - Zoom features
2 - ColorBar features
3 - Origin of the inspection map

3 - Difference in elevations at the cursor pos-
ition
4 - Inspection map
5 - ColorBar

14.3.3.4.1 Plane Shape

1 - Origin of the inspection map
2 - Inspection map

3 - Selected point cloud

Tip: Please, refer to the ColorBars section for more information about how to use the features.

14.3.3.4.2 Cylinder Shape
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1 - Origin of the inspection map
2 - Inspection map

3 - Selected point cloud

Tip: Please, refer to the ColorBars section for more information about how to use the features.

When a cylinder is vertical, i.e. when the angle between its axis and the Z-axis of the current coordinate system is less than
45 degrees, the orientation of the inspection map changes between RealWorks 10.1 and RealWorks 10.2. When the angle
is greater than 45 degrees, the cylinder is considered horizontal. In this case, the orientation of the map does not change
between 10.1 and 10.2. Refer to the table below.
Horizontal Cylinder Vertical Cylinder
10.1 10.2 10.1 10.2

Note:When you save a project for which the orientation of the inspection map changed due to the verticality of the cylinder
in RealWorks 10.2, this changes the database. As a result, the project cannot be opened in 10.1.

14.3.3.4.3 Tunnel Shape
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1 - Origin of the inspection map
2 - Inspection map

3 - Selected point cloud

Tip: Please, refer to the ColorBars section for more information about how to use the features.

14.3.3.5 Avoid the Filling of Holes on an Inspection Map

When you create an inspection map using clouds, and when there is a hole located inside the dataset, i.e., an area without
data that is completely surrounded by data, you have the choice of filling this hole (or not), whatever the size of the hole.

When the Fill Holes option has been kept unchecked, all the holes on the clouds are preserved on the inspection map.
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When the Fill Holes option has been checked, all the holes on the clouds are filled on the inspection map.

14.3.3.6 Create & View a Colored Map

The Create Color Layer With Current Rendering enables to produce stunning colored maps using the rendering modes and
the point size options available in the software. You cannot use point filtering options and shading with normals option
(ambient shading options will work). They will not apply in the colored map. Objects of any type (e.g., measurements,
annotations, geometries, etc.) displayed in the 3D View have to be hidden. They will not appear in the colored map.

To create & view a colored map:
1. In the Preview Inspection panel, check Create Color Layer With Current Rendering and click Preview.
2. In the Map Preview, click Switch to Color Layer to display the colored map.
3.  Click "Blend" and:

n Enter a value in the field.
n Or use the "Up" and "Down" arrows to select a value and press Enter.
n 100%: Only the colored map is displayed.
n 0%: Only the distance map is displayed.
n In Between: The two maps are blended together according to the entered value.

Note: The Switch to Color Layer icon is grayed out if an inspection map has been generated without the Create Color Layer
With Current Rendering off.
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14.3.3.7 Print an Inspection Map

To print an inspection map, click inside the Map Preview window and do one of the following:

To print an inspection map:
1. Click Print in the Main toolbar,
2. Or select Print from the File menu
3. Or select Print from the pop-up menu.

14.3.3.8 Edit an Inspection Map

The inspection map computed previously may have irregularities like holes or spades, you can then edit it in order to keep
or to remove the part you want, to complete the holes or to smooth the map. In the edition mode, the mouse cursor will
change its shape and picking is always inside the inspection map. Before you draw a polygonal fence, only the Draw Poly-
gon To Edit tool can be used (see [A]). After you draw and validate a polygonal fence, the other tools become active (see
[B]).

1 - Draw Polygon to Edit
2 - Keep Cells

3 - Empty Cells
4 - Fill Holes

5 - Smooth Cells

To fence an area:
1. Click the Draw Polygon to Edit.
2. Fence an area on the inspection map.
3. Right-click in the 3D View window.
4. Select End Fence from the pop-up menu.

Notes:
n To cancel the current polygonal fence, you can press Esc or select New Fence from the pop-up menu.
n To leave the Draw Polygon to Edit tool, click again the Draw Polygon to Edit, select Close Polygon Tool from the

pop-up menu or press Esc.

Tips:
n Instead of selecting End Fence from the pop-up menu, you can either double-click or press on the Space Bar.
n You can also select Keep Cells (or Empty Cells) from the pop-up menu or use their related short-cut key I (or O).

To filter an area:
1. Click the Fill Holes, if the fenced area contains holes.
2. Or click Smooth Cells, if the fenced area contains spikes for example.

Notes:
n You can also select Fill Holes (or Smooth Cells) from the pop-up menu or use their related short-cut key F (or S).
n An inspection map, once created, becomes uneditable.

14.3.3.9 Check the Inspection
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The map gives you a global vision of the inspection between the selected surface and the model. You can move your cursor
over a point on the inspection map in order to have the difference of elevations between both the surface and the model at
this point. The difference of elevations appears in text beneath the Map Inspection.

14.3.3.10 Save the Inspection

In this last step, you can save the inspection result as a permanent object in the database, perform a screen printout or go
further in analyzing the result thanks to the Inspection Map Analyzer tool. For each inspection map you save, a geometric
object is created and is put under the active group in the Models Tree. The ColorBar(s) that is (or are) related to it will be
saved too. As any geometric object in RealWorks, you can display its representation in the 3D View by double-clicking it in
the Project Tree or by selecting the Open Inspection Map command from the Display menu. A ColorBar has no rep-
resentation in the Project Tree.

Notes:
n To leave the Surface to Model Inspection tool, you can press Esc or select Close from the pop-up menu.
n Leaving the Surface to Model tool without saving the inspection result will open an information box which prompts

you to confirm, undo or cancel the operation you attempt to execute.

14.3.4 Inspection Map Analyzer

The Inspection Map Analyzer tool allows you to extract five categories of information (Points & Polylines, Sections & Shifts,
Volumes & Surfaces, Iso-curves and Colored Meshes) from an inspection map and each category corresponds to a sub-
tool.

14.3.4.1 Open the Tool

You can open the Inspection Map Analyzer tool either from the main menu after selecting an existing inspection map from
the Project Tree or inside the Twin Surface Inspection (or Surface to Model Inspection) tool after inspecting.

To open the tool:
1. Select an inspection map from the Project Tree.

2. Select Inspection Map Analyzer in Inspection > Inspection Map. The Inspection Map Analyzer dialog opens.
This dialog opens as the third tab of the WorkSpace window. Depending on the sub-tool you select, the Inspection
Map Analyzer dialog changes appearance. The selected inspection map is displayed in the Inspection Map Ana-
lyzer Viewer [A] with two sliders (horizontal and vertical).

Vertical slider (in this example)
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The Section Viewer [B] shows the extraction result(s) in 3D and optionally the inspection map if the Display 3D Map
option is checked. The Lock in 2D option (when not dimmed and if checked) locks the extractions result(s) in 2D
(constrained in the XZ* plane of the active frame) with a 2D Grid in superposition. You can hide and display the 2D
Grid again. When the Lock in 2D option is checked, you can only pan the results(s) in the YZ* plane, zoom (in or
out) or rotate around the X* axis. Un-checking Lock in 2D will hide the 2D Grid and will free the result(s) from the 3D
locked constraint.

The way the two viewers (Inspection Map Analyzer and Section) will be represented depends on the sub-tool you
select. You can rearrange the viewers as you please using the View Manager tools

Notes:
n Pressing Esc will close the Inspection Map Analyzer tool.
n Clicking Close in the Inspection Map Analyzer dialog (or selecting Close from the pop-up menu in the viewers) will

not close the current sub-tool but will close the main tool.
n (*) In the X, Y, Z Coordinate System.

14.3.4.2 Select "Points & Polylines"

Because the metric information is still stored in an inspection map, you can get the 3D position of a point as in the Feature
Set tool (surveying point) or as in the Measure tool (measured point) or simply define an area of interest by drawing a poly-
line.

To select "Points & Polylines":
1. In the Inspection Map Analyzer dialog, click on the pull down arrow.
2. Select Points & Polylines. The Inspection Map Analyzer dialog appears as shown.

1 - Pick Point 2 - Draw Polyline 3 - Close Polyline (or Open Polyline)
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The Inspection Map Analyzer and Section Viewers are both opened. In the Section Viewer, the inspection map is by
default hidden and the navigation is locked in 2D. In the Inspection Map Analyzer Viewer, the horizontal and vertical
sliders are shown and only one is active.

3. If required, check the Display 3D Map option to view the inspection map in the Section Viewer.
4. If required, uncheck the Lock in 2D option to free the navigation from 2D lock in the Section Viewer.
5. In Step 1, choose between Pick on Reference Surface and Pick on Comparative Surface.

Tip: You can use the Up/Down (or Right/Left) arrows of your keyboard to vertically (or horizontally) move the slider with con-
stant step. This step corresponds to one pixel on the inspection map (not one pixel on the screen). To do this, you should
first click inside the Inspection Map Analyzer Viewer to select it.

14.3.4.2.1 Pick Points

Picking should always be done inside the Inspection Map Analyzer Viewer and anywhere over the color area of the inspec-
tion map (except on black area).

To pick a point:
1. Pan (or zoom) the inspection map in or out (if required).
2. Click the Pick Point icon. The two sliders disappear from the Inspection Map Analyzer Viewer.
3. Pick a point on the inspection map in the Inspection Map Analyzer Viewer.

The picked point is shown in the Inspection Map Analyzer Viewer [A] and in the Section Viewer [B]. Its 3D position
(XYZ coordinates) is displayed in text in the Section viewer. Starting a new picking will cancel the current one.

Picked point in the Inspection Map Analyzer Viewer
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Picked point in the Section Viewer

Tips:
n You can also select Quit Point Creation Mode from the pop-up menu or press on the Esc key.
n You can remove the picked point labels from the 3D View by first selecting Rendering, then Display 3D Labels from

the 3D View menu.

14.3.4.2.2 Draw Polylines

Picking should be done on the colored areas of the inspection map.

To draw a polyline:
1. Click the Draw Polyline icon. The two sliders disappear from the Inspection Map Analyzer Viewer and the Close

Polyline icon becomes active*.
2. Pick a series of points on the inspection map in the Inspection Map Analyzer Viewer.
3. Right-click and select Close Polyline from the pop-up menu. The start point is connected to the end point. Close

Polyline becomes Open Polyline.
4. Right-click again and select Open Polyline from the pop-up menu. The start point is disconnected to the end point.

Open Polyline becomes Close Polyline.
5. Double-click to end the polyline.

The drawn polyline appears in both of the two viewers (Inspection Map Analyzer and Section).
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Drawn polyline in the Inspection Map Analyzer Viewer

Drawn polyline in the Section Viewer

6. If required, right-click in the Inspection Map Analyzer viewer and select New Polyline from the pop-up menu. The
drawn polyline is cancelled. You can then start a new polyline.

Notes:
n You can neither draw a circle arc nor a series of discontinuous polylines.
n (*) The Close Polyline icon may define two creation modes. The Not-clicked-on Close Polyline icon sets the open

polyline creation mode. The Clicked-on Close Polyline icon sets the close polyline creation mode.
n You cannot combine the Pick Point and Draw Polyline features together.

Tips:
n You can also select Draw Polyline, Close Polyline, Open Polyline and End Polyline from the pop-up menu.
n Pressing once Esc will cancel the current polyline. Pressing twice Esc will cancel the current polyline and leave the

polyline tool.

14.3.4.2.3 Save the Results

You can create the extracted result(s) in the database and start a new point picking (or polyline drawing) without leaving the
tool. An object of 3D Point (or Polyline) type is created and rooted in the Models Tree. Before saving a point (or polyline),

Trimble RealWorks User Guide | 524



PRODUCTION TOOLS

add comments to it. After saving a point (or polyline), you can edit its related comments. To do this, display the created
object properties and go to the Label line for edition.

To save the results:
1. For each picked point (or drawn polyline), you can add comments.
2. Click Create to save the result.

Note: Be sure to first save the picked point (or drawn polyline) before leaving the Point Creation (or Draw Polyline) tool.
Otherwise, it will be cancelled.

14.3.4.3 Select "Sections & Shifts"

Because the metric information is still stored in an inspection map, you can extract some profiles and some cross-sections
from it as in the Profile/Cross-Section tool or inspect along a given path as in the 2D-Polyline Inspection tool.

To select "Sections & Shifts":
1. In the Inspection Map Analyzer dialog, click on the pull down arrow.
2. Choose Sections & Shifts from the drop-down list.

n The Inspection Map Analyzer viewer and the Section viewer both open. The Section viewer is split into two sub-
viewers. The top sub-viewer displays a section, or a couple of sections, or a shift depending on the option(s)
(Comparison Section, Reference Section, or 1D Inspection) chosen in Step 2. The bottom sub-viewer displays
the difference plot between a couple of sections.

n A section is a profile resulting from the slicing over a surface on an inspection map. A slice over a reference sur-
face, in red, is called Reference Section. A slice over a comparison surface, in green, is called Comparison Sec-
tion.

n The shift between a couple of Reference Section and Comparison Section, at a given position, is called 1D
Inspection.

1 - Reference Section (Red)
2 - Comparison Section (Green)

3 - 1D Inspection

n In the Section viewer, the selected inspection map is by default hidden. The navigation is locked in 2D.
n In the Inspection Map Analyzer viewer, the horizontal slider and the vertical slider are shown and only one is act-

ive at a time.

14.3.4.3.1 Define a Section Position

You need to define a direction and a position over the selected inspection map. The direction is given by the displacement
direction of a slider and the position by its position. You have at all two sliders (Vertical and Horizontal) and only one can be
activated at a time. The active slider is in blue.
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1 - Set Horizontal Slider
2 - Set Vertical Slider

3 - Set Slider Position
4 - Set Slider Point Position

Caution: The Set Horizontal Slider is grayed out when the selected inspection map is a Tunnel.

To choose a slider:
1. Click the Set Horizontal Slider icon to choose the horizontal direction.
2. Or click the Set Vertical Slider icon to choose the vertical direction.
3. Or position the cursor over the end of a slider and click on it.

Note: To hide (or display) the active slider, select Hide Slider (or Display Slider) from the pop-up menu in the Inspection
Map Viewer.

To set a slider position by drag & drop:
1. In the Inspection Map viewer, position the cursor over one of the two ends of a slider, as illustrated below.
2. If the Horizontal Slider has been chosen, drag and drop it from Up to Down and reversely until it meets the position

required. The slicing will be done in this direction and at this position.
3. If the Vertical Slider has been chosen, drag and drop it from Right to Left and reversely until it meets the position

required. The slicing will be done in this direction and at this position.

Note: The Set Horizontal Slider icon is grayed out when the selected inspection map is a Tunnel.

Tip: You can move the two sliders in four directions (Right, Left, Up and Down) using the arrow keys of your keyboard. In
that case, the displacement is done with a constant interval. The interval value is the one you set in the Interval field in Step
3.

To set a slider to a position by picking:
1. Choose a slider's direction.
2. Click the Set Slider Position icon. The two sliders disappear from the Inspection Map Analyzer viewer. The cursor

changes its default shape to a pointer.
3. Pick a point on the displayed inspection map.

n If the inspection map is a Plane (or a Cylinder); the chosen slider moves to the picked position in the chosen dir-
ection.

n If the inspection map is a Tunnel; the Vertical Slider moves horizontally to the picked position.

Tip: You can also right-click anywhere in the Inspection Map Analyzer viewer to display the pop-up menu and select Set
Slider Position.
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Tip: Instead of choosing Set Slider Position, you can also double-click in the inspection map.

To set a slider position by defining values:
1. Click the Set Slider Point Position icon. The Slider Position Definition dialog opens.
2. If the inspection map is a Plane (or a Cylinder); choose between Horizontal Slider and Vertical Slider.
3. If the inspection map is a Tunnel; only the Vertical Slider option can be chosen.
4. Do one of the following:

n Check the Point option, and enter the 3D coordinates of a point. Its related position, along the 3D Path and on
the inspection map, updates.

If the position of the point is out of the inspection map. A warning message displays in red in the Slider Position
Definition dialog, and the OK button is grayed out.

n Check the Position On 3D Path option.
If an alignment stationing is available on the selected 3D Path, the Station Prefix value displays next to the edit
field.

If no alignment stationing is available on the selected 3D Path, no Start Prefix value displays next to the edit
field.

Enter a distance value. The 3D coordinates and the position on the map of the related point, get updated. You
cannot input a position that is out of the range delimited the Start and End positions. These positions are those
defined when performing an inspection.

5. Click OK. The Slider Position Definition dialog closes.
n If Horizontal Slider has been chosen, the horizontal slider becomes active and it jumps vertically to the defined

position.
n If Vertical Slider has been chosen, the vertical slider becomes active and it jumps horizontally to the defined pos-

ition.

Note:When the format 2 Digits: 10+00 or 3 Digit 1+000 is used for the stationing, the sub units are not used.

14.3.4.3.2 Choose a Type of Object to Extract

You can now choose the type of object you want to extract from the selected inspection map. By default, all types are selec-
ted.

To choose a type of object to extract:
1. Keep all options checked.
2. Or/and clear the Reference Section option. The section in red is hidden.
3. Or/and clear the Comparison Section option. The section in green is hidden.
4. Or/and clear the 1D Inspection option. The shift is hidden.
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1 - Reference Section
2 - Inspection map

3 - Comparison Section
4 - 1D Inspection

14.3.4.3.3 Navigate Through the Sections

You can slice the selected inspection map with a constant interval along a defined direction and at a defined position. The
result is a set of Reference Sections; and/or Comparison Sections, and/or 1D Inspections. Only a couple of sections (Refer-
ence and Comparison) can be active at a time, it's the couple in fussing.

To navigate through the sections:
1. In Step 3, check the Multi-Slices option.
2. If the selected map is a Cylinder, click on the Choose Type of Unit pull-down arrow*.

a. Select the Use Length Unit option from the list. The unit of the Interval changes according to the unit set in the
Preferences / Units / Unit System / Length.

b. Or select the Use Angular Unit option from the list. The unit of the Interval changes according to the unit set in
the Preferences / Units / Unit System / Angle.

c. And jump to the step 5.
3. If the selected map is a Plane, jump to the step 5.

4. If the selected map is a Tunnel, jump to the step 5.

Trimble RealWorks User Guide | 528



PRODUCTION TOOLS

5. Enter a value in the Interval field.
6. Click (or ) to set a value.

In the case of a Tunnel, and with the Multi-Slices option selected:
n If the Horizontal Interval option is unchecked, the slices are set with a regular interval along the 3D Path (red

path).
n If the Horizontal Interval option is checked, the slices are set with a regular interval, not along the 3D Path, but

along its projection on a horizontal plane (blue path).

7. Click the Next (or Previous) button.

1 - Reference Section (in red)
2 - Comparison Section (in green)
3 - Shift (also called 1D inspection)

4 - Constant step used for slicing
5 - The active sections

In the Inspection Map Analyzer viewer, the Next (or Previous) button moves the horizontal slider from Down to Up
(or the vertical slider from Right to Left). The displacement is performed with a constant step which corresponds to
the value in the Interval field. In the Section viewer, the Next (or Previous) button sets the next (or previous) section
(s) (and/or shift) as active.

8. If needed, check the Reverse Directions option.
In the Inspection Map Analyzer viewer, the Next (or Previous) button moves the horizontal slider from Up to Down
(or the vertical slider from Left to Right). In the Section viewer, the Next (or Previous) button sets the previous (or
next) section(s) (and/or shift) as active.
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Tip: Instead of clicking Next (or Previous), you can use the Up and Down (or the Left and Right) Arrows on your keyboard.
Caution: (*) Only if the Horizontal Slider has been set.

Note: The 2D Lock option is unchecked on its own in case the Multi-Slices has been chosen.

14.3.4.3.4 View the Difference Plot

The Plot viewer displays the difference plot between a couple of sections. You can zoom it in/out, pan it, or change its scale
or print it.

When you create a tunnel inspection map with a 3D Path with an alignment stationing, you can see the position of the ver-
tical slider in the Plot viewer.

In the case of an inspection map, resulting from a cylindrical projection, to avoid having the axis of the difference plot inver-
ted compared to the slicing direction, we automatically compare the axis of the cylinder with the Z-Axis, as illustrated below.

In the case of a vertical cylinder and if the angle between its vector and the Z-Axis is less than 45°, the difference plot is dis-
played vertically along the slicing direction.
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In the case of a horizontal cylinder and if the angle between its vector and the Z-Axis is less than 45°, the difference plot is
displayed horizontally along the slicing direction.

In other cases, you can invert the axes manually by selecting Swap Axes.

To Manipulate a plot:
1. Click inside a graph to select it.
2. Drag and drop the graph (with the left button) to a new location to pan it.
3. Or use the mouse scroll wheel to zoom in/out.
4. Or use the left and middle buttons.

Note: Zoom In or Zoom Out will change the linear graph scale.

Note: The Zoom is centered on the current mouse location.

14.3.4.3.4.1 Print a Plot

To print a plot:
1. Right-click inside a graph.
2. Select Print from the pop-up menu. The Print Setup dialog opens.
3. Define the properties of your Printer.
4. Set the Size of the Paper.
5. Add title, reference, etc. in the Legend panel.
6. Choose an Orientation between Portrait and Landscape.
7. Choose a Scale between Auto Scale and Fixed Scale.
8. Click OK. The Print Setup dialog closes.

14.3.4.3.4.2 Scale a Plot

To scale a plot:
1. Right-click inside a graph.
2. Select Scales from the pop-up menu. The Plot Scale dialog opens.
3. Do one of the following:

1. Choose Automatic Scaling to
2. Or click on the Horizontal Scale (or Vertical Scale) pull-down arrow.
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3. Choose a scale from the drop-down list.

4. Click OK. The Plot Scale dialog closes.

14.3.4.3.4.3 Swap the Axes

To swap the axes:
1. Right-click inside a graph.
2. Select Swap Axes from the pop-up menu.

14.3.4.3.5 Export Sections

You are able to export a set of sections to the AutoCAD DXF (or DWG) format.

Note: For all of the exports described in the next topics, the Amplification Factor value is by default set to 3.

14.3.4.3.5.1 Horizontal Slices from a Plane Inspection

To export horizontal slices from a plane inspection:
n If the Set Horizontal Slider has been chosen, click Export. The Export Inspection Map Horizontal Slices dialog

opens.
1. Choose from a version of the DWG (or DXF) format from the File of Type field.
2. Locate a drive/folder to store the file in the Look In field.
3. Enter a name in the File Name field and click Save. The Horizontal Slices Export Parameters dialog opens.

n If the Multi-Slices option has not been checked, the Vertical Interval field is grayed-out, as illustrated below.

n If the Multi-Slices option has been checked, the Vertical Interval field is grayed-out with the Interval value, as
illustrated below.
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a. Input a distance value in the Horizontal Interval field.
b. Set a number in the Amplification Factor field.
c. If required, input a name in the Reference Surface Title field.
d. If required, input a name in the Comparison Surface Title field.
e. Choose a unit of measurement from the Unit field.
f. Click Export. The Horizontal Slices Export Parameters dialog closes.

A unique Horizontal Slice will be then exported to the chosen format.
Or
A set of Horizontal Slices will be then exported to the chosen format. All result from slicing the map hori-
zontally along the Horizontal Slider, with the Vertical Interval as a constant step.

Note:Out of the Inspection Map Analyzer tool, you can only export a set of Horizontal Slices.

14.3.4.3.5.2 Vertical Slices from a Plane Inspection

To export vertical slices from a plane inspection:
n If the Set Vertical Slider has been chosen, click Export. The Export Inspection Map Vertical Slices dialog opens.

1. Choose from a version of the DWG (or DXF) format from the File of Type field.
2. Locate a drive/folder to store the file in the Look In field.
3. Enter a name in the File Name field and click Save. The Vertical Slices Export Parameters dialog opens.

n If the Multi-Slices option has not been checked, the Horizontal Interval field is grayed-out, as illustrated
below.

n If the Multi-Slices option has been checked, the Horizontal Interval field is grayed-out with the Interval value,
as illustrated below.
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a. Input a distance value in the Vertical Interval field.
b. Set a number in the Amplification Factor field.
c. If required, input a name in the Reference Surface Title field.
d. If required, input a name in the Comparison Surface Title field.
e. Choose a unit of measurement from the Unit field.
f. Click Export. The Horizontal Slices Export Parameters dialog closes.

A unique Vertical Slice will be then exported to the chosen format.
Or
A set of Vertical Sections will be then exported to the chosen format. All result from slicing the map hori-
zontally along the Vertical Slider, with the Horizontal Interval as a constant step.

Note:Out of the Inspection Map Analyzer tool, you can only export a set of Vertical Slices.

14.3.4.3.5.3 Horizontal Slices from a Cylinder Inspection

To export horizontal slices from a cylinder inspection:
n If the Set Vertical Slider has been chosen, click Export. The Export Inspection Map Horizontal Slices dialog opens.

1. Choose from a version of the DWG (or DXF) format from the File of Type field.
2. Locate a drive/folder to store the file in the Look In field.
3. Enter a name in the File Name field and click Save. The Vertical Slices Export Parameters dialog opens.

n If the Multi-Slices option has not been checked, the Horizontal Interval field is grayed-out, as illustrated
below.

n If the Multi-Slices option has been checked, the Horizontal Interval field is grayed-out with the Interval value,
as illustrated below.
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a. Input a distance value in the Horizontal Interval field.
b. Set a number in the Amplification Factor field.
c. If required, input a name in the Reference Surface Title field.
d. If required, input a name in the Comparison Surface Title field.
e. Choose a unit of measurement from the Unit field.
f. Click Export. The Horizontal Slices Export Parameters dialog closes

A unique Horizontal Slice will be then exported to the chosen format.
Or
A set of Horizontal Slices will be then exported to the chosen format. All result from slicing the map hori-
zontally along the Vertical Slider, with the Vertical Interval as a constant step.

Note:Out of the Inspection Map Analyzer tool, you can only export a set of Horizontal Slices.

14.3.4.3.5.4 Vertical Slices from a Cylinder Inspection

To export vertical slices from a cylinder inspection:
n If the Set Horizontal Slider has been chosen, click Export. The Export Inspection Map Vertical Slices dialog

opens.
1. Choose from a version of the DWG (or DXF) format from the File of Type field.
2. Locate a drive/folder to store the file in the Look In field.
3. Enter a name in the File Name field and click Save. The Vertical Slices Export Parameters dialog opens.

n If the Multi-Slices option has not been checked, the Horizontal Interval field is grayed-out, as illustrated
below.

n If the Multi-Slices option has been checked, the Horizontal Interval field is grayed-out with the Interval value,
as illustrated below.
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a. Input a distance value in the Vertical Interval field.
b. Set a number in the Amplification Factor field.
c. If required, input a name in the Reference Surface Title field.
d. If required, input a name in the Comparison Surface Title field.
e. Choose a unit of measurement from the Unit field.
f. Click Export. The Vertical Slices Export Parameters dialog closes

A unique Vertical Slice will be then exported to the chosen format.
Or
A set of Vertical Slices will be then exported to the chosen format. All result from slicing the map horizontally
along the Horizontal Slider, with the Vertical Interval as a constant step.

Note:Out of the Inspection Map Analyzer tool, you can only export a set of Horizontal Slices.

14.3.4.3.5.5 Horizontal Slices from a Tunnel Inspection

Within the Inspection Map Analyzer tool, you cannot export the Horizontal Slices from a tunnel inspection, but you can do
this out of the tool by selecting the Export Inspection Map Horizontal Slices from the File / Advanced Exports menu.

14.3.4.3.5.6 Vertical Slices from a Tunnel Inspection

To export vertical slices from a tunnel inspection:
n The Set Vertical Slider is by default chosen, click Export. The Export Inspection Map Vertical Slices dialog opens.

1. Choose a format (DWG (or DXF) and a version from the File of Type field.
2. Locate a drive/folder to store the file in the Look In field.
3. Enter a name in the File Name field and click Save. The Vertical Slices Export Parameters dialog opens.

n If the Multi-Slices option has not been checked, the Horizontal Interval field is grayed-out, as illustrated
below.

n If the Multi-Slices option has been checked, the Horizontal Interval field is grayed-out with the Interval value,
as illustrated below.
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a. Input a distance value in the Vertical Interval field.
b. Set a number in the Amplification Factor field.
c. If required, input a name in the Reference Surface Title field.
d. If required, input a name in the Comparison Surface Title field.
e. Choose a unit of measurement from the Unit field.
f. Click Export. The Vertical Slices Export Parameters dialog closes

A unique Vertical Section will be then exported to the chosen format.
Or
A set of Vertical Slices will be then exported to the chosen format. All result from slicing the map horizontally
along the Vertical Slider, with the Horizontal Interval as a constant step.

Caution:Outside the Inspection Map Analyzer tool, you are not allowed to export vertical slices from a single Section.

14.3.4.3.6 Create a Set of Sections and 1D Inspection

To create a set of sections and 1D inspection:
1. If only one type of object has been chosen in Step 2, click the Create button.
2. If at least two types have been chosen in Step 2, click the Create All button.

n If the object type is Reference Section (or Comparison Section), a polyline named OBJECT is created under the
current project, in the Models Tree.

n If the object type is 1D Inspection, a 1D Inspection named OBJECT is created under the current project, in the
Models Tree.

3. Click Close. The Inspection Map Analyzer dialog closes.

14.3.4.3.7 Create a Multitude of Sets of Sections and 1D Inspection

To create a multitude of sets of sections and 1D inspection:
1. If the Reference Section (or Comparison Section) option has been checked in Step 2, click the Create All button.

n A set of polylines is created. All are put in a folder, named Map_Section_Ref (or Map_Section_Comp), followed
by the Interval value.

n Each polyline is named Map_Section_Ref (or Map_Section_Comp), with an ordering at the beginning and a pos-
ition (in term of distance or angle*) at the end, as illustrated below. The ordering is given by the direction of the
slider chosen in Step 1.
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Section at the position of the cursor in the inspection map
n If the inspection map is a Tunnel, and an Alignment Stationing applied to the selected 3D Path, and the sta-

tioning information is added to each created polyline. This helps the user to visualize which Vertical Slice is at
which position along the alignment:
Polylines created with the Horizontal Distance (2D) option chosen in the Alignment Stationing tool:

Polylines created with the Distance Along Alignment (3D) option chosen in the Alignment Stationing tool:

2. If the 1D Inspection option has been checked in Step 2, click the Create All button.
n A set of 1D Inspections is created. All are put in a folder, named Map_Section_Insp followed by the Interval

value

n Each 1D Inspection is named Map_Section_Insp, with a numbering at the beginning and a position (in term of
distance or angle*) at the end, as illustrated below.

n If the inspection map is a Tunnel, and an Alignment Stationing applied to the selected 3D Path, and the sta-
tioning information is added to each created 1D Inspection. This helps the user to visualize which 1D Inspection
is at which position along the alignment:

3. If the Reverse Directions option has been chosen in Step 3, the numbering order is inverted and the position of the
active section(s) (and/or 1D Inspection) changes.

4. Click Close. The Inspection Map Analyzer dialog closes.
Caution: (*) For a cylindrical inspection map (Tunnel), the cross map data lines are numbered with the following order: from
0° to +360°. All are put in a folder, whose name is followed by the Interval value in degrees.

14.3.4.4 Select "Volumes & Surfaces"

Trimble RealWorks User Guide | 538



PRODUCTION TOOLS

Because the metric information is still stored in the inspection map, you can extract the volume and surface information
(respectively in cubic meters and in square meters) from it as in the Volume Calculation tool. You can do this by fencing a
specific area or a series of areas. You can also filter according to a color defined by picking, from a range of colors by spe-
cifying values or using surface (or altitude) values. In selection, the mouse pointer changes depending on the mode you are
using. In Volumes & Surfaces, only the Inspection Map Analyzer viewer* is opened and the horizontal and vertical sliders
are hidden**.

To select "Volumes & Surfaces":
1. In the Inspection Map Analyzer dialog, click on the pull down arrow.
2. Select Volumes & Surfaces. The Volumes & Surfaces dialog appears.

1 - Polygonal Selection
2 - Color Range Selection
3 - Define Color Range

4 - Select By Using Surface Values
5 - Altitude Filter
6 - Select Whole Inspection Map Area

3. Select the whole map by clicking Select Whole Inspection Map Area.
4. Or fence an area,
5. Or pick a color,
6. Or define a color range,
7. Or use surface values,
8. Or filter altitudes.

Notes:
n You can right-click anywhere in the Inspection Map Analyzer viewer to display the pop-up menu and select the com-

mand you wish to use.
n * Click Restore Down in the Inspection Map Analyzer viewer to swap to the Inspection Map Analyzer and Section

viewers' display.
n ** To make one of the two sliders appear, select Display Slider from the pop-up menu.
n To be able to view the 2D lock (or the inspection map) when checking the Lock 2D (or Display 3D Map) option in the

dialog, please first restore the default layout (Inspection and Section viewers).

14.3.4.4.1 Fence an Area

Fencing an area is always done by picking anywhere (colored and black areas) on the inspection map. If no area has been
fenced, the whole inspection map will be selected by default.

To fence an area:
1. Click Polygonal Selection .
2. Pan or zoom the inspection map in or out (if required).
3. Draw a polygonal fence by picking and double-clicking to end.
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1 - Polygonal fence 2 - Selected area 3 - Unselected area

Tip: Pressing Esc or selecting New Fence or Close Polygon Tool from the pop-up menu will undo the polygonal
fence in progress.

4. Click on the pull down arrow of the Polygonal Selection list.
5. Select Add by Polygonal Selection .
6. Fence another area. This newly fenced area is added to the previous one.

1 - Fencing of addition shape 2 - The newly defined area is added to the old one

Tip: Instead of selecting Add By Polygonal Selection, you can also use its related shortcut key Ctrl. You should do
this before ending the polygon.

7. Click on the pull down arrow of the Polygonal Selection list.
8. Select Subtract by Polygonal Selection .
9. Draw another polygonal fence. Areas in common are subtracted.
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1 - Fencing of subtraction shape 2 - Areas in common are removed

Tip: Instead of selecting Subtract By Polygonal Selection, you can also use its related shortcut key Shift. You
should do this before ending the polygon.

10. Click on the pull down arrow of the Polygonal Selection list.
11. Select Intersect with Polygonal Selection .
12. Draw another polygonal fence. Areas in common are kept.

1 - Fencing of intersection shape 2 - Areas in common are kept

Tip: Instead of selecting Intersect With Polygonal Selection, you can also use its related shortcut key Shift + Ctrl.
Note: If there is no common area, all fenced areas will be canceled.

Tip: To leave the polygon selection mode, you can select Close Polygon Tool from the pop-up menu, click on any icon in
the Volumes & Sections dialog.

14.3.4.4.2 Pick a Color

To pick a color:
1. Picking should always be done inside the Inspection Map Analyzer viewer and anywhere over the colored areas of

the map.
2. Pan or zoom the inspection map in or out (if required).
3. Click Select Color Range .
4. Pick a pixel on the inspection map. The map is filtered according to the picked point color; the areas of this map shar-

ing the same color as the picked point are kept.
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1 - Cursor shape when selecting Select Color
Range

2 - Filtering color
3 - Unfiltered colors are darken

5. Click on the pull down arrow of the Color Range Selection list.
6. Click Add Color Range Selection .
7. Pick another pixel on the inspection map. The map is filtered according to the newly picked color.

1 - Cursor shape when selecting Add Color
Range Selection

2 - New filtering color

Tip: Instead of selecting Add Color Range Selection, you can also use its related shortcut key Ctrl. You should do
this before picking another pixel.

8. Click on the pull down arrow of the Color Range Selection list.
9. Select Subtract Color Range Selection .
10. Pick another pixel on the inspection map. The areas of the map having the same color as the picked point are sub-

tracted from the selection.

Cursor shape when selecting Subtract Color Range Selection

Tip: Instead of selecting Subtract Color Range Selection, you can also use its related shortcut key Shift. You should
do this before picking another pixel.

11. Click on the pull down arrow of the Color Range Selection list.
12. Select Intersect Color Range Selection .
13. Pick another pixel on the inspection map. The areas of the map having the color in common are kept. Those not hav-

ing the same color are unkept.
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Cursor shape when selecting Color Range Selection

Tip: Instead of selecting Intersect Color Range Selection, you can also use its related shortcut key Shift + Ctrl.
Note: If there is no pixel area, all picked pixels will be cancelled.

Tip: To leave the selection by color range mode, you can select Quit Selection by Color Range from the pop-up menu, click
on any icon in the Volumes & Sections dialog.

14.3.4.4.3 Define a Color Range

To define a color range:
1. Pan or zoom the inspection map in or out (if required).
2. Click Define Color Range. The Color Range Definition dialog opens.
3. Do one of the following:

n Filter according to one bound.
a. Choose between Keep Above and Keep Below.
b. Enter a value in the Bound 1 field.

1 - Bound value 2 - The elevation differences above or below the
bound value are kept and the others are darkened

n Filter between two bounds.
a. Select Keep Inside or Keep Outside.
b. Enter a value in the Bound 1 and Bound 2 fields.
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The elevation difference inside or outside the bound values are kept and the others are darkened

4. Click OK.

14.3.4.4.4 Use the Surface Values

The shift between two surfaces on an inspection map along a given direction and at a defined position can be viewed in the
Section viewer when selecting 1D Inspection in Sections & Shifts. This shift is a surface of its own. That’s why; the purpose
of this new feature in RealWorks is to allow the user to filter an inspection map according to a surface value or between two
values.

To use the surface values:
1. Click Select by Using Surface Values. The By Surface Selection dialog opens.

This dialog opens as the third tab of the WorkSpace window in place of the Inspection Map Analyzer dialog. In
Select by Using Surface Values, only the Inspection Map Analyzer viewer is opened and the horizontal and vertical
sliders appear again.

1 - Allows setting a section dir-
ection

2 - Allows filtering above/below a value or inside/outside
two values

2. Do one of the following:
n Check the Horizontal option. The horizontal slider becomes active.
n Check the Vertical option. The vertical slider becomes active.

3. Do any of the following:
n Select surfaces with values above a bounded value.

a. Select the Above Bound option.
b. Enter a value in the Bound 1 field.

n Select surfaces with values below a bounded value.
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a. Select the Below Bound option.
b. Enter a value in the Bound 1 field.

n Select surfaces with values between two bounded values.
a. Select the Inside Bounds option.
b. Enter a value in the Bound 1 field.
c. Enter a value in the Bound 2 field.

n Select surfaces with values outside two bounded values.
a. Select the Outside Bounds option.
b. Enter a value in the Bound 1 field.
c. Enter a value in the Bound 2 field.

4. Click Preview. Shifts between surfaces are extracted.

1 - Surfaces inside two bounds
2 - Section direction

3 - Surfaces out of bound tolerance are 4 - selected
and darkened
Surfaces outside two bounds

5. Check the results in Step 2.
6. Click Apply.

Tip: You can also choose Select by Using Surface Values from the pop-up menu.

14.3.4.4.5 Filter the Altitudes

The new RealWorks feature allows you to filter an inspection map based on a given altitude or between two defined alti-
tudes. The inspection map needs to be of Cylinder shape.

To filter an altitude:
1. Click Altitude Filter. The Altitude Filtering dialog opens.
2. Do one of the following:

n Filter according to one bound.
a. Choose between Keep Above and Keep Below.
b. Enter a value in the Bound 1 field.

n Filter between two bounds.
a. Select Keep Inside or Keep Outside.
b. Enter a value in the Bound 1 and Bound 2 fields.

3. Click OK. The Altitude Filtering dialog closes.

14.3.4.4.6 Report the Volume and Surface Information

The extraction results are listed in text in the Volumes & Surfaces dialog. You can save these results in a report file in rft
format. Note that you cannot save the results as permanent objects in the RealWorks database as in the Volume Cal-
culation, Twin Surface Inspection and Surface to Model Inspection tools.

To report the volume and surface information:
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1. Click Report. The Volume Calculation Report dialog opens.
2. Click Export. Another Volume Calculation Report dialog opens.
3. Enter a name for the report file in the File Name field.
4. Find a location where you want the report file to be stored.
5. Click Save.

14.3.4.5 Select "Iso-Curves"

You can extract and create Iso-Curves (of polyline type) from an inspection map. Iso-Curves are computed from a position
(called Reference) with a certain spacing (called Interval).

14.3.4.5.1 Extract Iso-Curves

In Iso-Curves, the Inspection Map Analyzer and Section viewers are opened. The horizontal and vertical sliders are hidden
in the Inspection Map Analyzer viewer and the Section viewer is empty of contents*.

To extract iso-curves:
1. In the Inspection Map Analyzer dialog, click on the pull down arrow.
2. Select Iso-Curves. The Iso-Curves dialog appears. The inspection map is by default not displayed in the Section

viewer.
3. If required, check the Display 3D Map option to view the inspection map.

1 - ColorBar
2 - Interval

3 - Reference
4 - Select Reference by
Picking

5 - Number of estimated
Iso-Curves with the default Reference and
Interval values

4. To define the Reference, do one of the following:
n Enter a value in the Reference field.
n Click (or ) to set a value.
n Click Select Reference by Picking and pick one point on the inspection map.

5. To define the Interval, do one of the following:
n Enter a value in the Interval field.
n Click (or ) to set a value.

6. Click Preview.
The first computed Iso-Curve will be the ReferenceIso-Curve; this means that it will have height the value set in the
Reference field. The other Iso-Curves will then be computed from the ReferenceIso-Curve by propagation in two dir-
ections (up and down) with the defined Interval. The active Iso-Curve (not necessarily the ReferenceIso-Curve but
the first in the computation’s order) is of fuchsia color in the Section viewer and is colored according to its value in
the ColorBar in the Inspection Map Analyzer viewer. For a given active Iso-Curve, the information window at the top
right corner of the Section viewer shows in text its order, shift and size (of the polyline).

Trimble RealWorks User Guide | 546



PRODUCTION TOOLS

1 - Active iso-curve 2 - Information window

Notes:
n Computing a huge quantity of Iso-Curves may take a very long time. In that case, an information dialog appears and

prompts you to continue or abort the operation.
n * To make one of the two sliders appear, select Display Slider from the pop-up menu.
n To be able to view the iso-curves in the Section viewer, hide the inspection map in the 3D View by un-checking the

Display 3D Map option.

14.3.4.5.2 Browse Iso-Curves

The active Iso-Curve is the first in the computation’s order. It is of fuchsia color in the Section viewer and is colored accord-
ing to its value in the ColorBar in the Inspection Map Analyzer viewer.

To browse iso-curves:
1. Click Display Next Iso-Curve (or Display Previous Iso-Curve ) to set the next (or previous) iso-curve as active.
2. Or click Display First Iso-Curve (or Display Last Iso-Curve ) to set the first (or last) iso-curve as active.
3. Or key in an iso-curve’s number and press Enter.
4. Or pick an iso-curve in the Inspection Map Analyzer viewer.

Notes:
n You can set several iso-curves as active. To do this, multi-select the ones you need in the Section viewer by com-

bining the use of Ctrl with clicking.
n You can use the Up (or Down) Arrow key instead of Display Next Iso-Curve (or Display Previous Iso-Curve).

14.3.4.5.3 Define Principal Iso-Curves

After previewing the result, you can choose and assign some of the Iso-Curves as principals. The remaining Iso-Curves are
then considered as intermediate Iso-Curves. Each principal Iso-Curve has a label which contains its height information in
text.

To define principal iso-curves:
1. Check the Define Principal Iso-Curves option.

1 - Defines the first principal Iso-
Curve by entering a number

2 - Defines the number of
Iso-Curves to skip

3 - Select First Principal
Iso-Curve by Picking

2. To define the First value, do one of the following:
n Enter a number in the First field.
n Or click (or ) to set a number.
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n Or click and pick an Iso-Curve in the Section viewer.
3. To define the Skip value, do one of the following:

n Enter a number in the Skip field.
n Or click (or ) to set a number.

1 - Principal Iso-Curves 2 - Intermediate Iso-Curves

14.3.4.5.4 Create Iso-Curves

Iso-Curves are created in the RealWorks database as 3D polylines in a set (named Cross-MapData-IsoCurves XX where
XX is the Interval value) under the current (active) project. You can export them to the AutoCAD application.

To create iso-curves:
1. Click Create All.
2. Click Close.

Notes:
n Close can also be selected from the pop-up menu.
n Leaving the Iso-Curves sub-tool without saving the result will display a warning message.

14.3.4.6 Select "Colored Meshes"

You can extract and create a Colored Mesh not based on the point clouds, meshes or model (prerequisites for doing the
inspection) but directly from a surface (Reference or Comparison) of an inspection map. A Colored Mesh is built by using
both the grid information and the color information found in the inspection map. The grid information is used for computing
vertices while the color information is required for coloring.

14.3.4.6.1 Extract Colored Meshes

In Colored Mesh, the Inspection Map Analyzer and Section viewers are opened and the horizontal and vertical sliders are
hidden*.

To extract colored meshes:
1. In the Inspection Map Analyzer dialog, click on the pull down arrow.
2. Select Colored Mesh. The Colored Mesh dialog appears. The inspection map is by default not displayed in the Sec-

tion viewer.
3. If required, check the Display 3D Map option to view the inspection map.
4. Do one of the following:

n Check the Reference Surface option.
n Check the Comparison Surface option.
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5. Click Preview. A colored mesh is then extracted.

1 - Colored mesh 2 - Inspection map

Notes:
n After clicking Preview, the number of vertices and the number of triangles related to the computed mesh are shown

in the Colored Mesh dialog.
n * To make one of the two sliders appear, select Display Slider from the pop-up menu.

14.3.4.6.2 Create Colored Meshes

To create colored meshes:
1. Click Create.
2. Click Close.

Notes:
n Close can also be selected from the pop-up menu.
n Leaving the Colored Mesh sub-tool without saving the result will display a warning message.

14.3.4.7 Print Inspection Maps

To Print an Inspection Map:
1. Right-click inside the Inspection Map Analyzer view.
2. Select Print from the pop-up menu. The Print Setup dialog opens.
3. Choose a printer from the Printer panel.
4. Choose a size and a source from the Paper panel.
5. Define an orientation for the paper by checking either Portrait or Landscape.
6. Fill in comments in the Legend panel.
7. Choose between Auto Scale and Fixed Scale.
8. If Fixed Scale has been chosen, click on the pull-down arrow and select a scale from the list.
9. Click Preview. A preview of the inspection map appears.
10. In the preview mode, do one of the following:

n Click Print to print the inspection map.
n Click Zoom In to magnify the inspection map.
n Click Zoom Out to reduce the inspection map (after zooming in).
n Click Next Page (if there is more than one page).
n Click Prev Page (if the current page is other than the first page).
n Click Two Pages (if there is more than one page).
n Press Esc to leave the preview mode.

11. Click OK. The Print Setup dialog closes.

Tips:
n You can also click Print in the Main toolbar or select Print from the File menu.
n You can also select a printer from the network (or set the current printer's properties) by clicking on the Network (or

Properties) button in the Print Setup dialog.
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14.3.5 Floor Inspection

The Floor Inspection feature lets the user inspect quite quickly the flatness of a floor. The result can be saved in the
RealWorks database and exported into a report and other files in order to be opened in other software solutions.

14.3.5.1 Open the Tool

To open the tool:
1. Select a point cloud from the Project Tree.

2. Select Floor Inspection in Inspection > Floor. The Floor Inspection dialog opens.

14.3.5.2 Edit the Selected Point Cloud

Frequently, the selected cloud contains many points. Some are required for the inspection like points on the ground and oth-
ers are not. You need to isolate and keep points on the ground. To do this, you can use the Segmentation tool and / or the
Ground Extraction feature in the Sampling tool.

14.3.5.3 Define an Inspection Area

You need to define an area which delimits the part of the ground to inspect.

To define an inspection area:
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1. Click the Define Area button. The 3D scene is locked in 2D, in Top view, in the XY plane of the current frame.
2. Choose one of the following:

n Define Rectangle by Defining Two Points has to be used to draw a rectangle aligned with the current coordinate
frame.

n Define Rectangle by Defining Three Points has to be used to draw a rectangle free of alignment.
3. Pick two opposite points, if Define Rectangle by Defining Two Points has been chosen.
4. Pick three unaligned points, if Define Rectangle by Defining Three Points has been chosen.

n The two (or three) points define a rectangular area which delimits the part of the ground to inspect.
n Points inside the defined area are fitted with a plane, with red edges and yellow background. This plane is called

Reference Plane. It will be used as a projection plane for inspecting the ground. Its height along the Z axis (of the
current frame) is displayed in the Elevation field.

n When you change the current area to a new one, the value in the Elevation field changes too.
n When you hover the cursor over the plane, its manipulators appear, one per edge and one per corner.

5. If required, drag and drop a manipulator to resize the plane.

6. Click the Done button.
n A Grid, superimposed to the plane, appears.
n The Grid Origin and Grid Spacing fields become enabled.

Note: You cannot undo the defined area. If you wish to do it, you need to define a new one.

14.3.5.4 Define an Inspection Grid
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The Grid, which appears over the area previously defined, has by default its Origin set at its bottom left corner. The Spacing
between two consecutive lines (horizontal or vertical) is the last set one. The origin sets the position where the grid starts.

1 - Origin of the grid 2 - Spacing of the grid

To define an inspection grid:
1. Define the origin of the grid by performing one of the following:

1. In the Grid Origin field, enter the 3D coordinates of a position.
2. Press Enter.

If the position is within the defined area, the Origin moves to the position.
If the position is outside the defined area like in [P1], the position closer to the defined area is then considered
[P2]. The Origin moves then to [P2]. The 3D coordinates of [P2] should be within the defined area.
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Or
3. Click . The 3D scene is locked in 2D, in Top view, in the XY plane of the current frame.
4. Pick a point on the defined area. You are not allowed to pick a position outside the defined plane.

2. In the Grid Spacing field, input a distance value.

14.3.5.5 Define a Reference Plane

In this step, you need to define an altitude for the Reference Plane.

To define a reference plane:
1. Input a distance value* in the Elevation field.
2. Press Enter.

Or
3. Click . The Reference Plane and the Grid disappear.
4. If required, bring the view to Front .
5. Pick a point on the displayed cloud.
6. If required, click . This resets the elevation to the average value.

Note: (*) The value you entered does not need to correspond to the height of a point on the cloud. You can set a height
higher than the cloud.

14.3.5.6 Generate an Inspection

To preview the inspection result:
1. If required, check the Fill Holes option.
2. If required, check the Out of Tolerance option and input a distance value in the field below.
3. Click the Preview button. A plane-based Inspection Map is computed with a resolution smaller than the Grid's one,

(1/10 of the Grid Spacing resolution with a minimum of 1 mm beyond which you cannot go down).
n In the 3D View, the Inspection Map is by default displayed. Its Color Bar, in red and blue, helps you to easily

identify the regions, on the ground and in the defined area, above zero (Red), and those that are below (Blue).
You may have some regions in black. There are no points inside such regions. Empty region color can be
changed to white in Preferences > Viewer.

n A set of horizontal and vertical lines is also displayed. These lines contain the points found for each node of the
Grid. Each of these points is the deviation of the corresponding cell of the Inspection Map. If the Origin point
defined is inside the area of the Inspection Map, a node is at this position.

n The snapshot below illustrates the Inspection Map, the Grid and the cloud intentionally un-stacked
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N - Node, intersection between a vertical line and
horizontal line, on the grid
ED - Elevation Difference

P - Point on the cloud with XYZ coordinates

4. If required, check either Display Cloud, or Display Inspection Map, or Display Grid to hide each of them in the 3D
View.

5. If required, change each of the parameters previously defined.
6. And generate a new preview.

n If the Fill Holes option has been checked, the regions in black (or white) on the inspection map are filled with the
information found in the neighbourhoods.
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n If the Out of Tolerance option has been checked, some regions in gray appear on the inspection map. These
regions are the points whose deviation is in the defined Tolerance, as illustrated below.

14.3.5.7 Generate a Report

To generate a report:
1. In the Generate Report panel, check the Above Reference (Red) option and/or Below Reference (Blue) option.
2. Click the Export button. A dialog opens.
3. In the Look In field, locate a drive/folder to store the report.
4. Enter a name in the File Name field.
5. Click Save. Five files are created.

n "Given_Name"_Floor Flatness Inspection Report in RTF format.
n "Given_Name"_Map_With Annotated Deviation in JPEG format.
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n All the points are displayed on the inspection map as follows: X (cross), ID (name) and deviation value.
n Points in yellow and white color are those the user explicitly asks to be exported, while those in dark gray are

not.
n "Given_Name"_Map in TIF format. The file contains an image of the Inspection Map.
n "Given_Name"_Map in TXT format. This file contains the four corners for the Tiff image: Top Left, Top Right, Bot-

tom Left and Bottom Right. They are useful to locate the Inspection Map in 3D.
n "Given_Name"_Points in TXT format. This file contains the points written in the following format:

n The name of each point is based on a unique ID defined in the InspectionGrid. When you export several times with the
same grid, you will always have the same ID and the same coordinates for each point. The coordinates of the points are
exported in the current frame, and with the current units and decimal place that have been set in the Preferences of
RealWorks.

n If the Above Reference (Red) option has been checked, only points with positive deviation are exported (in the report).
n If the Below Reference (Blue) has been checked, only points with negative deviation are exported (in the report).
n If the Out of Tolerance option has been checked, points whose deviation enters in the field of the defined option are not

exported (in the report).

14.3.5.8 Save the Inspection Result

To save the inspection result:
1. Click Create.

A folder, named Floor Inspection-Spacing "Value", is created and rooted under the Models Tree.
At the same time, an Inspection Map and a Polyline, respectively named Map and Grid, are created and stored
under the folder. Both have "Unclassified" as layer.

2. Click Close.

14.3.6 FF/FL Analysis (ASTM E1155)

The FF/FL Analysis (ASTM E1155) tool enables to measure the floor flatness and levelness values FF and FL, at a specific
area, directly from the 3D point cloud of a scanned floor. The values should be compliant with the ASTM E1155 standard.

14.3.6.1 Open the Tool

The input of the FF/FL Analysis (ASTM E1155) tool should be a cleaned point cloud (only floor) which needs to be dense
enough(1 point / 10 mm is the required minimum; 1 point / mm is recommended).

To open the tool:
1. Select a point cloud from the Project Tree.

2. Select FF/FL Analysis (ASTM E1155) in Inspection > Floor. The FF/FL Analysis (ASTM E1155) dialog opens.
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14.3.6.2 Define a Test Section

A Test Section is a rectangle created by picking three points on the displayed cloud. It must be in compliance with the
ASTM E1155 standard in terms of dimensions and surface, i.e., at least 2.44 m for both sides and higher than 29.73 m2 for
the surface area

To define a test section:
1. In Step 1, click the Define button. The scene is locked in a 2D plane in the Top view with a 2D grid superimposed (if

not hidden previously). The Picking Parameters toolbar appears in the 2D constraint mode.
2. Pick a point on the displayed point cloud data.
3. Move the cursor to pick another point. The segment, linking the first picked point, to the cursor initially in red

switches to green when its length matches the length specified by the ASTM E1155 standard.

4. Pick a point on the displayed point cloud data.
5. Move the cursor to pick the third point. The rectangle, initially in red switches to green when its surface matches the

surface specified by the ASTM E1155 standard.

6. Click Validate.
Or

7. Pick the third point on the displayed point cloud data to validate.
If the drawn test section is not in compliance with the ASTM E1155 standard in terms of dimensions and surface, an
error message appears and prompts you to resize the drawn section by using the edge and corner manipulators.
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Tip: You can choose Define Test Section from the pop-up menu instead of clicking Define.
Tip: You can press Enter or choose Validate from the pop-up menu instead of clicking Validate.
Note: Press Esc. to cancel the test section in progress.

14.3.6.3 Create and Edit Samples

A sample is a segment created by picking two points, inside the boundaries of the Test Section previously defined. All must
be uniformly distributed across the test section and at 45° to the sides of the test section rectangle.

The first sample defines your choice, either Orthogonal and Parallel case or Diagonal case.
In the Orthogonal and Parallel case:

n A sample must be at least 3.35 m long.
n The first defined sample cannot be longer than the shortest side of the Test Section.
n Parallel samples should be not closer than 1.22 m.
n Number of orthogonal and parallel samples should be equal.
n All samples should have the same length

In the Diagonal case:

n A sample must be at least 3.35 m long.
n Parallel samples should be not closer than 1.22 m.

If the length of a sample is less than 3.35 m, the picking (of the second point) fails (with a beep) and an error message is dis-
played.
If the minimum distance between two samples is less than 1.22 m, the picking (of the second point) fails (with a beep) and
an error message displays.
If the sample is in an area that does not contain sufficient point cloud data, an error message is displayed and the newly
drawn sample is discarded.

14.3.6.3.1 Create Samples

To create samples:
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1. Click Add Sample . The 3D scene is locked 2D in Top view, with a 2D grid superimposed (if not hidden pre-
viously). The Picking Parameters toolbar appears in the 2D constraint mode.

2. Pick a point on the displayed point cloud.
3. Move the cursor to pick another point. The segment, linking the first picked point to the cursor, initially in ORANGE

turns GREEN when its length matches the length specified by the ASTM E1155 standard (3.35 m).
4. Pick the point. The 3D scene is unlocked.
5. Add a new sample. It is in RED if the minimum distance which separates that sample to the first one is less than

1.22 m. It turns GREEN if the minimum distance matches the ASTM E1155 standard specification (1.22 m).
n A sample newly created is added to a list of samples with its FF and FL values.
n Each new sample is automatically named (1, 2, 3, etc.).

n The minimum and overall values of FF and FL are displayed with the 90% interval.

n The Minimal Number of Readings according to the measured area and the Total Number of Readings are also
displayed. Readings are the measurements done on the samples, spaced a constant step of 1ft.

n A defined sample is visible in the 3D View with its full name (name + FF: xx FL:xx).

Tip: You can also use the shortcut A or choose Add Sample from the pop-up menu.

14.3.6.3.2 Delete Samples

To delete samples:
1. Select an already defined sample from the list.

2. Click the Delete Sample icon.

Tip: You can choose Delete Sample from the pop-up menu.

Note: You can undo the deletion of a sample.

14.3.6.4 Create a Report

You are able to create a report in the RTF format. The Report button remains grayed out as long as the number of defined
readings does not reach the minimum number of required readings, which is related to the size of the test section.

To create a report:
1. Click the Report button. If the defined samples are not uniformly distributed over the test section, a warning

appears.
2. Click Yes. The FF/FL Analysis (ASTM E1155) Report dialog opens.
3. Navigate to the drive/folder where you want the report file to be stored in the Look In field.
4. Enter a name in the File Name field. The extension RTF is added automatically.
5. Click Save. The Enter Contract Specifications for Report dialog opens.
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6. Input a value in the Specified Overall Value (SOV) field for FF.
7. Input a value in the Minimum Local Value (MLV) field for FF.
8. Input a value in the Specified Overall Value (SOV) field for FL.
9. Input a value in the Minimum Local Value (MLV) field for FL.
10. Click Create. The Enter Contract Specifications for Report dialog closes and the report displays.

The report contains a snapshot of the test section with the samples displayed.
It also contains the tolerances (Specified Overall Value (SOV) and Minimum Local Value (MLV) for both FF and FL) used
and associated pass/fail result for each sample and overall, the number of readings, the measured area.
It shows the FF and FL values, and the 90% Conf. Intervals for each sample, for the overall and the minimum.

14.3.6.5 Close the Tool

The purpose of this tool is to create a report. No object creation is permitted. Closing the tool will make all modifications lost.

14.3.7 Wall Verticality Inspection

TheWall Verticality Inspection feature lets the user inspect quite quickly if a wall is flat and vertical. The result can be saved
into the software database and is exportable as a report and other format files.

n TOOL ACTIVATION: Select a point cloud and chooseWall Verticality Inspection in Inspection > Walls.
n POINT CLOUD EDITION: Frequently, the selected point cloud contains many points. Some are required for the

inspection like points on a wall and others are not. Use the Sampling Tool and/or the Segmentation Tool to reduce

Trimble RealWorks User Guide | 560



PRODUCTION TOOLS

and keep points only on the wall. The resulting point cloud is called Working Cloud.

n REFERENCE PLANE DEFINITION: It's a plane used as reference for inspecting a wall, (zero in distance). An
inspection consists in computing the distances of points related to that reference.
Use:
- to fit a plane on the Working Cloud with a vertical constraint.
- to fit a local plane on the Working Cloud with a vertical constraint.
- Once fit, a Reference Plane displays. By default, the entire Reference Plane is the area to inspect, with a Grid in
superimpose, and an Origin at the bottom left corner.
- Define a 3D position (depth) for the Reference Plane by picking a point on the Working Cloud or by entering 3D
coordinates.
Tip: To easily pick a point, rotate the Working Cloud to visualize it from the top.

n GRID DEFINITION: To resize the area to inspect (previously the entire Reference Plane), click Define Area. The
view is locked in 2D in the Reference Plane's plane (with a 2D Grid in superimpose).
Use:
- to draw a rectangle by picking two points.
- to draw a rectangle by picking three points.
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- Optionally, use the manipulators to resize the rectangle.

- Once drawn, click Done. The inspection area updates as well as the Grid.
A Grid is a two-dimensional structure with intersecting vertical and horizontal lines. The inspection will be done at
the intersection positions, called Deviations.
- Spacing is the distance between two consecutive lines, either vertical or horizontal. Enter or choose a value.
Define the Origin by picking a point inside the inspection area or by entering 3D coordinates.
- Origin helps to set a naming order for the Deviations. Enter a 3D coordinate position or pick a point on the Working
Cloud, inside the inspection area.

n INSPECTION PREVIEW: Use either Fill Holes or Out Of Tolerance and click Preview.
A plane-based Inspection Map is computed with a resolution smaller than the resolution of the defined Grid (1/10 of
Grid resolution with a minimum of 1 mm (see RFT format file when generating a report). Colors on the Inspection
Map help to identify on the wall:
- Areas in front of the Reference Plane (Red).
- Areas behind the Reference Plane (Blue).
- Areas with no points (Black). Empty regions color can be changed to White in Preferences > Viewer.
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- If Fill Holes has been checked, areas in black (or white) are filled with the information found in the neighborhoods.
- If Out Of Tolerance has been checked with a value, some gray areas appear meaning that points whose distance
from either side of the Reference Plane are within the defined tolerance.
- If Cloud has been checked, the Working Cloud remains displayed. Un-check to hide.
- If Display Inspection Map has been checked, the computed Inspection Map remains displayed. Un-check to hide.
- If Grid has been checked, the defined Grid remains displayed. Un-check to hide.

n REPORT GENERATION: Choose In Front Of Reference (Red) and/or Behind Reference and click Export.
A set of files is created:
- A report in RFT format:

- An image of the Inspection Map with annotated Deviations in JPEG format. A Deviation is the inspection result at
an intersection position of the Grid. It is annotated as follows: X (position), ID (name) and deviation value (positive
when it is in front the reference, and negative when it is behind the reference):
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- An image of the Inspection Map in TIF format.
- A TXT format file with the 3D coordinates of the Inspection Map corners:

- A TXT format file with all inspection positions in the following format:

If In Front Of Reference (Red) has been checked, only positive Deviations are exported in the TXT report.
If Behind Reference has been checked, only negative Deviations are exported in the TXT report.
If Out of Tolerance has been checked, Deviations within the defined tolerance are exported in the TXT report.

n INSPECTION CREATION: Click Create. A folder with an Inspection Map (Map) and a Polyline (Grid) are created.

14.3.8 3D Inspection

The main purpose of the 3D Inspection tool is to calculate the distance between each point of the compared cloud to a ref-
erence surface. The result is a colored cloud where colors stand for a distance (e.g. blue for the closest points and red for
furthest points, according to a predefined ColorBar). You can select two point clouds or a point cloud and a mesh to com-
pare.

14.3.8.1 Open the Tool

To open the tool:
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1. Select two point clouds (or a point cloud and a mesh) from the Project Tree.

2. Select 3D Inspection in Inspection > 3D Inspection. The 3D Inspection dialog opens.
The first selected item is a Reference, it displays in red in the 3D View. The second selected item is a Comparison, it
is in green. You can display (or hide) each of them by checking (or un-checking) the Display Reference (or Display
Comparison) option. If one of the selections is a mesh, it is by-default a Reference.
The two sub-tools (Segmentation and Sampling) let you define a region (or reduce the number of points) in each
selection. The input of these two sub-tools is the Comparison if the Display Comparison option is checked (or both
the Comparison and the Reference if both options are checked). Reload Points reloads only points from the selec-
tion for which the display option has been checked.
Compensate For Low Density applies a density correction to the Comparison point cloud, where points are not
dense enough. This option is enabled only if the Comparison is a point cloud. It works only for structured terrestrial
scans.

14.3.8.2 Compute an 3D Inspection Cloud

To compute an 3D inspection cloud:
1. Click Compute.

n An inspection is done between the Comparison and the Reference. As a result, a colored point cloud displays in
the 3D View. This colored cloud results from the Comparison point cloud colorization, inside which each point is
colored according to the distance from the Reference.

n A ColorBar displays next to the colored point cloud. It is a scale of colors and each color stands for a distance
from the Reference.

n If Absolute Distances (Positive Values Only) has been checked, positive distance values stand for points above
the Reference, and negative distance values for points below the Reference.

n If Absolute Distances (Positive Values Only) has been unchecked, all distance values stand for absolute values
independently points are above or below the Reference.
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n At the same time, the maximum and minimum distances are computed and displayed in the dialog. If a value
has been defined in the Max. Distance field, the displayed value for the Max. Distance cannot exceed that value
and the Comparison points whose distance exceeds the defined distance are not taken into account for the
inspection.

2. If required, click Swap Surfaces .
n The Reference becomes a surface to inspect (Comparison) and the Comparison swaps for Reference.
n The Compute becomes enabled again.

Note: Reload Points will reload the Comparison.

14.3.8.3 Create an 3D Inspection Cloud

To create an 3D inspection cloud:
n Click Create. The 3D Inspection dialog closes.

An object of 3D Inspection Cloud type named Inspection is created and rooted under the Models Tree. This object is
by-default selected so that you can launch directly the 3D Inspection Analyzer; and the two items required for the
comparison are both unselected.
You can select a folder from the Project Tree under which you want to put the created 3D Inspection Cloud. You
only need to do that before clicking Create.

Tip: Close can also be selected from the pop-up menu.

Notes:
- Optionally, select the Cloud Color rendering from the 3D View > Rendering menu to view the 3D inspection cloud with
color information.
- Optionally, add some annotations on the computed 3D Inspection Cloud. See Annotate.

14.3.9 Analyze a 3D Inspection Cloud

The 3D Inspection Analyzer tool enables to filter a 3D inspection cloud by keeping points between two defined values or to
extract connected cloud(s) as individual component(s). This tool can only be used as a standalone tool after selecting a
computed 3D inspection cloud.

14.3.9.1 Open the Tool

To open the tool:
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1. Select a 3D inspection cloud from the Project Tree.

2. Select 3D Inspection Analyzer in Inspection > Floor.
The 3D Inspection Analyzer dialog opens as the third tab of the WorkSpace window. The selected 3D inspection
cloud is by-default displayed in the 3D View. The number of points inside the 3D inspection cloud displays in the dia-
log.

3. Edit a ColorBar,
4. Or extract a cloud from the 3D inspection cloud,
5. Or auto-Split a 3D inspection cloud in a cluster of clouds.

14.3.9.2 Extract Clouds From 3D Inspection Clouds

Extracting a cloud from a 3D inspection cloud consists in defining a range (From and To values). Inspected points inside the
defined range will be then kept.

To extract a cloud from a 3D inspection cloud:
1. Do one of the following:

n Define the From value as follows:
n Drag and drop the From slider.
n Or key a value in the From field and press Enter.
n Or use the Up (or Down ) button.

n Define the To value as follows:
n Drag and drop the To slider.
n Or key a value in the From field and press Enter.
n Or use the Up (or Down ) button.

1 - The "To" slider and the "To" value in the ColorBar
2 - The "From" slider and the "From" value in the ColorBar
3 - The 3D inspection cloud

4 - Points of the 3D inspection cloud below the "To" value
5 - Points of the 3D inspection cloud above the "From" value

The 3D inspection cloud's Number of Points (see Step 1) as well as its aspect and the color associated with it
(see 3D View) will be then updated. Kept points are those in the defined range; they remain with their own
color. The unkept points are those out of the defined range. All are colored in black when they are above the
From value, and in white when below the To value. The Reload Points becomes enabled.

2. Click Extract. Unkept points are removed from the 3D View.
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3. If required, define a new range. The Extract button becomes enabled again.
4. If required, click Reload Points . The 3D inspection cloud takes its initial state (number of points and distances

From and To) as well as the ColorBar even if you have done several extractions.

Notes:
n The unit of measurement for From (or To) is set to Meter, you do not need to enter "m" after the value. You can

change the unit of measurement in Preferences.
n The From value cannot be greater than the To value, and reversely.
n The Extract button becomes dimmed.
n The Display Inspection Cloud option when checked (or unchecked) enables to display (or hide) the cloud in display

in the 3D View. This cloud can be the initial 3D inspection cloud or an extracted cloud.

14.3.9.3 Create the Extracted Cloud(s)

To create the extracted cloud(s):
1. Click the Create button. The 3D Inspection Analyzer dialog remains open.

n If the 3D inspection cloud has not been split but only filtered, a lonely cloud named as follows Insp3D-Cloud
From value - To value is created.

n If the 3D inspection cloud has been split; each component is created as a

Cloud
. Each has its own color and all are put under a folder called

Extracted Clouds
.

2. If required, use the extracted cloud as input for a new extraction (or splitting).
3. Click Close. The 3D Inspection Analyzer dialog closes.

Tip: Close can also be selected from the pop-up menu.

14.3.10 2D-Polyline Inspection

This tool enables you to compare a model to a point cloud. A model can come from an imported DXF (or DWG) file or res-
ults from cross-sectioning. An imported model must be already georeferenced with the point cloud. In both cases, a model
is a 2D polyline which should be composed of at least three non-aligned points.

14.3.10.1 Open the Tool

If your project you load has no 2D polyline, to activate the 2D-Polyline Inspection tool you need to import or create at least
one. Otherwise, an error message will appear. If your project contains more than one 2D polyline, you can launch the tool
and select one for inspection. A 2D polyline should be formed by at least three non-aligned points.

To open the tool:
1. Select one point cloud (or more) from the Project Tree.
2. From the Quick Access Toolbar, click the Open icon. The Open dialog opens.
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3. Select AutoCAD® files (*.dxf, *.dwg) from the File Of Type field.
4. Select the Add To Project option (if needed).
5. In the Look In field, navigate to the drive/folder where the .dxf file is located.
6. Double-click on the file to select it. The DXF File Import dialog opens.
7. Select the DXF length unit and click OK.

8. Select 2D-Polyline Inspection in Inspection > Polyline Inspection. The 2D-Polyline Inspection dialog opens.
This dialog opens as the third tab of the WorkSpace window and is composed of four parts: The first part contains
two sub-tools: Segmentation and Sampling. The second part allows you to select a model and to set a thickness.
The third part is to perform the inspection. The fourth and last part is to save the inspection result in the RealWorks
database, close the tool and obtain access to the online help. The selected cloud is displayed in white in the 3D
View.

14.3.10.2 Select a Model for Inspection

Inspecting in 2D means by plane. A virtual plane drawn by the non-aligned points of the selected model cuts the selected
point cloud. The thickness you set corresponds to the thickness of this plane and it should be higher than 0. The 2D inspec-
tion is done by comparing the selected model to the points that are in this plane. All available models in your project are
stored in the selection list in the 2D-Polyline Inspection dialog, except those with less than three points and you can select
one of them by dropping down this list. If you select a set of models before opening the 2D-Polyline Inspection tool, these
models will be unselected except one which is the first in the selection list.

To select a model for inspection:
1. Click on the Select Model and Thickness pull down arrow.

1 - Field for selecting a model 2 - Field for setting a thickness

2. Select a model from the drop down list.

14.3.10.3 Set a Thickness

To set a thickness:
1. Enter a value in the Thickness field.
2. Press Enter on your keyboard.
3. Or use the Up and Down buttons to select a value.

14.3.10.4 View the 2D Inspection Result

The 2D inspection is automatically performed once a model is selected, even if you have not set a thickness. RealWorks
will set a thickness by default. The inspection result can be viewed in the 3D View window and in a graph at the bottom of
the 2D-Polyline Inspection dialog (see A). The selected (active) model and points resulting from the inspection are dis-
played in the 3D View. Each distance, which separates a point from the model, is shown with a color (see B). Two options
are available: you can lock the result to 2D and display or hide the selected point cloud. A color scale at the left side of the
3D View gives an idea of distance for a given color.
[A]
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1 - The inspection graph
2 - The selected model
3 - The inspection between the model and the
cloud at this position

4 - Sliders for filtering points based on a given distance
5 - The color scale giving the distance information

[B]

In this picture, the selected point cloud, the selec-
ted model and the inspection result are displayed
in the 3D View window.

In this picture, only points resulting from the inspection with
the selected model are displayed

Note: In the 2D locked position, you can display the 2D grid. To do this, you can either right-click anywhere in the 3D View
to display the pop-up menu and select Show 2D Grid or select the 2D Grid/Show 2D Grid command from the 3D View menu
bar.

14.3.10.5 Filter the 2D Inspection Result

Two sliders (one at each end of the inspection graph) allow you to filter points according to a given distance. The Right end
corresponds to the maximum distance from the model while the Left end corresponds to the minimum distance from the
model. Filtering is done by moving one of the two sliders.

To filter the 2D inspection result:
1. Place your cursor over a slider. It becomes red.
2. Drag the cursor from its current position (maximum or minimum distance).
3. Drop the cursor until it comes closed to the distance you attempt to reach. The filtering will be done between this

range of distances.
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1 - The model's position
2 - The filtering result
3 - The minimum distance from the model

4 - The maximum distance from the model
5 - The filtering range

Note: In the 2D locked position or not, you can print the inspection result. To do this, you can either right-click anywhere in
the 3D View to display the pop-up menu and select Print or select the Print command from the File menu bar.

14.3.10.6 Save the 2D Inspection Result

The inspection results are summarized in the Step 3 of the 2D-Polyline Inspection dialog. You may find four major pieces of
information: the maximum distance from the model, the minimum distance from the model, the positive area and the neg-
ative area. If more than one 2D polyline is available in your project, you can select a new one and set a new thickness; the
inspection is automatically updated. Once the inspection is done, you can save the result in the RealWorks database.

To save the 2D inspection result:
1. Click Save.
2. Click Close.

Note: Instead of clicking Close in the dialog, you can also right-click anywhere in the 3D View to display the pop-up menu
and then select Close or press Esc twice.

14.3.11 Annotate

An annotation is a note and/or an image attached to a location which has to pick on a displayed point cloud (or scan, or geo-
metry, or image) in the 3D View. The Annotate tool requires no input, it can be selected in Home > Annotation.

n From the Annotation Creation dialog:
n Pick a position on the displayed point cloud (or scan) or enter a 3D coordinate position in the Position field. A Pin

appears at the defined position.
n If required, select to cancel the defined position and pick a new one.

- When the picking has been done over a point cloud or a scan, the created annotation is linked to the station
where the point lies. This enables the annotation to move with the station when its position is changed during a
registration.
- When the picking has been done over a 3D inspection cloud, the 3D inspection distance displays in the inform-
ation box. This distance is a signed distance, measured between the point picked on the 3D inspection cloud
and the nearest point in the reference cloud.

n Input a name in the Name field. A Label appears next to the Pin. The Create button remains grayed-out if you
leave this field empty.

n Optionally, input some comments in the Comment field.
n Optionally, choose an image from the project by clicking on the pull-down arrow. The attached image appears

as a thumbnail in the dialog.
n Click Create. An annotation is created in the Annotations sub-tree. See Annotations.

14.4 IMAGING TOOLS
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The Ortho-Image group includes a set of tools dedicated to the production of either a unique (or a series) of ortho-image(s)
from a point cloud, by converting imported images. The created images can be exported or used for creating rectified
images.

Note: You can also find the Ortho-Image group in the Registration module, but without the Ortho-Projection, Multi Ortho-
Projection and Image Rectification features.

This group includes a set of tools that are related to matched images.

Note: You can also find the Matched Image group in the Registration module, but without the Image Matching feature.

14.4.1 Convert to Ortho-Image

The Convert to Ortho-Image feature lets the user create an Ortho-Image registered (position, rotation, scale) from a point
cloud from a jpeg file (or any other format).

n ACTIVATE - Import an image into the project (See Import Image), and choose Convert to Ortho-Image in Ima-
ging > Ortho-Image. The image may have one of the following formats: JPG, TIFF and BMP, and shows the 3D
scene from the top view. Once done, select and display a point cloud in the 3D View.

Note: You can select an Ortho-Image and access the Convert to Ortho-Image to refine it (see Refine) or to change
its size (See Ortho-Image Size).

Tip: Select an image and choose Convert to Ortho-Image from the pop-up menu.
n DEFINE A PROJECTION PLANE - This step consists of defining a plane to project the three points to be picked

onto the point cloud in the next step. Do one of the following:
- Click Define Horizontal Plane by Picking 3D Position and pick a point. A plane perpendicular to the Z axis is cre-
ated at the picked position.
- Click Place Image by Entering Coordinates of Corners and set the Top Left Corner, Top Right Corner and Bot-
tom Left Corner of a projection plane. These three corners should form a square area. Otherwise, the OK button
remains grayed-out.

n DEFINE SCALE & POSITION - Click Place by Picking and pick three similar points onto the image and onto the
point cloud. These three points should be picked in the same order and should not be aligned.

Trimble RealWorks User Guide | 572



PRODUCTION TOOLS

If required:
- Use (or select Undo 2D Point from the pop-up menu) to cancel the last picked point in the image.

- Use ( or select Undo 3D Point from the pop-up menu) to cancel the last picked point in the point cloud.

- Use to cancel all picked points, and to stay in the picking mode.
- Press ESC. to cancel all picked points, and to leave the picking mode.

Click Apply (or press Enter) to validate. The software matches the 2D points of the image with the 3D points of the
point cloud and creates an Ortho-Image.
The Lock Ratio option enables you to create an Ortho-Image with an aspect ratio maintained.
- If the option has been checked, the software may deform the image while keeping its aspect ratio maintained to
match the 2D points with the 3D points.
- If the option has not been checked, the software may deform the image without keeping its aspect ratio maintained
to match the 2D points with the 3D points.
As a result the created Ortho-Image may not have the exact same size as the image.
If required, reset the created Ortho-Image to the original size of the image.

n CHECK & EDIT - Click and drag the slider to set a transparency.

- Opacity set to 0%:

- Opacity set to 50% (default position of the slider):
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- Opacity set to 100%:

n REFINE: Use to refine the Ortho-Image. Do one of the following:

- Bring the view to Front View. Select and drag the manipulator to move the Ortho-Image along the manipulator.

If required use to change the manipulator position.

- Bring the view to Front View. Select and pick a position to move the Ortho-Image moves along the direction of
its normal, at the position set by the picked point.
- Bring the view to Top View. Select
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and use the manipulator to rotate the Ortho-Image in its plane. If required use to change the manipulator pos-
ition.

- Bring the view to Top View. Select and use the manipulator to pan the Ortho-Image in its plane. If required use
to change the manipulator position.

- Bring the view to Top View. Select and pick two points to move the Ortho-Image in its plane along the direction
defined by the two picked points.

n RESIZE - To change the Height of the Ortho-Image proportionally with the Width, ensure the aspect ratio is main-
tained by checking Lock Ratio.

n CREATE - Input a name and click Apply.

14.4.2 Ortho-Projection

Conventional and perspective photographs taken by any 2D camera show distortions caused by the camera angle and the
topography itself. These phenomena can be noticed particularly on aerial photographs. Non-uninformed scale on this kind
of photographs prevents from direct measurement, like on a map. These disadvantages can be cancelled by ortho-rec-
tification. This means that such photographs are computer-deformed.

The Ortho-Projection tool allows you to create ortho-images from a point cloud (or a textured mesh) displayed in the 3D
View. You can either export the ortho-images to CAD software, such as AutoCAD® or MicroStation® for further processing
or drafting operations, or you can perform 2Dmeasurements directly within RealWorks. The basic principle behind this tool
is to choose a Projection Plane on which the ortho-image will be created, and choose the right information that you want to
store in this image, and then create it. All the metric information will be stored in this image, i.e. measurements made on this
photo will be accurate.
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14.4.2.1 Open the Tool

If you work with a point cloud and you need to delimit an area for the ortho-projection calculations, to render it cleaner
without parasite points or to simplify it. You can use either the Sampling tool or the Segmentation tool for doing these oper-
ations, and you need to perform them prior to open the Ortho-Projection tool.

To open the tool:
1. Display a point cloud (or mesh) in the 3D View.
2. Select Ortho-Projection in Imaging > Ortho-Image. The Ortho-Projection dialog opens.

This dialog opens as the third tab of the Workspace window and is composed of four parts. Each part corresponds
to one step in the ortho-projection computation. The first step (called Define Projection Plane) is to define, orientate
and check a Projection Plane. The second part (called Define Zone of Interest) is to draw a Zone of Interest on the
previous Projection Plane. The third part (called Define Image Resolution) is to specify parameters and rendering to
apply. The fourth part is to preview and create ortho-images.

14.4.2.2 Define a Projection Plane

You can define a Projection Plane by three points on an objector by using the current viewing/camera position. The Pro-
jection Planes that result from these two methods are not similar in terms of size. In the first method, the three picked points
delineate the size of the Projection Plane. In the second method, the bounding box that highlights the input (point cloud or
mesh) delineates the size of the Projection Plane.

A Projection Plane is characterized by a projection direction called View, two orientations Right and Up (also called X*and
Y* directions) which define an orthogonal frame, a position which is its position in the 3D scene and two dimensions that cor-
respond to its length and width. The View direction is the Normal of that Projection Plane. You can also define a Projection
Plane by getting the parameters of an existing ortho-image.

1 - Define Projection Plane by Picking 3
Points
3 - Define Corners of Zone of Interest

3 - Define Projection Plane by Screen View
4 - Define Projection Plane from Existing
Ortho-Image

Note: (*) In the X, Y, Z Coordinate Frame.

14.4.2.2.1 Pick Three Points

You can pick three points to define a Projection Plane. The accuracy of such a Projection Plane's orientation will be influ-
enced by the points you pick. It is recommended to pick these points in such a way that they are distributed across the area
on which you want to calculate the ortho-projection.

To pick three points:
1. Click the Define Projection Plane by Picking 3 Points icon. The Picking Parameters toolbar appears.
2. Pick three points (free or constrained) on the displayed objects.
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1 - Three picked points 2 - The defined projection plane (in yellow)

A number located beside the mouse's pointer guides you in picking points. This number starts from One and ends
by Three. When two points are picked, they are linked by a red segment. When three points are reached, they are
linked two-by-two by a red segment and form in that way a triangle. A Projection Plane is then computed. No need
of defining its Normal; it will be automatically calculated. You can cancel this plane whenever you want and start a
new one. To do it, start again the previous procedure.

Notes:
n You can also select Cancel Picking from the pop-menu.
n You can Pan, Rotate, Zoom (in or out) and Zoom with constant ratio in the 3D View while defining a Projection

Plane.
n In the picking mode, pressing Esc cancels the selection of points in progress. Out of the picking mode, pressing Esc

closes the Ortho-Projection tool.

14.4.2.2.2 Use the Current Camera View

In certain applications, you may need to visually choose a projection plane. The Define Projection Plane by Screen View
tool allows this. You first need to rotate the 3D scene to find the right viewing direction, and use the current screen plane as
the Projection Plane.

To use the current camera view:
1. Turn the scene to find the right viewing direction.
2. Click the Define Projection Plane By Screen View icon.

14.4.2.2.3 Set the Corners

Another method for defining a Projection Plane consists of setting its corner values. This operation has no influence upon
the View direction and the Right and Up orientations (X and Y directions).

To set the corners:
1. Click the Define Corners of Zone of Interest icon. The Vertical Rectangle Corner Coordinates dialog opens.
2. Enter a point position in the Top Left Corner field.
3. Enter a point position in the Bottom Right Corner field.
4. Click OK.

Tip: You can also select the Set Projection Plane Corners icon from the pop-up menu.

Note: You can measure the 3D coordinates of two opposite points in the 3D View thanks to the Point Measurement feature
in the Measure tool, and copy and paste the coordinates in the Vertical Rectangle Corner Coordinates dialog.

14.4.2.2.4 Set (or Edit) the Parameters
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Sometimes, you may need to edit manually the parameters of the current Project Plane or use the parameters of an exist-
ing ortho-image to calculate your own ortho-image. You can use the method below to recover the Projection Plane from
that of an existing ortho-image by getting its directions (View, X* and Y*), its position in the 3D scene and its Resolution and
Size. An option allows you to preview that ortho-image in 3D View.

To set (or edit) the parameters:
1. Click the Parameters button. The Set Parameters of Projection Plane dialog opens.

1 - Existing ortho-image in the project or
current Projection Plane
2 - Parameters of an existing ortho-
image or of the current Projection Plane

3 - Resolution and size of an existing ortho-
image or of the current Projection Plane

2. Click on the Select Source Plane pull-down arrow.
3. Select an existing ortho-image from the drop-down list
4. Modify the parameters (if necessary).
5. Check the Preview in 3DWindow option (if required).
6. Click OK. The Set Parameters of Projection Plane dialog closes.

Notes:
n You can use the Shift + C short-cut (or select Set Camera Parameters from the pop-up menu) to set or edit para-

meters.
n (*) In the X, Y, Z Coordinate Frame.

14.4.2.3 Modify a Projection Plane

After defining a Projection Plane, the other icons in the Step 1 panel become active. The Step 1 looks as illustrated below:

1 - Define Horizontal by Picking 2 Points
2 - Rotate 90° around Vertical Axis
3 - Define Projection Plane Position by Picking
Point

4 - Buttons for selecting a canonical
view
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14.4.2.3.1 Define the Horizontal

The Define Horizontal By Picking 2 Points feature enables to align the horizontal orientation of a Projection Plane to the dis-
played point cloud by picking two points. It means that for a given Projection Plane, you keep unchanged its Normal (View
direction) and you adjust its Right and Up orientations (horizontal and vertical).

To define the horizontal:
1. Click the Define Horizontal by Picking 2 Points icon. The Picking Parameters toolbar appears.
2. Pick a free or constrained point on the selected object to start the first point of the X direction.
3. Pick then the second point (free or constrained) to end this X direction.

1 - The first and second picked points 2 - The projection plane is aligned to the defined horizontal

After clicking Define Horizontal By Picking 2 Points, a 2D Grid appears upon the 3D scene. You can hide it or
change its size. The mouse cursor shape changes. The arrow becomes a pointer. A number beside this pointer
guides you in selecting points. It starts from One that corresponds to the first point of the X direction and ends by
Two. Once the two points are reached, a red segment links them and the new Projection Plane will be then gen-
erated. No need of defining a Normal direction. It keeps the former one. You can cancel it whenever you want and
start a new one. To do it, start again the previous procedure.

Note: In the picking mode, pressing Esc or selecting Cancel Picking (Esc) from the pop-up menu cancels the selection of
points in progress and closes Define Horizontal by Picking 2 Points.

14.4.2.3.2 Set a Position

You can also modify the position of a Projection Plane by picking a point on the displayed scene (point cloud or mesh). This
is important if you want to use the elevation information for calculating the ortho-projection.

To set a position:
1. Click the Define Projection Plane Position by Picking Point icon. The Picking Parameters (in 3D constraint mode)

toolbar opens.
2. Pick a point (free or constrained) anywhere on the selected object.
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1 - A point picked on the displayed cloud 2 - The projection plane moves from its current position
to its new position

Notes:
n Modifying a Projection Plane’s position will not modify its orientation.
n Press Esc (or select Cancel Picking (Esc) from the pop-up menu) to close the Define Projection Plane Position by

Picking Point tool.

14.4.2.3.3 Change the Dimensions

You can resize the previous Projection Plane. This operation has not an influence upon the View direction and the Right
and Up orientations (X* and Y* directions). The resized Projection Plane keeps the same parameters than before except
the dimensions. You can do this either by dragging & dropping a corner for example in the 3D View or by entering coordin-
ates in a dialog.

To change the dimensions:
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1. Place the mouse cursor upon any handle of a Projection Plane. A green square appears.

1 - The handle before the drag & drop operation 2 - The handle during the drag & drop operation

2. If a corner handle is selected, drag it to increase or reduce the Projection Plane size. During this operation, the
green square becomes yellow.

3. If a middle handle is selected, drag it to increase or reduce the Projection Plane width (or length). During this oper-
ation, the green square becomes yellow.

Note: (*) In the X, Y, Z Coordinate Frame.

14.4.2.4 Check a Projection Plane

In the example of a house, in order to have a complete facade drawing, you need to calculate ortho-images for both the
front and side views. You can rotate the Projection Plane or the scene to calculate a series of ortho-images in different ori-
entations. You can use a canonical view to control the projection definition, rotate left the scene (Half Pi rotation) or rotate
the scene around the screen vertical axis. Six canonical views are available: Front View, Back View, Left View, Right View,
Top View and Bottom View. You can edit and validate the current Projection Plane's parameters. This enables an accurate
definition and control of the Projection Plane's vectors and depth.

1 - Rotate 90° around Vertical Axis 2 - Buttons for selecting a canonical view

14.4.2.4.1 View from a Projection Plane' Side

The user can view the displayed scene from each of the Projection Plane' sides.

To view from a projection plane's side:
1. Click on the canonical view pull down arrow.
2. Choose among Front View, Back View, Left View, Right View, Top View and Bottom View.

Notes:
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n You need to first define a Projection Plane. Otherwise, all views are dimmed.
n You can swap from a view to another not by clicking on the button as are used to do in the View Alignment toolbar

but by clicking on the pull down arrow. Because clicking on that button will always bring you to the Front View of the
Projection Plane which is the view required to compute an ortho-image.

14.4.2.4.2 Rotate 90° Around Vertical Axis

To rotate 90° around the vertical axis:
1. Bring the Projection Plane in Front view.
2. Define the region on which you want to calculate the ortho-image and save the result.
3. Click the Rotate 90° Around Vertical Axis icon to turn the active projection plane to the side view.
4. Modify the region definition and calculate the second ortho-image and save the result.

The projection plane remains fixed while the 3D scene rotates 90° around its vertical axis

14.4.2.4.3 Edit Parameters

To edit the parameters:
1. Click Parameters. The Set Parameters of Projection Plane dialog opens.
2. Check the Preview in 3D ViewWindow option (if required).
3. Enter new values in the View Direction field.
4. Enter new values in the X Direction field.
5. Enter new values in the Y Direction field.
6. Enter a new value in the Point Position field.
7. Click OK.

Tip: You can use the short-cut key Shift + C to edit the parameters (or select Set Camera Parameters from the pop-up
menu).

14.4.2.5 Define a Zone of Interest

You need to define a region (called Zone of Interest) on the previous Projection Plane from which the ortho-projection will
be computed. For this, you have to draw a rectangular frame. In that drawing mode, you are locked in the Projection Plane's
plane with a 2D-grid in superimposition and the Projection Plane is hidden.

Before clicking on the Draw button, the Area in the Step 2 panel is "Area Undefined". After clicking on the Draw button, the
entire Projection Plane is set as a Zone of Interest and its dimensions appear in the Area field. After drawing a rectangular
frame, the Area values are updated to match the drawn frame' size.
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At the same time, the Rotate Counterclockwise 90° icon becomes enabled.

14.4.2.5.1 Draw a Zone of Interest

To draw a zone of interest:
1. Click the Draw button. The cursor will take the shapes as shown below.
2. Draw a rectangular frame by picking two points.
3. If required, rotate left both the displayed scene and the Projection Plane (see Rotate Counterclockwise 90°).
4. Click Validate.

1 - Shape of the cursor for the first point to pick 2 - The cursor shape of the second point to
pick
3 - The Zone of Interest size

A 2D Grid appears upon the locked scene. You can hide it or change its size. The mouse cursor shape changes.
The arrow becomes a pointer with a number beside; this guides you in selecting points. This number starts from
One (first corner of a rectangular frame) and ends by Two (opposite corner). You can cancel the rectangular frame
whenever you want and start a new one.

Notes:
n Select Cancel Rectangle (Esc) from the pop-up menu to undo the selection of points in progress (once the first has

been picked).
n Movements are constrained to the Projection Plane's plane and are restricted to Pan and Zoom. Rotate is not

allowed.

14.4.2.5.2 Resize a Zone of Interest

To resize a zone of interest:
1. Pick in the previous rectangular frame.
2. Move the cursor over a handle in green.
3. Drag-and-drop the handle to resize the rectangular frame.

Note: The Area values are updated to match the resized frame's dimensions.

14.4.2.5.3 Rotate Counterclockwise 90°

Trimble RealWorks User Guide | 583



PRODUCTION TOOLS

The Rotate Counterclockwise 90° feature rotates left both the displayed scene and the Projection Plane.

To rotate counterclockwise 90°:
1. Set the Projection Plane to see its front view (by choosing Front View).
2. Click the Rotate Counterclockwise 90° icon. The displayed scene and the Projection Plane are rotated left.
3. Click again the Rotate Counterclockwise 90° icon. The displayed scene and the Projection Plane are rotated left

again, and so on.

Both the Projection Plane and the 3D scene are rotated left

14.4.2.6 Set a Resolution

You can define an ortho-image’s resolution by giving the PPI (Pixels Per Inch), specifying the number of pixels in the X* and
Y* directions or giving the pixel size. The pixel size is equal to 1 (if the unit of measurements is Inch) or to 25.4 (if the unit of
measurement is millimeters) divided by the image resolution (in PPI). The image size (in pixels) is obtained by dividing the
interest zone size by the pixel size.

To set a resolution:
1. Click Resolution. The Set Image Resolution of Ortho-Image dialog opens.
2. Do one of the following:

n Enter a value (in PPI) in the Image Resolution (PPI) field.
n Enter two values (in pixels) in the Image Size (WxH) field.
n Enter a value (in the current unit of measurement) in the Pixel Size field.

3. Click OK.

Tip: You can use the short-cut key R or select Set Image Resolution (R) from the pop-up menu to open the Set Image Res-
olution of Ortho-Image dialog.

Note: (*) In the X, Y, Z Coordinate Frame.

14.4.2.7 Choose a Rendering Option

You can choose an option to render the computed ortho-image(s). The Colorize by Depth (Cloud Only) rendering option
has to be used if only point clouds are displayed in the current view. It enables you to create an ortho-projection image
using a color scale based on the distance of each of the point clouds to the defined area. Use the Current 3D View Settings
rendering option for other cases (point clouds to display with geometries, limit box, station markers, station labels or annota-
tions). You can use all rendering option combinations (except Adaptive Point Size and Perspective projection mode), like
doing a snapshot of the current view.

To choose a rendering option:
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1. Click on the pull down arrow below the Resolution button.
2. Select a rendering option from the drop down list.

14.4.2.8 Preview an Ortho-Image

You can now use the Preview button to calculate the ortho-image. When completed, the calculated image will be shown in
the 2D Image viewer. You can change the current parameters and perform a new preview. You can do this as many times
as required until you have the right result.

To preview an Ortho-Image:
n Click the Preview button. The computed image is shown in a 2D Image viewer.

1 - Zoom In
2 - Zoom Out

3 - Zoom factor
4 - Measure tool

Before previewing the ortho-image, clicking Close leaves the Ortho-Projection tool and the position of the ortho-
image is lost. After previewing the ortho-image, clicking Close opens a dialog which prompts you to abort or con-
tinue the operation. In this 2D Image viewer, you can zoom-in (or zoom-out). You can zoom in three ways. The first
one is to magnify (or reduce) an area of the ortho-image using Zoom In and Zoom Out. The second way is to mag-
nify (or reduce) the ortho-image using the mouse wheel (if it exists). The third is to select a zoom factor from the
drop-down list.
If the ortho-image is bigger than the 2D Image viewer can show, you can pan it on left-click in any direction. You can
also make a 2D-distance measurement. Because the metric information is stored in the calculated ortho-image, the
measurement is accurate. You can create the measurement in the database by using the corresponding command
in the pop-up menu. Note that once it is created, the measurement will be shown in the 3D View.

Tip:
n You can select Preview Ortho-Image from the pop-up menu.
n The color of the background on an Ortho-Image is the same as the one in the 3D View. You can change it in Prefer-

ences\Viewer. This change will be then applied whatever the Rendering option you choose.

Note: The preview image is computed based on points loaded in the RAM, i.e. 10 millions. The disk capability is not used at
all. Thus, point density may change greatly compared to the final result.

Note: The Preview button is now a real preview. It quickly computes a low resolution image letting you check the result
before creating it in the database.

14.4.2.9 Print an Ortho-Image

To print an Ortho-Image:
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1. Right-click in the 2D Image view.
2. Select Print from the pop-up menu. The Print Setup dialog opens.
3. Define a Printer.
4. Choose a Paper' Size and Source.
5. Choose an Orientation between Portrait and Landscape.
6. Add some comments in the Legend panel.
7. Set an Appearance between As Is and Reverse Colors.
8. Click OK.

Tip: You can also select Print from the menu bar or click its icon in the Main toolbar.

14.4.2.10 Split an Ortho-Image

When an ortho-image is too wide (or long), you can split it into a set of ortho-images of smaller size. You can split an ortho-
image along a direction (Width (or Height)) or along two directions (Width + Height).

To split an Ortho-Image:
1. Enter a number in the W (or H) field.
2. Or use the Up (or Down ) button to select a number in the W (or H) field.

Note: Each split ortho-image is named as follows: ImageX_Line Index_Colum Index. The maximum size of a picture
depends on your graphic card capabilities.

14.4.2.11 Create an Ortho-Image

You can save the result in the database. An ortho-image whose name is "Image" is created and put under the current active
group of the Images Tree. You can create several ortho-images without leaving the tool.

To create an Ortho-Image:
1. Click Create.
2. Click Close.

Tip: You can also select Create Ortho-Image (or Close) from the pop-up menu. You should first hide the 2D Image viewer.

Note: You do not need to first preview an ortho-image to create it in the database.

Note:Within the Ortho-Projection tool, you don't have to change the loading state in order to load more or less points in
RAM. Now the computation of ortho-images is done with all points available on the disk. As a result, the time to compute
may be a bit longer but the resolution is much higher.

14.4.3 Multi Ortho-Projection

The Multi-Ortho-Projection tool allows you to create multi-ortho-projection images from a point cloud or a mesh. You can
either export the ortho-projection images to CAD software, such as AutoCAD® or MicroStation® for further processing or
drafting operations, or you can perform 2Dmeasurements directly within RealWorks. The basic principle behind this tool is
to use a polyline to create multi-projection planes on which the ortho-projection images will be created, and choose the right
information that you want to use in the ortho-projection, and then create the images either one-by-one or all at once. All the
metric information will be stored in this image, i.e. measurements made on this photo will be accurate.

14.4.3.1 Open the Tool

To open the tool:
1. Display a point cloud (or mesh) in the 3D View.

2. Select Multi-Ortho-Projection in Imaging > Ortho-Image. The Multi-Ortho-Projection dialog opens.
If you work with a point cloud, you can work on it to delimit an area for the multi-ortho-projection computation, to
render it cleaner without parasite points or to simplify it. You have to do these operations before entering the Multi-
Ortho-Projection tool (see the Sampling and Segmentation tools).
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Note:Within the Multi-Ortho-Projection tool, you don't have to change the loading state in order to load more or less points
in RAM. Now the computation of connected-ortho-images is done with all points available on the disk. As a result, the time
to compute may be a bitter longer but the resolution is much more higher

Note: The Head Always Up option is kept after opening the tool, i.e., if the option has been enabled, it will remain enabled.

14.4.3.2 Define a Polyline

A polyline can be either a line of continuous segments which can be closed (or not). It can also be composed of one or sev-
eral non-continuous segments but it cannot be formed by arcs.

14.4.3.2.1 Select a Polyline

If there is a polyline within the project, it is displayed in the Define Polyline field. The "Number of Segments" is not then
equal to zero. The selected point cloud (or mesh) and the Projection Planes obtained by extruding each segment of this
selected polyline along the Z* direction are displayed in the 3D View.

1 - Field for selecting an existing
Polyline

2 - Number of segments in the selected (or drawn)
Polyline

To select a polyline:
1. Click on the Define Polyline pull down arrow.
2. Select a polyline from the drop down list.

Notes:
n A polyline which is composed of arcs will not appear in the selection list.
n (*) In the X, Y, Z Coordinate System.

14.4.3.2.2 Draw a Polyline

If no polyline is available. The Define Polyline combo box is grayed out and the "Number of Segments" is equal to zero. You
have to create at least one in the database. The selected point cloud (or mesh) is shown with a 2D Grid in superimpose (if
not hidden previously) in the 3D View. The scene is constrained in the XY* plane of the active coordinate frame, brought to
the Top view and movements while picking points are restricted to Rotate (around the Z* axis), Zoom (along the Z* axis),
and Pan (in the XY* plane).

Create New 2D Polyline

To draw a polyline:

1. Click the Create New 2D Polyline icon. The Drawing and Picking Parameters (in 2D constraint mode) toolbars
appear in the 3D View. The mouse cursor shape changes to a pencil.

2. Draw a polyline by picking several points.
3. Click End Line. The last picked point ends the line.
4. Click Create. The drawn Polyline appears in the Define Polyline field and its "Number of Segments" is updated.
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Tip: You can select each of the Drawing features from the pop-up menu.

Notes:
n (*) In the X, Y, Z Coordinate System.
n In the Drawing toolbar, the Change Mode to Arc, Draw Circle by Defining the Center and Radius and Draw Circle by

Defining the Diameter icons are enabled and let the user draw such a polyline but any will be taken into account.

14.4.3.3 Define a Zone of Interest

After defining a polyline, a series of Projection Planes runs along that polyline. For a given Projection Plane, its width cor-
responds to the length of a segment and its height to the height of the bounding box that highlights the input (point cloud or
mesh) along the Z axis of the active coordinate frame.

1 - A Polyline
2 - The active Projection Plane (in red)

3 - The height of the active Projection Plane
4 - The width of the active Projection Plane

You can modify all the Projection Plane heights at once by changing the Maximum Altitude (or Minimum Altitude) value or
each Projection Plane height individually. The Maximum (or Minimum) Altitude default value will be the Maximum (or Min-
imum) Altitude value of the active Projection Plane. The maximal value must be higher than the minimal value.

1 - Top Align all Planes
2 - Bottom Align all Planes

3 - Start Editing Table 4 - Inverse Normal of All Planes

To Define a Zone of Interest:
1. Top align all Projection Planes.
2. Or bottom align all Projection Planes.
3. Or Edit all Projection Planes.
4. Or invert the Normal of all Projection Planes.

Notes:
n Instead of clicking a button in the Multi-Ortho-Projection dialog, you can also select its equivalent from the pop-up

menu.
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n You undo the change you have done and redo it again by selecting Undo and Redo.
n You can also select a Projection Plane in the 3D View by picking it. Enlarge (or reduce) the selected Projection

Plane's height by dragging and dropping the two horizontal edges.

14.4.3.3.1 Top Align all Planes

To top align all planes:
1. Click the Top Align all Planes icon. The Maximum Altitude dialog opens.
2. Enter a new value in the Maximum Altitude field.
3. Or use the Up and Down buttons* to select a value.
4. Click OK. All Projection Planes are aligned to the top.

Note: (*) The value will be incremented (or decremented) by 5 millimeters. If the unit of measurement in use is too
big, the user won't see the increment (or decrement).

14.4.3.3.2 Bottom Align all Planes

To bottom align all planes:
1. Click the Bottom Align all Planes icon. The Minimum Altitude dialog opens.
2. Enter a new value in the Minimum Altitude field.
3. Or use the Up and Down buttons* to select a value.
4. Click OK. All Projection Planes are aligned to the bottom.

Note: The value will be incremented (or decremented) by 5 millimeters. If the unit of measurement in use is too big,
the user won't see the increment (or decrement).

14.4.3.3.3 Edit Planes

To edit planes:
1. Click the Start Editing Table icon. The Multi-Ortho-Image Area Parameters dialog opens.

n Each area in the Area column corresponds to a unique Projection Plane.
n The length of an area in the Length column is the gap between its Minimum Altitude and its Maximum Altitude

along the Z direction.
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2. Select an area* from the dialog by picking a line.
3. Click on a value in either the Minimal Altitude or Maximum Altitude. The value becomes editable.
4. Enter a new value and press Enter. The Projection Plane which corresponds to the selected area has its Minimal

Altitude (or Maximum Altitude) changed as well as its height.
5. Click on the Close button at the top right corner of the dialog box.

1 - The Auto-hide button
2 - The Close button

3 - Only the Maximum Altitude of the selected Pro-
jection Plane is modified

The Auto Hide feature allows displaying more information using less screen space by hiding (or showing) the Multi-
Ortho-Image Area Parameters dialog. When you press the Auto Hide button, the Multi-Ortho-Image Area Para-
meters dialog will hide away. Move the mouse pointer over the Multi-Ortho-Image Area Parameters title bar, it will
slide out and will become visible. If you want the Multi-Ortho-Image Area Parameters dialog to stay visible after it
has been slid out, just press the Auto Hide button.

Tip: (*) You may see the Projection Plane corresponding to the selected area appeared in Step 4 - Preview Single Image
as well as its Size, Minimum Altitude and Maximum Value.

14.4.3.3.4 Hide/Display the Input

You can also display/hide the input: point cloud or mesh.

To hide/display the Input:
1. Un-check to hide the input from the 3D View.
2. And check to display it again.

14.4.3.4 Define the Image Parameters

You should define the parameters used for generating the ortho-images.

To define the image parameters:
1. Define a Resolution.
2. Choose a Density to apply.
3. Define the Depth parameter.

14.4.3.4.1 Set a Resolution

The user should define a Resolution to apply to the active Projection Plane. A Resolution is by default square.

To set a resolution:
1. Enter a value in the Resolution field.
2. Use the and Down to select a value.

Trimble RealWorks User Guide | 590



PRODUCTION TOOLS

14.4.3.4.2 Set a Density

The Density expressed in terms of PPI (Pixels Per Inch) is automatically computed according to the current value of the
Resolution.

14.4.3.4.3 Choose a Rendering Option

You can choose an option to render the computed ortho-image(s). The Colorize by Depth (Cloud Only) rendering option
has to be used if only point clouds are displayed in the current view. It enables you to create an ortho-projection image
using a color scale based on the distance of each of the point clouds to the defined area. Use the Current 3D View Settings
rendering option for other cases (point clouds to display with geometries, limit box, station markers, station labels or annota-
tions). You can use all rendering option combinations (except Adaptive Point Size and Perspective projection mode), like
doing a snapshot of the current view.

To choose a rendering option:
1. Click on the pull down arrow below the Resolution button.
2. Select a rendering option from the drop down list.

14.4.3.4.4 Define the Depth Parameter

You also should select the Define Depth option in order to define the distance forwards and backwards all rectangular
areas. Front value is the distance from all rectangular areas, in the normal direction (or in the opposite direction for Back).
Values can be zero but not negative.

To define the depth parameter:
1. Check the Define Depth option. The Front and Back fields become editable.

1 - Distance Front and Back all Projection Planes 2 - Reload Front Depth
3 - Reload Back Depth

2. Enter a value in the Front field. The Reload Front Depth icon becomes enabled.
3. Enter a value in the Back field. The Reload Back Depth icon becomes enabled.
4. If required, load the initial value by pressing Reload Front Depth.
5. If required, load the initial value by pressing Reload Back Depth.

Note: You can use a limit box to delimit a region of interest.

14.4.3.5 Preview a Single Ortho-Image

To preview a single ortho-image:
1. Select a Projection Plane.
2. Click Preview. The computed ortho-image is shown in a 2D Image view and the Preview button becomes inactive.
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1 - Image Zoom In
2 - Image ZoomOut
3 - Measurement tool

4 - An ortho-image computed from the active Projection Plane
5 - The Active Projection Plane

In this view, you can zoom or make a 2D distance measurement. You have three ways to zoom. The first way is to
magnify (or reduce) an area of the ortho-projection image using Zoom In and Zoom Out. The second way is to mag-
nify (or reduce) the whole ortho-projection image using the mouse's wheel. The last way is to select a rate from the
drop-down list.

3. Select another Projection Plane (if required).
4. Click again Preview.

Note: You cannot go down under 10% when zooming out.

Tip: The color of the background on an Ortho-Image is the same as the one in the 3D View. You can change it in Prefer-
ences\Viewer. This change will be then applied whatever the Rendering option you choose.

Note: The Preview button is now a real preview. It quickly computes a low resolution image letting you check the result
before creating it in the database. Thus, point density may change greatly compared to the final result.

14.4.3.5.1 Select a Projection Plane

An active Projection Plane is the one which appears in the Preview Single Image field and is shown in red in the 3D View.
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1 - Display First Ortho-image
2 - Display Previous Ortho-image
3 - Field for entering a Projection Plane order

4 - Display Next Ortho-image
5 - Display Last Ortho-image

To select a projection plane:
n Click Display Previous (or Next) Ortho-image to set the previous (or next) Projection Plane as active.
n Click Display First (or Last) Ortho-image to set the first (or last) Projection Plane as active.
n Key in a Projection Plane's order in the Preview Single Image field to select it. Do not need to validate by pressing

the Enter key.

Tips:
n Use the Home (or End) button of your keyboard instead of Display First (or Last) Ortho-image.
n Use the Up (or Down) arrow of the keyboard instead of Display Previous (or Next) Ortho-image.

Notes:
n The active (current) Projection Plane's parameters like its Size, Maximum Altitude and Minimum Altitude are dis-

played in Step 4 of the Multi-Ortho-Projection dialog.
n The Display Previous Ortho-image, Display Next Ortho-image, Display First Ortho-image and Display Last Ortho-

image buttons are dimmed if there is only one segment in the defined polyline.

14.4.3.5.2 View from a Projection Plane' Side

The user can view the displayed scene from each of the active Projection Plane' sides.

To view from a projection plane' side:
1. Select a Projection Plane.
2. Click on the canonical view pull down arrow.
3. Choose among Front View, Back View, Left View, Right View, Top View and Bottom View.

14.4.3.5.3 Print an Ortho-Image

You can print the preview of an ortho-image.

To print an ortho-image:
1. Right-click in the 2D Image view.
2. Select Print from the pop-up menu. The Print Setup dialog opens.
3. Define a Printer.
4. Choose a Paper' Size and Source.
5. Choose an Orientation between Portrait and Landscape.
6. Add some comments in the Legend panel.
7. Set an Appearance between As Is and Reverse Colors.
8. Click OK.

Tip: You can also select Print from the menu bar or click its icon in the Main toolbar.

14.4.3.6 Create Ortho-Images
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You can create an ortho-image at a time or all at once in the database. Each ortho-image is named as follows: Cross-
Object-Polyline's name-Segment's order. You can export each of them as a TIFF format file or via the DXF format to
AutoCAD®. Note that you can create several series of ortho-images without quitting the tool.

14.4.3.6.1 Create a Single Ortho-Image

A single ortho-image is created and put under the current active group of the Images Tree.

To create a single ortho-image:
1. First preview a single ortho-image.
2. Click Create.
3. Click Close.

14.4.3.6.2 Create all Ortho-Images

A set of ortho-images is created and put in a folder under the current active group of the Images Tree. This folder is named
as follows: Multi-Ortho-Polyline's name

To create all ortho-images:
1. Click Create All.
2. Click Close.

14.4.4 Create Rectified Images

This tool allows the creation of images rectified from perspective distortion by projecting station images onto a given 3D
plane.

14.4.4.1 Open the Tool

To open the tool:
n Select Image Rectification in Imaging > Ortho-Image. The Image Rectification dialog opens.

This dialog opens as the third tab of the WorkSpace window. The navigation mode swaps automatically to the Sta-
tion-Based mode.

Note: No selection is required for using the Image Rectification tool.

14.4.4.2 Choose a Station

You need to select a station with at least an image inside.

To choose a station:
1. Click on the pull-down arrow.

2. Choose a station with images from the drop-down list.
3. Or use the Go to First Station, Go to Previous Station, Go to Next Station or Go to Last Station) in the 3D View.
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4. Or click inside the station number's field and select a station from the drop-down list.

Note: In case no selection has been performed before entering the tool, the entire project will be taken into account. The
first station of the project is by default chosen.

14.4.4.3 Filter the Images

To filter the images:

1. Click the Filter Images by Camera Type button.
If the current project has no images; the Select Image Type dialog is empty and looks as illustrated below:

If the current project has some images which come from an instrument other than the Trimble SX10, the Select
Image Type dialog appears as illustrated below:

If the current project has some images which come from the Trimble S1X0 instrument, the Select Image Type dia-
log appears as illustrated below:

2. Select a type by checking the corresponding check box. The number of images of the chosen type is displayed. The
selected images are displayed in overlap in the background, only if the Display Images option has been chosen. 

Note:Only one type of images can be selected at once.
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14.4.4.4 Define a Projection Plane

There are two methods for defining a projection plane, by picking points or by using the parameters of an already created
rectified-image.

14.4.4.4.1 Define a Plane in the Station-Based Mode

There are several methods available in the Station-Based mode for defining a 3D plane.

You can swap from the Station-Based mode to the Examiner (or Walkthrough) mode and vice versa; Switching to the Exam-
iner mode is typically useful for checking a plane that has been defined in the Station-Based mode.

To define a plane in the Station-Based mode:
n Use one of the following methods:

n Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction) and One 3D Points,
n Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction) and One 3D Point,
n Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope Directions) and One 3D Points.

Note: You can define a projection plane even if the selected station does not contain any image.

14.4.4.4.1.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction) and One 3D
Points

To define a vertical plane by picking two screen points (Horizontal Direction) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

A]

B]

3. Pick another point anywhere in the 3D View (on the displayed point cloud or not). The cursor becomes as shown in
[C] and the Picking Parameters toolbar appears in 3D constraint mode.
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4. Pick the last point anywhere in the 3D View (only on the displayed point cloud). A vertical plane appears with the
third picked point as center.
C]

[D]

Tip: can be selected from the pop-up menu.

14.4.4.4.1.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction) and One 3D
Point

To define a horizontal plane by picking two screen points and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]
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3. Pick another point on the screen. These two points will define the orientation of the first axis of the horizontal plane's
frame. The cursor becomes as shown in [C] and the Picking Parameters toolbar appears in 3D constraint mode.

4. Pick the last point in 3D (on a cloud point, a measured point or a geometry). This point defines the height of the ver-
tical plane. A horizontal plane appears with the third picked point as center.
[C]

[D]

Tip: can be selected from the pop-up menu.

14.4.4.4.1.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope Directions)
and One 3D Points

This feature enables you to define a plane with any orientation.

To define a plane by picking three screen points (Horizontal and Steepest Slope Directions) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]
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[B]

3. Pick another point on the screen so that the two points represent a horizontal segment in the 3D space. These two
points define the orientation of a horizontal segment drawn on the final plane. The cursor becomes as shown in [C].

4. Pick another on the screen so that the previous point and this new one represent the steepest slope direction of the
final plane. The cursor becomes as shown in [D] and the Picking Parameters toolbar appears in 3D constraint
mode.
[C]

[D]
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5. Pick the last point in the 3D View (only on the displayed point cloud). The three first picked points - which are not col-
linear (not lying on the same line) - draw a 3D plane; the fourth picked point is its center.

Tip: can be selected from the pop-up menu.

14.4.4.4.2 Define a 3D plane in the Examiner WalkThrough

In the Examiner (or Walkthrough) mode, only two are available.

You can swap from the Station-Based mode to the Examiner (or Walkthrough) mode and vice versa; Switching to the Exam-
iner mode is typically useful for checking a plane that has been defined in the Station-Based mode.

To pick three 3D points:

1. Click the Define Plane by Picking Three 3D Points icon. The Picking Parameters toolbar appears in 3D con-
straint mode.

2. Pick three points (free or constrained) in the 3D View.

To pick two 3D Points:

1. Click the Define Vertical Plane by Picking Two 3D Points icon. The Picking Parameters toolbar appears in 3D
constraint mode.

2. Pick two points (free or constrained) in the 3D View.

14.4.4.4.3 Load Existing Rectified Image Parameters

If there are some rectified images in your project, the From button in Step 2 is active. You can select a rectified image and
use its parameters for computing a new one.

To load existing rectified image parameters:
1. Click on the From button. The Copy From Existing Rectified Image dialog opens. All rectified images inside the pro-

ject are listed.

2. Select a rectified image from the ProjectTree. The OK button becomes active.
3. Click OK. The Copy From Existing Rectified Image dialog closes.

The rectified image parameters appear in the Step 3 and Step 4 of the Image Rectification dialog. Its projection
plane is shown in the 3D View window.
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14.4.4.4.4 Modify a Projection Plane's Size

You can resize the previous projection plane. The resized projection plane keeps the same parameters as before except
the dimensions. You can do this by dragging & dropping a corner in the 3D View window.

To modify a projection plane's size:
1. Place the mouse cursor upon any handle of a projection plane. A green square appears.
2. If a corner handle is selected, drag it to increase (or reduce) the projection plane size. During this operation, the

green square becomes yellow.

1 - Handle before the drag & drop operation 2 - Handle during the drag & drop operation

3. If a middle handle is selected, drag it to increase (or reduce) the projection plane width (or length). During this oper-
ation, the green square becomes yellow.
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1 - Handle before the drag & drop operation 2 - Handle during the drag & drop operation

14.4.4.4.5 Modify the Position of the Projection Plane

To modify the position of the projection plane:

1. Click the Define Plane Position by Picking One 3D Point icon. The Picking Parameters toolbar appears in 3D con-
straint mode.

2. Pick a point (free or constrained) on the displayed point cloud in the 3D View.

14.4.4.5 Define a Zone of Interest

The objective of this step is to define a region (called Zone of Interest) on the previous projection plane onto which the sta-
tion images will be projected. For this, you have to draw a rectangular frame. In the drawing mode, the 3D scene is locked.
Before drawing a zone of interest, the entire projection plane is set as a zone of interest and its size is shown in text in Step
3 of the Image Rectification dialog.

Notes:
n The size of the zone of interest is in the current unit of measurement (the one set in Preferences).
n If no projection plane has been defined in Step 1, the grayed-out Area Undefined message appears in the dialog

and the Draw button remains dimmed.

14.4.4.5.1 Draw a Zone of Interest

To draw a zone of interest:
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1. Click Draw. The cursor will take the shapes as shown below and the projection plane is hidden.
2. Draw a rectangular frame by picking two points.

1 - Cursor shape of the first
point to be picked

2 - Cursor shape of the second
point to be picked

3 - Size of the interest zone

The mouse cursor shape changes. The arrow becomes a pointer to indicate that you are in the picking mode. A
number beside this pointer guides you step-by-step in the point's selection. It starts from One that corresponds to
the first point of the X* direction and ends by Two. Once the two points are reached, the interest zone is generated.
You can cancel it whenever you want and start a new one.

Notes:
n Pressing Esc cancels the selection of points in progress and leaves the drawing mode.
n (*) In the X, Y, Z Coordinate System.

14.4.4.5.2 Modify a Zone of Interest

To modify a zone of Interest:
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1. Move the cursor over a handle in green.

2. Drag-and-drop the handle to resize the rectangular frame.

14.4.4.6 Set an Image Resolution

You can define the rectified image's resolution by giving the PPI (Pixels Per Inch), specifying the number of pixels in the X
and Y directions or giving the pixel size. The pixel size is equal to 1 (if the unit of measurements is Inch) or to 25.4 (if the unit
of measurement is millimeters) divided by the image resolution (in PPI). The image size (in pixels) is obtained by dividing
the interest zone size by the pixel size.

To set an image resolution:
1. Enter a value in the Pixel Size field. The image size (WxH) is updated according to the new value.
2. Or click Advanced. The Set Image Resolution dialog opens.
3. Do one of the following:

n Enter a value (in PPI) in the Image Resolution (PPI) field.
n Enter two values (in pixels) in the Image Size (WxH) field.
n Enter a value (in the current unit of measurement) in the Pixel Size field.

4. Click OK. The Set Image Resolution dialog closes.

Tip: You can use the combination of keys Shift + R (or select Set Image Resolution from the pop-up menu) to open the Set
Image Resolution dialog.

14.4.4.7 Preview a Rectified Image
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You need to have at least one image inside the selected station to be able to preview the rectified image. Otherwise, the
Preview button remains dimmed even if a projection plane and a zone of interest have been defined.

To preview a rectified Image:
n Click the Preview button. The computed image is shown in a 2D Image viewer called Image Preview of Image Rec-

tification Tool.

In this 2D Image viewer, you can zoom-in (or zoom-out) by doing one of the following:
n Magnify or reduce an area on the rectified image with the Image Zoom In and Image Zoom Out buttons,
n Use the mouse wheel,
n Choose a zoom factor from the drop-down list.

If the rectified image is larger than the 2D Image viewer can show, you can pan it on left-click in any direction.

Tip: You can select Preview Rectified Image from the pop-up menu.
Note: If you close the Image Rectification tool before previewing the result, the position of the rectified image will be lost. If
you close the tool after previewing the result, a dialog opens and prompts you to save the result or not.

14.4.4.7.1 Perform a 2D-Distance Measurement

You can perform a 2D-distance measurement on the rectified image. As the metric information is stored in the calculated
rectified-image, the measurement is accurate.

To perform a 2D-distance measurement:
1. Click Measurement.
2. Pick two points on the rectified image. The measurement distance is shown in text in the 2D Image viewer.
3. Select Create Measurement from the pop-up menu.
4. Select Close Tool from the pop-up menu.

Tip: You can also use the Esc key instead of selecting Close Tool from the pop-up menu.

Note: Pressing Esc without saving the measured distance will cancel that distance.

14.4.4.7.2 Print a Rectified Image

To print a rectified image:
1. Right-click on the rectified-image.
2. Select Print from the pop-up menu.

Tip: You can also select Print from the File menu (or click on the Print button in the Main toolbar).

14.4.4.8 Split a Rectified Image
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For rectified images of large size, you can split them into rectified images of small size. Splitting can be done along a rec-
tified image's width, along its height or in both directions.

To split a rectified image:
1. Enter a number in the W (or H) field.
2. Or use the Up (or Down ) button to select a number in the W (or H) field.

14.4.4.9 Create a Rectified Image

You can now create the rectified image in the database. It will be put under the current active group of the Images Tree. It
has the "Ortho-Image” as type. You can create several rectified images without quitting the tool.

To create a rectified image:
1. Click Create.
2. Click Close.

Tip: You can also right-click in the 3D View and select Create Rectified Image from the pop-up menu.

Note:Once the zone of interest has been defined (3D rectangle), defining a new plane will merely modify the position and
orientation of the zone of interest. In particular, the size of the rectangle is kept. This can prove useful when producing a
series of rectified images of a facade (to keep the height and vertical position of the rectangle).

Note: You do not need to first preview a rectified image to create it in the database.

14.4.5 Move Ortho-Image

The Move Ortho-Image feature contains a set of tools that enable to modify the position and orientation of an Ortho-Image.

To move an Ortho-Image:
1. Select an Ortho-Image from the Images Tree.
2. Display the selected Ortho-Image in the 3D View, by turning the bulb from to or by dragging and dropping it in

the 3D View.
3. Select Move Ortho-Image . The Move Ortho-Image toolbar opens.
4. Do one of the following:

n Move Perpendicular to the Ortho-Image,
n Move Perpendicular to the Ortho-Image by Picking a Height,
n Pan in the Plane of the Ortho-Image,
n Rotate in the Plane of the Ortho-Image,
n Move in the Ortho-Image Plane by Picking a Direction

5. Validate the transformation. The MoveOrtho-Image toolbar closes.

Tip: All the features can be accessed from the pop-up menu.

Note: You are not able to undo a transformation, once applied.

14.4.5.1 Move Perpendicular to the Ortho-Image

To move perpendicular to the Ortho-Image:

1. If required, bring the view to Front , and the projection mode to Parallel .
2. Click the Move Perpendicular to Ortho-Image icon. A manipulator perpendicular to the plane of the Ortho-Image

appears.
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3. Pick the manipulator and move the Ortho-Image along its direction.

Tip: If required, change the position of the manipulator by clicking .

14.4.5.2 Move Perpendicular to the Ortho-Image by Picking

To move perpendicular to the Ortho-Image by picking:

1. If required, bring the view to Front , and the projection mode to Parallel .
2. Click the Move Perpendicular to Ortho-Image by Picking icon. The cursor becomes as illustrated below.

3. Pick a position. The Ortho-Image moves along the direction of its normal, at the position set by the picked point.

14.4.5.3 Pan in the Plane of the Ortho-Image

To pan in the plane of the Ortho-Image:

1. If required, bring the view to Top .
2. Click on the Pan In Ortho-Image Plane icon. A manipulator appears over the Ortho-Image.
3. To pan the Ortho-Image in a direction, click on an Arrow Handle and move the Ortho-Image along the direction

given by the arrow.
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4. To pan the Ortho-Image in any direction, click on the Plane Handle and move the Ortho-Image in its plane.

Tip: If required, change the position of the manipulator by clicking .

14.4.5.4 Rotate in the Plane of the Ortho-Image

To rotate in the plane of the Ortho-Image:

1. If required, bring the view to Top .
2. Click on the Rotate In Ortho-Image Plane icon. A manipulator appears over the Ortho-Image.
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3. Drag the manipulator and rotate the Ortho-Image in its plane and around its normal, clockwise or counterclockwise.

Tip: If required, change the position of the manipulator by clicking .

14.4.5.5 Move in the Ortho-Image Plane by Picking

To move in the Ortho-Image plane by picking:

1. If required, bring the view to Top .
2. Click on the Move In Ortho-Image Plane by Picking icon.
3. Pick a point, on the displayed point cloud or the displayed Ortho-Image.

4. Pick another point, on the displayed point cloud or the displayed Ortho-Image.
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The Ortho-Image is moved in its plane along the direction defined by the two picked points.

14.4.6 Match with an Image

The Image Matching tool allows you to match an imported image to a displayed 3D scene, or in other words, to find the cam-
era position from which the image is shot. The basic principle behind this tool is to select at least four pairs of markers
(points or segments or a combination thereof); each of them should be selected on the same physical objects. For example,
you can select a point from the 3D scene, and another one in the 2D image, both correspond to the corner of a room. We
call these two points a pair of markers. Then RealWorks will use these selected markers to calculate a best registration (or
a best camera position) so that when you view from this camera position and along its axis, the image and the 3D scene will
be superposed. Once the image is matched to the 3D scene, you can use it to color the scanned points, to texture the
meshed model, or just to enhance understanding of the scene.

14.4.6.1 Open the Tool

To open the tool:
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1. Select a point cloud (or mesh) from the Models Tree.
2. Select an image (or more) from the Images Tree.

3. Select Image Matching in Imaging > Matched Image. The Image Matching dialog opens as well as the Picking
Parameters (in 3D constraint mode) toolbar.
This dialog opens as the third tab of the WorkSpace window is separated into four parts. The first part enables you
to select an image that will be used as reference for matching. The second part contains tools to select and edit
markers. The third part enables previewing the matching, viewing stored and matched images and matching under
constraint. The last part enables you to validate the matching and color points. The selected image is shown as a
thumbnail in the left top corner of the 3D View. If more than one image are selected, the first in the selection list is
the one that is shown in the 3D View.

14.4.6.2 Select an Image

You should select an image from the Select Image combo box for matching. Only unmatched and already matched images
are listed in that combo box.

To select an image:
1. Click on the Select Image pull-down arrow.
2. Select an image from the drop-down list.

1 - Field for selecting an image 2 - Hide/Show Image 3 - Maximize/Minimize Image

Tip: Inside the Image Matching tool, you can go back to the Models Tree tab to display or hide objects for marker selection
purposes.

14.4.6.2.1 Hide (or Show) a Thumbnail

To hide (or show) a thumbnail:

1. Click on the Hide/Show Image icon to hide the thumbnail.
2. And click again on the Hide/Show Image icon to display the thumbnail.

Tips:
n The Hide/Show Image icon can also be selected from the pop-up menu.
n You can also click anywhere in the 3D View and use the short-cut key V.

14.4.6.2.2 Maximize (or Minimize) a Thumbnail

To maximize (or minimize) a thumbnail:

1. Click on the Maximize/Minimize Image icon to make the thumbnail full.
2. And click again on the Maximize/Minimize Image icon to restore the thumbnail size.

Tips:
n The Maximize/Minimize Image icon can also be selected from the pop-up menu.
n You can also click anywhere in the 3D View and use the short-cut key M.

14.4.6.2.3 Extend (or Stretch) a Thumbnail

You can drag and drop a vertical (or horizontal) edge of the thumbnail image to extend it in width (or length).

14.4.6.2.4 Move a Thumbnail

Place your cursor over the symbol and drag and drop the thumbnail image to a location within the 3D View.
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14.4.6.3 Select Markers

For a given image, if a matching has been already performed, you can view the stored matching. If any matching has been
performed and when no information about the shooting position is available, you can start matching by selecting at least
four pairs of markers. Before selecting, each pair is set as "Undef" in the Pairs column of the marker list and "?" in the
Defined In column.

1 - Check box 2 - List of markers

To select markers:
1. Pick a pair of makers.
2. Or load a set of maker pairs.

Notes:
n Press the Esc button twice to close the Image Matching tool.
n In the marker list table, each selected marker pair will be shown. You can see in the second column whether the pair

is completely defined, or if it is just partially defined.

14.4.6.3.1 Pick Markers

You should pick at least four pairs of markers. Each pair may be either a 3D Point/2D Point pair or a 3D Line/2D Line pair.
The order of these pairs has no influence on the final calculation. So you can pick them whenever you find a corresponding
marker pair (no matter its type) in both 3D View and 2D View (for image). Movements are restricted in the 3D View to Pan,
Zoom and Rotate while picking markers.

1 - Add Point Marker 2 - Add Line Marker

To pick markers:
1. Pick a pair of points.
2. Or pick a pair of lines.
3. Or pick a combination of point pairs and line pairs.

Notes:
n Pressing Back (or once on Esc) while the picking is in progress cancels the selected markers.
n A pair of points is always put at the first position in the marker list when you select a combination of points and lines.

14.4.6.3.1.1 Pick a Pair of Points

To pick a pair of points:
1. Select an image that will be used as a reference image for matching.
2. Navigate in the 3D scene so that the displayed scene aligns approximately with the chosen image.
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3. Click the Add Point Marker icon. You are now in the picking mode.
4. Pick a point marker on the reference image.

n This point is shown by a red square with One as order.
n In the marker list, "Undef" becomes "Point#1" in the Pairs column and "?" swaps to "[2D]/ " in the Define In

column.
5. Pick a point marker on the 3D scene.

n This point is shown by a yellow P with One as order.
n In the marker list, "[2D]/ " in the Define In column becomes "[2D]/[3D]".
n A check mark beside this pair means that it is taken into account for the matching.

6. Repeat the steps from 4 to 5 for the three other pairs of point markers.

1 - 2D Point marker 2 - 3D Point marker

Notes:
n Point markers can be selected by pair (one from a view and one from the other view) as described above or con-

tinuously (four from a view and four the other view).
n When you select a pair from the list, its related point marker P on the object becomes green (the number label

remains in yellow) and the red square in the reference image becomes pink (the number remains unchanged).

14.4.6.3.1.2 Pick a Pair of Lines

To pick a pair of lines:
1. Select an image from the selection list that will be used as a reference image for matching.

2. Click on the Add Line Marker icon. You are now in the picking mode.
3. Pick in the 3D scene to set at least four line markers (if any point has been set).
4. Pick in the reference image to set at least four line markers (if any point has been set).
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1 - 2D Line marker 2 - 3D Line marker

The mouse cursor shape changes. The arrow becomes a pointer with two numbers beside it. The first number is a
line order and the second to the picked point order. A point once picked on the selected object is shown by a yellow
L with a number besides indicating a line marker order. Two points from the same rank once picked are linked by a
color segment which is named Line # X. X is the line marker rank. A point once picked on the reference image is
shown by a pink square marker with a number besides indicating a line marker order and a line is drawn through
this point to the current mouse cursor position. Two points from the same rank once picked are linked by a color seg-
ment which named Line # X. X is the matching line rank. When a pair of line markers from the same rank (one in the
reference image and one in the cloud) is defined, this pair is named Line # X and is put in a list. X is the pair rank. A
check mark besides a pair of line markers means that this pair is taken into account for matching. Un-select a check
mark if you don't want to take into account a pair. When you select a pair from the list, its related line markers are
lengthened.

14.4.6.3.2 Load Markers

You can import an image that has been already matched, load and use its parameters for matching new images. Usually,
such parameters are stored in a TXT (or ASCII) format file.

To load markers:
1. Right-click anywhere in the 3D View to display the pop-up menu.
2. Select Load Marker Pairs From File. The Open dialog box opens.
3. Select a file type (*.txt or *.asc) from the drop-down list in the File of Type field.
4. Navigate to the drive/folder where the file to load is in the Look In field.
5. Select the file. Its name appears in the File Name field.
6. Click Open.

Tip: You can also use the short-cut key L instead of selecting Load Marker Pairs From File from the pop-up menu.

14.4.6.4 Modify Markers

Once four pairs of markers (Points or Lines) are set, you can delete those that are not correctly set for matching, re-order a
part (or the whole) of them, modify their location in each view or reset them all. Four tools, available for editing the marker
features, are described hereafter.

Trimble RealWorks User Guide | 614



PRODUCTION TOOLS

1 - Move Marker
2 - Delete Marker

3 - Reset all Markers
4 - Re-order Markers

14.4.6.4.1 Move a Point (or Line)

To move a point (or line):

1. Click on the Move Markers icon. The cursor shape changes as shown in the illustration below.
2. Move the cursor over any marker in either the 2D image or the 3D View. The marker will be highlighted in pink in the

2D image and in green in the 3D View.
3. Drag and drop the marker to a new position. Its corresponding marker in the other view will not be moved too.

14.4.6.4.2 Delete a Point (or Line)

To delete a point (or line):

1. Click the Delete Makers icon. The cursor shape changes as shown in the illustration below.
2. Move the cursor over any marker either in the image or in the 3D scene. The marker will be highlighted.
3. Click on the marker to delete it. Its corresponding marker in the other view will be also deleted.
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When you place the mouse cursor upon a point (P), its color tilts from red to pink in the reference image and from
yellow to green in the point cloud (or mesh). This means that the point (P) is selected and can be deleted. Deleting a
point (P) will remove it from both the reference image and the point cloud (or mesh). A point (P) once deleted is
replaced by one which is just after it and the pairs list is automatically updated. Once all markers are deleted, you go
back automatically to the selection mode. When you delete a line (L), you delete by the same way the line (L) in the
other view.

Tip: You select a pair of markers from the marker list table and press the Del key to delete it.

14.4.6.4.3 Reset all Points (or Lines)

To reset all points (or lines):

1. Click the Reset All Markers icon. A question box opens.
2. Click Yes to delete the current set of point/line markers.
3. Click No to abort the operation.

Tip: The Reset All Markers icon can also be selected from the pop-up menu.

14.4.6.4.4 Reorder Points (or Lines)

To reorder points (or lines):

1. Click the Reorder Markers icon. The cursor shape changes as shown in the illustration below.
2. Move the cursor over any marker in either the
3. 2D Image or the 3D View.
4. Pick the marker. Its order* is reversed with that of the first marker. The order of its corresponding marker in the other

view does not change.
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Note: (*) Only if it is not the first in the selection order.

14.4.6.5 Save Markers

You can save the selected marker pairs into a text file and reload it later on to continue your image matching work.

To save markers:
1. Right-click anywhere in the 3D View to display the pop-up menu.
2. Select the Save Marker Pairs To File command. The Save As (or Open) dialog box opens.
3. Select a file type (*.txt or *.asc) from the drop-down list in the File of Type field.
4. Navigate to the drive/folder where you want the file to save in the Look In field.
5. Enter a file name in the File Name field. The selected extension will be added automatically.
6. Click Save.

Tip: You can also use the short-cut key S instead of selecting Save Marker Pairs To File from the pop-up menu.

14.4.6.6 Match an Image

With an unmatched image, once four pairs of markers have been selected, the Preview button becomes enabled. You can
proceed to a preview. With an already matched image, you can view the stored matching.

14.4.6.6.1 Preview

You can now preview the matching. The image will be projected into the 3D View. It is displayed in the background and blen-
ded with the 3D scene. You can use the slider to change the blending parameter in order to check the coincidence of the
image with the 3D data. The markers set on the displayed scene appear on the reference image, this enables the user to
visually compare them with those set on the reference image.

To preview:
1. In Step 3 of the Image Matching dialog, click Preview.
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2. If required, extend the thumbnail image and compare the markers.

Gap between markers set on the reference image and on the displayed scene

3. If required, click Hide. The image in the background will be removed from the 3D View.

Tips:
n Instead of using the slider, you can click anywhere in the 3D View and use the Up and Down keys of your keyboard.
n You can click anywhere in the 3D View and use the short-cut key A to set the blending parameter to 0 (slider in Low

position) or to 1 (slider in Top position).

Note: You can hide the image by right-clicking anywhere in the 3D View and selecting Projected Image.

14.4.6.6.2 Improve

Where necessary, you can improve the matching by adding more markers, deselecting some from the calculation (by using
the check box in the marker list), or modifying the position of certain markers, and then re-perform the preview.

14.4.6.6.3 Adjust

You can also manually adjust the 3D scene over the projected image by small movements. To do this, you can use either
the free or the constrained movements. Free movements consist of using basic navigation tools (Zoom, Pan and Rotate)
for moving the 3D scene while constrained movements require the use of constraint tools.

To adjust:
1. Constrain to a pair of markers.
2. Or constrain to two pairs of markers.

Note: Because you need to adjust the 3D scene to cover the projected image by small movements in all directions, the
Head Always Up option in Preferences if checked is then disabled.

14.4.6.6.3.1 Constrain to one Pair of Markers

You can select either a 3D Point/2D Point pair or a 3D Line/2D Line pair as constraint.

To constrain to one pair of makers:
1. Select a pair of markers from the marker list which you consider offer the best coincidence

2. The first Constrained to Marker Pair icon becomes active. Click on it.
3. Go to the 3D View, and move the scene. You can see that the movement is constrained in such a way that the selec-

ted marker pair will always be coincident.

Tip: To unset a pair of markers as constraint, click again on the Constrained to Marker Pair icon.

14.4.6.6.3.2 Constrain to Two Pairs of Markers

If the first constraint is a 3D Point/2D Point pair, you can add a new constraint which should be necessary a 3D Point/2D
Point pair. You may see in the third column (called Constraint) of the marker list table if a pair is selected as constraint (or
not). The first constrained pair is shown as follows . The second constrained pair is shown
as follows .

Trimble RealWorks User Guide | 618



PRODUCTION TOOLS

To constrain to two pairs of markers:

1. Select another pair of markers from the markers list. The second Constrained to Marker Pair icon becomes
enabled.

2. Click on the Constrained to Marker Pair icon.
3. Go to the 3D View, and move the scene. You can see that the movement is constrained in such a way that both the

selected pairs will always be coincident.

Tip: To unset a pair of markers as constraint, click again on the Constrained to Marker Pair icon.

14.4.6.6.4 Project

If the selected image is already matched, the Project button in Step 3 of the Image Matching dialog becomes enabled. Click-
ing on it allows you to view the matching.

14.4.6.7 Color Points

You can now use the Coloring button to color the displayed cloud(s) with the currently matched image. It is important to
note that this coloring operation has no Undo. After the coloring, the color attributes of the points can be changed again if
you use this function with another image.

Notes:
- Colorization may take a while for huge datasets.
- Uncolored points remain in white.

14.4.6.8 Apply the Matching

If you are satisfied with the matching result, you can use the Apply button to save it to the database. It is important to note
that this operation has no Undo. The selected image becomes matched.

14.4.7 Go to a Shooting Position

This feature allows you to align your viewing frustum from the shooting position of an image as registered to the 3D data. It
is not accessible if the selected image has no 3D data correspondence.

1. Select an image from the Images Tree.
2. Display (or open) the image if required.
3. Select Go to Shooting Position in Imaging > Matched Image.
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The first screen capture shows an image thumbnail
with a displayed cloud

The second image shows the view alignment after
the Go to Shooting Position command is executed

Tip: You can right-click on an image and select Go to Shooting Position from the drop-down menu.

Note: The Go to Shooting Position feature is only available in the Examiner (or Walkthrough) mode.

14.5 MODEL TOOLS

The Model tab provides a fast and intuitive 3D modeling capability. Tools in this tab are gathered in two groups: Creation
and Edit.

Tools are split into two categories: Main Tool and Sub-Tool. Main tools enable to model diverse shapes to represent the as-
built environment using simple CAD compliant geometrics. They can be selected in Model > Creation.

Tools to modify the objects created previously can be found in Model > Edit.

14.5.1 Cloud-Based Modeler

The Cloud-Based Modeler tool allows you to model geometries of the following shapes: Plane, Sphere, Cylinder, etc.
Modeling can only be cloud-based. In this case, a selection as input data (Project Cloud or pure point cloud) is required and
the modeling is done by fitting points.

14.5.1.1 Open the Tool

An object having the point cloud and geometry representations cannot be selected as an entry for the Cloud-Based
Modeler tool; you need to first delete the geometry representation from that object. The selection can be multiple.

To open the tool:
1. Select a point cloud* (or more*) from the Project Tree.
2. Select Cloud-Based Modeler in Model > Creation. The Cloud-Based Modeler dialog opens.
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n This dialog opens as the third tab of the WorkSpace window. The Segmentation tool is open default and its tool-
bar appears. The input point cloud is called Cloud Data. The information box at the top right corner of the 3D
View displays the RMS Deviate and Number of Points information (both are initially "Undefined") for the Cloud-
Based Modeler tool and the Number of Points information for the Segmentation tool. The RMS (Root Mean
Square) Deviate corresponds to the standard deviation between points used for fitting and the fitted geometry.

n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not
checked, all objects displayed in the 3D View are hidden except the one selected. All of the displayed objects
have their bulb icon turned to Off.

n If the option is checked, all objects displayed in the 3D View remain displayed. All displayed objects have their
bulb icon remained On, except the one selected.

Note: (*) If the selected point cloud is On before starting the tool, it automatically tilts to Off. We advise you to maintain it
Off.

Caution: (**) You can select several point clouds as input of the tool but one of them should not be the Project Cloud.

14.5.1.2 Select a New Cloud Data

The Set New Cloud Data is for swapping the default Cloud Data (not necessarily the one selected before starting the tool)
for another one. You cannot choose and set a subset of the default Cloud Data as the new Cloud Data; you need to choose
a different point cloud.

To select a new cloud data:
1. Select another point cloud from the Project Tree, and display it in the 3D View.

2. If required, hide the default Cloud Data by clicking the Hide Cloud icon.
3. Click the Set New Cloud Data icon. The cursor becomes as shown below and the information box related to the

Segmentation tool disappears from the 3D View.
4. Pick a point on the selected point cloud. It becomes the new Cloud Data. The Segmentation information box

appears again with the new cloud data number of points.
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1 - The initial Cloud Data
2 - The newly selected Point Cloud

3 - The cursor in the Set New Cloud Data
mode
4 - The new Cloud Data

Note: (*) The Hide Cloud icon becomes Display Cloud after clicking on it.

14.5.1.3 Define a Set of Points on the Cloud Data

Frequently, the Cloud Data contains many points; you need to decimate them before doing the fitting. You may also decide
to fit a geometry just on a part of it. To do these, you can use the Segmentation and the Sampling sub-tools.

After segmenting/sampling the Cloud Data, the Keep Only Displayed Cloud in Cloud Data and Delete Displayed Cloud from
Cloud Data icons (respectively for keeping/deleting points in/from the current Cloud Data (after decimation) and the Reload
Points icon become active.

To keep only the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Keep Only Displayed Cloud in Cloud Data icon. Points displayed in the 3D View inside are kept.

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are kept.
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Tip:Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

To delete the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Delete Displayed Cloud from Cloud Data icon. Points displayed in the 3D View are unkept (removed
from the Cloud Data).

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are unkept.

Tip: Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

14.5.1.4 Choose a Geometry Type

There are ten geometry types and one construction method (Extrusion). When the Cloud-Based Modeler dialog appears,
the type which comes first is the one you have selected during the previous use of that tool. To change the geometry type,
click an icon in the Cloud-Based Modeler dialog. Extrusion is a tool for creating a three-dimensional geometry of free shape
from 2D profiles.

1 - Plane
2 - Sphere
3 - Cylinder
4 - Regular Cone

5 - Box
6 - Rectangular Torus
7 - 3D Point

8 - Segment
9 - Circular Arc
10 - Circular Torus
q - Extrusion

Tip: You can also select a geometry type from the pop-up menu.

14.5.1.5 Use Constraints

This optional step is for applying constraints to objects under construction. Check the Use Constraint option to make this
step appear. Constraints can be assumed as limits imposed on objects and they vary according to the geometry type selec-
ted in Step 1. You cannot apply two constraints of the same type. The applied constraint you find in the constraint list - see
hereafter - is always the last applied one.

14.5.1.5.1 Plane

Three types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing a constraint. A constraint (once applied) is put in the constraint list and each is selected by default (box checked). You
can apply one constraint of the same type at once. You can mix a constraint type with another; but you have some restric-
tions in combining constraint types (see the table).
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If you mix incompatible constraints together; a warning message appears. For those you do not want anymore, you can
deselect them by unchecking their check box. To remove all created constraints, click on the Clear button. After applying
constraints, the constraint list looks as shown in the table.
[A]

1 - Make Parallel
2 - Make Perpendicular

3 - Pass Through Point
4 - Constraint list

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To use a constraint to calculate a plane:
1. Constrain a plane parallel/perpendicular to an entity.
2. Or constrain a plane passing through a point.
3. Un-checking a defined constraint in the constraint list will free the related constraint type for use.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.1.1 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.
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Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.1.2 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.1.3 Pass Through a Point

To pass through a point:

1. Click the Pass through Point icon. The 3D Point toolbar and its information box at the top right corner of the 3D
View.

2. Define and validate a 3D point.

14.5.1.5.2 Sphere

Three types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing constraints. A constraint (when applied) is put in the constraint list and each is selected by default (box checked). You
can apply one constraint of the same type at once. You can mix a constraint type with another; but you have some restric-
tions in combining constraint types (see the table).

If you mix incompatible constraints together; a warning message appears. For those you do not want anymore, you can
deselect them by unchecking their check box. To remove all created constraints, click on the Clear button. After applying
constraints, the constraint list looks as shown in [B].
[A]
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1 - Lock Radius
2 - Lock Center

3 - Lock Center on Line
4 - Constraint list

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To use a constraint to calculate a sphere:
1. Lock a sphere center.
2. Or lock a sphere radius.
3. Or lock a sphere center on a line.
4. Un-check a defined constraint in the constraint list to free it.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.2.1 Lock a Radius

To lock a radius:

1. Click the Lock Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

14.5.1.5.2.2 Lock a Center

To lock a center:

1. Click the Lock Center icon. The 3D Point toolbar opens as well as its information box.
2. Define and validate a 3D point.

14.5.1.5.2.3 Lock a Center on a Line

To lock a center on a line:
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1. Click on the Lock Center on Line icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

14.5.1.5.3 Cylinder

Six types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before applying
constraints. All constraints cannot be mixed together; refer to the table below to check how a constraint is compatible with
the others. If you mix incompatible constraints together; a warning message appears. After applying constraints, the con-
straint list looks as shown in [B].

[A]

1 - Make Parallel
2 - Make Perpendicular
3 - Pass Axis Through Point

4 - Make Secant to Cylinder
5 - Fit to Axis
6 - Lock Radius

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To apply constraints to a cylinder:
1. Make a cylinder parallel/perpendicular to an entity/plane/direction.
2. Or lock a cylinder radius.
3. Or pass a cylinder axis through a point.
4. Or fit a cylinder axis.
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5. Or constraint secant to a cylinder.
6. Un-check a defined constraint in the constraint list to free it.
7. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.3.1 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.3.2 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.3.3 Pass an Axis Through a Point

To pass an axis through a point:

1. Click the Pass Axis Through Point icon. The 3D Point toolbar opens with the Pick Point mode set by default.
2. Define and validate a 3D point.

14.5.1.5.3.4 Lock a Radius

To lock a radius:
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1. Click the Lock Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

14.5.1.5.3.5 Fix to an Axis

To fix to an axis:
1. Click on the Fix to Axis icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

14.5.1.5.3.6 Make Secant to a Cylinder

To make secant to a cylinder:

1. Click the Make Secant to Cylinder icon. The 3D Secant dialog as well as its information box appears.
2. Pick a cylinder.
3. If required, check Use Same Radius to set the same radius as the picked cylinder.
4. If required, check Use Given Angle and give a secant angle.
5. If required, click Perpendicular to have a 90° secant angle.
6. Click OK.

Entity used as constraint

Note that the Make Secant to Cylinder constraint type generates four sub-constraint types according to the option
(s) checked.
n If only Use Same Radius has been checked, you have the two following constraint types: Make Axis Secant to

Axis and Lock Radius.
n If only Use Given Angle has been checked and the given angle value is different to 90° and 270°, you have the

two following constraint types: Make Axis Secant to Axis and Lock Angle with Direction.
n If only Use Given Angle has been checked and the given angle value is equal to 90° and 270°, you have the two

following constraint types: Make Axis Secant to Axis and Make Perpendicular to Direction.
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n If only Use Given Angle has been checked and Perpendicular pressed-on, you have the two following constraint
types: Make Axis Secant to Axis and Make Perpendicular to Direction.

n If the two options have been checked with an angle other than 90° or 270°, you have the three following con-
straint types: Make Axis Secant to Axis, Lock Radius and Lock Angle with Direction.

n If the two options have been checked with an angle equal to 90° or 270°, you have the three following constraint
types: Make Axis Secant to Axis, Lock Radius and Make Perpendicular to Direction.

n If the two options are kept unchecked, you have the Make Axis Secant to Axis constraint type.

14.5.1.5.4 Regular Cone

Three types of constraint are available (see [A]). The constraint list with (two columns Type andWith) is empty before apply-
ing constraints. All constraints cannot be mixed together; refer to the table below to check how a constraint is compatible
with the others.

If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
[A]

1 - Make Parallel 2 - Make Perpendicular 3 - Fit to Axis

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To apply constraints to a regular cone:
1. Make a cone parallel/perpendicular to an entity/plane/direction.
2. Or fit a cone axis.
3. Un-check a defined constraint in the constraint list to free it.
4. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.
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14.5.1.5.4.1 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.4.2 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.4.3 Fix to an Axis

To fix to an axis:
1. Click on the Fix to Axis icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

14.5.1.5.5 Circular Torus

Five types of constraints are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing constraints. All constraints cannot be mixed together; refer to the table below to know how a constraint is compatible
with the other(s).
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If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
[A]

1 - Make Perpendicular to Dir-
ection
2 - Make Parallel to Plane
3 - Lock Center Line Radius

4 - Align to Join Two Existing Secant Cylinders of Same
Radius
5 - Lock Pipe Radius

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To apply constraints to a circular torus:
1. Make a circular torus parallel/perpendicular to an entity/plane/direction.
2. Or fit a circular torus axis.
3. Or lock a circular torus's center line radius.
4. Or lock a circular torus's pipe radius.
5. Align and join a circular torus to two secant cylinders of the same radius.
6. Un-check a defined constraint in the constraint list to free it.
7. Or click Clear to remove all constraints from the list.

Note: Press Esc to leave the picking mode.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.5.1 Make Perpendicular to a Direction

To make perpendicular to a direction:
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1. Click the Make Perpendicular to a Direction icon. The 3D Direction toolbar opens.
2. Define and validate a 3D direction.

14.5.1.5.5.2 Make Parallel to a Plane

To make parallel to a plane:

1. Click the Make Parallel to a Plane icon. The 3D Plane toolbar opens.
2. Define and validate a 3D plane.

14.5.1.5.5.3 Lock a Center Line Radius

To lock a center line radius:

1. Click the Lock Center Line Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

14.5.1.5.5.4 Lock a Pipe Radius

To lock a pipe radius:

1. Click the Lock Pipe Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

14.5.1.5.5.5 Align to Join to two Secant Cylinders of Same Radius

To align to join to two secant cylinders of same radius:
1. Click the Align to Join to Two Secant Cylinders of Same Radius icon.
2. Pick a cylinder.

3. Pick another cylinder.

n A warning appears if the two cylinders are not secant or do not have the same diameter. In that case, use the
Make Secant to a Cylinder constraint from the Geometry Modifier tool, and then repeat the steps 2 and 3.
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n A circular torus appears between the two cylinders.

n If required, use the Connect a Geometry Sequence constraint from the Intersect tool to connect the cylinders
and the torus together as illustrated below.

14.5.1.5.6 3D Point

Two types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing constraints. These two constraints cannot be mixed together; refer to the table below to check how a constraint is com-
patible with the others.

If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
[A]

1 - Lock on Plane 2 - Lock to Line or Axis

[B]
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1 - Constraint type 2 - Check box 3 - Entity used as constraint

To use a constraint to calculate a 3D point:
1. Lock a 3D point on a plane.
2. Or lock a 3D point on a line/axis.
3. Un-check a defined constraint in the constraint list to free it.
4. Or Click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.6.1 Lock on a Plane

To lock on a plane:

1. Click the Lock on Plane icon. The 3D Plane toolbar opens with the Pick Entity with Direction mode set by default.
2. Define and validate a 3D plane.

14.5.1.5.6.2 Lock to Line (or Axis)

To lock on a line (or axis):

1. Click the Lock to Line (or Axis) icon. The 3D Axis toolbar opens with the Pick Axis Entity mode set by default.
2. Define and validate a 3D direction.

14.5.1.5.7 Circular Arc

Three types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing constraints. Lock on Plane, Make Parallel to Plane and Make Perpendicular to Direction (already evoked) will be
detailed here. All constraints cannot be mixed together; refer to the table below to check how a constraint is compatible with
the others.

If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
[A]
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1 - Lock on Plane 2 - Make Parallel to Plane 3 - Make Perpendicular to Direction

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To apply constraints to a circular arc:
1. Lock a circular arc on a plane (see the 3D Plane tool).
2. Or make a circular arc parallel to a plane (see the 3D Plane tool).
3. Or make a circular arc perpendicular to a direction (see the 3D Direction tool).
4. Un-check a defined constraint in the constraint list to free it.
5. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.7.1 Lock on a Plane

To lock on a plane:

1. Click the Lock on Plane icon. The 3D Plane toolbar opens with the Pick Entity with Direction mode set by default.
2. Define and validate a 3D plane.

14.5.1.5.7.2 Make Parallel to a Plane

To make parallel to a plane:

1. Click the Make Parallel to a Plane icon. The 3D Plane toolbar opens.
2. Define and validate a 3D plane.

14.5.1.5.7.3 Make Perpendicular to a Direction

To make perpendicular to a direction:

1. Click the Make Perpendicular to a Direction icon. The 3D Direction toolbar opens.
2. Define and validate a 3D direction.

14.5.1.5.8 Segment
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Three types of constraint are available (see [A]). The constraint list (with two columns Type andWith) is empty before apply-
ing constraints. All constraints cannot be mixed together; refer to the table (click to see) to know how a constraint is com-
patible with the other.

If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
[A]

1 - Make Parallel 2 - Make Perpendicular 3 - Pass Axis Through Point

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To use a constraint to calculate a segment:
1. Make a segment parallel/perpendicular to an entity/plane/direction (see the 3D Picking tool/3D Plane tool/3D Dir-

ection tool).
2. Or pass a segment through a point (see the 3D Point tool).
3. Un-check a defined constraint in the constraint list to free it.
4. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use the Del to clear it.
n All constraints can be selected from the pop-up menu.

14.5.1.5.8.1 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.
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Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.8.2 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.1.5.8.3 Pass an Axis Through a Point

To pass an axis through a point:

1. Click the Pass Axis Through Point icon. The 3D Point toolbar opens with the Pick Point mode set by default.
2. Define and validate a 3D point.

14.5.1.5.9 Extrusion

This step is not in option as for the other geometry types. The Use Constraint option is checked by default and cannot be
unchecked. The Drawing and Picking Parameters (in 3D constraint mode) toolbars appear and the cursor is in the drawing
mode. Two types of constraints are available. The constraint list (with two columns Type andWith) is empty before applying
constraints.
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1 - Make Parallel to Direction
2 - Make Perpendicular to Plane

3 - Launch 2D Drawing Tool
4 - Constraint list

14.5.1.5.9.1 Define a Polyline

In the Drawing toolbar, not only the Change Mode icon is available but also the Draw Rectangle and Draw Circle icons. This
differs from the Drawing toolbar in the Polyline Drawing tool.

To define a polyline:
n If required, click the Start 2D Drawing Tool icon.

Notes:
n After defining a polyline, all drawing modes (Line, Arc, Rectangle and Circle) are dimmed in the Drawing toolbar.
n TheWalkthrough navigation mode is forbidden. If you are in the Walkthrough mode, the navigation mode will swap

of its own from that mode to Examiner after starting drawing.

To draw a polyline in a plane parallel to the screen view:
1. Choose a drawing mode among Line, Arc, Rectangle and Circle.
2. Draw a polyline. The scene is locked on a plane parallel to the screen view with a 2D grid superimposed (if not hid-

den previously) and the Picking Parameters toolbar appears in the 2D constraint mode.
3. Validate the polyline. The scene is free from the 2D lock.

The Lock 2D Curve and Make Parallel to Direction constraints appear in the constraint list. The primitive to extrude
will have an axis direction perpendicular to the screen view.

1 - Constraint type 2 - Check box

To draw a polyline in a user-defined plane:

1. Click the Start 3D Plane Tool icon. The 3D Plane toolbar appears.
2. Define and validate a 3D plane*. The scene is locked on the defined 3D plane with a 2D grid superimposed (if not

hidden previously) and the Picking Parameters toolbar appears in the 2D constraint mode.
3. Choose a drawing mode among Line, Arc, Rectangle and Circle.
4. Draw and validate a polyline. The scene is free from the 2D lock.

By default, the defined polyline is a 2D polyline in the defined 3D plane which is brought parallel to the screen view.
The Lock 2D Curve and Make Parallel to Direction constraints appear in the constraint list. The primitive to extrude
will have an axis direction perpendicular to the screen view.
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1 - Constraint type 2 - Check box

Notes:
n (*) Please, refer to the 3D Plane tool on how to define a 3D plane.
n The Find Best Extrusion View is only present when using the 3D Plane tool in the Cloud-Based Modeler tool. It

enables you to find the best cutting direction.

If there is a polyline within the project (or after drawing and creating one), you can set it as selected. Only a 2D polyline and
3D coplanar polyline (all nodes are in the same plane) can be selected.

To select a polyline:

1. Click the Select Polyline icon. The cursor becomes as
2. Pick a polyline. A polyline (in green) appears over the picked polyline. The scene is locked on the polyline's plane

with a 2D grid superimposed (if not hidden previously) and the Picking Parameters toolbar appears in the 2D con-
straint mode.

3. Validate the polyline. It becomes red and the scene is free from the 2D lock.

Tip: You can also check Select Polyline from the pop-up menu.

14.5.1.5.9.2 Make Parallel to a Direction

If you wish the primitive to extrude has an axis direction parallel to a defined direction, follow the steps below:

To make parallel to a direction:

1. Click the Make Parallel to Direction icon. The 3D Direction toolbar opens.
2. Define and validate a direction. The Make Parallel to Direction constraint is put in the constraint list.
3. Draw* or select a polyline (if existing).
4. Validate the defined polyline.
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1 - Defined direction 2 - First Picked point in the polyline drawing
mode

Notes:
n (*) Picking a first point in the polyline drawing mode will bring the 3D scene locked to a view perpendicular to the

defined direction.
n After validating the defined polyline, the Lock 2D Curve constraint is put in the constraint list under the Make Parallel

to Direction constraint.

Tip: You can also select an applied constraint from the constraint list and use the Del to clear it.

14.5.1.5.9.3 Make Perpendicular to a Plane

If you wish the primitive to extrude has an axis direction parallel to the normal direction of a defined plane, follow the steps
below:

To make perpendicular to a plane:

1. Click the Make Perpendicular to Plane icon. The 3D Plane toolbar opens.
2. Define and validate a plane. The Make Perpendicular to Plane constraint is put under the constraint list.
3. Draw* or select a polyline (if existing).
4. Validate the defined polyline.

1 - A defined plane 2 - The first picked point in the polyline drawing
mode

Notes:
n (*) Picking a first point in the polyline drawing mode will bring the 3D scene locked to a view parallel to the defined

plane with a 2D Grid (if not previously hidden).
n After validating the defined polyline, the Lock 2D Curve constraint is put in the constraint list under the Make Per-

pendicular to Plane constraint.

Tip: You can also select an applied constraint from the constraint list and use the Del to clear it.

14.5.1.5.10 Rectangular Torus

Only one constraint type is available (see [A]). The constraint list with (two columns Type andWith) is empty before apply-
ing a constraint. After applying a constraint, the constraint list looks as shown in [B].
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[A]

Align to Join to Two Existing Secant Boxes of Same Section

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To apply constraints to a rectangular torus:
1. Align to join two existing secant boxes of the same section.
2. Un-check a defined constraint in the constraint list to free it.
3. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use Del to clear it.
n All constraints can be selected from the pop-up menu.

Note: The user should fit (or extract) a Rectangular Torus with constraint. Otherwise, the Fit and Extract buttons remain
dimmed.

14.5.1.5.10.1 Align to Join to Two Existing Secant Boxes of Same Section

To align to join to two existing secant boxes of same section:

1. Click the Align to Join to Two Existing Secant Boxes of Same Section icon. The cursor becomes as shown in [A].
2. Pick the first box. The cursor takes the shape shown in [B].

[A]
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[B]

3. Pick another box. If the two boxes are secant and have the same section, a rectangular torus appears.

n Its Direction of Normal (also called Direction of Axis) is parallel to the two boxes' Direction of Normal (also called
Direction of Width).

n Its Bend Angle is equal to the angle drawn by the two boxes' Direction of Height.
n Its Outer Diameter is equal to the two boxes' Depth.

4. If the two picked boxes are not secant; the "This constraint cannot be activated because the two boxes are not sec-
ant" warning message appears. Click OK. The warning message closes and the Align to Join to Two Existing
Secant Boxes of Same Section constraint is left.

5. If the two picked boxes do not have the same section, the "There is too much indetermination to activate this con-
straint: two boxes are identical, one of them is a cube or they have no common face" warning message appears.
Click OK. The warning message closes and the Align to Join to Two Existing Secant Boxes of Same Section con-
straint is left.

Tips:
n If required, make the two boxes secant using the Make Secant to a Box (With Same Section) constraint in the Geo-

metry Modifier tool.
n If required, modify manually the two boxes' parameters (like Center, Width, Height, Depth, Directions, etc.) in the

Property window to make sure that both are secant and have the same section.

14.5.1.5.11 Box

Three types of constraint are available (see [A]). The constraint list with (two columns Type andWith) is empty before apply-
ing constraints. All constraints cannot be mixed together, refer to the table below to check how a constraint is compatible
with the others.

If you mix incompatible constraints together; a warning message appears. After applying constraints, the constraint list
looks as shown in [B].
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[A]

1 - Define Z* 2 - Define X* 3 - Make Secant to Box (With Same Section)

[B]

1 - Constraint type 2 - Check box 3 - Entity used as constraint

To use a constraint to calculate a box:
1. Define the vector X direction,
2. Or define the normal Z direction,
3. Or make secant to a box (with the same section).
4. Un-check a defined constraint in the constraint list to free it.
5. Or click Clear to remove all constraints from the list.

Tips:
n You can also select an applied constraint from the constraint list and use Del to clear it.
n All constraints can be selected from the pop-up menu.

Note: Amain axis direction property is added to a Box. It is initialized to the largest direction of the Box upon construction. It
is possible to change the Box main axis in the Geometry Modifier tool.

1 - The largest side of a Box 2 - Main axis
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14.5.1.5.11.1 Define the Vector X Direction

To define the vector X direction:

1. Click the Define X icon. The 3D Direction toolbar opens with the Pick an Entity With Direction set by-default.
2. Define a direction using available tools.

The Vector X (also called Direction of the Weight in the Property window) of the box is parallel* to the defined dir-
ection.

Note: (*) But not necessarily in the same direction.

14.5.1.5.11.2 Define the Normal Z Direction

To define the normal Z direction:

1. Click the Define Z icon. The 3D Direction toolbar opens with the Pick an Entity With Direction set by-default.
2. Define a direction using available tools.

The Normal Z (also called Direction of the Height in the Property window) of the box is parallel** to the defined dir-
ection.

Note: (*) But not necessarily in the same direction.

14.5.1.5.11.3 Make Secant to a Box (With Same Section)

To make secant to a box (with same section):

1. Click the Make Secant to a Box (With Same Section) icon.
2. Pick a box.

14.5.1.6 Calculate a Geometry

This step can come after choosing a geometry type or after constraints have been applied. You have two ways for com-
puting a geometry: Fit and Extract. Fit consists of adjusting the displayed/fenced point cloud with geometry. Extract con-
sists in picking a point on the point cloud where the geometry should lie. The resulting geometry will be fitted to a subset of
the point cloud in the neighborhood around the picked point. This is a faster way of defining a geometry; no fence is neces-
sary.

If no sampling/segmentation has been done; the displayed cloud (current cloud data) will be used for fitting or for extraction.
In (A), the number of points in the fitted geometry is equal to the number of points in the current cloud data. If a
sampling/segmentation has been done, the number of points in the geometry is equal to the number of points after seg-
menting/sampling if Fit has been chosen (B) and different if Extract has been chosen (C). After fitting or extracting a geo-
metry, its properties are shown in the Cloud-Based Modeler information box.

To fit a geometry on points:
n Click Fit. A primitive of the type selected in Step 1 appears.

To extract a geometry from a Picked Point:
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1. Click Extract.
2. Pick a point. A primitive of the type selected in Step 1 appears.

After fitting a geometry on points or extracting a geometry from a picked point, you can change the geometry shape
by opening the Geometry Modifier tool. Note that modifications on the geometry will create it as a persistent object
in the database. If you swap from a geometry type to another, the fitted/extracted geometry will be lost; and no warn-
ing message will appear. If constraints have been applied; clicking on the Clear button will also cancel the fitted or
extracted geometry.

Tip: If a sampling/segmentation has been started; you can directly fit and create a geometry in the database without doing
this in two steps. Choose for that the Fit and Create command from the pop-up menu or use its related short-cut key Space
bar.

Notes:
n Fit and Extract are dimmed if Extrusion has been selected in Step 1 and remains in this state as long as a polyline

has not been drawn and validated.
n The Extract function will work well when the picked point is in a clear area on the model, i.e., where the model is only

present in a large enough neighborhood around the point. When it is difficult to find a clear area, then it is better to
first fence then fit

14.5.1.7 Create a Geometry

If you are satisfied with the fitted (or extracted) geometry, you can create it as a persistent object in the RealWorks data-
base by using the Create button in the dialog. You can create as many geometries as required without leaving the tool.
When you need to leave the tool, just click on Close.

Tip: Create and Close can be selected from the pop-up menu.

Note:When you create a Plane with (or without holes), its area surface is automatically computed and displayed in the
Properties window (if open)

14.5.2 Geometry Creator

The Geometry Creator tool is for creating geometry. Ten types are available. You can create a geometry by editing known
parameters, picking points or picking entities within displayed objects. All construction methods inside the tool are pure;
they are in opposition to those based on point cloud fitting. A created geometry can be used as an entry for the other tools of
RealWorks like e.g. the Surface to Model Inspection tool where models of tunnel are required for comparison.

14.5.2.1 Open the Tool

No selection is required to open the Geometry Creator tool. Inside each creation mode, picking a point (free or constrained)
does not need to be on displayed objects. The Picking Parameters toolbar opens in the 3D constraint mode. When you
swap a creation mode for another, a message appears and prompts you to save or not the current geometry (default or
drawn one) except for Plane, Circular Torus, Extrusion and 3D Point.

To open the tool:
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n Select Geometry Creator in Model > Creation. The Geometry Creator dialog opens.

1 - Cylinder
2 - Sphere
3 - Plane

4 - Rectangular Torus
5 - Extrusion
6 - Regular Cone

7 - Circular Torus
8 - Box
9 - Segment
10 - 3D Point

This dialog opens as the third tab of the WorkSpace window. The Plane type is set by default and the 3D Plane tool
information box appears at the top right corner of the 3D View.

Notes:
n You can press the Esc key to leave the Geometry Creator tool.
n You can use the Geometry Modifier tool, the Intersect tool and the Duplicator tool within the Geometry Creator tool

in order to modify the geometry you are defining.

14.5.2.2 Define a Plane

To define a plane:

1. Click the Plane icon. Step 2 of the Geometry Creator dialog becomes as shown in [A] in the Examiner (or Walk-
through) mode and in [B] in Station-Based mode.
[A]

[B]

2. Do one of the following:
n Define a 3D plane (in all navigation modes (Examiner, Walkthrough and Station-Based)).
n Define a 3D plane in the Station-Based mode.
n Edit parameters.

3. Click Create.
4. Click Close.

A plane whose name is OBJECTX is created and put under the current Sub-Project in the Models Tree. X is its
order. With the Property window open, you can edit manually the plane parameters like its Center and Direction of
Normal.

14.5.2.2.1 Define a Plane in all Navigation Modes

There are three methods available in all navigation modes for interactively defining a plane's orientation and position: Pick
two Screen Points, Pick Three Points and Pick Two Points. For the first method, the plane will pass through the line defined
by these two points and will be perpendicular to the screen plane. For the second method, the plane will pass through these
three points. The third method is to pick two points which define a vector. As a plane is defined by two vectors. Selecting
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this method will orientate the plane so that the second vector is parallel to the Z Axis (or Elevation Axis) of the active coordin-
ate frame.

There are two methods for precisely defining the orientation of a plane: Axis and Pick Entity with Direction. For the first
method, the plane becomes perpendicular to an axis of the active frame. For the second method, the plane's orientation will
be aligned to the axis of the picked entity.

To pick an entity with a direction:
1. Click Pick Entity with Direction .
2. Pick an entity with direction.

To make perpendicular to an axis:

1. Choose among X Axis , Y Axis and Z Axis (in the X, Y and ZCoordinate System).
2. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).

To pick two screen points:

1. Click Pick two Screen Points .
2. Pick two points on displayed objects or not.

To pick three points:

1. Click Pick three Points . The Picking Parameters toolbar opens in the 3D constraint mode.
2. Pick three points (free or constrained) on displayed objects or not.

To pick two points:

1. Click Pick Two Points (in the X, Y and ZCoordinate System).

2. Or click in the North, East and Elevation Coordinate System).
3. Pick two points. No need to pick on displayed objects.

14.5.2.2.2 Define a Plane in the Station-Based Mode

There are several methods available in the Station-Based mode for defining a 3D plane.

You can swap from the Station-Based mode to the Examiner (or Walkthrough) mode and vice versa; Switching to the Exam-
iner mode is typically useful for checking a plane that has been defined in the Station-Based mode.

To define a plane in the Station-Based mode:
n Use one of the following methods:

n Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction) and One 3D Points,
n Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction) and One 3D Point,
n Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope Directions) and One 3D Point.

Note: You can define a projection plane even if the selected station does not contain any image.

14.5.2.2.2.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction) and One 3D
Points

To define a vertical plane by picking two screen points (horizontal direction) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]
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[B]

3. Pick another point anywhere in the 3D View (on the displayed point cloud or not). The cursor becomes as shown in
[C] and the Picking Parameters toolbar appears in 3D constraint mode.

4. Pick the last point anywhere in the 3D View (only on the displayed point cloud). A vertical plane appears with the
third picked point as center.
[C]

[D]
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Tip: can be selected from the pop-up menu.

14.5.2.2.2.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction) and One 3D
Point

To define a horizontal plane by picking two screen points and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]

3. Pick another point on the screen. These two points will define the orientation of the first axis of the horizontal plane's
frame. The cursor becomes as shown in [C] and the Picking Parameters toolbar appears in 3D constraint mode.

4. Pick the last point in 3D (on a cloud point, a measured point or a geometry). This point defines the height of the ver-
tical plane. A horizontal plane appears with the third picked point as center.
[C]

[D]
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Tip: can be selected from the pop-up menu.

14.5.2.2.2.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope Directions)
and One 3D Points

This feature enables to define a plane with any orientation.

To define a plane by picking three screen points (horizontal and steepest slope directions) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]

3. Pick another point on the screen so that the two points represent a horizontal segment in the 3D space. These two
points define the orientation of a horizontal segment drawn on the final plane. The cursor becomes as shown in [C].

4. Pick another on the screen so that the previous point and this new one represent the steepest slope direction of the
final plane. The cursor becomes as shown in [D] and the Picking Parameters toolbar appears in 3D constraint
mode.
[C]
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[D]

5. Pick the last point in the 3D View (only on the displayed point cloud). The three first picked points - which are not col-
linear (not lying on the same line) - draw a 3D plane; the fourth picked point is its center.

Tip: can be selected from the pop-up menu.

14.5.2.2.3 Edit Parameters

To edit parameters:
1. Enter a direction in the Normal field.
2. Enter a point’s position in the Position field.

14.5.2.3 Define a Sphere

To define a sphere:

1. Click the Sphere icon. Pick Two Points * is set by default. The Picking Parameters toolbar appears in the 3D
constraint mode. The cursor is in the picking mode.

2. Do one of the following:
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n Pick two points*.
n Edit parameters.

3. Click Create.
4. Click Close.

A Sphere whose name is OBJECTX is created and put under the current project in the Models Tree. X is its order.
With the Property window open, you can edit manually the sphere parameters like its Center, Diameter, Direction of
Axis and Distance Between Extremities.

Notes:
n The Direction of Axis is assumed to be aligned with the Z-Axis of the active coordinate frame.
n (*) In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and

then makes a 3D Sphere appear in the middle of the 3D View. This 3D Sphere has the default parameters as para-
meters (the ones in the dialog after choosing Sphere as Geometry Type). If you decide to choose another Geometry
Type, a dialog appears and prompts you to create the current geometry (or not).

14.5.2.3.1 Pick Two Points

To pick two points:

1. If required, click the Pick Two Points icon. The Picking Parameters toolbar opens in the 3D constraint mode.
2. Pick a point. This point will be the first extremity of a sphere.
3. Pick another point. This point will be the second extremity of a sphere.

14.5.2.3.2 Edit Parameters

The value by default for the Radius is one meter. The 3D coordinates in the Center field are the 3D position of the middle of
the 3D View.

To edit parameters:
1. Enter another 3D coordinates in the Center field.
2. Enter a new value in the Radius field.

14.5.2.4 Define a Cylinder

To create a cylinder:

1. Click the Cylinder icon. Pick Three Points * is selected by default. The Picking Parameters toolbar appears in
the 3D constraint mode. The cursor is in the picking mode.

2. Do one of the following:
n Pick three points*.
n Edit parameters.

3. Click Create.
4. Click Close.

A Cylinder whose name is OBJECTX is created and put under the current project in the Models Tree. X is its order.
With the Property window open, you can edit manually the cylinder parameters like its Center, Pipe Diameter,
Length, Direction of Axis, Direction of Bound 1 and Direction of Bound 2.

Notes:
n The Direction of Bound 1 and the Direction of Bound 2 are aligned with the Direction of Axis.
n (*) In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and

then makes a vertical Cylinder appear in the middle of the 3D View. This Cylinder has as parameters the defaults
(the ones in the dialog after choosing Cylinder as Geometry Type). If you choose another geometry type, a dialog
appears and prompts you to create the current geometry (or not).

14.5.2.4.1 Pick Three Points

To pick three points:
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1. If required, click the Pick Three Points icon. The Picking Parameters toolbar opens in the 3D constraint mode.
2. Pick a point. This point will be the first extremity of a cylinder.
3. Pick another point. This point will be the second extremity of a cylinder.
4. Pick a third point. This point will define the pipe radius.

14.5.2.4.2 Edit Parameters

To edit parameters:
1. Click on the pull down arrow.
2. Choose between "Two Points and Radius" and "Point, Direction and Length".

n If "Two Points and Radius" has been chosen:
a. Enter a point’s coordinates in the First Point field.
b. Enter another point’s coordinates in the Last Point field.
c. Enter a distance value in the Radius field.

n If "Point, Direction and Length" has been chosen:
a. Enter a direction in the Direction field.
b. Give a point’s position in the Position field.
c. Give a distance value in the Radius field.

14.5.2.5 Define a Regular Cone

To define a regular cone:

1. Click the Regular Cone icon. Pick Three Points * is set by default. The Picking Parameters toolbar appears in
the 3D constraint mode. The cursor is in the picking mode.

2. Do one of the following:
n Pick three points*.
n Edit parameters.

3. Click Create.
4. Click Close.

A Regular Cone whose name is OBJECTX is created and put under the current Sub-Project in the Models Tree. X is
its order. With the Property window open, you can edit manually the regular cone parameters like its Center, Dia-
meter at Base, Diameter at Top, Distance Between Extremities and Direction of Axis.

Notes:
n The Center and Direction of Axis (automatically computed based-on the other parameters) can be modified.
n (*) In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and

then makes a vertical Regular Cone appear in the middle of the 3D View. This Regular Cone has as parameters the
default parameters (the ones displayed in the dialog after choosing Regular Cone as Geometry Type). If you
choose another geometry type, a dialog appears and prompts you to create the current geometry (or not).

14.5.2.5.1 Pick Three Points

To pick three points:

1. If required, click the Pick Three Points icon.
2. Pick a point. This point will be the base extremity of a regular cone.
3. Pick another point. This point will be the top extremity of a regular cone.
4. Pick a third point. This point will define the top radius.

The drawn regular cone parameters are displayed in the dialog.

14.5.2.5.2 Edit Parameters

To edit Parameters:
1. Enter a 3D position in the First Point field.
2. Enter another 3D position in the Last Point field.
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3. Give a radius for the first point in the Top Radius field.
4. Give a radius for the last point in the Base Radius field.

14.5.2.6 Define a Circular Torus

To define a circular torus:

1. Click the Circular Torus icon.
2. Do one of the following:

n Pick two points(1).
n Align to join an existing cylinder(2).
n Align to join two secant cylinders of the same radius(3).
n Edit parameters.

3. Click Create.
4. Click Close.

A Circular Torus whose name is OBJECTX is created and put under the current project in the Models Tree. X is its
order. With the Property window open, you can edit manually the Circular Torus parameters like its Center, Pipe Dia-
meter, Center Line Diameter, Direction of Axis and Bend Angle.

Notes:
n (1) With no constraint applied, the created Circular Torus is of closed shape (the Bend Angle equal to 360 degrees).
n (2) With one constraint applied, the created Circular Torus is an open regular torus, its Bend Angle is equal to 90

degrees.
n (3) With two constraints applied, the created Circular Torus is an open regular torus, its Bend Angle is equal or less

than 90 degrees.

Note: In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and
then makes a Circular Torus appear in the middle of the 3D View. This Circular Torus has as parameters the defaults para-
meters (the ones displayed in the dialog after choosing Circular Torus as Geometry Type). If you choose another geometry
type, a dialog appears and prompts you to create the current geometry (or not).

14.5.2.6.1 Pick Two Points

To pick two points:

1. Click the Pick Two Points icon. The Picking Parameters toolbar opens in the 3D constraint mode.
2. Pick a point. This point will be the center of a Circular Torus.
3. Pick another point. This point will define the Pipe Radius + Center Line Radius distance.

14.5.2.6.2 Align to Joint to an Existing Cylinder

To align to join to an existing cylinder:

1. Click the Align to Join to an Existing Cylinder icon.
2. Pick an existing cylinder.

14.5.2.6.3 Align to Join to two Secant Cylinders of Same Radius

To align to join to two secant cylinders of same radius:
1. Click the Align to Join to Two Secant Cylinders of Same Radius icon.
2. Pick a cylinder.
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3. Pick another cylinder.

n A warning appears if the two cylinders are not secant or do not have the same diameter. In that case, use the
Make Secant to a Cylinder constraint from the Geometry Modifier tool, and then repeat the steps 2 and 3.

n A circular torus appears between the two cylinders.

n If required, use the Connect a Geometry Sequence constraint from the Intersect tool to connect the cylinders
and the torus together as illustrated below.

14.5.2.6.4 Edit Parameters

To edit parameters:
1. Give a direction in the Normal field.
2. Enter a 3D position in the Center field.
3. Enter a distance in the Center Line Radius field.
4. Enter a distance in the Pipe Radius field.

14.5.2.7 Define a Box

To create a box:

1. Click the Box icon. Step 2 of the Geometry Creator dialog becomes as shown in [A] in the Examiner (or Walk-
through) modes and in [B] in the Station-Based mode.
[A

[B]
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2. In the Examiner (or Walkthrough) mode, do one of the following:
n Pick an entity with direction,
n Project a box on a plane,
n Pick the bottom left corner of a box,
n Pick four 3D points,
n Edit parameters.

3. In the Station-Based mode, in addition to the five construction methods above, do one of the following:
n Define a horizontal face by picking one 3D point, then four screen points (two horizontal directions and depth),
n Define a vertical face by picking one 3D point, the four screen points (horizontal direction, vertical direction and

depth).
4. Click Create.
5. Click Close.

A 3D Box whose name is OBJECTX is created and put under the current project in the Models Tree. X is its order.
With the Property window open, you can edit manually the box parameters like its Center, Width, Depth, Height, etc.

Note: In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and
then makes a 3D Box appear in the middle of the 3D View. Its parameters are displayed in the dialog. If you choose another
geometry type, a dialog appears and prompts you to create the current geometry (or not).

Note: Amain axis direction property is added to a Box. It is initialized to the largest direction of the Box upon construction. It
is possible to change the Box main axis in the Geometry Modifier tool.

1 - The largest side of a Box 2 - Main axis

14.5.2.7.1 Pick an Entity With a Direction

To pick an entity with a direction:
1. Click the Pick Entity With Direction icon. The cursor becomes as shown in [A].
2. Pick an entity. A 3D Box appears [B].

[A]
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[B]

n It has the picked entity's Direction of Axis as Normal Z direction (also called Direction of Height in the Property
window),

n Its center is the same as the picked entity.

14.5.2.7.2 Project a Box in a Plane

To project a box in a plane:

1. Click the Stick to Plane icon. The cursor becomes as shown in [A].
2. Pick a plane. The selected box is projected on the picked plane [B]. The bottom side (of the box) lies on the plane.

[A]

[B]
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The Direction of Normal (of the plane) [C] and the Direction of the Height (also called the Normal Z* of the box) [D]
are parallel but not necessarily in the same direction. In the example below, both are opposite.
[C] [D]

Note: (*) In the X, Y, Z Coordinate System.

14.5.2.7.3 Pick the Bottom Left Corner of a Box

To pick the bottom left corner of a box:

1. Click the Pick Bottom Left Corner of Box icon. The cursor becomes as shown and the Picking Parameters
toolbar in the 3D constraint mode opens.

2. Pick a point. A 3D Box appears. Its bottom left corner is the point you picked.

Note: Picking should be on displayed objects.

14.5.2.7.4 Pick Four Screen Points

To pick four screen points:

1. Click the Pick Four Screen Points icon. The cursor becomes as shown in [A] and the Picking Parameters toolbar
in 3D constraint mode opens.

2. Pick the first screen point*. The cursor takes the shape shown in [B].
3. Move your mouse. A segment in orange links the first screen point to the cursor.

[A]
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[B]

4. Pick the second screen point*. The cursor then takes the shape shown in [C].
5. Move your mouse. Two other segments in orange link the first and second screen points previously picked to the

cursor. The two picked points and the cursor draw a triangular plane.
6. Pick the third screen point*. The cursor then takes the shape shown in [D] and the triangular plane changes to a rect-

angular plane.
[C]

[D]
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7. Move your mouse again (from Up to Down or vice versa). A 3D Box (with an orange frame) appears.
8. Pick the fourth screen point* to complete the 3D Box.

Note: Picking should be on displayed points.

14.5.2.7.5 Define a Horizontal Face By Picking One 3D Point, Then Four Screen Points (Two Horizontal
Directions and Depth)

To define a horizontal face by picking one 3D point, then four screen points (two horizontal directions and depth):
1. Click the Define Horizontal Face By Picking One 3D Point, Then Four Screen Points (Two Horizontal Directions and

Depth) icon. The cursor becomes as shown in [A].
2. Pick a 3D Point. Picking should be on displayed points. The cursor then takes the shape shown in [B].
3. Pick the first screen point. Picking doesn't need to be on displayed points.

[A]

[B]
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4. Move your mouse. The cursor then becomes as shown in [C]. A segment in orange links the first screen point to the
cursor. This segment can be vertical or horizontal.

5. Pick the second screen point, not necessary on displayed points.
6. Move your mouse again. The cursor then becomes as shown in [D]. A horizontal plane (with an orange frame)

appears.
7. Pick the third screen point, not necessarily on displayed points.

[C]

[D]

8. Move your mouse again. The cursor then becomes as shown in [E]. A 3D Box (with an orange frame) appears.
9. Pick the fourth screen point to complete the 3D Box.
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[E]

14.5.2.7.6 Define a Vertical Face By Picking One 3D Point, Then Four Screen Points (Horizontal Dir-
ection, Vertical Direction and Depth)

To define a vertical face by picking one 3D point, then four screen points (horizontal direction, vertical direction and depth):
1. Click the Define Vertical Face By Picking One 3D Point, Then Four Screen Points (Horizontal Direction, Vertical Dir-

ection and Depth) . The cursor becomes as shown in [A].
2. Pick a point. Picking should be on displayed points. The cursor then takes the shape shown in [B].
3. Pick the first screen point. Picking doesn't need to be on displayed points.

[A]

[B]

Trimble RealWorks User Guide | 663



PRODUCTION TOOLS

4. Move your mouse. The cursor then becomes as shown in [C]. A segment in orange links the first screen point to the
cursor. This segment should not be vertical but horizontal.

5. Pick the second screen point, not necessary on displayed points.
6. Move your mouse again. The cursor then becomes as shown in [D]. A vertical plane (with an orange frame)

appears.
7. Pick the third screen point, not necessarily on displayed points.

[C]

[D]

8. Move again your mouse. The cursor becomes then as shown in [E]. A 3D Box (with an orange frame) appears.
9. Pick the fourth screen point to complete the 3D box.

[E]

14.5.2.7.7 Edit Parameters
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To edit parameters:
1. Enter a point position in the Center field.
2. Enter a direction in the Normal Z field.
3. Enter a direction in the Vector X field.
4. Enter a distance value in the Depth (X) field.
5. Enter a distance value in the Width (Y) field.
6. Enter a distance value in the Height (Z) field.

Note: After updating a parameter, remember to press Enter. The current 3D Box (the one in display in the 3D View) will
change its shape according to the updated parameter.

14.5.2.8 Define a Rectangular Torus

To create a rectangular torus:

1. Click the Rectangular Torus icon.
2. Do one of the following:

n Align to join to two existing secant boxes of same section,
n Edit parameters.

3. Click Create.
4. Click Close.

A rectangular torus whose name is OBJECTX is created and put under the current Sub-Project in the Models Tree.
X is its order. With the Property window open, you can edit manually the rectangular torus parameters like its
Center, Width, Height, etc.
Note: If no constraints have been applied; the created rectangular torus is of open shape (the Bend Angle is less
than 360 degrees). If no constraint has been applied, the created rectangular torus is of closed shape (the Bend
angle is equal to 360 degrees).

14.5.2.8.1 Align to Join to Two Existing Secant Boxes of Same Section

To align to join to two existing secant boxes of same section:

1. Click the Align to Join to Two Existing Secant Boxes of Same Section icon. The cursor becomes as shown in [A].
2. Pick the first box. The cursor takes the shape shown in [B].

[A]

[B]
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3. Pick another box. If the two boxes are secant and have the same section, a rectangular torus appears.

n Its Direction of Normal (also called Direction of Axis) is parallel to the two boxes' Direction of Normal (also called
Direction of Width).

n Its Bend Angle is equal to the angle drawn by the two boxes' Direction of Height.
n Its Outer Diameter is equal to the two boxes' Depth.

4. If the two picked boxes are not secant; the "This constraint cannot be activated because the two boxes are not sec-
ant" warning message appears. Click OK. The warning message closes and the Align to Join to Two Existing
Secant Boxes of Same Section constraint is left.

5. If the two picked boxes do not have the same section, the "There is too much indetermination to activate this con-
straint: two boxes are identical, one of them is a cube or they have no common face" warning message appears.
Click OK. The warning message closes and the Align to Join to Two Existing Secant Boxes of Same Section con-
straint is left.

Tips:
n If required, make the two boxes secant using the Make Secant to a Box(With Same Section) constraint in the Geo-

metry Modifier tool.
n If required, modify manually the two boxes' parameters (like Center, Width, Height, Depth, Directions, etc.) in the

Property window to make sure that both are secant and have the same section.

14.5.2.8.2 Edit Parameters

To edit parameters:
1. Give a direction in the Normal field.
2. Enter a 3D position in the Center field.
3. Enter a distance in the Center Line Radius field.
4. Enter a distance in the Width field.
5. Enter a distance in the Height field.

Note: The Normal's direction is called Direction of Axis in the Property window.

14.5.2.9 Define an Extruded Entity

An Extrusion is a tool for creating a three-dimensional geometry of free shape from 2D profiles.
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To create an extruded entity:

1. Click the Extrusion icon. The Drawing and Picking Parameters (in 3D constraint mode) toolbars appear.
2. Draw or select a polyline.
3. Enter a distance value in the Length field.
4. Click Create.
5. Click Close.

An Extrusion whose name is OBJECTX is created and put in the Models Tree. X is its order. With the Property win-
dow open, you can edit manually the segment parameters like its Center, Length, Direction of Axis, Direction of
Bound 1 and Direction of Bound 2.

14.5.2.9.1 Create an Extrusion With Holes

An Extrusion with holes is mainly a three-dimensional geometry of Plane shape with holes within.

To create an extrusion with holes:
1. In OfficeSurvey, use the Polyline Drawing tool to draw a series of circles.
2. Finalize the drawing with a plane surrounding the circles.

3. In Modeling, select the Geometry Creator tool from the menu.
4. Choose Extrusion as Geometry Type from Step 1.
5. Choose Select a Polyline from the Drawing toolbar.
6. Pick any polyline from the 3D View. All are selected.
7. Enter a value in the Length field.
8. Click Create.
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9. Click Close.

14.5.2.10 Define a 3D Point

To define a 3D point:
1. Click the 3D Point icon. A 3D Point appears at the middle of the 3D View. Its 3D coordinates are displayed in the

Position field (in the dialog) and in the information panel (in the 3D View).
2. Do one of the following:

n Pick a point*
n Pick three secant planes*.
n Pick a plane and a segment*.
n Pick an entity with center*.
n Project a 3D Point on a plane*.
n Pick two axial entities*.

A 3D Point in yellow appears in the 3D View. Its parameter (Center) is updated in the dialog in the Position field.
n Edit parameters.

3. Click Create.
4. Click Close.

A 3D Point whose name is OBJECTX is created and put under the current project in the Models Tree. X is its order. With the
Property window open, you can only edit manually the 3D Point's Center.

Note: (*) In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and
then makes a 3D Point appear in the middle of the 3D View. If you choose another geometry type, a dialog appears and
prompts you to create the current geometry (or not).

14.5.2.10.1 Pick a Point

To pick a point:

1. Click the Pick Point icon. The cursor takes the following shape , the initial 3D Point is hidden and the Picking
Parameters toolbar opens in the 3D constraint mode.

2. Pick a point (free or constrained) on displayed objects (or not).

14.5.2.10.2 Pick Three Planes

If three planes are not parallel two-by-two (with no coplanar normals), then they will intersect (cross over) somewhere at a
point.

To pick three planes:
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1. Click the Pick Three Planes icon. The initial 3D Point is hidden in the 3D View and the cursor becomes as shown
in [A].

2. Pick a plane. A red frame with a yellow background upon the picked plane appears. The cursor becomes as shown
in [B].

3. Pick another plane. Another red frame with a yellow background appears upon the picked plane. The cursor
becomes as shown [C].

4. Pick another plane again. A 3D Point (the intersection of the three picked planes) appears. [D]
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14.5.2.10.3 Pick a Plane and a Segment

In this creation mode, you need to have a plane and a segment - both intersected at a point.

To pick a plane and a segment:

1. Click the Pick Plane and Segment icon. The initial 3D Point disappears from the 3D View and the cursor takes
the shape shown in [A].

2. Pick a plane. A red frame with a yellow background upon the picked plane appears. The cursor takes the shape
shown in [B].
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3. Pick a segment. The plane and the segment intersect at a 3D Point [C].

14.5.2.10.4 Pick an Entity with Center

To pick an entity with center:

1. Click the Pick Entity with Center icon. The cursor takes the following shape . The initial 3D Point disappears
from the 3D View.

2. Pick an object of any type having a center (except point cloud, mesh, etc.).

14.5.2.10.5 Project a 3D Point on a Plane

To project a 3D point on a plane:

1. Click the Project 3D Point on Plane icon. The initial 3D point disappears from the 3D View and the cursor takes
the shape shown in [A].

Trimble RealWorks User Guide | 671



PRODUCTION TOOLS

2. Pick a 3D Point. A yellow label with the following text “Point to Project on Plane” appears over the picked point [B].

3. Pick a plane. A 3D point appears on that plane [C].

14.5.2.10.6 Pick Two Axial Entities

To pick two axial entities:

1. Click the Pick Two Axial Entities .
2. Pick an axial geometry in the 3D View.
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3. Pick another axial geometry in the 3D View.

Note: A warning message appears if no intersection is found.

14.5.2.10.7 Edit Parameters

To edit parameters:
n Enter a 3D Point position in the Position field.

14.5.2.11 Define a Segment

To define a segment:

1. Click the Segment icon.
2. Do one of the following:

n Pick two points*,
n Pick two planes*,
n Pick an axial geometry*,

A Segment in yellow appears in the 3D View. Its parameters (Direction of Axis and Center) are updated in the
dialog in the Direction, Point and Length fields (if "Point, Direction and Length" has been chosen) and in the First
Point and Last Point fields (if "Two Points" has been chosen).

n Edit parameters.
3. Click Create.
4. Click Close.

A Segment whose name is OBJECTX is created and put under the current project in the Models Tree. X is its order. With
the Property window open, you can edit manually the segment parameters like its Center, Direction of Axis and Length.

Note: (*) In the picking mode, pressing Esc (or selecting Cancel Picking from the pop-up menu) first leaves that mode and
then makes a Segment appear in the middle of the 3D View. This Segment has as parameters the default parameters (the
ones displayed in the dialog). If you choose another geometry type, a dialog appears and prompts you to create the current
geometry (or not).

14.5.2.11.1 Pick Two Points

To pick two points:

1. Click the Pick Two Points icon. The Picking Parameters toolbar opens in the 3D constraint mode and the cursor
is in the picking mode.

2. Pick a point. This point will be the first extremity of a Segment.
3. Pick another point. This point will be the second extremity of a Segment.

Note: Pickings can be done on objects displayed in the 3D View (or not).

14.5.2.11.2 Pick Two Planes

If two planes are not parallel, then they will intersect (cross over) each other somewhere at a line.

To pick two planes:

1. Click the Pick Two Planes icon. The Picking Parameters toolbar opens in the 3D constraint mode. The cursor
becomes as shown in [A].
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2. Pick a plane. A red frame with a yellow background upon the picked plane appears. The cursor takes the shape
shown in [B].

3. Pick another plane.

14.5.2.11.3 Pick an Axial Geometry

To pick an axial geometry:
1. Click the Pick Axial Geometry icon.
2. Pick an axial geometry in the 3D View.
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14.5.2.11.4 Edit Parameters

To edit parameters:
1. Click on the pull down arrow.
2. Choose between "Two Points" and "Point, Direction and Length".

n If "Two Points" has been chosen:
a. Enter a 3D position in the First Point field.
b. Enter another 3D position in the Last Point field.

n If "Point, Direction and Length" has been chosen:
a. Enter a direction in the Direction field.
b. Enter a 3D position in the Point field.
c. Enter a distance value in the Length field.

14.5.3 Sub-Tools

There are no direct entries for sub-tools. All of them can only be open within a main tool to perform basic operations such as
editing or transforming an existing shape or a shape to create. There is no creation anymore

14.5.3.1 3D Picking

The 3D Picking is a tool for picking entities with direction. It only appears when you apply constraints to object manipulation.
When using the Make Parallel (or Make Perpendicular) constraint, the 3D Picking tool opens as a tab of the Make Per-
pendicular (or Make Parallel) toolbar with the Pick Entity with Direction mode set by-default (see [A]). When the Make Par-
allel to Plane or Lock on Plane constraint has been applied to object manipulation; Pick Entity with Direction appears in the
3D Plane tool opens as shown in [B]*. When the Make Perpendicular to Direction constraint has been applied to object
manipulation; the 3D Direction tool opens as shown in [C]*.

The 3D Picking tool information at the top right corner of the 3D View is empty of information. The Make Perpendicular (or
Make Parallel) toolbar contains three tabs detailed below. When this toolbar appears; the By Picking Entity tab comes first.
All these constraints can be found in tools like Geometry Modifier, Cloud-Based Modeler, etc.
[A]

[B]

[C]

1 - Pick Entity With Direction 2 - Cancel

Notes:
n To leave the Pick Entity with Direction mode, press Esc or select Cancel Picking from the pop-up menu.
n (*) In the Examiner (or Walkthrough) navigation mode.
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14.5.3.1.1 Pick an Entity with Direction

To pick an entity with direction:
1. Select an entity from the Project Tree (or in the 3D View). The Make Perpendicular (or Make Parallel) becomes act-

ive.
2. Click Pick Entity with Direction if required.
3. Click a point on a displayed entity.

n If Make Parallel has been chosen, the selected entity will be parallel to the picked entity.
n If Make Perpendicular has been chosen, the selected entity will be perpendicular to the picked entity.

4. Click Cancel. The Make Perpendicular (or Make Parallel) toolbar closes.

1 - The selected entity
2 - The picked entity

3 - The selected entity is parallel to the picked
entity

Note:When picking a plane as constraint, the entity in selection will be parallel (or perpendicular) not to the plane’s normal
direction but to the plane itself.

Tip: You can also select Pick Entity with Direction and Cancel from the pop-up menu. For Cancel, you can press Esc.

14.5.3.2 3D Direction

The 3D Direction allows you to define 3D primitives of linear shape (only direction). This tool appears when applying con-
straints to object manipulation. When using the Make Perpendicular or Make Parallel constraint, the 3D Direction tool
opens as a tab of the Make Perpendicular (or Make Parallel) toolbar with the X-axis* mode set by-default (see [A]). The
Make Perpendicular (or Make Parallel) toolbar contains three tabs detailed below. When this toolbar appears; the By Pick-
ing Entity tab comes first.

To use the 3D Direction tool, you need to click on the To Direction tab. A 3D direction in yellow and dotted appears. To use
the tool fully, you need to have objects selected and displayed. When the Make Perpendicular to Direction constraint has
been applied to object manipulation; the 3D Direction tool opens as shown in [B]. The 3D Direction tool information box at
the top right corner of the 3D View displays the current 3D direction (default or drawn) parameters. These constraints can
be found in tools like Geometry Modifier, Cloud-Based Modeler, etc.
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[A]

[B]

1 - X*, Y and Z* Axis
2 - Pick Two Points
3 - Pick Two Planes

4 - Pick Two Screen Points
5 - Edit Parameters
6 - Validate

7 - Cancel
8 - Pick Entity With Direction

Tip: All direction definition modes can be selected from the pop-up menu or using available short-cut keys (Space Bar for
Validate and Esc for Cancel).

Note: (*) In the X, Y and Z Coordinate System.

14.5.3.2.1 Define a 3D Direction Using Precise Methods

There are four methods for precisely defining the orientation of a 3D segment. The first method is to select an axis (from the
active coordinate frame) so that the initial 3D direction becomes parallel to it. The second method is by picking points on dis-
played objects. In general, the 3D direction’s orientation will be aligned to these two picked points. The third method is to
edit parameters. The fourth method is to pick an entity with direction.

To define a 3D direction perpendicular to an axis:

1. Choose among X axis , Y axis and Z axis (in the X, Y and Z Coordinate System).
2. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).

To define a 3D direction by picking two points:
1. Click Pick Two Points . The Picking Parameters toolbar appears in 3D constraint mode and the cursor becomes

as shown in [A] and the initial 3D direction disappears from the 3D View.
2. Pick a point (free or constrained) on the displayed entity. The cursor becomes as shown in [B].
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3. Pick another point (free or constrained). A direction in the form of a yellow dotted line appears.

To define a 3D direction by editing parameters:

1. Click Edit Parameters . The Direction Editing dialog opens.
2. Enter a direction in the Direction field.
3. Click OK. The Direction Editing dialog closes.

To define a 3D direction by picking an entity with direction:
1. Click Pick Entity with Direction .
2. Pick an entity with a direction in the 3D View.

14.5.3.2.2 Define a 3D Direction Using Visual Methods

There are two methods for visually defining a 3D segment’s orientation. The first method is to pick two points. A 3D seg-
ment will pass through the line defined by these two points. The second method is to pick two secant planes.

To define a 3D direction by picking two points:

1. Click Pick Two Screen Points .
2. Pick two points. No need to pick on the displayed object.

To define a 3D direction by picking two planes:

1. Click Pick Two Planes . The cursor becomes as shown in (A).
2. Pick a plane. A red frame with a yellow background appears upon the picked plane and the cursor becomes as

shown in (B).
3. Pick another plane. An axis (yellow dotted line) appears.
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1 - The selected geometry 2 - The first picked plane

14.5.3.2.3 Validate a 3D Direction

Once you are satisfied with the defined 3D direction, you can validate it by clicking Validate. Note that any persistent object
will be created in the database. Be sure to first validate the result before leaving the 3D Direction tool; there is no warning
message prompting you to save the result or not.

Note: To leave the 3D Direction tool, you can click Cancel in the Make Perpendicular, Make Parallel or 3D Direction tool-
bar, select Cancel from the pop-up menu or press Esc.

14.5.3.3 3D Point

The 3D Point allows you to define a 3D primitive of Point shape. This tool can only be used as a sub tool inside main tools
like Geometry Modifier, Cloud-Based Modeler, etc. The 3D Point tool opens with the Pick Point mode set by-default and the
cursor in the picking mode. The 3D Point information box at the top right corner of the 3D View displays the current 3D
Point’s parameters - Position. Press on the Esc key (or select Cancel Picking) from the pop-up menu to leave the Pick Point
mode. A 3D Point appears and the other modes become enabled. To use the tool fully, you need to have objects selected
and displayed.

1 - Pick Point 4 - Pick Entity with Center 6 - Edit Parameters
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2 - Pick Three Planes
3 - Pick Plane and Segment

5 - Project 3D Point on Plane 7 - Validate
8 - Cancel

Tip: All point definition modes can be selected from the pop-up menu or using available short-cut keys (Space Bar for Val-
idate and Esc for Cancel).

14.5.3.3.1 Pick a Point

To pick a point:

1. Click the Pick Point icon. The cursor takes the following shape , the initial 3D Point is hidden and the Picking
Parameters toolbar opens in the 3D constraint mode.

2. Pick a point (free or constrained) on displayed objects (or not).

14.5.3.3.2 Pick Three Planes

If three planes are not parallel two-by-two (with no coplanar normals), then they will intersect (cross over) somewhere at a
point.

To pick three planes:

1. Click the Pick Three Planes icon. The initial 3D Point is hidden in the 3D View and the cursor becomes as shown
in [A].

2. Pick a plane. A red frame with a yellow background upon the picked plane appears. The cursor becomes as shown
in [B].
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3. Pick another plane. Another red frame with a yellow background appears upon the picked plane. The cursor
becomes as shown [C].

4. Pick again another plane. A 3D Point (the intersection of the three picked planes) appears. [D]

14.5.3.3.3 Pick a Plane and a Segment

In this creation mode, you need to have a plane and a segment - both intersected at a point.

To pick a plane and a segment:

1. Click the Pick Plane and Segment icon. The initial 3D Point disappears from the 3D View and the cursor takes
the shape shown in [A].
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2. Pick a plane. A red frame with a yellow background upon the picked plane appears. The cursor takes the shape
shown in [B].

3. Pick a segment. The plane and the segment intersect at a 3D Point [C].

14.5.3.3.4 Pick an Entity with Center

To pick an entity with center:
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1. Click the Pick Entity with Center icon. The cursor takes the following shape . The initial 3D Point disappears
from the 3D View.

2. Pick an object of any type having a center (except point cloud, mesh, etc.).

14.5.3.3.5 Project a 3D Point on a Plane

To project a 3D point on a plane:

1. Click the Project 3D Point on Plane icon. The initial 3D point disappears from the 3D View and the cursor takes
the shape shown in [A].

2. Pick a 3D Point. A yellow label with the following text “Point to Project on Plane” appears over the picked point [B].
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3. Pick a plane. A 3D point appears on that plane [C].

14.5.3.3.6 Edit Parameters

To edit parameters:

1. Click Edit Parameters . The initial 3D point is hidden and the Position Editing dialog opens.
2. Enter a point’s position in that dialog.
3. Press OK.

14.5.3.3.7 Validate a 3D Point

Once you are satisfied with the defined 3D Point, you can validate it by clicking Validate. No persistent object will be created
in the database. Be sure to first validate the result before leaving the tool because there is no warning message prompting
you to validate the result (or not).

14.5.3.4 3D Axis

The 3D Axis allows you to define primitives of Segment shape (with Direction and Position). This tool appears when you
apply constraints such as Lock Center on Line or Fit to Axis in object manipulation. These constraints can be found in tools
like e.g. Geometry Modifier and Cloud-Based Modeler. This tool also appears when evoking the 3D Axis tool inside the
Duplicator tool.

In the first case, the 3D Axis tool opens with the Pick Axial Entity mode set by-default - the other modes are dimmed - and
the cursor in the picking mode. In the second case, the Pick Axial Entity mode is not set by-default. The 3D Axis information
box at the top right corner of the 3D View displays the current 3D axis parameters - Direction and Position. If the Pick Axial
Entity has been set by default; press on the Esc key (or select Cancel Picking) from the pop-up menu to leave this mode. A
3D axis (red dotted line) appears and the other modes become available. To use the tool fully, you need to have objects
selected and displayed.

Tip: All axis definition modes can be selected from the pop-up menu or by using available short-cut keys (Space Bar for Val-
idate and Esc for Cancel).

14.5.3.4.1 Pick an Axial Entity

To pick an axial entity:

1. Click the Pick Axial Entity icon. The cursor becomes as follows and the initial 3D axis disappears from the 3D
View.
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2. Pick an object with a direction.

14.5.3.4.2 Pick Two Points

To pick two points:
1. Click Pick Two Points . The initial 3D axis is hidden and the cursor takes the shape shown in [A].
2. Pick a point. After picking, it takes the shape shown in [B].
3. Pick another point.

[A] [B]

Note: Picking can be free or constrained and the Picking Parameters toolbar opens in 3D constraint mode. In this creation
mode, you can have objects of any type.

14.5.3.4.3 Pick Two Planes

After clicking Pick Two Planes , the initial 3D axis is hidden and the cursor takes the shape shown in [A]. This means that
you are in the picking mode. After picking a plane, it takes the shape shown in [B]; this means that you need to pick a
second plane. In this creation mode, you need to have secant planes.

[A] [B]

To pick two planes:
1. Pick a plane. A red frame with a yellow background upon the picked plane means that it is selected.
2. Pick another plane. An axis (the intersection of the two picked planes) in red and dotted appears.

1 - The first picked plane
2 - The cursor before picking the first plane

3 - The cursor before picking the second
plane

14.5.3.4.4 Edit Parameters

To edit parameters:

1. Click Edit Parameters . The Axis Editing dialog opens and the initial 3D axis disappears from the 3D View.
2. Click on the pull-down arrow in the Axis Editing dialog.
3. Do one of the following:
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n Choose Axis: Direction + Position.
a. Give an orientation in the Direction field.
b. Enter a point position in the Position field.

n Choose Axis: 2 Points.
a. Enter a point position in the Position 1 field.
b. Enter another point position in the Position 2 field.

4. Click OK. The Axis Editing dialog closes.

14.5.3.4.5 Validate an 3D Axis

Once you are satisfied with the defined 3D axis, you can validate it by clicking Validate. No persistent object will be created
in the database. Be sure to first validate the result before leaving the 3D Axis tool because there is no warning message
prompting you to validate the result (or not).

14.5.3.5 3D Radius

The 3D Radius dialog only appears when you apply a constraint like e.g. Lock Radius, Lock Center Line Radius or Lock
Pipe Radius respectively to a sphere or a cylinder and to a regular torus. The 3D Radius dialog opens with the Pick Radial
Entity mode set by-default. The information box, at the top right corner of the 3D View, displays the radius value of the cur-
rent entity. To leave the Pick Radial Entity mode, press Esc (or select Cancel Picking) from the pop-up menu.

To constrain the radius of an entity:
1. First, select an entity with a radius from the Project Tree.
2. From the Geometry Modifier toolbar, select Lock Radius . The 3D Radius dialog opens.

3. Do one of the following:
n Edit Parameters,
n Pick a Radial Entity,
n Pick Two Points of a Diameter,
n Pick Two Points of a Radius,
n Pick an Axis and a Point.

Tip: All commands in the 3D Radius tool dialog can be selected from the pop-up menu. The user should first leave the pick-
ing mode.

14.5.3.5.1 Edit Parameters

To edit parameters:
1. Choose between Radius and Diameter.
2. Enter a distance value in the corresponding field.
3. Click OK. The 3D Radius dialog closes.

The radius (or diameter) of the selected entity changes to fit the input value.
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14.5.3.5.2 Pick a Radial Entity

To pick a radial entity:
1. Click the Pick Radial Entity icon.
2. Pick an entity with a regular radius. The 3D Radius dialog closes.

n If the Radius option has been checked, the radius of the selected entity changes to fit the radius of the picked
entity.

n If the Diameter option has been checked, the diameter of the selected entity changes to fit the diameter of the
picked entity.

14.5.3.5.3 Pick Two Points of a Diameter

To pick two points of a diameter:
1. Click the Pick Two Points on Diameter icon. The Picking Parameters toolbar appears.
2. Pick two points anywhere. If the Diameter option is unchecked, it is automatically checked. The distance between

the two picked, is displayed in the dialog box and in the 3D View. It is also displayed as a segment in red and dotted.
3. Click OK. The 3D Radius dialog closes.

The Diameter of the selected entity changes to fit the distance between the two picked points.

14.5.3.5.4 Pick Two Points of a Radius

To pick two points of a radius:

1. Click the Pick Two Points on Radius icon.
2. Pick two points on the displayed objects, or not. If the Radius option is unchecked; it is automatically checked. The

distance between the two picked points is displayed in the dialog, and in the 3D View. It is also displayed as a seg-
ment in red and dotted.

3. Click OK. The 3D Radius dialog closes.
The Radius of the selected entity changes to fit the distance between the two picked points.

14.5.3.5.5 Pick an Axis and a Point

To pick an axis and a point:

1. Click the Pick Axis and Point icon. The cursor is as shown in [A].
2. Pick a segment. A line (in dot and yellow) appears upon the picked segment and the cursor becomes as shown in

[B].
3. Pick a point.

If the Radius option has been checked; a line (in dot and red) from the picked point and perpendicular to the picked
segment appears [C]. The distance of that line is displayed in the dialog box. This distance will be used as a con-
strained radius.
If the Diameter option has been checked; the picked point will be the center of a line (in dot and red and per-
pendicular to the picked segment) appears [D]. The distance of that line is displayed in the dialog box. This distance
will be used as a constrained diameter.
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4. Click OK. The 3D Radius dialog closes.
The radius (or diameter) of the selected entity changes to fit the radius (or diameter) defined by the picked segment
and point.

Note: You need to have a segment and a point, already created in the database.

14.5.3.6 3D Secant

The 3D Secant dialog appears when you use the Make Secant to Cylinder constraint in tools like Geometry Modifier or
Cloud-Based Modeler. The Pick Cylinder to be Secant With mode is set by default. To leave this mode, press Esc or select
Cancel Picking from the pop-up menu.

The 3D Secant information box, at the top right corner of the 3D View, contains the information related to the secant cyl-
inder and the secant angle if the Use Same Radius and Use Given Angle options are unchecked, the secant cylinder, the
radius value and the secant angle if the Use Same Radius option is checked and the secant cylinder and the secant value if
the Use Given Angle option is checked.

Trimble RealWorks User Guide | 688



PRODUCTION TOOLS

All are undefined before applying the constraint except the secant angle which has the value in the Use Given Angle field or
is equal to 90 degrees if Perpendicular is pressed-on.

Note:When you use the Make Secant to Cylinder constraint inside the Geometry Modifier tool; you need to have a cylinder
first selected. This condition is unnecessary in the Cloud-Based Modeler tool.

14.5.3.6.1 Make Secant to a Cylinder

To make secant to a cylinder:

1. If required, click the Pick a Cylinder to be Secant With icon.
2. Keep the Use Same Radius and Use Given Angle options unchecked.
3. Pick a cylinder in the 3D View. The selected cylinder axis is secant to the picked cylinder axis.
4. Click OK. The Make Secant dialog closes.

14.5.3.6.2 Make Secant to a Cylinder With a Radius Constraint

To make secant to a cylinder with a radius constraint:

1. If required, click the Pick a Cylinder to be Secant With icon.
2. Check the Use Same Radius option.
3. Pick a cylinder. The selected cylinder and the picked cylinder have secant axes and same radius.
4. Click OK. The Make Secant dialog closes.

14.5.3.6.3 Make Secant to a Cylinder With an Angle Constraint

To be secant to a cylinder with an angle constraint:

1. If required, click the Pick a Cylinder to be Secant With icon.
2. Do one of the following:

n Check the Use Given Angle option and enter a value different from 90° or 270°. The selected cylinder axis is sec-
ant to the picked cylinder axis with the given angle.

n Check the Use Given Angle option and enter a value equal to 90° or 270°. The selected cylinder axis is secant
and perpendicular to the picked cylinder axis.

n Check the Use Given Angle option and click the Perpendicular icon. The selected cylinder axis is secant and
perpendicular to the picked cylinder axis.

3. Click OK. The Make Secant dialog closes.

14.5.3.6.4 Make Secant to a Cylinder With the Angle and Radius Constraints
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To be secant to a cylinder with the angle and radius constraints:

1. If required, click the Pick a Cylinder to be Secant With icon.
2. Do one of the following:

n Check the Use Given Angle and Use Same Radius options with an angle other than 90° or 270°. The selected
cylinder axis is secant to the picked cylinder axis with the given angle and both entities have the same radius.

n Check the Use Given Angle and Use Same Radius options with an angle equal to 90° or 270°. The selected cyl-
inder axis is secant and perpendicular to the picked cylinder axis both entities have the same radius.

3. Click OK. The Make Secant dialog closes.

14.5.3.7 3D Plane

The 3D Plane allows you to define a 3D primitive of planar shape. In the Modeling processing mode and whatever the nav-
igation mode you use (Examiner, WalkThrough or Station-Based), this tool appears when you apply constraints to object
manipulation. When using the Make Perpendicular (or Make Parallel) constraint, the 3D Plane tool opens as a tab of the
Make Perpendicular (or Make Parallel) toolbar with the X-Axis* mode set by-default (see [A1] and [A2] respectively in the
Examiner/Walkthrough and Station-Base mode).

The Make Perpendicular (or Make Parallel) toolbar contains three tabs. When it appears; the By Picking Entity tab comes
first. To use the 3D Plane tool, you need to click on the To a Plane tab (or click on the (or ) button). A 3D plane per-
pendicular to the screen appears and the 3D Plane information box at the top right corner of the 3D View displays the cur-
rent (default or drawn) 3D plane parameters - Normal and Position.

To use the tool fully, you need to have an object selected and displayed.
[A1]

[A2]

14.5.3.7.1 Define a 3D Plane in the Examiner (or WalkThrough)

There are three methods for precisely defining the orientation of a 3D plane. The first method is to select an axis (from the
active coordinate frame) so that the initial 3D plane becomes perpendicular to it.

To select an axis:

1. Choose among X Axis , Y Axis and Z Axis (in the X, Y and Z Coordinate System).
2. Or choose among North Axis , East Axis and Elevation Axis (in the North, East and Elevation Coordinate

System).

The second method is to edit parameters.

To edit parameters:

1. Click the Edit Parameters icon. The Plane Editing dialog opens.
2. Enter a direction in the Normal field.
3. Enter a point position in the Point field.
4. Click OK. The Plane Editing dialog closes.

The third method is to pick an entity with a direction so that the initial 3D plane normal becomes parallel to the picked entity
direction.

To Pick an Entity With Direction:
1. Click the Pick Entity with Direction icon.
2. Pick an entity with a direction in the 3D View.
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There are three methods for visually defining the orientation of a 3D plane. The first method is to pick two points. The initial
3D plane will pass through the line defined by these two points and perpendicular to the screen plane.

To pick two screen points:

1. Click the Pick Two Screen Points icon.
2. Pick two points. No need to pick on displayed objects.

The second method is to pick three points. The initial 3D plane will pass through the plane drawn by these three points.

To pick three points:

1. Click the Pick 3 Points icon. The Picking Parameters toolbar appears.
2. Pick three points (free or constrained). Picking is always on displayed objects.

1 - First picked point 2 - Second picked point 3 - Third picked point

The third method is to pick two points which define a vector. As a plane is defined by two vectors. Applying this constraint
will orientate the selected plane so that the second vector is parallel to the Z Axis (or Elevation Axis) of the active coordinate
frame.

To pick two points:

1. Click the Pick Two Points icon (in the X, Y and Z Coordinate System).

2. Or click the icon in the North, East and Elevation Coordinate System).
3. Pick two points. No need to pick on displayed objects.

Tip: All plane definition modes can be selected from the pop-up menu or using available short-cut keys (Space Bar for Val-
idate and Esc for Cancel).

14.5.3.7.2 Define a 3D Plane in the Station-Based Mode
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There are ten methods available in the Station-Based mode for defining a 3D plane. Three are specific to that mode: two
are based on two screen points and a 3D point and one on three screen points and a 3D point. The other methods are
already described in the Examiner (or Walkthrough) mode.

14.5.3.7.2.1 Define a Vertical Plane by Picking Two Screen Points (Horizontal Direction) and One 3D
Points

To define a vertical plane by picking two screen points (horizontal direction) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]

3. Pick another point anywhere in the 3D View (on the displayed point cloud or not). The cursor becomes as shown in
[C] and the Picking Parameters toolbar appears in 3D constraint mode.

4. Pick the last point anywhere in the 3D View (only on the displayed point cloud). A vertical plane appears with the
third picked point as center.
[C]

[D]
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Tip: can be selected from the pop-up menu.

14.5.3.7.2.2 Define a Horizontal Plane By Picking Two Screen Points (Horizontal Direction) and One 3D
Point

To define a horizontal plane by picking two screen points and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]

3. Pick another point on the screen. These two points will define the orientation of the first axis of the horizontal plane's
frame. The cursor becomes as shown in [C] and the Picking Parameters toolbar appears in 3D constraint mode.

4. Pick the last point in 3D (on a cloud point, a measured point or a geometry). This point defines the height of the ver-
tical plane. A horizontal plane appears with the third picked point as center.
[C]
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[D]

Tip: can be selected from the pop-up menu.

14.5.3.7.2.3 Define a Plane By Picking Three Screen Points (Horizontal and Steepest Slope Directions)
and One 3D Points

This feature enables you to define a plane with any orientation.

To define a plane by picking three screen points (horizontal and steepest slope directions) and one 3D point:

1. Click on the button. The cursor becomes as shown in [A].
2. Pick a point anywhere on the screen. The cursor becomes as shown in [B].

[A]

[B]
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3. Pick another point on the screen so that the two points represent a horizontal segment in the 3D space. These two
points define the orientation of a horizontal segment drawn on the final plane. The cursor becomes as shown in [C].

4. Pick another on the screen so that the previous point and this new one represent the steepest slope direction of the
final plane. The cursor becomes as shown in [D] and the Picking Parameters toolbar appears in 3D constraint
mode.
[C]

[D]

5. Pick the last point in the 3D View (only on the displayed point cloud). The three first picked points - which are not col-
linear (not lying on the same line) - draw a 3D plane; the fourth picked point is its center.
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Tip: can be selected from the pop-up menu.

14.5.3.7.3 Modify the Size of a Plane

You can resize the previous 3D plane. The resized 3D plane keeps the same parameters as before except the dimensions.
You can do this by dragging & dropping a corner in the 3D View.

To modify the size of a 3D plane:
1. Place the mouse cursor upon any handle of a 3D plane. A green square appears.
2. If a corner handle is selected, drag it to increase (or reduce) the 3D plane size. During this operation, the green

square becomes yellow.
3. If a middle handle is selected, drag it to increase (or reduce) the 3D plane width (or length). During this operation,

the green square becomes yellow.

14.5.3.7.4 Validate a Plane

Once you are satisfied with the defined 3D plane, you can validate it by clicking Validate. Note that any persistent object will
be created in the database. Be sure to first validate the result before leaving the 3D Plane tool; there is no warning message
prompting you to save the result or not.

Note: To leave the 3D Plane, you can click Cancel in the Make Perpendicular, Make Parallel or 3D Plane toolbar, select
Cancel from the pop-up menu or press Esc.

14.5.4 Modify Geometry

Rotating or panning an object can be free (called Standard Navigation) or constrained. Constraints can be imposed
(Screen Rotation, Vertical Pan, Horizontal Pan, etc.) or defined by the user. That’s the reason of the Modify Geometry tool
which enables you to define these constraints by using manipulators in order to have a fine control in rotating or panning
objects.

No selection is required to launch the Modify Geometry tool. Once inside the tool, you need to have at least a geometry
selected, in one of these three windows (3D View, List and Property) and you need to display the selection to be able to use
a manipulator.

14.5.4.1 Open the Tool

The Modify Geometry tool may take several aspects. Each aspect depends on the type of the selected geometry.

To open the tool:
n Select Modify Geometry in Model > Edit. The Modify Geometry toolbar appears.

14.5.4.2 Modify a Shape

You can modify the shape of a geometry by changing its dimensions with manipulators which change according to the type
of the geometry.
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Notes:
n You cannot modify the shape of a Plane (or 3D Point).
n You can select a geometry before or after choosing the Modify Shape command.

Tip: You can select Modify Shape from the pop-up menu or use its related shortcut key Shift + E.

14.5.4.2.1 Sphere

To modify a sphere:
1. Select and display a sphere.
2. Click the Modify Shape icon. The selected sphere is displayed with a manipulator (with one ring and two

handles).
3. Pick on the ring to select it. It turns yellow.
4. Drag to increase (or reduce) the sphere's diameter.

5. Pick on the top handle to select it. It turns yellow.
6. Drag to shorten the selected sphere’s axis by the top. It is like bounding the selected sphere with a plane. The result

is a hemisphere.

7. Pick on the bottom handle to select it. It turns yellow.
8. Drag to shorten the selected sphere’s axis by the bottom. It is like bounding the initial sphere with a plane. The res-

ult is a sliced sphere.
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14.5.4.2.2 Cylinder

To modify a cylinder:
1. Select and display a cylinder.
2. Click the Modify Shape icon. The selected cylinder is displayed with a manipulator (with two rings and two

handles).
3. Pick on a ring manipulator to select it. It turns to yellow.
4. Drag to increase or reduce the cylinder’s diameter.

5. Pick on a handle to select it. It turns to yellow.

Trimble RealWorks User Guide | 698



PRODUCTION TOOLS

6. Drag to shorten or lengthen the selected cylinder’s axis.

14.5.4.2.3 Cone

To modify a cone:
1. Select and display a cone.
2. Click the Modify Shape . The selected cone is displayed with a manipulator (with two rings and two handles).
3. Pick e.g. the top ring manipulator to select it. It turns to yellow.
4. Drag to increase or reduce the cone’s top diameter.

5. Pick e.g. the top handle to select it. It turns to yellow.
6. Drag to shorten the selected cone’s axis by the top.
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7. Do the same for the top handle (or ring) manipulator.

14.5.4.2.4 Circular Torus

To modify a circular torus:
1. Select and display a circular torus.
2. Click the Modify Shape icon. The selected circular torus is displayed with a manipulator (with two rings and one

handle).
3. Pick the director radius ring manipulator to select it. It turns to yellow.
4. Drag to increase or reduce the selected circular torus director radius.

5. Pick the generator radius ring manipulator to select it. It turns to yellow.
6. Drag to increase or reduce the selected circular torus generator radius.

7. Pick on the handle to select it. It turns to yellow.
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8. Drag to increase or reduce the selected circular torus angle.

14.5.4.2.5 Segment

To modify a segment:
1. Select and display a segment.
2. Click the Modify Shape icon. The selected segment is displayed with a manipulator (with two handles).
3. Pick one of the two handles to select it. It turns to yellow.
4. Drag to increase or reduce the selected segment’s length.

14.5.4.2.6 Extrusion

To modify an extrusion:
1. Select and display an extruded entity.
2. Click the Modify Shape icon. The extruded entity in selection is displayed with a manipulator (with two handles).
3. Pick one of the two handles to select it. It turns yellow.
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4. Drag to increase or reduce the extruded entity’s length.

14.5.4.2.7 Box

To modify a box:
1. Select and display a Box.
2. Click the Modify Shape icon. The selected Box is displayed with a manipulator which has six Face Handles, one

on each face, and eight Corner Handles.
3. To increase or decrease the size of the Box in one direction:

a. Pick a Face Handle to select it. It turns yellow.
b. Drag and drop the Face Handle away from (or toward) the center of the Box.

4. To increase or decrease the size of the Box, uniformly in all directions:
a. Pick a Corner Handle to select it. It turns yellow.
b. Drag and drop the Corner Handle away from (or toward) the center of the Box.
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Caution:Modifying the size of a Box will not change the direction of the main axis anymore.

14.5.4.2.8 Rectangular Torus

To modify a rectangular torus:
1. Select and display a rectangular torus.
2. Click the Modify Shape icon. The selected rectangular torus is displayed with manipulators (with one ring and

two handles).
3. Pick the Center Line Radius ring manipulator to select it. It turns yellow.
4. Drag to increase or reduce the selected rectangular torus Center Line Radius.

5. Pick on a handle manipulator to select it. It turns yellow.
6. Drag to increase or reduce the selected circular torus angle.
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14.5.4.3 Extend a Geometry by Snapping

You can extend a geometry to snap one of its faces to a VISIBLE face of another geometry. Not all geometries can be exten-
ded but only those that are given hereafter: Cylinder, Cube or Rectangular Cuboid, and Extrusion. For the face of the target
entity, nearly all geometries can be used for snapping purposes, except meshes. If the selected face does not allow a stand-
ard bounding of the geometry (perpendicular axes for instance), it will be refused.

To extend a geometry by Snapping:
1. First display two entities, e.g. a cylinder and a cube.
2. Select the cylinder.
3. Click the Modify Shape icon. The selected cylinder is displayed with a manipulator (two rings and two handles).

4. Pick a handle to select it. It turns yellow.
5. While dragging the handle, move the mouse over a visible face of the cube. A 3D feedback will highlight the face

and the name of the geometry will be displayed.

Note: If you don't want to snap on any face, press the CTRL key while dragging the handle.

14.5.4.4 Modify a Position

"To Pan" a geometry means moving and positioning it at a desired location within the scene. "To Rotate" a geometry means
turning it around an axis or around a point.

Note: You can select a geometry before or after choosing one of the above displacement modes.

14.5.4.4.1 Pan Along the Home Frame Axes

This feature lets the user displace a selected entity along the three axes of the Home Frame.

To pan along the Home Frame axes:
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1. Select and display a geometry.
2. Click the Pan Along Home Frame Axes icon. A manipulator (with three-axis handles and three-plane handles)

appears. This manipulator has the same color as the Home Frame. It has as Origin the center of the selection if sev-
eral entities are selected. Otherwise, its Origin is the center of the selected geometry, if a unique geometry is selec-
ted.

1 - An axis handle
2 - A plane handle

3 - Home frame

3. Select an axis handle by picking it; it turns to yellow. The direction along which you can pan the selection is high-
lighted in yellow and those for which you cannot are in mauve.

4. Move the selection along that direction.

5. Select a plane handle by picking it. It turns yellow. The directions (two) along which you can pan the selection are
highlighted in yellow and the one for which you cannot is in mauve.

6. Move the selection in that plane.
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Tip: You can also select Pan along Home Frame Axes from the pop-up menu or use the Shift + T short-cut key to choose
this manipulation mode.

Note: The manipulator will not appear if there is no selection.

14.5.4.4.2 Pan Along its Own Axes

This feature lets the user displace a selected entity along its own axes.

To pan along its own axes:
1. Select and display a geometry.
2. Click the Pan Along Own Axes icon. A manipulator (with three-axis handles and three-plane handles) appears.

This manipulator does not have the same color as the Home Frame. It has as Origin the center of the selection if
several entities are selected. Otherwise, its Origin is the center of the selected geometry, if a unique geometry is
selected.

1 - An axis handle
2 - A plane handle

3 - Home frame

3. Select an axis handle by picking it; it turns yellow. The direction along which you can pan the selected geometry is
highlighted in yellow and those for which you cannot are in mauve.

4. Move the selected geometry along that direction.
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5. Select a plane handle by picking it. It turns to yellow. The directions (two) along which you can pan the selection are
highlighted in yellow and the one for which you cannot is in mauve.

6. Move the selection in that plane.

Tip: You can also select Pan along Own Axes from the pop-up menu or use the Ctrl + T short-cut key to choose this manip-
ulation mode.

Note: The manipulator will not appear if there is no geometry selected.

14.5.4.4.3 Rotate a Geometry

This feature lets the user turn a selected entity around its center.

To rotate a geometry:
1. Select and display a geometry.
2. Click the Rotate icon. A manipulator (with three ring handles (red, light blue and green)) appears. This manip-

ulator has as origin the center of the selection if several entities are selected. Otherwise, it has as origin the center
of the selected geometry, if only a unique geometry has been selected.
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A ring handle (X3)
The Rotation Manipulator Parameters toolbar opens.

Tip: You can also select Rotate from the pop-up menu (or use the Shift + R short-cut key).

14.5.4.4.3.1 Use the Manipulator

To use the manipulator:
1. Select a ring handle by picking it. It turns yellow. An axis passing through the center of that ring handle and per-

pendicular to it, appears. This axis has the color of the selected ring handle.
2. Drag the ring handle to rotate the selected geometry around the axis.

14.5.4.4.3.2 Enter Manually an Angle

To enter manually an angle:
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1. Input an angle in the Red field and click Validate .
The selected geometry rotates according to the input value, around an axis passing through the center of the Red
ring handle and perpendicular to it.

2. Or / and enter an angle in the Green field and click Validate .
The selected geometry rotates according to the input value, around an axis passing through the center of the Green
ring handle and perpendicular to it.

Or
The selected geometry rotates according to the two input values.

3. Or / and enter an angle in the Blue field and click Validate .
The selected geometry rotates according to the input value, around an axis passing through the center of the Blue
ring handle and perpendicular to it.
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Or
The selected geometry rotates according to the three input values.

Tip: Instead of clicking Validate, you can also press Enter.

Cautions:
n A value, once input in a field, will not be reset (to zero) once the transformation is applied. You have to manually

reset this value to zero.
n Any transformation can be applied if all of the fields are set to zero. The Validate icon becomes dimmed.

Note: A value can be either negative or positive.

14.5.4.4.4 Change the Manipulator Location

This feature lets the user change, not the position of a selected entity, but the position of its manipulator. This can be helpful
in the case the manipulator is not visible anymore in the 3D View.

To change the manipulator location:
1. Select and display a geometry.
2. Choose among Pan Along Home Frame Axes, Pan Along Own Axes and Rotate.

3. Click the Change Manipulator Location icon.
4. Pick a position anywhere. The picking can be on a displayed object or not. The manipulator will move to the picked

position.

Tip: You can also select Change Manipulator Location from the pop-up menu (or use the C short-cut key).

Caution: There is no Undo for this kind of operation.

14.5.4.5 Switch from one Manipulation Mode to Another

You can easily switch between the different manipulation modes, i.e. from Modify Shape to Pan Along Home Frame Axes,
and from Pan Along Home Frame Axes to Pan Along Own Axes, and so on, by just picking one of the Handles.

Note: The cursor changes from to when you hover it over a Handle.

14.5.4.6 Move a Geometry by Picking a Geometry
You can pan (or rotate) an entity along (or around) the axis (or center) of another entity.
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14.5.4.6.1 Pick an Axis from Other Geometry, then Pan

The Pick an Axis From Other Geometry, then Pan feature lets you move an entity along a direction which is given by the
axis of another entity.

To pick an axis from other geometry, then pan:
1. Click the Pick an Axis From Other Geometry, then Pan icon. The cursor takes the shape shown in [C1]. This means

that you are in the axis picking mode.
2. Pick the object. The cursor takes its default state (Arrow); this means that you leave the picking mode and you are in

the selection mode.
3. Select another object. A position manipulator (in blue) (in the picked object’s axis and having as origin its center)

appears [C2].

4. Pick the object. The cursor takes its default state (Arrow); this means that you leave the picking mode and you are in
the selection mode.

5. Select another object. A position manipulator (in blue) (in the picked object’s axis and having as origin its center)
appears [C2].

6. Select the position manipulator. It turns yellow. The direction along which you can pan the second object is in yellow
and those (two) for which you cannot are in mauve.
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7. Drag the position manipulator to pan the second object along the first object’s axis [C3].

Tips:
n You can also select Pick Axis from Other Geometry and Pan from the pop-up menu.
n With this tool, you can pan an object along its own axis or along another object’s axis. Only objects having an axis

can be picked for panning purposes.

Note: To leave the picking mode, press Esc (or select Cancel Picking from the pop-up menu).

14.5.4.6.2 Pick an Axis from Other Geometry, then Rotate

The Pick an Axis From Other Geometry, then Rotate feature lets you rotate an entity around a direction which is given by
the axis of a picked entity.

To pick an axis from other geometry, then rotate:

1. Click the Pick an Axis from Other Geometry, then Rotate icon.
2. Pick an entity other than the selected one. A manipulator, perpendicular to the axis of the picked entity and having

as origin its center, appears.

3. Select the ring handle (in deep blue) by picking it. It turns yellow.
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4. Drag the ring handle to rotate the selected entity around the axis of the picked one.

Tip: You can also select the Pick Axis from Other Geometry and Rotate icon from the pop-up menu.

Note:With this manipulation mode, you can rotate an entity around its own axis, or around the axis of another entity. Only
an object with an axis can be picked.

Note: To leave the picking mode, press Esc (or select Cancel Picking from the pop-up menu).

14.5.4.6.3 Pick a Point from Other Geometry, then Rotate

To pick a point from other geometry, then rotate:

1. Click the Pick a Point from Other Geometry, then Rotate icon. The cursor takes the shape shown in [C1]. This
means that you are in the point picking mode.

2. Place the cursor over an object [C1].

3. Pick the object. The cursor takes its default state (Arrow); this means that you leave the picking mode and you are in
the selection mode.

4. Select another object by picking it. A manipulator appears [C2]. This manipulator has three rings (red, light blue and
green) and has as origin the center of the picked object.
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5. Select a ring handle by picking it. It turns yellow. An axis passing the center of that ring handle and perpendicular to
it appears. This axis has the color of the selected ring handle.

6. Drag the ring handle to rotate the second object around the axis of the second object (C3).

Tip: You can also select the Pick a Point from Other Geometry, then Rotate from the pop-up menu.

Note: To leave the picking mode, press Esc (or select Cancel Picking from the pop-up menu).

14.5.4.6.4 Pick a Plane, and then Pan

After selecting Pick Plane and Pan , the cursor takes the shape shown in (A). This means that you are in the plane pick-
ing mode. After picking a point, it returns to its default shape (Arrow); this means that you are in the selection mode. With
this tool, you can pan an object in a plane or along a plane’s axis.

[A]

Tip: You can also select Pick Plane and Pan from the pop-up menu.

Note: To leave the picking mode, press Esc (or select Cancel Picking from the pop-up menu).

14.5.4.6.4.1 Pick and Pan a Plane

1. Place the cursor over a plane (B1).
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2. Pick the plane. The cursor takes its default state (Arrow); this means that you leave the picking mode and you are in
the selection mode.

3. Select the same plane by picking it. A manipulator appears (B2). This manipulator has two axis handles (red and
green) and a plane handle and has as origin the center of the picked plane.

4. Select an axis handle by picking it. It turns yellow. The direction along which you can pan the plane is highlighted in
yellow and those (two) for which you cannot are in mauve.

5. Drag the axis handle to pan the plane along the direction in yellow (B3).

6. Select the plane handle by picking it. It turns yellow. The directions (two) along which you can pan the object are
highlighted in yellow and the one for which you cannot is in mauve.

7. Drag the plane handle to pan the plane along any of the two directions (B4).

14.5.4.6.4.2 Pick a Plane and Select Another Object
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1. Place the cursor over a plane (C1).

2. Pick the plane. The cursor takes its default state (Arrow); this means that you leave the picking mode and you are in
the selection mode.

3. Select another object (plane or others) by picking it. A manipulator appears (C2). This manipulator has two axis
handles (red and green) and a plane handle and has as origin the center of the picked object.

4. Select an axis handle by picking it. It turns yellow. The direction along which you can pan the object is highlighted in
yellow and those for which you cannot are in mauve.

5. Drag the axis handle to pan the object along the plane direction in yellow (C3).

6. Select the plane handle by picking it. It turns yellow. The directions (two) along which you can pan the object are
highlighted in yellow and the one for which you cannot is in mauve.

7. Drag the plane handle to pan the object along any of the plane directions C4).
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14.5.4.6.4.3 Pick and Select a Plane

1. Place the cursor over the selected plane (D1).

2. Pick the plane. A manipulator appears (D2). This manipulator has two axis handles (red and green) and a plane
handle and has as origin the center of the picked plane.

3. Select an axis handle by picking it. It turns yellow. The direction along which you can pan the plane is highlighted in
yellow and those (two) for which you cannot are in mauve.

4. Drag the axis handle to pan the plane along the direction in yellow (D3).
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5. Select the plane handle by picking it. It turns yellow. The directions (two) along which you can pan the object are
highlighted in yellow and the one for which you cannot is in mauve.

6. Drag the plane handle to pan the plane along any of the two directions (D4).

14.5.4.6.4.4 Picking a plane and selecting another object.

1. Place the cursor over a plane (E1).

2. Pick the plane. A manipulator appears (E2). This manipulator has two axis handles (red and green) and a plane
handle and has as origin the center of the picked object.

3. Select an axis handle by picking it. It turns yellow. The direction along which you can pan the object is highlighted in
yellow and those for which you cannot are in mauve.

4. Drag the axis handle to pan the object along the plane direction in yellow (E3).
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5. Select the plane handle by picking it. It turns yellow. The directions (two) along which you can pan the object are
highlighted in yellow and the one for which you cannot is in mauve.

6. Drag the plane handle to pan the object along any of the plane directions (E4).

14.5.4.7 Move an Entity Along a User Defined Vector

You can move a geometry along a vector that you have to define on your own.

Note: You need to select a geometry before choosing one of the above commands. Otherwise, they are dimmed. Each of
the commands can be selected from the pop-up menu.

MOVE A GEOMETRY USING A 2-POINT DEFINED VECTOR:

After choosing the Move Geometry using 2-Point Defined Vector icon, the cursor takes the shape shown in [A] and the
Picking Parameters toolbar appears in 3D constraint mode. This means that you are in the point picking mode. After picking
a point, it becomes as shown in [B]. This means that you need to pick another point. After picking, it returns to its default
shape (Arrow); this means that you are in the selection mode. With this tool, you can pan a geometry by picking two points.

[A] [B]
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1 - The first and second picked points 2 - The selected object is translated from the first picked
point to the second picked point

Note: You can select Cancel Picking from the pop-up menu (or use the Esc key) to leave the Move Geometry using 2-Point
Defined Vector tool.

ALIGN GEOMETRY (Z-AXIS) ALONG 2-POINT-DEFINED AXIS:

After choosing the Align Geometry (Z-Axis) along 2-Point-Defined Axis icon, the cursor takes the shape shown in [A] and
the Picking Parameters toolbar appears in 3D constraint mode. This means that you are in the point picking mode. After
picking a point, it becomes as shown in [B]. This means that you need to pick another point. After picking, it returns to its
default shape (Arrow); this means that you are in the selection mode. With this tool, you can align an object’s Z-axis along
two picked points.

[A] [B]
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Note: You can select Cancel Picking from the pop-up menu (or use the Esc key) to leave the Align Geometry (Z-Axis) along
2-Point-Defined Axis tool.

14.5.4.8 Apply Constraints

14.5.4.8.1 Plane

After selecting a plane (before or after opening the tool), the Modify Geometry toolbar becomes as shown below. There are
seven types of constraints.

1 - Make Vertical
2 - Make Horizontal
3 - Make Parallel

4 - Make Perpendicular
5 - Pass Through Point
6 - Pass Through Axis

To make a plane parallel/perpendicular to an entity/plane/direction:
n See the 3D Picking/3D Plane/3D Direction.

To pass a plane through a point:
n See the 3D Point.

To pass a plane through an axis:
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1. Click Pass through Axis. The 3D Axis toolbar and its information box appear.
2. Do one of the following to define an axis:

n Pick an axial entity,
n Pick two points (free or constrained),
n Pick two planes,
n Enter axis parameters.

3. Validate the defined axis.

To make a plane horizontal:
1. Select a plane.
2. Click Make Horizontal. Its Direction of Normal becomes parallel to the Z Axis (or Elevation Axis)) but not necessarily

in the same direction.

To make a plane vertical:
1. Select a plane.
2. Click Make Vertical. As the selected plane is defined by two vectors. Applying this constraint will orientate the selec-

ted plane so that one of the vectors is parallel to the Z Axis (or Elevation Axis) of the active coordinate frame.

Tip: All constraints can be selected from the pop-up menu.

14.5.4.8.1.1 Make Vertical

To make vertical:
1. Select a geometry.

2. Click the Make Vertical icon. The selected geometry is moved so that its Direction of Axis is parallel to the Z-Axis
of the Home frame.

14.5.4.8.1.2 Make Horizontal

To make horizontal:
1. Select a geometry.

2. Click the Make Horizontal icon. The selected geometry is moved so that its Direction of Axis is perpendicular to
the Z-Axis of the Home frame.

14.5.4.8.1.3 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.1.4 Make Perpendicular

To make perpendicular:
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1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.1.5 Pass Through a Point

To pass through a point:

1. Click the Pass through Point icon. The 3D Point toolbar and its information box at the top right corner of the 3D
View.

2. Define and validate a 3D point.

14.5.4.8.1.6 Pass Through an Axis

To pass through an axis:

1. Click the Pass through Point icon. The 3D Axis toolbar as well as its information box appear.
2. Define and validate a 3D axis.

14.5.4.8.2 Sphere

After selecting a sphere-shaped geometry (before or after opening the tool), the Modify Geometry toolbar becomes as
shown below. There are four constraint types.

1 - Lock Radius
2 - Lock Center

3 - Lock Center on a Line
4 - Pass Through a Point

Tip: All constraints can be selected from the pop-up menu.

To lock a radius:

1. Click the Lock Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

To lock a center:
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1. Click the Lock Center icon. The 3D Point toolbar opens as well as its information box.
2. Define and validate a 3D point.

To lock a center on a line:

1. Click on the Lock Center on Line icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

To pass through a point:

1. Click the Pass through Point icon. The 3D Point toolbar and its information box at the top right corner of the 3D
View.

2. Define and validate a 3D point.

14.5.4.8.3 Cylinder

After selecting a cylinder-shaped geometry (before or after opening the tool), the Geometry Modifier toolbar becomes as
shown below. There are six constraint types.

1 - Make Vertical
2 - Make Parallel
3 - Make Perpendicular
4 - Pass Axis Through a Point

5 - Lock Radius
6 - Fit to an Axis
7 - Make Secant to a Cylinder

To apply a constraint to a cylinder:
1. Make a cylinder parallel/perpendicular to an entity/plane/direction (see the 3D Picking/3D Plane/3D Direction).
2. Or lock a cylinder radius (see the 3D Radius).
3. Or pass a cylinder axis through a point (see the 3D Point).
4. Or fit a cylinder axis (see the 3D Axis).
5. Or make a cylinder secant to a cylinder (see the 3D Secant)
6. Or make a cylinder vertical. Its Direction of Axis then becomes parallel to the Z Axis (or Elevation Axis) but not

necessarily in the same direction.

Tip: All constraints can be selected from the pop-up menu.

14.5.4.8.3.1 Make Vertical

To make vertical:
1. Select a geometry.

2. Click the Make Vertical icon. The selected geometry is moved so that its Direction of Axis is parallel to the Z-Axis
of the Home frame.

14.5.4.8.3.2 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.
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Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.3.3 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.3.4 Pass an Axis Through a Point

To pass an axis through a point:

1. Click the Pass Axis Through Point icon. The 3D Point toolbar opens with the Pick Point mode set by default.
2. Define and validate a 3D point.

14.5.4.8.3.5 Lock a Radius

To lock a radius:

1. Click the Lock Radius icon. The 3D Radius toolbar opens as well as it information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

14.5.4.8.3.6 Fix to an Axis

To fix to an axis:
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1. Click on the Fix to Axis icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

14.5.4.8.3.7 Make Secant to a Cylinder

To make secant to a cylinder:

1. Click the Make Secant to Cylinder icon. The 3D Secant dialog as well as its information box appears.
2. Pick a cylinder.
3. If required, check Use Same Radius to set the same radius than the picked cylinder.
4. If required, check Use Given Angle and give a secant angle.
5. If required, click Perpendicular to have a 90° secant angle.
6. Click OK.

Entity used as constraint
Note that the Make Secant to Cylinder constraint type generates four sub-constraint types according to the option
(s) checked.
n If only Use Same Radius has been checked, you have the two following constraint types: Make Axis Secant to

Axis and Lock Radius.
n If only Use Given Angle has been checked and the given angle value is different to 90° and 270°, you have the

two following constraint types: Make Axis Secant to Axis and Lock Angle with Direction.
n If only Use Given Angle has been checked and the given angle value is equal to 90° and 270°, you have the two

following constraint types: Make Axis Secant to Axis and Make Perpendicular to Direction.
n If only Use Given Angle has been checked and Perpendicular pressed-on, you have the two following constraint

types: Make Axis Secant to Axis and Make Perpendicular to Direction.
n If the two options have been checked with an angle other than 90° or 270°, you have the three following con-

straint types: Make Axis Secant to Axis, Lock Radius and Lock Angle with Direction.
n If the two options have been checked with an angle equal to 90° or 270°, you have the three following constraint

types: Make Axis Secant to Axis, Lock Radius and Make Perpendicular to Direction.
n If the two options are kept unchecked, you have the Make Axis Secant to Axis constraint type.

14.5.4.8.4 Regular Cone

After selecting a cone-shaped geometry (before or after opening the tool), the Geometry Modifier toolbar becomes as
shown below. There are three constraint types.
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1 - Make Vertical
2 - Make Parallel

3 - Make Perpendicular
4 - Fit to an Axis

To apply a constraint to a cone:
1. Make a cone parallel/perpendicular to an entity/plane/direction (see the 3D Picking/3D Plane/3D Direction).
2. Or fit a cone axis (see the 3D Axis).
3. Or make a regular cone vertical. Its Direction of Axis then becomes parallel and in the same direction as the Z Axis

(or Elevation Axis).

Tip: All constraints can be selected from the pop-up menu.

14.5.4.8.4.1 Make Vertical

To make vertical:
1. Select a geometry.

2. Click the Make Vertical icon. The selected geometry is moved so that its Direction of Axis is parallel to the Z-Axis
of the Home frame.

14.5.4.8.4.2 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.4.3 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.
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Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.4.4 Fix to an Axis

To fix to an axis:
1. Click on the Fix to Axis icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

14.5.4.8.5 Circular Torus

After selecting a circular torus-shaped geometry (before or after opening the tool), the Geometry Modifier toolbar becomes
as shown below. There are seven constraint types.

1 - Make Parallel
2 - Lock Center Line Radius
3 - Lock Pipe Radius
4 - Align to Join to Existing Cylin-
der

5 - Make Perpendicular
6 - Fit to Axis
7 - Align to two Existing Secant Cylinders of Same
Radius

Tip: All constraints can be selected from the pop-up menu.

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.
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Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

To fix to an axis:
1. Click on the Fix to Axis icon. The 3D Axis toolbar opens.
2. Define and validate a 3D axis.

To lock a pipe radius:

1. Click the Lock Pipe Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

To lock a center line radius:

1. Click the Lock Center Line Radius icon. The 3D Radius toolbar opens as well as its information box.
2. Do one of the following:

n Pick a radial entity,
n Pick two points,
n Pick an axis and a point,
n Edit parameters.

3. Validate the radius.

To align to join to an existing cylinder:

1. Click the Align to Join to Existing Cylinder icon.
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2. Pick an existing cylinder.

To Align to Join to Two Secant Cylinders of Same Radius:
1. Click the Align to Join to Two Secant Cylinders of Same Radius icon.
2. Pick two existing cylinders. The result is null if the two picked cylinders are not secant or do not have the same dia-

meter.
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14.5.4.8.6 3D Point

After selecting a 3D point (before or after opening the tool), the Geometry Modifier toolbar becomes as shown below. There
are two constraint types.

1 - Lock on Plane 2 - Lock to Line or Axis

Tip: All constraints can be selected from the pop-up menu.

To lock on a plane:

1. Click the Lock on Plane icon. The 3D Plane toolbar opens with the Pick Entity with Direction mode is set by
default.

2. Define and validate a 3D plane.
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To lock on a line (or axis):

1. Click the Lock to Line (or Axis) icon. The 3D Axis toolbar opens with the Pick Axis Entity mode is set by default.
2. Define and validate a 3D direction.

14.5.4.8.7 Segment

After selecting a segment (before or after opening the tool), the Geometry Modifier toolbar becomes as shown below. There
are four constraint types.

1 - Make Vertical
2 - Lock on Plane
3 - Make Parallel

4 - Make Perpendicular
5 - Pass Axis Through Point

To apply a constraint to a segment:
1. Make a segment parallel/perpendicular to an entity/plane/direction (see the 3D Picking/3D Plane/3D Direction).
2. Or lock a segment on a plane (see the 3D Plane).
3. Or pass a segment through a point (see the 3D Point).
4. Or make a segment vertical. Its Direction of Axis then becomes parallel to the Z Axis (or Elevation Axis)).

Tip: All constraints can be selected from the pop-up menu.

14.5.4.8.7.1 Make Vertical

To make vertical:
1. Select a geometry.

2. Click the Make Vertical icon. The selected geometry is moved so that its Direction of Axis is parallel to the Z-Axis
of the Home frame.

14.5.4.8.7.2 Lock on a Plane

To lock on a plane:

1. Click the Lock on Plane icon. The 3D Plane toolbar opens with the Pick Entity with Direction mode is set by
default.

2. Define and validate a 3D plane.

14.5.4.8.7.3 Make Parallel

To make parallel:

1. Click the Make Parallel icon. The Make Parallel toolbar opens with three tabs (By Picking Entity, To Plane and To
Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.
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2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.7.4 Make Perpendicular

To make perpendicular:

1. Click the Make Perpendicular icon. The Make Perpendicular toolbar opens with three tabs (By Picking Entity, To
Plane and To Direction) inside.

Each tab corresponds to a tool (respectively 3D Picking, 3D Plane and 3D Direction). The By Picking Entity tab
opens first, its information box takes place at the top right corner of the 3D View and the Pick Entity with Direction
mode is set by default.

2. Do one of the following.
n Define a plane,
n Define a direction,
n Pick an entity with direction.

3. Validate the defined plane (or direction).

14.5.4.8.7.5 Pass an Axis Through a Point

To pass an axis through a point:

1. Click the Pass Axis Through Point icon. The 3D Point toolbar opens with the Pick Point mode set by default.
2. Define and validate a 3D point.

14.5.4.8.8 Extrusion

After selecting an extrusion (before or after opening the tool), the Geometry Modifier toolbar becomes as shown below.
There are two constraint types.

1 - Make Vertical
2 - Make Parallel to Direction

2 - Make Perpendicular to Plane

To apply constraint to an extruded entity:
1. Make an extruded entity parallel to a direction (see the 3D Direction).
2. Or make an extruded entity perpendicular to a plane (see the 3D Plane).
3. Or make an extruded entity vertical. Its Direction of Axis then becomes parallel to the Z Axis (or Elevation Axis)).

Tip: All constraints can be selected from the pop-up menu.

14.5.4.8.8.1 Make Vertical

To make vertical:
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1. Select a geometry.

2. Click the Make Vertical icon. The selected geometry is moved so that its Direction of Axis is parallel to the Z-Axis
of the Home frame.

14.5.4.8.8.2 Make Secant to an Extrusion

To make secant to an extrusion:
1. Select an Extrusion.
2. Click on the Make Secant to an Extrusion icon.
3. Pick another Extrusion.

14.5.4.8.9 Rectangular Torus

To apply constraints to a rectangular torus:
1. Select a rectangular torus. The Geometry Modifier toolbar becomes as shown below. There are three constraint

types (detailed below).

Align to Join to Two Existing Secant Boxes of Same Direction

2. Align to join two existing secant boxes of the same section.
3. Click Close. The Geometry Modifier toolbar closes on its own.

Tips:
n The Align to Join to Two Existing Secant Boxes of Same Direction constraint can also be selected from the pop-up

menu.
n Selecting a rectangular-torus-shaped geometry can be done before (or after) opening the Geometry Modifier tool.

14.5.4.8.9.1 Align to Join to Two Existing Secant Boxes of Same Section

To align to join to two existing secant boxes of same section:

1. Click the Align to Join to Two Existing Secant Boxes of Same Section icon. The cursor becomes as shown in [A].
2. Pick the first box. The cursor takes the shape shown in [B].

[A]

[B]
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3. Pick another box. If the two boxes are secant and have the same section, a rectangular torus appears.

n Its Direction of Normal (also called Direction of Axis) is parallel to the two boxes' Direction of Normal (also called
Direction of Width).

n Its Bend Angle is equal to the angle drawn by the two boxes' Direction of Height.
n Its Outer Diameter is equal to the two boxes' Depth.

4. If the two picked boxes are not secant; the "This constraint cannot be activated because the two boxes are not sec-
ant" warning message appears. Click OK. The warning message closes and the Align to Join to Two Existing
Secant Boxes of Same Section constraint is left.

5. If the two picked boxes do not have the same section, the "There is too much indetermination to activate this con-
straint: two boxes are identical, one of them is a cube or they have no common face" warning message appears.
Click OK. The warning message closes and the Align to Join to Two Existing Secant Boxes of Same Section con-
straint is left.

Tips:
n If required, make the two boxes secant using the Make Secant to a Box (With Same Section) constraint in the Geo-

metry Modifier tool.
n If required, modify manually the two boxes' parameters (like Center, Width, Height, Depth, Directions, etc.) in the

Property window to make sure that both are secant and have the same section.

14.5.4.8.10 Box

To apply constraints to a box:
1. Select a box. The Geometry Modifier toolbar becomes as shown below. There are three constraint types (detailed

below).

1 - Make Parallel
2 - Stick to Plane

3 - Change Main Axis
4 - Make Secant to Box (With Same Section)

Trimble RealWorks User Guide | 735



PRODUCTION TOOLS

2. Make parallel to a direction.
3. Or project a Box onto a Plane.
4. Or make secant to a Box of the same section.
5. Or change the main axis.
6. Click Close. The Geometry Modifier toolbar closes on its own.

Tip: All constraints can be selected from the pop-up menu.

Note: Selecting a box-shaped geometry can be done before (or after) opening the Geometry Modifier tool.

14.5.4.8.10.1 Making Parallel to a Direction

To make parallel to a direction:

1. Click Make Parallel . The Make Parallel toolbar opens with the By Picking Entity tab selected by-default. In that
tab, the Pick an Entity With Direction is set by-default.

2. Do one of the following:
n Pick an entity using the Pick an Entity With Direction tool in the By Picking Entity tab.
n Define a plane using available tools in the To a Plane tab*.
n Define a direction using available tools in the To a Direction tab*.

The Normal Z (also called the Direction of the Height in the Property window) of the box is parallel** to the Dir-
ection of Axis of the picked entity (or to the Direction of Normal of the defined plane or to the defined direction).

Notes:
n (*) First click on the corresponding tab.
n (**) But not necessarily in the same direction.

14.5.4.8.10.2 Project a Box in a Plane

To project a box in a plane:

1. Click the Stick to Plane icon. The cursor becomes as shown in [A].
2. Pick a plane. The selected box is projected on the picked plane [B]. The bottom side (of the box) lies on the plane.

[A]

[B]
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The Direction of Normal (of the plane) [C] and the Direction of the Height (also called the Normal Z* of the box) [D]
are parallel but not necessarily in the same direction. In the example below, both are opposite.
[C] [D]

Note: (*) In the X, Y, Z Coordinate System.

14.5.4.8.10.3 Making Secant to a Box (With Same Section)

To make secant to a box (with same section):

1. Click Make Secant to a Box (With Same Section) .
2. Pick a box having the same section as the selected one.
3. If the picked box does not have the same section, the "There is too much indetermination to activate this constraint:

two boxes are identical, one of them is a cube or they have no common face" warning message appears. Click OK.
The warning message closes and the Make Secant to a Box (With Same Section) constraint is left.

14.5.4.8.10.4 Change the Direction of the Main Axis

You can change the main axis' direction of a Box so that it becomes parallel to:
n The X-Axis of its (local) frame,
n The Y-Axis of its (local) frame,
n The Z-Axis of its (local) frame.

14.5.5 Plane Bounding

The Plane Bounding tool is dedicated to plane modifications. We mean by this you can modify an existing plane bounds,
define new ones, create holes, etc. This tool is based on polyline drawing and editing like the Polyline Drawing tool. It
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requires a selection as input data (mainly a plane from the database (already created)) when used alone as a main tool or is
based on local objects (not yet created in the database) when used as a sub-tool in e.g. the Cloud-Based Modeler tool.

14.5.5.1 Open the Tool

To open the tool:
1. Select a plane from the Project Tree.

2. Select Plane Bounding in Model > Edit. The Plane Bounding and Picking Parameters (in the 2D constraint pick-
ing mode) toolbars are displayed.

1 - Selection Mode
2 - Change Mode

3 - Draw Rectangle
4 - Draw Circle

5 - Select Polyline
6 - Close Tool

In the Examiner (or Walkthrough) mode, the 3D scene is locked in 2D in the selected plane and is brought to the
Top view with a 2D grid superimposed (if displayed previously). The Selection Mode and Change Mode are respect-
ively set in the deactivate and line state. The cursor is as shown below and the selected plane is displayed with its
bounds (a polyline of the same shape in dotted line and is of blue color).

1 - 2D Grid
2 - The selected plane

3 - The bounding polyline
4 - The cursor

In Station-Based mode, the 3D scene is viewed from the first station viewpoint (the first in the Project Tree) with
overlapped images in the background (if it existed).

3. Do one of the following:
n Modify the selected plane bounds,
n Select an existing polyline for bounding,
n Draw a new polyline for bounding.

Tip: You can also click on the Plane Bounding icon in the Tools toolbar.

14.5.5.2 Modify the Selected Plane Bounds

The selected plane is displayed with its bounds: a polyline of the selected plane’s shape in dotted line and of blue color. Edit-
ing the selected plane bounds is similar to editing a bounding polyline.
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To modify the selected plane bounds:
1. Edit a bounding polyline.
2. Delete a bounding polyline.
3. Move a bounding polyline.
4. Apply the bounds.
5. Validate the bounds.

14.5.5.3 Select an Existing Polyline for Bounding

If you have a closed polyline in your project; you can use it for bounding purposes. The polyline doesn't need to be selected
first but it needs to be displayed in the 3D View.

To select a polyline for bounding:

1. Click Select Polyline . The 3D scene becomes free from the 2D lock. The 2D Grid (if displayed) is hidden. The
Picking Parameters toolbar is hidden.

2. In the 3D View, pick a polyline.
n If the polyline is unclosed; an error message appears. Click OK to close the error message.
n If the polyline is closed; an editable polyline (in green) superimposes it. The 3D scene is locked again in 2D. The

2D Grid is displayed. The Picking Parameters toolbar (in 2D constraint mode) is displayed.
3. Do one of the following:

n Edit a bounding polyline.
n Move a bounding polyline.
n Delete a bounding polyline.
n Apply the bounds.

4. Validate the bounds.
Notes:

n Press Esc to leave the Select Polyline mode.
n Selecting another polyline will cancel the current one.

Tip: You can also choose Select Polyline from the pop-up menu.

14.5.5.4 Draw a New Polyline for Bounding

A bounding polyline can be composed of only segments or a combination of segments and circular arcs. It needs to be of
closed shape and all of its nodes have to be on the selected plane. You can only define one bounding polyline; this differs
from the Polyline Drawing tool where you can draw a set of polylines.

To draw a new polyline for bounding:
1. Do one of the following:

n Draw a polygonal polyline.
n Draw a rectangular polyline.
n Draw a circular polyline.

2. Edit a bounding polyline, if required.
3. Move a bounding polyline, if required.
4. Delete a bounding polyline, if required.
5. Apply the bounds.
6. Validate the bounds.

14.5.5.4.1 Draw a Polygonal Polyline

To draw a polygonal polyline:
1. Pick a point to start the first node of a polyline.
2. Pick another point. A segment links these two points.
3. Click on the Change Mode pull-down arrow.

4. Choose Change Mode to Arc .
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5. Pick another point. The newly picked point is linked to the previous picked point by an arc.
6. Click on the Change Mode pull-down arrow.
7. Choose Change Mode to Line .
8. Pick another point. The newly picked point is linked to the previous picked point by a segment.
9. Continue picking in order to define the other nodes of the polyline.
10. Right-click anywhere in the 3D View to display the pop-up menu.
11. Select Close Line to end and close the polyline. The start node is linked to the last selected node.

Notes:
n Double-click to end drawing. The polyline is closed.
n Picking can be free or constrained on displayed objects or not.

Tips:
n You can switch from the line drawing mode to the arc drawing mode and conversely as often as you wish by press-

ing respectively the L and C keys on your keyboard.
n Out of the picking mode, press Esc to quit the Plane Bounding tool. Or select Close Tool from the pop- up menu.

Note:What happens if you press Esc while you are picking points. If at least three points (for segments) (or two (for an arc))
have been picked, then the polygonal polyline will be closed and validated.

14.5.5.4.2 Draw a Rectangular Polyline

To draw a rectangular polyline:
1. Click on the Draw Rectangle pull-down arrow.
2. Choose between Draw Rectangle by Defining 2 Points and Draw Rectangle by Defining 3 Points .

n If Draw Rectangle by Defining 2 Points has been chosen:
a. Pick a point.
b. Pick another point. The segment, linking the new point to the previous one, defines a diagonal of a rectangle.

n If Draw Rectangle by Defining 3 Points has been chosen:
a. Pick a point.
b. Pick another point. The segment, linking the new point to the previous point, defines the first side of a rect-

angle.
c. Pick another point. The segment, linking the new point to the previous point, defines the second side of the

rectangle and is perpendicular to the first one.
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Note: Picking can be free or constrained on displayed objects or not.

Note:What happens if you press Esc while you are picking points. Nothing occurs. The rectangular polyline in progress is
then cancelled.

14.5.5.4.3 Draw a Circular Polyline

To draw a circular polyline:
1. Click on the Draw Circle pull-down arrow.
2. Choose between Draw Circle by Defining the Diameter and Draw Circle by Defining the Middle Point and the

Radius .
n If Draw Circle by Defining the Diameter has been chosen:

a. Pick a point.
b. Pick another point. The segment, linking the new point to the previous one, defines a diameter of a circle.

n If Draw Circle by Defining the Middle Point and the Radius has been chosen:
a. Pick a point. This point defines the center of a circle.
b. Pick another point. These two points form the radius of the circle.
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Note: Picking can be free or constrained on displayed objects or not.

Note:What happens if you press Esc while you are picking points. Nothing occurs. The circular polyline in progress is then
cancelled.

14.5.5.5 Edit a Bounding Polyline

You can edit the bounding polyline of a selected plane after opening the Plane Bounding tool, one selected using the Select
Polyline command or one defined using the drawing tools (Draw Rectangle, Draw Circle, etc.).

Editing means to change the bounding polyline shape by moving, deleting, inserting a node, deleting the whole bounding
polyline, etc. When you place the cursor over a segment of a polyline, you may see the following symbols: for nodes,
for middle nodes and for middle nodes to be inserted. When the cursor is over an arc of a polyline; only for nodes are
available.

14.5.5.5.1 Delete a Node

To delete a node:
1. Place the cursor over a node. A solid square appears over the node.
2. Right-click to display the pop-up menu and select Delete Node.
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n If the node is shared by two segments, the two segments will be deleted and replaced by a segment.

n If the node is shared by two arcs; the two arcs will be deleted and replaced by a segment.

Tip: You can press Del on your keyboard instead of selecting Delete Node from the pop-up menu.

Note: Nothing occurs if you delete a node that is along a segment.

14.5.5.5.2 Move a Node

To move a node:
1. Place the cursor over a node. A solid square appears on the node.
2. Drag and drop the node to a new location. The green square turns to yellow during this operation.
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n If the node at the end of two segments, the node will be moved and the two segments will be extended.

n If the node in the middle of a segment, the whole segment will be moved.

Tip: Picking a point anywhere on a segment except on the End and Middle nodes (or on an arc except on the End node) will
transform that point to a node.

14.5.5.5.3 Insert a Middle Node

To insert a middle node:
1. Place the cursor anywhere on a segment (except at the End and Middle nodes) or on an arc (except at the end

nodes). A hollow square appears on the segment at the cursor position.
2. Right-click to display the pop-up menu and select Insert Middle Node. A new Middle node is inserted not at the pick-

ing position but at the middle of the segment (or arc).
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14.5.5.6 Delete a Bounding Polyline

You can delete a bounding polyline when the drawing is in progress or after selecting one (using Select Polyline). You can-
not delete the bounding polyline of the selected plane.

To delete the current bounding polyline:
n Select Delete Polyline from the pop-up menu.

To delete all bounding polylines:

1. Click Select Polyline . The 3D scene becomes free from the 2D lock. The 2D Grid (if displayed) is hidden.
2. In the 3D View, pick a polyline.

3. Click Delete All Temporary .

14.5.5.7 Activate/Deactivate the Selection Mode

You need to activate the Selection Mode to be able to move a bounding polyline. The Selection Mode is applied to the last
drawn (or selected) bounding polyline if one has been drawn (or selected) or to the selected plane’s bounding polyline if any
has been drawn (or selected). A manipulator appears over the bounding polyline.

To activate/deactivate the selection mode:

1. Click Selection Mode to activate this mode.
2. Click again Selection Mode to deactivate this mode.

Tip: The Selection Mode icon can also be selected from the pop-up menu.

14.5.5.8 Move a Bounding Polyline

You can use Pan and Rotate for moving a bounding polyline within the selected plane.

Change Move Mode

To move a bounding polyline:
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1. Click on the Change Move Mode pull-down arrow.
2. Choose between Pan and Rotate.

n If Pan has been chosen, a distance manipulator is displayed. It has as origin the current bounding polyline’s cen-
ter.

n If Rotate has been chosen, a rotation manipulator is displayed. It has as origin the current bounding polyline’s
center.

3. Move the bounding polyline within the selected plane.

Tip: You can also select Pan (or Rotate) from the pop-up menu. Just first select Change Move Mode.

Note: After choosing Selection Mode, the Change Move Mode icon becomes enabled. The moving mode which comes first
is the last used one.

Tip: You can easily switch between Pan and Rotate, and vice versa, by just picking one of the Handles. Note that the cursor

changes to when you hover it over a Handle.

14.5.5.9 Apply the Bounds

In Set as External Curve, the bounding polyline previously defined is used as contouring bounds for the selected plane.
Only one bounding polyline can be set as an external curve at once. In Create Hole, the bounding polyline is used as excav-
ating bounds for the selected plane. This feature can be applied to several bounding polylines at once.

1 - Create Hole 2 - Set as External Curve

To apply bounds:
1. Define a bounding polyline as previously described.
2. Choose between Set as External Curve and Create Hole.
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1 - The defined bounding poly-
line

2 - External curve set 3 - Hole created

Tip: The Set as External Curve and Create Hole icons can also be selected from the pop-up menu.

14.5.5.10 Validate the Bounds

After applying bounds, the Set as External Curve, Create Hole and Delete All Temporary icons are grayed out and the Val-
idate Plane Modification becomes enabled as well as the Change Mode, Draw Rectangle and Draw Circle icons.

Validate Plane Modification

You can start drawing a new bounding polyline if required. Validating a modification will not create a new entity in the data-
base. You can see the number of created holes in the Property window (if opened).

Tips:
n You can also select Validate Plane Modification and Close Tool from the pop-up menu.
n For Close Tool, you can use its related short-cut key (Esc).

14.5.6 Intersect Entities

Intersecting an entity with another entity is similar to bounding the first with the second. Mainly entities of the following
shapes (circular torus, cone, cylinder, extruded geometry, plane and sphere) can be intersected. The first entity will be mod-
ified after the intersection and the second entity remains unchanged. Intersecting a series of entities together is similar to
bound together. All will be modified after intersecting. The Intersect tool can be used alone or inside main tools like the
Cloud-Based Modeler tool.
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14.5.6.1 Open the Tool

No selection is required to open the tool. Once inside the tool, a selection must be carried out. In [A], the Intersect tool
opens as a toolbar when there is no input. In [B], the tool opens with an input.

[A]

[B]

To open the tool:
1. Select an entity from the Project Tree if required.
2. Select Intersect in Model > Edit. The Intersect toolbar appears.

Tip: All commands can be selected from the pop-up menu.

Note:When picking geometries, only the geometries of the required types are considered, even if other geometries or point
clouds are displayed.

14.5.6.2 Extend to One Other Geometry

To extend to one other geometry:

1. Click the Extend to One Other Geometry icon.
2. Pick an entity in the 3D View.

n Some constraints may be observed when intersecting entities together. They are detailed hereafter.
n A warning appears if no intersection has been found.
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3. If required, click on the Switch to Other Side icon*.

Note: (*) For some entities, you are able to switch to the other side of the intersection. For others, this cannot be done as
the icon remains grayed out.

14.5.6.2.1 Cylinder

A Cylinder can only be intersected with:
n A Circular Torus of same radius, when it joins the Cylinder,
n A Cone of same radius,
n A Cylinder with secant and same radius.
n A Plane.
n A Sphere, when its center is on the Cylinder axis.

CYLINDER WITH CYLINDER:

When intersecting two Cylinders together; both Cylinders need to have secant axes and the same radius. If these pre-
requisites are not observed; open the Geometry Modifier tool and apply the Lock Radius and Make Perpendicular (or Make
Secant to Cylinder) constraints.

CYLINDER WITH SPHERE:

When intersecting a Cylinder with a Sphere (or vice versa); the Sphere’s center needs to be on the cylinder’s axis. If this pre-
requisite is not observed; open the Geometry Modifier tool and apply the constraint below:

n Lock Center on Line to the Sphere when intersecting it with the Cylinder,
n Pass Axis through Point to the Cylinder when intersecting it with the Sphere.

CYLINDER WITH CIRCULAR TORUS:

When intersecting a Cylinder with a Circular Torus (or vice versa); the Cylinder needs to have the same radius as the Cir-
cular Torus. If this prerequisite is not observed; open the Geometry Modifier tool and apply the Align to Join to Existing Cylin-
der constraint to the Torus.
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CYLINDER WITH CONE:

When intersecting a Cylinder with a Cone (or vice versa); both need to have the same axis. If this prerequisite is not
observed; open the Geometry Modifier tool and apply the constraint below:

n Make Parallel and Fit to Axis to the Cylinder when intersecting it with the Cone,
n Make Parallel and Fit to Axis to the Cone when intersecting it with the Cylinder.

14.5.6.2.2 Sphere

A Sphere can only be intersected with:
n A Cylinder, when the Sphere center is on its axis,
n A Plane parallel to the Sphere existing bound (if any).

14.5.6.2.3 Plane

A Plane can only be intersected with:
n A Circular Torus, when the Plane contains its axis.
n A Cone with a collinear axis,
n A Cylinder,
n An Extrusion with a collinear axis,
n A Plane,
n A Sphere, the Plane is parallel to its existing bound (if any).

PLANE WITH CIRCULAR TORUS:

When intersecting a Plane with a Circular Torus (or vice versa); the Plane needs to contain the Circular Torus axes. If this
prerequisite is not observed; open the Geometry Modifier tool and apply the constraint Pass Through Axis to the Plane.
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PLANE WITH EXTRUDED ENTITY:

When intersecting a Plane with an Extrusion (or vice versa); both need to have collinear axes. If this prerequisite is not
observed; open the Geometry Modifier tool and apply the constraint below:

n Make Parallel to Direction to the Extrusion when intersecting it with the Plane,
n Make Perpendicular to the Plane when intersecting it with the Extrusion.

PLANE WITH SPHERE:

When intersecting a Plane with a Sphere ((or vice versa); the Plane needs to be parallel to the Sphere existing bound. If this
prerequisite is not observed; open the Geometry Modifier tool and apply the constraint below:

n Pass Through Point to the Plane when intersecting it with the Sphere,
n Lock Center or Pass Through Point to the Sphere when intersecting it with the Plane.
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14.5.6.2.4 Cone

A Cone can only be intersected with:
n A Cone with the same axis,
n A Cylinder with the same axis,
n A Plane with a collinear axis.

CONE WITH CONE:

When intersecting two Cones together; both need to have the same axis. If this prerequisite is not observed; open the Geo-
metry Modifier tool and apply the Fit to Axis constraint.

CONE WITH PLANE:

When intersecting a Cone with a Plane (or vice versa); both need to have collinear axes. If this prerequisite is not observed;
open the Geometry Modifier tool and apply the Make Perpendicular constraint to either the Cone or the Plane.

14.5.6.2.5 Circular Torus

A Circular Torus can only be intersected with:
n A Cylinder of the same radius when the Circular Torus joins it.
n A Plane containing its axis.

14.5.6.2.6 Box

The intersection of a Box is always done along the Box main axis. A Box can only be intersected with:
n A Rectangular Torus of the same section,
n A Plane not passing through the Box center. The intersection can bevel the Box edges.
n A secant Box.

Trimble RealWorks User Guide | 752



PRODUCTION TOOLS

Tip: If required, use first the Change Main Axis constraint in the Geometry Modifier tool to change a Box main axis' dir-
ection.

14.5.6.2.7 Rectangular Torus

A Rectangular Torus can only be intersected with:
n A Box of the same section when the Rectangular Torus joins it,
n A Plane containing its axis.

14.5.6.2.8 Extrusion

An Extrusion can only be intersected with a Plane.

14.5.6.2.9 3D Point

A 3D Point cannot be intersected with any entity.

14.5.6.2.10 Line

A Line cannot be intersected with any entity.

14.5.6.3 Extend Between two Other Geometries

To extend between two other geometries:

1. Click the Extend Between Two Other Geometries icon.
2. Pick the first entity used to extend the selection in the 3D View.
3. Pick the second entity used to extend the selection in the 3D View.

n Some constraints may be observed when intersecting entities together. They are detailed hereafter.
n A warning appears if no intersection has been found.

4. If required, click on the Switch to Other Side icon*.

Caution: You cannot switch to the other side of an intersection when you extend an entity between two other ones.

14.5.6.3.1 Cylinder

A Cylinder can only be intersected with two entities of type:
n A Circular Torus of same radius, when they join the Cylinder,
n A Cone of same axis,
n A Cylinder with secant and same radius,
n A Plane.

14.5.6.3.2 Sphere

A Sphere can only be intersected with two Planes parallel to the Sphere existing bound (if any).

14.5.6.3.3 Plane

A Plane can only be intersected with two Planes.

14.5.6.3.4 Cone

A Cone can only be interested with two entities of type:
n Cone(s) with same axis,
n Cylinder(s) with same axis,
n Plane(s) with collinear axis.

14.5.6.3.5 Circular Torus

A Circular Torus can only be intersected with two Cylinders of same radius, when the Circular Torus joins them.

14.5.6.3.6 Box
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A Box can only be intersected with two entities of type:
n Rectangular Torus of the same section, when they join the Box.
n Plane.

14.5.6.3.7 Rectangular Torus

A Rectangular Torus can only be intersected with two Boxes of the same section, when the Rectangular Torus joins them.

14.5.6.3.8 Extrusion

An Extrusion can only be intersected with two Planes.

14.5.6.3.9 3D Point

A 3D Point cannot be intersected with any entities.

14.5.6.3.10 Line

A Line cannot be intersected with any entities.

14.5.6.4 Connect a Series of Entities

Use the "Connect to Geometry Sequence" feature to intersect a series of entities together. This is very useful for connecting
a series of pipes together.

To connect a series of entities:
1. Display the entities to intersect in the 3D View.
2. Click the Connect a Geometry Sequence icon. The cursor becomes as shown below.

3. Pick an entity. The cursor becomes as shown below.

4. Pick another entity and so on.

14.5.6.5 Connect a Series of Planes

You can also use the "Connect a Geometry Sequence" feature to intersect a plane with a series of planes.

To connect a series of planes:
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1. Display a series of planes in the 3D View.

2. Click the Connect Geometry Sequence icon.
3. Pick anywhere in the 3D View except on the displayed planes.
4. Press the Ctrl key. The cursor shape becomes as shown below.

5. Pick a plane to bound. It becomes selected.

6. Pick a series of planes which is going to be used as bounds.
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Caution: Planes used as bounds need to be picked in order in any direction (clockwise or anti-clockwise).

14.5.6.6 Connect Cylinders

The Link Cylinders feature enables two cylinders to connect together even if they are not secant or don’t have the same dia-
meter, by creating entity(ies) in between.

To connect two cylinders:

1. Click the icon.
2. Pick the first cylinder in the 3D View.
3. Pick the second cylinder in the 3DView.

For two cylinders, secant in axes and having the same diameter, a connected cylinder is created in between:

For two cylinders, not secant in axes and having the same diameter, a connected cylinder is created in between:

For two cylinders, not secant in axes and not having the same diameter, two connected cylinders and one regular
cone are created in between:
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For two cylinders, with aligned axes but not having the same diameter, a regular cone is created in between:

14.5.6.7 Switch to Other Side

The intersection of an entity with another entity is similar to bound the first with the second, in a given direction. The Switch
to Other Side feature changes this bounding direction to the opposite as illustrated below.
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14.5.7 Duplicate

The Duplicate tool enables to duplicate a geometry along (or around) a path defined by the user. A path can be a line, a
circle or a combination of both (called Polyline). This tool requires a selection as input. If the input is an object from the data-
base (already created), the tool can be used as a main tool. When the object is being created, the tool is a sub-tool inside a
main tool like the Geometry Creator tool.

14.5.7.1 Open the Tool

To open the tool:
1. Select a geometry from the Project Tree.
2. Select Duplicate in Model > Edit. The Duplicator dialog opens as the third tab of the WorkSpace window.

14.5.7.2 Choose a Method

There are three duplication methods: Along a Line, Around an Axis and Along a Polyline. Inside each method, you need to
define a path along (or around) which the duplication will be carried out. The method which comes first is the one set during
the last use of that tool.

To choose a method:
1. In the Choose Method panel, click on the pull-down arrow.
2. Choose among Along a Line, Around an Axis and Along a Polyline from the drop-down list.

Tip: All duplication methods can be selected from the pop-up menu. First select Choose Type of Path.

14.5.7.2.1 Define a Line
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Before defining a path, Step 2 of the Duplicator dialog takes the appearance shown below in [A]. After defining a path, the
Select Global Frame for Manipulator icon becomes enabled; it enables you to switch from a one-handle manipulator to a
three-handle manipulator (see [B]).
[A] [B]

1 - Draw Line by Defining Two Points
2 - 3D Direction

3 - Select Global Frame for Manipulator

To define a line:
1. Define a line by picking two points.
2. Or define a 3D direction.

Tip: The Select Global Frame for Manipulator can also be selected from the pop-up menu.

14.5.7.2.1.1 Draw a Line by Defining Two Points

The Draw Line by Defining Two Points icon (set by-default) enables to define a path of segment shape by picking two
points. The first point is always at the center of the selected item. The second point with the first point defines a path used
for duplication.

To define two points:

1. Click on the Draw Line by Defining Two Points icon. The Picking Parameters toolbar appears in 3D constraint
mode.

2. Pick a point (free or constrained) on displayed items. A Red Line linking the first picked point to the cursor appears.
This Red Line has a label in red showing the distance from the first picked point to the cursor’s current position.

3. Pick another point (free or constrained), always on displayed items.

1 - The selected item 2 - The second picked point
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1 - Manipulator 4 - Duplicated items

The distance between the two picked points sets the Step value (see Step 3 of the Duplicator dialog). The selected
item is duplicated according to the parameters set in Step 3 along the defined path. The last duplicated item has a
Manipulator and an End label at its center.

Tip: The Draw Line by Defining Two Points icon can also be selected from the pop-up menu.

14.5.7.2.1.2 Define a 3D Direction

The 3D Direction icon enables you to define a 3D direction.

To define a 3D direction:

1. Click on the 3D Direction Tool icon. The 3D Direction toolbar appears as well as its information box and a yellow
dotted direction.

2. Define a 3D direction and validate it.

1 - The selected item 2 - The defined direction
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3 - The one-handle manipulator 4 - The duplicated items

A Red Line starting from the selected item and running parallel to the defined 3D direction appears. The selected
item is duplicated according to the parameters set in Step 3 along the defined path. The last duplicated item has a
Manipulator and an End label at its center.

Tip: The 3D Direction can also be selected from the pop-up menu.

14.5.7.2.2 Define a Circle

After choosing Around an Axis, you need to indicate the displacement mode for duplication by checking either the All Par-
allel option or the All Rotated option. Step 2 of the Duplicator dialog becomes as shown below.

1 - Draw Circle by Defining its Center 2 - 3D Axis

To define a circle:
1. Draw a circle by defining its center.
2. Or define a 3D axis.

This Red Circle may have two shapes (dotted and/or continuous arc) with an arrow as duplication direction. The ini-
tial item is duplicated around that Red Circle according to the parameters in Step 3.
If All Parallel has been checked, all newly duplicated items have the same direction as the first one.
If All Rotated has been checked, each newly duplicated item has its own direction. The initial (selected) item still
remains selected and the last duplicated item has an End label at its center.

14.5.7.2.2.1 Draw a Circle by Defining its Center

The Draw Circle by Defining its Center icon (set by-default) enables to define a circular path by its circle. This circular path
has as Normal the direction perpendicular to screen view.

To draw a circle by defining its center:
1. If required, bring the scene to the Top view.
2. Click Draw Circle by Defining its Center . The Picking Parameters toolbar appears in the 3D constraint mode.

The cursor takes the shape shown below. A Red Circle in the screen plane appears. It has as Origin the cursor cur-
rent position and passes through the initial item's center.

3. Pick a point (free or constrained) anywhere - not necessary on displayed items.
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The selected item

1 - The two handle manipulator 2 - Duplicated items

Tip: The Draw Circle by Defining its Center can also be selected from the pop-up menu.

14.5.7.2.2.2 Define a 3D Axis

The 3D Axis icon enables to define an axis which will be used in the Normal direction of a circular path.

To define a 3D axis:

1. Click on the 3D Axis icon. The 3D Axis toolbar appears as well as the 3D Axis information box.
2. Define a 3D axis. A Red and Dotted Segment appears.
3. Validate the 3D axis. The Red and Dotted Segment disappears. A Red Circle appears with a Red and Green Manip-

ulator along and in the middle of the defined axis.
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1 - The selected item
2 - The defined direction

3 - Duplicated items
4 - Manipulator

Tip: The 3D Axis icon can also be selected from the pop-up menu.

14.5.7.2.3 Define a Polyline

Before selecting (or defining) a polyline, Step 2 of the Duplicator dialog takes the appearance shown in [A]. After selecting
(or defining) a polyline, Pick on the Wanted Position of the Start of the Path and Reload the Start to its Initial Value become
active (see [B]).
[A] [B]

1 - Select Polyline
2 - Create Polyline to Define Path

3 - Pick on the Wanted Position of the Start of
the Path
4 - Reload the Start to its Initial Value

To define a polyline:
1. Select an existing polyline.
2. Or create a new polyline.
3. Enter a value distance value in the Start field.
4. Or click Pick on the Wanted Position of the Start of the Path .
5. Go to the 3D View and pick a point on the selected/drawn polyline. The Start position changes on the path.
6. If required, get back the Start position by clicking Reload the Start Position.

The initial (selected) item is duplicated according to the parameters set in Step 3 along the defined path (in red).
Starting a new polyline selection (or a new polyline drawing) will undo the duplication. Duplicated items except the
initial (selected) one are removed from the 3D View.
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14.5.7.2.3.1 Select a Polyline

The Select Polyline icon enables you to select a path of segment (or a combination of segment and circular arc) shape -
mainly polyline - if present in your project.

To select a polyline:

1. Click Select Polyline . The cursor takes the shape as shown below.
2. Pick a polyline to select it.

1 - The selected item 2 - An existing polyline 3 - The duplicated items

A red path of the same shape as the polyline starting from the initial item’s center appears. The Start and End positions on
the path are indicated with a label. It’s up to you to change the Start position.

Tip: The Select Polyline icon can also be selected from the pop-up menu.

14.5.7.2.3.2 Creating a Polyline

The Create Polyline to Define Path icon enables you to draw and create a polyline.

To create a polyline:

1. Click Create Polyline to Define Path . The Drawing and Picking Parameters (in 3D constraint mode) toolbars
appear.

2. Draw a polyline by picking points (free or constrained).
3. Validate the polyline.
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1 - The selected item
2 - The first picked point
3 - The first second point

4 - The drawn polyline
5 - The duplicated items

A red path of the same shape as the polyline starting from the initial item’s center appears. The Start and End pos-
itions on the path are indicated with a label. It’s up to you to change the Start position.

Tip: The Create Polyline to Define Path icon can also be selected from the pop-up menu.

14.5.7.3 Resize a Path

You can use the Manipulator to resize the path previously defined. If the path is a Red Circle, the Manipulator has two Axis
Handles (Red and Green) and a Plane Handle. You can enlarge (or reduce) the Red Circle's diameter by displacing its cen-
ter in a direction using an Axis Handle or in an arbitrary position using the Plane Handle. For both, the displacement is done
on the Red Circle's plane.

If the path is a Red Line, the Manipulator has only one Axis Handle (Green). You can extend (or shorten) the Red Line
along the defined direction by using the Handle Axis. But you can also use the Select Global Frame for Manipulator which
has three Axis Handles (Green, Red and Blue) and three Plane Handles. In that case, you extend (or shorten) the Red Line
not along the defined path but along the direction indicated by the Axis Handle or on the plane defined by a pair of Axis
Handles. If the path is a Red Polyline, there is no Manipulator.

Note: If you start defining a new path; this cancels the current duplication. Duplicated items except the selected item are
removed from the 3D View.

14.5.7.4 Define Parameters

There are three sets of parameters available for duplicating items: Step & Quantity, Step & Length and Length & Quantity.
The Step parameter corresponds to the distance (or angle) between two successive items. The Length corresponds to the
distance (or angle) from the Start position to the End position.

To define parameters:
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1. In the Define Parameters panel, click on the pull-down arrow.
2. Choose among Step & Quantity, Step & Length and Length & Quantity.

14.5.7.4.1 "Step & Quantity" Parameters

After choosing Step & Quantity, Step 3 of the Duplicator dialog changes its appearance according to the duplication method
set in Step 1.
Along a Line (or Along a Polyline) Around an Axis

To define the Step & Quantity parameters:
1. Enter a number in the Quantity field.
2. Or use (or ) to set a value in the Quantity field.
3. If Along a Line (or Along a Polyline) has been selected, enter a distance value in the Step field.
4. If Around an Axis has been selected, enter an angular value in the Step field.
5. Or click Pick on the Wanted Position of the Next Element .
6. Go to the 3D View and pick a point on the path.

Note: The Length value is automatically updated according to the value set in the Quantity (or Step) field.

14.5.7.4.2 "Step & Length" Parameters

After choosing Step & Length, Step 4 of the Duplicator dialog changes its appearance according to the duplication method
selected in Step 1.
Along a Line (or Along a Polyline) Around an Axis

To define the Step & Length parameters:
1. If Along a Line / Along a Polyline (or Around an Axis) has been selected, enter a distance (or angular) value in the

Step field.
2. Or click Pick on the Wanted Position of the Next Element .
3. Go to the 3D View and pick a point on the path.
4. If Along a Line / Along a Polyline (or Around an Axis) has been selected, enter a distance (or angular) value in the

Step field.
5. Or click Pick on the Wanted Position of the End of the Path .
6. Go to the 3D View and pick a point on the path.
7. If required, click Reload the Path Length to its Initial Value .

Note: The Quantity value is automatically updated according to the value set in the Step (or Length) field.

14.5.7.4.3 Length & Quantity

After choosing Length & Quantity, Step 3 of the Duplicator dialog changes its appearance according to the duplication type
selected in Step 1.
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Along a Line (or Along a Polyline) Around an Axis

To define the Length & Quantity parameters:
1. Enter a number in the Quantity field.
2. Or use (or ) to set a value in the Quantity field.
3. If Along a Line (or Along a Polyline) has been selected, enter a distance value in the Length field.
4. If Around an Axis has been selected, enter an angular value in the Length field.
5. Or click Pick on the Wanted Position of the End of the Path .
6. Go to the 3D View and pick a point* on the path.
7. If required, click Reload the Path Length to Its Initial Value .

Notes:
n The Step value is automatically updated according to the value set in the Quantity (or Length) field.
n (*) To leave the picking mode, select Cancel Picking from the pop-up menu or use Esc. Outside the picking mode,

use Esc to leave the Duplicator tool.

14.5.7.5 Reverse the Path Direction

You can use Invert Path Direction to reverse the duplication direction. If Along a Line has been selected, the End position
will be moved at the opposite end along the path. If Around an Axis has been selected, the End position remains in the
same position but the duplication direction changes. If Along a Polyline has been selected, the Start and End positions are
inverted.

Tip: Invert Path Direction can also be selected from the pop-up menu.

14.5.7.6 Duplicate Items

After defining a path and setting parameters, you can create the duplicated items as persistent objects in the database. All
are gathered in a folder named Duplication which is put under the active group. Each duplicated item has the name set in
the Name Prefix field with an order.

If a name has been entered in the NamePrefix field, each duplicated item has the name set in the field with an order. If no
name has been entered in the field, each duplicated item is named as follows: Copy of "Selected_Entity_Name" with an
order between parentheses.

Note: You can duplicate as many items as required without leaving the Duplicator tool.

14.5.8 Auto-Extract Cylinders

The Auto-Extract Cylinders feature lets the user automatically extract cylinders and elbows in order to model pipelines, not
from a point cloud but from the point cloud information found in the TZF Scans. The extraction is applied to the whole pro-
ject.

To extract cylinders automatically:

1. Select Auto-Extract Cylinders in Model > Creation. The Automatic Cylinder Extraction dialog opens. The pre-
view of the first station is displayed in the dialog as shown below. If there are several TZF Scans within the station,
the preview of the Main TZF Scan is displayed.
If there is no valid TZF Scan in the project, an error message opens. If you select in the dialog a station with no valid
TZF Scan, an error message opens as well.

Trimble RealWorks User Guide | 767



PRODUCTION TOOLS

2. If required, choose a station (or a set of stations) for which you want to proceed to a cylinder extraction:
n Use "Select All" to select (CHECKED) all of the stations (or groups) from the tree,
n Use " Clear Selection" to deselect (UNCHECKED) all of the stations (or groups) from the tree,
n Use "Expand All' (or Expand) to expand all groups (or a unique group) from the tree,
n Use "Collapse All" (or Collapse) to collapse all groups (or a unique group) from the tree.

3. Input a value in the Min. Diameter field. The default value is 0.05 meter, you cannot input a value lower than 0.01
meter.

4. Input a value in the Max. Diameter field. The default value is 1 meter, you cannot input a value higher than 10
meters.

5. If required, apply some constraints to the cylinder fitting by checking one of the following option:
n Force Vertical Alignment: A cylinder direction is forced to the vertical when the angle drawn by its main axis and

the vertical direction is within the Tolerance range defined hereafter.
n Force Horizontal Alignment: A cylinder direction is forced to the horizontal when the angle drawn by its main axis

and the horizontal plane is within the Tolerance range defined hereafter.
n Ensure 90° Angles between Connected Cylinders: Two connected cylinders are perpendicularly forced to 90°

when the angle drawn by their main axes is in the Tolerance range defined hereafter.
n Input a value in the Tolerance field.
Note: The Tolerance field becomes enabled only if one of the three options is checked.

6. If required, use the Extract Cylinders Only (No Pipe Groups) option.
7. Click OK. The Automatic Cylinder Extraction closes.

Notes:
n If the number of selected TZF Scans is higher than 25, a dialog opens and prompts you to continue (or not). "Yes"

will lead to a long processing time and potential memory issues.
n If the number of selected TZF Scans is equal (or higher) than 100 and the amount of RAM lower than 8 GB, a dialog

opens and prompts you to continue (or not). "Yes" will lead to a long processing time and potential memory issues.
Note: You can abort the extraction in progress by pressing Esc.
At the end of the extraction, if:

n The Extract Cylinders Instead of Pipes option has been checked, only cylinders are extracted.
- A dialog pops up and prompts you to visually check the results and if required modify (or edit) them (see Geometry
Visual Check).
- A folder named "Extracted Cylinders" is created and rooted under the project node in the Models Tree, and all
extracted cylinders are put under that folder. A cylinder is named ObjectX where X is its order.
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n The Extract Cylinders Instead of Pipes option has been unchecked, cylinders and elbows are extracted as pipeline
objects (Pipe Group).
- A dialog displays to notify the number of extracted pipes and the total of extracted objects.
- Extracted cylinders and elbows belonging to the same sequence (pipeline) have the same color and they are sor-
ted by sequences from 1 and ending at 10 with a step of 1/2. A group is created for each extracted pipe.
- Isolated cylinders and elbows (not belonging to a sequence (pipeline)) are not kept. As a consequence, the
amount of extracted objects is less than when the option has been checked, but the extraction quality is higher.

Note: Trimble RealWorks internally uses a bend factor for extracting the elbows, i.e., the factor between the radius of
curvature and the nominal radius which should be in a range starting from 1 and ending a 10 with a step of 1/2.
Notes:

n A cylinder with a length lower 1.2 times its radius will not be extracted.
n A cylinder with an angular coverage of less than 70° will not be extracted.

14.5.9 Geometry Visual Check

The Geometry Visual Check feature lets the user to visually check, not only the cylinders that have been automatically
extracted from a TZF Scan (see Extract Cylinders Automatically) but also from other types of geometry like Plane, Circular
Torus, etc. created by using e.g. the Cloud Based Modeler tool. Each geometry can be visually checked alone (for the fitting
quality purpose) and among a set of geometries.

14.5.9.1 Open the Tool

To open the tool:
1. Select a geometry (or a set of geometries) from the Project Tree.

2. Select Geometry Visual Check in Model > Edit. The Geometry Visual Check dialog opens.

14.5.9.2 Check Visually a Geometry

The selected geometry (or the first from the selection set) displays centered in the 3D View, in yellow. If the input came from
an extraction, only its geometry displays. If the input came from a fitting, its geometry and cloud both display. You can
check the extraction (or fitting) quality of a geometry visually in the 3D View. Its main attributes (Axis, Length, Diameter,
etc.) are displayed in the information box at the top right corner of the 3D View.
To check the current Geometry:

1. Click Next (or Previous) to navigate through the list (of geometries).
2. Or press the Left (or Right) button on your keyboard.
3. Or click on the pull-down arrow and choose a geometry from the list.
4. If required use the Limit Box Views to visualize the current geometry from different views.

Note:With the Geometry Visual Check open, all the display commands (i.e. Display Geometry, Display Cloud, View Only
This, etc.), when applied to the selected geometry, displays either a warning message or an error message.
The current geometry is bounded by a limit box. The user can increase (or decrease) the area inside the limit box in order to
visually check the current geometry with the neighborhood geometries.
To increase / decrease the visible area surrounding the current Geometry:
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1. Click + to increase the size of the visible area surrounding the current geometry*.
2. Click - to decrease the size of the visible area surrounding the current geometry*.
3. If required, click the Show / Hide icon to display (or hide) all clouds and geometries outside the limit box.
4. If required, click the Hide Other Geometries icon to only display the current geometry. The other selected geo-

metries are hidden.
Tip: (*) You can press + (or -) on your keyboard.
Note: All commands can be selected from the pop-up menu.

14.5.9.3 Edit a Geometry

If the current geometry has not been properly extracted (or fitted), it can be deleted from the project, or modified, or refitted
(for only a fitted geometry).

To delete a Geometry:
n Click the Delete button. The current geometry is deleted and removed from the selection list in the dialog, and from

the Models tree. The next geometry (from the selection list) is displayed.

Tip: You can also select Delete from the pop-up menu, or use the Del key on your keyboard

To modify a Geometry:
n Click the Modify button. The Modify Geometry toolbar and the Limit Box Mode toolbar open. You can use the fea-

tures available in the Limit Box Mode and in the Modify Geometry tool to respectively increase the bounding area
around the current geometry and to modify it. The current geometry will be replaced by the modified one.

To fit a Geometry:
n Click the Fit button. The Cloud-Based Modeler dialog and the Segmentation toolbar both open. You can use the fea-

tures available in the Cloud-Based Modeler tool to fit a new geometry. The current geometry will be replaced by the
refitted one.

14.6 PLANT TOOLS

The Model tab, which includes all the modeling functions, also provides powerful tools for various tasks specifically related
to the power, process, plant and related environments. All are gathered in three groups: called Piping, SteelWorks and
Access.

Features related to the piping can be found in the Piping group.

Tools that bring you the benefits of streamlined workflow to the world of engineering are gathered in the SteelWorks group.

Tools for creating ladders, ladder cages, railing and stairs are gathered in the Access group.
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14.6.1 Create Pipe

The Create Pipe feature enables you to manually create a complete pipeline object from a point cloud. Each component of
the pipeline is connected to the previous ones by just clicking it in 3D and has alignment and dimensions automatically man-
aged by the tool. The result can be saved into the software database and exportable.

ACTIVATE THE TOOL: Before choosing Create Pipe in Model> Piping, select and display:
n A point cloud to create a complete pipeline object from it. is selected by default.
n Or a complete pipeline object (pipe group) to edit it. is selected by default.

START A RUN:This step consists in defining the first segment or selecting several pipeline objects (pipe group) to edit
them.

n Use to start a new run by picking two points in the point cloud. The result is a fitted cylinder, its extremities are
the two picked points. Its color:

- Green means a good fitting quality (low standard deviation).
- Red means a bad fitting quality (high standard deviation).
- Between Green and Red, means an intermediate fitting quality.

Notes:
- The fitted cylinder diameter is displayed in the Current Diameter field.
- You can also use the C shortcut key to select this mode .
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Note: The Cloud Transparency feature, which lets you visualize geometries without needing to hide the point cloud
that is in front of, should be automatically enabled. If not, enable it.

n Use to start a new run by picking a cylinder.

Note: You can also use the G shortcut key to select this mode .

BUILD A RUN: This step consists in defining the next segment(s). After defining the first segment of a pipe:
n Pipe Segment is automatically selected and enabled. Use it to define the next segment by picking a point on the

point cloud, either from the right side or left side of the first segment.

n Use Pipe Horizontal Tee to define a tee by picking a point on the point cloud perpendicular to the orthogonal
branch.
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n If required, click Change Active Extremity and pick an extremity of a pipeline to select it.

Pick a point on the point cloud to define the next segment.
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Note: You can also use the E shortcut key to select Change Active Extremity.

n Use Pipe Reducer to pick a point on the point cloud, not the reducer,

but on the pipe segment after the reducer:
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EDIT & CONNECT:
n Use Merge Pipe With Segment to merge a pipe with the current pipe. The two pipes should have adjacent

extremities.
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n Use Merge Pipe With Reducer to merge a reducer with the current pipe. The two pipes should have adjacent
extremities.

n Use Merge Pipe With Tee to a reducer with the current pipe. The two pipes should have adjacent extremities.
n Use Edit Pipe Diameter to change a pipe diameter. Pick a pipe to select it and enter a value to change its dia-

meter.
n Use Edit Elbow Radius to change the curvature ratio of an elbow (or of all the elbows of a pipe run). The

curvature ratio is defined as the pipe diameter (D) over the bend radius of curvature (Rc).

Trimble RealWorks User Guide | 776



PRODUCTION TOOLS

- Pick an elbow to edit its curvature ratio.
- Pick a pipe run to edit the curvature ratio of all elbows.

Use the slider to change the ratio, from 1 to 5, with a step of 0.5 to see the changes automatically applied.

Note: Sometimes, the maximum value for the ratio can be lower than 5; this occurs when the selected elbow(s) is
(are) not compatible with too high values.

n Select Split Pipe :

- Pick a pipe to split it into two small pieces. Two pipe groups will be created, one for each piece.
- Press the CTRL key. Keep the key pressed and pick a pipe as much as required to obtain the number of desired
pieces. A pipe group will be created for each piece.

n Select Delete Pipe Object :

- Pick to delete an element of a pipeline. If you select a cylinder, the non-cylinder neighbours will be deleted, if any.
- Press the CTRL key. Keep the key pressed and pick a pipe as much as required to delete the exact number of
items.

EXPLORE: Click Magnifier Mode to activate the mode (or use the N key). See Modifier Mode for Point Clouds.
n Pick a location in the 3D View to crop and zoom on an area of interest around the location. The default size of the

cropped area can be changed in the Preferences > Navigation.
n Optionally, use + and - keys to increase or decrease the size of the cropped area.

CREATION OPTIONS: Use one of the following options:
n Extract All Points When Creating Pipes - To model a pipe run, RealWorks does use only a small portion of the dis-

played points. To extract all points from the full project cloud to create a pipe run, enable the option. The process
can be a bit slow and depends on the point cloud and the pipe(s) to model.

n Snap to Common Elbow Angles - The angles of the elbows will be rounded off to standard values (5°, 15°, 22.5°,
30°, 45°, 60° and 90°).

CREATE: For each run of pipe, a pipe group is created, with fitted items inside:
n For a cylinder, a fitted cylinder is created .
n For an elbow, a fitted circular torus is created .
n For a tee, a fitted cylinder and a fitted sphere are created.
n For a reducer, a fitted regular cone is created.

Notes:
n A pipe group cannot be modified with the Modify Geometry tool, but it can be edited by using the Create Pipe tool.
n A pipe group can be deleted, but not the fitted items (whether geometry or cloud).

Tip: You can select and export a pipe group to the IFC format.

14.6.2 Convert Geometries to Pipe Group
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This feature enables to convert manually a set of pipe components (in old format) to the pipe object format.

To convert geometries to a pipe group:
1. Select a set of pipe elements (cylinders, circular torus (elbows) and cone (reducers)).

2. Choose Convert Geometries to Pipe Group in Model > Piping.
3. Enter a distance in the field.
4. Click Apply. A pipe group is created, containing the pipe elements parts.

Note: To avoid conversion errors, the following has to be observed:
n All geometries have to be linked with two others except the extremities which have only one neighbor.
n A geometry has to be not linked with a geometry of the same kind, meaning that cylinder-to-cylinder, elbow-to-

elbow, reducer-to-reducer, elbow-to-reducer links are not recommended.
n The extremities have to be close, and you can define this threshold. If the extremities are not exactly the same they

will be modified to be strictly the same.
n Though there cannot be missing parts. If the pipe starts or ends with a non cylinder element, a short cylinder (10

cm) will be added at the end of the pipe. In the case of a single non-cylinder element, two cylinders will be added on
each extremities.

Note: A pipe group cannot be modified with the Modify Geometry tool. It can be edited it by using the Create Pipe tool.

Tip: You can select and export a pipe group to the IFC format.

14.6.3 EasyPipe

The EasyPipe is very easy to use because you only need a few clicks to execute the following tasks: extract a pipe path
from more than one million points and model the extraction with geometric entitie(s) if needed. The procedure given here-
after guides you step-by-step through the use of this tool. For each command, you can use its short-cut key (if available);
this allows you to accelerate your work.

14.6.3.1 Open the Tool

Only an object having the point cloud representation can be selected as an entry for the EasyPipe tool.

To open the tool:
1. Select a point cloud* (or more**) from the Project Tree.
2. Select EasyPipe in Model > Piping. The EasyPipe dialog opens as the third tab of the WorkSpace window. We

will call the input Point Cloud a Cloud Data.
n If the Keep Displayed Objects Visible When Starting Segmentation option (in the Preferences dialog) is not

checked, all objects displayed in the 3D View are hidden except the one selected. All of the displayed objects
have their bulb icon turned to Off.

n If the option is checked, all objects displayed in the 3D View remain displayed. All displayed objects have their
bulb icon remained On, except the one selected.

Note: (*) If the selected point cloud is On before starting the tool, it automatically tilts to Off. We advise you to maintain it
Off.

Caution: (**) You can select several point clouds as input of the tool but one of them should not be the Project Cloud.

14.6.3.2 Select a New Cloud Data

The Set New Cloud Data is for swapping the default Cloud Data (not necessarily the one selected before starting the tool)
for another one. You cannot choose and set a subset of the default Cloud Data as the new Cloud Data; you need to choose
a different point cloud.

To select a new cloud data:
1. Select another point cloud from the Project Tree, and display it in the 3D View.

2. If required, hide the default Cloud Data by clicking the Hide Cloud icon.
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3. Click the Set New Cloud Data icon. The cursor becomes as shown below and the information box related to the
Segmentation tool disappears from the 3D View.

4. Pick a point on the selected point cloud. It becomes the new Cloud Data. The Segmentation information box
appears again with the new cloud data number of points.

1 - The initial Cloud Data
2 - The newly selected Point Cloud

3 - The cursor in the Set New Cloud Data
mode
4 - The new Cloud Data

Note: (*) The Hide Cloud icon becomes Display Cloud after clicking on it.

14.6.3.3 Define a Set of Points on the Cloud Data

Frequently, the Cloud Data contains many points; you need to decimate them before doing the fitting. You may also decide
to fit a geometry just on a part of it. To do these, you can use the Segmentation and the Sampling sub-tools.

After segmenting/sampling the Cloud Data, the Keep Only Displayed Cloud in Cloud Data and Delete Displayed Cloud from
Cloud Data icons (respectively for keeping/deleting points in/from the current Cloud Data (after decimation) and the Reload
Points icon become active.

To keep only the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Keep Only Displayed Cloud in Cloud Data icon. Points displayed in the 3D View inside are kept.

Trimble RealWorks User Guide | 779



PRODUCTION TOOLS

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are kept.

Tip:Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

To delete the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Delete Displayed Cloud from Cloud Data icon. Points displayed in the 3D View are unkept (removed
from the Cloud Data).

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are unkept.

Tip: Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

14.6.3.4 Extract an Initial Cylinder by Picking

To extract an initial cylinder by picking:
1. In Step 1, click the Extract Cylinder button. The cursor takes the appearance of a cross.
2. Pick a point on the displayed set of points. The cross becomes a ruler.
3. Move the cursor to any location. A circle appears. Its center is at the position of the picked point.
4. Pick another point (not necessary on the set of points).

A first cylinder is extracted from points inside the circle. The Start button in Step 2 becomes enabled. The Number
of Elements is equal to One.
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Note: An information box at the top right corner of the 3D View displays the first extracted cylinder parameters like its Dia-
meter, the Number of Points (used for fitting) and the Standard Deviation.

Tip: You can cancel the current cylinder and extract a new one by using the Start button again.

Caution: The first extracted cylinder will not be saved if you close the tool by pressing Esc. (or by selecting Close).

14.6.3.5 Select an Initial Cylinder for Tracking

If you already have a cylinder inline with a set of points for which you want to extract a set of cylinders; you can set it as the
first cylinder in the tracking process.

To select an initial cylinder for tracking:
1. First select a cylinder from the Project Tree.
2. Display the cylinder in the 3D View.
3. In Step 1, click the Pick a Cylinder button. The cursor becomes as shown below [A].
4. In the 3D View, pick a cylinder. The picked cylinder becomes the first cylinder. The Start button in Step 2 becomes

enabled. The Number of Elements is equal to One [B].
[A]

[B]
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Note: An information box at the top right corner of the 3D View window displays the information related to the picked cyl-
inder like its Diameter, Number of Points and Standard Deviation.

Tip: You can also select a point cloud and a cylinder as input of the tool. The selected cylinder will be automatically con-
sidered as the first cylinder, without picking.

14.6.3.6 Start Tracking Cylinders

The cylinder tracking will consist of building and propagating in both directions a series of consecutive constrained cyl-
inders (all based on the first cylinder and all ball-jointed at a pivot point). The tracking will stop on its own when the fitting
error between the current (last) cylinder and its points is too large or when the number of points in the immediate neigh-
borhood is insufficient to continue tracking.

To start tracking cylinders:
n In Step 2, click the Start button.
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Notes:
n The Start button takes the name of Pick to Continue.
n The Delete Elements, Smooth and Model buttons become enabled. The Number of Elements will be updated

according to the fitted cylinders.

14.6.3.7 Continue Tracking Cylinders

You can continue extracting cylinders along a line of points. You have to do this from the first (or from the last) extracted cyl-
inder.

To continue tracking cylinders:
1. Click the Pick to Continue button. If the fitting is too important; the extraction stops on its own and a dialog opens

and prompts to continue or to abort.
2. Click Yes to continue.
3. Click No to abort.

14.6.3.8 Delete the Extracted Cylinders

You can delete an alone (or a set of) extracted cylinder(s) which is not correctly fitted.

To delete the extracted cylinders:
1. Click the Delete Elements button. The mouse cursor becomes as shown below [A].
2. In the 3D View, pick an extracted cylinder. The picked cylinder and those that follow after are deleted [B].

[A]

[B]

Trimble RealWorks User Guide | 783



PRODUCTION TOOLS

Tip: You can undo a deletion by selecting Undo Delete Elements from the pop-up menu (or by using the following short-cut
Ctrl + Z).

Note: You cannot delete the first cylinder; the one used for tracking. The cursor will stay in the picking mode until a valid cyl-
inder will be selected.

14.6.3.9 Smooth the Extracted Cylinders

The stack of the extracted cylinders may be not aligned. You can then use the Smooth command. It allows you to align all
cylinder axes together. This is an interactive procedure. You can try as often as you want until you reach the result you
need; but applying too many the Smooth command consecutively may result in removing valid elbows or deviating cyl-
inders from the initial fitting.

Note: The Number of Elements will be updated once the extracted cylinders have been smoothed.

14.6.3.10 Model the Extracted Cylinders

The last step consists of merging the extracted cylinders, for which the axes can be aligned, into a long pipe. The extracted
cylinders for which the axes cannot be aligned are replaced with an elbow.

To model the extracted cylinders:
n In Step 3, click on the Model button.
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14.6.3.11 Create the Extracted Cylinders

Once you are satisfied with the tracking result, you can save it in the RealWorks database. A new folder named "Branch
(X)" is created and rooted under the current project. This folder contains all computed cylinders named "ObjectY". X and Y
are respectively the folder and cylinder order.

To create the extracted cylinders:
1. Click Create. You can still extract another pipe from remaining points. The EasyPipe dialog remains open.
2. Click Close. The EasyPipe dialog closes

Note: If the extracted cylinders have not been modeled; a list of cylinders will be created in RealWorks. If the modeling has
been applied, a mix of cylinders and circular torus will be created.

Tip: You can also select Close from the pop-up menu.

14.6.4 Export Pipe Center Lines

A Center Line is an imaginary line running through the center of a Pipe.

To export pipe center lines:
1. Select a lone (or a set of) fitted Pipe(s) from the Project Tree.

2. Select Export Pipe Center Lines in Model > Piping. The Save As dialog opens.
3. Navigate to the drive / folder where you want to store the file.
4. Keep the default name which is the project name.
5. Or input a new name in the File Name field.
6. Click on the File of Type pull down arrow.
7. Choose among Solids AutoCAD Files (*.dwg), Solids AutoCAD (*.dxf) and MicroStation Files (*.dgn).
8. Click Save.

Note: A unique format file will be exported regardless of the number of Pipes selected as input.

14.6.4.1 Export as a DWG Format File

AutoCAD's native file format, DWG, and to a lesser extent, its interchange file format, DXF, have become de facto stand-
ards for CAD data interoperability. From 1982 to 2007, Autodesk created versions of AutoCAD which wrote no less than 18
major variants of the DXF and DWG file formats. Here below are the numerous versions of AutoCAD.
Product Version
AutoCAD® 2010 v.u.24
AutoCAD® 2009 v.u.23.1.01
AutoCAD® 2008 v.u.22.1.01
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AutoCAD® 2007 v.u.21.1.01
AutoCAD® 2006 v.u.20.1.01
AutoCAD® 2005 v.u 19.1.01
AutoCAD® 2004 v.u 18.1.01
AutoCAD® 2002 v.u 16.1.01
AutoCAD® 2000 v.u 15.0.02
AutoCAD® Release 14 v.u 14.1.04
AutoCAD® Release 13 v.u 13.1.01

To export as a DWG format file:
1. In the Export as DWG File dialog, customize the option(s) below.

n Version: This option allows you to choose from the various versions of AutoCAD.
n Export Frame: A project may contain several coordinate frames. This option allows you to select which coordin-

ate frame you want to apply to the exported data.
n Unit: This option allows you to select the unit system you want to apply to the exported data.

2. Click Export. The Export as DWG File dialog closes.

14.6.4.2 Export as a DXF Format File

AutoCAD's native file format, DWG, and to a lesser extent, its interchange file format, DXF, have become de facto stand-
ards for CAD data interoperability. From 1982 to 2007, Autodesk created versions of AutoCAD which wrote no less than 18
major variants of the DXF and DWG file formats. Here below are the numerous versions of AutoCAD.
Product Version
AutoCAD® 2010 v.u.24
AutoCAD® 2009 v.u.23.1.01
AutoCAD® 2008 v.u.22.1.01
AutoCAD® 2007 v.u.21.1.01
AutoCAD® 2006 v.u.20.1.01
AutoCAD® 2005 v.u 19.1.01
AutoCAD® 2004 v.u 18.1.01
AutoCAD® 2002 v.u 16.1.01
AutoCAD® 2000 v.u 15.0.02
AutoCAD® Release 14 v.u 14.1.04
AutoCAD® Release 13 v.u 13.1.01

To export as a DXF format file:
1. In the Export as DXF File dialog, customize the option(s) below.

n Version: This option allows you to choose from the various versions of AutoCAD.
n Export Frame: A project may contain several coordinate frames. This option allows you to select which coordin-

ate frame you want to apply to the exported data.
n Unit: This option allows you to select the unit system you want to apply to the exported data.

2. Click Export. The Export as DXF File dialog closes.

14.6.4.3 Export as a DGN Format File

DGN for DesiGN is a file format of Bentley MicroStation®. Exporting to this format means exporting a selection from
RealWorks to the MicroStation® format. You can only export one project at a time. MicroStation® includes the notion of lay-
ers which can be used as a tool for organizing and gathering information about a drawing. These layers can be considered
as an electronic version of traditional layers. In addition to the layers, this format includes the notion of working units which
are the real-world units that you work with in drawing or creating your models in a DGN file. The working units are set as
Master Units (the largest units in common use in a design, such as meters) and fractional Sub Units (the smallest con-
venient unit to use, such as centimeters or millimeters). The Sub Units cannot be larger than Master Units.
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To export as DGN format file:
1. In the Export as DGN File dialog, customize the option(s) below.

n Layer: This option allows you to define a number of layers. One is set by default and the option is dimmed.
n Export Of: This option allows you to choose which type of object(s) you want to export: Selected Clouds and

Geometries, Selected Geometries and Selected Clouds. Selected Geometries is set by default and the option is
dimmed.

n Export Frame: A project may have several coordinate frames. This option allows you to select which coordinate
frame from the drop-down list you want to apply to the exported data.

n Master Unit: This option allows you to select a unit system to the Master unit.
n Sub Unit: This option allows you to select a unit system to the Sub unit.
n Positional Unit: This option allows you to enter a value for the Positional unit.

2. Click Export. The Export as DGN File dialog closes.

14.6.5 Change Pipe Diameter

You are able to change the diameter of one (or more) selected cylinder(s) and/or circular torus.

To change a pipe diameter:
1. Select a set of cylinders and/or circular torus from the Models Tree.

2. Select Change Pipe Diameter in Model > Piping. The Change Pipe Diameter dialog opens.
3. In the New Diameter Value field, input a new value.
4. Click Apply. The Change Pipe Diameter dialog closed. The new value is then applied to all selected cylinders and/or

circular torus

Note: For a circular torus, the pipe diameter cannot be larger than the center line diameter. If you input a value that leads to
such a case, an error message is then displayed.

1 - Center line diameter 2 - Pipe diameter

14.6.6 Import & Remove SteelWorks Catalogs

A SteelWorks Catalog provides parametric definition of all components in the required size ranges, ratings and types. You
can use it to create beams with constraints.

You can import a lone (or a set of) steelworks catalog(s) before starting the SteelWorks Creation tool (or within that tool).

To import a SteelWorks catalog:
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1. Select Import SteelWorks Catalog(s) in Model > SteelWorks. The Import Catalog dialog opens.
2. Navigate to the drive/folder where the SteelWorks catalog file is located in the Look In field.
3. Click on the SteelWorks catalog file to select it. Its name appears in the File Name field.
4. Click Open. The Import Catalog dialog closes.

Note: Importing a catalog file that is already imported will open a warning message.

Some catalog files may have been installed in X:\Program Files\Trimble\RealWorks 12.0\Tables\SteelWorks after installing
RealWorks. These catalog files are samples. If the user decides to not install these tables, he needs to first choose the
"Custom" option when installing RealWorks and then uncheck the "RealWorks Plant Tables" option in the Select Features
window.

You can delete all steelworks catalogs inside (or out of) the SteelWorks Creation tool. The Remove SteelWorks Catalog
List command will remain dimmed until a catalog file is first imported.

To remove the SteelWorks catalog list:
n Select Remove SteelWorks Catalog List in Model > SteelWorks.

14.6.7 SteelWorks Creator

This feature allows you to model structural steelworks. Standard and specific catalogs can be used within it.

14.6.7.1 Open the Tool

To open the tool:
1. Select a point cloud* (or several**) from the Project Tree.

2. Select SteelWorks Creator in Model > SteelWorks. The SteelWorks Creator dialog and the Drawing toolbar
open. We call the input point cloud a Cloud Data.
n If the Keep Displayed Objects Visible When Starting Segmentation option in the Preferences dialog is not

checked, all objects displayed in the 3D View are hidden except the one selected. All of the displayed objects
have their bulb icon turned to Off.

n If the option is checked, all objects displayed in the 3D View remain displayed. All displayed objects have their
bulb icon remained On, except the one selected.

Notes:
n The Picking Parameters toolbar appears in 3D constraint mode.
n (*) If the selected point cloud is On before starting the tool, it automatically swaps to Off. We advise you to maintain

it Off.

Caution: (**) You can select several point clouds as input of the tool but one of them should not be the Project Cloud.

14.6.7.2 Select a New Cloud Data

The Set New Cloud Data enables to change the default Cloud Data to another one. A subset of the default Cloud Data can-
not be set as the new Cloud Data; you need to choose a different point cloud.

To select a new cloud data:
1. Display some point clouds in the 3D View.
2. Click the Set New Cloud Data icon.
3. Pick a point cloud to set it as the new Cloud Data.

Tip: Select and display a point cloud. With the point cloud still selected, click Set New Cloud Data to set it as the new Cloud
Data.

14.6.7.3 Define a Set of Points on the Cloud Data

Frequently, the Cloud Data contains too many points. Use the Segmentation and Sampling sub-tools to decimate these
points, or isolate a part of the Cloud Data.
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After segmenting or sampling the Cloud Data, the Keep Only Displayed Cloud in Cloud Data and Delete Displayed Cloud
from Cloud Data icons (respectively for keeping/deleting points in/from the current Cloud Data (after decimation) and the
Reload Points icon become active.

To keep only the displayed cloud:
1. Fence on the Cloud Data.
2. Or sample the Cloud Data.

3. Click Keep Only Displayed Cloud in Cloud Data . Points displayed in the 3D View inside are kept.

Note:Reload Points will only reload points of the current Cloud Data after sampling or segmenting.

To delete the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Or sample the Cloud Data.

3. Click the Delete Displayed Cloud from Cloud Data icon. Points displayed in the 3D View are unkept (removed
from the Cloud Data).

Note:Reload Points will only reload points of the current Cloud Data after sampling or segmenting.

14.6.7.4 Import a SteelWorks Catalog

Some catalog files may have been installed in C:\Program Files\Trimble\RealWorks 12.0\Tables\SteelWorks after installing
RealWorks. These catalog files are sample files. To not install them, choose the "Custom" in the installation options and
uncheck the "RealWorks Plant Tables" option.

Click to import a catalog file. Such a file has ".spec" as extension.

Note:
- "None" displays in the Select Catalog field if there is no catalog file in your project.
- You can remove a catalog file from your project by selecting Remove SteelWorks Catalog List from the Model tab.

14.6.7.5 Manual Extraction Method

To manually extract a beam:
1. Check Manual Extraction.
2. Select a Section type: H Section, I Section, U Section, L Section and T Section.

Tip: For each type, you can use its related shortcut. Please, refer to the Shortcut Keys section for more information.
The Select Table and Select Model fields update to display the first Table and the first Model for the chosen Section.

3. Draw a 2D Section:
With the Drawing toolbar opened, pick to draw a 2D Section. Drawings are constrained by:
- The chosen Section.
- The chosen Table and Model.
Optionally, use:
- 3D Plane Tool to define a plane. Drawings are then done on the defined plane.
- Lock In 2D to lock the current view in 2D. Drawings are then done the locked plane

Trimble RealWorks User Guide | 789



PRODUCTION TOOLS

Optionally, use Selection Mode / Pan or Rotate to change the 2D Section position and orientation.

Once done, click . A temporary beam is created.

Note: TheWalkthrough navigation mode is forbidden. If you are in that mode, the navigation mode will switch to
Examiner after starting drawing.

4. If required, change the Model to fit the point cloud.

Note: If "No" has been chosen in Step 1, the drawn 2D Section is only constrained by the Section type.

14.6.7.6 Automatic Extraction Method
To automatically extract a beam:

1. Check Automatic Extraction.
2. If required, check Snap Axis to Active Frame. This will snap the main axis and secondary axes of the temporary

beam to the active frame axes, making them parallel to the active frame axes if they form an angle (with the active
frame axes) less than 10 degrees.

3. Click Extract.
- A temporary beam is extracted from the Cloud Data.
- And the software applies an Adjust fitting to the extracted beam. See Optimize the Fitting.
- The found model is displayed.

4. If required, change the found table.
5. If required, change the found model.

Note: If the Cloud Data has no normals, they will be computed during the Automatic Extraction and Adjust fitting. This leads
to an increase in the processing time of a factor two, or more when the Cloud Data contains too many points.
Note: A warning will appear if the Cloud Data has been badly cleaned up. Consider first cleaning it up prior to processing
the extraction.

14.6.7.7 Optimize the Fitting
To optimize the fitting:

1. Choose Constrained Adjust to refit the temporary beam with constraints. The temporary beam will be moved in a
plane perpendicular to its main axis, and rotated around that axis.

2. Or choose Adjust to refit the temporary beam with no constraints. The temporary beam will be moved in any dir-
ection to fit the Cloud Data.
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3. Adjust the length by:
- Using the manipulators.
- Entering a value in the Length field.

14.6.7.8 Create Beams

An extruded entity will be created in the RealWorks database. Each extruded entity has the name "ObjectX - Reference -
Catalog" where X is its order. X always starts at One. Reference will be replaced by the Selected Reference’s value and
Catalog by the Catalog’s name. If the "No" option has not been chosen; the extruded entity has the name " ObjectX -
SteelWorks".

14.6.8 Ladder

The Ladder is a tool that lets the users build a ladder based on a predefined model or on a model defined by the user.

14.6.8.1 Open the Tool
To open the tool:

1. Select a set of points from the Project Tree.
2. Select Ladder in Model > Access.

n The Ladder dialog opens as well as the Drawing toolbar.

Note: From here, when you press the Esc. key, this will close both the Drawing toolbar and the Ladder tool.

14.6.8.2 Select a New Cloud Data

The Set New Cloud Data is for swapping the default Cloud Data (not necessarily the one selected before starting the tool)
for another one. You cannot choose and set a subset of the default Cloud Data as the new Cloud Data; you need to choose
a different point cloud.

To select a new cloud data:
1. Select another point cloud from the Project Tree, and display it in the 3D View.

2. If required, hide the default Cloud Data by clicking the Hide Cloud icon.
3. Click the Set New Cloud Data icon. The cursor becomes as shown below and the information box related to the

Segmentation tool disappears from the 3D View.
4. Pick a point on the selected point cloud. It becomes the new Cloud Data. The Segmentation information box

appears again with the new cloud data number of points.
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1 - The initial Cloud Data
2 - The newly selected Point Cloud

3 - The cursor in the Set New Cloud Data
mode
4 - The new Cloud Data

Note: (*) The Hide Cloud icon becomes Display Cloud after clicking on it.

14.6.8.3 Define a Set of Points on the Cloud Data

Frequently, the Cloud Data contains many points; you need to decimate them before doing the fitting. You may also decide
to fit a geometry just on a part of it. To do these, you can use the Segmentation and the Sampling sub-tools.

After segmenting/sampling the Cloud Data, the Keep Only Displayed Cloud in Cloud Data and Delete Displayed Cloud from
Cloud Data icons (respectively for keeping/deleting points in/from the current Cloud Data (after decimation) and the Reload
Points icon become active.

To keep only the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Keep Only Displayed Cloud in Cloud Data icon. Points displayed in the 3D View inside are kept.

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are kept.
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Tip:Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

To delete the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Delete Displayed Cloud from Cloud Data icon. Points displayed in the 3D View are unkept (removed
from the Cloud Data).

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are unkept.

Tip: Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

14.6.8.4 Select a Ladder Model

To select a ladder model:
n If there are several models in your project, you can choose one by doing the following

1. Click the Ladder Model pull-down arrow.
2. And choose a model from the drop-down list.

There is a persistence in the chosen model, i.e., it will be kept until you change it to a new one.
n If there is only the STDMODEL, you can:

n Use the default STD Model. It comes with a set of predefined parameters; you can view them by clicking the Edit
button.

n Or customize a model by modifying each of the parameters, the Apply button, initially grayed-out, becomes
enabled, as well as the Save As button. The name of the chosen model changes to "Custom".

14.6.8.5 Edit Parameters

The illustration below shows in detail the parameters of a ladder.
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1 - Ladder, Width
2 - Rung, Depth
3 - Rung, Thickness

4 - Rung, Interval
5 - Rail, Depth
6 - Rail, Width

To edit parameters:
1. Click the Edit button. The Edit Parameters dialog opens.
2. Define the Width (1) of the ladder.
3. Click the Rail Section pull-down arrow.
4. Choose a shape for the Rail between Circular and Rectangular.
5. Define the parameters of the Rail by setting its:

n Depth (2) ,
n Thickness (3),
n and Interval (4),

6. Click the Rung Section pull-down arrow.
7. Choose a shape for the Rung between Circular and Rectangular.
8. Define the parameters of the Rung by setting its:
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n Depth (5),
n AndWidth (6).

9. Click the Apply button. The Edit Parameters dialog closes.

Note: You are not allowed to input either a negative or null value in each of the parameter fields.

Tip: You can use the Tab key to navigate through the parameter fields.

14.6.8.6 Create a New Ladder Model

To create a new ladder model:
1. Click the Edit button. The Edit Parameters dialog opens.
2. Define the parameters of the ladder to create.
3. Click the Save As button. The Save As dialog opens.
4. Enter a name in the NewMode Name field.
5. Click the Create button. The Edit Parameters dialog closes.

Note: The model created is not stored in the current project but in the Windows registry, so that when performing an update
of RealWorks, the model will be not lost.

14.6.8.7 Lock the Ladder Top View in 2D

To lock the ladder top view in 2D:
1. Rotate the ladder so that you can view it from its top, as illustrated below.
2. Lock the view in 2D by clicking the Lock In 2D icon in the Drawing toolbar.
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Or
3. Use the UCS Creation tool to create a new frame. Its Z axis must be aligned with one of the rails, as illustrated

below.

4. Select the created frame and display its top view by selecting Object Top .
5. If required, lock the view in 2D by clicking the Lock In 2D icon.
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14.6.8.8 Draw a 2D Section

To draw a 2D section:
1. Pick a point, ideally at the center of one of the Rungs. A 2D Section and a manipulator appear. The 3D scene is

locked in 2D, with the 2D Grid in superimposition (if not previously hidden).

2. If required, adjust the position of the 2D Section so that it matches the position of the ladder, by clicking the Change
Move Mode pull-down arrow and choose among Pan and Rotate.

Trimble RealWorks User Guide | 797



PRODUCTION TOOLS

n If Pan has been chosen, move the 2D section in the 2D locked plane.

n If Rotate has been chosen, rotate the 2D section in the 2D locked plane.

3. If required, click the New 2D Section icon to delete the current 2D section.
4. Once satisfied, click the Validate Polyline icon.

Note: If the Drawing toolbar is not open, click the Polyline Drawing icon.

Note: There is no way to close the Drawing toolbar except to first draw and validate a 2D section.

Note:When you press the Esc. key after defining a 2D section, this will delete the 2D section.

14.6.8.9 Define the Ladder Length and Start Height

To define the ladder length:
1. Enter a value in the Length field.
2. Enter a value in the Start Height field.
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Or
3. Adjust the Length of the ladder by using the manipulator (1).
4. Adjust the Start Height of the ladder by using the manipulator (2).
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Note: A negative or null value cannot be considered for the Length and Start Height parameters.

14.6.8.10 Create a Ladder

To create a ladder:
1. Click the Create button.
2. Click Close. The Ladder dialog closes.

n A group , named Ladder - Model's name, is created and rooted under the Project Tree.
n Under the group, the items below are also created:

n A cloud, which is not displayed in the 3D View window.
n Two boxes (or cylinders), named Rail 1 and Rail 2, which are displayed in the 3D View window.
n And a set of boxes (or cylinders), each named Rung XX where XX is its order, which are displayed in the 3D

View window.
After clicking Create, you are brought back to Step 1. You can start drawing another 2D Section and create a
new ladder without having to leave the tool. At the same time, the created ladder is by default selected and
set as a Model Group. You can change its layer or set it as a Non Model Group. To be able to do that, you
need to first leave the 2D Section drawing mode, and select Change Classification Layer or Set as Non
Model Group from the pop-up menu.

Note: The cloud displayed in the 3D View after clicking Create is not the cloud created within the ladder but the one selec-
ted as input of the tool. By this way, you can continue on fitting other ladders.

14.6.9 Ladder Cage

This tool is dedicated to the creation of ladder cages, which may have several shapes: Circular, Horseshoe, etc.

14.6.9.1 Open the Tool
To open the tool:
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1. Select a ladder group (created previously with the Ladder tool) from the Project Tree.

2. Select Ladder Cage in Model > Access.
n The Ladder Cage dialog opens.
n All the items of the selected ladder, except the cloud, are hidden in the 3D View window.
n A preview of a ladder cage with a 3D plane is displayed in the 3D View. The ladder cage is obtained by fitting the

displayed cloud. In order to have a good fitting in models and in direction, we advise you to properly clean the
cloud that represents the ladder cage with the Segmentation (and/or Sampling) tool by removing undesirable
points (and/or to reduce the cloud in size).

Note: From here, when you press the Esc. key, this opens a dialog prompting you to create the ladder cage or not before
closing the tool.

Note:When you use the Segmentation (or Sampling) tool, a dialog opens asking you to keep (or not) the preview of the lad-
der cage.

14.6.9.2 Define Hoops

To define hoops:
1. Input a distance in the From field�.
2. Or pick a point on the displayed point cloud.
3. Input a distance in the To field�.
4. Or pick a point on the displayed point cloud.
5. Input a distance in the Interval field�.
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6. If required, add some extra hoops.

14.6.9.3 Add Additional Hoops

To add additional hoops:

1. Click the Pick to Add Hoop(s) icon.
2. Pick a point on the displayed cloud in the 3D View.
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14.6.9.4 Edit the Active Hoop

The active hoop is the one that is highlighted in the 3D View, and whose number is displayed in the dialog. The default act-
ive hoop is the first one.

14.6.9.4.1 Set a Hoop as Active

To set a hoop as active:
1. Input a number in the Edit Hoops field.
2. Or choose Select New Active Hoop from the pop-up menu and pick a hoop in the 3D View.
3. Or click the Display Next Hoop button to set the next hoop as active.
4. Or click the Display Last Hoop button to set the last hoop as active.
5. Or click the Display Previous Hoop button to set the previous as active.
6. Or click the Display First Hoop button to set the first hoop as active.

Note: The shape of the chosen hoop is displayed in the Shape field.

14.6.9.4.2 Delete the Active Hoop

To delete a hoop:
n Click the Delete button. The active hoop is then deleted.

Warning: In case you delete the active hoop which is not the first one, the next active hoop is not the one that comes after
the one that has been deleted but the first one.

Note: The number of hoops in Step 1 is updated consequently.

Note: You can undo the deletion by selecting .

Caution: You cannot delete several hoops at once. The Delete icon is grayed out in that case.

14.6.9.4.3 Choose the Shape of the Active Hoop

To choose the shape of the active hoop:
1. Click on the Shape pull-down arrow.
2. Choose a shape among Circular, Horseshoe, U Shape or User-Defined.

14.6.9.4.4 Change the Radius and Dimension Parameters

To change the radius and dimension parameters
1. Input a distance in the Radius field�.
2. Input a distance in the Dimension field�.

Trimble RealWorks User Guide | 803



PRODUCTION TOOLS

Note: The values in the Radius and Dimension fields are persistence. They remain unchanged until you change them. To
preserve the shape of the chosen hoop, the value in the Dimension field should be higher than the value in the Radius field.
If you input a value that is lower, the value won't be taken into account.

14.6.9.4.5 Define the Shape of the Active Hoop

To define the shape of the active hoop:
1. Click on the Shape pull-down arrow.
2. Choose the User-Defined option. The New Shape toolbar opens.

3. Pick an extrusion.

a. Click the Pick Extrusion icon.
b. Pick an entity.

Or
4. Draw a polyline:

a. Click the Polyline Drawing icon. The Drawing toolbar opens. The 3D View is locked in 2D, with the 2D Grid (if
not previously hidden).

b. Draw a polyline and validate by choosing Close Tool, from the toolbar or from the pop-up menu. A dialog opens
and prompts you to either create the drawn polyline or not.

5. Click the Create icon.
6. Click Close.

Note: You are not able to change the intrinsic parameters of a user-defined hoop. The Radius field in Step 2 is dimmed.
Only the Dimension field is enabled.

When you change the value in the Dimension field, its shape does not lengthen or shorten as for the predefined shapes.
You will only see the hoop(s) moving as well as the 3D plane.

14.6.9.5 Edit Several Hoops

You can select all hoops at once by using the Ctrl + A key combination, or select Select All from the pop-up menu, or select
separately several hoops by picking them in the 3D View while keeping the Ctrl key pressed. No number will be displayed
then in Step 2, as illustrated.

You can apply any transformation you applied to a unique hoop, like changing its shape, radius, etc. except deleting several
of them or deleting them all. To deselect all the selected hoops, do the following:

n Enter a number to set a single hoop as active.
n Click the Display Last Hoop (or Display First Hoop) icon.
n Pick a hoop in the 3D View.

14.6.9.6 Define the Vertical Straps

To define the vertical straps:

Trimble RealWorks User Guide | 804



PRODUCTION TOOLS

1. Leave the Inner Strap option unchecked to set all the straps out of the hoops (1).
2. Or check the Inner Strap option to set all the straps inside of the hoops (2).

3. Define the number of straps by selecting a number among 3, 5 and 7.
4. Or define your own number of straps by checking the User-Defined Configuration option.
5. Define the Width (3).
6. Define the Thickness (4).

14.6.9.6.1 Configure the Number of Straps

To configure the number of straps:

1. Click the User-Defined Configuration icon. The Edit Strap Configuration dialog opens.
2. Input a number in the Strap Number field.

n The first strap is always at the center (1),
n The second strap is at the left of the first one (2),
n The third strap is at the right of the first one, oppositely to the second one (3),
n And so one.

3. And input an angle in the Angle Between Straps field (4).
4. Click Apply. The Edit Strap Configuration dialog closes.

14.6.9.7 Create Ladder Cages

To create ladder cages:
1. Click the Create button.
2. Click Close. The Ladders dialog closes.
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n A group , named Ladder Cage Group, is created and rooted under the Project Tree.
n Under the group, the items below are also created:

n A set of Hoops, named Hoopx,
n And a set of Straps, each named Strapx.

14.6.10 Railing

The Railing is a tool that lets the users build a railing based on a predefined model or on a model defined by the user.

14.6.10.1 Open the Tool
To open the tool:

1. Select a set of points from the Project Tree.

2. Select Railing in Model > Access.

14.6.10.2 Select a New Cloud Data

The Set New Cloud Data is for swapping the default Cloud Data (not necessarily the one selected before starting the tool)
for another one. You cannot choose and set a subset of the default Cloud Data as the new Cloud Data; you need to choose
a different point cloud.

To select a new cloud data:
1. Select another point cloud from the Project Tree, and display it in the 3D View.

2. If required, hide the default Cloud Data by clicking the Hide Cloud icon.
3. Click the Set New Cloud Data icon. The cursor becomes as shown below and the information box related to the

Segmentation tool disappears from the 3D View.
4. Pick a point on the selected point cloud. It becomes the new Cloud Data. The Segmentation information box

appears again with the new cloud data number of points.
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1 - The initial Cloud Data
2 - The newly selected Point Cloud

3 - The cursor in the Set New Cloud Data
mode
4 - The new Cloud Data

Note: (*) The Hide Cloud icon becomes Display Cloud after clicking on it.

14.6.10.3 Define a Set of Points on the Cloud Data

Frequently, the Cloud Data contains many points; you need to decimate them before doing the fitting. You may also decide
to fit a geometry just on a part of it. To do these, you can use the Segmentation and the Sampling sub-tools.

After segmenting or sampling the Cloud Data, the Keep Only Displayed Cloud in Cloud Data and Delete Displayed Cloud
from Cloud Data icons (respectively for keeping or deleting points in or from the current Cloud Data (after decimation) and
the Reload Points icon become active.

To keep only the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Keep Only Displayed Cloud in Cloud Data icon. Points displayed in the 3D View inside are kept.

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are kept.
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Tip:Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

To delete the displayed cloud:
1. Draw a fence on the Cloud Data.
2. Use the In (or Out )* icon to keep points inside (or outside) the fence.
3. Or sample the Cloud Data.

4. Click the Delete Displayed Cloud from Cloud Data icon. Points displayed in the 3D View are unkept (removed
from the Cloud Data).

Notes:
n The Reload Points icon is only for reloading points of the current Cloud Data after sampling or segmenting.
n (*) You can skip the step of keeping In (or Out). In that case, points inside the fence are unkept.

Tip: Outside the segmentation mode, you can select the Segmentation tool from the pop-up menu or use its related short-
cut key (S).

14.6.10.4 Select a Path

If there is at least one path (polyline) in the loaded project. You can select it for creating railings. In that case, the selected
point cloud and the current path (polyline), the one listed in the selection box, with its projection (if existing) in the XY plane
are displayed in the 3D View.

To select a path:
1. In the Railing Creator dialog, click the pull down arrow.
2. Select a path (polyline) from the drop down list.
3. Or draw a path by using the Polyline Drawing tool.

n If the Horizontal Path option has been checked, the railings will be computed from the projection of the path on
the XY plane.

n If the 3D Path option has been checked, the railings will be computed perpendicularly from the path in 3D (not
projected in the XY plane).

n The Vertical Offset (1) is the distance which separates the selected (or drawn) path (polyline in green (2)) and
the polyline along which the railings will be generated (polyline in red (3)). This value is by default equal to zero.

4. Enter a value in the Vertical Offset field.

Note: The selected path (polyline) has to be regular (one chain with at least three points).

14.6.10.5 Draw a Path

If any path (polyline) exists in your project, the combo box is grayed out. You have to create at least one in the database. In
that case, only the selected scene (point cloud or mesh) is shown in the 3D View. The scene is constrained in the XY plane
of the active coordinate frame and movements while picking points are restricted to the navigation movements. You can
rotate the complete scene around the Z axis, zoom (in or out) along this same axis and pan in the XY plane.
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To draw a path:

1. Click the Draw and Create Path in Database icon. The Drawing toolbar appears. The scene is locked in a 2D
plane in the Top view with a 2D grid superimposed (if not hidden previously). The Picking Parameters toolbar
appears in the 2D constraint mode. The mouse cursor changes to a pencil.

2. Pick at least two points (free or constrained).
3. Click End Line. The last picked point ends the line.
4. Or click Close Line. The start and end picked points are linked with a segment in order to form a closed line.
5. Click Create. The drawn line is saved and created in the database as a polyline.

Note: If the 2D Grid has been hidden in a previous case, it will also be hidden when you activate the Polyline Drawing tool.

14.6.10.6 Select a Model

To select a model:
1. Click on the Model pull-down arrow.
2. Choose a model from the drop-down list.
3. Or if there is no model, edit the parameters.

14.6.10.7 Edit Parameters

To edit the parameters:
1. Click the Parameters button. The Edit Parameters dialog opens.
2. Perform the steps below:

a. Choose a configuration.
b. Edit the heights.
c. Edit the heights.
d. Define the loop end.

3. Click Apply. The Edit Parameters dialog closes.

14.6.10.7.1 Configuration

To choose a configuration:
1. Click on the Configuration pull-down arrow.
2. Choose a configuration from the drop-down list.

n Top Rail Only.

n 2 Rails (Top + Middle Rail).
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n 2 Rails and Toeboard.

n 3 Rails (Top + Middle + Lower).

n 3 Rails and Toeboard.

14.6.10.7.2 Profiles
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To edit the profiles:
1. Click on the Posts�pull-down arrow.
2. Choose between Rect. and Circ.

n If Circ. has been chosen, define the diameter of the circle.
n If Rect. has been chosen, define the length of the sides.

3. Click on the Top Rail�pull-down arrow.
4. Choose between Rect. and Circ.

n If Circ. has been chosen, define the diameter of the circle.
n If Rect. has been chosen, define the length of the sides.

5. Click on the Sub-Rail(s)�pull-down arrow.
6. Choose between Rect. and Circ.

n If Circ. has been chosen, define the diameter of the circle.
n If Rect. has been chosen, define the length of the sides, and choose where to place them:

n Rec. Axial�.
n Rec. Left‘.
n Rec. Right’.

7. Click on the Toeboard�pull-down arrow.
8. Choose among Rec. Axial, Rec. Left and Rec. Right.
9. Define the length of the sides

Note: The procedure explained in this section is about the 3 Rails and Toeboard configuration. Please, enter the para-
meters corresponding to the chosen configuration.

14.6.10.7.3 Heights

To edit the profiles:
1. Input a distance value in the Total Height� field.
2. Input a distance value in the Spacing 1� field.
3. Input a distance value in the Spacing 2� field.
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4. Input a distance value in the Toeboard Clearance� field.

Note: The procedure explained in this section is about the 3 Rails and Toeboard configuration. Please, enter the para-
meters corresponding to the chosen configuration.

14.6.10.7.4 Loop End (Dimension) & End Type

To edit the loop end (dimension) and end type:
1. Input a distance value in the Loop End (Dimension)� field.

2. Click on the End Type pull-down arrow.
3. Choose a type from the drop-down list.

n Straight.

n Vertical.
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n Straight Loop (to Sub-Rail 1).

n n Straight Loop (to Sub-Rail 2).

14.6.10.8 Define Posts Along the Path

To define posts along the path:

1. Define the Start and End positions.
2. Or pick the Start and End positions.
3. Input a distance value in the Interval (1) field.
4. Input a distance value in the Corner Post Offset (2) field.

The Corner Post Offset is the distance from either side of a corner.
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5. If required, add extra posts.
6. Or remove undesirable posts.

14.6.10.8.1 Define the Start and End Positions

To define the Start and End positions:
1. Enter a distance value in the Start field, and press Enter.
2. Enter a distance value in the End field, and press Enter.
3. Click the Reload Initial Start Position On Path icon (if required).
4. Click the Reload Initial End Position On Path icon (if required).

14.6.10.8.2 Pick the Start and End Positions

To pick the Start and End positions:

1. Click the Pick Start Position On Path icon. The mouse cursor shape changes to a pointer.
2. Pick a point along the path (polyline). The picked point becomes the Start point.
3. Repeat the two above steps for the End position.
4. Click the Reload Initial Start Position On Path icon (if required).
5. Click the Reload Initial End Position On Path icon (if required).

14.6.10.8.3 Add Extra Posts

To add extra posts:

1. Click the Pick to Add Post(s) icon.
2. In the 3D View, pick a position along the path. A new post is added along the path, at the picked position.

14.6.10.8.4 Remove Undesirable Posts

To remove undesirable posts:

1. Click the Delete icon.
2. In the 3D View, pick a post. The picked post is removed from the path.

14.6.10.9 Create a New Model

To create a new railing model:
1. Click the Parameters button. The Edit Parameters dialog opens.
2. Define the parameters of the railing to create.
3. Click the Save As button. The Save Model Parameters dialog opens.
4. Enter a name in the NewMode Name field.
5. Click the Create button. The Model Parameters dialog closes.

14.6.10.10 Create the Railings

To create the railings:
1. Click the Create button.
2. Click Close. The Railing Creator dialog closes.

n A group , named Railing Group - Model's name, is created and rooted under the Project Tree.
n Under the group, the items below are also created:

n A cloud,
n A set of Cylinders, each is named Post.

14.6.11 Stairs

The Stairs is a tool that lets the users build stairs based on a predefined model or on a model defined by the user.
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14.6.11.1 Open the Tool
To open the tool:

1. Select a set of points from the Project Tree.

2. Select Stairs in Model > Access. The Stairs dialog opens.

Note: From here, when you press the Esc. key, this will close the Stairs tool.

14.6.11.2 Select a Stair Model

To select a stair model:
n f there are several models in your project, you can choose one by doing the following

1. Click the Stair Model pull-down arrow.
2. And choose a model from the drop-down list.

There is a persistence in the chosen model, i.e., it will be kept until you change it to a new one.
n If there is only the STDMODEL, you can:

n Use the default STD Model. It comes with a set of predefined parameters; you can view them by clicking the Edit
button.

n Or customize a model by modifying each of the parameters, the Apply button, initially grayed-out, becomes
enabled, as well as the Save As button. The name of the chosen model changes to "Custom".

14.6.11.3 Edit Parameters

The illustrations below show in detail the parameters of a stair.

1 - Run (Depth) 3 - Thickness
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2 - Rise (Height) 4 - Nosing

5 - Stringer, Width
6 - Stinger, Depth

7 - Axis Offset (+/-)
8 - Overall Width

To edit the stair parameters:
1. Click the Edit button. The Edit Parameters dialog opens.
2. Define the Run (Width) (1) of the stairs.
3. Define the Rise (Height) (2) of the stairs.
4. Define the Thickness (3) of the stair tread.
5. Define the Nosing (4) of the stair tread.
6. Define the Width (5) of the stringer.
7. Define the Depth (6) of the stringer.
8. Define the Axis Offset (+/-) (7) along the Z-Axis of the stringer.
9. If required, check the Force Overall Width.
10. And input a value in the Overall Width field.
11. Click the Apply button. The Edit Parameters dialog closes.

Note: You are not allowed to input either a negative or null value in each of the parameter fields, except for the Axis Offset.

Tip: You can use the Tab key to navigate through the parameter fields.

14.6.11.4 Create a New Model

To create a new model:
1. Click the Edit button. The Edit Parameters dialog opens.
2. Define the parameters of the stairs to create.
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3. Click the Save As button. The Save As dialog opens.
4. Enter a name in the NewMode Name field.
5. Click the Create button. The Edit Parameters dialog closes.

Note: The model created is not stored in the current project but in the Windows registry, so that when performing an update
of RealWorks, the model will be not lost.

14.6.11.5 Define the Landings

To define the landings:

1. Bring the view to Front .
2. Click the Pick Bottom Landing Position icon.
3. In the 3D View, pick a point on the displayed cloud.

The position picked by the user is labeled Bottom, and its height along the Z axis (of the current frame) is displayed
in the Bottom field.

4. Click the Pick Top Landing Position icon.
5. In the 3D View, pick a point on the displayed cloud.

The position picked by the user is labeled Top, and its height along the Z axis (of the current frame) is displayed in
the Top field.

Note: The Top value needs to be higher than the Bottom value. If you pick a point whose height is below the height of the
bottom point, this point won't be considered.

Tip: The Bottom and Top fields are editable after picking the bottom and top landing positions.

14.6.11.6 Draw a 2D Section

To draw a 2D section:

1. Click the Draw Frame to Positions New Stairs icon. The Drawing toolbar appears. The scene is locked in a 2D
plane in the Top view with a 2D grid superimposed (if not hidden previously). The Picking Parameters toolbar
appears in the 2D constraint mode. The mouse cursor changes to a pencil.

2. Pick two (or three) points (free or constrained) to define a rectangular frame.
3. If required, resize the rectangular frame in length and in width by dragging and dropping a middle node.
4. Click Validate. The Drawing toolbar closes.

A stair built based on the parameters of the selected mode appears. A manipulator located at the bottom of the stair
lets you move it in two directions.

Note:When you press the Esc. key after defining a 2D section, this will delete the 2D section.

Note: You are able to edit the defined frame in length and width. When you try to edit a node in order to change the shape
of the frame, it won't change.

14.6.11.7 Create Stairs

To create stairs:
1. Click the Create button.
2. Click Close. The Stairs dialog closes.

n A group , named Stairs - Model's name, is created and rooted under the Project Tree.
n Under the group, the items below are also created:

n A cloud, which is not displayed in the 3D View window.
n A set of Boxes, each is named Stair Tread, and all are displayed in the 3D View window.
n Two Boxes, each is named Stringer, and both are displayed in the 3D View window.

Note: You can create as many stairs as needed without having to leave the tool.
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Note: The cloud displayed in the 3D View after clicking Create is not the cloud created within the stairs but the one selected
as input of the tool. By this way, you can continue fitting the other stairs.

14.6.12 Auto-Segment Steel Beams

In order to accelerate the modeling of beams, the Auto-Segment Steel Beams allows you to automate the process of
extracting structural beam points from a point cloud.
Select the feature either in:

n Model > SteelWorks.
n Edit > Cloud.

The requirement to use the feature is to select a point cloud (or a set of point clouds) as input(s). Only point cloud(s) which
have been extracted from TZF Scans can be processed.

After launching the feature, a dialog appears and warns you about:
n The hardware that is used, either CPU or GPU. The program checks for your graphic card compatibility: NVIDIA®

GPU with CUDA® compatibility, and 4 GB of VRAM. If your graphic card is compatible with the requirements, your
GPU is used. If your graphic card is not compatible with the requirements, your CPU is used instead.

n The input(s) are either point clouds or associated TZF format files. If the selected point cloud is empty, or if it has not
been extracted from a TZF Scan, an error message pops up and the process is not launched. If the selected point
cloud has been extracted from a TZF Scan, the link to the TZF format file is missing, a warning message pops up
and the process is not launched.

If all requirements are met, you can proceed to the extraction by clicking Ok or abort it by clicking Cancel.

After the processing has completed, a point cloud of Beam type is created per selected point cloud. This new point cloud is
named according to the selected point cloud name with "Beam" as suffix. The number of points in the selected point cloud
is diminished from the amount of points in the created point cloud.

14.6.13 Auto-Segment Moving Objects

The Auto-Segment Moving Objects enables to automate the process of isolating noisy points generated by moving objects
(specifically pedestrians and cars) during a scan acquisition. The feature can be selected from the Edit tab, in the Cloud
group.

The requirement to use the feature is to select a point cloud (or a set of point clouds) as input(s). Only point cloud(s) which
have been extracted from TZF Scans can be processed.

After launching the feature, a dialog appears and warns you about:
n The hardware that is used, either CPU or GPU. The program checks for your graphic card compatibility: NVIDIA®

GPU with CUDA® compatibility, and 4 GB of VRAM. If your graphic card is compatible with the requirements, your
GPU is used. If your graphic card is not compatible with the requirements, your CPU is used instead.

n The input(s) are either point clouds or associated TZF format files. If the selected point cloud is empty, or if it has not
been extracted from a TZF Scan, an error message pops up and the process is not launched. If the selected point
cloud has been extracted from a TZF Scan, the link to the TZF format file is missing, a warning message pops up
and the process is not launched.

If all requirements are met, you can proceed to the extraction by clicking Ok or abort it by clicking Cancel.

After the processing has completed, a point cloud of Moving Objects type is created per selected point cloud. This new
point cloud is named according to the selected point cloud name with "Beam" as suffix. The number of points in the selec-
ted point cloud is diminished from the amount of points in the created point cloud.

14.7 STORAGE TANK TOOLS

Traditional methods for calibrating storage tanks employ complex, labor-intensive techniques to achieve the required stand-
ardized results. The Storage Tank module in RealWorks, is a set of tools, when used in combination with a Trimble 3D
Scanning system, enables to achieve the same standardized results with optimal accuracy, and less effort.
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The Storage Tank module is present in all RealWorks products except in the Viewer and Starter. Core and Performance
contain only Vertical Tank Calibration. Storage Tank contains all (Vertical Tank Calibration, Horizontal Tank Calibration,
Tank Setup, Vertical Tank Inspection, Tank Secondary Containment and Table Location tools).

The set of tools can be reached by selecting Storage Tank > Tank Object / Tank Inspection / Tank Calibration.

14.7.1 Vertical Tank Calibration

The Vertical Tank Calibration tool is a feature which enables to accurately determine the capacity (or partial capacities) of a
vertical storage tank and expresses this capacity as a volume at given linear increments or height of liquid.

14.7.1.1 Open the Tool

To open the tool:
1. Select a point cloud (or a fitted mesh) from the Project Tree.

2. Select Vertical Tank Calibration in Storage Tank > Tank Calibration.

1 - Point cloud
2 - Bottom plane

3 - Top plane
4 - Bounding box
5 - Cross section center line

n The Vertical Tank Calibration dialog opens as the third tab of the WorkSpace window. It is composed of several
parts.

n If the input is a point cloud, you can clean it by removing parasite points (or reduce its size by simplifying it). If the
input is a fitted mesh, only a point cloud is displayed.

n By default, two planes and a cross-section center line are displayed.

14.7.1.2 Define the Dipping Plate
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A Dipping Plate, also known by the name of Datum Plate is a level plate which defines the separation between the Sump
part and the Body part in a vertical tank. Its Height can be picked in the 3D View or a value that the user has to enter, if
known by the user. A Dipping Plate can also be defined by fitting a set of points.

1 - Dipping plate
2 - Sump

3 - Thickness of the tank
4 - Body

Caution: The Dipping Plate must be below the maximum level height of the Body. If you enter a value (or pick a height) that
does not meet this requirement, an error dialog opens.

To input the height value of a dipping plate:
1. Enter a height value in the Dipping Plate Height field.
2. Press Enter.

To pick the height of a dipping plate:

1. In the VerticalTank Calibration dialog, click the Segmentation icon. The Segmentation toolbar opens. The two ini-
tial planes and the cross section center line disappear.

2. Switch to the Station-Based mode. By this way, the tank is then visualized from its interior. This will help you to
locate the Dipping Plate easily. Please note this is only available in case the scan data has been acquired from the
interior of the tank.

3. Navigate within the set of points to visually locate where the Dipping Plate is.
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4. Isolate the Dipping Plate from the whole set of points by fencing.
5. If required, switch back to the Examiner mode.

6. Bring the view to Front, by selecting from the 3D View / Standard Views menu.
7. If required, remove unwanted points from the Dipping Plate, by fencing.
8. Close the Segmentation toolbar by clicking Close Tool . The two initial planes and the cross section center line

appear.
9. Click the Pick Dipping Plate icon. The two initial planes and the cross section center line disappear again.
10. In the 3D View, pick a point on the Dipping Plate. The two initial planes and the cross section center line reappear

again and the Bottom Plane is then set to that point.

11. If required, reload the initial points that make up the tank by clicking the Reload Points icon (within the Vertical
Tank Calibration).

To determine the height of a dipping plate by fitting:

1. In the VerticalTank Calibration dialog, click the Fit Dipping Plate icon. The Fitting toolbar opens. The two initial
planes and the cross section center line disappear.

2. Switch to the Station-Based mode. By this way, the tank is then visualized from its interior. This will help you to
locate the Dipping Plate easily. Please note this is only available in case the scan data has been acquired from the
interior of the tank.

3. Navigate within the set of points to visually locate where the Dipping Plate is.
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4. Isolate the Dipping Plate from the whole set of points by fencing.
5. If required, switch back to the Examiner mode.

6. Bring the view to Front, by selecting from the 3D View / Standard Views menu.
7. If required, remove unwanted points from the Dipping Plate, by fencing.
8. Click the Horizontal Plane icon. The fenced points are fitted with a blue horizontal plane.

9. Close the Fitting toolbar by clicking Close Tool . The two initial planes and the cross section center line appear
again. The Bottom Plane is then set to the position of the fitted plane.

10. If required, reload the initial points that make up the tank by clicking the Reload Points icon (within the Vertical
Tank Calibration tool).

14.7.1.3 Define the Parameters of the Body

A Body is the part of a vertical tank above its Dipping Plate, from which Sections will be computed. Its Maximum Height
from the Dipping Plate can be either picked in the 3D View or entered by the user if known.

To input a value:
n Enter a height value in the Maximum Level Height field.

To pick a height:

1. Click on the Pick Maximum Level icon.

2. If required, bring the view to Front .
3. Pick a point on the set of points in the 3D View.

An Interval is the distance between two consecutive Sections. It needs to be at least 5 mm.
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To define the interval between two consecutive sections:
1. Enter a distance value in the Interval field.
2. Or use the Up (or Down ) button to set a value.

Note: If the input value is lower than 5 millimeters, an error dialog opens.

14.7.1.4 Define the Parameters of the Sump

A Sump is the part of a tank below its Dipping Plate, from which a Volume will be computed. The computation is based on a
2D grid projection. The projection plane by default is a plane passing through the Dipping Plate. The Resolution is square,
the same in both of the default projection plane directions (Length andWidth). It needs to be at least 10 mm.

To define the parameters of the sump:
1. Enter a value in the Resolution field.
2. Or use the Up and Down buttons to select a value.

Note: If the input value is lower than 10 millimeters, an error dialog opens.

14.7.1.5 Define the Thickness for Outside Scans

You are able to compute the inner Volume and Sections of a tank even if the tank has been scanned, not from the inside,
but from the outside. You have to enter a value that corresponds to the thickness of its wall.

To define the thickness for outside scans:
1. Enter a value in the Thickness field.
2. Or use the Up and Down buttons to select a value.

14.7.1.6 Preview the Results

You can now generate and visualize the Sections and the Volume of the Sump obtained from the set of points (before cre-
ating them in the database).

To preview the results:
1. Click the Preview button.

n In the Vertical Tank Calibration dialog, the Display Sump and Display Sections options become enabled. By
default, the two Geometry options are checked.

n In the 3D View, the Sump's Volume is represented by a graph of vertical color lines and the Sections are rep-
resented by a set of closed and fitted (with points) Polylines. The information box, in the upper right corner, dis-
plays in text the values of the Sump Volume, Body Volume and Full Volume.

2. If required, check the Cloud options to display the point cloud in the 3D View.
3. If required, uncheck the Geometry options to hide the computed Volume and Sections in the 3D View.
4. Visually check the Sump Volume data to ensure that the entire area has been taken into account for the volume cal-

culation. If you detect "holes" in the Sump Volume display, choose a different resolution setting. Reiterate this step
until you achieve a satisfactory result.
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1 - A set of point cloud slides
2 - The Volume of the Sump

3 - A set of Sections

14.7.1.7 Create the Results
Once you are satisfied with the results, you can save them in the database.

To create the results:
1. Click Create.
2. Click Close.

A group named Tank-Interval "Interval value" is created and rooted under the Models Tree. All computed Sections
and Volume are put under that group. A Section is a Fitted Polyline and is named Section-TankX-Alt "Altitude
Value" where X is its order in three digits, or more. A Volume is named: Sump-Dipping Plate "Height value".
If the Dipping Plate has been defined by fitting a set of points with a plane, a Fitted Plane object named "Dipping
Plate" is created and put under the Tank-Interval folder.

Tip: You can leave the Vertical Tank Calibration tool by pressing Esc or by selecting Close from the pop-up menu.
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Note: You can create as many sets of Sections and Volume as required without having to leave the tool. If you decide to
leave this tool without saving the results, a message appears and prompts you to confirm, undo or cancel the process.

14.7.1.8 Export the Results

The results can also be exported into a TXT format file. There are two columns of information inside the file. The first
column contains all Section Heights (above the Dipping Plate). The second column lists the Area information at each Sec-
tion level. The first line displays the Sump value.

To export the results:
1. Click Export. The Save As dialog opens.
2. Enter a name in the File Name field.
3. Find a location in your disk in the Look In field.
4. Click Save. The Save As dialog closes.

Note: If the Storage Tank Application option has been chosen during the installation of RealWorks, two files are installed in
X:\Program Files\Trimble\RealWorks12.0\Tables\Tank. The Excel sheet is a sample template that allows the importing of
cross section data (from the above mentioned TXT file) generated by the Vertical Tank Calibration tool. Formulas allow the
user to apply compensations and to then create capacity tables. TheWord format file contains detailed instructions for
importing and processing the cross section data.

Warning: You must export the results before closing the Vertical Tank Calibration tool, otherwise they will be lost.

14.7.2 Horizontal Tank Calibration

The Horizontal Tank Calibration tool is a feature which enables to accurately determine the capacity (or partial capacities)
of a horizontal storage tank and expresses this capacity as a volume at given linear increments or height of liquid.

14.7.2.1 Open the Tool

To open the tool:
1. Select a point cloud (or a fitted mesh) from the Project Tree.
2. Select Horizontal Tank Calibration in Storage Tank > Tank Calibration.

n The Horizontal TankCalibration dialog opens as the third tab of the WorkSpace window. It is composed of sev-
eral parts.
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n If the input is a point cloud, you can clean it by removing parasite points (or reduce its size by simplifying it). If the
input is a fitted mesh, only a point cloud is displayed.

n By default, two planes and a cross-section center line are displayed.

14.7.2.2 Define the Dipping Plate

A Dipping Plate, also known by the name of Datum Plate is a level plate which defines the separation between the Sump
part and the Body part in a horizontal tank. Its Height can be picked in the 3D View or a value that the user has to enter, if
known by the user.

To input the height value of a dipping plate:
1. Enter a height value in the Dipping Plate Height field.
2. Press Enter.

To pick the height of a dipping plate:

1. In the HorizontalTank Calibration dialog, click the Segmentation icon. The Segmentation toolbar opens. The two
initial planes and the cross section center line disappear.

2. Switch to the Station-Based mode. By this way, the tank is then visualized from its interior. This will help you to
locate the Dipping Plate easily. Please note this is only available in case the scan data has been acquired from the
interior of the tank.

3. Navigate within the set of points to visually locate where the Dipping Plate is.
4. Isolate the Dipping Plate from the whole set of points by fencing.
5. If required, switch back to the Examiner mode.

6. Bring the view to Front, by selecting from the 3D View / Standard Views menu.
7. If required, remove unwanted points from the Dipping Plate, by fencing.
8. Close the Segmentation toolbar by clicking Close Tool . The two initial planes and the cross section center line

appear.
9. Click the Pick Dipping Plate icon. The two initial planes and the cross section center line disappear again.
10. In the 3D View, pick a point on the Dipping Plate. The two initial planes and the cross section center line reappear

again and the Bottom Plane is then set to that point.
11. If required, reload the initial points that make up the tank by clicking the Reload Points icon (within the Vertical

Tank Calibration tool).

To determine the height of a dipping plate by fitting:

1. In the HorizontalTank Calibration dialog, click the Fit Dipping Plate icon. The Fitting toolbar opens. The two ini-
tial planes and the cross section center line disappear.

2. Switch to the Station-Based mode. By this way, the tank is then visualized from its interior. This will help you to
locate the Dipping Plate easily. Please note this is only available in case the scan data has been acquired from the
interior of the tank.

3. Navigate within the set of points to visually locate where the Dipping Plate is.
4. Isolate the Dipping Plate from the whole set of points by fencing.
5. If required, switch back to the Examiner mode.

6. Bring the view to Front, by selecting from the 3D View / Standard Views menu.
7. If required, remove unwanted points from the Dipping Plate, by fencing.
8. Click the Horizontal Plane icon. The fenced points are fitted with a blue vertical plane.
9. Close the Fitting toolbar by clicking Close Tool . The two initial planes and the cross-section center line appear

again. The Bottom Plane is then set to the position of the fitted plane.
10. If required, reload the initial points that make up the tank by clicking the Reload Points icon (within the Vertical

Tank Calibration tool).
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14.7.2.3 Define the Body Parameters

A Body is the part of a horizontal tank above its Dipping Plate, from which some Sections will be computed. Its Maximum
Height from the Dipping Plate can be either picked in the 3D View or entered by the user if known.

To input a value:
n Enter a height value in the Maximum Level Height field.

To pick a height:

1. Click on the Pick Maximum Level icon.

2. If required, bring the view to Front .
3. Pick a point on the set of points in the 3D View.

An Interval is the distance between two consecutive Sections. It needs to be at least 5 mm.

To define the interval between two consecutive sections:
1. Enter a distance value in the Interval field.
2. Or use the Up (or Down ) button to set a value.

Note: If the input value is lower than 5 millimeters, an error dialog opens.

14.7.2.4 Define the Parameters of the Sump

A Sump is the part of a tank below its Dipping Plate, from which a Volume will be computed. The computation is based on a
2D grid projection. The projection plane by default is a plane passing through the Dipping Plate. The Resolution is square,
the same in both of the default projection plane directions (Length andWidth). It needs to be at least 10 mm.

To define the parameters of the sump:
1. Enter a value in the Resolution field.
2. Or use the Up and Down buttons to select a value.

Note: If the input value is lower than 10 millimeters, an error dialog opens.

14.7.2.5 Define the Thickness for Outside Scans

You are able to compute the inner Volume and Sections of a tank even if the tank has been scanned, not from the inside,
but from the outside. You have to enter a value that corresponds to the thickness of its wall.

To define the thickness for outside scans:
1. Enter a value in the Thickness field.
2. Or use the Up and Down buttons to select a value.

14.7.2.6 Preview the Results

You can now generate and visualize the Sections and the Volume of the Sump obtained from the set of points (before cre-
ating them in the database).

To preview the results:
1. Click the Preview button.

n In the Horizontal Tank Calibration dialog, the Display Sump and Display Sections options become enabled. By
default, the two Geometry options are checked.

n In the 3D View, the Sump's Volume is represented by a graph of vertical color lines and the Sections are rep-
resented by a set of closed and fitted (with points) polylines. The information box, in the upper right corner, dis-
plays in text the values of the Sump Volume, Body Volume and Full Volume.

2. If required, check the Cloud options to display the point cloud in the 3D View.
3. If required, uncheck the Geometry options to hide the computed Volume and Sections in the 3D View.
4. Visually check the Sump Volume data to ensure that the entire area has been taken into account for the volume cal-

culation. If you detect "holes" in the Sump Volume display, choose a different resolution setting. Reiterate this step
until you achieve a satisfactory result.
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14.7.2.7 Create the Results
Once you are satisfied with the results, you can save them in the database.

To create the results:
1. Click Create.
2. Click Close.

A group named Tank-Interval "Interval value" is created and rooted under the Models Tree. All computed Sections
and Volume are put under that group. A Section is a Fitted Polyline and is named Section-TankX-Alt "Altitude
Value" where X is its order in three digits, or more. A Volume is named: Sump-Dipping Plate "Height value".
If the Dipping Plate has been defined by fitting a set of points with a plane, a Fitted Plane object named "Dipping
Plate" is created and put under the Tank-Interval folder.

Tip: You can leave the Horizontal Tank Calibration tool by pressing Esc or by selecting Close from the pop-up menu.

Note: You can create as many sets of sections and volume as required without having to leave the tool. If you decide to
leave this tool without saving the results, a message appears and prompts you to confirm, undo or cancel the process.

14.7.2.8 Export the Results

The results can also be exported into a TXT format file. There are two columns of information inside the file. The first
column contains all Section Heights (above the Dipping Plate). The second column lists the Area information at each Sec-
tion level. The first line displays the Sump value.

To export the results:
1. Click Export. The Save As dialog opens.
2. Enter a name in the File Name field.
3. Find a location in your disk in the Look In field.
4. Click Save. The Save As dialog closes.

Note: If the Storage Tank Application option has been chosen during the installation of RealWorks, two files are installed in
X:\Program Files\Trimble\RealWorks12.0\Tables\Tank. The Excel sheet is a sample template that allows the importing of
cross section data (from the above mentioned TXT file) generated by the Horizontal Tank Calibration tool. Formulas allow
the user to apply compensations and to then create capacity tables. The Word format file contains detailed instructions for
importing and processing the cross section data.

Warning: You must export the results before closing the Horizontal Tank Calibration tool, otherwise they will be lost.

14.7.3 Tank Calibration Check
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The Tank Calibration Check feature lets you first check, and then if required, modify the Sections previously extracted from
either the Vertical Tank Calibration tool or the Horizontal Tank Calibration tool.

14.7.3.1 Open the Tool

To open the tool:
n In the Horizontal (or Vertical) Tank Calibration dialog, click the Check button. The Tank Calibration Check dialog

opens in place of the Horizontal (or Vertical) Tank Calibration dialog. The first Section with fitted points is displayed
in the 3D View with a 2D Grid superimposed (if not previously hidden).

Note: You can hide the 2D Grid or change its size by selecting its related command from the pop-up menu or from the 3D
View menu bar.

Note: You need to first generate a preview of Sections and Volume from the set of points; otherwise the Check button
remains dimmed.

14.7.3.2 Filter all Sections

This step is optional, though recommended if you expect, or visually detect, significant differences from one section to the
next. It allows you to filter by comparing sections from one to the next. The filtering setting called Tolerance corresponds to
a degree of change from one section to the next at a percentage rate ranging from 0% to 10%. The sections for which the
difference (in percent) is higher than the defined rate are considered as potentially defective, and can then be edited.

To filter all sections:
1. Check the Filter Sections options. The Tolerance slider and its field become enabled.
2. Move the Filter Sections slider from Left to Right to set a value.
3. Or enter a rate in the field.

Note: The Step 1 is dimmed in case of a horizontal tank.

14.7.3.3 Select a Section to Edit

If the Step 1 has been skipped, all sections extracted from the Horizontal Tank Calibration tool (or Vertical Tank Calibration
tool) are listed in Step 2. If the Step 1 has been executed, only the extracted sections that are considered as out of tol-
erance are listed here. By default, the first section from the list is the selected one and is displayed with its associated points
in the 3D View.

1 - A list of Sections 2 - The order of the Sections in that list

If the selected (active) section is other than the first section, you can use the Up and Down keys of your keyboard (or Dis-
play Previous Contour and Display Next Contour buttons in the dialog) to display the next and the previous section in
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the 3D View. The Display First Contour or Display Last Contour buttons will set the first section or last section as active
(selected). You can also key in a number in Step 2 to select it.

Tip: You can hide the slice of points that is associated with the selected section by un-checking the Display Cloud option.

14.7.3.4 Edit a Section

This step is dedicated to the editing of defective sections. Only one section can be edited at a time; the selected one. As a
section is a fitted polyline which is composed of a set of segments, you can use the Polyline Drawing tool to modify it manu-
ally by moving vertices. You can also delete a part and connect extremities with a segment.

1 - Polyline Drawing
2 - Standard Selection Mode

3 - Delete and Connect Extremities
4 - Reload Initial Section

Tip: All features can be selected from the pop-up menu.

To modify a section manually:

1. Click the Polyline Drawing icon. The Drawing and Picking Parameters (in 2D constraint mode) toolbars appear.
2. Place the cursor over the Section. A solid square appears if you are on a node, if you are on a middle node and

if you are on a middle node to insert.
3. Drag the node to a position. The selected node turns to yellow.
4. Drop the node to that position.
5. Click Validate.

Note: If required, reload the initial Section by clicking .

Tip: The Polyline Drawing icon can also be selected from the pop-up menu.

A section is a fitted polyline which is composed of segments.

To select items from a section:
1. Click the Standard Selection Mode icon.
2. Draw a polygonal fence.
3. Double-click to end and validate the polygonal fence.

Note: To undo the previously drawn fence and start a new one, select the Standard Selection Mode icon again.

Tip: The Standard Selection Mode icon can also be selected from the pop-up menu.

To delete and connect Extremities:
1. Perform a selection as described previously.
2. Click the Delete and Connect Extremities icon. Segments inside the previous selection are deleted and the

extremities are connected together with a Segment.
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3. If required, reload the initial Section by clicking .

Tip: The Reload Initial Section and Delete and Connection Extremities icons can be selected from the pop-up menu.

14.7.3.5 Apply the Modifications

If some modifications have been applied to the selected section, click Apply. The Tank Calibration Check dialog will save
the changes and then close. Otherwise, click Close. This will close the Tank Calibration Check dialog too.

14.7.4 Tank Setup

The purpose of this tool is to allow the user to create an object of Tank type in the database. This creation must first go
through an initial phase that corresponds to the classification (of the tank). A classification is a feature that enables you to
automatically (or manually) identify each part of a tank, whatever the shape it has. A tank is composed of the following
parts:
n Bottom.
n Shell.
n Roof.
n Deadwood (all the data inside the tank like pipes, ladders, etc.).
n Remaining (point clouds not classified in the previous categories).

14.7.4.1 Open the Tool

The input of the Tank Creation can be either a point cloud or an object of Tank type (that has been created with that tool).

To open the tool:

1. Select a point cloud (or a Tank object ) from the Project Tree.

2. Select Tank Setup in Storage Tank > Tank Object. The Tank Setup dialog opens.
n The Use Constrained View, when selected, applies a constraint to the selected point cloud. This constraint

locks the rotation around the Z-Axis and around the center of the box that bounds the selected point cloud. In
addition, only the closest half part of the selected point cloud is visible.

n If a point cloud has been selected as input, the number of points in the Remaining part is equal to the number of
points of the point cloud, and the others are equal to zero.
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The Segmentation tool is a sub-tool. It enables you to prepare the selected point cloud, by reducing its size
and/or removing undesirable points.
The Reload Points enables you to reload the initial state of the selected point cloud.

n If a Tank object has been selected as input, the number of points of each part (of the tank) is displayed.

The Segmentation tool removes the existing classification.
The Reload Points reloads the classification as it was when entering the tool.

14.7.4.2 Define the Parameters

In this step, the user has to choose the parameters to use in relation to the type of tank he has as input

To define the parameters:
1. Drop-down the first list and choose among Vertical Cylinder and Horizontal Cylinder.
2. Drop-down the second list and choose among Inner Scans and Outer Scans.

n If Vertical Cylinder and Inside Scans have been chosen, the Bottom parameter is enabled, and you can drop-
down the list to choose among Planar Bottom (Flat/Sloped), Cone Up Bottom and Cone Down Bottom.

n If Vertical Cylinder and Outside Scans have been chosen, the Bottom parameter is grayed-out.
n If Horizontal Cylinder has been chosen, the Bottom parameter is grayed-out.

14.7.4.3 Classify Automatically a Tank

To classify automatically a tank:
n Click the Classify button. An automatic algorithm is launched to detect each part of the tank and fill the cor-

responding point clouds.
n The Cloud Rendering option switches to the Cloud Color .
n Each part of the tank is displayed with a color, Red for Remaining, Blue for Shell, etc.
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n The number of points of each part is displayed in Step 3, as illustrated below.

14.7.4.4 Classify Manually a Tank

Instead of using the automatic classification method, you can go straight away to the manual method. The input cloud is in
its entirety the Remaining part of the tank.

To classify manually a tank:
1. Click the Edit button. The Tank Classification toolbar opens.
2. Choose among Polygonal Selection, Rectangular Selection, and Circular Selection.
3. Fence a region on the set of points.
4. Click on the pull-down arrow and choose among:

n Remaining, Roof, Shell, Deadwood and Bottom, if Vertical Cylinder and Inside Scans have been chosen in Step
1.
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n Remaining, Roof and Shell, if Vertical Cylinder and Outside Scans have been chosen in Step 1.
n Remaining, Shell and Deadwood, if Horizontal Cylinder and Inside Scans have been chosen in Step 1.
n Remaining and Shell, if Horizontal Cylinder and Outside Scans have been chosen in Step 1.

5. Click the Assign to Desired Tank Part icon.
n The set of points inside the defined fence is colored with the color corresponding to the part of the tank you have

chosen.
n The number of points inside the defined fence appears, in Step 3 of the Tank Creation dialog, below the chosen

part.
n The number of points in the Remaining part is reduced by the amount of points inside the defined fence.

6. If necessary, fence another region on the set of points and add it to the previous.

Note: To end a fence, you can double-click (or press on the Space Bar).

Tip: You can select Assign to Desired Tank Part from the pop-up menu or use the P shortcut key.

14.7.4.5 Check and Refine the Classification

This step lets you visually check the quality of the classification by focusing on a particular part of the tank (by hiding the oth-
ers), and if required, refine the part by subtracting and/or adding points into.

14.7.4.6 Create a Tank Object

Once each part of the tank has been clearly identified and classified, you can create the tank object in the database by click-
ing Create. Below is a tank object with all its parts in the Project Tree. Each of the created parts cannot be deleted or dis-
placed from its location in the tank object. You can only copy each of them.

All the parameters that compose the tank object can be viewed when displaying its properties.
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Note: You cannot create a tank object without Shell. The Create button remains grayed-out until a Shell has been defined.

Note: The Tank Creation dialog remains open after a tank object is created. You need to close it manually to leave the Tank
Creation tool.

14.7.5 Measure Tank

The Measure Tank feature lets the user measure a distance on a tank shell surface perpendicular to its main direction.

14.7.5.1 Open the Tool

To open the tool:
1. Select a Tank Object from the Project Tree.

2. Select Measure Tank in Storage Tank > Measure Tank. The Tank Measurement toolbar opens.

The selected tank object is composed of several items: Remaining, Roof, Shell, etc. Only the Shell part is kept and dis-
played in the 3D View. The rest of them are hidden.

14.7.5.2 Measure a Distance on the Shell

To measure a distance on the shell:

1. If required, click the Tank Shell Measurement icon.
2. In the 3D View, pick two points on the tank shell.

A measurement is performed using the shortest distance between the two picked points. The first point enables you
to define a plane, and the second point is projected on it.
The measured value is displayed in the information box, in the 3D View.
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3. If required, cancel the current measurement and start a new one by doing one of the following:
n Press Esc.
n Select Tank Shell Measurement from the pop-up menu.
n Pick two new points.

14.7.5.3 Reverse a Distance Measurement

To reverse a distance measurement:
1. First perform a distance measurement on a shell.
2. Then, click the Reverse Tank Shell Measurement icon.

A complementary measurement is performed.
The value in the information box in the 3D View is updated.
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14.7.5.4 Create the Measured Value

You cannot create anything within the selected Tank Object. The Create icon is grayed out and remains in this state until
you deselect the Tank Object.

For each measurement, a Polyline Measurement named ObjectX is created and rooted under the Models Tree. You can
make as many measurements as required without having to close the tool. You can export the created measurements to
the CVS format file.

Tip: Instead of clicking Create, you can press Enter, or select Create from the pop-up menu.

14.7.6 Vertical Tank Inspection

The Vertical Tank Inspection tool enables you to analyze the verticality and roundness of a tank.

The verticality analysis tells whether the tank is vertical or not up to a tolerance. The tank may be vertical and not perfectly
round. The algorithm compares the shell point cloud to a reference shape extruded vertically. To define the reference
shape, pick a position at the lower part of the tank shell (refer to Define a Reference for the Verticality). The software will
then derive a reference shape fitted on the points at this elevation.

The roundness analysis tells whether the tank is circular up to a tolerance. The tank may be round and not perfectly cyl-
indrical, i.e., it may have a different diameter at different heights. For each elevation, the roundness analysis compares the
shell point cloud to a circular shape as illustrated below.
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Caution: Due to some changes in the verticality and roundness inspection methods in version 10.4, the format of the tank
object created in the database has changed. After saving the project in version 10.4, you will not be able to reopen your pro-
ject in previous versions of RealWorks.

14.7.6.1 Open the Tool

To open the tool:

1. Select a Tank object from the Project Tree.

2. Select Vertical Tank Inspection in Storage Tank > Tank Inspection. The Vertical Tank Inspection dialog opens.
n The Use Constraint View, when selected, applies a constraint to the selected point cloud. This constraint

locks the rotation around the Z-Axis and around the center of the box that bounds the selected point cloud. In
addition, only the closest half part of the selected point cloud is visible.

n If the tank object has never been inspected before, only its Shell and Bottom are kept and displayed in the 3D
View. Its Remaining, Roof and Deadwood parts are hidden. You can start defining a reference for the verticality
by picking a point (refer the Define a Reference for the Verticality topic).

n If the tank object has already been inspected, its Shell and Bottom and the Grid are displayed. You can either
redefine the verticality by picking a point (refer to the Define a Reference for the Verticality topic) or edit the exist-
ing Grid.

Caution: You need to have a vertical Tank object with Shell. Otherwise the Vertical Tank Inspection tool cannot be
launched.

14.7.6.2 Define a Reference for the Verticality

The reference shape for the verticality is obtained by picking a position in the lower part of the tank shell. A fitted shape on
the shell points close to this elevation will define the reference shape for measuring the verticality. Make sure you pick an
elevation at which the shell shape has no issues. If needed, you can modify which points should be in the Shell and which
points should be in the Remaining in the Tank Setup tool.
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To define a reference for the verticality:
1. Pick a point on the displayed cloud.
2. Or enter a value in the Elevation field.

n A horizontal plane displays in the 3D View at the defined elevation.

14.7.6.3 Define the Inspection Stations

In a tank, an Inspection Station is a vertical line which may correspond (or not) to a vertical weld seam.
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1 - Inspection stations
2 - Shell

3 - Roof

14.7.6.3.1 Define the Initial Station

To define the initial station:

1. Click the Pick Initial Inspection Station icon. The cursor takes the following shape .
2. In the 3D View, pick a point, over a vertical weld seam (or not). The 3D coordinates of the picked point are displayed

in the Initial Station field.
Or

3. Enter the 3D coordinates of a point in the Initial Station field.
4. Press Enter to validate.

Note: You can cancel the initial Inspection Station by selecting Undo.

14.7.6.3.2 Define the Rest of the Stations

To define the rest of the stations:
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1. Enter a distance value in the Step Distance field.
2. Press Enter to validate.

A set of vertical (and blue) lines appears all around the tank. The longer one is the initial line (initial Inspection Sta-
tion).
The number of lines, which is always a multiple of 2, is obtained by subdividing the circumference of the tank by the
Step Distance value.
The value, you entered in the Step Distance field, is automatically adjusted to a value to fit the subdivision and the
multiple-of-two constraint.
Or

3. Enter a number in the Number of Stations field.
4. Press Enter to validate.

If the input number is not a multiple of 2; it will be changed by a value, greater and multiple of 2.
The Step Distance value will change to take into account this new number.

Note: You can cancel the whole Stations except the initial one by selecting Undo.

Caution: The minimum of Stations, you entered, should be at least 4. If you enter a number lower than 4, an error message
appears.

Note: The numbering will start from the initial station, at 0 or at 1, depending on the convention chosen in step 2. The order
for the rest of the stations will be given by the chosen direction. See the Set the Orientation and Numbering Conventions
topic.

Note: A warning message appears and prompts you to continue or abort when the number of stations exceeds 250.

14.7.6.3.3 Shift a Station

This step enables you to edit the Station lines previously defined by moving them.

To shift a station:

1. Click the Shift Stations button. The cursor takes the following shape .
2. In the 3D View, pick a Station. Its color turns to pink.
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3. Pick a new position in a space delimited by the next Station and the previous Station. The selected Station is shifted
horizontally to the picked position.

4. Click the Done button.

Note: You can cancel the shift of the Station by selecting Undo.

Tip: You can leave the picking mode by pressing Esc.

Caution: You are not allowed to shift a Station to a position which may modify its order in regards with the rest of the Sta-
tions.

14.7.6.3.4 Set the Orientation and Numbering Conventions

To set the orientation and numbering conventions:
1. Click on the first pull-down arrow and choose Clockwise and Counterclockwise. This sets a direction around which

the Stations to be created will be incremented.
2. Click on the second pull-down arrow and choose an option:

n The Numbers from 0 option enables the numbering of the Stations to start at 0.
n The Numbers from 1 option enables the numbering of the Stations to start at 1.
n The Angles option enables to display the numbering of the Stations, as angular values (always in degrees).

Note: The conventions related to the Orientation and the Numbering of the Stations, defined here, will be visible when
checking the verticality and the roundness of the tank, in the report and in the created results.
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14.7.6.4 Evaluate the Shell of a Tank

This sub-tool enables you to measure the roundness and verticality of a tank. It lets the user pick positions in order to define
the Welds and Courses, (refer to the illustration below). The Inspection Stations defined previously and the Welds defined
here will set a Grid. This step also enables you to define a set of measurement rules. Both the grid and the measurement
rules will be used to compute the inspection between the point cloud and the fitted cylinder.

1 - Horizontal weld seams
2 - Course

3 - Shell
5 - Roof

To evaluate the shell of a tank:
n Click the Shell button. The Tank Shell Inspection dialog opens, in place of the Vertical Tank Inspection dialog.

14.7.6.4.1 Define Courses

In a tank, a Course is a circumferential ring bounded by two consecutive horizontal weld seams.

14.7.6.4.1.1 Pick Welds

To pick welds:

1. Click the Pick Welds button. The cursor takes the following shape . The Pick Welds button takes the name of
Done.

2. In the 3D View, pick a point on the top horizontal weld seam of a Course.
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A horizontal line in orange which symbolizes a horizontal weld seam is displayed as illustrated below.
Its position along the tank, which is displayed in the information box in the 3D View, defines its order in regards to
the others.

3. In the 3D View, pick on the bottom horizontal weld seam of the Course to define.
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4. Click the Done button.

Note: You can cancel the addition of lines by selecting Undo.

Tip: You can leave the picking mode by pressing Esc.

Note: You can add a series of lines without having to leave the tool.

14.7.6.4.1.2 Remove Welds

To remove welds:

1. Click the RemoveWeld button. The cursor takes the following shape .
2. In the 3D View, pick a horizontal weld seam.

The picked weld is removed.
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Note: You can cancel the removal of lines by selecting Undo.

Tip: You can leave the picking mode by pressing Esc.

Note: You can only remove one weld at a time.

14.7.6.4.1.3 Shift a Weld

This step enables you to edit the Course lines (Welds) previously defined by moving them.

To shift a weld:

1. Click the Shift Welds button. The cursor takes the following shape .
2. In the 3D View, pick a weld. Its color turns to pink.

3. Pick a new position. The selected weld is moved to that position.
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4. Click Done.

Note: You can cancel the shift by selecting Undo.

Tip: You can leave the picking mode by pressing Esc.

14.7.6.4.2 Define the Shell Measurement Rules

This step enables you to define a series of horizontal measurement rules, spaced at a regular distance inside a Course,
and/or above the top weld, and/or below the bottom weld.

1 - Weld
2 - Course
3 - Regular Interval

4 - Height above the bottom weld
5 - Height below the top weld

Note: If a measurement rule is out of a tank, it won't be taken into account in the computation of the result.

Caution: Be aware that all of the parameters input in this step are persistent. You have to reset themmanually.

Trimble RealWorks User Guide | 847



PRODUCTION TOOLS

Note: You can display (or hide) the measurement rules by checking (or un-checking) the Display Rules option.

14.7.6.4.2.1 Define Measurement Rules Spaced at Regular Distance Between Two Welds

To define measurement rules spaced at regular distance between two welds:
1. Enter an integer value in the Regular Intervals field.
2. Press Enter to validate.

A set of measurement rules spaced at regular distance

Note: The Regular Intervals value should be at least 2.

14.7.6.4.2.2 Define a Unique (or a Series of) Measurement Rule(s) Above the Bottom Weld of a Course

To define a unique (or a series of) measurement rules above the bottom weld of a course:
1. In Step 4, enter a distance value in the Above field.
2. Press Enter. The input value is then displayed with the current unit of measurement and with a semi-colon.

Ameasurement rule above the bottom weld of a Course

3. If required, enter a new value after the semi-colon.
4. Press Enter again to validate.
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A series of measurement rules above the bottom weld of a course

Note: A value entered in the Above is always positive.

14.7.6.4.2.3 Define a Unique (or a Series of) Measurement Rule(s) Below the Top Weld of a Course

To define a unique (or a series of) measurement rules below the top weld of a course:
1. In Step 4, enter a distance value in the Below field.
2. Press Enter. The input value is then displayed with the current unit of measurement and with a semi-colon.

Ameasurement rule below the top weld of a Course

3. If required, enter a new value after the semi-colon.
4. Press Enter again to validate.
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A series of measurement rules below the top weld of a course

Note: The value entered in the Below is always positive. If you input a negative value, the value will not be taken into
account.

14.7.6.4.3 Apply the Grid and Compute the Inspection

The Apply button computes the distances between the fitted cylinder and the point cloud at the positions defined by inter-
secting the whole vertical lines (Inspections Stations) with the measurement rule lines. If no point has been found in a large
area around an intersection position, an error message will be displayed and the computation will not be done.

Caution: The user needs to first define a measurement rule to be able to inspect the verticality and the roundness of the
tank. Otherwise, after clicking Apply, the Verticality and Roundness buttons in step 4 remain grayed out.

14.7.6.5 Evaluate the Bottom of a Tank

This sub-tool enables you to measure the settlements on the bottom of a tank. The settlements can occur when the tank
shell settles sharply around the periphery, causing:

n A deformation on the bottom plate near the shell-to-bottom corner junction (as illustrated below):

n Or a depression (or budge) area on the bottom plate (as illustrated below):
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To Define the Bottom Inspection Parameters:
n Click the Bottom button. The Tank Bottom Inspection dialog opens, in place of the Vertical Tank Inspection dialog.

The Bottom of the tank (1), the Radial Measurements (2) and the Inspection Stations previously defined (3) are dis-
played in the 3D View. You can hide (or display) each of them by unchecking and checking the corresponding
option in the dialog. The Bottom's theoretical model (4) is displayed in the information box at the top right corner of
the 3D View.

14.7.6.5.1 Generate a Preview of the Inspection Map

The user can generate an inspection map in order to visually check the settlement areas on the bottom plate. A settlement
can occur near to the edge of a tank, or on the bottom plate. The inspection map is obtained by comparing the point cloud of
the Bottom to its theoretical model. The theoretical model is the parameter chosen in the Tank Setup tool to classify the bot-
tom. The user has to define first the Outer Zone (4) which is the interval from the Shell to a given position, generally the pos-
ition where the bottom starts to be settled. The Inner Zone is the interval from this position to the center of the tank.

Half of the tank viewed from the Top:
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1 - Radial measurements
2 - Station positions
3 - Center of the tank

4 - Outer Zone
5 - Inner Zone
- Measurement points

Tank viewed from the Front.

1 - Radial measurements
2 - Station positions
3 - Center of the tank

4 - Outer Zone
5 - Inner Zone
- Measurement points

To generate a preview of the Inspection Map:
1. Input a distance value in the Outer ZoneWidth field.
2. Click the Preview Map button. An inspection map displays in the 3D View. Red Areas are areas where there are

some bulges, Blue Areas are areas where there are some depressions, Gray Areas are areas where the bulge /
depression is below the Tolerance threshold defined in step 2.
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3. If required, use the options to display (or hide) either the map or the point cloud.

14.7.6.5.2 Change the Rendering of the Inspection Map

You can change the rendering on the inspection map in order to highlight more or less the regions that may settle.

To change the rendering of the Inspection Map:
n Use the slider or a set a value in the Tolerance field to change the rendering of the inspection map. The bulges over

are in red, the depression in blue.

Note: The Tolerance slider becomes enabled once a preview of the inspection map has been generated.

14.7.6.5.3 Edit Radial Measurements

The default Radial Measurements are equally spaced around the circumference of the tank. This spacing corresponds to
the distance which separates two consecutive Inspection Stations. You can delete some that are not necessary for the
inspection, add some new ones over the settled areas highlighted by the inspection map in order to increase the number of
measurement lines, and by extension the number of measurement points.
To add a new radial measurement:

1. Click the Add New Radial button. The cursor takes the following shape . The Add New Radial button takes the
name of Done.

2. In the 3D View, pick a point on the Bottom.
A radial measurement line is added at the picked position.

3. Click the Done button.
To delete a radial measurement:

1. Click the Delete Radial button. The cursor takes the following shape . The Delete Radial button takes the name
of Done.

2. In the 3D View, pick a measurement line.
The picked measurement line is removed from the 3D View.

3. Click the Done button.
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To delete all radial measurements:
n Click the Delete All Radials button.

14.7.6.5.4 Edit the Bottom Measurement Rules

This step allows you to define a measurement rule that will be used to inspect the bottom part (Bottom) of the tank. This rule
enables you to obtain measurements along the centerlines (Radial Measurements) of the tank, at positions regularly
spaced at two distinct intervals (Outer Zone and Inner Zone).

Half of the tank viewed from the Top:

1 - Outer Zone
2 - Outer Zone step
3 - Inner Zone
4 - Inner Zone step

5 - Center of the tank
6 - Station positions
7 - Radial measurements
- Measurement points

Tank viewed from the Front.

1 - Outer Zone
2 - Outer Zone step
3 - Inner Zone

4 - Inner Zone step
5 - Center of the tank
6 - Station positions
7 - Breaking point

To edit the bottom measurement rules:
1. Input a distance value in the Outer Zone Step field.

You can put a distance equal to zero in the Outer ZoneWidth field.
In that case, whatever the value in the Outer Zone Step, it is not going to be taken into account.

2. Input a distance value in the Inner Zone Step field.

Note: If a measurement rule is out of a tank, it won't be taken into account in the computation of the result.

Caution: Be aware that all of the parameters input in this step are persistent. You have to reset themmanually.

Note: You can display (or hide) the measurement rules by checking (or un-checking) the Display Rules option.
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14.7.6.5.5 Apply the Rules and Compute the Inspection

The Apply button computes the measurement lines (Radial Measurements) and on the measurement rule.

Caution: The user needs to first define a measurement rule to be able to inspect the settlement of the tank.

14.7.6.6 Check the Verticality of a Tank

This step, when chosen, launches a sub-tool called Tank Vertically Check. It enables to inspect the verticality of a tank, by
comparing its point cloud with the fitted model, along the Station lines and at the positions defined by intersecting these Sta-
tion lines with the horizontal measurement rules defined Step 4 of the Tank Grid Definition sub-tool. Note that a Station line
has the naming illustrated below.

1 - Vertical Reference_Station N
2 - Vertical Reference_Station N + 1

3 - Vertical Reference Station N + 2

To check the verticality of a tank:
n Click on the Verticality button. The Tank Verticality Check dialog opens, in place of the Vertical Tank Inspection dia-

log.
Both the cylinder (fitted in Step 2 of the Vertical Tank Inspection) and the selected point cloud are hidden in the 3D
View.

14.7.6.6.1 Filter Sections

The slicing of the selected point cloud along the Station lines, are called Sections. All are selected after entering into the
Tank Verticality Check sub-tool. The number of selected Stations is displayed in Step 1. The measurements, made at the
points by intersecting the Station lines with the measurement rule lines, are called Measurement Points.

By default, the first Section (in order) is the one selected (in Step 2) and displayed in the 3D View. The Apply Filter option is
by default not chosen. But when you choose it, it enables you to filter by only keeping the Sections for which some meas-
urement points are not in the Tolerance the user has to define.

To filter the sections:
1. Check the Apply Filter option. The Tolerance field becomes enabled.
2. Enter a distance value in the Tolerance field.

n The measurement points that are out of the defined Tolerance are in red.
n Those that are in the defined Tolerance are in blue.
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n In Step 1, the number of selected Selections is updated according to the defined Tolerance.
n In Step 2, the number of Vertical Measurements is also updated.

1 - A measurement point out of the defined tol-
erance

2 - A measurement point in the defined tol-
erance

Caution: Be aware that the value put in the Tolerance parameter is persistent. You have to reset it manually.

14.7.6.6.2 Analyze the Verticality from one Station Line

If the Step 1 has been skipped, all Sections are listed in Step 2. If the Step 1 has been executed, only the Sections that are
not in the defined Tolerance are listed here. By default, the first Section from the list is the selected one and is displayed in
the 3D View.
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1 - Point cloud
2 - Model (fitted cylinder)

3 - A section
4 - A measurement point

To analyze the verticality from one station line:
1. Click Display Next Section (or Display Previous Section ) to display the next (or previous) section in the 3D View.
2. Or click Display Last Section (or Display First Section ) to display the last (or first) section in the 3D View.
3. Or key a number and press Enter.
4. If required, check the Display Cloud option.
5. If required, check the Display Reference option.
6. Zoom in or zoom out the displayed Section.

Tips:
n You can use the Up (or Down) Arrow key instead of Display Next Section (or Display Previous Section).
n You can use the Home (or End) key instead of Display First Section (or Display Last Section)

14.7.6.7 Check the Roundness of a Tank

This step, when it is chosen, launches a sub-tool called Tank Roundness Check. It enables to inspect the roundness of a
tank, by comparing its point cloud with the fitted model at the positions defined by intersecting the Station lines with the hori-
zontal measurement rules defined Step 4 of the Tank Grid Definition sub-tool. Note that a horizontal measurement line has
the naming illustrated below.
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1 - Course N
2 - Bottom weld of Course N
3 - Top weld of Course N
4 - Course N+1
5 - A measurement rule line at a
position above the bottom weld
(called Weld 1 + 1/Regular Inter-
val value)

6 - A measurement rule line at a
position above the bottom weld
(called Weld 1 + 2/Regular Inter-
val value)
7 - A measurement rule line
below the top weld (called Weld
2 + Height Below)
8 - A measurement rule line
above the bottom weld (called
Weld 1 + Height above)

To check the roundness of a tank:
n Click on the Roundness button. The Tank Roundness Check dialog opens, in place of the Vertical Tank Inspection

dialog.
Both the cylinder (fitted in Step 2 of the Vertical Tank Inspection) and the selected point cloud are hidden in the 3D
View.
The view is brought to Top, locked in 2D with the 2D Grid displayed.

14.7.6.7.1 Filter all Sections

The slicing of the selected point cloud along the measurement rule lines, are called Sections. All are selected after entering
into the Tank Roundness Check sub-tool. The number of selected Stations is displayed in Step 1. The measurements,
made at the points by intersecting the Station lines with the measurement rule lines, are called Measurement Points.

By default, the higher Section (in elevation) is the one selected (in Step 2) and displayed in the 3D View. The Apply Filter
option is by default not chosen. But when you choose it, it enables you to filter by only keeping the Sections for which some
measurement points are not in the Tolerance the user has to define.

To filter the sections:
1. Check the Apply Filter option. The Tolerance field becomes enabled.
2. Enter a distance value in the Tolerance field.

n The measurement points that are out of the defined Tolerance are in red.
n Those that are in the defined Tolerance are in yellow.
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n In Step 1, the number of selected Selections is updated according to the defined Tolerance.
n In Step 2, the number of welds is also updated.

1 - A measurement point out of the defined Tol-
erance

2 - A measurement point in the defined Tol-
erance

Caution: Be aware that the value put in the Tolerance parameter is persistent. You have to reset it manually.

14.7.6.7.2 Analyze the Roundness from One Measurement Rule Line

If the Step 1 has been skipped, all Sections are listed in Step 2. If the Step 1 has been executed, only the Sections that are
not in the defined Tolerance are listed here. By default, the first Section from the list is the selected one and is displayed in
the 3D View.
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1 - Point cloud
2 - Model (fitted cylinder)

3 - A section
4 - A measurement point

To analyze the roundness from one measurement rule line:
1. Click Display Next Section (or Display Previous Section ) to display the next (or previous) section in the 3D View.
2. Or click Display Last Section (or Display First Section ) to display the last (or first) section in the 3D View.
3. Or key a number and press Enter.
4. If required, check the Display Cloud option.
5. If required, check the Display Reference option.
6. Zoom in or zoom out the displayed Section.

Tips:
n You can use the Up (or Down) Arrow key instead of Display Next Section (or Display Previous Section).
n You can use the Home (or End) key instead of Display First Section (or Display Last Section)

14.7.6.8 Create a Report

To create a report:
1. Click the Create Report button. The Vertical Tank Inspection Report dialog opens.
2. Navigate to the drive/folder where you want the report file to be stored in the Look In field.
3. Enter a name in the File Name field. The extension RTF is added automatically.
4. Click Save. A new Vertical Tank Inspection Report dialog opens.
5. Do one of the following:

n Define the content of the report (see Report Content).
n If the Verticality Inspection (or Roundness Inspection) option has been checked, define the Criteria for Verticality

and Roundness.
n If the Bottom Settlement Inspection option has been checked, choose a Bottom Reference.
n If the Shell Settlement Inspection option has been checked, define the Criteria for Shell Settlement.
n For any type of content, define the Conventions that will be used in the plots.
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6. If required, check the Display Point Cloud in Plots option to enable the display of points in the plots.
7. If required, check the Display Difference Values in Roundness Plots option to display the values of the deviation in

radius between the measurement points and the circular reference in the report.
8. Click Create. The Vertical Tank Inspection Report dialog closes and the report opens on its own.

The unit of measurement that will be used in the report is the unit of measurement for Length.

14.7.6.8.1 Report Content

n If the Verticality Inspection option has been checked, the Verticality Report part will be included in the report.
n If the Roundness Inspection option has been checked, the Roundness Report part will be included in the report.
n If the Verticality Inspection and the Roundness Inspection options have been checked, the Verticality and Round-

ness table in the first page will be displayed.
n If the Bottom Settlement Inspection option has been checked, the Bottom Settlement Report part will be included in

the report. In the first page the Bottom Settlement table will be added.
n If the Shell Settlement Inspection has been checked, the Shell Settlement Report part will be included in the report.

In the first page, the Shell settlement table will be added.

14.7.6.8.2 Bottom Reference

n If the Bottom model option has been chosen, the plots in the Bottom Settlement report will display the fitted bottom
as a reference line. This “fitted” reference line will be used to compute the elevation from reference in the tables.
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n If the Horizontal (Average Elevation) option has been chosen, a line showing the average of the elevations for all
the points of the Bottom will be displayed. This horizontal average reference line will be used to compute the elev-
ation from reference in the tables.
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n If the Horizontal (Automatic, Above) option has been chosen, a Reference Line is set.

The elevation of this reference line is the elevation of the highest measured point for all the profiles plus 25% of the
distance between the highest and the lowest elevations for all the profiles.
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14.7.6.8.3 Criteria for Verticality

n The Tolerance is a threshold on the deviations from the verticality reference shape. If a measured deviation is
greater than this value, it will be highlighted in the report. You might want to use the estimated tank shell height
shown above for defining the tolerance.

14.7.6.8.4 Criteria for Roundness

n The Top Tolerance threshold applies on the upper part of the tank, i.e., above the ‘Height above Shell-to-Bottom
Weld’.
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n The Bottom Tolerance threshold applies on the lower part of the tank, i.e., below the ‘Height above Shell-to-Bottom
Weld’.

n The Height above Shell-to-BottomWeld field enables you to use two different tolerances.
n The estimated tank diameter is given as an aid for defining the tolerances.

14.7.6.8.5 Criteria for Shell Settlement

The Young’s Modulus and the Yield Strength are used to compute the exceeds/does not exceed value based on API 653
with the formula:

Where:
n L is the arc length between two measurement points.
n Y is the Yield Strength (in lbf/in²).
n E is the Young's modulus (in lbf/in²).
n H Is the tank height.

14.7.6.8.6 Conventions
n The Unit field enables you to choose a unit system to be used in the report.

14.7.6.9 Save the Inspection Results

After clicking Create, two folders, named Grid and Measurements, are created in the Tank object folder. The Grid folder con-
tains a frame used in the inspection, and a series of fitted polylines corresponding to the Inspection Stations (1) and the
Welds (2) (defined respectively in Step 2 of the Vertical Tank Inspection tool and in Step 1 of the Tank Shell Evaluation sub-
tool) and the Radial Measurements (3) set in the Tank Bottom Evaluation sub-tool.

The Measurements folder contains the inspection results, i.e. an inspection map (4) and a set of fitted polylines (respect-
ively the results of the inspections along the Inspection Stations (5), the Welds (6) and the Radial Measurements (7) lines.

In case there is no point behind an Inspection Station, the Vertical Measurement resulting from the inspection, is a pure
polyline instead of a fitted polyline.
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When you edit an already inspected tank object and save the results, a dialog appears and warns you that the new inspec-
tion will delete the existing one. If you wish to keep the old inspection, please make a copy of the tank object before entering
the tool. This way, you will create a new inspection.

14.7.7 Tank Secondary Containment

The Tank Secondary Containment feature lets you measure the capacity of a tank Secondary Containment and to know the
position of the Spill Point. A Secondary Containment is an impermeable barrier that prevents leaks from the primary stor-
age tank system from reaching outside the containment area. A Spill Point is the lowest point on the watershed line.

14.7.7.1 Open the Tool

To open the tool:
1. Select a Tank object and a Cloud object from the Project Tree.
2. Select Tank Secondary Containment in Storage Tank > Tank Calibration. The Tank Secondary Containment

dialog opens.
The input cloud should correspond to the ground surface where the secondary containment has to be extracted.
Thus, before computation, it is recommended to remove other objects (e.g. pipes, cars, tanks, etc.) using the auto-
matic Ground Extraction feature and/or the manual Segmentation.
It is assumed that the selected tank is inside the secondary containment.

14.7.7.2 Define an Area

To define an area:
1. In Step 1, click the Select Area button. The Drawing toolbar appears. The 3D View is locked in 2D, with a 2D Grid in

superimpose (if not hidden previously). The view is brought to Top View.
2. Draw a fence around the containment area. It should be not too far from the top of the dike, around one meter. The

secondary containment is assumed to be entirely inside the fence.

3. Validate the fence by clicking . The Drawing toolbar closes.

Tip: You can press Enter instead of clicking Validate.

Note: After defining an area, the Compute button in Step 2 becomes enabled.

14.7.7.3 Compute the Containment Volume

In Step 2, you can see the name of the selected tank and choose between the different display options that are available:
"Display Point Cloud", "Display Tank" and "Display Volume". Before computing the results, the "Display Volume" option is
always grayed-out and checked. After computing the results, this option becomes enabled and remains checked.

To compute the containment volume
n Click the Compute button. The volume as well as the watershed line and the spillover point are computed and dis-

played in the 3D View.
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14.7.7.4 Generate a Report

To generate a report:
1. Click the Generate Report button. The Tank Secondary Containment Report dialog opens.
2. In the Look In field, locate a drive/folder to store the file.
3. In the File Name field, enter a name in
4. Click Save. A new Tank Secondary Containment Report dialog opens.
5. Define the options below:

n Containment Pass/Fail Criterion:

n Tank Volume: Pre-filled with the volume of the displayed cylinder. The value can be edited.
n Ratio: The Ratio expresses the filling rate of the selected tank, 100% for the entire tank and 50% for the half.

n Rainfall:

An important factor that the user has to take into consideration in determining the necessary secondary con-
tainment capacity is the local precipitation condition, Rainfall.

n Amount: Average precipitation in mm per year. This field can be editable, and 0% can be input.
n Estimated Surface Area: Surface used to compute the rain volume, it cannot be edited.
n Estimated Volume: Rain volume computed thanks to rainfall height and surface.

n Units:

n Volume: The unit that is used in the report for quantifying a volume.

6. Click the Create button. The Tank Secondary Containment Report dialog closes.

Here is an example for which the contents of the selected tank combined with the rainfall rate do not exceed the capability
of the secondary containment.
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Here is an example for which the contents of the selected tank combined with the rainfall rate exceed the capability of the
secondary containment.

14.7.7.5 Create

To create:
n Click the Create button. The computed result is then created in the database in a new folder named "Secondary

Containment".

14.7.8 Locate Table

The Storage Tank Application is an option, when installed, also installs a set of tables. The Locate Table option is a direct
entry that brings you to the folder where the tables are.

Note: The Locate Table option can be selected in Storage Tank> Tank Calibration.
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The Media tab is present in all RealWorks products, and in all modules. In the Production module, all tools are available. In
the Registration module, only the Screen Capture (High Resolution) and Capture Screen tools are available. In the Viewer,
only the Screen Capture tool is available.

15.1 Video Creator

The aim is to provide a tool that can generate videos from survey data. The video files are saved in the AVI (for Audio Video
Interleave, a video format from Microsoft) format with customizable resolution and compression level.

15.1.1 Open the Tool

No selection is required to access the Video Creator tool. Videos will be created based on the objects displayed in the 3D
View. However, a selection can be done within the tool and objects can be of any kind (point cloud, mesh, geometry, etc.).

To open the tool:
1. Display objects in the 3D View.
2. Select Video Creator in Media > Media. The Video Creator dialog opens.

The 3D View splits into two 3D viewers. The top 3D viewer (Main View) displays the global scene. The bottom 3D
viewer (called Preview) displays the view from the current keyframe. A keyframe is like a camera in a given position.
The Perspective projection mode is set by default; you cannot swap to Parallel.

15.1.2 Define a Navigation Path

There are three modes to create a video. The Quick Mode uses a predetermined path (a circle). The Step-by-Step Mode
lets you define your own path by navigating through the scene. The Path Mode uses an existing polyline (or a drawn one)
as path.

15.1.2.1 Quick Mode
In the Examiner mode, the top 3D viewer (Main View) displays the global scene with a red circular path (1) and four key-
frames (2). All the keyframes are directed towards the center of the circular path. The bottom 3D viewer (Preview) displays
the view of the current keyframe (in yellow). The circular path has as diameter the diagonal of the bounding box that high-
lights the selection. A 3D manipulator (3) (three handles corresponding to three secant directions, each with a color (red,
green and blue)) is located at the center of the circular path. The View Inwards/Outwards button in Step 1 is enabled.

15
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In the Station-Based mode, the top 3D viewer displays the global scene with only one keyframe. This keyframe is set at the
first station position of the Project Tree. The bottom 3D Viewer shows the viewpoint from that keyframe. The View Inward-
s/Outwards button is dimmed.

15.1.2.1.1 View Inwards/Outwards

You can reverse the keyframe direction so that all keyframes diverge from the center instead of converging on it.

To view inwards/outwards:
n In the Video Creator dialog, click the View Inwards/Outwards icon.
n Or right-click in any 3D viewer and select View Inwards/Outwards from the pop-up menu.
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Note: You can undo (or redo) the inversion by clicking on the Undo Operation (or Redo Operation) button in the Main tool-
bar.

15.1.2.1.2 Move the Circular Path Along a Direction

To move the circular path along a direction:
1. Click on a handle; it turns to yellow. The direction along which you can displace the circular path (with keyframes) is

highlighted in yellow and those along which you cannot displace the circular path (with keyframes) are in mauve.
2. Drag and drop to move the circular path (with keyframes) along that direction.

Note: You can undo (or redo) the displacement by clicking on the Undo Operation (or Redo Operation) in the Main toolbar.

15.1.2.1.3 Move the Circular Path in a Plane

To move the circular path in a plane:
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1. Click on a plane. It turns yellow. The plane in which you can displace the circular path (with keyframes) appears
highlighted in yellow and those you cannot displace along are in mauve.

2. Drag and drop to move the circular path (with keyframes) in that plane.

Note: You can undo (or redo) the displacement by clicking on the Undo Operation (or Redo Operation) in the Main toolbar.

15.1.2.1.4 Resize the Circular Path

To resize the circular path:
1. Click the circular path (with keyframes).
2. Drag and drop to enlarge or reduce the circular path (with keyframes) size.
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Note: You can undo (or redo) the resizing by clicking on the Undo Operation (or Redo Operation) in the Main tool-
bar.

15.1.2.2 Step-by-Step Mode

In the Examiner (or Walkthrough) mode, the top 3D viewer (Main View) displays the global scene with an initial keyframe.
The bottom 3D viewer (Video Editing and Preview) displays the view from that keyframe. In both 3D viewers, the Head
Always Up option and the Perspective project mode are default-set. The initial keyframe is at a position that corresponds to
the current keyframe (of the previous creation mode) position with a shift. As the Heap Always Up option is default-set; you
cannot navigate with permanent constraints (Horizontal Pan, Horizontal Rotation, etc.) or temporary constraints (Rotate
constrained around a vertical axis, Pan constrained along a vertical axis, etc.) in the 3D viewers. You can only zoom (in or
out), pan and rotate.

Keyframe
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In the Station-Based mode, the top 3D viewer remains unchanged. The bottom 3D viewer shows the view from the first sta-
tion position with image(s) overlapped (if present). The initial keyframe is at the first station's position. The same navigation
rules are applied in both 3D viewers except that you cannot pan in the bottom 3D viewer.

15.1.2.2.1 Add a Keyframe

To add a keyframe:
1. In the bottom 3D viewer, navigate through the scene to find the right point of view.
2. Click the Add New Keyframe icon.

In the Examiner navigation mode, a new keyframe is added in the top 3D viewer. A red curve path links this new key-
frame to the previous keyframe.

In the Walkthrough navigation mode, a new keyframe is added in the top 3D viewer at the same position as the pre-
vious keyframe but with a different direction if you tilt or look at a direction. A red curve path links this new keyframe
to the previous keyframe if you pan or walk through the scene.
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In the Station-Based navigation mode, a new keyframe is added in the top 3D viewer at the same position as the pre-
vious keyframe but with a different orientation if you rotate (or zoom) or at the second station position if you jump to
the second station. There is no red curve path linking this new keyframe to the initial keyframe.

3. Repeat the steps from 1 to 2 to add other keyframes.

Tips:
n Add New Keyframe can also be selected from the pop-up menu, in the bottom 3D viewer.
n In the Examiner (or Walkthrough) navigation mode, use the View Alignment tools like Center On Point to help you

rotate around a point.

Notes:
n Adding a keyframe at the same position of an existing keyframe will rotate the camera 360°.
n You can undo (or redo) the addition of a keyframe by clicking on the Undo Operation (or Redo Operation) in the

Main toolbar.
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n You can switch from the Examiner navigation mode to the Walkthrough navigation mode and vice versa when
adding new keyframes. You cannot switch to the Station-Based navigation mode if there are already keyframes.
You need to delete all of them to be able to switch to this navigation mode.

15.1.2.2.2 Load Keyframes from a File

A keyframe file is a data file with the *.dat extension. Select Load Keyframes from file from the pop-up menu.

15.1.2.2.3 Saving Keyframes to a File

The Save Keyframes to File command is only available after adding a keyframe. A keyframe file is a data file with the *.dat
extension. Select Save Keyframes to File from the drop-down menu.

15.1.2.2.4 Edit Keyframes

After adding a keyframe, the Clear All Keyframes, and Delete Current Keyframe icons as well as the Save Keyframes to
File command become enabled.

To delete a Keyframe:

1. In Step 1 of the Video Creator dialog, click the Clear Current Keyframe icon. The current keyframe is removed
from the sequence.

2. Or browse the sequence of keyframes using the navigation buttons to find the one you want to delete and click
Clear Current Keyframe.

Note: You can undo (or redo) the deletion of a keyframe by clicking on the Undo Operation (or Redo Operation) button in
the Main toolbar.

To delete all keyframes:

1. In Step 1 of the Video Creator dialog, click the Clear all Keyframes icon.
2. Or right-click in a 3D viewer (top or bottom) and select Clear all Keyframes from the pop-up menu.

Note: You can undo the deletion of all keyframes.

To change the position and orientation of a keframe:
1. Browse the sequence of keyframes using the navigation buttons to find the one to edit.
2. In the bottom 3D viewer, navigate through the scene to find the right point of view.
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If you are in the Examiner mode, the current keyframe position changes as well as the path's shape.

If you are in the Walkthrough mode, the current keyframe orientation changes while the path's shape remains
unchanged.

If you are in the Station-Based mode, the current keyframe position changes. All are at the same position.
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Note: You can undo (or redo) the operation by clicking on the Undo Operation (or Redo Operation) button in the Main tool-
bar.

15.1.2.3 Path Mode

The top 3D viewer (Main View) displays the global scene with a path (1) (if there is a polyline in your project) and keyframes
(2) (one at each node of the polyline). The initial keyframe is at the starting node's position. The bottom 3D viewer (Preview)
displays the view from the current keyframe (in yellow). If your project has no polyline; the top 3D viewer still displays the
global scene but without a path. The bottom 3D viewer keeps the view from the current keyframe (of the previous creation
mode). In both 3D viewers, the Head Always Up option and the Perspective project mode are default-set. As the Heap
Always Up option is default-set; you cannot navigate with permanent constraints (Horizontal Pan, Horizontal Rotation, etc.)
or temporary constraints (Rotate constrained around a vertical axis, Pan constrained along a vertical axis, etc.) in the 3D
viewers. You can only zoom (in or out), pan and rotate.
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1 - A defined path
2 - A keyframe

3 - The manipulator

Note: The navigation mode is restricted to the Examiner (or Walkthrough) mode.

15.1.2.3.1 Select a Path

If the loaded project contains one (or several) polyline(s), you can select one as a path. The selected polyline needs to be
regular (composed of one or several continuous segments with (or without) arcs).

To select a path:
1. Click on the Choose Path pull down arrow.
2. Select a polyline from the drop down list.

n If the polyline is a set of continuous segments, a keyframe appears at each node.
n If the polyline is a set of arcs, a keyframe appears at each node (start, middles and end).

Note: If the selected polyline contains more than twenty-two nodes, a warning message appears and prompts you to select
the polyline or not.

15.1.2.3.2 Draw and Create a Path

When there is no polyline, you have to create at least one in the database. The top 3D viewer displays the global scene
locked in 2D with a 2D Grid superimposed (if not hidden previously). Movements while picking points are restricted to
Rotate around the Z-Axis, Zoom (In or Out) along this same axis and Pan in the XY plane. The drawn polyline needs to be
regular (composed of one or several continuous segments with or without arcs).

To draw and create a path:
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1. Click Draw and Create Path in Database . The Drawing and Picking Parameters (in 2D constraint mode) toolbars
appear. The mouse cursor shape changes to a pencil.

2. Draw a polyline by picking several points
3. Click End Line. The last picked point ends the line.
4. Click Create to save the drawn polyline in the database.

n If the polyline is a set of continuous segments, a keyframe appears at each node.
n If the polyline is a set of arcs, a keyframe appears at each node (start, mids and end).

Tip: You can also select Create from the pop-up menu.

Notes:
n If the drawn polyline is composed of no continuous segments, an error dialog appears.
n If the drawn polyline contains more than twenty-two nodes, a warning message appears and prompts you to select

the polyline or not.
n If the drawn polyline is a circle, five keyframes are generated. The first and fifth keys are in the same position. That's

why only four keyframes are visible.

15.1.2.3.3 Set a Direction

There is a polyline in your project or after drawing one, the Reverse Path Direction (1), and Smooth Curve (2) icons and the
Direction field become enabled.

Note: Straight is the default direction.

To change the direction:
1. Click on the Direction pull-down arrow.
2. Choose an item from the drop-down list.

n If the polyline is a set of segments, Straight sets the start [A] and end [E] keyframes aligned respectively with the
first [AB] and last [DE] segments and the other keyframes [C e.g.] parallel to the line passing through the pre-
vious and next keyframes.
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n If the polyline is a set of arcs, Straight sets each keyframe tangent to its node.
n Left rotates all keyframes to the right of the Straight direction.
n Right rotates all keyframes to the left of the Straight direction.
n Top rotates all keyframes so that they point upward.
n Bottom rotates all keyframes so that they point downward.

Note: The white dotted line in the picture above is not present in the top 3D viewer but just here for illustrating the explan-
ation.
To reverse the path direction:

1. Click the Reverse Path Direction icon.
2. Or select Reverse Path Direction from the pop-up menu.

n Straight sets the opposite direction.
n Left becomes Right.
n Right becomes Left.
n Top becomes Bottom.
n Bottom becomes Top.

Tip: You can combine the Reverse Path Direction feature with the Smooth Curve feature.
To smooth the path:

1. Click the Smooth Curve icon.
2. Or select Smooth Curve from the pop-up menu.

Tip: You can combine the Smooth Curve feature with the Reverse Path Direction feature.

15.1.2.3.4 Move the Path Along a Direction

To move the path along a direction:
1. Click on a handle; it turns yellow. The direction along which you can displace the path (with keyframes) is high-

lighted in yellow and those along which you cannot displace the path (with keyframes) are in mauve.
2. Drag and drop to move the path (with keyframes) along that direction.

Note: You can undo (or redo) the displacement by clicking on the Undo Operation (or Redo Operation) in the Main toolbar.

15.1.2.3.5 Move the Path in a Plane

To move the path in a plane:
1. Click on a plane. It turns to yellow. The plane in which you can displace the path (with keyframes) appears high-

lighted in yellow and those you cannot displace along are in mauve.
2. Drag and drop to move the path (with keyframes) in that plane.

Note: You can undo (or redo) the displacement by clicking on the Undo Operation (or Redo Operation) in the Main toolbar.

15.1.3 Browse the Keyframes

A sequence of keyframes defines which movement the spectator will see, whereas the position of the keyframes on the
video defines the timing of the movement. An active keyframe - the one in yellow in the top 3D viewer - sets the starting
point of that movement. If more than one keyframe is available and if the active keyframe is other than the first one, you can
browse through the sequence as described below:

1 - Go to First Element
2 - Go to Previous Element
3 - Field for entering a keyframe order

4 - Go to Next Element
5 - Go to Last Element
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To browse the keyframes:
n Click Go to Previous Element (or Go to Next Element) to set the previous (or next) keyframe as active.
n Click Go to First Element (or Go to Last Element) to set the first (or last) keyframe as active.
n Key in a keyframe order in the path in the Go to Keyframe field to select it. You do not need to validate by pressing

the Enter key.

Tips:
n Use the Home (or End) button of your keyboard instead of Got to First Element (or Go to Last Element).
n Use the Up (or Down) arrow of the keyboard instead of Go to Previous Element (or Go to Next Element).

15.1.4 Define the Video Parameters

To define the video parameters:
1. Enter a value in the Duration field.

1 - Video speed
2 - Launch the Video preview

3 - Duration

2. Click on the pull-down arrow below the Duration field.
3. Choose a value among x1, x2, x4 and x10 from the drop-down list.

15.1.4.1 Set a Duration

A Duration in second expresses the time the camera will take to run through the navigation path from the beginning to the
end.

To set a duration:
n Enter a value in the Duration field.

15.1.4.2 Define a speed

To define a speed:
1. Click on the Speed pull-down arrow.
2. Choose a factor among x1, x2, x4 and x10 from the drop-down list.

15.1.4.3 Choose a Processing Mode

There are two quality modes: Quick Processing and High Quality. Anti-Aliasing is a technique of smoothing images. It con-
sists of adjusting pixel positions and/or setting pixel intensities so that there is a more gradual transition between the color
of a line and the background color. The side effect of the Anti-Aliasing is the Flickering.

15.1.4.3.1 High Quality Option (Recommended)
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The High Quality option enables you to create videos of significantly higher image quality. The produced video shows more
point cloud details and less visual artifacts - flickering and aliasing are highly reduced. This is especially visible when the
point clouds consist of several scans acquired from different stations.

This option is the recommended option because it enables you to create videos of the best quality but requires more graph-
ics card memory and more computation time.

A snapshot with the Anti-Aliasing applied and the Flickering filter enabled.

15.1.4.3.2 Quick Processing Mode

You can use the Quick Processing option for generating a video more quickly, e.g., for producing a first draft version.

A snapshot without Anti-Aliasing nor Flickering filter.

15.1.5 Preview the Video

To preview the video:
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1. Click Play. The video is launched and the Play button becomes dimmed.
2. Press Esc to stop the video preview.

n In the Main View window, a keyframe runs along the defined path from the first keyframe position to the last key-
frame position.

n In the Preview window, a preview of the video to create displays in the 4/3 format.

15.1.6 Create the Video

To create the video:
1. Click Create. The Save Video File dialog opens.
2. Navigate to the drive/folder where you want to store the video.
3. Enter a name in the File Name field.
4. Click on the File of Type pull-down arrow.
5. Select a type from the drop-down list.
6. Click on the Resolution pull-down arrow.

7. Do one of the following:
n Use a predetermined resolution.

n Choose among Publisher (320x240), Web small (240x188), Web large (320x240), DVD (720x576), HD 720p
(1280x720) and HD 1080p (1920x1080).

n Customize your own resolution.
a. Select Custom. The two Pixels fields become editable with 320 x 240 as default values.
b. Set your own resolution.

8. Click on the Codec pull-down arrow.
9. Choose "Uncompressed" to not compress the video. In that case, the About and Options buttons remain dimmed.
10. Or choose a codec from the drop-down list. Both the About and Options buttons become active.
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11. If required, click on the About button. A codec, for which the information is missing when clicking on the About but-
ton, will not open any dialog. Otherwise, an information box appears.

12. Click on the Options button and configure your own options.
13. Click Save. The Save Video File dialog closes. RealWorks will then encode the video. When encoding is complete,

a box with the following information - End of operation notified, Elapsed time for the encoding and location of the
video in your hard drive - appears.

Notes:
n A warning message appears when the resolution values are invalid. You can only set a value between 100 and

2000.
n Pressing Esc stops the video encoding. A message which prompts you to cancel the operation (or not) appears.
n In the Main View window, the keyframe, which runs along the defined path from the first keyframe position to the

last keyframe position when previewing the video, does not run anymore. In the Preview window, a preview of the
video to create displays in the 4/3 format, in the chosen resolution. The two bands, one on each side of the preview
video, take the color of the main window color.

Tip: The codecs from the drop-down list are those installed in your computer system. For practical purposes, we recom-
mend you to install the (free) codec to ensure that your videos reach a wide audience.

Caution: All Microsoft codecs (Microsoft RLE, Microsoft YUV and Microsoft Video 1) are removed from the RealWorks 8.1
release.

15.2 Capture Screen (High Resolution)

This command enables you to create a snapshot of the 3D View in high resolution and high quality. The aliasing effect
related to the point cloud is highly reduced. Note that since the created image is larger than the screen, you may want to
increase the point size to get a visually similar result. The result is a high resolution image in the BMP format. Select Cap-
ture Screen (High Resolution) icon in Media > Media.

15.3 Capture Screen

This command enables you to create a snapshot of the 3D View with the quality of the current view. The result is a stand-
ard resolution image in the BMP format, for which the anti-aliasing has NOT been applied. Select Capture Screen icon
in Media > Media.
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All the RealWorks family of products contain the export features described in this chapter except for the Viewer. All export
commands are gathered in the Import/Export group, in the Home tab.

Caution: For all export features, a dialog opens and prompts you to input a File Name. Please, note that you cannot leave
the File Name field empty. You have to enter a name. Otherwise, you cannot export.

16.1 Export a Selection

The Export Selection feature is dedicated to the export of a selection from RealWorks toward a file for which the format can
come from a third party software, a competitor, etc.

To export a selection to a file:
1. Select the data to export from the Project Tree.
2. Select Export Selection in Home > Import/Export > Export.
3. Select a file type from the drop-down list.
4. Click Save. A new dialog opens.

Note: There are two types of E57 exports: Export to non-Gridded E57 Format and Export to Gridded E57 Format.

16.1.1 Google Earth (KMZ) Format

A KML (Keyhole Marked Language) file is a XML-based-language file from Google Earth (originally called Earth Viewer and
created by Keyhole Inc.). Google Earth is a virtual globe program which maps the earth by superimposing images obtained
from satellite imagery and aerial photography, etc. A KML file contains geo-referenced information (about points, lines and
text) to display in Google Earth. A KMZ file is simply a zip compressed KML file with images. KMZ is the default Google
Earth format. In RealWorks, meshes (textured with images or not) and geometries (plane, cylinder, sphere, etc.) can be
exported to Google Earth.

To export to a KMZ format file:
n In the Export as KMZ File dialog, do one of the following:

In a basic Geodetic System, a location (or a point) on the Earth has its longitude and latitude as coordinates, both
expressed in angles. A latitude is measured from the equator and a longitude from a meridian (the Greenwich
meridian is used as reference). There are around a hundred Geodetic Systems in use around the world differing
from country to country. A unified Geodetic System (called WGS84, dating from 1984) is in use in Google Earth. In
the WGS84 coordinate system, the distance of one degree in longitude changes according to the latitude. This
drawback disappears in the Universal Transverse Mercator (UTM) system which is a grid-based method of spe-
cifying locations on the surface of the Earth. The surface of the Earth is divided between 80° S latitude and 84° N lat-
itude into 60 zones, each 6° of longitude in width and centered over a meridian of longitude. Zones are numbered
from 1 to 60.
n Define your own conversion Parameters.
n Convert UTM coordinates to WGS84 latitude and longitude.

16
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Notes:
n You can also select a project with meshes (or geometries) inside.
n A geometry is converted into a mesh when exporting.

16.1.1.1 User Defined
If the selected mesh (or geometry) has been geo-referenced in a coordinate system different from the UTM coordinate sys-
tem (for example the Lambert or the Trimble GX™ scanner), the Export as KMZ File dialog opens with the "User Defined"
option set as default. Exporting to the Google Earth format involves defining a "Reference Point" on the selected mesh/geo-
metry (mainly a point on the ground) and giving its related latitude and longitude coordinates in the WGS84 coordinate sys-
tem.

To define your own conversion parameters:
1. Check the User Defined option.

2. Enter reference point coordinates in the Define Reference Point.
3. Or click on the Pick Reference Point icon. The Picking Parameters toolbar appears in 3D constraint mode and

the cursor shape changes to a pointer.
4. Pick a point on displayed items in the 3D View (for example the ground). Its coordinates in the current unit of meas-

urement appear in the Define Reference Point field.
5. Enter an angle value in the Latitude field.
6. Click on the Latitude pull-down arrow.
7. Choose between North and South from the drop-down list.
8. Enter an angle value in the Longitude field.
9. Click on the Longitude pull-down arrow.
10. Choose between East and West from the drop list.
11. If required, add a description.
12. Click Export. The Export as KML File dialog closes.

Note: If the selected mesh (or geometry) hasn't been geo-referenced in any coordinate system, the user will have to ori-
entate the scene by himself in Google Earth.
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Tip: You can use the Add Placemark tool in Google Earth to get the longitude and latitude coordinates of the Reference
Point.

16.1.1.2 UTM to WGS84 Latitude and Longitude

If the selected mesh (or geometry) is geo-referenced in the UTM coordinate system, the Export as KMZ File dialog opens
with the "UTM to WGS84 Latitude/Longitude" option set by default. Exporting to the Google Earth format means converting
the mesh (or geometry) coordinates expressed in the UTM coordinates to the WGS84 coordinates (latitude, longitude and
height).

To convert UTM coordinates to WGS84 latitude and longitude:
1. Check the UTM to WGS84 Latitude/Longitude option.

2. Click on the UTM Latitude Hemisphere pull-down arrow.
3. Choose between North and South from the drop-down list.
4. Enter a number in the UTM Zone Number field.
5. If required, add a description.
6. Click Export. The Export as KML File dialog closes.

16.1.2 PDMS Macro Format

You can export any entities created within RealWorks into a PDMSmacro file like Box, Circular Torus, Cone, Cylinder,
Eccentric Cone, Ellipsoid (with or without one or two bounds), Point, Pyramid, Rectangular Torus, Sphere (with or without
one or two bounds), Plane and Extrusion.

To export to a PDMSMacro format file:
1. In the Export as PDMS file dialog, choose:

- A frame to apply from the drop-down list.
- The unit to export is alwaysMillimeter.

Note: A file of PDMSMacro format carries the pdmsmac file extension.

16.1.3 Non-Gridded E57 Format

The E57 format is a file format specified by the ASTM (American Society for Testing and Materials), an international stand-
ards organization. It is compact and vendor-neutral. It was developed for storing data (Point Clouds, images and metadata)
produced by 3D imaging systems such as laser scanners. Such format enables data interoperability among 3D imaging
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hardware and software systems and is not dependent on proprietary formats for storing and exchanging data. A file of E57
format carries the e57 file extension.

Only a Cloud (or 3D Inspection Cloud) can be exported. If an object has sub-objects with no points inside, a warning mes-
sage appears and warns the user that this (or these) sub-object(s) are not exported. The Intensity, and/or True Color
(RBG color), and/or Inspection Color as True Color information will be exported.

To export to a non-gridded E57 format file:
1. In the Export Options dialog, if there are several frames available in your project, click on the Export Frame pull-

down arrow.
2. Choose a frame to apply from the drop-down list.
3. If a Cloud has been selected as input, choose between Export Intensity and Export True Color.
4. If a 3D Inspection Cloud has been selected as input, choose between Export Intensity and Export Inspection Color

as True Color.
5. If both a Cloud and a 3D Inspection Cloud have been selected as input, choose between Export Intensity and

Export True Color.
6. Click Export. The Export Options dialog closes.

Caution: Data is exported to the E57 format as an irregular grid point set, in the Cartesian coordinates (XYZ). Data is expor-
ted in Meters.

16.1.4 LAS Format

The LAS file format is a public file format for the interchange of 3-dimensional point cloud data between data users. It is bin-
ary-based. The two LAS format versions (1.2 and 1.4) support natively the classification of point clouds. Both standards con-
tain a slight difference in terms of number of layers. The user has to choose the LAS format version to export to.

16.1.4.1 LAS 1.2

The LAS 1.2 format version supports 9 predefined layers, and 0 customizable layers.

16.1.4.2 LAS 1.4

The LAS 1.4 version supports 17 predefined layers, and 191 customizable layers.

16.1.4.3 Export as a LAS Format File
To Export as a LAS Format File:

1. In the Export Options dialog, if there are several frames available in your project, click on the Export Frame pull-
down arrow.

2. Choose a frame to apply from the drop-down list.
3. Choose to export (or not) the color information by checking (or un-checking) the Export RGB Color option.

Note: The Exported Intensity option is always checked and dimmed. This means that the intensity information is
always exported.

4. Click on the Unit pull-down arrow.
5. Choose a unit of measurement among Meters, U.S. Survey Feet and International Feet from the list.
6. Click Export. The Export Options dialog closes.

Note:
n Only an object with a point cloud inside can be exported. If an object has sub-objects with no points inside, a warn-

ing message is displayed and warns the user that this (or these) sub-object(s) are not exported.
n A file of LAS format has *.las as extension.
n Data and bounding box limits are exported in meters.

Warning: An error dialog opens if no cloud (or an empty cloud) is in the selection.

Caution: The LAS file format has coordinate size limitations. When you export a georeferenced scene using the LAS
format, be aware that its size may have an impact on the precision of the exported data. For a scene with a size smaller
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than 2000 Km, you will have a precision to the millimeter. For a scene with a size larger than 2000 Km, you will have a pre-
cision to the centimeter. For a scene with a size larger than 20000 km, you will have a precision to the decimeter.

Warning: The dialog below appears if points to be exported are too far from the origin of the coordinate frame that will be
applied. Precision of the data may be reduced if you choose Yes.

Note: An error message appears in case some layers are out of the LAS classification range. Some information may be lost
because unsupported layers will be converted to "1 Unclassified", while compatible layers will be kept intact.

16.1.5 LAZ format

The LAZ format is a compressed version of the LAS format. Exporting to the LAZ format is similar to the LAS one. Refer to
the LAS format topic for more information. The LAZ format also supports natively the classification of point clouds.
RealWorks does only export in the LAZ 1.2 version. The same behavior (warning to the user and reclassification to "Unclas-
sified") should be observed.

16.1.6 Alias/WaveFront (OBJ) Format

Alias/Wavefront is a provider of 2D/3D graphics technology for the film, video, games, interactive media, industrial design,
automotive industry and visualization markets. Their .OBJ ASCII file format is widely accepted for exchanging graphical
data between drafting applications. OBJ files contain solids which are made up of 3 or 4 sided faces. Only meshes can be
exported to this format.

To export to an Alias/WaveFront (OBJ) format file:
1. In the Export as OBJ File dialog, click on the Export Frame pull-down arrow.
2. Select a coordinate frame to apply from the drop-down list.
3. Click on the Unit pull-down arrow.
4. Select a unit system to apply in the Unit field.
5. Click Export.

Notes:
n A file of Alias/WaveFront (OBJ) format carries the obj file extension.
n Only a mesh can be exported. Trying to export anything else makes an error dialog appear.

16.1.7 MicroStation (DGN) Format
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DGN for DesiGN is a file format of Bentley MicroStation®. Exporting to this format means exporting a selection from
RealWorks to the MicroStation® format. You can only export one project at a time. MicroStation® includes the notion of lay-
ers which can be used as a tool for organizing and gathering information about a drawing. These layers can be considered
as an electronic version of traditional layers. In addition to the layers, this format includes the notion of working units which
are the real-world units that you work with in drawing or creating your models in a DGN file. The working units are set as
Master Units (the largest units in common use in a design, such as meters) and fractional Sub Units (the smallest con-
venient unit to use, such as centimeters or millimeters). The Sub Units cannot be larger than Master Units.

To export to a DGN format file:
1. Select data to be exported from the Models Tree.
2. In the Import/Export group, click on the Export pull-down arrow.
3. Choose the Export Selection feature from the list. The Export dialog opens.
4. Click on the File of Type pull down arrow.
5. Select MicroStation Files (*.DGN) as file type.
6. Locate a drive/folder to store the file in the Look In field.
7. Enter a name in the File Name field.
8. Click Save. The Export as DGN File dialog opens.

n Layer: This option allows you to define a number of layers.
n Export Of: This option allows you to choose which kind of objects you want to export: Selected Clouds and Geo-

metries, Selected Geometries and Selected Clouds.
n Export Frame: A project may have several coordinate frames. This option allows you to select which coordinate

frame from the drop-down list you want to apply to the exported data.
n Master Unit: This option allows you to select a unit system to the Master unit.
n Sub Unit: This option allows you to select a unit system to the Sub unit.
n Positional Unit: This option allows you to enter a value for the Positional unit.

9. Select the kind of objects to be exported in the Export of field.
10. Select the coordinate frame to be applied in the Export Frame field.
11. Select the unit system to be applied for the master unit in the Master Unit field.
12. Select the unit system to be applied for the sub unit in the Sub Unit field.
13. Enter a value for the positional unit in the Positional Unit field
14. Click Export.

Note: You can also select and export a scan/station of a project in the Models (or Scans) Tree.

16.1.8 Pointools Format

POD (Point Database) files are Bentley's native point cloud format. No specific dialog appears when you export a selection
to this format. A selection can be a cloud, a scan, a station or a project. Points, color, intensity and normal (if available)
information (from the selection) are then exported.

Note: The POD file format for Pointools does support the point cloud classification.

16.1.9 PTS Format

Only an object of cloud type can be exported to the PTS format. If you try to export anything else, like e.g. a pure geometry,
an error dialog appears. If the object has the two types, only the cloud property will be exported.

To export to a PTS format file:
n In the Export Options dialog, do one of the following:

- If there are several frames, select one to apply.
- Choose to export (or not) the color information by checking (or un-checking) the Export RGB Color option.

Note: The Exported Intensity option is always checked and dimmed. This means that the intensity information is
always exported.
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16.1.10 ASCII Format

ASCII is the acronym for American Standard Code for Information Interchange. Exporting to this file format involves export-
ing a selection from RealWorks to the ASCII format. You can only export one project at a time; in this case only point clouds
are exported. In such conditions, an ASCII file format is composed of a header (mainly comments) and a set of lines. Each
line is composed of one point with coordinates (X, Y and Z), and where present, attributes like intensity, normal or color.

To Export to an ASCII Format File:
1. In the Export as ASCII File dialog, choose an option among those listed below.

n Export Frame allows you to select which frame will be applied to the exported data.
n Unit allows you to select the unit system that will be applied to the exported data.
n Separator allows you to specify a separator to set between each value (Semicolon, Comma, Tabulation and

Space).
n Decimal Char allows you to specify the decimal char (Point or Comma).
n Coordinate System allows you to choose between the Cartesian system (X, Y and Z) and the Global system

(also called Geodetic Northing, Easting, and Elevation system).
n Decimal Places allows you to define the decimal places.
n Export Intensity allows you to export data with intensity attributes.
n Export Normal allows you to export data with normal attributes.
n Export RGB color allows you to export data with RGB color attributes.

2. Click Export. The Export as ASCII File dialog closes.

Note: You can also select and export a scan/station of a project in the Models (or Scans) Tree.

Caution: A warning appears in the case there is no cloud or the clouds are empty in the selection.

Note:When the selection is the whole project, no matter the name you enter in the Export Selection dialog, an ASC format
file is created for each station of the project. Each ASC file is named based on the station name. When the selection is a sta-
tion/scan, a unique ASC format file is created and it has the name you entered in the Export Selection dialog.

16.1.11 LandXML Format

Several companies, including Autodesk, teamed up to create a method for exchanging project information across different
software packages and LandXML is the result. LandXML is a generic, text-based file format used to save project data. It is
similar to a DXF™ file, which is a generic file format for vector-based drawing information.

To export to a LandXML format file:
1. Select a Mesh (or a Polyline)* from the Models Tree.
2. Select Export Selection in Home > Import/Export > Export.
3. Select the LandXML Files (*.xml) file type.
4. Click Save. The Export Selection dialog closes.

n Each Mesh will be exported as a surface,
n Each break-line (a 3D Polyline or a 2D Polyline with a Normal direction different from the Z-axis) will be exported

as a surface,
n All Contours (Polylines with a Normal direction parallel to the Z-axis) will be exported as a surface.

Note: (*) Selecting anything else will open a warning message.

16.1.12 Autodesk FilmBoX (BX) Format

The FBX file format is a proprietary format, owned by Autodesk. It is used to provide interoperability between applications
when creating digital contents. The entities you can export (from RealWorks) to a FBX format file are of two types:
Geometry and Mesh.

When you export a geometry, the geometry itself will not be exported but only its mesh version. This mesh version of the
geometry comes from a conversion with two parameters you have to set. The geometries you can export are listed here:
Box, Cylinder, Ellipsoid, Extrusion, Plane, Plane with hole(s), Pyramid, Rectangular torus (open or closed), Sphere. When
you export a mesh, whatever the type of the mesh (a merged mesh, a textured mesh or a colored mesh), it will be exported
as a mesh but without the color information.
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In the FBX format, the position and the orientation of an object are expressed in a right-hand coordinate system with the Y-
Axis directed to the Up. RealWorks has also a right-hand coordinate system, but with the Z-Axis directed to the Up instead.
When exporting, a conversion will be performed so that the views (Front, Up, Left) are identical in RealWorks and in the
FBX format.

To export as an Autodesk FilmBox format file:
1. In the Export as FBX (Autodesk FilmBox) File dialog, click on the Export Frame pull-down arrow.
2. Select a coordinate frame to apply from the drop-down list.
3. Click on the Unit pull-down arrow.
4. Select a unit system to apply in the Unit field.

n If a mesh has been selected as input, jump to step 5.
n If a geometry has been selected as input, define the Length and Angle parameters in the Convert to Mesh Para-

meters panel. Both of them control the accuracy of a conversion.
The Angle parameter expresses the maximum length when discretizing an arc.
The Length parameter lets the user define the maximum length of an edge in a triangle.

1 - An entity of geometry type
2 - A triangular polygon

3 - Angle parameter
4 - Length parameter

a. Input a distance value in the Length field.
And/or

b. Input a distance value in the Angle field.
5. Click Export. The Export as FBX (Autodesk FilmBox) File dialog closes.

Note: An object of Cloud, Point, Segment and Polyline type cannot be exported to the FBX format. A warning dialog opens
in case you try to export this kind of entity. At the same time, an empty FBX format file is created.

Caution:When a group of objects has been selected as input, the hierarchy of the objects in the group is preserved in the
FBX format.

Caution: Do not put the parameters Length and Angle too small. Otherwise, the conversion of the mesh will take a lot of
memory and time.

16.1.13 TDX Format

The idea behind the TDX format is to enable the exchange of data between Trimble Business Center and Trimble
RealWorks. The requirements for being able to export to the TDX format is to have a selection from the Project Tree, and to
be in the Registration configuration. The selection (input) can be everything from the Project Tree, but the result (output) is
the entire project.
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To export to the TDX format:
1. In the TDX Export dialog, choose an option:

n Standard: This option creates both a TDX format and a TDF folder which contains all scan files of the project.
n Linked to Current Project: This option creates only a TDX format file. No TDF

2. Click Export. The Export as DXF File dialog closes.

Note: Scan data (scans, stations, and leveling information) except images is not exported from RealWorks.

16.1.14 AutoDesk RCP format

RCP files are the project files for Recap from AutoDesk.

16.1.14.1 Inputs

Any selection of cloud types can be exported. In Production, the selection can be a project, a group, or a set of clouds. In
Registration, a selection can be a set of scans.

16.1.14.2 Outputs

If there is no frame other than the default one, i.e. the Home frame, only point clouds from the selection are exported with
the following attributes: Location (XYZ), Normal, Layer, Intensity and / or Color (if present), in Meters.

If there are several frames in the project, the Export Options dialog displays. You can choose a Frame to export.

Once the export is done, a file with the RCP extension and a folder, named following the file name with the "Support" exten-
sion, are created. For each selected object (scan or cloud), a scan, with the RCS extension is created.

Caution: ReCap has a hard limit of one point per cubic millimeter. As a result, the number of points in the Recap point cloud
may be less than the number of points of the exported point cloud.

16.1.15 Solids for AutoCAD

In RealWorks, the user can export the primitives listed in the table below.
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Notes:
n (1) Export in DXF version R14.
n (2) Possibility to export in DWG version R12, R13, R14, R15 (2000/2002), R18 (2004/2005), R21 (2007) and R24

(2010).
n (3) DWG export case: ellipse arcs are exported as segments from start to end point.
n (4) LWPolyline by default, Polyline when exporting coplanar polyline as 3D Polyline checked.
n (5) DWG export case: Less powerful than DXF export. Use the last R24 version for best results.
n (6) DWG export case: Full ellipses well managed, ellipse arcs are exported as segments.

16.1.15.1 AutoCAD (DWG) Format
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DWG - for DraWinG - is a binary file format used by AutoDesk's AutoCAD software. It can contain 2D or 3D objects. Export-
ing to the DWG format means to export a selection from RealWorks to the AutoCAD application. AutoCAD includes the
notion of layers which can be used as a tool for organizing and gathering information about a drawing. These layers can be
considered as an electronic version of traditional layers. The selection hierarchy is preserved during the export; each group
or lone object has its own layer. You can only export one project at a time; in this case every type of object (geometries and
clouds) in the project can be exported, except frames, measurements, feature code sets and registration entities.

To export to Solids for AutoCAD (DWG) format:
1. Select data to be exported from the Models Tree.
2. In the Import / Export group, click on the Export pull-down arrow.
3. Select the Export Selection feature from the list. The Export Selection dialog opens.
4. Click on the File of Type pull down arrow.
5. Select Solids for AutoCAD Files (*dwg) as file type.
6. Locate a drive / folder to store the file in the Look In field.
7. Enter a name in the File Name field.
8. Click Save. The Export as DWG File dialog opens.
9. Choose an option among the following:

n Version: This option lets you choose from the various versions of AutoCAD.
n Export Of: This option lets you choose the kind of object you want to export: Selected Clouds and Geometries,

Selected Geometries or Selected Clouds.
n Use UCS: This option enables the export of the data in the User Coordinate System.
n Use Slice Frame: This option allows the export of coplanar polylines in the same plane.
n Export Frame: A project may contain several coordinate frames. This option lets you select the coordinate frame

to apply to the exported data.
n Unit: This option lets you select the unit system to apply to the exported data.
n Cloud Rendering: This option lets you select a rendering to apply to the exported point cloud.
n Discretize Polyline Arcs: Coplanar polylines will be exported as 3D DXF polylines. That is to say that all circle

arcs will be discretized in segments.

10. Click Export. The Export as DWG File dialog closes.

Notes:
n You can also select and export a scan/station of a project in the Models (or Scans) Tree.
n Selecting Selected Geometries in the Export Offield will gray out the Cloud Rendering field.
n Selecting Selected Geometries in the Export Offield and the Use Slice Frame option will gray out the Export Frame

and Cloud Rendering fields, and Export Polylines in XY Plane option.
n Selecting Selected Clouds in the Export Of field will gray out the Use Slice Frame, Discretize Polyline Arcs and

Export Polylines in XY Plane options.

16.1.15.2 AutoCAD (DXF) Format

DXF - for Drawing eXchange Format - is an ASCII file format of an AutoCAD® drawing file. Exporting to the DXF format
means to export a selection from RealWorks to the AutoCAD application. AutoCAD includes the notion of layers which can
be used as a tool for organizing and gathering information about a drawing. These layers can be considered as an elec-
tronic version of traditional layers. The selection hierarchy is preserved during the export; each group or lone object has its
own layer. You can only export one project at a time; in this case every type of object (geometries and clouds) in the project
can be exported, except frames, measurements, feature code sets and registration entities.

To export to Solids for AutoCAD (DXF) format:
1. Select data to be exported from the Models Tree.
2. In the Import / Export group, click on the Export pull-down arrow.
3. Select the Export Selection feature from the list. The Export Selection 'Name of Data to be exported' dialog opens.
4. Click on the File of Type pull down arrow.
5. Select Solids AutoCAD Files (*.dxf) as file type.
6. Locate a drive/folder to store the file in the Look in field.
7. Enter a name in the File Name field.

Trimble RealWorks User Guide | 896



EXPORT

8. Click Save. The Export as DXF File dialog opens.
9.  Select an option among the following:

n Version: This option lets you choose from the various versions of AutoCAD
n Export of: This option lets you choose the kind of object to export: Selected Clouds and Geometries, Selected

Geometries or Selected Clouds.
n Use UCS: This option enables the export of the data in the User Coordinate System.
n Use Slice Frame: This option allows the export of coplanar polylines in the same plane.
n Export Frame: A project may contain several coordinate frames. This option lets you select the coordinate frame

to apply to the exported data
n Unit: This option lets you select the unit system to apply to the exported data.
n Cloud Rendering: This option lets you select a rendering to apply to the exported point cloud.
n Discretize Polyline Arcs: Coplanar polylines will be exported as 3D DXF polylines. That is to say that all circle

arcs will be discretized in segments.
n Project Polylines in XY Plane: All nodes of the polyline(s) are exported in the XY plane.

10. Click Export. The Export as DXF File dialog closes.

Notes:
n You can also select and export a scan/station of a project in the Models (or Scans) Tree).
n Selecting Selected Geometries in the Export Of field will gray out the Cloud Rendering field.
n Selecting Selected Geometries in the Export Of field and the Use Slice Frame option will gray out the Export Frame

and Cloud Rendering fields, and Export Polylines in XY Plane option.
n Selecting Selected Clouds in the Export Of field will gray out the Use Slice Frame, Discretize Polyline Arcs and

Export Polylines in XY Plane options.

16.1.16 IFC Format

IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the con-
struction industry. IFC is developed as an open standard by buildingSMART. You can select a geometry, a set of geo-
metries, a mesh, or a set of meshes to export to the IFC C2x3 format. When you select an entity other than a geometry or a
mesh, a warning pops up and nothing is exported.

The following entities are exported as geometries:
n Plane.
n Cylinder.
n Box.
n Extrusion.

The following entities are exported as meshes:
n Sphere.
n Cone.
n Rectangular torus.
n Circular torus.
n Mesh.

The following entities cannot be exported. A warning message pops up when such items are selected.
n 3D point.
n Segment.
n Polyline,
n 2D Measurement.
n Cloud.

Name and color information are exported to IFC format and you need to be in the Production processing mode.

Note: You need to select which coordinate system to export in case there are several coordinate systems available in the
project.

You can select a pipe group and export it to the IFC format:
n For a cylinder, a fitted cylinder is created .
n For an elbow, a fitted circular torus is created .

Trimble RealWorks User Guide | 897



EXPORT

n For a tee, a fitted cylinder and a fitted sphere are created.
n For a reducer, a fitted regular cone is created.

16.2 Advanced Exports

The Advanced Exports features are dedicated to the export of an object (or set of objects) created within RealWorks.

16.2.1 Export Object Properties

You can export the properties of an object (or a set of objects) properties into a report in the RTF file format. These prop-
erties are those found in the Property window

To export the properties of an object:
1. Select a project (or group, station or other object) from the Project Tree.
2. Select Export Object Properties in Home > Import/Export > Export.
3. Choose one of the following:

n Selection: The properties of the selected object will be exported. If there are some sub-objects under the selec-
ted object; all the properties of the sub-objects will be exported as well.

n Project of Selection: The properties of all objects and sub-objects that belong to the project of the selection will
be exported.

n All Project Trees: The properties of all objects and sub-objects that belong to the Scans, Targets, Models and
Images trees will be exported.

16.2.2 Export Images

You can export a single image (or a set of images) to the JPEG format.

To export an image:
1. Select an image (or a set of images) from the Images Tree.
2. Select Export Image in Home > Import/Export > Export.
3. Or select Export Image from the pop-up menu.

n If one image has been selected, the Export Image dialog opens.
n If several images have been selected, the Export Image dialog opens for each select image.

16.2.3 Export Ortho-Images

Tiff (or Tif) is the acronym for Tagged Image File Format. It is one of the most popular and flexible current public domain ras-
ter file formats. Exporting an ortho-image involves saving it in a Tiff (or Tif) format. With the Tiff image, is created a file of the
same name and with the TXT extension. This file contains the four corners for the Tiff image: Top Left, Top Right, Bottom
Left and Bottom Right. These corners are useful for locating an ortho-image in 3D.

To export an Ortho-Image:
1. Select an ortho-image from the Images Tree.

2. Select Export Ortho-Image in Home > Import/Export > Export.
3. Or select Export Ortho-Image from the pop-up menu.

Notes:
n To export an ortho-image as a 3D Tiff, first select the Export Selection feature, and then the AutoCAD Files (*.dxf)

type file.
n If a set of ortho-images has been selected, the export will be done one by one from the first to the last. The user only

needs to click Save for each ortho-image.

16.2.4 Export Measurements

You can export a measurement (or a set of measurements) as a report in the Excel format (*.CSV files). Only meas-
urements from an active project (selected project) can be exported. For a Point to Point Distance Measurement, its type,
name, length, delta X, delta Y, delta Z, extremity 1 and extremity 2 values will be exported. For an Angular Measurement,
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its type, name and the angle value will be exported. For a 3D Point Measurement, its type, name and X,Y,Z values. For an
Orientation Measurement, its type, name and the center, azimuth angle and tilt angle values will be exported.

To export a measurement:
1. Select a measurement from the Models Tree.
2. Select Export Measurements in Home > Import/Export > Export.
3. Select one of the following:

n Export Frame: This option enables to select a frame that will be applied to the exported data.
n Separator: A separator can be a Semicolon, Comma or Tabulation.
n Decimal Char: A decimal symbol can be either a Point or a Comma.
n Options: There are five types of measurement: Point to Point Distance Measurement, Angle Measurement, 3D

point Measurement, Orientation Measurement and Polyline Measurement. Only one type can be selected at a
time.

Notes:
n The required Separator when exporting to the CSV format is a Comma. If you select a Semicolon (or Tabulation)

Separator instead, a warning message appears and informs you that the measurement(s) will be exported as a TXT
format report.

n When you select a type of measurement from the Models Tree, only the option (from the Options panel) of the same
type is enabled and the other options are dimmed. When you select several measurements with all types, the four
options are enabled. You need to choose an option; otherwise the Export button remains dimmed.

n You cannot use a Comma Separator with a Comma Decimal Char.

16.2.5 Export Feature Sets

Generally, a Feature Point is composed of three items: Point Number, Point Coordinates and Point Feature Code. Name
and description are optional. Exporting a Feature Set from RealWorks involves exporting such a set of information in an
ASCII file format.

To export a feature set:
1. Select a feature set from the Models Tree.
2. Select Export Feature Sets in Home > Import/Export > Export.
3. Select one of the following:

n Export Frame: This option enables to select a frame that will be applied to the exported data.
n Unit: This option enables the selection of the unit system that will be applied to the exported data.
n Separator: A separator can be Semicolon, Comma and Tabulation.
n Decimal Char: A decimal char can be either a Point or a Comma.
n Feature Set Export Options: Options in that panel enable to express a Feature Set in either the Cartesian

coordinate system or the Global coordinates system. If required, the user can add a description.

Notes:
n You can only export one Feature Set at a time. If you select a set of Feature Sets, only the last (from the selection

list) is exported.
n The Dash-Line Segments (or Continuous Segments) that have been chosen to link each Feature Point in the

Feature Set tool are not exported.
n You cannot combine a Comma Separator with a Comma Decimal Char.

Warning: A warning message appears if the selection (as input) is not a feature set and the export is aborted.

16.2.6 Export TZF Images

You can export each TZF Scan as a JPEG image file. Each pixel that composes a TZF Scan will be exported.

To export TZF images:
1. Select a project (or a set of stations or a station) or a TZF Scan.
2. Select Export TZF Images in Home > Import/Export > Export.
3. Choose a layer to export: Luminance Only, Color Only or Both Luminance and Color.
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n For each TZF Scan, a JPEG image file is created.
n If a luminance layer is found and the Luminance Only (or Both Luminance and Color) option has been checked,

the file is created with the name TZF_FileName_Intensity.
n If a color layer is found and the Color Only (or Both Luminance and Color) option, the file is created with the

name TZF_File_Name_Color.

Notes:
n A warning dialog will open if there is no TZF Scan within your selection.
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog will open.

Note: All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

Note: RealWorks internally computes the final number of points a full resolution extraction takes, and then checks the local
disk place. If there is a risk for the operation to fail due to a lack of disk space, an information box pops up, and displays an
estimated amount of needed space and the actual space left on the selected disk. If there is no risk, nothing happens.

Note: In the case where the JPEG image files are not writable to the folder (lack of space or lack of permissions), an Error
message is then shown.

16.2.7 Convert TZF Scans to Gridded E57/PTX/PTS/RCP

PTX, PTS, E57and RCP are extensions for laser scanning files.

To convert TZF Scans to gridded E57/PTX/PTS/RCP:
1. Select a station (or a set of stations or a project)* (with TZF Scans within) from the Project Tree.
2. Select Convert TZF Scans of Selected Stations (Gridded E57/PTX/PTS/RCP) in Home > Import/Export > Export.

n If the selection is a station (or a set of stations), the Convert to Gridded E57/PTX/PTS/RCP dialog opens.
n If the selection is a project, a dialog opens and asks to process all stations of the selection (or to abort).

SAMPLING BY STEP:
In this sampling method, one point will be taken into account at each defined Step vertically and horizontally in
the 2D Image Data.
E57:

The E57 format is a file format specified by the ASTM (American Society for Testing and Materials), an inter-
national standards organization. It is compact and vendor-neutral. It was developed for storing data (Point
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Clouds, images and metadata) produced by 3D imaging systems such as laser scanners. Such format enables
data interoperability among 3D imaging hardware and software systems and is not dependent on proprietary
formats for storing and exchanging data.

Note: An E57 format file is created for each TZF scan. The E57 format file is named according to the name of
the TZF format file.

Note: Each TZF Scan is exported to the E57 format as a regular grid point set.

PTX:

A PTX format file contains a set of line information. The Number of Columns and the Number of Points per
Column in the file are respectively at the first and the second line followed by a series of sets of lines. The Num-
ber of Lines in a set corresponds to the Number of Points. The first set - which comes after the two first lines of
the file - defines the first column, the next set the second column, and so on. Each line corresponds to a Point
with the following information: x,y,z,i (from 0.0 to 1.0). If there is no scanning data (because of sky e.g.), the
Point on the column still exists but contains zero.

Notes:
n The PTX option writes the station registration information in the file header and keeps point coordinates

unchanged.
n The unit of measurement is set to Meter.

A PTX format file is created for each TZF scan. The PTX format file is named according to the name of the TZF
format file. If the TZF Scan is colored, the color information is also exported into the PTX format file.

PTS:

A PTS format file contains a set of line information. The Number of Points in the file is at the first line followed by
as many lines as there are points. Each line corresponds to a Point with the X,Y,Z coordinates, intensity inform-
ation (from -2047 to +2048).

Notes:
n The PTS option first applies the station registrations to the point coordinates and then writes them.
n The unit of measurement is in Meter.
n A PTS format file is created for each TZF scan. The PTS format file is named according to the name of

the TZF format file.

RCP:

A file with the RCP extension and a folder named following the file name with the Support extension will be cre-
ated. For each selected object (scan or cloud), a scan with the RCS extension will be created.

Note: (*) The stations can be empty.

Notes:
n If the TZF format file(s) has (have) not been yet processed, the Processing TZF Scans dialog will open.
n All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

Note: RealWorks internally computes the final number of points a full resolution extraction takes, and then checks the local
disk place. If there is a risk for the operation to fail due to a lack of disk space, an information box pops up, and displays an
estimated amount of needed space and the actual space left on the selected disk. If there is no risk, nothing happens.
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16.2.8 Export Inspection Maps and Slices

Each inspection map is a plane which has two directions (Vertical and Horizontal) whatever the shape (Plane, Tunnel or
Cylinder) it has. The two directions are illustrated by the Red and Green axes. You can export an inspection map to the Tiff
format or all of the slices done on the comparison surfaces to the DXF (or DWG) format. Slices can be vertical (parallel to
the Green axis) or horizontal (parallel to the Red axis). Tiff is the acronym for Tagged Image File Format. It is one of the
most popular and flexible current public domain raster file formats. The DXF file format is an ASCII file format which
describes CAD data defined by AutoDesk. This file format facilitates the exchange of CAD data between two different pro-
grams. The DWG file format is the binary file format from AutoCAD and AutoCAD LT.

16.2.8.1 Export an Inspection Map

Exporting an inspection map from RealWorks involves saving it in the Tiff format. A TXT format file is also created. This file
will contain four corners (Top Left, Top Right, Bottom Left and Bottom Right). These corners are useful for situating an
inspection map in 3D.

To export an inspection map:
1. Select an inspection map from the Project Tree.
2. Select Export Inspection Map in Home > Import/Export > Export.
3. Or select Export Inspection Map from the pop-up menu.
4. In the Inspection Map Export Optionsdialog, choose an option:

- Export Distances to only export a distance map.
- Export Color Layer to only export a colored map.

Note: The Inspection Map Export Options will not open if the inspection map to export is only a distance map.

Notes:
n You cannot export an inspection map that is not already created in the database.
n If a set of inspection maps has been selected, the export will be done one by one.

16.2.8.2 Export Horizontal Slices

The Horizontal Slices are obtained by slicing an inspection map along the Red axis (of its own frame) in case of a Plane (or
a Tunnel) and along the Green axis in case of a Tunnel. The slicing is done with a constant interval. These slices are the
same as those obtained when multi-slicing in the Sections & Shifts in the Inspection Map Analyzer tool. A single slice is a
pair of Red Section and Green section. A Red Section results from the slicing over the Reference Surface. A Green Section
is one from the Comparison Surface. When you export the slices to DXF (or DWG), the order is preserved. Each slice has
its own layer (also called Level). For a given slice, the difference of elevations between the Red Section and the Green Sec-
tion is displayed with a value (in green), in the current unit of measurement. This difference can be displayed along the slice
with a constant interval (value in gray) that the user has to define.

To export the horizontal slices:
1. Select an inspection map from the Project Tree.

2. Select Export Inspection Map Horizontal Slices in Home > Import/Export > Export.
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3. Choose a format between DWG and DXF.
4. Set one of the following:

n Horizontal Interval: This interval is a constant step used for displaying the difference in elevations between the
Red Section and the Green Section. This constant step is a distance value.

n Vertical Interval: This interval is a constant step used for slicing horizontally the inspection map. It is the same as
the Interval used in Section & Shifts (in Inspection Map Analyzer tool) when multi-slicing. This constant step is a
distance value when the inspection map is a Plane (or Tunnel). It is an angle when the inspection map is a Cylin-
der.

n Amplification Factor: This factor is used for magnifying the differences in elevations when they are too small for
viewing.

n Reference Surface Title: This option enables to define a name for the Reference Surface.
n Comparison Surface Title: This option enables to define a name for the Comparison Surface.
n Layer Numbering Offset: This option enables to shift the naming of the exported slices.
n Unit: This option enables to choose a unit of measurement.

Notes:
n The unit of measurement for a distance value is by-default set to Meter; you do not have to enter “m” and you can

change it when necessary (refer to the Preferences options for more details).
n The unit of measurement for an angular value is by-default set to Degree; you do not have to enter “°” and you can

change it when necessary (refer to the Preferences options for more details).

Caution: In Sections & Shifts of the Inspection Map Analyzer tool, you cannot slice an inspection map of tunnel shape hori-
zontally while in the Export Inspection Map Vertical Slices feature you can.

From a Plane Inspection:
If the selected inspection map is a Plane; a Horizontal Slice has the shape shown below:
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1 - The difference of elevations between the
Reference Surface and the Comparison Sur-
face at constant interval

2 - The Hori-
zontal Interval
parameter

3 - The Vertical Interval
parameter (=between two
consecutive slices)

From a Cylinder Inspection:
If the inspection map is a Cylinder; a Horizontal Slice has the shape shown below:
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1 - The Vertical Interval para-
meter (between two con-
secutive slices)

2 - The Hori-
zontal Interval
parameter

3 - The difference of elevations between
the Reference and Comparison surfaces
at constant interval

From a Tunnel Inspection:
If the inspection map is a Tunnel; a Horizontal Slice has the shape shown below:
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1 - The Hori-
zontal Interval
parameter

2 - The Vertical Interval para-
meter (=between two con-
secutive slices)

3 - The difference of elevations between
the Reference and Comparison surfaces
at constant interval
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If an Alignment Stationing has been applied to the selected 3D Path, the stationing information in the drawing helps the
user to visualize which Horizontal Slice is at which position along the alignment

Note: You can specify the style used to format a station value in the Preferences / Units.

16.2.8.3 Export Vertical Slices

The Vertical Slices are obtained by slicing an inspection map along the Green axis (of its own frame) in case of a Plane (or
a Tunnel) and along the Red axis in case of a Cylinder. The slicing is done with a constant interval. These slices are the
same as those obtained when multi-slicing in Sections & Shifts in the Inspection Map Analyzer tool. A slice is a pair of Red
Section and Green Section. A Red Section results from slicing over the Reference Surface. The Green Section is the one
from the Comparison Surface. When you export the slices to DXF (or DWG), the order is preserved. Each slice has its own
layer (also called Level). For a given slice, the difference of elevations between the red and green sections is displayed with
a value (in green) in the current unit of measurement. This difference can be displayed along the slice with a constant inter-
val (value in gray) that the user has to define.

To export vertical slices:
1. Select an inspection map from the Project Tree.
2. Select Export Inspection Map Vertical Slices in Home > Import/Export > Export.
3. Choose a format between DWG and DXF.
4. Set a parameter:

n Horizontal Interval: This interval is a constant step used for displaying the difference in elevations between red
and green sections. This constant step is a distance value when the inspection map is a Plane (or Tunnel). It is
an angle when the inspection map is a Cylinder.

n Vertical Interval: This interval is a constant step used for vertically slicing the inspection map. It is the same as
the Interval used in Section & Shifts when multi-slicing. The constant step is distance value.

n Amplification Factor: This factor is used for magnifying the differences in elevations when they are too small for
viewing.

n Reference Surface Title: This option enables to define a name for the Reference Surface.
n Comparison Surface Title: This option enables to define a name for the Comparison Surface.
n Layer Numbering Offset: This option enables to shift the naming of the exported slices.
n Unit: This option enables to choose a unit of measurement.

Notes:
n The unit of measurement for a distance value is set by default to Meter; you do not have to enter “m” and you can

change it when necessary (refer to the Preferences options for more details).
n The unit of measurement for an angular value is set by default to Degree; you do not have to enter “°” and you can

change it when necessary (refer to the Preferences options for more details).

From a Plane Inspection:

If the selected inspection map is a Plane; a Vertical Slice has the shape shown below:
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1 - The difference of elevations between
the Reference and Comparison surfaces
at constant interval

2 - The Ver-
tical Interval
parameter

3 - The Horizontal Interval
parameter (=between two con-
secutive slices)

From a Cylinder Inspection:

If the selected inspection map is a Cylinder; a Vertical Slice has the shape shown below:
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1 - The difference of elevations between
the Reference and Comparison surfaces
at constant interval

2 - The Ver-
tical Interval
parameter

3 - The Horizontal Interval
parameter (= between two
consecutive slices)

From a Tunnel Inspection:

If the selected inspection map is a Tunnel; a Vertical Slice looks as illustrated below.
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1 - The Ver-
tical Interval
parameter

2 - The Horizontal Interval
parameter (=between two
consecutive slices)

3 - The difference of elevations between
the Reference and Comparison surfaces
at constant interval

If an Alignment Stationing has been applied to the selected 3D Path, the stationing information can be found in two loc-
ations:

n In the title of each drawing. This helps the user to visualize which Vertical Slice is at which position along the align-
ment:
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n And in the title of each layer:

Note: You can specify the style used to format a station value in the Preferences / Units.

16.3 Import and Register

The Import Scans and Register feature is a batch processing tool. It enables to execute a sequence of three action types in
a Wizard manner, i.e. Input Preparation (selection of gridded scan data files in TZF format and non-TZF format, conversion
of non-TZF format files to TZF format files, etc.), Data Extraction (creation of sampled scans, station panoramic images,
etc.) and Scan Registration (with the Plane-Based or Target-Based method).

16.3.1 Start to Import and Register

The Import Scans and Register feature is available indifferently in the Registration module or in the Production module. It is
accessible from the Home tab, in the Import/Export group, and can be launched within an existing project or with no project.
In the first case, if the project is not saved yet, Trimble RealWorks will prompt to save it first. If there are some scans in the
project, they will be selected and sent to the Import Scans and Register feature, keeping the group hierarchy they are in.
More scan files may be added afterward. In the second case, Trimble RealWorks will prompt to create a new project with
PROJECT1 as default name. A RWP format file, a RWI folder and a PROJECTNAME_Batch_Output folder are created
under the location specified by the user. The latter folder is used for storing various batch output files: RMX, log and station
panorama.

Caution: Do not process more than one time over a given dataset under the same project. If done anyway, the Import
Scans and Register will duplicate extracted objects.

Note: Trimble RealWorks disables once the Import Scans and Register feature is started.

16.3.2 Select Scan Data Files

The Import Scans and Register feature does only support the gridded scans data with the following formats:
n TZF: Trimble scan file format.
n TZS: Historical Trimble scan file format.
n PTX: ASCII based for scan file format.
n FLS: Scan file format from Faro Scene. It is a result of the import of raw scan files provided by a Faro laser scanner.
n ZFS: Scan file format from Z+F instrument aside with ZFPRJ for project file and ZFI for images.
n E57: File format specified by the ASTM (American Society for Testing and Materials), an international standards

organization. It is compact and vendor-neutral. It was developed for storing data (point clouds, images and
metadata) produced by 3D imaging systems such as laser scanners.

n RSP: Project file format from Riegl. This file is text file using an XML structure, and does not contain scan data but
only links to the scan data files which are stored in the RDB folder.
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n Select Files: Enables to select a scan data file (or set of scan data files) to be added to the list of files to be imported.
The selected file (or set of files) can be of (or a mix of) any supported file formats.

n Select Folder: Enables to select a folder (or a set of folders) to be added to the list of files to be imported. All files
from the set of supported formats found under the selected folder(s) / sub folder(s) will be added to a default group.
The disk hierarchy will not be kept.

n New Group: Enables to create a new group.

If there is no existing project in Trimble RealWorks, all selected files will be added in a one-level group whose name is
Default Folder. The user will be able to rename this default group either by pressing F2 or double-clicking the name. If there
is an existing project in Trimble RealWorks, all TZF Scans files rooted directly under the project node will be selected and
put under a group named Scans Tree. Those that are under a first level group in Trimble RealWorks will be selected and
put under a first level group in the Import Scans and Register dialog with the same name. Those that are under a second
level group will not be selected and processed.

Caution: If there are some TZF format files out of the project RWI folder. These files will not be selected and processed.
When saving an existing Trimble RealWorks project file as a new project, please choose to copy the TZF Scan files into the
new project. It is possible to retrieve locally the TZF format files using the Get TZF Scan Files button of Trimble RealWorks.
It is also possible to retrieve locally the TZF Scan files using the Get TZF Scan Files button of Trimble RealWorks.

To remove a scan data file or a folder from the list of files to be imported, press the Red Cross at its right side. To remove all
files, click the Remove All button. Once scan data files are added, the total number of files to be processed displays in brack-
ets in the dialog.

Note: A Riegl's RSP format file is a project file that points to a set of scan data files. The number of files displayed in the dia-
log does not reflect the RSP format file itself but the number of scan data files.
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All selected TZF format files will be copied to the project RWI folder. TZF format files, that need processing (Extended-
Range, Color, Re-projection, etc.), will be processed into new TZF files to the RWI folder. When processing the TZF format
files, the Import Scans and Register feature will re-compress the TZF format files. All non-TZF format files will be converted
to the TZF format. For those requiring additional inputs (i.e. the FLS format and the ZFS format), the corresponding import
parameters dialog pops up.

FLS Extraction Options:

n GNSS: Adds the GPS information to the scan data.
n Tilt and Compass: Imports the Leveling information. The inclination of scans will be used during the process of the

registration of overlapping scans. Imports the Orientation information, if the scan data was recorded with an instru-
ment equipped with a built-in Compass.

n Color: Adds the Color information to the scan data (if they were recorded with color).
n Equalize Luminance: Equalize point cloud luminance. This enhances the visual perception of the luminance but

might slightly affect the auto-extraction performances.
n Force Full Scan: This option enables the creation of an uncropped TZF Scan, by keeping empty pixels. Empty

pixels are on outdoor scans with large pieces of sky (Zenith) and no tall objects foreground (Nadir).

Z+F Extraction Options:
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n Filter by Intensity: This filter, when it is chosen, discards pixels that are below the Min. value and above the Max.
value in terms of Intensity. These two values are defined in percentage by the user. The default values depend on
the type of the scanner.

n Filter by Range: This filter, when it is chosen, discards pixels which are not in the defined range. The filter is not act-
ive when the Min. and the Max. values are equal to zero.

n Filter Edge Points: This filter, when it is chosen, removes pixels, which are on edges of objects and therefore not
valid. On edges you have mixed range values, these range values are often between the foreground and the back-
ground (but also possible in front or behind objects).

n Filter Bottom: This filter, when it is chosen, removes pixels from the bottom of the instrument (Nadir) up to a user
given angle.

n Remove Isolated Points: This filter, when it is chosen, removes pixels which have no valid neighbor.
n Remove Bad Lines: This filter, when it is chosen, deletes the first scan lines of recording, marked by the scanner as

“bad” due to laser warm-up procedure at the early beginning of the scan (first few scan-lines).
n TZS: Historical Trimble scan file format.
n Remove Scan Outer Boundary: This filter masks pixels at the outer borders of the scan. The first and last line and

the first and the last pixel of each line are filtered.
n Remove Points at Range Discontinuities: This filter detects jumps in range and filters out pixels.
n Remove Lines at Tilt Discontinuities: This filter, when it is chosen, removes lines which show too big tilt changes.

Note: The Import Scans and Register feature cannot import directly surveyed data produced by a data collector such as
Total Stations (or Field Stations, etc.), i.e. Topo Points. However, it is possible to use an existing project containing Topo
Points.

16.3.3 Set Point Cloud Extraction Options

There are three extraction methods available and only one extraction will be performed at a time.

n Sampling by Step: With this sampling method, one point will be taken into account at each defined Step vertically
and horizontally in the 2D image data.

n Spatial Sampling: With this sampling method, you will obtain a point cloud with a homogeneous spatial density that
you have to define.

n Extract Preview: This option, when enabled, will create a scan by first getting points, not based on a TZF Scan but
from its preview, and by computing the normals on them. A scan is always named Preview. The number of points
for each is less than two million points.

n Filter by Range: This filter will let you to define twos distances (from the center of the instrument), before and bey-
ond which no point will be taken into account. This filter is only applied to the scan data.

Note: The default unit of measurement is the unit of measurement set in the Preferences / Units in Trimble RealWorks.

Note: A RWCX format file will be created for each extracted point cloud and, this file will be put under the RWI folder.
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16.3.4 Set Scan Data Registration Options

The user can register the data by using two available features, the Auto-Register Using Planes feature which enables to
automatically register the data by extracting planes in the scans and matching them without using targets and the Target-
Based Registration feature which registers the stations by extracting targets and automatically matching them together.

The Auto-Register Using Planes feature does not require any input parameter:

The Target-Based Registration feature allows the user to select between Black andWhite Flat Target and Spherical Target
as type to use. To select Black andWhite Flat Target, click the Black andWhite Flat Target button. To select Spherical Tar-
get, first enter a value in the Diameter field and then click the Spherical Target button.

Note: The default unit of measurement is the unit of measurement set in the Preferences / Units in Trimble RealWorks.

Note: A Black andWhite Flat Target can appear only once as it has no size while a Spherical Target can have several
sizes, thus appearing several times in the target list. The target extraction will be launched sequentially for the two types (if
the types have been defined) and for every diameter (if multiple sizes have been defined).

To remove a type of target to use, select it from the target list and press the Remove button at its right.

A Reference Station is a station whose position and orientation remain unchanged through the registration process. The
Import Scans and Register feature will use the first leveled station as the Reference Station. If no station is leveled, an arbit-
rary station is used. All registration operations are performed on groups, each group having its own Reference Station.
Groups are not registered together.

16.3.5 Process Files in Batch Mode

To execute the batch process once you have introduced all the necessary values, press the Start button. The Import Scans
and Register feature starts executing a sequence of actions. The progress of each action can be visualized thanks to a pro-
gress bar, 100%Green meaning "Succeeded" and 100% Red meaning "Failed". The Batch Monitor window, that appears,
displays for each selected TZF format file, the below progress bars:

n Importation (of the TZF format file).
n Copy of the imported TZF format file to the RWI folder.
n Extraction of the station panoramic image (from the TZF format file).
n Creation of a sampled scan (from the TZF format file).
n Addition of the created sampled scan in the RWI folder
n If a set of ortho-images has been selected, the export is done one by one from the first to the last. The user only

needs to click Save for each ortho-image.

And for all the selected TZF format files, the below progress bars:
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n Registration.
n Extraction of RMX format files.
n Update of TZF format files.
n Job status

There are three groups: In Progress, Completed and Failed. When the batch process starts, all steps initially are stacked in
the In Progress group.

Once a step is completed and succeeded, it is moved down under the Completed group.

If the step is completed and failed, it is moved down to the Failed group.

Before starting the batch processing, the user can go back and modify any parameters. Once the batch processing is
launched, the Start button becomes disabled. When the batch processing ends, the Finish button becomes enabled. A
folder whose name is Project Name_Batch Output opens and contains the items listed below:

n Registration Report is a report in the RTF format file.
n RMX Folder which contains a set of RMX format files, one per TZF format file. A RMX format file is an ASCII-based

file which contains the registration parameters (vector of translation, axis of rotation and angle of rotation).
n Set of JPG station panoramic images with the luminance information and / or with the color information (if avail-

able).

When the batch processing is ended, press the Close button. Trimble RealWorks switches back to "Enabled" in the Regis-
tration mode showing all scans.

Once launched, the batch process cannot be paused but canceled. All completed operations will be reflected in the project
file as the RWP file is saved on the go after every successful operation.

Note: An empty registration report means that a registration has been attempted but gave no result (no matching).
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You can share your data for collaboration purposes in a customizable and professional format. You can publish your pro-
ject, and view it easily in any web browser. The published project will be viewed in a 2.5D view. You have the ability to take
measurements, add annotations, and/or extract data from the published project.

17.1 Publish

The input of Trimble Publisher is a single project with at least one TZF format file within. Otherwise, the feature is grayed
out. If the TZF format file has not yet been processed, the Processing TZF Scans dialog opens and prompts you to proceed
to do so. The output of the feature, both a published project and an embedded version of Trimble Scan Explorer, can then
be distributed via a media like a USB flash drive or DVD-Rom. To be able to view a published project with the embedded
version of Trimble Scan Explorer, the user needs to have a 64-bit OS (Seven, 8, 8.1 and 10), .Net Framework 4.7.1 and
Visual C++ Redistributable X64 2010, 2012, 2015 and 2017.

Note: All leveled TZF Scans will be automatically re-projected during the Post-Processing step.

To publish a project:
1. Select a project from the Project Tree.

2. Select Publish in Home > Sharing. The Publish 'Project_Name' dialog opens*.
3. Define the layout of a publication.
4. Add media in a publication.
5. Add links in a publication.
6. Reduce the data size.
7. Enable data extraction.
8. Click Publish to start publishing.

Tip: You can abort the publication in progress by clicking Cancel.

Note: (*) If the selected project contains some TZF Scans for which the links to the TZF format file are broken, a warning
dialog with all missing TZF files appears. Click OK to close it. The Publish 'Project_Name' dialog opens then.

Note: A RealWorks temporary project file is created during the publishing process. This project file is named according to
the current project name followed by the word "Publisher". It will disappear once the publishing process is terminated.

17.1.1 Define a Layout

The default name in the Title field is the name of the selected project. It's up to you to give a name other than this default
one. The default (or defined) Title is the one which appears at the top of the published page. A Logo (or a Project Image) is
an image file that may have the following formats: bmp, jpg, png and gif. The Logo will appear at the top left corner of the
published page, next to the Title. The Project Image will appear below the Title.

The Output folder is the folder where all the published files are located. The default path to the Output folder is C:\User-
s\User_Name\Documents. The default Background Color is yellow. The default Font Color is dark gray.

To define a layout:

17
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1. Click on the Page Configuration tab.
2. Set one of the following:

n Title,
n Logo - Click Open to add a logo file.
n Project Image - Click Open to add an image file. If there is no Project Image file, the image of the first sta-

tion will be used by default and will be stored under the Data folder.
n Output - Click Open to define an output folder.
n Background - Select a Standard Color (White, Gray, Black, Red, Green, Blue, Yellow, Orange, and Purple) or

click Advanced to define a color.
n Font Color - Select a Standard Color (White, Gray, Black, Red, Green, Blue, Yellow, Orange, and Purple) or

click Advanced to define a color.

17.1.2 Include a Media

AMedia item can be either an image or a video. An image file may have the following formats: jpg, jpeg, png, gif, and bmp.
A video file can be of the following formats: WebM, Avi,MP4 and flv.

WebM is a new open standard for compressing Video content. It is based on both the VP8 and Vorbis, respectively for the
Video and for the Audio. Avi (Audio Video Interleave) is a multimedia container format from Microsoft. MP4, an abbreviated
term for MPEG-4 Part 14 or MPEG-4 AVC, is also a multimedia container format. FLV known as Flash Video, is a video file
format used to deliver video over the Internet using Adobe Flash Player.

All added media will be embedded on the published page, below the Project Image pane.

Note: There is no restriction to the number of Media items you can add.
To add a media file:

1. Click Open . The Open dialog opens.
2. Navigate to the drive/folder where the Media file is located.
3. Click on the file to select it. Its name appears in the File Name field (in the Open dialog).
4. Click Open. The Open dialog closes.

n The selected Media's name is displayed in the Title field.
n Its Path appears in the File Path field.

Note: First click on the Media tab.

Tips:
n You can manually enter the path of a Media to include when publishing.
n You can also manually edit a Media's name in the Title field.

To add another media file:

1. Click Add . Another Media line is added to the previous one. becomes as illustrated below.

2. Click Open to add another media file.

Notes:
n First click on the Media tab, if not done.
n You cannot add another Media file unless the first Media has been added.

To remove a media file:
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n From the Media tab, click Subtract to remove the related line.

Note: You cannot remove a Media file if there is only one.

17.1.3 Add a Link

What is a Link? A Link can be either a Path or URL pointing to a document, a Web page, etc. All added links will appear on
the published page, below the Project Image pane.

To add a link:

1. Click Open . The Open dialog opens.
2. Navigate to the drive/folder where the Link file is located.
3. Click on the file to select it. Its name appears in the File Name field.
4. Click Open. The Open dialog closes.

Note: First click on the Links tab.

Tips:
n You can manually enter the path of a Link to include when publishing.
n You can also manually edit a Link's name in the Title field.

Caution: If you add an application (.exe); it could not work if all dependencies (of the application) are not present.

Note:When a Link points to a document, the document is copied into the final published project.

To add another link:

1. Click Add . Another Link line is added to the previous one. becomes as illustrated below.

2. Click Open to add another link.

Notes:
n First click on the Links tab, if not done.
n You cannot add another Links unless the first Link has been added.

To remove a media file:
n From the Links tab, click Subtract to remove the related line.

Note: You cannot remove a Link if there is only one.

17.1.4 Reduce the Size of the Data

You can publish with, or without reducing the size of the data. With the Full File Size option, no compression is applied. With
the Large File Size, or Medium File Size, or Small File Size option, a Spatial Sampling (with a Step of 6 mm) is applied, redu-
cing by this way the number of points. With the Medium File Size, or Small File Size option, each TZF Scan of the project is
resized. The length and the width are divided by two each time. The File Size is the size of the project in the Data folder,
once the sampling and the reduction of size are applied. The Estimated Time is the time required to process the whole pro-
ject.

To reduce the size of the data:
n Drag to the slider up or down to choose a reduction level.

The information about the "File Size" and the "Estimated Time" are not available if for each TZF Scan (of the pro-
ject), the link to the TZF format file is broken.
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17.1.5 Enable the Extraction of the Data

The Enable Extract option is by default unchecked. It activates removal of the Extract Points feature from the Trimble Scan
Explorer Web Viewer. This means that the user cannot extract any points from the published data.

Caution: You will be warned that your data will be published with extraction capabilities if the Enable Extract option is
checked.

Note: If the Enable Extract option is kept unchecked, a TZF format file, once published in the Data/RWI folder, is locked. Its
icon is grayed-out if you try to load it in RealWorks.

17.1.6 View the Publication

Once you start publishing your project (by clicking Publish), two progress bars appear, one for all the TZF format files and
one for a TZF format file. Once the publication is completed, you may see the following texts: "Publish Succeeded" and "Nb.
of files processed in minutes and seconds".

A main folder, named according to the name given in the Title field, is created under the default (or defined) Output Folder.
The day and time information are added to the main folder (respectively in the Day-Month-Year and Hour-Minute-Second
format). A sub-folder named Dependencies with three folders (Bin, Data andWeb) and an executable are created under
the main folder.

Note: The publication may be a success even if the links (from the TZF Scans to the TZF format files) are broken. You will
see the text "0 files Processed".

BIN FOLDER - This folder is used to embed the Trimble Scan Explorer application files.

DATA FOLDER - This folder is where a published project is stored. By default, a published project shares the same name
as the original project (project to publish) or the name defined by the user in the Title field. A published project in the Data
folder is a replica of the project that has been published (from RealWorks). This means that there is a RWP file and a RWI
folder within (the Data folder). Each TZF format file from the project to publish is replicated in the published project in the
RWI folder in the Data folder but with a size other than the original ones (due to the size reduction).

Caution:Only TZF Scans and images (RWV) are published.

Note: All the Point Clouds of a published project are not accessible. Only TZF Scans and images are accessible. An error
message appears if you try to open a published project. The message warns you that the scan point file(s) is (or are) miss-
ing, points cannot be loaded and the project cannot be open.

Note: All image files (Logo or Project Image or first station image) are stored in the Data folder.

WEB FOLDER - This folder is used to store the Web files.

To view a published project within the embedded version of Trimble Scan Explorer, double-click the Trimble Scan Explorer
Viewer program file. Once executed, a Start Page opens, with the defined Logo, Title (or project name), and Project Image
(if not defined, the first station image will be used instead and the path to the first station displayed in the title bar). Hover the
cursor over the project image and click the Explore Project button.
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AMedia once included is embedded in the Start Page. Click on the embedded Media to enlarge it.
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TRIMBLE GENERAL PRODUCT TERMS
Trimble RealWorks
Version 2.0

These Trimble General Product Terms (this “Agreement”) are entered into by and between Trimble and the entity or per-
son placing an order for or accessing any Product(s) specified in the applicable Order (“Customer” or “you”). Certain cap-
italized terms are defined in Section 17 (Definitions), and others are defined contextually in this Agreement.

This Agreement consists of the terms and conditions set forth below, any applicable Product-Specific Terms, any applic-
able Support Terms, and the Order. If you are accessing or using the Product(s) on behalf of your company, you represent
that you are authorized to accept this Agreement on behalf of your company, and all references to “you” reference your
company.

Effective Date. The “Effective Date” of this Agreement means the earlier of (a) the effective date of the Order, or (b) the
date Trimble has first made access to a Product available to Customer, which could be by physical delivery of media (e.g.,
CD, dongle, etc.) or electronic or access delivery by means of an online provisioning, registration, download or other similar
process (“Initial Product Availability Date”). This Agreement will govern Customer’s initial purchase(s) on the Effective
Date as well as any renewals thereof (unless different terms are specified upon renewal).

Product-Specific Terms. Customer’s use of each Product is also subject to any additional product-specific terms and con-
ditions set forth in Exhibit A or separately referenced in the applicable Order (“Product-Specific Terms”). Any conflict or
inconsistency will be resolved in the following order of precedence: (1) the applicable Order, (2) the Product-Specific
Terms, (3) the Support Terms, and (3) the body of this Agreement.

BY INDICATING YOUR ACCEPTANCE OF THIS AGREEMENT OR INSTALLING, ACCESSING OR USING ANY
PRODUCT(S), YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. EACH
PARTY EXPRESSLY AGREES THAT THIS AGREEMENT IS LEGALLY BINDING UPON IT. IF YOU HAVE PAID A
FEE FOR USE OF THE PRODUCT(S) AND DO NOT AGREE TO THESE TERMS AND CONDITIONS, YOU MAY
RETURN THE PRODUCT(S) FOR A FULL REFUND, PROVIDED YOU (A) HAVE NOT INSTALLED, ACCESSED, OR
USED THE PRODUCT(S) AND (B) RETURN THE PRODUCT(S) WITHIN 14 DAYS OF YOUR INITIAL PURCHASE.

1. Products.

1. Product Types. The following provisions apply to the applicable Product type (Service or Software) in the
Order.

1. Service. For Product(s) that are a Service, Customer may access and use the Service dur-
ing the Utilization Term only for its internal business purposes in accordance with the Docu-
mentation, Usage Limitations, any applicable Product-Specific Terms and this Agreement.
Unless otherwise specified by Trimble, any Software provided with a Service is subject to the
terms applicable to Software under this Agreement.
2. Software. For Product(s) that are Software, subject to the terms of this Agreement,
Trimble hereby grants Customer a non-transferable, non-sublicensable, non-exclusive
license solely during the Utilization Term to install, copy and use the Software on systems
under Customer’s control only for its internal business purposes in accordance with the
Documentation, Usage Limitations, any applicable Product-Specific Terms and this Agree-
ment. Software is licensed not sold.

2. Authorized Users; Administrators.

18
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1. Only Authorized Users may access or use any (i) Service or (ii) Software licensed on an
Authorized User basis. User IDs are granted to individual, named persons, and each Author-
ized User will keep its login credentials confidential and not share them with anyone else.
Customer is responsible for its Authorized Users’ compliance with this Agreement and
actions taken through their accounts. In the event an Authorized User is no longer a Cus-
tomer employee or contractor, Customer will promptly de-activate such Authorized User’s
access. Only if expressly permitted under the applicable Order, Customer may transfer
Authorized User status from one individual to another at any time, provided that use of the
Product(s) by its Authorized Users in the aggregate remains within the Usage Limitations.
Customer will promptly notify Trimble if it becomes aware of any compromise of its Author-
ized User login credentials.
2. If the Product permits administrator access, as described in the Documentation, Customer
may designate one or more Authorized Users to be administrators (each an
“Administrator”) with control over Customer’s Service account, including management of
Authorized Users and Customer Data, as described in the Documentation. Customer is fully
responsible for its choice of Administrators and any actions they take with respect to the Ser-
vice. Trimble’s responsibilities do not extend to the internal management or administration of
the Service for Customer.

3. API Access and Customer Applications.

1. API. The Product(s) may include one or more application program interfaces (“API(s)”)
that allow Customer to develop applications, code or services that communicate with the
Product (collectively, “Customer Applications”). Such APIs, if any, may be available upon
request. Customer may use an API only if such use is authorized in the Documentation or
otherwise in writing by Trimble. Use of APIs may be subject to additional terms and con-
ditions. Trimble may modify APIs from time to time, and Trimble is not responsible for the
compatibility of any such modifications with Customer Applications.
2. Use of Customer Applications. If use of an API is authorized, subject to the terms of this
Agreement and in compliance with the applicable Documentation, Customer may develop
Customer Applications for use solely by Customer’s Authorized Users. Customer will not
develop Customer Applications for the benefit of, or distribute Customer Applications to, any
third party. Customer assumes all risk and liability regarding the development or use of any
Customer Applications. Other customers or Trimble itself may independently develop applic-
ations similar to Customer Applications.

4. Restrictions. Customer will not (and will not permit, encourage, or assist anyone else to) do any of the fol-
lowing: (a) provide access to, distribute, sell or sublicense the Product(s) to a third party, (b) use the Product
(s) on behalf of, or to provide any product or service to, third parties, (c) use the Product(s) to develop a sim-
ilar or competing product or service, (d) reverse engineer, decompile, disassemble or seek to access the
source code or non-public APIs to any element of the Product(s), except to the extent expressly permitted
by Law (and then only after providing prior written notice to Trimble), (e) modify or create derivative works of
the Product(s) or copy any element of the Product(s) (other than in connection with making copies of Soft-
ware authorized under this Agreement), (f) remove or obscure any proprietary notices in the Product(s), (g)
publish benchmarks or performance information about the Product(s), except to the extent expressly per-
mitted by Law, (h) interfere with the Product(s)’ operation or its use by others, circumvent its access restric-
tions or, without the prior written permission of Trimble, conduct any security or vulnerability test of the
Product(s), (i) transmit any viruses or other harmful materials to the Product(s), (j) submit to the Product(s)
any information that is inappropriate, defamatory, obscene, salacious or unlawful, or use the Product(s) to
defame, harass, stalk, threaten or otherwise violate the rights of others or (k) use the Product(s) to advert-
ise, offer to sell or buy goods, or otherwise for business promotional purposes, or (i) for Software, unless
expressly permitted in the Order, Product-Specific Terms or the Documentation, use or host any Software in
a virtual server environment.
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5. Trials and Betas. If Customer receives access to the Product(s) or any features thereof on a free or trial
basis or as an alpha, beta or early access offering (“Trials and Betas”), use is permitted only for Cus-
tomer’s internal evaluation to determine whether to purchase a full license or subscription to the Product(s)
during the period designated by Trimble (or if not designated, 30 days). If Customer purchases a full license
or subscription to the Product(s), this Agreement will apply to Customer’s use unless otherwise specified in
the applicable Order. Trials and Betas are optional and Trimble may cease offering Trials and Betas at any
time for any reason. Trials and Betas may be inoperable, incomplete or include features that Trimble may
never release, and their features and performance information are Trimble’s Confidential Information. If the
Product(s) includes a mechanism that limits access to Trials and Betas, Customer will not attempt to cir-
cumvent any such mechanism or restriction. Notwithstanding anything else in this Agreement: (a)
Trimble has no obligation to retain Customer Data used with Trials and Betas, (b) Trimble provides
the Trial and Betas “AS-IS”with no warranty, indemnity, service levels or support and (c) Trimble’s
liability for Trials and Betas will not exceed US$50.
6. Educational Versions. Notwithstanding the foregoing, for any version of the Product(s) designated as
“educational,” or a similar term, Customer may use the Product(s) solely for educational purposes (i.e., by
an instructor or a student at an educational institution and while engaged in educational work). Such edu-
cational versions may not be used (a) by any other person, (b) by any educational institution for any non-edu-
cational purposes, or (c) for any for-profit purpose, including professional work or training offered for a fee,
or by commercial entities.
7. Internet Connection. The Product(s) may require an active Internet connection or other means of elec-
tronic communications to operate, which are not the responsibility of Trimble.
8. Software Delivery and Deployment. Any Product(s) that are Software, and any applicable Documentation
and any applicable License Keys, will be delivered by electronic means unless otherwise specified on the
applicable Order. Delivery is deemed to occur on the date on which the Software and License Keys, if any,
are first made available to Customer. The Software may gather and transmit to Trimble license compliance
and activation data. Customer will not disable, modify or interfere with the operation of any such functionality
of the Software. Trimble may use the foregoing information to validate the authenticity of Customer’s license
to the Software, to register Customer’s Software, for license metering and to protect Trimble against unli-
censed or illegal use of the Software.

2. Data Rights.

1. Data Usage and Ownership.

1. Customer hereby grants to Trimble and its affiliates the non-exclusive, worldwide, irre-
vocable, royalty-free right: (i) to use Customer Data during the Utilization Term to provide the
Products and Professional Services to Customer; (ii) to use and disclose Customer Data as
otherwise permitted pursuant to this Agreement or any written consent and/or instructions of
the Customer; and, (iii) on a perpetual basis: (A) to create, use and disclose Anonymized
Data for any purpose; and (B) subject to Trimble’s confidentiality obligations in Section 13
(Confidentiality) and all applicable Data Protection Legislation, to use Customer Data to
develop, maintain and improve the Products(s) and any other products, software, and ser-
vices of Trimble and/or its affiliates.
2. Except for Trimble’s use rights set forth in this Agreement, as between the parties, Cus-
tomer retains all intellectual property and other rights in Customer Data provided to Trimble.
Trimble owns all right, title and interest in Anonymized Data (including, without limitation, any
and all intellectual property rights).
3. Customer will not have access to Customer Data after termination or expiration of the Util-
ization Term, unless otherwise indicated in the application Documentation, Order, Product-
Specific Terms, or the parties agree otherwise in writing.
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4. In the event of any conflict between the terms of Section 13 (Confidentiality) and this Sec-
tion 2.1 (Data Usage and Ownership), the terms of this Section 2.1 (Data Usage and Own-
ership) will control.

2. Personal Information; Data Protection. The following section applies if Customer is an entity.

1. All applicable laws, rules, and regulations relating to the protection of privacy and data pro-
tection are referred to as “Data Protection Legislation”. “Personal Information” is defined
as in the applicable Data Protection Legislation, or if no definition is provided, any personally
identifiable information which is either (i) provided by Customer or on its behalf, or (ii) auto-
matically collected through the Service on Customer’s behalf. “Applicable”, in this context,
means the Data Protection Legislation applicable to Customer at Customer’s principal place
of business or to Trimble at Trimble’s principal place of business, and such laws that Cus-
tomer notifies Trimble in writing of that apply to the parties.
2. Each party will comply with all applicable requirements of the Data Protection Legislation
that applies to it. This Section 2.2(b) is in addition to, and does not relieve, remove or
replace, a party's obligations or rights under the applicable Data Protection Legislation.
3. The parties acknowledge that: (i) if Trimble processes any Personal Information here-
under, it is on the Customer's behalf when performing its obligations under this Agreement
and (ii) the Personal Information may be transferred or stored, and/or accessed from outside
of the country where the Customer’s principal place of business is located in order to provide
the Service and Trimble's other obligations under this Agreement.
4. Without prejudice to the generality of Section 2.2(b), Customer will ensure that it has all
necessary appropriate consents and notices in place (i) to enable lawful transfer of the per-
sonal information to Trimble for the duration and purposes of the Agreement and (ii) to
enable Trimble to lawfully use, process and transfer the Personal Information in accordance
with this Agreement, including on the Customer's behalf.
5. If the processing of Personal Information by Trimble is subject to the General Data Pro-
tection Regulation ((EU) 2016/679) or the Data Protection Act 2018 of the United Kingdom,
then, in addition, at the request of Customer, then the parties will execute an applicable data
processing addendum.
6. If the processing of Personal Information by Trimble is subject to the California Consumer
Privacy Act of 2018 (Title 1.81.5, §1798.100 et. seq.) (“CCPA”), then in addition, in con-
nection with a verified request by a data subject pursuant to an exercise of rights under
CCPA related to Personal Information, Trimble is Customer’s service provider, that Cus-
tomer (and not Trimble) will respond to such request, and that if necessary in connection
with such verified request Customer will utilize the tools and information provided or made
generally available by Trimble, such as Trimble’s online portals or APIs and standard doc-
umentation regarding Trimble’s products, software and services. To the extent such tools do
not enable Customer to respond to a verified request, upon Customer’s request Trimble will
provide reasonable assistance with respect to Personal information in Trimble’s systems
that is required for Customer’s response to such request. A consumer request to delete Per-
sonal Information will not require Trimble to delete Personal Information required to provide
Customer with the Product(s), which includes any of Trimble’s service provider(s) acting on
Trimble’s behalf to provide the Product(s); provided, however, that such service provider(s)
do not have a separate right to sell or use Customer’s Personal Information other than as
required for Trimble’s business purposes.

3. Customer Obligations.

1. Compliance with Laws. Customer is responsible for complying with all applicable Laws in its use of the
Product(s) and any results derived from the Product(s)
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2. No High Risk Activities. Customer will not use the Product(s) for High Risk Activities. Customer acknow-
ledges that the Product(s) are not intended to meet any legal obligations for High Risk Activities.
3. No Prohibited Data. Customer will not use the Product(s) with Prohibited Data. Customer acknowledges
that the Product(s) are not intended to meet any legal obligations for these uses, including HIPAA require-
ments, that Trimble is not a Business Associate as defined under HIPAA.
4. Customer Data. Customer is responsible for its Customer Data, including its content and accuracy and
compliance with Laws. Customer represents and warrants that it has made all disclosures and has all rights,
consents and permissions necessary to use its Customer Data with the Product(s) and grant Trimble the
rights in Section 2.1 (Data Use and Ownership), all without violating or infringing Laws, third-party rights
(including intellectual property, publicity or privacy rights) or any terms or privacy policies that apply to its
Customer Data.

4. Suspension of Access to Product(s). Trimble may suspend Customer’s access to the Product(s) and/or Support,
without liability, and in whole or in part, if Customer breaches Section 1.4 (Restrictions) or Section 3 (Customer Oblig-
ations), if Customer’s account is 30 days or more overdue or if Customer’s actions risk harm to other customers or the
security, availability or integrity of the Product(s). Where practicable, Trimble will use reasonable efforts to provide Cus-
tomer with prior notice of the suspension. Once Customer resolves the issue requiring suspension, Trimble will promptly
restore Customer’s access to the Product(s) in accordance with this Agreement.
5. Certain Product Features. The following provisions apply to the extent applicable to the Product(s).

1. Devices. The Product(s) may be compatible with or require use of a device (“Device”). Compatible
Devices are specified in the applicable Documentation. Trimble makes no warranties regarding the oper-
ation of any Device or continued compatibility of the Product(s) with any such Device. You are solely
responsible for the configuration and operation of your Device. The results obtained through a Product may
be affected by, and Trimble will have no liability for, the compatibility, placement, configuration or operation
of your Device, weather or other environmental conditions, color or composition of materials being scanned,
or other factors outside of Trimble’s control.
2. Use with other Trimble Products. The Product(s) may allow Customer to connect with other Trimble
products or services. Use of such other products or services that are not part of the Product(s) may require
payment of a separate fee and are governed by those products or services’ respective terms of service, end
user license agreement, or other agreement, and not by this Agreement.
3. Scripts. The Product(s) may allow Customer to input and/or develop custom scripts, macros and com-
mands (collectively, “Scripts”) that control the operation of the Product(s). Scripts may be available for down-
load or purchase from Trimble or third parties, or created by Customer. Unless otherwise specified by
Trimble in writing, Scripts are not part of the Product. Customer’s development and/or use of any Scripts are
solely at its own risk. To the extent any Scripts are provided by a third party, such Scripts will be deemed to
be Third-Party Materials, and may be subject to Third-Party Terms.
4. Third-Party Materials.

1. Generally. The Product(s) may provide Customer with access to Third-Party Materials.
Third-Party Materials are not deemed to be part of the Product(s). To the extent specified by
Trimble (including in any Product-Specific Terms or Documentation), use of the Third-Party
Materials may be subject to additional terms or restrictions (“Third-Party Terms”). Cus-
tomer is solely responsible for its compliance with any Third-Party Terms, and failure to com-
ply with such terms may result in termination of Customer’s right to access any features of
the Product(s) that utilize such Third-Party Materials. If no Third-Party Terms are specified,
Customer may use Third-Party Materials solely in support of Customer’s authorized use of
the Product(s) in accordance with this Agreement.
2. Open Source. The Software may incorporate third-party open source software (“Open
Source”), as listed in the Documentation or Product-Specific Terms, or otherwise made
available by Trimble. To the extent the terms of the Open Source license prohibit the terms

Trimble RealWorks User Guide | 926



LICENSE AGREEMENT

of this Agreement from applying to the Open Source, the terms of the Open Source license
will apply to the Open Source on a stand-alone basis instead of this Agreement.
3. Content Subscriptions. This Section 5.4(c))Content Subscriptions) applies if the Product
makes available Third-Party Materials as a data or content subscription (“Subscription Con-
tent”). If you have a separate agreement with Trimble in place regarding the use of Sub-
scription Content (the "Subscription Content Agreement"), then such Subscription
Content Agreement governs the use of Subscription Content accessed through the Product,
but not the use of the Product itself, which will be governed by this Agreement. If no Sub-
scription Content Agreement is in place, then, unless otherwise authorized by Trimble in writ-
ing, such Subscription Content may only be used solely for Customer’s internal purposes
during the applicable Utilization Term and only when accessed pursuant to a manual end
user request. Customer will not: (i) access, extract or download any Subscription Content, or
portions thereof, in batch or mass by any means, (ii) sell, offer to sell, rent, sublicense or
transfer any copies of the Subscription Content, or portions thereof, to a third party or allow a
third party to use the Subscription Content; (iii) use the Subscription Content to develop ser-
vices or products for sale or include any portion of the Subscription Content in any product or
service; (iv) use any portion of the Subscription Content to create a competitive service,
product or technology; (v) recreate the Subscription Content or create otherwise a separate
database or other repository of Subscription Content, (vi) use Subscription Content to train,
augment, or correct another database or information repository, or (vii) make any portion of
the Subscription Content available to the public in any manner. Upon notice from Trimble
and/or any termination or expiration of the Utilization Term, Customer will immediately cease
using and delete/destroy all electronic and physical copies of Subscription Content.

5. Third-Party Platforms. Customer may choose to use the Product(s) with Third-Party Platforms. Third-
Party Platforms are not deemed to be part of the Product(s). Use of Third-Party Platforms is subject to Cus-
tomer’s agreement with the relevant provider and not this Agreement, and may enable data exchange
between the Product(s) and Third-Party Platform. Trimble does not control and has no liability for Third-
Party Platforms, including their security, functionality, operation, availability or interoperability or how the
Third-Party Platforms or their providers use Customer Data. If Customer enables a Third-Party Platform
with a Product(s), Trimble may access and exchange Customer Data with the Third-Party Platform on Cus-
tomer’s behalf.
6. Third-Party Application Stores.

1. Purchase from Application Store. If Customer obtained Software through a third-party
application store, marketplace or other site or service (each, an “Application Store”), such
Application Store is considered a “Reseller” under this Agreement, and Customer’s use of
the Software is subject to Section 7.3 (Purchase from Reseller) of this Agreement. Except as
expressly set forth in Sections 7.3 (Purchase from Reseller) and 5.6(c) (Apple-Specific
Terms), all fees are non-refundable once paid. Customer’s download of the Software may be
subject to other terms as specified by the operator of the Application Store from which Cus-
tomer downloaded the Software.
2. In App Purchases. The Software may offer Customer the opportunity to purchase addi-
tional functions and/or features from within the application (an “In App Purchase”). All
billing and transaction processes are handled by the provider of the Application Store (the
“App Store Provider”) from whose platform Customer downloaded the Software and are
governed by the App Store Provider’s terms and conditions. If Customer has any payment
related issues with In-App Purchases, then Customer must contact the App Store Provider
directly.
3. Apple-Specific Terms. If Customer downloaded the Software from Apple Inc.’s (“Apple’s”)
Application Store, the following terms are part of this Agreement:
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1. This Agreement is between Customer and Trimble, and not with Apple.
However, as required by Apple, Apple and its subsidiaries will be third party
beneficiaries of this Agreement and will have the right (and will be deemed to
have accepted the right) to enforce this Agreement against Customer as a
third-party beneficiary.
2. As set forth in Section 8 (Warranties and Disclaimers) of this Agreement,
Trimble offers a refund in certain circumstances following a breach of
Trimble’s limited warranty for the Software. If Customer is entitled to such a
refund, Customer may notify Apple, and Apple will refund the purchase price
(if any) for the Software to Customer. To the maximum extent permitted by
Law, Apple will have no other warranty obligation with respect to the Soft-
ware, and, as between Apple and Trimble, any other claims, losses, liab-
ilities, damages, costs or expenses attributable to a failure to conform to a
warranty will be Trimble’s responsibility. Apple has no obligation whatsoever
to furnish any maintenance or support services with respect to the Software.
3. As between Trimble and Apple, Trimble is solely responsible for the Soft-
ware and for addressing any claims Customer or any third parties have about
the Software or your possession or use of the Software, including without lim-
itation (A) product liability claims, (B) any claim that the Software fails to con-
form to any applicable legal or regulatory requirement and (C) claims arising
under consumer protection or similar legislation. In the event of any third-
party claim that the Software or your possession or use of the Software
infringes that third party’s intellectual property rights, Apple will not be
responsible for the investigation, defense, settlement or discharge of such
claim.

6. Support and Professional Services.

1. Service Support. During the Utilization Term, Trimble will provide the support for the Service (“Service
Support”) and service level commitments specified on the applicable Order and/or the Product-Specific
Terms, if any (“Service Support Terms”).
2. Software Support. Trimble will provide the support and maintenance services for the Software (“Software
Support”) specified on the applicable Order and/or the Product-Specific Terms, if any, during such period
as Customer has paid the applicable fee. Unless (a) Trimble and Customer have entered into a separate
written agreement for Support or (b) different terms and conditions are set forth in the Order or Product-Spe-
cific Terms, Support will be provided pursuant to Trimble’s then-current Software Support and Maintenance
Terms, available at https://www.trimble.com/support/SoftwareSSMTerms or a successor URL (any such
terms and conditions from (a) or (b), “Software Support Terms”).
3. Professional Services. Professional Services are not covered by this Agreement. If the applicable Order
indicates that Trimble will provide any Professional Services to Customer, then Trimble’s provision of and
Customer’s receipt of such Professional Services will be governed by Trimble’s then-current standard Pro-
fessional Services terms, available at http://www.trimble.com/legal/tandcforservices or a successor URL,
unless otherwise mutually agreed by the parties in writing.

7. Commercial Terms.

1. Utilization Term; Utilization Commencement Date; Renewal Opt Out Deadline. Unless otherwise set forth
in the Product-Specific Terms or Order,

(1) the initial Utilization Term for each Product is 12 months from the Utilization Com-
mencement Date, and each Utilization Term will renew for successive 12-month periods
unless either party gives the other party notice of non-renewal by the Renewal Opt Out Dead-
line; and

Trimble RealWorks User Guide | 928

https://www.trimble.com/support/SoftwareSSMTerms
https://www.trimble.com/legal/tandcforservices


LICENSE AGREEMENT

(2) the “Utilization Commencement Date” for each Product means:

(a) if Customer ordered such Product directly from Trimble, the later of (i)
applicable Initial Product Availability Date, or (ii) the start date of the term
indicated in the Order; or
(b) if Customer ordered such Product through a Reseller, the Initial Product
Availability Date.

(3) the “Renewal Opt Out Deadline” is the date that is 30 days before the expiration of the
then-current Utilization Term.

2. Fees and Taxes. Fees are as described in each Order. Fees are invoiced on the schedule in the Order
and reimbursable expenses are invoiced in arrears. Unless the Order provides otherwise, Custom will pay
all fees and expenses within 30 days of the invoice date. Fees for renewal Utilization Terms are at Trimble’s
then-current rates, regardless of any discounted pricing in a prior Order. Any amount due under this Agree-
ment that remains unpaid after its due date will bear interest at the lower of 1.5% per month or the maximum
rate permitted by Law, calculated from the data such amount was due until the date that payment is
received. Customer will pay all costs and expenses of collection (including attorneys’ fees) incurred by
Trimble collecting any amounts past due under this Agreement. Subject to any mandatory Laws to the con-
trary, all fees and expenses are non-refundable except as set out in Section 8.2 (Warranty Remedy). Cus-
tomer will pay any sales, use, GST, value-added, withholding or similar taxes or levies that apply to its
Orders, whether domestic or foreign (“Taxes”), other than Trimble’s income tax. Fees and expenses are
exclusive of Taxes. Customer will pay any foreign exchange transaction fees and any foreign exchange
profits or losses incurred on such transactions.
3. Purchase from Reseller. If Customer obtained the Product(s) through an authorized dealer, distributor or
reseller of Trimble (“Reseller”), the following terms are applicable and will prevail in event of any conflict
with any other provisions of this Agreement:

1. This Agreement is between Trimble and Customer and governs all access and use of the
Product(s) by Customer. Resellers are not authorized to modify this Agreement or make any
promises or commitments on Trimble’s behalf, and Trimble is not bound by any obligations
to Customer other than as set forth in this Agreement. Trimble is not party to (or responsible
under) any separate agreement between Customer and Reseller and is not responsible for
the Reseller’s acts, omissions, products or services. The applicable Product(s) list price for
the applicable Utilization Term will be deemed the amount paid or payable by Customer to
Trimble under this Agreement for purposes of Section 11 (Limitations of Liability).
2. Instead of paying Trimble, Customer will pay the applicable amounts to the Reseller, as
agreed between Customer and the Reseller. If the Reseller fails to pay Trimble the applic-
able fees for Customer’s use of the Product(s), Trimble reserves the right to terminate the
applicable Utilization Term for such Product(s) and all related rights granted hereunder. Cus-
tomer may purchase renewal Utilization Terms for the Product(s) under this Agreement dir-
ectly from Trimble pursuant to an Order.
3. Customer’s order details (e.g., the applicable Product(s), the Utilization Term, Usage Lim-
itations, Authorized Users, and any additional scope of use restrictions) will be as stated in
the Order issued by Trimble (i.e., entitlement confirmation), and the Reseller is responsible
for the accuracy of any such information as communicated to Trimble. Unless otherwise des-
ignated by Trimble, the Reseller is solely responsible for delivering to Customer any Product
(s), and Trimble has no liability for the Reseller’s failure to deliver such materials.
4. The Reseller may fulfill Trimble’s warranty obligations under Section 8.1 (Limited War-
ranty) on behalf of Trimble, to the extent authorized by Trimble in writing. Notwithstanding
the foregoing, the Reseller has no authority to make any statements, representations, war-
ranties or commitments on Trimble’s behalf and any such statements, representations,
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warranties or commitments are null and void. If the Reseller agrees to provide front-line sup-
port or professional services to Customer, Trimble has no responsibility for such Reseller-
provided support or professional services.
5. In the event Customer is entitled to a refund under this Agreement, Customer must
request such refund through the Reseller. Any request sent directly to Trimble may be redir-
ected to the Reseller. Trimble will refund any applicable fees to the Reseller and the Reseller
will be solely responsible for refunding such fees to Customer, unless otherwise specified by
Trimble. Trimble will have no further liability to Customer in the event the Reseller fails to
refund such fees to Customer.

8. Warranties and Disclaimers.

1. Limited Warranty. Unless otherwise specified in the Product-Specific Terms, and subject to any man-
datory Laws to the contrary, Trimble warrants to Customer that during the Warranty Period the Product(s)
will perform materially as described in the Documentation. The “Warranty Period” is (1) for Software that is
licensed on a perpetual basis, 90 days from the Subscription Commencement Date, and (2) for any Service
and/or Software that is licensed for a limited Utilization Term, the applicable Utilization Term.
2. Warranty Remedy. If Trimble breaches Section 8.1 (Limited Warranty) during the Warranty Period and
Customer makes a reasonably detailed warranty claim within 30 days of discovering the issue, then Trimble
will use reasonable efforts to correct the non-conformity or provide a work-around. If Trimble determines
such remedy to be impracticable, either party may terminate the affected Order to the extent that it relates to
the non-conforming Product(s). Trimble will then refund to Customer any pre-paid, unused fees for the ter-
minated portion of the Utilization Term. Subject to any mandatory Laws to the contrary, these procedures
are Customer’s exclusive remedy and Trimble’s entire liability for breach of the warranty in Section 8.1 (Lim-
ited Warranty). These warranties do not apply to (a) issues caused by misuse or unauthorized modi-
fications, (b) unsupported versions of Software, (c) issues in or caused by Third-Party Platforms or other
third-party systems or (d) Trials and Betas or other free educational or evaluation use.
3. Disclaimers.

1.General: EXCEPT AS EXPRESSLY PROVIDED IN SECTION 8.1 (LIMITED
WARRANTY), PRODUCT(S) AND SUPPORT ARE PROVIDED “AS IS”. TRIMBLE AND
ITS SUPPLIERS MAKE NO (AND HEREBY DISCLAIM ALL) OTHER WARRANTIES,
WHETHER EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
TITLE, NONINFRINGEMENT OR ANY WARRANTIES ARISING FROM A COURSE OF
DEALING OR USAGE OF TRADE. WITHOUT LIMITING ITS EXPRESS OBLIGATIONS
IN SECTION 6 (SUPPORT AND PROFESSIONAL SERVICES), TRIMBLE DOES NOT
WARRANT THAT CUSTOMER’S USE OF THE PRODUCT(S) WILL BE
UNINTERRUPTED OR ERROR-FREE, THAT TRIMBLE WILL REVIEW CUSTOMER
DATA FOR ACCURACY OR THAT IT WILL MAINTAIN CUSTOMER DATA OR OTHER
DATA WITHOUT LOSS. TRIMBLE IS NOT LIABLE FOR DELAYS, FAILURES OR
PROBLEMS INHERENT IN USE OF THE INTERNET AND ELECTRONIC
COMMUNICATIONS OR OTHER SYSTEMS OUTSIDE TRIMBLE’S CONTROL.
TRIMBLE WILL NOT BE LIABLE IN ANY MANNER FOR THE OUTPUT OBTAINED
THROUGH USE OF THE PRODUCT(S) OR CUSTOMER’S RELIANCE ON SUCH
OUTPUT. CUSTOMER IS RESPONSIBLE FOR THE SUPERVISION, MANAGEMENT
AND CONTROL OF CUSTOMER’S USE OF THE PRODUCT(S). THIS RESPONSIBILITY
INCLUDES THE DETERMINATION OF APPROPRIATE USES FOR THE PRODUCT(S)
AND THE SELECTION OF THE PRODUCT(S) AND OTHER PROGRAMS TO ACHIEVE
INTENDED RESULTS. CUSTOMER IS ALSO RESPONSIBLE FOR ESTABLISHING
THE ADEQUACY OF INDEPENDENT PROCEDURES FOR TESTING THE RELIABILITY
AND ACCURACY OF ANY OUTPUT OF THE PRODUCT(S). CUSTOMER MAY HAVE
OTHER STATUTORY RIGHTS, BUT ANY STATUTORILY REQUIRED WARRANTIES
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WILL BE LIMITED TO THE SHORTEST LEGALLY PERMITTED PERIOD.
2. Customer Applications. Trimble hereby disclaims any warranty, support or other
obligations with respect to any Customer Applications.
3. Scripts. Subject to mandatory Laws to the contrary, Scripts are provided “AS IS”
and Trimble hereby disclaims any warranty, support, or other obligations with
respect to any Scripts, including, without limitation, any Scripts provided by
Trimble.
4. Third-Party Materials and Third-Party Platforms. Third-Party Materials and Third-
Party Platforms are provided “AS IS” and Customer assumes all risk and liability
regarding any use of (or results obtained through) Third-Party Materials or Third-
Party Platforms. Trimble and its suppliers make no warranty or guarantee regarding
any Third-Party Materials or Third-Party Platforms, including regarding their accur-
acy or continued availability or compatability.
5. High Risk Activities and Prohibited Data. Trimble and its suppliers specifically dis-
claim any responsibility for, and will not be liable in any manner arising from, any
use of the Product(s) in connection with High Risk Activities or with any Prohibited
Data.
6. Global Positioning Data. Trimble and its suppliers are not responsible for the oper-
ation or failure of operation of any Global Positioning System (“GPS”) or Global Nav-
igation Satellite System (“GNSS”) satellites or base stations, or the availability of
GPS or GNSS satellite signals. You acknowledge that use of the Product(s) is sub-
ject to transmission limitations caused by a variety of factors such as atmospheric
conditions, topographical obstructions, limitations or lack of coverage of the under-
lying carrier service, and other natural or manmade conditions. Additionally, motor
and ignition noise, metal shielding, and interference by users of the same or adja-
cent radio channels may limit or interfere with coverage.

9. Term and Termination.

1. Term. This Agreement starts on the Effective Date and continues until expiration or termination of all Util-
ization Terms for all Product(s).
2. Termination. Either party may terminate this Agreement (including all Orders) if the other party (a) fails to
cure a material breach of this Agreement (including a failure to pay fees) within 30 days after notice, (b)
ceases operation without a successor or (c) seeks protection under a bankruptcy, receivership, trust deed,
creditors’ arrangement, composition or comparable proceeding, or if such a proceeding is instituted against
that party and not dismissed within 60 days.
3. Effect of Termination. Upon expiration or termination of this Agreement or an Order, Customer’s right to
use the Product(s) (including its license to any Software) will cease and Customer will immediately cease
any and all use of and access to the Product(s) and will delete (or, upon request, return) all copies of any
Software. At the disclosing party’s request upon expiration or termination of this Agreement, the receiving
party will delete all of the disclosing party’s Confidential Information (excluding Customer Data, which is
addressed in Section 2.1 (Date Usage and Ownership). Customer Data and other Confidential Information
may be retained in the receiving party’s standard backups after deletion but will remain subject to this Agree-
ment’s confidentiality restrictions.
4. Survival. These Sections survive expiration or termination of this Agreement: 1.4 (Restrictions), 2.1 (Data
Usage and Ownership), 3 (Customer Obligations), 7.2 (Fees and Taxes), 8.3 (Disclaimers), 9.3 (Effect of
Termination), 9.4 (Survival), 10 (Ownership), 11 (Limitations of Liability), 12 (Indemnification), 13 (Con-
fidentiality), 14 (Required Disclosures), 16 (General Terms) and 17 (Definitions). Except where an exclusive
remedy is provided, exercising a remedy under this Agreement, including termination, does not limit other
remedies a party may have.

10. Ownership. Neither party grants the other any rights or licenses not expressly set out in this Agreement. Except for
Customer’s use rights in this Agreement, Trimble and its licensors retain all intellectual property and other rights in the
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Product(s), Documentation, other deliverables and related Trimble technology, templates, formats and dashboards, includ-
ing any modifications or improvements to these items made by Trimble. If Customer provides Trimble with any suggestions,
ideas, enhancement requests, feedback, recommendations or other information relating to the Products (“Feedback”), Cus-
tomer hereby grants to Trimble and its Affiliates a nonexclusive, worldwide, perpetual, irrevocable, transferable, sub-
licensable, royalty-free, fully paid up license to use and otherwise exploit the Feedback.
11. Limitations of Liability.

1. Consequential Damages Waiver; Liability Cap. EXCEPT FOR EXCLUDED CLAIMS (AS DEFINED
BELOW), TO THE GREATEST EXTENT PERMITTED BY APPLICABLE LAW, EVEN IF SUCH
DAMAGES COULD HAVE BEEN FORESEEN OR IF A PARTY HAS BEEN APPRAISED OF THE
POSSIBILITY OF SUCH DAMAGES, AND REGARDLESS OF WHETHER SUCH DAMAGES ARE
ARISING IN CONTRACT, TORT, NEGLIGENCE, STRICT LIABILITY, BREACH OF ANY STATUTORY
DUTY OR OTHERWISE, IN NO EVENT WILL (A) EITHER PARTY (OR ITS SUPPLIERS) BE LIABLE
FOR DAMAGES FOR LOSS OF PROFIT OR REVENUE, DATA THAT IS LOST OR CORRUPTED,
FAILURE OF SECURITY MECHANISMS, INTERRUPTION OF BUSINESS, LOSS OF GOODWILL, OR
ANY SPECIAL, INCIDENTAL, RELIANCE, INDIRECT, PUNITIVE OR CONSEQUENTIAL DAMAGES
OF ANY KIND OR (B) EACH PARTY’S (AND ITS SUPPLIERS) ENTIRE LIABILITY ARISING OUT OF
OR RELATED TO THIS AGREEMENT WILL NOT EXCEED IN AGGREGATE THE AMOUNTS PAID OR
PAYABLE BY CUSTOMER TO TRIMBLE DURING THE PRIOR 12 MONTHS UNDER THIS
AGREEMENT FOR THE APPLICABLE PRODUCT(S) GIVING RISE TO THE LIABILITY. SOME
JURISDICTIONS DO NOT ALLOW A LIMITATION OF LIABILITY FOR DEATH, PERSONAL INJURY,
FRAUDULENT MISREPRESENTATIONS OR CERTAIN INTENTIONAL OR NEGLIGENT ACTS, OR
VIOLATION OF SPECIFIC STATUTES, OR THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES. IN SUCH AN EVENT THE FOREGOING LIMITATION(S) WILL NOT APPLY TO THE
EXTENT PROHIBITED BY LAW.
2. Excluded Claims. “Excluded Claims” means: (a) Customer’s breach of Section 1.3 (API Access and Cus-
tomer Applications), 1.4 (Restrictions), 3 (Customer Obligations), or 5.4 (Third-Party Materials), (b) either
party’s breach of Section 13 (Confidentiality) (but excluding claims relating to Customer Data); (c) amounts
payable to third parties under Customer’s obligations in Section 12 (Indemnification) or (d) any liabilities that
cannot be excluded or limited by Laws.
3. Nature of Claims and Failure of Essential Purpose. The waivers and limitations in this Section 11 (Lim-
itations of Liability) apply regardless of the form of action, whether in contract, tort (including negligence),
strict liability or otherwise and will survive and apply even if any limited remedy in this Agreement fails of its
essential purpose.

12. Indemnification.

1. Indemnification by Customer. Customer will defend, indemnify and hold harmless Trimble from and
against any and all third-party claims, costs, damages, losses, liabilities and expenses (including reas-
onable attorneys’ fees and costs) arising out of or in connection with (a) any Customer Data, Third-Party
Platforms, or third-party Devices, (b) Customer’s breach or alleged breach of 3 (Customer Obligations) or
5.4 (Third-Party Materials) or (c) any service or product offered by Customer (including any Customer Applic-
ation) in connection with or related to the Product(s) (each, a “Claim”).
2. Procedures. Trimble will give Customer prompt written notice of any Claim and will cooperate in relation
to the Claim at Customer’s expense. Customer will have the exclusive right to control and settle any Claim,
except that Customer may not settle a Claim without Trimble’s prior written consent (not to be unreasonably
withheld) if the settlement requires Trimble to admit any liability or take any action or refrain from taking any
action (other than ceasing use of infringing materials). Trimble may participate in the defense of any Claim
at its expense.

13. Confidentiality.
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1. Definition. “Confidential Information” means information disclosed to the receiving party under this
Agreement that is designated by the disclosing party as proprietary or confidential or that should be reas-
onably understood to be proprietary or confidential due to its nature and the circumstances of its disclosure.
Trimble’s Confidential Information includes the terms and conditions of this Agreement and any technical or
performance information about the Product(s). Customer’s Confidential Information includes Customer
Data.
2. Obligations. As a receiving party, each party will use reasonable care to protect the disclosing Party’s
Confidential Information from being disclosed third parties except as permitted in this Agreement, including,
without limitation, in Section 2.1 (Data Usage and Ownership), and (b) only use Confidential Information to
fulfill its obligations and exercise its rights in this Agreement. The receiving party may disclose Confidential
Information to its employees, agents, Affiliates, contractors and other representatives having a legitimate
need to know (including, for Trimble, the subcontractors referenced in Section 16.9 (Subcontractors)),
provided it remains responsible for their compliance with this Section 13 (Confidentiality) and they are
bound to confidentiality obligations no less protective than this Section 13 (Confidentiality).
3. Exclusions. These confidentiality obligations do not apply to information that the receiving party can doc-
ument (a) is or becomes public knowledge through no fault of the receiving party, (b) it rightfully knew or pos-
sessed prior to receipt under this Agreement, (c) it rightfully received from a third party without breach of
confidentiality obligations or (d) it independently developed without using the disclosing party’s Confidential
Information.
4. Remedies. Unauthorized use or disclosure of Confidential Information may cause substantial harm for
which damages alone are an insufficient remedy. Each party may seek appropriate equitable relief, in addi-
tion to other available remedies, for breach or threatened breach of this Section 13 (Confidentiality).

14. Required Disclosures. Nothing in this Agreement prohibits either party from making disclosures, including of Cus-
tomer Data and other Confidential Information, if required by Law, subpoena or court order, provided (if permitted by Law) it
notifies the other party in advance and reasonably cooperates in any effort to obtain confidential treatment.
15. Publicity. Neither party may publicly announce this Agreement except with the other party’s prior consent or as
required by Law. However, Trimble may include Customer and its trademarks in Trimble’s customer lists and promotional
materials but will cease this use at Customer’s written request.
16. General Terms.

1. Assignment. Trimble may assign this Agreement upon notice to Customer. Customer may not assign or
transfer this Agreement (by operation of law or otherwise) without the prior consent of Trimble. Any non-per-
mitted assignment is void. This Agreement will bind and inure to the benefit of each party’s permitted suc-
cessors and assigns.
2. Notices. Except as set out in this Agreement, any notice or consent under this Agreement must be in writ-
ing and will be deemed given: (a) upon receipt if by personal delivery, (b) upon receipt if by certified or
registered mail (return receipt requested) or (c) one day after dispatch if by an internationally reputable com-
mercial overnight delivery service. If to Trimble, notice must be provided to the address in Section 16.15
(Trimble Entity; Governing Law; Jurisdiction) below, with a copy to Trimble Inc., Attn: General Counsel –
Important Notice, 935 Stewart Drive, Sunnyvale, CA 94085, USA. If to Customer, Trimble may provide
notice to the address Customer provided at registration or on the Order. Either party may update its address
with notice to the other party. Trimble may also send general and operational notices to Customer by email
or through the Product(s).
3. Entire Agreement. This Agreement (which includes the Order and all applicable, the Product-Specific
Terms, Support Terms, Product Policies) is the parties’ entire agreement regarding its subject matter and
supersedes any prior or contemporaneous agreements regarding its subject matter. In this Agreement,
headings are for convenience only and “including” and similar terms are to be construed without limitation.
The terms in any Customer purchase order, business form, or other similar documents will not amend or
modify this Agreement and are expressly rejected by Trimble; any of these Customer documents are for
administrative purposes only and have no legal effect.
4. Modifications to Agreement. Subject to Section 16.5 (Modifications to Product Policies) below, Trimble
may modify this Agreement from time to time with notice to Customer. Modifications take effect at
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Customer’s next Utilization Term, if any, for an existing Order, or from the start of a new Order, unless
Trimble indicates an earlier effective date. If Trimble requires modifications with an earlier effective date and
Customer objects in writing, then Trimble may permit such modifications to take effect at the date indicated
above. If Trimble declines to do so, Customer’s exclusive remedy is to terminate this Agreement with notice
to Trimble, in which case Trimble will provide Customer a refund of any applicable pre-paid Product fees for
the terminated portion of the current Utilization Term. To exercise this termination right, Customer must
notify Trimble of its objections within 30 days after Trimble’s notice of the modified Agreement. Once the
modified Agreement takes effect Customer’s continued use of the Product(s) constitutes its acceptance of
the modifications. Trimble may require Customer to click to accept the modified Agreement.
5. Modifications to Product Policies. Product Policies are not subject to Section 16.4 (Modifications to Agree-
ment). With notice to Customer, Trimble may modify the Policies to reflect new features or changing prac-
tices, but the modifications will not materially decrease Trimble’s overall obligations during a Utilization
Term.
6. Amendments. Except as otherwise provided herein, any amendments, modifications or supplements to
this Agreement must be in writing and signed by each party’s authorized representatives or, as appropriate,
agreed through electronic means provided by Trimble.
7. Waivers and Severability. Waivers must be in writing signed by the waiving party’s authorized rep-
resentative and cannot be implied from conduct. Each provision contained in this Agreement constitutes a
separate and distinct provision severable from all other provisions. If any provision (or any part thereof) is
unenforceable under or prohibited by any present or future law or is held by a court of competent jurisdiction
or arbitrator to be invalid, void or unenforceable, then such provision (or part thereof) will be amended, and
is hereby amended, so as to be in compliance with such law, while preserving to the maximum extent pos-
sible the intent of the original provision. Any provision (or part thereof) that cannot be so amended will be
severed from this Agreement; and, all the remaining provisions of this Agreement will remain unimpaired.
8. Force Majeure. Neither party is liable for any delay or failure to perform any obligation under this Agree-
ment (except for a failure to pay fees) due to events beyond its reasonable control, such as a strike, block-
ade, war, act of terrorism, riot, Internet or utility failures, refusal of government license, pandemics or natural
disaster.
9. Subcontractors. Trimble may use subcontractors and permit them to exercise Trimble’s rights in con-
nection with this Agreement, including for hosting purposes. Trimble remains responsible for compliance of
any such subcontractors with this Agreement and for its overall performance under this Agreement.
10. Independent Contractors. The parties are independent contractors, not agents, partners or joint ven-
turers.
11. Compliance; Export Control.

1. Compliance with Laws. Customer is responsible for complying with all applicable Laws in
its use of the Product(s).
2. Export Restrictions. Customer acknowledges that the Product(s) are subject to export
restrictions by the United States government and import restrictions by certain foreign gov-
ernments. Customer will not, and will not allow any third-party to, remove or export from the
United States or allow the export or re-export of any part of the Product(s) or any direct
product thereof: (i) into (or to a national or resident of) any embargoed or terrorist-supporting
country; (ii) to anyone on the U.S. Commerce Department’s Table of Denial Orders or U.S.
Treasury Department’s list of Specially Designated Nationals; (iii) to any country to which
such export or re-export is restricted or prohibited, or as to which the United States gov-
ernment or any agency thereof requires an export license or other governmental approval at
the time of export or re-export without first obtaining such license or approval; or (iv) oth-
erwise in violation of any export or import restrictions, Laws s of any United States or foreign
agency or authority. Customer warrants that it is not located in, under the control of, or a
national or resident of any such prohibited country or on any such prohibited party list. The
Product(s) are further restricted from being used for the design or development of nuclear,
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chemical, or biological weapons or missile technology, or for terrorist activity, without the
prior permission of the United States government. Customer will defend, indemnify and hold
Trimble harmless against any liability (including attorneys’ fees) arising out of Customer’s fail-
ure to comply with the terms of this provision. Customer’s obligations under this paragraph
will survive the termination of this Agreement for any reason whatsoever.

12. Government End-Users. Elements of the Product(s) are commercial computer software. If the user or
licensee of the Product(s) is an agency, department, or other entity of the United States Government, the
use, duplication, reproduction, release, modification, disclosure, or transfer of the Product(s) or any related
documentation of any kind, including technical data and manuals, is restricted by the terms of this Agree-
ment in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal
Acquisition Regulation Supplement 227.7202 for military purposes. The Product(s) were developed fully at
private expense. All other use is prohibited.
13. No Third Party Beneficiaries. This Agreement does not confer any rights or remedies upon any third
party except to the extent expressly set forth in this Agreement. The parties to this Agreement may rescind
or vary this Agreement without the consent of any such third party beneficiaries.
14. Official Language. The official language of this Agreement is English. If there is a conflict between ver-
sions of this Agreement in any other language, the English language version controls.
15. Trimble Entity; Governing Law and Venue. Unless a different entity is specified in the applicable Order
or the Product-Specific Terms or in this Agreement, “Trimble” for purposes of this Agreement will mean the
“Trimble Entity” set forth below. The Agreement is governed exclusively by, and construed and enforced
exclusively in accordance with, the laws of the applicable jurisdiction set forth below under “Governing Law”,
without regard to or application of its conflicts of laws provisions and without regard to or application of the
United Nations Convention on the International Sale of Goods. The parties agree that any legal proceeding
arising out of or related to this Agreement will be subject to the sole and exclusive jurisdiction and venue set
forth below under “Exclusive Venue/Jurisdiction,” to the exclusion of all others. Each party irrevocably con-
sents and hereby submits to the personal jurisdiction thereof.

Customer Location*
Trimble Entity and Notice Address
Governing Law
Exclusive Venue/Jurisdiction
United States
Trimble Inc.
935 Stewart Drive, Sunnyvale, CA 94085 USA
California
State of California and United States federal courts located in Sunnyvale, California
Australia
Trimble Europe B.V.
Industrieweg 187a, 5683 CC, Best, The Netherlands
New South Wales
Courts of New South Wales and the courts having appeal from them
Any other country or geography not specified above
Trimble Europe B.V.
Industrieweg 187a, 5683 CC, Best, The Netherlands
The Netherlands
An arbitrator located in Eindhoven, The Netherlands, selected in accordance with the International Cham-
ber of Commerce (“ICC”)***
Notes:
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* Customer location determined by Customer’s billing address specified on the Order, or if none, then the
address provided by Customer to Trimble when registering its online account.
** See additional required notice address for Trimble in Section 16.2 (Notices).
*** In the event arbitration under an ICC process is specified above, except as provided in this paragraph
with respect to injunctive relief, all disputes regarding the Product(s) or this Agreement will be finally
resolved by binding and final arbitration before a single arbitrator, selected in accordance with the rules of
the ICC. Any arbitration will be conducted at the indicated location in the English language. After each party
has been afforded a reasonable opportunity to present written and testimonial evidence in support of its pos-
ition in any such arbitration proceeding, the arbitrator will issue his/her decision and award, which will (i) be
in writing, stating the reasons therefore, (ii) be based solely on the terms and conditions of the Agreement,
and (iii) except as provided in this paragraph regarding injunctive relief, be final and binding upon the
parties. The arbitrator will not award punitive or exemplary damages. The parties, their representatives, and
any other participants will hold the existence, content, and result of arbitration in confidence. The provisions
of this paragraph may be enforced by any court of competent jurisdiction. Notwithstanding the foregoing, (A)
either party may, at its sole discretion, seek injunctive relief in any court of competent jurisdiction (including,
but not limited to, preliminary injunctive relief), and (B) Trimble may bring suit against Customer in the courts
at Customer's place of business for infringement of intellectual property rights, over usage of Product(s) and
breach of restrictions of license or usage limitations and misappropriations of confidential information and
trade secrets or other intellectual property rights.

16. Australia-Specific Terms. For Customer who purchase Product(s) in Australia, the following provisions
apply:

1. For the purposes of this Section 16.16 (Australia-Specific Terms), “Australian Consumer
Law” means the Competition and Consumer Act 2010 (Cth) and “Non-excludable Condi-
tion” means certain consumer guarantees, warranties, rights, or remedies under the Aus-
tralian Consumer Law that cannot be limited, excluded, restricted, or modified, and to which
Customer may be entitled. For purposes of the following limitation of liability statement, the
Parties intend for the following: “service” means a Service and “goods” means Software.
2. To the extent permitted by law, Trimble’s liability in relation to breach of any such Non-
excludable Condition shall be limited as follows (and in which “our” “or “us” means Trimble,
and “you” means Customer):

i) in the case of the goods, to repairing or replacing the goods, supplying equi-
valent goods, or paying the costs of repairing or replacing the goods or acquir-
ing equivalent goods; and
ii) in the case of the services, to re-supplying the services or paying the cost
of re-supplying the services.

3. Nothing in these terms excludes, restricts or modifies any condition, warranty, right or rem-
edy implied or imposed by any statute or regulation which cannot lawfully be excluded,
restricted or modified.
4. Nothing in these terms is intended to derogate from Trimble’s obligations under the Pri-
vacy Act 1988 (Cth) as amended from time to time.

17. Definitions.

“Affiliate” means an entity that, directly or indirectly, owns or controls, is owned or controlled by or is under common own-
ership or control with a party, where “ownership” means the beneficial ownership of fifty percent (50%) or more of an
entity’s voting equity securities or other equivalent voting interests, and “control” means the power to direct the man-
agement or affairs of an entity.

“Anonymized Data” means any data collected in connection with the Product(s) (including Customer Data) that has been
aggregated and/or de-identified in such a manner that neither Customer nor any of its Authorized Users or any other indi-
vidual can be identified from the data when it is shared outside of Trimble or its Affiliates.
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“Authorized User” means (a) any employee or contractor of Customer that Customer allows to use the Product(s) for its
sole benefit, and/or (b) any other party(ies) expressly permitted to be “Authorized Users” in this Agreement (including the
Order or any Product-Specific Terms), if any.

“Customer Data” means any information, documents, materials, or other data of any type that is input by or on behalf of
Customer into the Product(s), including without limitation information or data that is submitted manually by Authorized
Users or through a Third-Party Platform, or that Customer may provide to Trimble in connection with receipt of Support.

“Documentation” means Trimble’s then-current usage guidelines and standard technical documentation applicable to the
Product(s).

“High Risk Activities” means any mission critical, hazardous, strict liability or other activity(ies) where use or failure of the
Product(s) could lead to death, personal injury or physical or environmental damage. Examples of High Risk Activities
include, but are not limited to: aircraft or other modes of human mass transportation, nuclear or chemical facilities, life sup-
port systems, implantable medical equipment, motor vehicles, autonomous vehicles, air traffic control, emergency ser-
vices, weaponry systems. High Risk Use does not include utilization of Cloud Service for administrative purposes, to store
configuration data, engineering and/or configuration tools, or other non-control applications, the failure of which would not
result in death, personal injury, or physical or environmental damage. These non-controlling applications may com-
municate with the applications that perform the control, but must not be directly or indirectly responsible for the control func-
tion.

“Law(s)” means all applicable local, state, federal and international laws, regulations and conventions, including those
related to data privacy and data transfer, international communications and export of technical or personal data.

“License Keys” means electronic passwords or other enabling mechanisms provided for use with Software.

“Order” means (a) any ordering documents, proposals, quotations, sales agreement or similar documents issued by
Trimble or executed by both parties or, or (b) any Trimble-issued entitlement confirmation or online order acknow-
ledgement, in each case of (a) or (b) for the Product(s) or Support for Software.

“Product(s)” means the applicable Software or Service.

“Product Policies” means the applicable Support Terms, acceptable use policies, service level commitments, or other
policies referenced in this Agreement (including, without limitation, the Order or Product-Specific Terms) for a Product.

“Professional Services” means any training, enablement, configuration or other professional consulting services provided
by Trimble related to the Product(s), as identified in the Order.

“Prohibited Data” means any (a) special categories of data enumerated in European Union Regulation 2016/679, Article 9
(1) or any successor legislation, (b) patient, medical or other protected health information regulated by the Health Insurance
Portability and Accountability Act (as amended and supplemented) (“HIPAA”), (c) credit, debit or other payment card data
subject to the Payment Card Industry Data Security Standards (PCI DSS), (d) other information subject to regulation or pro-
tection under specific Laws such as the Children’s Online Privacy Protection Act or Gramm-Leach-Bliley Act (or related
rules or regulations), (e) social security numbers, driver’s license numbers or other government ID numbers or (f) any data
similar to the above protected under foreign or domestic Laws.

“Service” means a Trimble proprietary cloud service, as identified in the relevant Order and as modified from time to time.
The Service includes Documentation but does not include Third-Party Materials or Third Party Platforms.

“Software” means the object code form of Trimble’s proprietary installed software product, as identified in the relevant
Order. The Software includes the Documentation, and any maintenance releases of the same Software product provided
by Trimble (or a Reseller) to Customer under this Agreement, and optional software component module(s) that provides
specific features and functionality enhancements for the Software not available in the standard configuration of the Soft-
ware. Software does not include Third-Party Materials or Third Party Platforms.

“Support” means the Service Support or Software Support, as applicable.

“Support Terms” means the Service Support Terms or Software Support Terms, as applicable.

“Third-Party Materials” means any third-party data, content or proprietary software.

“Third-Party Platform” means any platform, add-on, service or product not provided by Trimble that Customer elects to
integrate or enable for use with the Product(s).
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“Trimble” means the Trimble entity identified in Section 16.15 (Trimble Entity; Governing Law and Venue); provided that (ii)
for purchases made through a Reseller located in the United States, “Trimble” means Trimble Inc., and (iii) for purchases
made through a Reseller located outside the United States, “Trimble” means Trimble Europe B.V.

“Usage Limitations” means Customer’s authorized scope of use for the Product(s) as specified in the applicable Order or
Product-Specific Terms, which may include any user, seat, copy, instance, CPU, computer, field of use, location or other
restrictions.

“Utilization Term(s)” means the period of time, as identified in an Order, for which Customer is at any point in time cur-
rently authorized to use a Service or licensed to use a Software (including if perpetual).

Exhibit A

Product-Specific Terms

THE SOFTWARE IS A TOOL INTENDED TO BE USED BY TRAINED PROFESSIONALS ONLY. IT IS NOT A
SUBSTITUTE FOR YOUR PROFESSIONAL JUDGEMENT OR INDEPENDENT TESTING. DUE TO THE LARGE
VARIETY OF POTENTIAL APPLICATIONS FOR THE SOFTWARE, THE SOFTWARE HAS NOT BEEN TESTED IN ALL
SITUATIONS UNDERWHICH IT MAY BE USED. ANY USE BY YOUOF THE SOFTWARE OR ANY THIRD-PARTY
MATERIALS IS SOLELY AT YOUROWNRISK AND YOU AGREE THAT TRIMBLEWILL HAVE NO LIABILITY FOR
SUCH USE. TRIMBLE SHALL NOT BE LIABLE IN ANYMANNERWHATSOEVER FOR THE RESULTS OBTAINED
THROUGH THE USE OF THE SOFTWARE. YOU ARE RESPONSIBLE FOR THE SUPERVISION, MANAGEMENT, AND
CONTROL OF THE SOFTWARE.
THIS RESPONSIBILITY INCLUDES, BUT IS NOT LIMITED TO, THE DETERMINATION OF APPROPRIATE USES FOR
THE SOFTWARE AND THE SELECTION OF THE SOFTWARE ANDOTHER PROGRAMS TO ACHIEVE INTENDED
RESULTS. YOU ARE ALSO RESPONSIBLE FOR ESTABLISHING THE ADEQUACY OF INDEPENDENT
PROCEDURES FOR TESTING THE RELIABILITY AND ACCURACY OF ANY OUTPUT OF THE SOFTWARE.
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